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Introduction

Introduction
Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along with 
the matching definition. To understand how to use these functions in a production context, read the User 
guide. 

In the Reference guide, you will learn about the various parameters available in dialog boxes, menus, nodes, 
toolbars, views, and windows. 

The Preferences guide provides additional details about each individual preference. 
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Chapter 1: Dialog Boxes

Chapter 1: Dialog Boxes
Dialog boxes contain controls such as options and lists through which you can carry out a particular command 
or task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A 
typical dialog box looks as follows:

Add Column Dialog Box 22

Add Drawing Layer Dialog Box 25

Add Frames Dialog Box 27

Add Prefix or Suffix Dialog Box 29

Add Synced Drawing Layer Dialog Box 30

Advanced Save Dialog Box 32

Attribute Information Dialog Box 37

Auto-Matte Dialog Box 40

Close Gaps Dialog Box 41

Column Properties Dialog Box 42

Column Types Dialog Box 44

Configure Line Art to Colour Art Dialog Box 45

Convert to Synced Drawing Layer Dialog Box 47

Create Cycle Dialog Box 48

Create Drawing from Drawing Selection Dialog Box 49
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Export to Sprite Sheet Dialog Box 106

Expression Dialog Box 109

Extend Exposure Dialog Box 111

Fill Cells Randomly Dialog Box 112

Fill Exposure Using Render Changes Dialog Box 113

Fill Selection Dialog Box 116

Function Wizard Dialog Box 117

Master Controller Grid Wizard Dialog Box 124

Hold Timing 131

Import 3D Models Dialog Box 134

Import Images Dialog Box 136

Loop Node 143

Manage Local Cache Dialog Box 146

Manage Pre-Render Cache Dialog Box 148
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Manage Tool Presets Dialog Box 150

Marker Dialog Box 152
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Add Column Dialog Box
The Add Column dialog box lets you add a column in the Xsheet view.

By default, when you create a new scene, there is one drawing column in the Xsheet view and one 
corresponding drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the 
Timeline view, and a node in the Node view.

How to access the Add Column dialog box

 1. Do one of the following:

 l In the Xsheet menu, select Columns > Add Columns. 

 l Click the Add Columns  button. 

 l Press Shift + C.

NOTE 

The Add Column dialog box contains additional parameters for working with elements which 
will only display if you set advanced preferences. To do this, press Ctrl + U (Windows/Linux) or 
⌘  + U (macOS) to open the Preferences dialog box. Select the Advanced tab, then select the 
Advanced Element Mode option and click OK.

Parameter Description
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Name Lets you give the new column a meaningful name.

Type
Lets you select a type of column to create. Choices include: Drawing, Timing, 
Sound, 3D Path, 3D Rotation, Bezier Curve, Ease Curve, Expression and 
Annotation. 

Drawing Layer Options

Line Art Creates a vector or bitmap drawing column in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing column in the Colour Art layer. 

Element

Create New Element Creates an independent column with its own drawing folder.

Vector
Select this option if you want the layer to contain vector drawings. Deselect this  
option if you want the layer to contain bitmap images. Most of the time, the 
Vector option will be enabled.

Bitmap Format
Lets you select the type of bitmap image to insert in the column. Select SCAN 
from the list if you are planning to scan drawings using the Toon Boom Harmony 
Premium Scan module.

Scan Type
If you chose SCAN from the Bitmap Format list, select the kind of scanning you 
want to achieve.

Field Chart
When importing traditional animation, lets you indicate the size of paper on 
which the animation or background was drawn. If you are not using perforated 
animation paper, leave the 12 field default value as is.

Reuse Existing 
Element

Links your column to an existing folder within the Element folder of your scene.

Folder Lets you select the folder to which you want to link your new column.

Use Existing Element

Uses drawings from an existing column in the new column. Both columns will 
be attached to the same set of drawings, but their timing will remain  independent  
from one another. If you modify one of the drawings, it will be modified in both 
columns. This is the same principle as the Clone column.
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Name Lets you select the column to which you want to link your new column.

Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.
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Add Drawing Layer Dialog Box
The Add Drawing Layer dialog box lets you add a drawing layer  to your project. 

By default, when you create a new scene, there is one drawing column in the Xsheet view and one 
corresponding drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the 
Timeline view, and a node in the Node view.

How to access the Add Drawing Layer dialog box

 1. Do one of the following: 

 l In the Timeline view, click the Add Drawing Layer  button.

 l From the top menu, select Insert > Drawing.

 l Press Ctrl + R (Windows/Linux) or ⌘  + R (macOS).

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 
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Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 

Extend Exposure for Scene 
Duration

Automatically create and empty drawing exposure on each layer and expose 
them for the duration of the scene.

Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.
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Add Frames Dialog Box
The Add Frames dialog box allows you to add a given amount of frames at a specific point in your scene. The 
new frames are added to every layer in your scene and will offset all the keyframes and drawings after the 
insertion point.

How to access the Add Frames dialog box

 1. In the Timeline or Xsheet view, select a frame or a range of frames. 

 

 2. Do one of the following:

 l From the top menu, select Scene > Frame > Add Frames at Start, Add Frames at End, Add 
Frames Before Selection or Add Frames After Selection. 

 l In the Xsheet view, right-click and select Frame > Add Frames at Start, Add Frames at End, 
Add Frames Before Selection or Add Frames After Selection.

 l In the Xsheet toolbar, click the  Add Frames  button to add frames after your selection. 

 l Press Ctrl + G (Windows/Linux) or ⌘  + G (macOS) to add frames before the selection, or Ctrl 
+ H to add frames after the selection.

The Add Frames dialog box appears.

Parameter Description

Number of frames to add The amount of frames to add.
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Parameter Description

Ripple Scene Markers

If checked, scene markers after the insertion point will be offset forward to remain 
synchronized with the keyframes and drawings in your scene. If unchecked, 
scene markers will remain in place while everything else after the insertion point  
is offset.

Extend Drawing Exposure

If checked, drawings that are exposed just before the insertion point will be 
exposed throughout the added rames. If unchecked, no drawing will be exposed 
in the added frames. 

NOTE 

This option has no effect when adding frames at the start of the scene.
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Add Prefix or Suffix Dialog Box
The Add Prefix or Suffix dialog box lets you add or remove a prefix or suffix for a multi-layer or multi-node 
selection.

How to access the Add Prefix or Suffix dialog box

 1. In the Network or Timeline view, select all the nodes or layers to rename or press Ctrl + A 
(Windows/Linux) or ⌘  + A (macOS).

 2. In the Scripting toolbar, click the Add Prefix or Suffix Script  button. If the Scripting toolbar is not 
visible, you can display it by selecting Windows > Toolbars > Scripting from the top menu. If the 
Add Prefix or Suffix Script  button is not visible in the Scripting toolbar.

The Add Prefix or Suffix dialog box opens.

Parameter Description

Suffix
Allows you put a defined set of characters (letters, numbers, symbols) after the 
pre-existing layer or node name.

Prefix
Allows you put a defined set of characters (letters, numbers, symbols) before the 
pre-existing layer or node name.

Insert Text Enter a set of characters to be added to the selected layers or nodes.

Remove Text Enter a set of characters to be removed from the selected layers or nodes.
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Add Synced Drawing Layer Dialog Box
The Add Synced Drawing Layer dialog box lets you add a drawing layer  to your project that will automatically 
be synced with the currently selected layer.

Depending on whether the Support Overlay and Underlay Arts option was selected in the Advanced tab of 
the Preferences panel, the Add Synced Drawing Layer dialog box may look one of two ways.

How to access the Add Synced Drawing Layer dialog box

 1. In the Timeline view, right-click on the drawing layer you would like to sync with another layer.

 2. From the right-click menu, select Add Synced Drawing Layer.

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 
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Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.
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Advanced Save Dialog Box
In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an 
existing version, set a new current version, display a list of modified drawings, colour palettes, and modified 
colour palette lists. 

How to access the Advanced Save dialog Box

 1. Make sure that you have the necessary rights to save the current scene version. If you do not, you 
can acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify 
Scene from the top menu.  

 2. From the top menu, select File > Advanced Save. 

The Advanced Save dialog appears.
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File Tab

Parameter Description

Save

‣ Enable this option if you want to save the modifications made to the 
current scene. 

‣ Deselect the Save option if you only want to save specific components of 
your scene listed in the Drawings, Palettes or Palette Lists tabs. This will 
disable all option in the File tab. 

This Version (number)
Saves the current version of the scene. You can rename the current version by 
typing a new name into the field. 

New Version (number)
Saves the current scene as a new version. You can name this new version by 
typing a name into the field. 

Overwrite Existing Version Lets you select an existing version of your scene from the list to overwrite it.

Description
Use this field to add or edit an existing description for the scene version you want 
to save. 

Mark as Current
Lets you set this scene version as the current one. This version will be 
automatically selected as the default current version when the scene is selected 
in the Database Selector dialog box
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Drawings (Harmony Server only) 

The Drawings tab lists the modified drawings.

Parameter Description

Drawing list
Lets you select the modified drawings to save, and deselect the ones you do not 
want to save.

Select All Selects all modified drawings in list.

Deselect All Deselects all modified drawings in the list.

Palettes Tab

The Palette tab lists the modified colour palettes.
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Parameter Description

Colour Palette list
Lets you select the colour palette to save, and deselect the ones you do not want 
to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified colour palettes in the palette list.

Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists Tab

The Palette Lists tab lists all the modified colour palette lists.
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Parameter Description

Palette Lists
Lets you select the modified palette list to save, and deselect the ones you do not 
want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified palette lists in the list.

Deselect All Deselects all modified palette lists in the list.
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Attribute Information Dialog Box
The Attribute Information dialog box displays information for accessing a specific attribute in a specific node 
through the Harmony scripting interface.

How to access the Attribute Information Dialog Box

 1. In the top-left corner of the Node view, click on the  Menu button and select View > Show 
Attribute Information.

 2. In the Node view, locate the node which you want to manipulate through scripting. 

 3. Click on the  Layer Properties  button for this node. 

The Layer Properties dialog for this node appears. Right of each attribute is a  Show Attribute 
Information button. 
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 4. Click on the  Show Attribute Information button next to the attribute which you want to access 
through scripting. 

The Attribute Information dialog appears and displays information on the attribute, as well as a 
sample script to access the attribute.
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Parameter Description

Node Path

The path to access the node in your scene's node system. This path is the 
hierarchy of groups in which the node is located, and always starts with Top, 
which represents the root of the scene's group hierarchy. For example, if the node 
is named master-P and is inside a group named CH001_MyCharacter in the 
scene's root, its path would be Top/CH001_MyCharacter/master-P.

Attribute Display Name
The user friendly name of the attribute. This name cannot be used in the Harmony 
scripting interface.

Attribute Keyword The actual name of the attribute in the Harmony scripting interface. 

Attribute Type The type of the attribute. 

Get Value in Script A sample script to access the attribute and store its value in a variable. 
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Auto-Matte Dialog Box
The Auto-Matte dialog box lets you generate a matte for a drawing. 

How to access the Auto Matte dialog box

 1. In the Camera or Drawing view, select the drawing you want to create a matte for.

 2. Do one of the following: 

 l From the top menu, select Drawing > Generate Auto-Matte. 

 l In the Camera or Drawing menu, select Drawing > Generate Auto-Matte.

Parameter Description

Settings

Apply to all Drawings Creates a matte for all the drawings included in layer.

Radius
Lets you increase or decrease the radius value depending on the precision or 
roughness of your line. Use a lower value, the closer to your lines’ contours the 
matte will be shaped. The higher the value, the looser the matte will be shaped.

Source Art
Lets you select the layer from which you want the matte created: Line Art,Colour 
Art, Underlay or Overlay.

Destination Art
Lets you select the layer on which you want the matte to be created: Line 
Art,Colour Art, Underlay or Overlay.

Clear Destination Art First Deletes existing artwork on the destination layer before adding a matte to it.

Copy Strokes in Destination
Copies the contour of your lines as invisible lines in the matte drawing. This is 
useful if you need to reuse the lines later.
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Close Gaps Dialog Box
The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen 
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two 
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few 
millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box

 1. Select View > Show > Show Strokes or press K to see a preview of the result.

 2. To flatten the strokes you draw, click the Auto-Flatten  button in the Tool Properties view.

 3. Select Drawing > Clean Up > Close Gaps or press Shift + F10 (Windows/Linux only).

The Close Gaps dialog box opens.

Parameter Description

Size Lets you set the size of the gap you want to be closed.

Apply to all drawings Closes all gaps in the drawing of the selected layer.
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Column Properties Dialog Box
The Column Properties dialog box lets you add, delete or modify elements (drawing folders) in your scene.

How to access the Drawing dialog box

 1. In the Xsheet view, double-click on a column name. Do not click on the drawing folder name that 
the column is linked to (this also appears in the column header just below the column name).

Parameter Description

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to enable 
the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Premium Scan 
module, select the scan type from the list.
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Field Chart
If you're importing traditional animation, select the size of the paper on which the 
animation was drawn.
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Column Types Dialog Box
The Columns Types dialog box lets you show or hide columns in the exposure sheet. 

How to access the Columns Types dialog box

 1. In the Xsheet view, select View > Column Types Manager.

The Column Types dialog box opens.

Parameter Description

Column Types Lets you select the types of columns to display in the Xsheet view.

Save as Default Makes these new settings the default ones used each time you start Harmony.

Restore Default Returns the settings to their defaults.
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Configure Line Art to Colour Art Dialog Box
The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

How to access the Configure Line Art to Colour Art dialog box

 1. In the Tools toolbar, select the Select tool. 

 2. In the Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line 
Art button.

Parameter Description

Use rendered version of the 
drawing

Renders the drawing and vectorize it to calculate the position of the centreline 
that will produce the colour art stroke.

Maximum Resolution for 
rendered image

The size of the rendered image.

Threshold for rendered 
image

The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered 
Beziers

This value represents how precise the fitting of the colour art zone in relation to 
the line art will be.

Source layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created from.

Destination layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created on.

Clear Destination Art Layer Deletes the content before the colour art is added. This is useful when you 
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First already have artwork on the destination layer.

Perform Line Art to Colour 
Art Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.
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Convert to Synced Drawing Layer Dialog Box
The Sync Layer feature allows for drawings to be separated on different layers, but to have the same timing.

How to access the Convert to Synced Drawing Layer dialog box

 1. right-click on a drawing layer you would like to sync with another layer. 

 2. From the right-click menu, select Sync Layers With.

In the Choose the Parent Drawing Layer drop-down list, with the exception of the selected layer, 
every layer in your scene is listed.

 3. To sync a layer with your currently selected layer, from the drop-down list, select a parent drawing 
layer and click OK. The child layer immediately updates to the parent layer's timing.
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Create Cycle Dialog Box
The Create Cycle dialog box lets you create cycles from a series of drawings and exposures. 

When you create a drawing cycle, all the repeated drawings are linked to the same original files. When 
modify, repaint, or correct a drawing named “1” for example, all drawings named “1” are updated 
simultaneously. In order to modify a drawing independently from its other exposures, you must duplicate the 
drawing.

How to access the Create Cycle dialog box

 1. In the Timeline or Xsheet view, select the cell range to loop.

 2. In the Timeline toolbar, click the Create Cycle  button (you may have to customize the toolbar to 
display it).

The Create Cycle dialog box opens.

Parameter Description

Number of Cycles Lets you specify the number of cycles, including the current selection.
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Create Drawing from Drawing Selection Dialog Box
The Create Drawing from Drawing Selection dialog box lets you cut a part of a drawing and send it to a new or 
existing layer.  

How to access the Create Drawing from Drawing Selection dialog box

 1. From the top menu, select Edit > Create Drawing From Drawing Selection or press F9 
(Windows/Linux) or ⌘  + F9 (macOS).

The Create Drawing From Drawing Selection dialog box opens.

Parameter Description

Layer Name Lets you enter a name for the layer using the naming convention you established.

Cut Artwork From Source Lets you cut the selected artwork from the model.
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Create Function Step On Dialog Box
The Create Function Step On dialog box lets you  hold the same value over a selected number of frames for 
multiple parameters (pos x, scale y, etc.). This works well when you are animating drawings on 2s or 3s, for 
example, and you want to hold the same value for a function over those two or three frames.

How to access the Create Function Step On dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l right-click on the empty space near the top of the interface  and from the quick-access menu 
selecting Scripting.

 l right-click on the empty space near the top of a view and from the quick-access menu 
selecting Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager 
window.

 3. In the Scripts Manager, in the Files section, select the file TB_CreateStepsOn.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_CreateStepsOn.

The Add script to toolbar button becomes active.
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 5. Click on the Add script to toolbar button.

The TB_CreateStepsOn script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Timeline view, select the layer whose parameter values you would like to hold. 

 9. In the Scripting toolbar, click on the TB_CreateStepsOn script  button.

The Create Function Step On dialog box appears.

Parameter Description

Settings

Every Number of Frames Enter in the number of frames you would like to hold your functions.
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Selection

First Frame

Enter in the frame number of where you would like the stepped holds to 
start.  The playhead location determines the lowest value you can enter 
for the first frame. You need to move the playhead to frame one if you 
would like to set frame one as the lowest possible starting value. 

Last Frame
Enter in the frame number of where you would like the stepped holds to 
stop.
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Create Palette Dialog Box
The Create Palette dialog box allows you to create a colour palette for your scene. Palettes created with this 
dialog box are added to your scene's palette list, and stored in your scene's palette-library subdirectory.

NOTE 

If you have the Advanced Palette Lists preference enabled, the dialog will also have a palette 
browser, which allows you to decide where the palette is stored and whether to add it to the scene 
or the element's palette list—see Palette Browser Dialog Box on page 170.

How to access the Create Palette dialog box

 1. Do one of the following:

 l In the Colour View, click the New Palette  button over the palette list.

 l From the Colour view menu, select Palettes  > New

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose the palette type to create:

 l Colour: A colour palette can contain colours, gradients and bitmap textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 
transparency filters to pencil lines, in combination to their line colour, to create 
various styles of pencil lines.
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Create Palette from Selection Dialog Box
The Create Palette from Selection dialog box allows you to create a palette that contains all the colours used 
by all the drawings in the selected drawing layers. 

This can be useful, for example, if the colour design for a character model or rig, a background or another kind 
of asset was made using several different palettes, and you need to consolidate all of the colours used by the 
asset into its own dedicated palette. 

NOTES 

 l The Create Palette from Selection dialog uses the colours in all the drawings in the selected 
layers, even drawings that are not exposed. 

 l For tasks related to this dialog box, see the User Guide.

How to access the Create Palette from Selection dialog box

 1. In the Timeline, Xsheet, Camera or Node view, select one or more drawing layers. 

 2. In the top-left corner of the  Colour view, open the  View Menu and select Palettes > New 
Palette from Selected Drawings. 

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose one of the type of palette to create:

 l Colour: Creates a palette containing all the colours, gradients and bitmap 
textures used in the selected drawing layers.

 l Pencil Texture: Creates a palette containing all the pencil textures used in the 
selected drawing layers.

Generate New 
Colour IDs and 
Recolour Selected 
Drawings

By default, the Create Palette from Selection dialog box generates the palette by copying 
the colour swatches used in the selected drawings from their original palette into a new 
palette, along with their colour ID. This means that the colour swatches in the generated 
palette will use the same colour IDs as the ones in the original palettes.
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If you select this option, Harmony will generate a palette with new colour IDs, and will 
replace the old colour IDs in your artwork with the new ones. This will usually have no 
visible effect, and will prevent the swatches in the new palette from having the same 
colour IDs as the swatches you originally used to colour your artwor. When two palettes 
have a swatch with the same colour ID, Harmony uses the swatch from the top-most 
palette in the palette list. 

NOTE 

If your artwork uses Colour-Override effects, the colour IDs used by these Colour-
Override will not be replaced with the new colour IDs, making the Colour-Override 
ineffective unless you reconfigure them manually. Hence, you should avoid using 
this parameter if you are consolidating the palette of a character rig that uses a lot 
of Colour-Overrides. 
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Database Selector Dialog Box
The Database Selector dialog box lets you connect to your studio's central database when working on 
Harmony Server. 

NOTE 

When you connect to the database, you cannot create new scenes directly from Harmony. The 
available scenes must have been already created using the Control Center module. 

How to access the Database Selector dialog box

 1. Start Harmony

 2. In the log-in dialog, select Connect to Database.

 3. In the User Name field, type in your Harmony Server username.

 4. Click on OK.

The Database Selector dialog box opens.

Parameter Description

Environments Lets you select the scene's environment (project, movie).
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Jobs Lets you select the scene's job (episode, sequence). 

Scenes Lets you select the scene.

Get rights to modify the 
scene

Allows you to modify the selected version of the scene as well as to manage and 
overwrite other versions. Other users will not be able to open a different version 
of the scene until you close the scene.

Get rights to modify the 
scene version

Allows you to modify the currently selected scene version only. Unless the Get 
rights to modify the scene option is also checked, you will not be able to 
change other versions of the scene. This allows other users to modify different 
versions of the scene while you are working on the selected version.

Get rights to modify all 
scene assets

Automatically gets the rights to modify all of the scene's assets, locking other 
users from making changes to them until you close the scene. This means that 
you will have the rights to modify all the scene's versions, drawings, palettes, its 
palette list, but not its library folder. If this option is unchecked, drawings and 
palettes will be locked unless you unlock them manually. This can allow another 
user to work on the scene's drawings and palettes in Paint while you are working 
on the scene's timing or staging in Harmony.

Cache scene assets locally

Downloads the scene's drawings to your computer before opening the scene. 
Harmony will then load the drawings from your computer during the session, 
instead of loading them from their original location over the network. This can 
significantly increase performance, especially with resource-heavy scenes. 

When you save your scene, the updated drawings will be uploaded 
automatically to the database, so you do not have to re-upload them manually. 

NOTE 

If this option is checked, it may take a while to download all of the scene's 
assets when opening a particularly heavy scene.

Version If you saved different versions of a scene, this lets you select one to open.
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Deformer On Deformer Wizard Dialog Box
The Deformer on Deformer Wizard dialog box allows you to create a Curve deformer over an Envelope 
deformer, so that the Curve deformer deforms the Envelope deformer, which in turn deforms the drawing it is 
attached to. 

Simply creating a Curve deformer over or under an Envelope deformer does not achieve the expected results, 
as both deformers end up acting as a single chain that both deform the drawing, and manipulating one 
deformer does not offset the other deformer’s points. This usually results in a deformation system that is 
unwieldy and which doesn’t produce a good image. 

With the Deformer on Deformer Wizard, it is possible to create a functional Curve deformer over an existing 
Envelope deformer. The Deformer on Deformer Wizard accomplishes this by converting the Curve deformer 
into a Master Controller. This Master Controller, while looking like a regular Curve deformer, will actually 
deform the Envelope deformation chain it is rigged to, rather than the drawing itself. The Envelope 
deformation chain will in turn deform the drawing. 

This allows you to combine the ability of an Envelope deformer to make tweaks to the outer shape of a drawing 
with the ability of a Curve deformer to easily animate the centreline of a drawing.

Before you use the Deformer on Deformer Wizard, you must already have created the Envelope deformer for 
the drawing using the Rigging tool. Then, you must select the group containing the Envelope deformer in 
the Node View and open the Deformer on Deformer Wizard.

The Deformer on Deformer Wizard only has two buttons: Cancel and Done. This is because it works by 
observing while you build the Curve deformer over the Envelope deformer. As you create Curve deformation 
points, it generates the nodes and connections required to create a  Deformer on Deformer system. When 
you’re done building the Curve deformer, you can click on Done to finalize the conversion of the Curve 
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deformer into a Deformer on Deformer system. Then, your Curve deformer will be able to deform the Envelope 
deformer your rigged it to. 

So, in summary, to use the Deformer on Deformer Wizard, you must follow these steps:

 1. Create your drawing.

 2. Create the Envelope deformation chain for your drawing, as you normally would, using the  Rigging 
tool.

 3. Select the Envelope deformation chain your created.

 4. Open the Deformer on Deformer Wizard.

 5. While the Wizard is open, create a Curve deformation chain using the  Rigging tool. You can move 
the Wizard aside and keep working on your scene while it is open.

 6. Once you created your Curve deformer, click on Done in the wizard.

And that’s it. Your Curve deformer will be converted to a Deformer on Deformer system, which will be able to 
work with the Envelope deformer you created prior. 

How to access the Deformer on Deformer Wizard

 1. Add the Master Controller toolbar to your workspace by doing one of the following:

 l Right-click on an existing toolbar and select Master Controller.

 l In the top menu, select Windows > Toolbars > Master Controller.

The Master Controller toolbar appears.

 2. In the Node View or the Timeline view, select the group for the Envelope deformer over which you 
want to create a Curve deformer.
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 3. In the Master Controller toolbar, click the  Deformer on Deformer button.

The Deformer on Deformer Wizard appears. The  Rigging tool is also automatically selected in 
the Deformation toolbar. 

Button Description

Cancel
Cancels the creation of a Deformer on Deformer. This undoes changes to the Node View that were 
made while using the wizard. 

Done
Once you are done creating the Curve deformer, click on Done to finalize the Deformer on Deformer 
system. After this, the Curve deformer you created will be converted to a Master Controller that is able 
to deform the Envelope deformer you created prior. 

60



Edit Default Paste Preset Dialog Box
The Edit Default Paste Preset dialog box lets you modify settings for the keyframe and exposure paste presets, 
as well as setting the defaults.

How to access the Edit Default Paste Preset dialog box

 1. From the Timeline menu, select Edit > Modify Paste Presets > All or Key Frame or Exposure.

Parameter Description

Drawings

Add/Remove 
Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved when 
pasting. No key exposures are added. This is the default behavior when pasting.
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Fill Gap with 
Previous Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.

Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.
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Edit Exposure Paste Preset Dialog Box
The Edit Exposure Paste Preset dialog box lets you reuse key exposures as you animate.  

How to access the Edit Exposure Paste Preset dialog box

 1. From the Timeline view menu, select Edit > Modify Paste Presets > Exposure.

The Edit Exposure Paste Preset dialog box opens.

Parameter Description

Drawings

Add/Remove 
Exposure

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when do they do not exist: When adding exposures 
to a drawing layer, new drawings will be created only when drawings with the 
same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure Creates a key exposure on the same drawing.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.
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Fill to Next Key Exposure Fills selected area till the next key exposure.

Keyframes

Add/Remove Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End:  Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.

Reset to Default Return all values to their defaults.
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Element Manager Dialog Box
The Element Manager window lets you Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing folders that are not linked to a column in 
your scene, use the Element Manager to delete them if needed. See xref Reference > Windows > Element 
Manager.

How to access the Element Manager window

 1. From the top menu, select Scene > Element Manager.

Parameter Description

Elements

Delete Elements Deletes the selected elements.

Delete Elements and 
Directories

Deletes  the selected layer and its directories (drawing folder).

Add/Modify Element

Name
Type in a new name in this field to create an element or to rename the 
selected element.

Vector
Select this option if the new element is a vector drawing or if you want to 
enable the parameters on the selected element in the Elements list.
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Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Premium 
Scan module, select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on 
which the animation was drawn.

Add
Creates a new element with the current parameters entered in the 
Add/Modify Element section.

Modify Applies the parameter changes made to the selected element.
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Envelope Creator Dialog Box
The Envelope Creator Dialog box allows you to procedurally generate a curve or envelope deformation chain 
based on the artwork in the current layer. The deformation chain can be made to wrap around the outer shape 
of the artwork or to go through its centre line. It will be created as a parent of the current layer, allowing you to 
use it to deform and animate the artwork in the layer instantly after creating it.

How to access the Envelope Creator dialog box

 1. Select the node or layer for which you want to create a deformation chain.

 2. In the top menu, select Animation > Envelope Creator > Create Envelope.

The Envelope Creator dialog appears.

Parameters

Parameter Description

Deformation 
Points

The amount of deformation points to create in the deformation chain. The higher the amount of 
points, the more faithful to the outer shape of your artwork the deformation chain will be, but the 
harder it will be to animate. 

67

Harmony 21 Premium Reference Guide                          



Chapter 1: Dialog Boxes

Parameter Description

TIP 

You can enable the Use All Corners option to let the Envelope Creator calculate how 
many points to create based on the amount of corners in your artwork.

Discretizer 
Spacing

The scale at which the Envelope Creator analyzes the drawing's details. A lower setting will 
cause the shape of the envelope to match the contours of the drawing more closely, but may 
cause the Envelope Creator to hang when generating an envelope and to generate points for small 
dents and bumps in the contour of the artwork. A higher setting will allow the Envelope Creator 
to ignore subtle details in the contour which would not be useful for the deformation chain.

Concave 
Smoothing

Smooths out the concavities of the envelope. Increasing this parameter makes the concave corners 
in the envelope moved away from the centre of the envelope, making the shape of the envelope 
closer to a convex shape. The position of convex corners is not affected by this parameter. 

Smooth 
Passes

The amount of smoothing applied to the corners and angles in the shape of the deformation chain.
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Parameter Description

Expand

Expands the outer shape of the envelope. This ensures that the contours of the artwork are inside 
the envelope instead of meshing with it.

Bisect 
Curves

The amount of extra points to add over the segments of the deformation chain. While points 
added with the Deformation Points parameter are laid out to match the corners of the shape, the 
points added with the Bisect Curves setting are added to the middle of the segments between 
those points.

This parameter determines the total amount of Bisect Curves points to add to the whole envelope. 
Those points are distributed along the envelope, with priority given to longer segments. An 
extremely long segment may have several Bisect Curves points added to it, like in this example:
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Options

Parameter Description

Envelope 
Mode

By default, the Envelope Creator will generate a Curve type deformation chain. This means that the 
first point in the chain is not used to deform the artwork, but rather, to offset the deformation chain 
and move the drawing. With Envelope mode enabled, the first point in the deformation chain has 
the same purposes as all the other points, which is to deform the drawing. 

Use All 
Corners

When enabled, this ignores the Deformation Points parameter and creates a deformation point for 
each corner the Envelope Creator detects in the shape of the artwork.

Create 
Single 
Center Line

When enabled, this creates a deformation chain that goes through the centre line of the artwork, 
instead of going around the outer contour of the artwork. 

Shape 
Nodes in 
Node View

Lays out the deformation nodes in the node view so that they resemble the shape of the 
deformation chain, allowing you to visually identify which deformation node corresponds to which 
deformation point in the chain. 

Optimize 
Handles

When the envelope has very wide angle corners, the Bezier handles for these points may be almost 
aligned, but not exactly. With this option enabled, Bezier handles that are almost aligned will be 
automatically aligned.
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Parameter Description

NOTE 

When two Bezier handles for a point are aligned, the point does not act as a corner, but 
rather as a control point for the curve of the shape. Rotating a handle that is aligned with the 
opposite handle also rotates the opposite handle, making sure that the point does not become 
a corner. You can rotate one of the handles independently from the other by holding the Alt 
key.

Buttons

Parameter Description

Create 
Envelope

Automatically generates a deformation chain around the artwork in the current layer, using the 
parameters in this dialog box. The deformation chain will be placed as a parent of the current layer.
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Export Layout Image Dialog Box 
The Export Layout Image dialog box allows you to export your drawings as bitmap images matching the scene 
resolution size, taking camera motions into account, to paint them in an external bitmap editing software.

Access Method

 1. From the top menu, select one of the following:

 l File > Export > Layout Image to export all the elements in your scene to the layout 
.psd file.

 l File > Export > Layout Image from Selection to export only the selected elements. 

The Export Layout Image dialog box opens.

Parameter Description

Destination Path
Use the Browse button to select a location to save your layout and name the 
resulting .psd file.

File Pattern Automatically puts the name of the scene and/or the frame number in the name of 
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the file you create.

Image Size

The size of the .psd image file that will be exported. The resulting image will be 
72 dpi as the standard television resolution and its size in pixel will fit your scene 
resolution settings. i.e HDTV, NTSC, PAL, etc. Note that if you have a camera 
movement going over the normal camera frame limit, for example a pan, the 
image will be bigger.

Options

Image Format: Drop list with all formats listed alphabetically. 

 l BMP

 l DPX

 l DTEX

 l EXR

 l JPG

 l OPT

 l PAL

 l PDF

 l PNG

 l PSD

 l SCAN

 l SGI

 l TGA

 l TIF

 l TVG

 l VAR

 l YUV

Colours: Drop list with colour modes. Available modes depend on the selected 
file type.

 l Greyscale

 l Colour

 l Colour + Alpha

Depth (bits/channel): Drop list with bit depth value and a label next to it 
"bits/channel". Available bit depth depends on the selected file type.

 l 8

 l 10
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 l 12

 l 16

Compression: Drop list that appears for EXR only.

 l Zip (per scanline)

 l Zip (16 scanlines)

Inverted Channels: A checkbox that appears for DPX only.

Export Camera Frame: Prints the first and last camera frame of each scene into 
the exported layout images. If exporting in .psd format, the camera frames will be 
printed on a separate layer. 

Add a Camera Frame for Each Keyframe: If a scene contains a camera 
movement with more than two keyframes, this prints each camera keyframe into 
the layout.

Label Camera Frame: Adds the camera position label in the top-left corner of 
each camera frame. Camera frames are labeled with a letter of the alphabet 
indicating their respective order.

 

Expand Render Area: Expands the area to render into the layouts. By default, 
only the area of the scene that is covered by the camera is rendered, and exported 
layout images are cropped at the edges of the camera frames. If enabled, this 
option adds space around the render area and captures extra details outside the 
camera frames. By default, the render area is expanded by 10%. You can use the 
input field to the right of the option to change this ratio.

Scale Image: Ensures that when a camera close-up is included in a scene, the 
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exported image is larger so that the closest camera frame is at least the size of the 
chosen image size. This way, the layout does not appear pixelated when zooming 
in on the closest camera frame. If disabled, the size of the exported images will 
be based off the chosen Base Image Size and Expand Render Area options.

Maximum Size: If the Scale Image Up to Smallest Camera Frame option is 
enabled, this ensures images do not get scaled up too much. If enabled, images 
will be limited to 4096 pixels in width and height by default.

 

Vector Options

If you export one or more vector-based drawing layers in your layout image, you 
have the option to export only the drawing layers you want. Enable or disable the 
following options to export or prevent the export of the corresponding art layers.  

Overlay: Exports the art in the Overlay layer of the drawings to be exported to the 
layout image.  

Line Art: Exports the art in the Line layer of the drawings to be exported to the 
layout image.  

Colour Art: Exports the art in the Colour layer of the drawings to be exported to 
the layout image.  

Underlay: Exports the art in the Underlay layer of the drawings to be exported to 
the layout image.
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Export OpenGL Frames Dialog Box
The Export OpenGL Frames dialog box allows you to export your scene as a sequence of images as they appear 
in the OpenGL View mode of the Camera view. This means they are exported without effects, antialiasing and 
proper compositing. This allows you to quickly preview the animation in your scene without having to wait 
through the full rendering process.

How to access the Export to OpenGL Frames dialog box

 1. In the top menu, select File > Export > OpenGL Frames.

Parameter Description

Output

Location

The directory in which to export the frames or movie file. 

You can click Browse... to open a dialog allowing you to navigate your file system and 
select a directory.

Filename

The name of the file to export. 

If you are exporting frames, the file name of each frame will start with this value, 
followed by the number of the frame. 
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Parameter Description

Format

Frames Exports each frame as an individual image file. 

Suffix Allows you to select the number of digits in the number used to identify each frame.

Drawing 
Type

Format Specification Description

TVG                                              

Toon Boom Vector Graphic (*.tvg)

Toon Boom's proprietary format for storing vector 
drawings. TVG images contain vector shape, colour 
and texture information.

NOTE 

To export TVG files, your Write node 
must be connected to a vector drawing 
layer or to a vector composite node. 
The exported TVG files will contain the 
vector and bitmap drawing information, 
but will ignore  effects and 
deformations. 

TGA                                              Full colour

Truevision TGA/TARGA (*.tga)

A standard image format with lossless compression 
and support for transparency. 

TGA files use more disk space than PNG files, but 
rendering in TGA is faster. 

TGA1                                              Greyscale

TGA3                                              Full colour

TGA4                                              
Full colour 
with 
transparency

SGI                                              
Full colour / 
8 bits per 
channel Silicon Graphics Image (*.sgi)

A highly capable format with lossless compression as 
well as support for double precision and transparency.

SGI1                                              
Greyscale / 8 
bits per 
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Parameter Description

Format Specification Description

channelchannelchannel

SGI3                                              
Full colour / 
8 bits per 
channel

SGI4                                              

Full colour 
with 
transparency 
/ 8 bits per 
channel

SGIDP                                              
Full colour / 
16 bits per 
channel

SGIDP3                                              
Full colour / 
16 bits per 
channel

SGIDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

PSD                                              
Full colour / 
8 bits per 
channel

Photoshop Document (*.psd)

An Adobe Photoshop proprietary format used for 
image editing. 

PSD files exported by Harmony contain a single 
background layer with the rasterized image. 

NOTE 

PSD files exported from Harmony are 
tagged with their colour space 
information in their metadata, except 
for PSD files exported in greyscale. 

PSD1                                              
Greyscale / 8 
bits per 
channel

PSD3                                              
Full colour / 
8 bits per 
channel

PSD4                                              Full colour 
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Parameter Description

Format Specification Description

with 
transparency 
/ 8 bits per 
channel

with 
transparency 
/ 8 bits per 
channel

with 
transparency 
/ 8 bits per 
channel

PSDDP                                              
Full colour / 
16 bits per 
channel

PSDDP1                                              
Greyscale / 
16 bits per 
channel

PSDDP3                                              
Full colour / 
16 bits per 
channel

PSDDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

YUV                                              

Y'UV frame (*.yuv)

A legacy format optimized for NTSC television. The 
image information is encoded in the Y'UV color space, 
which means Luma (Y') and Chrominance (UV). 

NOTE 

YUV images must be exported in NTSC 
resolution (720 x 540), or they will not 
be legible.

PAL                                              
PAL frame (*.pal)

A legacy format optimized for PAL television.
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Parameter Description

Format Specification Description

NOTE 

PAL images must be exported in PAL 
resolution (768 x 576), or they will not 
be legible. 

SCAN                                              

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used by Scan to 
store scanned image information along with its 
registration (peg), resolution and field chart metadata. 
SCAN files are in gresycale. 

PNG                                              
Full colour / 
8 bits per 
channel

Portable Network Graphics (*.png)

A highly portable image format with high lossless 
compression as well as support for transparency and 
double-precision. PNG is typically used for Web 
applications, graphical user interfaces and image 
sharing. 

Rendering in PNG takes more time than rendering in 
TGA or in uncompressed image formats, but saves a 
lot of disk space. 

NOTE 

PNG files exported from Harmony are 
tagged with their colour space 
information in their metadata.

PNG4                                              

Full colour 
with 
transparency 
/ 8 bits per 
channel

PNGDP                                              
Full colour / 
16 bits per 
channel

PNGDP3                                              
Full colour / 
16 bits per 
channel

PNGDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

JPG                                              
Jpeg (*.jpg)

A very compact image format with lossy compression. 
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Parameter Description

Format Specification Description

It is typically used for Web pages and photo sharing. 
Because it does not preserve image quality, it is 
recommended to never render in Jpeg format unless 
you are exporting stills for a Web page or are making 
quick render tests. 

BMP                                              Full colour
Bitmap (*.bmp)

A standard uncompressed image format commonly 
used on Microsoft operating systems. BMP4                                              

Full colour 
with 
transparency

OPT                                              Full colour

Toon Boom Optimized image (*.opt)

A legacy Toon Boom proprietary format that stores 
bitmap image data with lossless compression. It 
supports transparency.

OPT1                                              Greyscale

OPT3                                              Full colour

OPT4                                              
Full colour 
with 
transparency

VAR                                              

Toon Boom Variable Header image (*.var)

A legacy Toon Boom proprietary format that stores 
greyscale bitmap image data with lossless 
compression.

TIF                                              

Tagged Image File Format (*.tiff)

An image format with many compression and 
encoding settings. It is often used for image exchange 
in visual arts and publishing.

TIFF images exported by Harmony are uncompressed, 
encoded on a per-pixel (interleaved) basis in PC byte 
order. 

DPX                                              
8 bits per 
channel / 
Full color / 

Digital Picture Exchange (*.dpx)

A professional photo format that supports various 
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Parameter Description

Format Specification Description

RGB channel 
order

different approaches to storing colour information, 
which can be used for storing, exchanging and editing 
raw information recorded by cameras. It is commonly 
used in film production. 

DPX3_8                                             

8 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_10                                             

10 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_12                                            

12 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_16                                           

16 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_10_
INVERTED_
CHANNELS                                             

10 bits per 
channel / 
Full color / 
BGR channel 
order

DPX3_12_
INVERTED_
CHANNELS                                             

12 bits per 
channel / 
Full color / 
BGR channel 
order

DPX3_16_
INVERTED_

16 bits per 
channel / 
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Parameter Description

Format Specification Description

CHANNELS                                             
Full color / 
BGR channel 
order

CHANNELS                                             
Full color / 
BGR channel 
order

CHANNELS                                             
Full color / 
BGR channel 
order

EXR                                              
16 lines Zip 
compression

OpenEXR (*.exr)

A highly capable deep image format. Each pixel in an 
EXR file is exported with its Z-depth information. 
Additionally, if a pixel is semi-transparent, the color 
and depth information of pixels further back is stored 
along with it. If your scene has multiplane or 3D 
elements, this format can be used for compositing 
your animation with other graphical elements in 3D 
animation software.

NOTES 

 l OpenEXR files exported from 
Harmony are tagged with the 
white point and primaries 
coordinates for their colour 
space.

 l OpenEXR files are always 
exported by Harmony always 
have 1 line Zip compression if 
they contain a 3D image.

EXR_ZIP_
1LINE

1 line Zip 
compression

PDF                                              

Portable Document File (*.pdf)

Typically, PDF files are used to store, archive, share 
and print documents. However, Harmony uses the 
PDF format for its capability to store bitmap images 
and vector graphics.

If the write node is connected to a vector drawing 
layer or to a vector composite, the exported PDF files 
will contain the image as a vector graphic. It will 
ignore bitmap layers, effects and deformations. 
Otherwise, the PDF files will contain the rendered 
image as a bitmap.

DTEX                                              Deep Texture (*.dtex)
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Parameter Description

Format Specification Description

A commonly used deep image format. Each pixel in an 
DTEX file is exported with its Z-depth information. 
Additionally, if a pixel is semi-transparent, the color 
and depth information of pixels further back is stored 
along with it. If your scene has multiplane or 3D 
elements, this format can be used for compositing 
your animation with other graphical elements in 3D 
animation software.

NOTE 

Exporting in Deep Texture requires 
RenderMan to be installed on the 
machine and the path to RenderMan 
properly configured in Harmony. For 
more information, see the Setting 3D 
Renderer Paths topic of the User 
Guide.

Image Format

Drop list with all formats listed alphabetically. 

 l BMP

 l DPX

 l DTEX

 l EXR

 l JPG

 l OPT

 l PAL

 l PDF

 l PNG

 l PSD

 l SCAN

 l SGI

 l TGA

 l TIF
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Parameter Description

 l TVG

 l VAR

 l YUV

Colours

Drop list with colour modes. Available modes depend on the selected file type.

 l Greyscale

 l Colour

 l Colour + Alpha

Depth 
(bits/channel)

Drop list with bit depth value and a label next to it "bits/channel". Available bit depth 
depends on the selected file type.

 l 8

 l 10

 l 12

 l 16

       

Compression

Drop list that appears for EXR only.

 l Zip (per scanline)

 l Zip (16 scanlines)

Inverted Channels A checkbox that appears for DPX only.

Movie Exports the frames into a movie file. 

Movie 
options

Opens the movie settings dialog box for your selected video format, in which you can set 
the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on Windows: Movie Options Dialog Box (macOS),

 l QuickTime Movie (*.mov) on macOS: QuickTime Movie Settings Dialog Box 
(Windows)

 l Windows Media Video (*.wmv): Windows Media Video Settings Dialog Box 
(Windows)
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Parameter Description

NOTE 

This button is available on Windows and macOS only.

Video 
options 

Opens the video settings dialog box, which allows you to set the video compression 
settings for your video file—see OpenQuickTime Video Options Dialog Box (GNU/Linux).

NOTE 

This button is available on GNU/Linux only.

Sound 
options 

Opens the audio settings dialog box, which allows you to set the audio compression 
settings for your video file—see OpenQuickTime Sound Options Dialog Box 
(GNU/Linux). 

NOTE 

This button is available on GNU/Linux only.

Movie Format

Allows you to choose one of the following movie formats:

 l QuickTime ProRes Movie (*.mov): The Apple QuickTime format. This is the 
default export format and is recommended for its portability, and also because it 
allows you to choose among several video codecs.
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Parameter Description

NOTES 

 l On Windows, Apple QuickTime must be installed to allow 
Harmony to export QuickTime movies. You can configure the 
export of QuickTime movies to use any codec that is compatible 
with QuickTime, including H.264, MPEG-4 and Animation.

 l On macOS, Harmony uses Apple AVFoundation to export 
QuickTime movies, which allows you to export using codecs 
such as H.264, Apple ProRes 422 and Apple ProRes 4444, 
among others.

 l If you are looking to export a QuickTime movie with 
transparency, be sure to choose a codec that supports encoding 
with an alpha channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime library to 
export QuickTime movies. This only allows you to export videos 
in non-proprietary formats such as Motion-JPEG, Photo JPEG, 
PNG or Uncompressed (RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 codec, which 
is supported by most web browsers.

NOTES 

 l Using this format does not require additional software. However, 
if this is the first time you export a movie in H.264/MPEG-4 
format, you will be prompted to download the OpenH264 library 
from Cisco. Simply click Yes when prompted, and Harmony will 
automatically download the library, then export the movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 4096×2304. Each 
dimension must be a multiple of 16 pixels. 

 l Audio exported in this format is encoded in PCM 16-bit stereo, 
22.05 kHz.

 l Windows Media Video (*.wmv): The native format for Windows Media Player.

NOTES 

 l Windows Media Video (.wmv) files can only be exported on 
Windows. 

 l Video players and editors on non-Windows systems can 
generally not open Windows Media Video (.wmv) files.
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Parameter Description

 l Flash (.swf)

 l Image sequence in Jpeg (.jpg), Targa (.tga) or Portable Network Graphics (.png) 
format.

Options

Open in 
Player

If checked, the exported images or movie will be opened after the export is finished:

 l If you are exporting frames, they will be opened in the Play application.

 l If you are exporting a movie, it will be opened in your operating system’s movie 
player.

Resolution

Allows you to specify a resolution to export in, relative to your scene's actual resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as your 
scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width and 
height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width and 
height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width and 
height.

 l Custom: Allows you specify the preferred resolution of your exported video file, 
in pixels, in the Width and Height fields.

Range

Allows you to specify the range of frames in your scene to export:

 l All Frames: Exports all the frames in your scene.

 l From / to: Allows you to specify the frame range to export using the two input 
fields to the right. The first input field is for specifying the first frame to export, 
and the second one is for specifying the last frame to export. All the frames in-
between, including the ones specified, will be exported.

 l Current Frame: Exports the current frame only.

 l Selected Frames: Allows you to select which frames to export. You can enable 
or disable exporting a specific frame by clicking on it. You can also toggle 
exporting a range of frames by clicking and dragging over that range in the list. 

OK Exports OpenGL frames with the selected settings and closes the dialog box.
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Parameter Description

Cancel Closes the dialog box without exporting anything.
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Export Soundtracks Dialog Box
The Export Soundtracks dialog box lets you export a sound file to use it in another application, such as an 
editing software. Harmony allows you to export sound files as a merged soundtrack or as a series of individual 
files. The exported soundtracks are generated as *.wav files.

How to access the Export Soundtracks dialog box

 1. From the top menu, select File > Export > Soundtrack.

The Export Soundtracks dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Export Range

All Exports the sound over all the frames of your scene.

Frames Sets the start and end frames in the corresponding fields on the right.

Options

Process Soundtracks 
Individually

Each soundtrack from all layers is exported as individual files.
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Merge All 
Soundtracks

One single file is created, combining all the sound files you imported in your 
scene. Note that it will only use the sound files in the selected frame range set in 
the Export Range section. If you selected to export all the frames, all the sound 
files will be processed.

Sound Settings

Rate Lets you set the rate of the soundtrack.

Size Lets you export the soundtrack at 8 or 16 bits.

Use Lets you export the soundtrack as mono or stereo.
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Export to Animated GIF Dialog Box
Using the Export to Animated GIF dialog box, you can export your scene, or an excerpt of it, as an animated GIF 
image. 

Animated GIFs are a portable format commonly used for exchanging short animations and clips on the web. 
They can be played in any web browser and in many image viewers. 

Animated GIFs are a convenient sharing format, but they are not a publishing format. They are not as 
optimized for fast download and playback as movie files, cannot contain audio and, most importantly, can only 
contain up to 256 different colours throughout the entire animation. Hence, if your animation contains textures 
or gradients, it is likely to lose quality when exported as an animated GIF, as Harmony will have to limit the 
amount of different colours used in the exported image. 

NOTE 

For steps on how to use the Export to Animated GIF dialog box, see the User Guide.

How to access the Export to Animated GIF dialog box

 1. In the top menu, select File > Export > Animated GIF.

The Export to Animated GIF dialog box appears. 
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Parameter Description

Output                     

Output The full path and file name of the GIF file to export.

Browse 
Opens a dialog allowing you to browse to the desired export directory and enter 
the desired file name. 

Display Source

Export from Display 
Node

Allows you to select the display node from which to render your scene.

NOTE 

If there is no Display node in your scene, the only available option will be 
Display All. This renders all the nodes in your scene, including ones that 
are not connected to anything. You can add other Display nodes to your 
scene and connect them under specific parts of your scene to be able to 
render these parts only.

Export Range

All Exports all the frames in your scene.

Frames Allows you to specify a range of frames to render. 

Resolution

Resolution list

Lets you specify a resolution to export in relative to your scene's actual 
resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as 
your scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width 
and height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width 
and height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width 
and height.

 l Custom: Allows you specify the preferred resolution of your exported 
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Parameter Description

video file, in pixels, in the Width and Height fields.

Width
If you selected the Custom resolution, use this field to specify the width, in 
pixels, of the exported movie. 

Width
If you selected the Custom resolution, use this field to specify the height, in 
pixels, of the exported movie. 

Options Options

Dithering

Since GIF images can only have up to 256 colours, you have the option to add 
dithering to the rendered image. Dithering blends pixels of different colours 
where the image contains gradients to simulate colours that do not exist in the 
GIF image's colour palette. 

 l None: No dithering will be applied. Each pixel rendered is rendered with 
the colour in the palette that is the closest to its actual colour. 

 l Diffusion: Blends pixels in irregular patterns to blend pixels and simulate 
the colour as closely as possible. 

 l Pattern: Blends pixels in regular checkered patterns to simulate the 
colour without created clusters of pixels. 

Loop
If this option is checked, the exported GIF animation will loop when previewed in 
web browsers and other image viewers that support animated GIFs. Otherwise, it 
will only play once and stop. 
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Export to Easel JS Dialog Box
The Export to Easel JS window lets you flatten an image sequence of your animation. Even if you have a fully 
rigged puppet or a single drawing layer with your animation sequence, the outcome will still be a flattened 
output of each frame, grouped together in your sprite sheet. This allows for more flexibility and freedom of 
work as you have access to any tools or effect modules you want to use. However, this can result in heavier files 
depending on the length, complexity and export size of your animation.

How to access the Export to Easel JS window

 1. Select Windows > Toolbars > Game.

 2. Click the Export to Easel JS  button.

Parameter Description

Select Directory
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Save Path The folder path where you want to save your export.

Save Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder Displays the clips in the folder.

Scene Options

Display

Here, you must select the Display of your character. This is the one that will be 
used to render out all of the information attached to that Display node. If the 
Unconnected_Display option is selected, all of the visual information in your 
scene will be rendered out.

Sprite Sheet Preferences

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.

Max Height

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, 
only 2 of those pixels need to be different from my other drawing in order to 
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create a new one. The higher the threshold, the fewer similar drawings you will 
have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.
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Export to Flash Movie Dialog Box
The Export to Flash Movie dialog box lets you export your animation as a Flash (.swf) movie.  

How to access the Export to Flash Movie dialog box

 1. From the top menu, select File > Export > SWF.

The Export to Flash Movie (.swf) dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Display Source
Lets you select a Display node to read from in the Export From Display Node 
menu.

Export Range

All Exports all the frames of your movie.

Frames Export a frame range which you specify
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Options

Frame Rate
Lets you enter a Frame rate (fps). By default, it will be set to match the fps of your 
Harmony project. If you choose a lower frame rate, your export playback will be 
faster than your actual project. The reverse is also true for a higher frame rate. 

Jpeg Quality

Lets you select a JPEG quality:

‣ 100 = Full quality

‣ 50 = Average quality at about 1/5th of the size.

‣ 25 = Medium quality where loss of high image resolution starts to 
occur.

‣ 10 = Low quality where “macro-blocking” or large pixelation become 
obvious.

‣ 1 = Lowest quality where there is extreme loss of colour and detail 
and the image becomes nearly unrecognizable. 

Protect from Import Prevents the movie from being imported into another application.

Convert Pencil Lines 
to Brush Lines

Retains the thickness of pencil lines.

Compress Movie
Compresses the movie for a lighter format. The movie may lose some quality, but 
the file will be lighter.

Do Not Export

Lets you select the effects you do NOT want to be rendered in the SWF movie.

NOTE 

Certain Harmony effects are not listed in this section as they are not 
compatible and therefore not available for SWF export. These effects will 
not appear in the SWF render. 

99

Harmony 21 Premium Reference Guide                          



Chapter 1: Dialog Boxes

Export to Video Dialog Box
The Export to Video dialog box lets you export your animation as a movie file. 

If you added burn-in information to your scene, it will be included in your exported file—see Burn-In Node on 
page 735.

How to access the Export to QuickTime Movie dialog box

 1. From the top menu, select File > Export > Movie.

Parameter Description

Output                     

Video Format

Allows you to choose one of the following movie formats:

 l QuickTime ProRes Movie (*.mov): The Apple QuickTime format. This 
is the default export format and is recommended for its portability, and 
also because it allows you to choose among several video codecs.

100



NOTES 

 l On Windows, Apple QuickTime must be installed to 
allow Harmony to export QuickTime movies. You can 
configure the export of QuickTime movies to use any 
codec that is compatible with QuickTime, including 
H.264, MPEG-4 and Animation.

 l On macOS, Harmony uses Apple AVFoundation to 
export QuickTime movies, which allows you to export 
using codecs such as H.264, Apple ProRes 422 and 
Apple ProRes 4444, among others.

 l If you are looking to export a QuickTime movie with 
transparency, be sure to choose a codec that supports 
encoding with an alpha channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime 
library to export QuickTime movies. This only allows 
you to export videos in non-proprietary formats such 
as Motion-JPEG, Photo JPEG, PNG or Uncompressed 
(RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 
codec, which is supported by most web browsers.

NOTES 

 l Using this format does not require additional 
software. However, if this is the first time you export a 
movie in H.264/MPEG-4 format, you will be prompted 
to download the OpenH264 library from Cisco. 
Simply click Yes when prompted, and Harmony will 
automatically download the library, then export the 
movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 
4096×2304. Each dimension must be a multiple of 16 
pixels. 

 l Audio exported in this format is encoded in PCM 16-
bit stereo, 22.05 kHz.

 l Windows Media Video (*.wmv): The native format for Windows 
Media Player.
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NOTES 

 l Windows Media Video (.wmv) files can only be 
exported on Windows. 

 l Video players and editors on non-Windows systems 
can generally not open Windows Media Video (.wmv) 
files.

 l Flash (.swf)

 l Image sequence in Jpeg (.jpg), Targa (.tga) or Portable Network 
Graphics (.png) format.

Output file The full path and file name of the movie file to export.

Browse 
Opens a dialog allowing you to browse to the desired export directory and 
enter the desired filename. 

Display Source

Export from Display 
Node

Lets you select the display node from which to render your scene.

NOTE 

If there is no Display node in your scene, the only available option will 
be Display All. This renders all the nodes in your scene, including ones 
that are not connected to anything. You can add other Display nodes to 
your scene and connect them under specific parts of your scene to be 
able to render these parts only.

Export Range

All Exports all the frames in your scene.

Frames

Allows you to specify the frame range to export using the two input fields to 
the right. The first input field is for specifying the first frame to export, and the 
second one is for specifying the last frame to export. All the frames in-
between, including the ones specified, will be exported.

Resolution

Resolution list Allows you to specify a resolution to export in, relative to your scene's actual 
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resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as 
your scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width 
and height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width 
and height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width 
and height.

 l Custom: Allows you specify the preferred resolution of your exported 
video file, in pixels, in the Width and Height fields.

Width / Height

Lets you specify the width and height of video file you wish to export, in 
pixels. To preserve your scene's aspect ratio, changing the value of the Width 
or Height field will automatically update the other field with a proportional 
value. 

Colour Space

The colour space in which to render your movie. The rendered frames will be 
converted from your scene’s working colour space to the selected colour 
space.

The following colour spaces are supported in Harmony:

 l Scene Working Colour Space: The same colour space as the one 
selected in the Colour Space tab of the Scene Settings dialog. 

 l Linear: The same primaries and white point as sRGB and Rec. 709, but 
with no gamma transfer curve applied to the colour values. This colour 
space is useful for compositing intermediary images that are meant to 
be rendered in sRGB or Rec. 709.

 l Display P3: A colour space commonly used for digital projection. It 
has the same primaries as DCI-P3, the same white point as sRGB and 
the same gamma transfer curve as sRGB.

 l Display P3 Linear: The same as Display P3, except with no gamma 
transfer curve. This colour space is useful for compositing 
intermediary images that are meant to be rendered in Display P3.

 l Rec. 709: The colour space used for HDTV. It has the same primaries 
and white point as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with 
a gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space 
exists because some editing systems use a gamma transfer curve of 
2.4 instead of the standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). 
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It has a complex gamma transfer curve and primaries that cover more 
of the human-perceivable colour space than other colour spaces, 
especially in the area of human-perceivable greens. 

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a 
simple gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour 
space exists because some editing systems use a gamma transfer 
curve of 2.4 instead of the standard gamma curve for Rec. 2020.

 l Rec. 2020 Linear: The same colour space as Rec. 2020, except with 
no gamma transfer curve. This colour space is useful for compositing 
intermediary images that are meant to be rendered in Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. 
It has the same primaries and white point as Rec. 709, but has a 
different gamma transfer curve.

Options

Movie Options

Opens the movie settings dialog box for your selected video format, in which 
you can set the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on Windows: Movie Options Dialog Box 
(macOS),

 l QuickTime Movie (*.mov) on macOS: QuickTime Movie Settings Dialog 
Box (Windows)

 l Windows Media Video (*.wmv): Windows Media Video Settings 
Dialog Box (Windows)

NOTE 

This button is available on Windows and macOS only.

Video Options 

Opens the video settings dialog box, which allows you to set the video 
compression settings for your video file—see OpenQuickTime Video Options 
Dialog Box (GNU/Linux).

NOTE 

This button is available on GNU/Linux only.

Sound Options 
Opens the audio settings dialog box, which allows you to set the audio 
compression settings for your video file—see OpenQuickTime Sound Options 
Dialog Box (GNU/Linux). 
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NOTE 

This button is available on GNU/Linux only.
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Export to Sprite Sheet Dialog Box
The Export to Sprite Sheets window export to multiple resolutions, generating multiple .xml files and one or 
multiple sprites sheets depending how many sprite resolutions you defined.

This saves different animations of the same character into the same name. For example, if there's an idle, run, 
and jump animation, these should all share the same Save Name. You can think of it as the overall collection of 
animations. Inside are the different saved scene versions whose drawings you can reuse for all the animations 
in that character set. Each scene version will be displayed as an item in the list.

When you export an animation, only the drawings used in that scene are exported. All the drawings are 
exported individually first and then atlased together into a sprite sheet.

If you saved multiple animations to the same Save Name (i.e. SpaceDuck: run, idle), then it will reatlas the 
sprite sheet to include all the drawings from all the animations in that folder, creating a new animation file, but 
reusing the same skeleton.

How to access the Export to Sprite Sheets window

 1. Select Windows > Toolbars > Game.
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 2. Click the Export to Sprite Sheets  button.

Parameter Description

Select Directory

Asset Path The folder path where you want to save your export.

Asset Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder

Preview Window
Displays a list of pre-existing clips in the same export folder location, most  likely 
exported there from a previous time.

Use Scene Markers to 
Export Clips

Uses scene markers to define the export range, instead of exporting the entire 
scene.

Project Settings

Unit Scale

Lets you change the scale when exporting to Unity to accommodate the size of 
the export without it affecting the Harmony scene. This helps you resize assets 
properly for Unity without having to resize them in Harmony. The basic scale is 
one Animation Field for one Unity unit.

Preset
Lets you select the unit conversion from Harmony to Unity, by selecting one of 4 
presets. Note: a field is a unit of measure in traditional animation grid.

Sprite Sheet Preferences

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.
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Max Height
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, 
only 2 of those pixels need to be different from my other drawing in order to 
create a new one. The higher the threshold, the fewer similar drawings you will 
have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.

Delete Existing Clips Select this option to delete any pre-existing clips in the export location.

Bake Animation Curves
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.

Clear Texture Folder
Removes any information from the texture folder within the Harmony file. This 
has no incidence towards the Unity export but contributes to a lighter Harmony 
file.
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Expression Dialog Box
In Harmony, you can use expressions to automate the calculation of effect values based on the values in 
another function. An expression is a mathematical formula that allows you to manipulate the value in the 
source function to create new values for the destination effect.

The Expression dialog box is where you write expressions. It's a simple text editor that can handle incomplete 
or invalid JS programs although they will not be evaluated. Harmony can save and load invalid JS programs.

The Expression editor evaluates the current script at the current global frame and reports any errors or returns 
the numerical result of the program.

How to access the Expression dialog box

 1. In the Xsheet view menu, select Columns > Add Columns or press Shift + C.

The Add Column dialog box opens.

 2. In the Name field, type a name for the column.

 3. From the Type menu, select Expression and click OK.

 4. Double-click on the column's header to open the Expression dialog box.
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The Expression dialog box opens.

Parameter Description

Name
Indicates the name of the expression column in the Xsheet. You can edit this 
name.

Description field Area in which you can type in expressions.
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Extend Exposure Dialog Box
The Extend Exposure dialog box lets you extend the exposure of a selected cell in the Timeline or Xsheet. 

How to access the Extend Exposure dialog box

 1. Select a cell and do one of the following:

 l From the top menu, select Animation > Cell > Extend Exposure.

 l Press F5.

The Extend Exposure dialog box opens.

Parameter Description

Extend to Frame
Lets you enter the frame up to which you want to extend the exposure. You can 
expose the drawing in the frames and replace the drawings that were originally 
there or move the subsequent frames forward in time.

Overwrite
Lets you expose the drawing in the frames and replace the drawings that were 
orginally there.

Insert
Lets you expose the drawing in the frames and move the subsequent frames 
forward in the Timeline view.
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Fill Cells Randomly Dialog Box
The Fill Cells Randomly dialog box lets you Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to choose the random values from. The 
selection can be over one cell or a cell range in one column or more or an entire column or many entire columns.

How to access the Fill Cells Randomly dialog box

 1. Do one of the following:

 l Select Animation > Cell > Fill Cells Randomly.

 l In the Xsheet view, click the Fill Cells Randomly  button  (you may have to 
customize the toolbar to display it).

The Fill Cells Randomly dialog box opens.

Parameter Description

Minimum Value The lowest value to be used in the randomized exposure or keyframe value.

Maximum Value The highest value to be used in the randomized exposure or keyframe value.

Hold The exposure holding value.

Whole Numbers
If you are applying this to a drawing column, this option lets you avoid having 
decimal points.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection.
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Fill Exposure Using Render Changes Dialog Box
The Fill Exposure Using Render Changes dialog box lets you detect if a threshold of changes has occurred 
between two consecutive images and then expose the affected textures for further processing. It can be used 
for example to change the texture on a characters shirt only when the shape of the shirt is changed 
significantly from the previous frame.  This avoids unnecessary repetitive texture changes on every frame.

How to access the Fill Exposure Using Render Changes dialog box

 1. In the Timeline view, select the textures or live-action sequence.

 2. From the top menu, select Scene > Default Display > desired Display node.

 3. From the top menu, select Animation > Exposure Fill > Using Render Change.

Wait while Harmony creates a low resolution render of the images to preview.
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 4. In the Fill Exposure Using Render Changes window, use the Frame slider to view the motion 
change analysis.

 5. Based on your style preference, adjust the parameters to assign when the texture exposure 
changes will occur. You can adjust the type of filter to use for the motion detection, as well as 
threshold values to indicate what will be considered a big enough motion variation for an exposure 
change. 

Parameter Description

Changes Detection Settings

Frame: Use the slider to see when a change is necessary. A red edge indicates 
there is a large enough motion for the texture to change.

Use: Lets you use either the Red, Green, Blue, or Alpha channel, or Luminance 
difference between frames to analyze the motion changes. The Alpha channel is 
selected by default as it is the most commonly used parameter.

Pixel Value Change Threshold: The percentage of change in a pixel to be 
considered different from one frame to another. The higher the value, the more 
change is required when comparing two images in order for a new texture to be 
used.

Area Change Threshold: The percentage of non-empty pixels that must change 
from one frame to another to be considered different.

Fill Settings

These settings let you change the exposure. You can also decide on how many 
images you want to cycle. 

First/Last Frame: Lets you set the first and last frame for the exposure change. 
You can set this for the entire scene or for part of the scene (frames 20 to 32 for 
example).

Number of Drawings in Cycle: Lets you set of the number of drawings to 
include in the cycle.
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First Drawing Used in Cycle: Lets you set the first drawing used in the cycle. 
Your drawings must be named using numeric values only, or number values with 
a prefix or suffix. It cannot only be letters.

Drawing Name Prefix: Adds a prefix before the number. For example, texture_
01, texture_02 and so on.

Drawing Name Suffix: Adds a suffix after the number. For example, 01_texture, 
02_texture and so on.
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Fill Selection Dialog Box
The Fill Selection dialog box lets you Lets you fill the same value over an entire selection. The selection can be 
over one cell, a cell range in one column, a cell range over many columns, an entire column, or many columns. 
You can use numbers, words, letters, or any alphanumeric value.

How to access the Fill Selection dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 1. Do one of the following: 

 l From the top menu, select Animation > Cell > Fill Selection. 

 l In the Xsheet toolbar, click the Fill Selection  button. Note that you may have to add this 
button to your toolbar by right-clicking on it and selecting Customize.

 l Press Ctrl + T (Windows/Linux) or ⌘  + T (macOS)).

The Fill Selection dialog box opens.

Parameter Description

Value This is the value to be used in the filled selection.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection. 
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Function Wizard Dialog Box
The Function Wizard dialog box allows you to easily create Master Controller widgets that are programmed to 
control specific attributes in a node. It works by letting you select a type of widget, a type of operation, one or 
several nodes and the node attribute to control, and generates a fully functional Master Controller node that 
controls the selected attribute in the selected nodes. 

The Function Wizard automatically generates the script to make your Master Controller work, so you don’t 
need to have scripting knowledge to use this wizard. However, it also allows you to customize the script it 
generates from within the wizard. Hence, users who are familiar with Harmony scripting can easily change or 
expand the capacities of the Master Controller they’re creating. They can use this wizard to create a “basic” 
Master Controller and use it as a foundation to develop a much more complex Master Controller. Users who are 
less familiar with scripting can also look at the script generated to learn how scripting with Master Controllers 
works. 

To use the Function Wizard, you must first identify and select a node for which you want to create a widget. 
The resulting widget, which will appear in the Camera View, can be configured to perform the following 
operations:
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 l Control the value of one of a node’s numerical (scalar) attributes (e.g., horizontal position, vertical 
position, etc.)

 l Control the value of one of a node’s 2D (vector) attributes (e.g., position, scale, etc.)

 l Toggle whether a node is enabled or disabled

 l Show or hide the controls for a node

 l Show or hide the deformation controls for a deformation chain

How to access the Function Wizard

 1. Add the Master Controller toolbar to your workspace by doing one of the following:

 l Right-click on an existing toolbar and select Master Controller.

 l In the top menu, select Windows > Toolbars > Master Controller.

The Master Controller toolbar appears.

 2. In the Node or Timeline view, select the nodes that you want to control with a Master Controller. 

 3. In the Master Controller toolbar, click the  Function Wizard button.

Icon Parameter Description

 
Controller 
Type

The type of Master Controller widget to create. The Function Wizard can generate a 
widget of the following types:

 l Checkbox: A simple controller that has two states: checked or unchecked. 
The user can toggle its state by clicking on it.

 l Slider: A controller consisting of a point that can be moved vertically within a 
range. It returns a value based on where the point is positionned within that 
range.

 l Point2d: A controller consisting of a point that can be moved horizontally and 
vertically within a rectangle. It returns the position of the point within that 
rectangle, in x and y coordinates.
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Icon Parameter Description

  Operation

The operation to execute on the selected nodes, on their selected attribute, when the 
user manipulates the widget. Depending on the selected controller types, the 
following operations are available:

 l CheckboxWidget:

 l Toggle Attribute: Toggles one of the boolean attributes of the target 
nodes to true or false, depending on whether the checkbox is checked 
or unchecked.

 l Show/Hide Node Controls: Toggles whether the controls for the 
target nodes are visible in the Camera view. 

 l Enable/Disable Nodes: Toggles whether the target nodes are enabled 
or disabled. Disabled nodes have no effect on the rendered image. For 
example, disabled Element nodes are invisible, disabled Peg nodes do 
not offset the elements attached under them, and disabled effect 
nodes output their input image as-is, without applying an effect to it.

 l Show/Hide Deformers: Toggles whether the controls for the 
deformers in the target nodes are visible in the Camera view.

 l Point2dWidget:

 l Set Value: Sets the value of an attribute for the target nodes based on 
the X and Y coordinates of the 2D point within its bounding box. 

NOTES 

In the case of Point2d widgets, the target attribute must be a 
vector-type attribute, which means it must have X and Y child 
attributes, so that these child attributes can be set to the value 
of the X and Y coordinates of the 2D point. 

For example, a 2D point widget can be used to manipulate the 
position or the scale of a Peg or Element node, as those 
attributes have X and Y child attributes. 

 l SliderWidget:

 l Set Value: Sets the value of a numerical attribute for the targets 
nodes, based on the position of the point within the slider. Contrary to 
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Icon Parameter Description

Point2D widgets, the Slider widget can manipulate any single 
numerical (scalar) attribute for the target nodes. 

 
Target 
Nodes

The list of nodes that the Master Controller will affect. When you open the Function 
Wizard, this list is automatically filled with the currently selected nodes in your 
scene. The list of target nodes can be edited using the buttons just below it. 

NOTES 

 l If multiple nodes of different types are added to the Target Nodes 
list, only attributes that are common to all the target nodes can be 
manipulated. As such, it is recommended to only add nodes of the 
same type to the Target Nodes list.

For example, if you add both Peg and Element nodes to the Target 
Nodes list, you will not be able to manipulate their position with 
your Master Controller, as the position attribute for a Peg is named 
POSITION, whereas the position attribute for an Element is named 
OFFSET. Hence, they are not considered the same attribute. 

 l If multiple nodes are added to the Target Nodes list, the first node in 
the list will serve as the “master” node. This means that the widget’s 
state or position will remain synchronized to the value of the first 
node’s target attribute.

 
Add 
Selected 
Nodes

Adds the nodes that are currently selected in the scene, whether from the Timeline 
view, Node View or Camera view, to the list of Target Nodes in the Function Wizard.

Locate 
Selected 
Node

Instantly navigates, in the Node View, to the node that is currently selected in the 
Target Nodes list, and selects it.

Remove 
Node

Remove the nodes that are selected in the Target Nodes list from the Target Nodes 
list.

Slider widget parameters
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Icon Parameter Description

  Attribute

Allows you to select which attribute in the target nodes that the slider widget will 
control. This drop-down will display all numerical (scalar) attributes available for the 
selected nodes. 

NOTE 

If several nodes of different types (i.e.: Peg, element, effect, composite, etc.) are 
in the Target Nodes list, only attributes that are common to all the target 
nodes will be available. 

  Label

The label text to display over the widget, to make it easy to identify in the Cameras 
view. 

This value is also used to name the Master Controller node that will be created. The 
Master Controller node will be named mc_ followed by the name in the Label, with 
spaces replaced by underscores (_).

  Min Value The value returned by the slider when it is set to its lowest position.

  Max Value The value returned by the slider when it is set to its highest position.

Point2d widget parameters

  Attribute

Allows you to select which attribute in the target nodes that the slider widget will 
control. This drop-down will display all vector-type attributes available for the 
selected nodes. Vector-type attributes are attributes that have X and Y sub-attributes, 
which can be set to the X and Y coordinates of the 2D point as it is manipulated.

NOTE 

If several nodes of different types (i.e.: Peg, element, effect, composite, etc.) are 
in the Target Nodes list, only attributes that are common to all the target 
nodes will be available. 
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Icon Parameter Description

  Label

The label text to display over the widget, to make it easy to identify in the Cameras 
view. 

This value is also used to name the Master Controller node that will be created. The 
Master Controller node will be named mc_ followed by the name in the Label, with 
spaces replaced by underscores (_).

  XMin
The value returned by the 2D point widget for the X coordinate when it is at its 
leftmost position.

  XMax
The value returned by the 2D point widget for the X coordinate when it is at its 
rightmost position.

  YMin
The value returned by the 2D point widget for the Y coordinate when it is at its 
bottommost position.

  YMax
The value returned by the 2D point widget for the Y coordinate when it is at its 
topmost position.

Checkbox widget parameters

  Attribute

Allows you to select which attribute in the target nodes that the checkbox widget 
will toggle. This drop-down will display all boolean-type attributes available for the 
selected nodes. 

This drop-down will be greyed out if you selected an operation that toggles 
something other than an attribute, such as Enable/Disable Nodes, Show/Hide Node 
Controls and Show/Hide Deformers. 

NOTES 

 l This drop-down will be greyed out if the Operation parameter is set 
to something other than Toggle Attribute.

 l If several nodes of different types (i.e.: Peg, element, effect, 
composite, etc.) are in the Target Nodes list, only attributes that are 
common to all the target nodes will be available. 

  Label The label text to display over the widget, to make it easy to identify in the Cameras 
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Icon Parameter Description

view. 

This value is also used to name the Master Controller node that will be created. The 
Master Controller node will be named mc_ followed by the name in the Label, with 
spaces replaced by underscores (_).

Additional parameters

 
Function 
Code

The function that is executed when the Master Controller widget is manipulated. 

This script can be edited within the Function Wizard, and any changes you make to 
the script will actually be carried over to the Master Controller that the wizard will 
create. Hence, not only this field allows you to learn what the code for a basic Master 
Controller looks like, it can also allow you to create Master Controllers that have 
more complex effects than what is supported by the Function Wizard.

TIP 

You can also modify this code at any time after you created your Master 
Controller. To make changes to this code, simply open the Layer Properties for 
the Master Controller node, and then select the UI Script tab.

  Advanced

By default, several of the target node’s attributes are hidden in the Attribute drop-
down so as to avoid cluttering it. In Advanced mode, all of the target node’s attributes 
that are compatible with your Master Controller widget will be listed in the Attribute 
drop-down, giving you more options for which attribute of the target node the Master 
Controller will manipulate. 
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Master Controller Grid Wizard Dialog Box
T-HSCP-003-006

The Master Controller Grid Wizard dialog box allows you to create a 2D point-type Master Controller widget 
which can be used to position a character model based on a grid of poses.

To use the Interpolation Wizard, you must first create enough poses to make a grid of poses. For example, key 
poses of a character's head looking in every direction can be laid out in a grid:

Once you've done that, you need to select the layers and/or groups you want your Master Controller to control 
which, in this case, would be all the layers making the character's head. Then, you can open the Grid Wizard. 
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The Wizard will start out by displaying the Load Preset dialog, in which you can specify the vertical and 
horizontal size of your grid in the Key Poses fields.

Optionally, you can also select its centre point and the size of its cells in the Center and Cell size fields. The 
coordinates used for the center position and cell size are based on a 4:3, 12 fields traditional animation grid. 
You display one over your character as a reference by adding a Grid node to your scene—see Grid Node.

Then, the Grid Wizard dialog will generate a grid with the specified size in the specified position and with the 
specified cell size. Each point in the grid will be represented by a red dot. You must select each of these dots 
and associate them with the frame number containing the pose you want the point to represent. Once a point 
is associated to a pose, it becomes green.

When you click on Create, this grid of poses will be stored in a pose database and a 2D point Master Controller 
will be created. This Master Controller will use this pose database to change your character's pose when you 
move the 2D point around in the Camera view.
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How to access the Grid Wizard

 1. Do one of the following to add the Master Controller toolbar to your workspace:

 l Right-click on an existing toolbar and select Master Controller.

 l In the top menu, select Windows > Toolbars > Master Controller. 

The Master Controller toolbar appears.

 1. In the Timeline view, select the layers and groups you want your Master Controller to control. 

NOTE 

If you select a group, all of the layers inside it will be added to the list of layers your 
Master Controller will control. 

 2. In the Master Controller toolbar, click on the  Grid Wizard button.

Grid Parameters Dialog Parameters

Parameter Description

Preset
Allows you to select and load a grid preset you previously created. If you have 
not created any, you can ignore this drop-down and set up a new grid in the 
fields below. 

Key Poses
The numbers of columns and rows with which to create the grid of poses. The 
product of these two amounts is the amount of poses you will need to provide 
to the Grid Wizard.

Center
The coordinates of the centre of the grid, relative to the centre of the scene, in 
horizontal and vertical fields. 

Cell Size The size of each cell in the grid, in horizontal and vertical fields.
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Parameter Description

OK
Dismisses the Grid Parameters dialog box and creates the grid with the 
selected parameters in the Grid Wizard dialog box, so that you can start 
configuring the points in the grid. 

Grid Wizard Dialog Parameters

Icon Parameter Description

Grid

  Grid View

Displays the grid of poses.

Each point in the grid is represented by a coloured dot:

 l Red dots are dots that need to be assigned to a pose (frame 
number). 

 l Green dots are dots that are already assigned to a pose 
(frame number). 

You must fill each point in the grid with poses, until they are all 
green, before you can create your Master Controller. 

To fill a point, simply click on it to select it. This will make the Select 
Frame dialog appears, in which you can type in the frame number to 
associate the point to.

Selecting a point makes the State Properties section of the dialog 
appears. In this section, you can change the identifier and the frame 
number of the point, and you can also modify its position in the grid. 

The grid is laid out over a standard 12 fields 4:3 animation grid. This 
grid is the same grid that displays in the Camera view if you add a 
Grid node to your scene. Hence, by adding a Grid node to your 
scene, you can use it as a reference to align the grid with specific 
areas in the scene.

You can pan around the grid view by clicking and dragging on it.

Zoom In Zooms into the grid view. 

Zoom Out Zooms out of the grid view.
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Icon Parameter Description

Load Preset

Opens the Load Preset dialog. In this dialog, you can load a grid 
preset, or create a new grid. 

To load an existing preset, select it in the Preset drop-down. To 
create a new grid from scratch, select New in the Preset drop-down 
instead.

If you click OK, the selected grid will be loaded into the Grid Wizard, 
replacing the current grid and discarding any work you put on it. If 
you click Cancel, you can resume working on the currently loaded 
grid. 

Save Preset

Saves the current grid and all of its properties as a grid preset. This 
allows you to quickly reload the current grid's size, its centre point, 
its cell size, as well as each point's assigned frame and other 
properties into the Grid Wizard later, when you want to create 
another 2D point widget. This can be very useful if you create several 
character models in different scenes, with the same poses at the 
same frames. 

You can select a grid preset to use in the Grid Parameters dialog that 
appears when you open the Grid Wizard.

Monitored Attributes

  Attribute List

The list of nodes (ie: layers, pegs, deformation points, etc.) that will 
be affected by the Master Controller. If you expand any of the listed 
nodes, you will find the list of attributes (ie: position, angle, scale, 
etc.) 

The list is structured in a group/node/attributes hierarchy, with Top 
representing the root of your scene. By expanding a group, you will 
find all of the nodes inside that group. By expanding a node, you 
will find all of its attributes. 

  Add Selected Nodes

If you first select groups nodes in the Timeline or Node view, you 
can click on this button to add these nodes' attributes to the 
Monitored Attributes list. This allows you to add more nodes to the 
list of nodes that will be controlled by the Master Controller. 
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Icon Parameter Description

If you select a group, this button will add the group as well as every 
node inside that group to the Monitored Attributes list. 

Remove Selected Items

Removes the groups, nodes or attributes that are currently selected 
in the Monitored Attributes list from the Monitored Attributes list. 
This allows you to remove nodes from the list of nodes that will be 
controlled by the Master Controller.

If you select a group, this button will remove the group as well as 
every node inside that group from the Monitored Attributes list. 

If you select specific attributes in a node, this button will only 
remove these attributes from the Monitored Attributes list, and will 
leave the other attributes in the list. This allows you to make the 
Master Controller only control specific attributes for a node and 
ignore others.

Filter Static Attributes

Remove every attribute that does not change across any of the poses 
added to the grid. This will optimize the performance of the Master 
Controller as well as reduce the amount of storage space it uses 
without impacting its functionality.

NOTE 

This option can only be used once you have filled your entire 
grid with poses.

  Node Count
The amount of nodes (layers, pegs, deformation points, etc.) that 
will be controlled by the Master Controller. 

  Attribute Count
The amount of attributes (position, angle, scale, etc.) that will be 
controlled by the Master Controller.

Pose Properties

  Identifier Allows you to type in a custom label for the currently selected point. 

  Frame
Allows you to view and update the frame number (pose) associated 
with the currently selected point.

  Position Allows you to update the position of the selected point on the grid, 
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Icon Parameter Description

in horizontal and vertical field coordinates. 

By default, all points in the grid are created to be at an equal 
distance from one another. By using these fields to edit the position 
of points, you can make a fully customized grid. 

Output

  Name
Allows you to enter the name for the Master Controller node that 
will be created at the end of the process.

  States Filename

Displays the name of the corresponding states file name, based on 
the Master Controller node name.

The attribute values of the associated poses are recorded in an 
external file. When the Master Controller node is created, the 
matching states file is created.

  Master Controller Name
Displays the complete Master Controller node name including the 
mc_ prefix.

  Create Generate the Master Controller and its database of poses. 
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Hold Timing

The Hold Timing node exists as Hold Timing (for Images) and Hold  Transformation Timing (for Pegs and 
Transformations). This node is used to apply holds to the input transformation or images, in order to expose 
certain frames for specific durations. These nodes can be used to change the exposure increments of input 
images and transformations so that the output updates at the appropriate frames. This is particularly useful for 
retiming the animated content.

The Hold Timing node takes an image input and output, and will provide the retimed transformation and 
render of that image with sections held given the settings of the node.

The Hold  Transformation Timing node takes a transformation input and output, and will provide the retimed 
transformation with sections held given the settings of the node.

How to access the Hold Timing and Hold Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.
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 l Hold Mode: Defines the mode in which the held frame transformations and renders are applied. 
You can select the value from the drop-down list.

 l Dynamic: Dynamic mode will scan all connected modules in the in-port and will also 
calculate the most reasonable timing based on all connected nodes’ attribute keyframes and 
timing. The dynamic mode aims for a maximum exposure as defined in the hold value 
attribute, and will divide up timed-sections based on attached keyframes and the 
appropriate amount of subdivisions possible in that section, while considering the timing of 
the animation.

 l Hold Value: Hold Value mode will use the value defined in the Hold Value attribute, and will 
only update the transformation or render in increments of that value. Setting a keyframe on 
this attribute will start a new section of exposures and all subsequent exposures will be 
based on the last keyframe. This is useful for retiming sections on twos and adding sections 
on ones by simply adding a keyframe.

 l Hold Between Stop-Motion Keyframes: Hold Between Stop-Motion Keyframes uses the 
keyframes and tweens in the Hold Keyframes attribute to define regions that will update 
and render new images and transformations. The node will only output the current frame 
from the input when a key, or tween, is present on that frame, otherwise it will hold the last 
value it has previously output.

 l Bake Dynamic Holds:  Bake Dynamic Holds will convert the dynamic mode to another mode that is 
static and no longer dependent on the input nodes. When clicking the Bake Dynamic Holds button, 
a prompt will request the type of mode to convert the dynamic values into. This prompt allows the 
user to select the mode into which the values are baked.

 l Hold Value: Defines the exposure increments in which the image or transformation is updated and 
output. This attribute is used when the node is in Dynamic and Hold Value mode.

 l Hold Keyframes: Defines the keys in which the image or transformation is updated and output. This 
attribute is used when the node is in Hold Between Stop-Motion Keyframes mode.

 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
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timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Import 3D Models Dialog Box
Use the Import 3D Models dialog box to import 3D models into Harmony.

How to open the Import 3D Models dialog box

 1. From the top menu, select File > Import > 3D Models.

The Import 3D Models dialog box opens.

Parameter Description

Files

Browse
Lets you locate and select 3D model file formats from a location on your 
computer or a location accessible from your computer (network, server, etc.).

Layer

Create Layers(s)
This option is selected by default. A new layer will be created for the selected 3D 
model files for the import. You have two choices:
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Create Single Layer 
Named

Creates a new layer for your 3D model that you can name. Name the new layer 
immediately by entering a name into the provided field.

Create Layer(s) Based 
on Filenames

Creates a layer based on each unique filename prefix. For example, the filenames 
a-1.obj, a-2.obj and b-1.obj will create layers named "a" and "b", where "a" has 
two 3D models and "b" has one. When creating a single layer from these three 
filenames, all three models will be imported to the new layer.

Add to Existing Layer

Imports the selected files to an existing layer in the scene. Once this option is 
selected the adjacent drop-down list becomes active. Select an existing layer 
name from the drop-down list. Note that if you select a vector layer, it will 
encapsulate the 3D model inside a symbol.

Conversion

Convert to FBX 
format

  Check this option if your file isn't already a Filmbox (.fbx) file and you would 
like it to be.  This format incorporates all associated files, such as the texture files.

Convert to 2D

Check this option if you want to render the 3D model into a 2D image and import 
it into a bitmap layer instead of as a 3D object. You will be prompted to select the 
position and angle from which to render the 3D model, as well as to apply 
geometrical transformations to it before rendering it—see Render 3D Model 
Dialog Box on page 197.
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Import Images Dialog Box
T-HFND-007-011

The Import Images dialog box lets you  import bitmap images and vectorize them, making the images editable. 
Then you can use a variety of drawing tools to edit the image. Or you can always keep the original bitmap 
image as is.

Also, you can choose to import bitmap images on bitmap or vector layers depending on your project..

How to open the Import Images dialog box

 1. Do one of the following:

 l From the top menu, select File > Import > Images. 

 l In the File toolbar, click the Import Images  button.

 l In the Xsheet view, right-click anywhere in the frame area and select Import > 
Images.

The Import Images dialog box opens.
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Parameter Description

Files

Browse Lets you find and select images on your computer.

Layer

Create Layers(s) Create layers for imported images.

Create Single Layer 
Named

Creates a new layer with the specified name and imports the images into it.

Create Layer(s) Based 
on Filenames

Creates a layer based on each unique filename prefix. For example, if you import 
three files named a-1.tga, a-2.tga and b-1.tga, this will create two layers, one 
named "a" and one named "b". Layer "a" will contain the two first images and "b" 
will contain the third one.

Add to Existing Layer

Imports the images into the specified layer. Note that you can only import into 
layers that are compatible with your import options. For example, if you're 
importing images as vector drawings, you can only import them into vector 
drawing layers. 

Import Options
Depending on how you choose to import images, the Alignment section offers 
different options.

Keep as Original 
Bitmap

Retains an imported image as a bitmap. In the Alignment section, decide on the 
size and placement of your image within the camera frame. Depending on the 
Scene Settings (the height and width in pixels that you chose for your project), an 
image that you import may get scaled to the point where all its individual pixels 
become visible.

Import as Toon Boom 
Bitmap Drawing

Imports a drawing into a vector layer where you can edit the image using the 
drawing tools.

Convert to Toon 
Boom Vector 
Drawing

Imports a drawing and converts it to a Toon Boom vector drawing.

Alignment (Keep As Original Bitmap)
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Rules

Fit:

Adjusts the image's size to fit completely within the scene's field, both vertically 
and horizontally, making sure the entire image is visible. 

If the image's orientation is portrait, then it will adjust the image's height to fit the 
field's height, without affecting the image's aspect ratio:

If the image orientation is landscape, then it will adjust the image's width to fit 
the field's width, without affecting the image's aspect ratio:

Pan: 

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the 
field's width, without affecting its aspect ratio:
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If the image's orientation is landscape, it will adjust the image's height to fit the 
field's height, without affecting its aspect ratio:

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the 
field's width, without affecting its aspect ratio:
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This has the opposite effect 
to the fit parameter. The 
image's smallest dimension 
will be made to fit the scene 
frame's matching dimension, 
and the image's largest 
dimension will be adjusted 
proportionally, making the 
image fill the entire scene 
field, and bleed past its 
boundaries it if its aspect 
ratio does not match the 
field's aspect ratio. This 
option can be used to import 
a panning background image, 
also referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the 
field's width, without 
affecting its aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the 
field's height, without 
affecting its aspect ratio:

This has the opposite effect 
to the fit parameter. The 
image's smallest dimension 
will be made to fit the scene 
frame's matching dimension, 
and the image's largest 
dimension will be adjusted 
proportionally, making the 
image fill the entire scene 
field, and bleed past its 
boundaries it if its aspect 
ratio does not match the 
field's aspect ratio. This 
option can be used to import 
a panning background image, 
also referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the 
field's width, without 
affecting its aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the 
field's height, without 
affecting its aspect ratio:

Project Resolution: Scales 
the image to fit the scene's 
resolution, making each pixel 
in the image take one pixel in 
the scene's field. For 
example, if the image's 
dimensions in pixels are half 
of the scene's resolution in 
pixels, then the image's 
dimensions will appear to be 
half of the scene field's 
dimensions. 

Alignment (Import as Toon Boom Bitmap Drawing)

Rules

Horizontal Fit: 

Adjusts the image's size so that its width matches the scene's width, without 
affecting its aspect ratio.

Vertical Fit: 

Adjusts the image's size so that its height matches the scene's height, without 
affecting its aspect ratio.
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Actual Size: Imports the image in its actual size, without adjusting its size 
relative to the scene's resolution. For example, if the image's dimensions in pixels 
are half of the scene's resolution in pixels, then the image's dimensions will 
appear to be half of the scene field's dimensions. 

Transparency

Alpha

Premultiplied with White: The colour values of semi-transparent pixels in the 
image have been encoded so that the more transparent they are, the closer to 
white they are. When an image that is premultiplied with white is loaded in a 
software that does not support transparency, it appears blended with a white 
background. Select this to make Harmony reverse this premultiplication so that 
the image blends properly with other visual elements in your scene.

Premultiplied with Black:The colour values of semi-transparent pixels in the 
image have been encoded so that the more transparent they are, the closer to 
black they are. When an image that is premultiplied with black is loaded in a 
software that does not support transparency, it appears blended with a black 
background. Select this to make Harmony reverse this premultiplication so that 
the image blends properly with other visual elements in your scene.

Straight: The colour of semi-transparent pixels in the image is encoded 
independently from their transparency. When an image that is not premultiplied 
is loaded in a software that does not support transparency, semi-transparent 
pixels simply appear fully opaque, making its edges appear pixelated. 

Clamp Colour to Alpha:This is the same as Premultiplied with Black, except 
that it also prevents the colour values for a given pixel from being higher than 
that pixel's alpha value. This option is only useful if you are working with images 
that are supposed to be premultiplied with black, but where the colour values of 
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pixels have been increased without their alpha values being adjusted 
accordingly.  

Vectorization

Black and White
Vectorizes drawings with a solid black line. This creates a 100% vector-based 
drawing and paints it with the Vectorized Line colour swatch from your scene's 
palette.

Grey
Vectorizes the image as a mix of vector contour and greyscale bitmap filling. 
Lines keep the texture from the scan, and the white of the paper becomes 
transparent.

New Preset Lets you create a new preset.

Delete Preset Lets you delete any preset in the list.

Edit Preset Lets you edit the vectorization parameters for the selected preset.
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Loop Node

The Loop node exists as both Loop (for Images) and Loop Transformation (for Pegs and Transformations). This 
node is used to create looping sections in the Timeline by referencing the input content at different frames. The 
Loop node is able to start a loop at a given frame, loop a section of frames a number of times, and continue after 
looping is required.

The Loop node takes an image input and output, and will provide the retimed transformation and render of 
that image, looping over a number of frames.

The Loop Transformation node takes a transformation input and output, and will provide the retimed 
transformation looping over a number of frames.

How to access the Loop and Loop Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.
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 l Cycle Mode: Defines the way in which the output frames are calculated when cycling.

 l Repeat: It will simply cycle the looping frames, and will repeat the cycle from the first frame 
when finished. 1,2,3,4,1,2,3,4

 l Ping Pong: It will cycle the looping frames, and will repeat the cycle backwards when 
finished. 1,2,3,4,3,2,1,2,3 . . .

 l Frames to Cycle:  This area defines the input range to be used in the looped content. 

 l First: The first frame to be used in the looping content.

 l Last: The last inclusive frame to be used in the looping content.

 l Offset: Offsets the internal frame of the loop by this amount. This is useful for reusing loops, 
but simply offsetting their starting frame.

 l Use Output Range: Defines whether the loop is considered infinite (when disabled) or, if the loop is 
mapped to a specific output range and will have a start and ending range in the Timeline.

 l Disabled: The loop will begin at frame one, and will persist for the total length of the scene.

 l Enabled: The loop will begin at the start frame and plays to the end frame.

 l Start: The output frame number that defines where the loop begins in the output frames. The 
input images or transformation will play normally up until this point.

 l End: The inclusive output frame number that defines where the loop ends in the output 
frames. The loop will continue until one frame after this value is reached, and will resume its 
output based on the resume behaviour of the node.
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 l Resume Behaviour: Defines the node’s behaviour after the end frame has been reached 
when the output range is enabled.

 l Hold: Holds the final output frame’s value after the end frame has been reached.

 l Continue from Looped Frame: Continues from the input frame that was last played in 
the Timeline when the end frame of the loop has been reached.

 l Continue from Timeline Frame: Continues from the actual Timeline frame, regardless 
of the looping frame or output range, once the end frame of the loop has been 
reached.

 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Manage Local Cache Dialog Box
The Manage Local Cache dialog box displays a list of all the Harmony Server scenes for which you have cached 
drawings. In this dialog, you can check if the drawings you have in a scene's cache match the drawings in the 
database server, you can delete unused caches and you can change the directory in which scene data is 
cached. 

NOTE 

A scene's data is cached on your computer when you check the Cache scene assets locally option 
in the Database Selector before opening the scene—see Database Selector Dialog Box on page 
56. 

How to access the Manage Local Cache dialog box

 1. In the top menu, select File > Manage Local Caches.

The Manage Local Caches dialog appears.

Parameter Description

List of 
scene 
caches

The list of caches stored on your computer. There is one item for each scene for which there is 
cached data. Each item is identified by the scene's environment, followed by its job, then its name, 
in this format: 

Environment/Job/Scene

If you select a scene cache in the list, the Manage Local Caches dialog will compare the drawings 
that are cached on your computer to the drawings in the actual scene in the database, and report if 
they are identical or not in the Local Cache Status field. 
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Parameter Description

Local 
Cache 
Status

If you select a cache, the Manage Local Cache dialog will analyze whether the data in the selected 
cache matches the data in the actual scene in the Harmony Server database. 

If it displays Scene's Local Cache is identical to the database, then the drawings in the selected 
cache on your computer are identical to the drawings in the corresponding scene in the database, 
meaning that your cache and that the database are up to date. 

If it displays Scene's Local Cache is different than database, then some drawings in the selected 
cache on your computer are different from the drawings in the corresponding scene in the 
database. This usually means one of the following:

 l If the selected cache is the cache of the currently opened scene and you just saved your 
scene, Harmony may still be uploading the updated drawings to the database. In this case, 
you can close the dialog, wait a few seconds, and reopen it to see if Harmony is done 
uploading the drawings. If it is, it will report that the cache is identical to the database.

 l If this is not the cache of the currently opened scene, it is likely that the database scene has 
been changed by someone else since the last time you opened it. That would mean that the 
database version is more up to date than your cache. This is not a problem, as next time you 
open the scene, your cache will be updated. 

Local 
Cache Root 
Folder

Indicates where scene caches are stored on your computer. By default, scene caches are stored in a 
folder named Toon Boom Harmony Local Cache, inside your Documents folder.

Browse

Allows you to change the folder where caches are downloaded when you open a scene. 

NOTE 

The caches that are currently stored on your machine will not be moved to their new location. 
Hence, when you change the local cache root folder, the list of scene caches will become 
empty until you open a scene. 

Remove

Deletes the selected scene cache from your computer.

NOTE 

This button is greyed out if the selected scene cache is for the currently opened scene, as this 
cache is currently in use by Harmony. 

Close Closes the dialog.
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Manage Pre-Render Cache Dialog Box
When a scene contains more than one Pre-render Cache node, it is possible to manage every or some Pre-
render Cache nodes at the same time. 

How to access the Manage Pre-render Cache dialog box

 1. In the top menu, select Scene > Manage Pre-render Cache.

The Manage Pre-render Cache dialog box opens.

How to manage all Pre-render Cache nodes at the same time

 1. In the top menu, select Scene > Manage Pre-render Cache.

 2. Define the range of the frames that need to be managed.

 3. Select All Nodes.

 4. Do one of the following:

 l Click on the Render button to render every Pre-render Cache node.

 l Click on the Clear button to clear the cache of every Pre-render Cache node.
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How to manage some Pre-render Cache nodes at the same time

 1. In the Camera view, select every Pre-render Cache node that you want to manage.

 2. In the top menu, select Scene > Manage Pre-render Cache.

 3. Define the range of the frames that need to be managed.

 4. Select Selected Nodes.

 5. Do one of the following:

 l Click on the Render button to render all selected Pre-render Cache nodes.

 l Click on the Clear button to clear the cache of all selected Pre-render Cache nodes.

NOTE 

It is also possible to open the Manage Pre-render Cache dialog box by using the Pre-render 
Cache shortcut available under the General shortcut category.

Parameter Description

Range

All Frames: Select All Frames if you want to pre-
render the entire scene.

Selected Frames: Select Selected Frames if you want 
to render a part of your scene. Then, in the field to the 
left, type in the first frame of the sequence you want 
to export, and in the other field, the last frame of the 
sequence you want to render.

Pre-render Cache Nodes

All Nodes: Select All Frames if you want to clear or 
render the cache of every Pre-render Cache node.

Selected Nodes: Select Selected Nodes if you want to 
render the cache on the Pre-render Cache nodes that 
were previously selected in the Node view. 

Render
Renders the frames into cache images within the 
prerender.db folder of the current Pre-render Cache 
node. Those images will be rendered as .rpng files.

Clear
Removes every cache image rendered within the 
prerender.db folder of the current Pre-render Cache 
node.

149

Harmony 21 Premium Reference Guide                          



Chapter 1: Dialog Boxes

Manage Tool Presets Dialog Box
The Tool Presets window lets you create new tool presets and manage them. 

How to access the Manage Tool Presets window

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the Manage Presets  button.

Parameter Description

Icon Lets you select a preset to manage.

Import Lets you import an existing preset.

Export Lets you export a preset for use in other projects.
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Delete Removes the preset from the list of tool presets.

Name Lets you change the name of the preset.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the new preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 

Update
After adjusting the settings for a preset, the current properties are applied to 
the presets, as well as any other changes you made in the Manage Tool 
Presets window.
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Marker Dialog Box
The Timeline Scene Marker dialog box lets you create and manage scene markers in the Timeline view. 

Scene markers are visual indicators displayed at the top of the Timeline view in the frame counter area. You can 
use it to denote anything relevant to your work. You can indicate the frames you want to clean up, a change in 
action, an impact, or where you intend to apply an effect. You can also add a note to a scene marker. If you hold 
the mouse cursor over a scene marker, its name, starting frame, duration and note will be displayed in the tool 
tip box.

How to access the Timeline Scene Marker dialog box

 1. In the Timeline view, do one of the following:

 l If you want to create a scene marker at a single frame, select that frame on any layer.

 l If you want to create a scene marker that spans over several frames, select this range of 
frame on any layer.

 2. Right-click on the ruler at the top of the Timeline view and, in the context menu, select Scene 
Markers > Create Scene Marker.
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NOTE 

If your scene already contains scene markers, you can also open this dialog box by clicking on a 
scene marker to select it, then right-clicking anywhere on the timeline ruler and selecting 
Scene Markers > Edit in the contextual menu.

Parameter Description

Name The name of the marker.

Time The frame number at which the marker starts.

Duration

The amount of frames during which the marker spans. 

TIP 

You can set the duration to zero to make a marker that just points at the 
starting frame.

Colour Allows you to select a colour for the scene marker.

Note Allows you to type a description for the scene marker.
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Mini Playback Dialog Box
The Mini Playback dialog box alllows you to configure and start Mini Playback. Mini Playback allows you to 
quickly preview a short span of animation starting a few frames before the current frame and ending a few 
frames after the current frame, at a customizable frame rate. 

How to access the Mini Playback dialog

 1. Do one of the following:

 l In the top menu, select Play > Mini Playback.

 l In the Mini Playback toolbar, click on the  Mini Playback Dialog button. 

Icon Parameter Description

  Frame Rate
The speed at which Mini Playback should play your animation. By default, it is set to 
Same as Scene to play at the same pace as your scene's frame rate. Otherwise, you 
can choose among a set of commonly used frame rates. 

  Before The amount of frames before the current frame at which to start Mini Playback. 

Play
Starts Mini Playback. Playback will start at the amount of frames in the Before field 
before the current frame, and end at the amount of frames in the After field after the 
current frame, at the frame rate in the Frame Rate drop-down. 

  After The amount of frames after the current frame at which to end Mini Playback. 
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Movie Options Dialog Box (macOS)
The Movie Options dialog box allows you to configure the video and audio settings when exporting a movie in 
QuickTime Movie (.mov) format on macOS.

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on macOS.

How to access the Movie Settings dialog box                                       from the Export Movie dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the Movie Settings dialog box from the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

How to access the Movie Settings dialog box from the Write node Layer Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.
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The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).

 2. To the right of Movie Options, click Customize.

Parameter Description

Video

Codec

Allows you to select which algorithm to use to compress the video data. The following video 
codecs are supported:

 l H.264 Legacy: A very effective lossy compression algorithm that is commonly supported 
by web browsers and media players. 

 l H.265  Legacy: Same compression quality as H.264, but with a smaller compression size. 
This is useful for videos intended for the web and mobile devices. Not supported on all 
major browsers or operating systems. 

 l Apple ProRes 422  Legacy: A nearly lossless compression algorithm commonly used for 
video editing on Apple systems. This codec is optimized for preserving video quality, but 
not for publishing or streaming.
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Parameter Description

 l Apple ProRes 422 HQ  Legacy: Preserves visual quality at the same high level as Apple 
ProRes 4444 but for 4:2:2 image sources (cleaner footage for things like green 
screening). Heavier than Apple ProRes 422 for real-time editing performance.

 l Apple ProRes 422 LT  Legacy: A more highly compressed codec than Apple ProRes 
422, with roughly 70 percent of the data rate and 30 percent smaller file sizes. This 
codec is perfect for environments with limited storage capacity and data rates.

 l Apple ProRes 422 Proxy  Legacy: An even more highly compressed codec than Apple 
ProRes 422 LT, intended for use in offline workflows that require low data rates but full-
resolution video.

 l Apple ProRes 4444  Legacy: A nearly lossless compression algorithm commonly used 
for video editing on Apple systems. Compared to Apple ProRes 422, this codec 
preserves more colour detail and supports transparency. However, it results in heavier 
file sizes.

Alpha

Check this option if you want to export a video with transparency.

NOTE 

This option is only available when exporting with the Apple ProRes 4444 codec. Other 
codecs do not support transparency.

Sound Uncheck this checkbox if you want to export a movie without an audio track.

Rate

Allows you to select the sample rate, or frequency, in which to export the audio track for the 
movie.

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 kHz. If you select a 
higher sample rate, your project's audio will be upsampled, which means it will take more 
disc space without increasing in quality. 

Use

Allows you to select whether to export the movie's audio track using the Mono or Stereo 
channel mode.

NOTE 

Stereo sound has a separate track for the left and right speakers, whereas mono sound 
only has a single audio track for all speakers. 
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QuickTime Movie Settings Dialog Box (Windows)
The Movie Settings dialog box allows you to configure the video and audio compression settings when 
exporting a QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Movie Settings dialog box                                       from the Export Movie 
dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Movie Settings dialog box from the Export OpenGL 
Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.
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The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

How to access the QuickTime Movie Settings dialog box from the Write node Layer 
Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.
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The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).

 2. To the right of Movie Options, click Customize.

Parameter Description

Video

Settings

Opens the Standard Video Compression Settings dialog box. This is where you 
can set the video compression settings for the movie you will export—see 
QuickTime Standard Video Compression Settings Dialog Box (Windows) on page 
252.

Filter
Opens the Choose Video Filter dialog box, where you can select from a range of 
filters to apply to your video export.

Size
Opens the Export Size Settings dialog box. This dialog is available because of the 
way the Apple QuickTime interface is designed, but its settings are not taken in 
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account by Harmony. The size of the exported video is determined by Harmony.

Sound

Settings
Opens the Sound Settings dialog box. This is where you can you set the sound 
compression settings for the movie you will export—see QuickTime Sound 
Settings Dialog Box (Windows) on page 246.

Prepare for Internet 
Streaming

If this option is enabled, the video will be optimized to start playing while it is 
downloading, as videos do in web browsers and web-based streaming 
applications. 

 l Fast Start: The video plays as soon as enough data required to start 
playback has been downloaded.

 l Fast Start - Compressed Header: Same as Fast Start, except the header 
is compressed for an even faster start. Requires QuickTime 3.0 or later.

 l Hinted Streaming: Allows you to optimize the movie file for streaming 
through QuickTime Server Software. Click on the Settings button to 
configure how hints are created in your movie file.
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New Scene Dialog Box
The New Scene window lets you create a new scene.

How to access the New Scene window

 1. Do one of the following:

 l From the top menu, select File > New. 

 l In the File toolbar, click the New  button. 

 l Press Ctrl + N (Windows/Linux) or ⌘  + N (macOS).

The New Scene dialog box opens.

Parameter Description

Name Lets you type in a name for the new scene.

Location Lists the locations you used most frequently for storing scenes.

Browse
Opens a browser in which you can specify a location for the new scene that 
is not listed in the Location list.
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Camera Size Opens a list of resolutions.

+ (Create Custom 
Resolution)

Opens the New Resolution window in which you can create a custom 
resolution that is added to the Camera Size list.

- (Delete Custom 
Resolution)

Lets you remove a custom resolution from the Camera Size list.

Width Indicates the width of the resolution you chose from the Camera Size list.

Frame Rate
Indicates the frame rate of the resolution you chose from the Camera Size 
list.
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New Tool Preset Dialog Box
The New Tool Preset dialog box lets you create new tool presets and manage them. 

Tool presets let you save a variety of settings and are very efficient for accessing the tools you use most often. 
That way, the tool is already set with the desired properties, such as colour, line thickness, whether to enable 
Draw Behind or Auto Flatten mode, and so on. You can create presets for these tools and many more: Brush, 
Pencil, Eraser, Rectangle, Ellipse, and Line. 

The difference between a tool preset and a brush preset is that when you save a tool preset, you have the 
option of saving the colour and assigning a shortcut, which you cannot do with brush presets.

How to access the New Tool Preset dialog box

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the New Tool Preset   button.

Parameter Description

Name Lets you give the preset a meaningful name.

Icon list Lets you select an icon for the preset.
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Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 
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Onion Skin and Light Table Transparency Dialog Box 
T-ANIMPA-006-009

This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box 

 l In the Drawing view toolbar, click on the Top Light button to open the Onion Skin and Light 
Table Transparency dialog box.

Command Description

Onion Skin Opacity
Sets the maximum opacity value for the onion skin opacity display.  Moving the 
slider all the way to the left = 0% opacity. Moving the slider all the way to the 
right = 100% opacity.

Lighttable Opacity
Sets the maximum opacity value for the light table display. Moving the slider 
all the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity.

LightTable Wash
Sets the washed-out value for the light table display.  Moving the slider all the 
way to the left = 0% opacity. Moving the slider all the way to the right = 100% 
opacity.

Bitmap Background 
Wash

Sets the maximum opacity value for the background wash.   Moving the slider 
all the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity. Only works for bitmap layers.

Pencil Lines Opacity
Sets the maximum opacity value for central vector lines (lines made by the 
Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity. 
Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box
The Palette Browser dialog allows you to decide the level of palette list and palette storage to use when you 
want to create, clone, link to or import a palette. 

This dialog only appears if you have the Advanced Palette Lists preference enabled, which is disabled by 
default. When Advanced Palette Lists mode is disabled, Harmony automatically stores palettes in a scene's 
palette list, inside the scene's palette-library subdirectory. 

How to access the Palette Browser dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

 4. In the Palette Operations dialog box that opens, select the palette you want to clone at the location 
and level in which it was stored. 

 5. Click Clone.

Parameter Description

Palette Location

This allows you to browse for the physical location of the palette file in your 
database.

If you are using Harmony Stand Alone, you can still select the scene's own job or 
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environment as a location. Stand alone scenes have a provisional job and 
environment storage space inside the scene's directory. The files in these storage 
spaces can be imported into a database scene's actual job and environment when 
importing the scene to a Harmony database. If you never intend to use Harmony 
Server, you should keep your palettes inside your scene or element's palette 
libraries. 

Environment

Stores the palette file in the selected environment's palette library. Environments 
are typically used to contain a whole production, series or feature film. 

 l In Harmony Server, this stores the palette in /USA_DB/environments/
[environment name]/palette-library.

 l In Harmony Stand Alone, this stores the palette inside the scene's 
directory, under environments/Digital/palette-library.

Job

Stores the palette file in the selected job's palette library. Jobs are typically used 
to contain episodes in a series, or any set of scenes that is intended to be put in 
the same sequence. 

 l In Harmony Server /USA_DB/jobs/[job name]/palette-library. 

 l In Harmony Stand Alone, this stores the palette inside the scene's 
directory, under jobs/Digital/palette-library.

Scene
Stores the palette file in the selected scene's palette library, which is the 
palette-library subdirectory of the scene's directory.

Element
Stores the palette file inside the  selected element's palette library. This library is 
located inside the scene's directory, under elements/[element 
name]/palette-library.

Palette This lists the existing palettes in the selected location. 

New Palette Name
If you are creating or cloning a palette, use this field to enter the palette file's 
name. The palette will be listed under this name in your palette list. On your file 
system, it will be named after its palette name, followed by the extension .plt. 

Palette Type

When creating a palette, you can choose between the following palette types:

 l Colour: A colour palette can contain colours, gradients and bitmap 
textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 
transparency filters to pencil lines, in combination to their line colour, to 
create various styles of pencil lines.
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Palette List
This allows you to decide if you want the palette to be added to your scene's 
palette list, or to the currently selected element's palette list. 

Scene Palette List

Adds the palette to the scene's palette list. Palettes in the scene's palette list are 
available to all the elements in your scene. This is especially useful if you are 
doing digital animation, where character models can be made of many layers that 
need to use the same palette. 

Element Palette List

Adds the palette to the currently selected element's palette list. Palettes in an 
element's palette list can only be used by the drawings in this element, and will 
only be listed in the Colour view when this element is selected. This can be 
useful if you are doing traditional animation, where each character is usually 
drawn on a single layer, and you want each layer to have its own palette. 
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Palette Operations Dialog Box
When you start Toon Boom Harmony Premium connected to the database, you can access the Palette 
Operations dialog box which lets you clone, rename, or delete palettes in your database, without having to 
open a scene or browse the database's file system in your operating system's shell. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is 
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 
directory in a palette-library folder unless you specify a different location.

There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

Parameter Description

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.
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Clone
Opens the Palette Browser dialog box from which you can select the level in 
which to store the palette file.

Rename Lets you rename a palette.

Delete

Lets you delete a palette.

NOTE 

It is not recommended to disable the warning message that appears when 
you are attempting to delete a palette as this operation cannot be undone.

Close Closes the Palette Operations dialog box.
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Paste Preset Dialog Box
When pasting key frames and exposures, you can modify the existing presets to your liking. There are three 
presets you can modify: the default presets for both key frames and exposures, key frames only and exposures 
only.

Parameter Description

Drawings

Add/Remove 
Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved when 
pasting. No key exposures are added. This is the default behavior when pasting.

Fill Gap with 
Previous Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.
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Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.
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Paste Special Dialog Box
The Paste Special dialog box lets you determine how templates and symbols are imported in the Timeline 
view. 

When you import a template in the Timeline view, all layers are created as well as drawings and keyframes. 
You can choose to import only the keyframes without the drawings or import only the drawings that are not 
already in your layers. You can adjust the behaviour using the Paste Special dialog box.When you import a 
symbol in your scene, its full length is exposed by default. If you import a symbol in the Timeline view’s left 
side, all the frames will be exposed. However, if you import it into an existing layer, you can use the Paste 
Special dialog box to adjust the import behaviour to fit your requirements.Once you set the parameters, 
Harmony will reuse them each time you import a symbol in the Timeline view’s right side until you set new 
parameters.

How to access the Paste Special dialog box

 1. In the Library view, select the symbol or template to import.

 2. Do one of the following:

 l While holding down the Alt key, click and drag on the template, then drop it on the 
Timeline view, over the layer and at the frame where you want to paste it.

 l Press Ctrl + C (Windows/Linux) or ⌘  + C (macOS). Then, in the Timeline view, click on the 
frame where you want to paste the template and press Ctrl + B (Windows/Linux) or ⌘  + B 
(macOS)

The Paste Special dialog box opens.

177

Harmony 21 Premium Reference Guide                          



Chapter 1: Dialog Boxes

Parameter Description

Drawings

Do Nothing Does not create or overwrite drawings.

Update Drawing 
Pivot

Revises the drawing pivot in the destination to use the same drawing pivot as the 
first drawing in the template. If you have a range of drawings selected in the 
destination, the pivot points of all selected drawings will be updated.

Add/Remove 
Exposure

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Replace existing drawings. Create drawing files when they do not exist: 
Replace drawings with the same names to update a scene with new modified 
drawings and preserve the animation.

Tip: If you don't want to lose the existing animation when pasting 
a template,  such as when placing new drawings after the 
animation, then delete the template's animation.  It will still have 
updated the drawings but not override the existing animation.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure: If there are key exposures that exist on copied drawings, 
they are preserved when pasting. No key exposures are added. This is the default 
behavior when pasting.

Fill Gap with Previous Drawing: Fills selected area in the Xsheet or Timeline 
view with the previous drawing.

Fill to Next Key Exposure: Fills selected area till the next key exposure.

Paste all frames of the symbol (full movie): When enabled, the Paste Special 
command exposes all the symbol's frames instead of only the first one.
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Symbols

Copy symbols if they 
do not exist

This is the default setting for this operation and will prevent Symbols in an 
Action template from being copied.

Duplicate symbols
Creates a duplicate of the symbol instead of linking the Symbol instance to the 
original one. The new Symbol is created in the Library.

Paste all Frames of 
the symbol (full 
movie)

When enabled, the Paste Special command exposes all the symbol's frames 
instead of only the first one.

Add Remove/Keyframes

Motion Copies the properties of the selected motion keyframe to the new frame.

Velocity Copies the properties of the selected velocity keyframe to the new frame.

Rotation Copies the properties of the selected rotation keyframe to the new frame.

Scale Copies the properties of the selected scale keyframe to the new frame.

Skew Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at 
Function's Beginning 
and End

 Adds a keyframe to the beginning and end of the pasted function, reproducing 
the source function.

Offset Keyframes
When pasting functions, offsets keyframes from the function's last frame value 
by the values in the pasted function. This will continue the progression of a 
function instead of repeating the values.

Options

Palettes

Do nothing: Does not create, overwrite, merge or link palettes.

Reuse palettes. Copy palettes if they do not exist: Palettes in the destination 
drawings are left as they are.

Copy and overwrite existing palettes: Overwrites destination palettes with the 
palettes from the source drawings.
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Copy and create new palette files: Creates new palette files, placing them at 
the same relative environment and scene level as the source. If the palettes in the 
templates were stored at the environment level of the source scene, the paste 
operation will place the palettes in the environment level of the destination 
scene.

Copy and create new palette files in element folder: Creates new palette files 
in the element folders of the destination scene, rather than in the same relative 
job or environment.

Copy palette and merge colours. Add new colours only: Adds new colours to 
the destination palettes and ignores colours that are the same in the two palettes.

Copy palettes and update existing colours: Adds new colours to the 
destination palette and updates duplicate colours in the destination with colour 
values from the source.

Link to original palettes (colour model): Links the colour palettes in the 
destination scene to the palettes in the source. Use this to link drawings to the 
palettes in a colour model.

Copy scene palettes and merge colours. Add new colours only: Adds new 
colours to the destination scene palettes and ignores colours that are the same in 
the two palettes.

Copy scene palettes and update existing colours: Adds new colours to the 
destination scene palette and updates duplicate colours in the destination with 
the colour values from the source.

Cycles

Normal (forward):Pastes your selection as is, starting with the first cell and end-
ing with the last.

Reverse: Pastes your selection in reverse, starting with the last cell and ending 
with the first.

Forward > Reverse:Pastes your selection as a yo-yo, starting with the first cell, 
going to the last one and ending with the first cell.

Reverse > Forward: Pastes your selection as a reverse yo-yo, starting with the 
last cell, going to the first one and ending with the last cell.

Nodes
Create New Columns: A new column is created when you copy and paste nodes 
from the Node view or layer in the Timeline view. If the layers are linked to 
function curves, the function curves, drawings and timing will be duplicated.

Elements
Reuse existing elements: Lets you paste existing elements without creating 
new ones. This should be used only when pasting within versions of the same 
scene.

Validation Match by Node/Layer Name: When pasting a template with a hierarchy onto 
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another hierarchy, this option looks to match the pasting elements with the same 
layer or node name, rather than the same hierarchical structure. This means that 
even if the two hierarchies are different, a new pose of a character's body part will 
still be pasted on the correct body part layer, as long as both layers are named 
the same.
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Pen Pressure Feel Dialog Box
The Pen Pressure Feel dialog box allows you to configure how Harmony processes the pressure you put on your 
tablet pen to apply it to the size of your drawing tool.

By default, Harmony applies the pressure you put on your pen to your tool in a linear fashion. That is, if you put 
25% of the maximum pressure on your pen, your tool's size will be 25% of the way between its minimum and 
maximum size. If you put 75% of the maximum pressure on your pen, your tool's size will be 75% of the way 
between its minimum and maximum size. 

However, you may find that it would feel more natural, or that it would make it easier to control the size of your 
drawing strokes, if Harmony interpreted the pressure you put on your pen differently. For example, you may 
want Harmony to make your brush strokes small unless you put a lot of pressure on your pen, or you may want 
Harmony to make your brush strokes big unless you put very little pressure on your pen. This is where the Pen 
Pressure Feel dialog box comes in handy.

NOTE 

For information on how to use the Pen Pressure Feel dialog, refer to the User Guide.

How to access the Pen Pressure Feel dialog

 1. Add the Pen Settings toolbar to your workspace by doing one of the following:

 l In the top menu, select Windows > Toolbars > Pen Settings.

 l Right-click on any existing toolbar and, in the context menu, select Pen Settings.

 2. In the Pen Settings toolbar, click on the  Pen Pressure Feel button.

The Pen Pressure Feel dialog appears.
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Parameter Description

Min 
Pressure

The percentage of your pen's maximum pressure you must apply before Harmony registers that you 
are drawing. If you increase this setting, you can lightly brush your tablet with your pen without 
drawing, and you must apply a certain amount of pressure on it to draw. 

For example, if you set this to 15%, you can apply up to 15% of your pen's maximum pressure 
without actually drawing. If you apply exactly 15% of your pen's maximum pressure, Harmony will 
draw a stroke in your tool's minimum size.

By default, this is set to 0%, which means that just brushing the tablet with your pen will draw in 
your tool's minimum size. You can increase this setting up to 25%. 

Curve 
Preset

Allows you to instantly apply a curve preset to the pressure curve below. 

Max 
Pressure

The percentage of your pen's maximum pressure at which point your drawing tool should draw in 
its maximum size.

For example, if you set this to 80%, your drawing tool will draw in its maximum size if you apply 
80% of your tablet pen's maximum pressure. 

By default, this is set to 100%, which means you have to press your tablet pen all the way to draw 
in your drawing tool's maximum size. You can decrease this setting down to 75%.

Pressure  
Curve

This curve determines how to process the amount of pressure you apply to your tablet pen into 
your drawing tool's size.

By default, it is linear, meaning that the amount of pressure you put on your tablet pen is directly 
applied to the size of your drawing tool. By moving the two Bezier handles between the extremities 
of the curve, you can change the curve's shape.

 l If you make an ease-in curve like the one below, the size of your drawing strokes will tend 
to be closer to the minimum size of your drawing tool, unless you apply a lot of pressure 
on your tablet pen.

 l If you make an ease-out curve like the one below, the size of your drawing strokes will tend 
to be closer to the maximum size of your drawing tool, unless you apply very little pressure 
on your tablet pen.
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Parameter Description

 l If you make an ease-in-ease-out curve like the one below, the size of your drawing strokes 
will tend to be closer to the minimum size of your drawing tool when applying light 
pressure, and to be closer to the maximum size of your drawing tool when applying more 
pressure, but it will rarely be the median between the minimum and the maximum size.

 l If you make an ease-out-ease-in curve like the one below, the size of your drawing strokes 
will tend to be closer to median between the minimum and maximum size of your drawing 
tool, unless you apply very little or a lot of pressure on your tablet pen.
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Pose Copier Dialog Box
T-RIG3-007-007

The pose copier contains many buttons and other information to facilitate the insertion of poses in the 
animation.

Parameter Description

Preview Window
Based on master template's generated thumbnails, previews currently selected 
frames.

Load Selected Template Updates the template with the newly selected template.

Template Name Name of the currently selected template.

Vertical Slider (SLV) Linked to the slv- node of the node system.

Horizontal Slider 1 (SLH)
Linked to the slh- node of the node system. Default slider for the pose copier if 
no guide layers are created.
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Horizontal Slider 2 (SLX) Linked to the slx- node of the node system.

Fill to Next Key Exposure
Having this option checked will automatically extend the exposure of the 
pasted frame up to the next key.

Use Default Destination 
Module

When enabled, the pasted keys will automatically refer to the destination 
defined in the option Set Default Destination Module.

Paste by Layer Name
When this option is checked the pasted layers will look for the individual layer 
name instead of matching the hierarchy of the template. 

Set Default Destination Module
Instead of selecting the destination every time, the layer set as default 
destination will automatically paste the keys onto those layers.

Find This will center on the default destination in the timeline.

Paste Paste the current position of the pose copier onto the destination.

Vertical 
Currently selected frame on the vertical slider. (based on frame name in slv-
node)

Horizontal 1 
Currently selected frame on the horizontal slider 1. (based on frame name in 
slh-node)

Horizontal 2
Currently selected frame on the horizontal slider 2. (based on frame name in 
slx-node)

Frame Frame number of the selected frame within the master template.
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Preferences Dialog Box
The Preferences dialog box allows you to adjust preferences to suit your workflow and your production's needs.

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

How to open the Preferences dialog box

 1. Do one of the following:

 l Windows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.
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Paramete
r

Description

Preference 
Set

This drop-down allows you to select among one of the available preference presets.

The different preference presets have a lot of settings in common. The following table lists how 
each preset differs for specific preferences:

Tab / 
Locatio
n

Preferenc
e

Preference Set

Basi
c

Compositin
g

Cutout 
Animatio

n

Paperless 
Animatio

n

Riggin
g

General

Focus on 
Mouse 
Enter

Off On On On On

Default 
pass 
Through 
Composite

Off Off On Off On

Default 
Separate 
Position for 
Pegs

Off Off On Off On

Stop-
Motion 
Keyframes

Off Off On Off On

Timeline

Reduce 
Indentation

Off On On Off On

Drawing 
Substitutio
n: Create 
Key 
Exposure

On Off Off Off On

Advance
d

Support 
Overlay and 
Underlay 
Arts

Off On On Off On
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Paramete
r

Description

Tab / 
Locatio
n

Preferenc
e

Preference Set

Basi
c

Compositin
g

Cutout 
Animatio

n

Paperless 
Animatio

n

Riggin
g

Advanced 
Display

Off On Off Off On
Advanced 
Display

Off On Off Off On
Advanced 
Display

Off On Off Off On

Advanced 
Palette List

Off On On On On

Advanced 
Element 
Mode

Off On Off Off Off

Element 
Node 
Animate 
Using 
Animation 
Tools

On On Off On Off

Pencil 
Tool 
Propertie
s

Auto Close 
Gap

On On On On Off

Save... Allows you to export your current preference settings as an XML file, which you can import later.

Load... Allows you to browse for and import a preference file that was exported with the Save... button.

Preference 
Tabs

Where you can browse for and change preferences. 

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

Restore Restores all your preferences to their default setting for the selected preference set.
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Paramete
r

Description

All 
Defaults

OK Commits your changes to the preferences and closes the dialog.

Cancel Undoes your changes to the preferences and closes the dialog.
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Recolour Drawings Dialog Box
The Recolour Drawing dialog box allows you to replace all instances of a colour or texture in drawings with a 
different colour or texture swatch in one of the scene's palettes. This replaces the colours or textures in the 
drawings without requiring you to modify the palettes. You can use this dialog to perform colour replacement 
in the current drawing, in all the drawings in one or several layers or in all drawings in your scene.

This dialog will replace the colour or texture that is currently selected in the Colour view with the colour or 
texture that you select inside the dialog. 

How to access the Recolour Drawings dialog

 1. In the Colour view, select the colour or texture swatch you want to replace by doing one of the 
following:

 l Select the palette in which the colour or texture swatch is located, then select the swatch 
you wish to replace. 

 l If the drawing in the Camera or Drawing view contains the colour or texture you want to 
replace, select the Colour Eyedropper  tool in the Tools toolbar, then click on that colour 
or texture in the drawing. The Colour view will automatically select that colour or texture's 
palette as well as that colour or texture's swatch.
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 2. Do one of the following:

 l Right-click on the swatches list, then select Recolour Drawings.

 l Open the Colour view menu , then select Colours > Recolour Drawings.

Parameter Description

Replace Colour In

Allows you to select which drawings will be affected by the colour replacement:

 l Current drawing: Replaces the selected colour in the currently selected 
drawing only.

 l All drawings in the currently selected layers: Replaces the selected 
colour in all the drawings in the layer that is currently selected in the 
Timeline, Xsheet or Node view. 

NOTE 

This option can work with several drawing layers selected. 

 l All drawings in the scene: Replaces the selected colour in every drawing 
in the current scene.

Replacement Colour
Allows you to select the palette and colour or texture swatch to replace the 
selected colour or texture with.
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Remove Dirt Dialog Box
The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box

 1. Do one of the following:

 l From the top menu, select Drawing > Clean Up > Remove Dirt.

 l From the Camera or Drawing View  menu, select Drawing > Clean Up > Remove Dirt.

 l Press Shift + D.

Parameter Description

Slider

Lets you adjust the amount of detail removed from the layer. 

Raising the Remove Dirt level will select bigger dots. When selecting larger dots, 
be careful not to lose small details like pupils and nostrils. Once you have 
chosen the level, you can apply it to the current drawing or the entire animation 
sequence. This is a quick way to get rid of most dirt and dust.

During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.
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Remove Frames Dialog Box
The Add Frames dialog box allows you to remove a range of frames from your scene. All the keyframes and the 
exposed drawings in the removed range will be deleted, and the keyframes and exposed drawings after the 
removed range will be offset backwards, so as to close the gap. 

How to access the Remove Frames dialog box

 1. In the Timeline or Xsheet view, select a frame or a range of frames. 

 

 2. Do one of the following:

 l From the top menu, select Scene > Frame > Remove Selected Frames.

 l In the Xsheet view, right-click and select Frame > Remove Selected Frames.

The Add Frames dialog box appears.

Parameter Description

Number of frames to remove
The amount of frames to remove. The range of frame that will be removed starts 
from the selected frame—or the first selected frame, if a range of frames is 
selected—and ends after the selected number of frames. 
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Parameter Description

By default, this is set to the amount of selected frames. 

Ripple Scene Markers

If checked, scene markers after the removed frames will be offset backward to 
remain synchronized with the keyframes and drawings in your scene. If 
unchecked, scene markers will remain in place while everything else after the 
removed frames is offset.
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Remove Hair Dialog Box
The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick 
lines or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the 
drawing.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box

 1. In the Timeline or Xsheet view, select the drawing containing the drawing to clean.

 2. From the top menu, select View > Show > Show Strokes to display the invisible lines or press K.

 3. In the top menu, select Drawing > Clean Up > Remove Hair.

Parameter Description

Slider Lets you adjust the number of length of hairs selected. 

Apply to all drawings Applies the operation to all drawings in the layer.
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Render 3D Model Dialog Box
The Render 3D Model dialog box allows you to render a 3D model into a 2D bitmap layer. In this dialog, you 
can pick the point of view and angle from which the model is rendered, as well as apply geometrical 
transformations to the model before rendering it. 

NOTE 

For information on how to use this dialog, see the User Guide.

How to access the Render 3D Model dialog box

 1. In Harmony, select File > Import > 3D Models.

The Import 3D Models dialog box opens.
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 2. In the Files field, click on Browse.

An Open dialog appears.

 3. Browse to an select your 3D model, then click on Open.

NOTE 

If you want to import a 3D model as a rendered 2D image, you can only import a single 
3D model at a time. 

NOTE 

You can only import .osb, .3ds, .obj, .fbx, .abc and .dae type 3D models. 

 4. In the Import 3D Models dialog, check the Convert to 2D checkbox.

 5. Click on OK.

The Render 3D Model dialog appears.
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Parameter Description

Preview Area

The preview area displays the 3D model as it will be rendered in the scene. Black bars 
display around the area to mark parts of the areas that are outside of the camera frame.

In this area, you can:

 l Either click and drag on the vertical slider to the right or scroll the mouse wheel up 
or down to adjust the distance between the camera and the model. 

 l Hold Ctrl + Shift (Windows/Linux) or ⌘  + Shift (macOS), then click and drag on the 
preview area to rotate the camera.

 l Hold Spacebar, then click and drag on the preview area to pan the camera laterally. 
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Parameter Description

Camera

Focal 
Length

The angle of the camera cone used to render the 3D model. A wide angle will render the 
model with less perspective, and a narrow angler will render it with exaggerated 
perspective. 

NOTE 

Increasing this setting will also decrease the perceived size of the 3D model, and 
decreasing it will increase its perceived size. You must then adjust the camera's 
distance from the model or the model's scaling to compensate. 

Transformation

Translation

The position of the 3D model relative to the center of the stage:

 l X: The horizontal position of the 3D model, from west to east.

 l Y: The vertical position of the 3D model, from south to north.

 l Z: The position of the 3D model relative to the camera, from near to far. 

Rotation

The angle of the 3D model relative to its default angle:

 l X: The rotation angle of the model around the horizontal axis. 

 l Y: The rotation angle of the model around the vertical axis.

 l Z: The rotation angle of the model around the z-axis. 

Scaling
The size of the 3D model relative to its default size:

 l Lock Scaling Axis: When enabled, you can use the X scaling field to set the scaling 
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Parameter Description

of the 3D model on all axes, preserving its proportions. 

 l X: The horizontal scaling of the model.

 l Y: The vertical scaling of the model.

 l Z: The scaling of the model on the z-axis.

Fit Model to View
Click on this button to automatically adjust the model's Truck, Translation X and 
Translation Y parameters so that the model fits inside the camera field and is positioned in 
its centre. 

Render to Scene Rasterize the 3D model into a bitmap layer and add it to the current panel.

Cancel Dismiss this dialog and do not import the 3D model. 
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Render Write Nodes Dialog Box
The Render Write Nodes dialog box lets you configure your scene to render locally or sent it to a render farm 
so other computers can render your scenes while you continue working on your station. 

In Harmony Stand Alone, the Render Write Nodes dialog box will look as follows:

In Harmony Server, the Render Write Nodes dialog box will have an additional section, Batch Composite 
Options, which allows to set parameters for the server's batch rendering service:

There are two approaches to rendering a scene in Harmony Server:

 l Local Rendering is done directly by your machine in your Harmony session. Hence, it uses your 
machine's resources and will prevent you from working on the scene until the render is done. You will 
see the render progress in real time and will be able to preview the results right after it's finished. 

 l Batch Rendering is done by sending a scene to the server's render queue so it can be processed by the 
render farm. This allows you to keep working on your scene while the render is being done. The 
rendering progress can be monitored in Control Center and, when finished, the results can be 
previewed in  Play. Batch Rendering gives you access to additional rendering options. 

In either case, the render will be output in the same folder and in the same file formats, as those are 
determined by the scene's Write nodes. However, batch rendering supports additional options, such as 
rendering in chunks, or in different resolutions than the scene's resolution. 
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How to access the Render Write Nodes dialog box

 1. Do one of the following:

 l From the top menu, select File > Export > Render Write Nodes.

 l Press Ctrl + Shift + Y (Windows/Linux) or ⌘  + Shift + Y (macOS).

The Render Write Nodes dialog box opens.

Parameter Description

Range

All Frames Sends all the frames in the scene to be rendered.

Selected Frames Sends the specified range of frames to be rendered. 

Batch Composite Options
Check this to send the scene to batch rendering and unlock batch rendering 
options. Otherwise, the scene will be rendered locally. 

Debug
Instructs the batch rendering service to log debug information. When this is 
checked, the machine that processes the render will have more information about 
the compositing process in its batch rendering service's log. 

Chunk

When checked, this splits the render job sent to the server's render queue into 
several smaller render jobs, allowing it to be processed by several machines in 
the render farm. Note that this only affects Frame renders. If the render includes a 
movie file, the movie will still be exported as a single file once all the frames 
have been rendered.

Size (Frames)
Specifies the amount of frames each chunk will include. For example, when 
rendering a 50 frames scene by chunks of 30, this will make the first render job 
render frames 1 to 30, and the second render job render frames 31 to 50.

Camera
If you created a scene with several Camera nodes, this allows you to specify 
which one to use for the render.

Resolution

This allows you to set the width and height of the rendered images or movie, 
either:

By Name: Allows you to select between Default or one of the available 
resolution presets. If Default is selected, the scene will be rendered in its own 
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resolution. 

By Value: Allows you to set the width and height of the rendered images in 
pixels. 

Field Composite Options

Add Pulldown

Renders using the 3:2 pull-down technique. Every odd-numbered frame will be 
rendered on 3 images, and every even-numbered frame will be rendered on 2 
images. 

The exported images will be named in pairs to indicate that they are to be 
combined together. Therefore, the exported frames will follow this scheme:

Exported Image File Rendered Frame

final-0001-f1.tga Frame 1 of the scene

final-0001-f2.tga Frame 1 of the scene

final-0002-f1.tga Frame 1 of the scene

final-0002-f2.tga Frame 2 of the scene

final-0003-f1.tga Frame 2 of the scene

final-0003-f2.tga Frame 3 of the scene

final-0004-f1.tga Frame 3 of the scene

final-0004-f2.tga Frame 3 of the scene

This makes a scene animated in 24 frames per second output in 60 images per 
second. Hence, once the paired images are combined, this will make a 30 frames 
per second render.

Automatic Combine
Combines each pair of images rendered with Pulldown by interlacing them 
together.

Second Field First
By default, when images rendered with Pulldown are combined, the first image in 
a pair is rendered on odd lines (referred to as the first field), and the second is 
rendered on even lines (referred to as the second field). This does the opposite: 
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The second image in a pair is rendered on odd lines and the first one is rendered 
on even lines.

Preview
When rendering locally, this opens the rendered image sequence in Play 
immediately after the render is done. 
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Rigid Point Deform Node

The Rigid Point Deformer is a type of weighted-deformation that prioritizes rigid transformations over 
deformations and is applied by tracking the position of attached pegs. It is particularly useful for tracking and 
deforming textures on characters and animated surfaces and is used with the Weighted Deformer node.

How to access the Rigid Point Deform Node dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.

 l Weight: A percentage value that defines the weight of all points connected to the Rigid Point 
Deform. This weight is considered when calculating the influence of all points, curves and Rigid 
Point Deforms connected to the Weighted Deform. These weights are relative to one another in the 
Weighted Deform system. A weight of 50% would have half the influence in the Weighted 
Deformation system than a weight of 100% when connected to that same system.

 l Minimum Distance: The Rigid Deform considers the proximity of the elements in the drawing and 
the points influence is based on that distance. When a minimum distance is defined, any points 
within that minimum distance are completely influenced by that point and this influence falls off as 
it approaches the maximum distance.
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 l Maximum Distance: Similar to the Minimum Distance, the Maximum Distance defines the distance 
in which the point has little to no control over the surrounding elements in the drawing.

The Minimum and Maximum distance are useful in defining particular regions of control within a Weighted 
Deformation system.
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Save Dialog Box
The Save dialog box appears when you save a scene for the first time in Harmony Server.

How to access the Save dialog Box

 1. Make sure you have the necessary rights to save the current scene version. If you do not, you can 
acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene in 
the top menu. 

 2. Do one of the following: 

 l In the top menu, select File > Save.

 l In the File toolbar, click on the  Save button.

 l Press Ctrl + S (Windows/Linux) or ⌘  + S (macOS). 

When saving the scene for the first time, the Save dialog box opens, prompting you to name the 
version.

Parameter Description
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This Version Allows you to enter the name of the current version.

Description Enter a short description of the current version.
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Scene Settings Dialog Box
The Scene Settings dialog box lets you select settings for the resolution of your scene, its alignment and the 
resolution of bitmap drawings and textured brush strokes. 

You are already required to select resolution and alignment settings when creating a scene, but those settings 
can also be modified later using the Scene Settings dialog box.

How to access the Scene Settings dialog box

 1. In the top menu, select Scene > Scene Settings.

The Scene Settings dialog box opens.

Resolution Tab

The resolution tab allows you to set the width and height of your scene in pixels, the angle of the field of view 
and the way elements are projected across the depth of your scene.

Icon Parameter Description

  Resolution Presets

You can select your project’s resolution (camera frame size) from this 
preset list.

 l HDTV_1080p24: The standard definition for high definition 
television at 24 frames per second, mostly used in the Americas 
and some Asian countries that used the NTSC standard for 
analogue television.
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Icon Parameter Description

 l HDTV_1080p25: The standard definition for high definition 
television at 25 frames per second, usually for broadcasting in 
European, African, Asian and Australian countries that used the 
PAL or SECAM standard for analogue television.

 l HDTV_1080p23.976: The standard definition for high 
definition television at 23.976 frames per second. This is useful 
if the remainder of your pipeline uses the 23.976 framerate for 
legacy reasons. 

 l HDTV_720p24: The former standard high definition resolution 
at 24 frames per second. 

 l 4K_UHD: A standard ultra HD (4K) format for television 
productons. 4K implies that the width of the image is of, give or 
take, 4000 pixels.

 l 8K_UHD: A standard ultra HD (8K) format for television 
productions. 8K implies that the width of the image is of, give 
or take, 8000 pixels. 

 l DCI_2K: A standard HD format for cinema. 

 l DCI_4K: A standard ultra HD (4K) format for cinema.

 l film-2K: A standard HD format for film projectors with a low 
aspect ratio.

 l film-4K: A standard ultra HD (4K) format for film projectors 
with a low aspect ratio. 

 l film-1.33_H: The standard resolution for the academy film 
format that conforms to the standard 4:3 aspect ratio.

 l film-1.66_H: The standard resolution for widescreen film 
format that conforms to the 16:9 aspect ratio.

 l film-1.66_V: The standard resolution for widescreen film 
format, but with a vertical field of view.

 l Cineon: The standard format for 35 mm Kodak/Cineon film.

 l NTSC: The standard resolution and framerate for analogue 
standard definition televisions in most of the Americas (except 
Brazil, Paraguay, Uruguay and Argentina), Japan, Taiwan, South 
Korea, the Philippines and Myanmar.

 l PAL: The standard resolution and framerate for analogue 
standard definition televisions in Europe, Africa, Australia, 
most of Asia, Brazil, Uruguay and Argentina. 

 l 2160p-240p: A series of standard widescreen presets named 
after their resolution heights.                             
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Icon Parameter Description

 l low: A resolution based on NTSC with half of its standard 
dimensions.

 l Web_Video: A legacy format for web streaming.

 l Game_512: A preset for the gaming pipeline, with a square 
canvas. 

 l Game_512_Ortho: Like Game_512, except with Orthographic 
projection so that elements moved on the Z axis do not appear 
smaller or bigger.

 l WebCC_Preview: The preset used by WebCC to render 
previews of scenes in a Harmony Server database.

 l HDTV: The standard definition for high definition television at 
24 frames per second, with a horizontal fit field of view.

 l HDTV_Vertical: The standard definition for high definition 
television at 24 frames per second, with a vertical fit field of 
view.

  Selected Resolution Preset
Displays the name of the selected resolution preset just below the 
presets list. If you have made any changes to the resolution since 
selecting a preset, this will display "(custom)".

Save Resolution Setting 

Allows you to save the current resolution settings as a new preset. If 
you have a resolution preset selected, this button is only available if 
you have made changes to the resolution since selecting the preset. 
You will be prompted to type in the name of the new resolution preset. 
If using Harmony Server, you will also be asked to select in which part 
of the database you want the preset to be saved.

  Resolution

The resolution of the scene defines the width and height of the canvas 
in pixels. By default, the scene will be rendered in this resolution. If 
using bitmap layers or textured brush strokes, the definition of the 
pixels in your artwork will also be based on the scene's resolution. 
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Icon Parameter Description

Scene Width The width of the resolution for the scene, in pixels. 

Scene Height The width of the resolution for the scene, in pixels. 

  Aspect Ratio

Displays the ratio between the horizontal and vertical dimensions of 
the scene. For example, if the scene width and height are the same 
value, this ratio equals 1. The standard aspect ratio for widescreen 
televisions is 1.777. For legacy displays, it is 1.333.

  Field of View

The angle of the field of view, which determines the size of the camera 
cone as well as the way the field grid used to position elements is 
adjusted to fit the scene. 

 l Horizontal Fit: The field of view is automatically adjusted so 
that the field grid and camera cone fit the horizontal length of 
the scene.

 l Vertical Fit: The field of view is automatically adjusted so that 
the field grid and camera cone fits the vertical length of the 
scene.

 l Custom FOV: Enter the angle of the field of view manually. A 
greater angle will make a wider camera cone and smaller fields. 
A smaller angle will mean a more narrow camera cone and 
bigger fields. 
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Icon Parameter Description

NOTES 

 l Objects in Harmony are positioned in fields, based on 
a traditional animation grid which, by default, extends 
to 12 fields from the center in each direction, and 
which has 4:3 proportions by default. In a scene with 
4:3 proportions, this grid fits the camera field 
perfectly. However, since most scenes have an aspect 
ratio of 16:9, the grid does not fit the camera field 
perfectly. If the field of view is Horizontal Fit, the 
grid's width will match the scene's width, but will 
extend beyond its vertical edges. If the field of view is 
Vertical Fit, the grid's height will match the scene's 
height, will not extends to its horizontal edges. 

 l To avoid distorting elements, the field of view angle is 
applied directly to the vertical axis, and the one 
applied on the horizontal axis is calculated 
proportionally to the aspect ratio of the scene. 

 l The field of view may affect the way 3D-rotated 
elements and 3D objects are rendered. If too wide, 
objects may appear distorted when seen from an 
angle. If too low, objects may seem flat and may lack 
foreshortening. 

  Projection

The Projection settings allows you to modify the type of camera your 
scene is using. You can either use a perspective camera (regular 
camera) or orthographic camera (no perspective).

 l Perspective:  Objects placed closer to the camera will be 
displayed bigger and objects placed further away will be 
displayed smaller. Elements that are 3D-rotated as well as 3D 
objects will be rendered in a realistic perspective.

 l Orthographic: The size of objects does not depend on their 
position on the Z-axis. Moving an element forward or backward 
will not change its apparent size, only its order relative to other 
elements. 3D-rotated elements and 3D objects will have no 
foreshortening. This option is more often useful when using 
Harmony for gaming, and more information about this option is 
available in the Gaming guide. This option can also be useful if 
you don't need any perspective in your project and want to use 
the Z-axis to order elements, or if you want to 

214



Icon Parameter Description

TIP 

In order  to create scenes with the Orthographic camera 
by default, you need to create a new custom scene 
resolution.        

  Frame Rate

The amount of animation frames to play each second. Increasing the 
FPS will make your animation play faster, and decreasing it will make it 
play slower.

 l Preset: Allows you to select a frame rate for your scene among 
one of many commonly used preset frame rates.

 l FPS:Allows you to type in the frame rate for your scene. 

NOTE 

The standard framerate for film production is 24 frames per 
second. However, televisions in some countries play at 25 
frames per second. Some productions may use 23.976 frames 
per second to preserve compatibility with legacy standard 
displays. 
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Alignment Tab

The alignment tab is used to determine the aspect ratio, the position and the size of the field grid used to 
position elements in the scene.

In Harmony are positioned in fields, a unit used in traditional animation which traditionally ranges from 0 to 12 
followed by a cardinal direction, and in which 0,0 is the center of the scene.

The default Alignment setting in Harmony is based on such a traditional 4:3 drawing grid. In a scene with an 
aspect ratio of 4:3, this means that positioning an element 12 fields in any direction will make it reach one of 
the edges of the camera field. For example, 12 North is the vertical position of the upper edge of the camera 
field, and 12 East is the horizontal position of the right edge of the camera field.

However, since the most commonly used scene resolutions have an aspect ratio of 16:9, and the default grid is 
in a 4:3 proportion, the grid used to position element will not be in the same proportions as the camera field. 
The way this is handled is determined by the Field of View setting in the Resolution tab. If your field of view is 
set to Horizontal fit, the field grid will be made to fit the scene horizontally, and stretch beyond the vertical 
edges of the scene. This means that 12 East will still be the right edge of the screen, but the position of the 
upper edge of the scene will be about 9.36 North. Likewise, if the field of view is set to Vertical Fit, the upper 
edge of the field will be at 12 North, but the right edge will be at about 16 East. 

Some artists or studios may prefer to use a square fields grid, where fields have the same size horizontally and 
vertically. 

Parameter Description

Alignment
The list of alignment presets. By default, Harmony has these two alignment 
presets:
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Parameter Description

 l 4:3 12 Fields: Defines the units of your project to have a 4:3 ratio and sets 
up 12 of these units to run both vertically and horizontally in four 
cardinal quarters (NW, NE, SW, SE). This is the default setting, and it 
corresponds to an animation grid used in traditional animation. Hence, 
coordinates based on a traditional animation grid can be entered in 
Harmony as is to position elements where they are expected to be.

 l Square 12 Fields: Defines the units of your project to have a 1:1 or 
square ratio and sets up 12 units to run both vertically and horizontally in 
four cardinal quarters (NW, NE, SW, SE). 

NOTE 

When the Grid is displayed in the Camera and Drawing view, it is always 
based on the 4:3 12 Fields alignment preset, regardless of your scene's 
alignment setting. To display the grid, from the top menu, select View > 
Grid > Show Grid.

Units Aspect Ratio

The aspect ratio of each field. This describes the proportional difference between 
the width and the height of the field. By default, it is set to 4:3, which means the 
width of each field will take 4 unites of length for each 3 units the height of the 
field takes. In other words, the width of a field is 1.333 times its height. If set to, 
for example, 1:1, the fields will be perfectly square. 

Number of Units
The number of fields the grid should have in each direction. In the Number of 
Units fields, enter the number of horizontal, vertical and depth units for your 
scene’s grid.
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Parameter Description

The grid is a specific size based on the scene's resolution and field of view angle. 
Changing the amount of units for each direction will not change the size of the 
grid, but rather, the size of the units. Hence, if an element is offset at 3 North, 4 
East, and you change the number of horizontal and vertical units from 24 to 12, 
the element will become offset twice as far from the centre as it originally was.

The third setting in this field determines the amount of units across the Z axis. 
This determines how far each unit will take an element further or closer to the 
camera when moved on the Z-axis. By default, the grid has 12 fields across the Z-
axis, which is half the amount of fields on the X and Y axes by default. Hence, 
each field on the Z-axis is worth exactly twice the length of a field on the 
horizontal axis. 

Animators who are familiar with traditional animation method will understand 
the default setting of 24 units horizontal by 24 units vertical as it corresponds to 
a traditional animation grid. 

Coordinates at Centre

The offset for the centre of the fields grid. The centre of the fields grid is where 
elements are positioned by default, when they themselves are at coordinates 0,0. 
To change the centre, you must enter its offset from the actual centre of the grid 
in fields. For example, if your fields grid is 24 x 24, and you want the centre to be 
at the top-left corner, you should enter -12,-12. 

Save
Saves your current Alignment settings and be able to select them later from the 
list.

TIP 

If you prefer working in pixel-based positions, you must set the aspect ratio of your units to be the 
same as the aspect ratio of your scene resolution, set the horizontal number of units to the  width of 
your scene in pixels, the vertical number of units to the height of your scene in pixels, and the 
depth number of units to the width of your scene in pixels. This way, each unit will translate to 
exactly 1 pixel, in all directions. 

NOTE 

Each layer also has an alignment rule, which determines how it is positioned relative to the fields 
grid. By default, it is set to "Centre First Page". However, this alignment rule is made to be 
compatible to 4:3 fields grids. Hence, if you change your scene's alignment rules, your layers will be 
offset. To avoid this issue, change the alignment rules of your layers to "Centre" via the Advanced 
tab of the Layer Properties view.
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Drawing Resolution Tab

The drawing resolution tab is used to set the pixel density of bitmap drawings as well as of bitmap textures in 
textured brush strokes in vector drawings. Also, it is used to set the size of the canvas for bitmap drawings 
relative to the size of the scene. 

NOTE 

These settings are applied to newly created drawings in the scene, but not to existing drawings in 
your scene. To change the pixel density of existing vector drawings, you must select Drawing > 
Change Vector Drawing Brush Resolution from the top menu. To change the pixel density and 
canvas size of existing bitmap drawings, you must select Drawing > Change Bitmap Drawing 
Resolution from the top menu.

NOTE 

You can change the default drawing resolution settings for new scenes in the Drawing tab of the 
Preferences dialog. 

Parameter Description

Scene Resolution
This indicates the currently selected scene resolution preset and its dimensions 
in pixels. 

Default Texture Density for 
Vector Drawings

Pixel Density:Determines the amount of pixels to store in textured brush strokes 
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Parameter Description

for each pixel that displays when the drawing is not zoomed in or scaled up. For 
example, at 100%, zooming in or scaling up textured brush strokes will make 
them lose texture quality. If set to 200%, textured brush strokes can be zoomed 
in or scaled up until they're twice their original size without losing picture 
quality.

Default Canvas Size and 
Pixel Density for Bitmap 
Drawings

Width: The default width of the canvas when creating drawings in a bitmap 
drawing layer. The percentage is relative to the width of the scene. Its default 
value, 200%, makes the width of the canvas twice the width of the stage. 

Height: The default height of the canvas when creating drawings in a bitmap 
drawing layer. The percentage is relative to the height of the scene. Its default 
value, 200%, makes the height of the canvas twice the height of the stage.

Pixel Density: Determines the amount of pixels to store for each pixel that 
displays on the screen when the drawing is not zoomed in or scaled up. For 
example, at 100%, zooming in or scaling up a bitmap drawing will make it lose 
picture quality. If set to 200%, bitmap drawings can be zoomed in or scaled up 
until they're twice their original size without losing picture quality.

Colour Space

Parameter Description

Working The working colour space of a project is the one used internally by Harmony. It is also the default 
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Parameter Description

Colour 
Space

colour space used for decoding the colours in drawing layers as well as for exporting images and 
movies. However, those can be configured to be different from the project colour space if needed.

The following colour spaces are available in Harmony:

 l No Colour Space Management: No colour space conversion will be done in the entire 
project, even if you set the colour space for your drawing layers or for rendering your scene.

 l Linear: The same primaries and white point as sRGB and Rec. 709, but with no gamma 
transfer curve applied to the colour values. This colour space is useful for compositing 
intermediary images that are meant to be rendered in sRGB or Rec. 709.

 l Display P3: A colour space commonly used for digital projection. It has the same primaries 
as DCI-P3, the same white point as sRGB and the same gamma transfer curve as sRGB.

 l Display P3 Linear: The same as Display P3, except with no gamma transfer curve. This 
colour space is useful for compositing intermediary images that are meant to be rendered in 
Display P3.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and white point as 
sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a gamma transfer 
curve of 2.4 (per ITU-R BT.1886). This colour space exists because some editing systems 
use a gamma transfer curve of 2.4 instead of the standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It has a complex 
gamma transfer curve and primaries that cover more of the human-perceivable colour space 
than other colour spaces, especially in the area of human-perceivable greens. 

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple gamma transfer 
curve of 2.4 (per ITU-R BT.1886). This colour space exists because some editing systems 
use a gamma transfer curve of 2.4 instead of the standard gamma curve for Rec. 2020.

 l Rec. 2020 Linear: The same colour space as Rec. 2020, except with no gamma transfer 
curve. This colour space is useful for compositing intermediary images that are meant to be 
rendered in Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It has the same 
primaries and white point as Rec. 709, but has a different gamma transfer curve.

By default, your drawing layers are read in the same colour space as your project, and your 
rendered frames are created in the same colour space as your project as well. However, if the 
colour space for the project is different from the colour space used for drawing layers and from the 
colour space used for rendering your scene, the project colour space serves as the “intermediary” 
colour space. 

This means that, in the process of rendering your scene, your drawing layers are converted from 
their colour space to the project’s colour space, after which they are composited together along 
with your scene’s visual effects, and finally the rendered image is converted to the colour space 
selected for rendering your scene.
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Parameter Description

Hence, from a compositing perspective, it is recommended to set your project’s workspace to the 
linear variant of the colour space used for your drawing layers and for rendering your scene. 
Working this way ensures that calculations made on the colour values for compositing visual 
elements effects are not affected by the colour space’s gamma curve. The following is a table of 
recommended colour space configurations:

Drawing Layer Colour Space Project Colour Space Rendering Colour Space

sRGB Linear sRGB

Rec. 709 Linear Rec. 709

Rec. 709 2.4 Linear Rec. 709 2.4

Rec. 2020 Rec. 2020 Linear Rec. 2020

Rec. 2020 2.4 Rec. 2020 Linear Rec. 2020 2.4

Display P3 Display P3 Linear Display P3
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Scripts Manager Dialog Box
The Scripts Manager dialog allows you to create buttons in the Scripting toolbar. Each button you create can 
run a specific function in one of your scripts. You can also choose an icon and a tool tip for the button, if you 
want. 

NOTE 

For tasks related to this dialog box, see the User Guide.

How to access the Scripts Manager Dialog Box

 1. Add the Scripting toolbar to your workspace by doing one of the following:

 l In the top menu, select Windows > Toolbars > Scripting.

 l Right-click on any existing toolbar and select Scripting.

 2. In the Scripting toolbar, click on the  Manage Scripts  button.

The Scripts Manager dialog box opens.

Parameter Description

Files A list of the available JavaScript files.
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Functions A list of the available functions for the selected script.

In Toolbar The list of script functions already added to the Scripting toolbar. 

Execute

Runs the selected function.

TIP 

Press Esc to interrupt the execution of the script.

Customize Icon
Allows you to select an icon for the toolbar button. Clicking on this button will 
open an Open dialog prompting you to browse for and select a .png, .jpg, .xpm 
or .svg file.

Customize Tooltip Allows you to type in a custom tooltip for the toolbar button. 
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Select Colour Dialog Box
The Select Colour dialog box lets you set the colour of layers and columns.  Using colours for layers and 
columns helps to differentiate them visually, making them easy to identify. The colours you choose will be 
reflected in the Node view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the HSV 
or RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom colour that 
you can reuse.

How to access the Select Colour dialog box in the Timeline view

 1. In the Timeline view, click the Change Track Colour  button of the layer you want to modify. 

The Select Colour dialog box opens.

How to access the Select Colour dialog box in the Xsheet view

 1. In the Xsheet view, select one or more columns to modify.

 2. Right-click on the column’s header and select Colour > Change Columns Colour.

The Select Colour dialog box opens.

Parameter Description

Basic colours A basic set of colours to choose from.
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Custom colours
Displays the custom colours you previously stored using the Add to Custom 
Colours button.

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.

Value slider
Once you select a colour, you can drag the slider to change the intensity and see 
it previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness 
(value) of the colour.

Red, Green, Blue Lets you set the red, green and blue values.
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Selection Presets Dialog Box
As you're animating, you might find that you are constantly selecting the same pegs, drawing layers, bezier 
points on a deformation envelope, part of a character rig, etc. You can create a preset that automatically selects 
any defined element or group of elements.

How to access the Selection Presets dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l right-click on the empty space near the top of the interface  and from the quick-access menu 
selecting Scripting.

 l right-click on the empty space near the top of a view and from the quick-access menu 
selecting Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager 
window.

 3. In the Scripts Manager, in the Files section, select the file TB_SelectionPreset.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_SelectionPreset.

The Add script to toolbar button becomes active.
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 5. Click on the Add script to toolbar button.

The TB_SelectionPreset script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Scripting toolbar, click on the TB_SelectionPreset  button.

The Selection Presets window opens.

Parameter Description

Refresh Removes any highlighted zones from the Group column.

Add Selection Preset 

Opens the Save Selection As Preset dialog box. After entering a name for the new 
preset and clicking OK, a new Selection Preset is added to the Selection Presets 
list. Note: before clicking on the Add button, make a selection in your scene of 
the elements for which you wish to create a Selection Preset.

Delete Selection Preset Deletes the selected Selection Preset from the list.

Group
Double-click in this area, next to the  Selection Preset you wish to use, to select 
the elements defined by the preset.

Name Displays the name of the preset.
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Apply to Selection Selects the elements defined by the selected preset from the Name list.

Close Closes the Selection Presets window.
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Sequence Fill Dialog Box
The Sequence Fill dialog box lets you Lets you create a numbered sequence over a selection. The sequence can 
be forward, backward, single, double or higher increment, as a cycle, and so on. The selection can be over one 
cell or a cell range in one column or more or an entire column or many entire columns.

How to access the Sequence Fill dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 2. Do one of the following:

 l From the top menu, select Animation > Cell > Sequence Fill. 

 l In the Timeline view, right-click and select Exposure > Sequence Fill.

 l In the Xsheet toolbar, click the Sequence Fill  button (you may have to customize 
the toolbar to display it).

 l Press Ctrl + M (Windows/Linux) or ⌘  + M (macOS)).

The Sequence Fill dialog box opens.
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Parameter Description

Starting Value The first number in the sequence.

Increment
Lets you type the number by which the drawing number will increase from frame 
to frame. For example, an increment of 1 gives you: 1-2-3-4; an increment of 2 
gives you: 1-3-5-7; and -2 gives you this: 8-6-4-2.

Hold The exposure holding value.

Cycle
Enable this option to cycle the values and enter the number of cycles in the Cycle 
field.

End Frame
Enable this option to stop the fill at a specific frame within the selection. Indicate 
the frame number in the End Frame field.

Padding
Enable this option to add a 0 padding before the drawing name. In the Padding 
field, enter as many hash symbols (#) as digit you want in your drawing name, 
including the value itself.

Add Key Exposure After
Inserts a key exposure on the frame following the last cell of the new fill 
selection. 
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Set Ease for Multiple Parameters Dialog Box
The Edit Set Ease for Multiple Parameters dialog box lets you apply ease to multiple functions and keyframes. 
You can display the function curve and modify the Bezier or Ease curve.

How to access the Set Ease for Multiple Parameters dialog box

 1. In the Timeline view, select a keyframe on one or more layers.

 2. Do one of the following:

 l In the Timeline view, right-click and select Set Ease For Multiple Parameters. 

 l In the Timeline toolbar, click the Set Ease For Multiple Parameters  button.

The Set Ease For Multiple Parameters dialog box opens.

Parameter Description

Filters

Motion

 

Motion: Applies the easing parameters to the selected Position X, Position Y, 
Position Z and 3D Path functions.

Rotation: Applies the easing parameters to the selected Angle functions.
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Parameter Description

Scale: Applies the easing parameters to the selected Scale functions.

Skew: Applies the easing parameters to the selected Skew functions.

Morphing: Applies the easing parameters to the selected Morphing Velocity 
functions. Note that it applies to the Morphing velocity function found in the 
Layer Properties window, not the basic morphing ease in the Tool Properties 
view.

Other: Applies the easing parameters to all the other the selected functions, 
such as all functions created to animate effect parameters.

Left and Right Time Ratio
Lets you type the percentage value corresponding to the length of time you want 
the easing to last. Stay between 0% and 100%. If you go beyond 100%, your 
motion will overshoot. 

Left and Right Value Ratio
Lets you type the percentage value of how strong you want the easing out to be. 
Stay between 0% and 100%. If you go beyond 100%, your motion will 
overshoot. 

Apply/Previous
Applies the easing parameters to the selected keyframes and then selects the 
previous keyframe in the timeline.

Apply Applies the easing parameters to the selected keyframes.

Apply/Next
Applies the easing parameters to the selected keyframes and then selects the 
next keyframe in the timeline.

Close
Close the dialog box. If you did not apply the modifications, they will be 
cancelled.
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Set Ease on Keyframes Dialog Box
The Set Ease on Keyframes dialog box allows you to quickly change the percentage of ease before and after a 
selection of keyframes. 

This dialog box is designed to quickly adjust the “time ratio” of the ease on your animations. To give you a 
better idea of its effect, select a keyframe and open the Set Ease for Multiple Paramters dialog box. This dialog 
box allows you to adjust the ease of your animations using Bezier handles. Moving the Bezier handle laterally 
changes the time ratio of the ease, and moving it vertically changes its value ratio—see Set Ease for Multiple 
Parameters Dialog Box on page 232.

How to access the Set Ease on Keyframes dialog box

 1. In the Timeline view, select one or several animation keyframes.

 2. In the Timeline toolbar, click on the  Set Ease on Selected Keyframes button.

The Set Ease on Keyframes dialog box appears.

Parameter Description

Ease In 
(left)

Allows you to adjust the ease left of the selected keyframes.

 l If the checkbox is unchecked, the ease left of the selected keyframes will be unchanged.
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Parameter Description

 l If the checkbox is checked, the ease left of the selected keyframes will be set to the 
percentage in the input-field right of the checkbox. 

Ease Out 
(right)

Allows you to adjust the ease right of the selected keyframes.

 l If the checkbox is unchecked, the ease right of the selected keyframes will be unchanged.

 l If the checkbox is checked, the ease right of the selected keyframes will be set to the 
percentage in the input-field right of the checkbox. 

OK Applies the selected changes and closes the dialog box.

Cancel Closes the dialog box without making any changes.
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Master Controller Slider Wizard Dialog Box
The Master Controller Slider Wizard dialog allows you to generate a slider-type Master Controller widget 
which can be used to position a character model based on a range of two or more key poses. 

To use the Slider Wizard, all you need to do is to provide it with a selection of layers and/or groups (ie: a 
character rig, or part of a character rig) as well as a range of frames. The Slider Wizard dialog will store all the 
poses for the selected layers in the selected range of frames in a file, and generate a Slider widget which, 
when manipulated by the user, is scripted to apply one of these poses, or an intermediary between two of 
these poses, onto these layers.

A good example of how this dialog can be used is by creating poses of your characters in key angles (ie: front, 
3/4 front, side, 3/4 back and back, as well as the flipped versions of these angles), and creating a slider made 
to interpolate between all these poses. If done properly, and provided that all the poses provided can be 
interpolated, the result will be a slider widget that can be used to pose the character in any angle. 

How to access the Slider Wizard

 1. Do one of the following to add the Master Controller toolbar to your workspace:

 l Right-click on an existing toolbar and select Master Controller.

 l In the top menu, select Windows > Toolbars > Master Controller. 

The Master Controller toolbar appears.
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 1. In the Timeline view, select a range of frames. 

 2. In the Master Controller toolbar, click on the  Slider Wizard button.

Icon Parameter Description

Source Frame Range

  First Frame The frame number of the first frame in the selection.

  Last Frame The frame number of the last frame in the selection.

Slider Properties

  Invert Direction

By default, the slider will interpolate from the first pose to the last 
post by sliding the handle from bottom to top, or from left to right if 
the Horizontal Layout option is checked. If this option is checked, 
the slider will interpolate from the first pose to the last pose by 
sliding the handle from the top to the bottom, or from right to left. 

  Horizontal Layout
By default, the slider will slide on a vertical axis. If this option is 
checked, it will slide on a horizontal axis. 

Monitored Attributes

  Attribute List

The list of nodes (ie: layers, pegs, deformation points, etc.) that will 
be affected by the Master Controller. If you expand any of the listed 
nodes, you will find the list of attributes (ie: position, angle, scale, 
etc.) 

The list is structured in a group/node/attributes hierarchy, with Top 
representing the root of your scene. By expanding a group, you will 
find all of the nodes inside that group. By expanding a node, you 
will find all of its attributes. 

  Add Selected Nodes

If you first select groups nodes in the Timeline or Node view, you 
can click on this button to add these nodes' attributes to the 
Monitored Attributes list. This allows you to add more nodes to the 
list of nodes that will be controlled by the Master Controller. 

If you select a group, this button will add the group as well as every 
node inside that group to the Monitored Attributes list. 
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Icon Parameter Description

Remove Selected Items

Removes the groups, nodes or attributes that are currently selected 
in the Monitored Attributes list from the Monitored Attributes list. 
This allows you to remove nodes from the list of nodes that will be 
controlled by the Master Controller.

If you select a group, this button will remove the group as well as 
every node inside that group from the Monitored Attributes list. 

If you select specific attributes in a node, this button will only 
remove these attributes from the Monitored Attributes list, and will 
leave the other attributes in the list. This allows you to make the 
Master Controller only control specific attributes for a node and 
ignore others.

Filter Static Attributes

Remove every attribute that does not change during the selected 
frame range. This will optimize the performance of the Master 
Controller as well as reduce the amount of storage space it uses 
without impacting its functionality.

  Node Count
The amount of nodes (layers, pegs, deformation points, etc.) that 
will be controlled by the Master Controller. 

  Attribute Count
The amount of attributes (position, angle, scale, etc.) that will be 
controlled by the Master Controller.

Output

  Name Allows you to type in a base name for your Master Controller.

  States Filename
Displays the path and name of the file where the poses database will 
for the Master Controller will be stored. This path is relative to the 
scene directory. 

  Master Controller Name
Displays the name of the Master Controller node that will be added 
to your scene. This is the name of your Master Controller the prefix 
mc_.

  Create Generate the Master Controller and its database of poses. 
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Show Hidden Columns Dialog Box
The Show Hidden Columns dialog box lets you display all the columns contained in the exposure sheet. It can 
be used to hide individual columns.

How to access the Show Hidden Columns dialog box

 1. In the Xsheet view, do one of the following:

 l Click the thick grey line that represents a hidden column. 

 l Right-click on the column header and select Show Hidden Columns.

 l Press Alt + Shift + H.

The Show Hidden Columns dialog box opens.

Parameter Description
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Show Lets you select the hiddens columns to display in the Xsheet view.

Name Name of the drawing.

Type Indicates the column type such as column, timing, and expression.

Check Selects all columns.

Uncheck Deselects all selected columns.
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OpenQuickTime Sound Options Dialog Box (GNU/Linux)
The OpenQuickTime Sound Options dialog box (titled MediaSettings) allows you to configure the audio 
compression settings when exporting a QuickTime movie on Linux. 

On GNU/Linux, Harmony uses the OpenQuickTime framework to export QuickTime movies. This framework 
uses its own user interfaces to allow you to configure the video and audio compression settings for a movie. 
Because OpenQuickTime only comes bundled with non-prorprietary codecs, its compression options are 
limited.

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on GNU/Linux.

How to access the OpenQuickTime Sound Options  dialog box                                       from the Export Movie 
dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the OpenQuickTime Sound Options  dialog box from the Export 
OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.
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The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Sound Options button.

How to access the OpenQuickTime Sound Options  dialog box from the Write node 
Layer Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.
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The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).

 2. To the right of Sound Options, click Customize.

Parameter Description

codec

Lets you select a codec. By default, the following codecs will be available:

 l A-Law 2:1: This codec uses logarithms to compress audio data. The 
resulting audio stream requires half the disk space of uncompressed 
audio data, but is of noticeably lower quality.

 l IMA 4:1: This codec compresses audio data to require a quarter of the disk 
space required for uncompressed audio data. It is not supported by a lot 
of software.

 l Twos Complement - Little Endian PCM: A standard uncompressed 
audio codec. 

 l Twos Complement - Big Endian PCM: A legacy standard uncompressed 
audio codec. This codec may be compatible with older editing interfaces. 
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 l (mu)-Law 2:1: Similarly to A-Law, this codec uses logarithms to 
compress audio data. The resulting audio stream requires half the disk 
space of uncompressed audio data, but is of noticeably lower quality.

NOTE 

It is recommended to leave this option to its default value, Twos 
Complement - Little Endian PCM, as it is commonly used for storing 
uncompressed audio. Other encoding formats are likely to sacrifice audio 
quality for negligible savings in disk space.

Sample rate
The sample rate at which to export your scene's audio. The only available option 
is 22050 Hz, as it is the sample rate used internally by Harmony.
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QuickTime Sound Settings Dialog Box (Windows)
The Sound Settings dialog box allows you to set the audio compression settings when you want to export a 
QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Sound Settings dialog box                                       from the Export Movie 
dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Sound Settings dialog box from the Export OpenGL 
Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.
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The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

The QuickTime Movie Settings dialog box appears.

 5. In the Sound section, click Settings.
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How to access the QuickTime Sound Settings dialog box from the Write node Layer 
Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.

The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).
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 2. To the right of Movie Options, click Customize.

The QuickTime Movie Settings dialog box appears.

 3. In the Sound section, click Settings.

Parameter Description

Compressor

Allows you to select the compression algorithm to use the compress the movie's 
audio track. 

NOTE 

It is recommended to leave this setting to None, as other formats are 
likely to sacrifice audio quality for negligible savings in disk space.

Rate

Allows you to select the sample rate, or frequency, in which to export the audio 
track for the movie.

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 kHz. If 
you select a higher sample rate, your project's audio will be upsampled, 
which means it will take more disc space without increasing in quality. 

Size
Allows you to select the bit depth in which to encode the audio track. This 
determines the amount of precision to record each wavelength in the audio track. 
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Parameter Description

NOTE 

The standard bit depth is 16-bit. If you choose 8-bit, the amount of disk 
space the audio track of your movie file requires will be halved, but the 
audio quality will be significantly lower.

Use

Allows you to select whether to export the movie's audio track using the Mono 
or Stereo channel mode.

NOTE 

Stereo sound has a separate track for the left and right speakers, whereas 
mono sound only has a single audio track for all speakers. 
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QuickTime Standard Video Compression Settings Dialog Box 
(Windows)
The Standard Video Compression Settings dialog box allows you to configure the video compression settings 
when exporting a QuickTime Movie (.mov) file. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows and requires Apple QuickTime to be installed.

How to access the QuickTime Standard Video Compression Settings dialog box                                       from 
the Export Movie dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the QuickTime Standard Video Compression Settings dialog box from 
the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.
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The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

The QuickTime Movie Settings dialog box appears.

 5. In the Video section, click Settings.
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How to access the QuickTime Standard Video Compression Settings dialog box from 
the Write node Layer Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.

The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).
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 2. To the right of Movie Options, click Customize.

The QuickTime Movie Settings dialog box appears.

 3. In the Video section, click Settings.

Parameter Description

Compression Type

Allows you to select the codec to use to compress the video stream of your 
movie. It is recommended to use one of the following codecs, depending on your 
usage scenario:

 l H.264: A very effective lossy compression algorithm that is commonly 
supported by web browsers and most media players.

 l MPEG-4 Video: A very effective lossy compression algorithm that is 
commonly supported by media players, but less so by web browsers.

 l Animation: A high quality compression algorithm that is commonly used 
for media interchange and video editing. 

TIPS 

 l You can export a video with transparency by selecting the 
Animation codec and setting the Depth setting to Millions of 
Colors+.

 l You can export a video with virtually lossless compression by 
selecting the Animation codec and setting Quality setting to 
Best.
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Parameter Description

Motion

Frame Rate
The amount of frames per second for the video stream. Leave this setting to 
Current to use your project's frame rate. 

Key Frames

Some codecs compress the video by recording a limited amount of keyframes, 
which are frames in which the entire picture is encoded, pixel by pixel and, in-
between, recording deltas, which are frames that are only defined by their 
difference with the previous frame. This significantly reduces the size of the 
movie file. However, the less keyframes a movie has, the more it is likely to 
encounter decoding errors, and the harder it is for players to scrub or jump to a 
specific time in the video. This option allows you to decide when keyframes are 
inserted in the video stream. 

Automatic: Lets the encoder decide when keyframes should be inserted.

Every ... frames:  Allows you to set the exact interval, in frames, at which 
keyframes should be inserted. 

All: Encodes every frame as a keyframe. This option will significantly impact file 
size, but will make it easier to scrub through the video without causing any 
rendering error. 

NOTE 

If you are using the H.264 codec, you must set the Key Frames option to 
All, or you will get an error message when you confirm the compression 
settings.

Frame Reordering
Encodes frames in a different order than the one at which they are meant to be 
displayed. This allows for more efficient compression, but may not be compatible 
with some players. 

Compressor

Depth

Allows you to set the colour depth for your video. A lower colour depth will 
reduce the size of the video stream but will have significant impacts on picture 
quality. 

TIP 

Set this to Millions of Colors+ if you want to export a video with 
transparency. 
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Parameter Description

Quality

Lets you choose a quality setting for the video compression. A higher quality 
setting will increase the size of the movie file, but will look better. A lower 
quality setting will reduce the size of the movie file, but will cause blurriness and 
compression artifacts to appear in the picture. 

Scan Mode / 
Interlaced

Allows you to choose between the following scan modes:

 l Interlaced: Frames are encoded starting with their odd-numbered 
scanlines, then their even-numbered scanlines.

 l Progressive: Frames are encoded whole, from the highest scanline to the 
lowest scanline. 

NOTE 

Some codecs will display a drop-down allowing you to select Interlaced or 
Progressive, while others will simply have an Interlaced checkbox. 

Aspect Ratio

Allows you to select one of the following aspect ratios:

 l 4:3: For output on standard definition displays. 

 l 16:9: For output to widescreen displays. 

Filter

When exporting with the PNG compression type, this determines the algorithm 
with which each pixel is encoded relative to other pixels. Leaving this option to 
Best will export in the most space-efficient filter, without compromising picture 
quality. Picking a filter may increase rendering speed a bit, at the expense of  some 
disk space.

Data Rate

Automatic Lets the encoder use the optimal bit rate for your compression settings. 

Restrict To

Allows you to specify the encoding bit rate. 

NOTE 

This setting will override other compression settings, so that the specified 
bit rate is respected. 

Optimized For Optimize the encoding to be responsive depending on the intended viewing 
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Parameter Description

method:

 l CD/DVD-ROM: Optimizes the bit rate for a video that will be played using 
an optical disc player.

 l Download: Optimizes the bit rate for a file that is going to be 
downloaded, then viewed from the user's hard drive.

 l Streaming: Optimized the bit rate for a video that will be streamed from 
the web and played as the video is being downloaded. 
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Tint Offset/Blend  Dialog Box 
You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

How to access the Tint Offset/Blend dialog box

 1. From the Colour View  menu, select Palettes > Tint Panel or right-click and select Tint Panel.

The Blend/Offset Tint panel opens.

Parameter Description

Offset
Offsets the selected colours by the adjustments made using the HSB and RGB 
sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider 
to adjust the opacity of the selected colour. 

Blend

Blends the selected colours with the colour swatch in the top-right corner. Use 
the Amount slider to adjust the degree of blend. A blend of 100% turns the 
selected colours into the same colour as the swatch. Adjusting the HSB and RGB 
sliders affect the swatch colour, which in turn affects the selected colours on the 
left. Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just 
beneath to mix the Base and Tint colours by different amounts. This will affect 
the mixed swatch whether it is selected or not. Select either the Tint or Base 
swatch and use the HSB and RGB sliders to adjust its colour. This will affect the 
mixed swatch colour, which in turn affects the selected colours on the left.
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Timing Node

The Timing-nodes exist in a new category of nodes called “Timing” in the node-library. These nodes are used 
to either show a different render at the given frame, or to transform the content with a transformation from a 
different frame. The Timing-nodes exists as both Retime (for Images) and Retime Transformation (for 
transformations).

The Retime node takes an image input and output, and will provide the retimed transformation and render of 
that image.

The Retime Transformation node takes a transformation input and output, and will provide the retimed 
transformation.

How to access the Retime and Retime Transformation Timing dialog box

 1. In the Node View press Enter.

 2. Type in the name of the node you want to search.

 3. Select the node.

 4. Click the yellow box on the left to open the dialog box.
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 l Retime Mode: Defines the way in which this node calculates the target frame to output.

 l Target Frame: It will use the Value attribute as an exact frame and outputs the content from 
that frame.

 l Frame Offset: It will use the Value attribute as an offset to the current frame and outputs the 
content from that offset frame.

 l Value: It provides the target frame or offset frame, depending on the retime mode.

 l Hold First Frame: This defines the node’s render behaviour. In the event that the retimed frame is 
less than 1 When enabled, the hold first frame option will cause the node to display the first frame 
until the Retime node hits a valid frame above 1. When disabled, the node will remain blank until a 
valid retimed frame is reached.

 l Disable Selection: This option is available in all timing nodes. It is recommended to disable the 
timing node when modifying content, and reapply it when the content is complete.

 l Hide from Timeline: This option will collapse all attached content above this node in the Timeline, 
preventing it from being selected or modified directly in the Timeline.
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Toolbar Manager Dialog Box
The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite 
tools to a toolbar for an efficient workflow.

How to access the Toolbar Manager dialog box

 1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if 
you right-click on a disabled icon.

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.

Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar with its default items.
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Vectorization Parameters Dialog Box
The Vectorization Parameters dialog box lets you vectorize pencil drawings, along with any red, blue or green 
pencil marks you may have used to indicate highlights and shadows. The drawing will be vectorized into pure 
red, blue, green and black (RGB values), while creating colour art zones wherever lines connect. After painting 
in your tones and highlights, change your pure RGB colours to transparent (0 Alpha) in the Colour Picker 
window and watch the indicator colour zone lines disappear.

How to open the Vectorization Parameters dialog box

 1. From the top menu, select File > Import > From Scanner.
You can also open it from any other import option that allows you to customize the vectorization 
parameters (i.e. from the scanner).

 2. In the Scan Drawings window, do the following:

 l In the Layer section, decide on the layer options.

 l In the Import Options section, select the Convert to Toon Boom Vector Drawing 
option

 l Click Preview.

 3. In the Vectorization section, click the Vectorization Parameters button.
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Options Tab

The Options tab contains the main vectorization settings. More settings are available in the Help tab.

Parameter Description

Input The input filters are applied to the bitmap image before it is vectorized.

One Pass
One threshold value is applied to both the Line and Colour Art. For drawings 
with distinct vector-style lines of mattes, you only need one pass.

Two Passes
Applies a different threshold value to each layer. For greyscale drawings, you 
may want to perform the vectorization process twice to apply different threshold 
values to the Line and Colour Art layers.

Threshold
Determines which values in the scanned image are considered part of the Line 
and Colour Art layer and what will be eliminated from the vectorized drawing; 
0% is white and 100% is black. The threshold is between these two values.

Expand Bitmap
Lets you enter a value to scale the bitmap to detect small variations in the line. 
Use this option if you scanned a greyscale image and want to preserve small 
variations in the texture to apply to the line art.

Jag Filter
Lets you enter a value to scale back the bitmap to remove some of the line’s 
roughness. This is useless when you have a drawing that appears quite rough; 
the Jag filter will eliminate excess strokes in the final drawing.

Line Art Threshold 
(%)

Determines which values in the scanned image are considered part of the Line Art 
layer and what will be eliminated from the vectorized drawing; 0% is white and 
100% is black. The threshold is between these two values.

265

Harmony 21 Premium Reference Guide                          



Chapter 1: Dialog Boxes

Colour Art Threshold 
(%)

Determines which values in the scanned image are considered part of the Colour 
Art layer and what will be eliminated from the vectorized drawing; 0% is white 
and 100% is black. The threshold is between these two values.

Output The output filters are applied during the vectorization process.

No Colour Art Does not generate filling zones in the Colour Art layer.

No Texture
Does not generate texture in the Line Art layer in the final images. Select this 
option to create solid lines in the final line art.

Generate Matte in 
Underlay Layer

Creates an opaque zone behind your drawing’s lines to avoid seeing through the 
layers.

Colour as Texture Converts colour values into a texture layer.

Optical Registration
The optical registration options are used to automatically align drawings based 
on the position of the peg holes on the animation paper. The peg holes must 
appear in the scanned drawings for the optical registration to work.

DPI
Lets you enter the dots-per-inch value of your image. You must enter the same 
value as the DPI used to scan the image.

Peg Side
Lets you select the position of the peg holes on your drawings. Identify whether 
they are on the top, bottom, left or right.

Strictness

Determines how exact the location of the peg holes must be for the software to 
recognize them. There are two values to choose from:

Strict: The peg holes must be in a tightly defined area to be recognized.

Loose: The peg holes can be recognized somewhere in a larger area. This is the 
recommended setting.

Field Chart Lets you indicate the size of the animation paper, 12 or 16.

Post Processing The Post Processing filters are applied to the final vector images.

Remove Holes Removes holes of a specified value that might make painting difficult.

Remove Dirt Removes stray marks and dirt of a specified value. Try a value around 500.
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Remove Hair Size Removes small strokes that have no line art.

Remove Hair: Number 
of Passes

The number of times the drawing will be analyzed to identify hair marks.

Miscellaneous

Close Gaps Closes gaps in the Colour Art so you can paint it.

Smooth Passes for 
Line Art Before 
Breaking Triangles

The number of times the smoothing operation runs before creating the triangles 
that break lines in the drawing. If unnecessary triangles are appearing in the 
drawing, increase this value.

Smooth Passes for 
Line Art

The number of times the smoothing operation is performed after the triangles 
have been created. This further smooths the line art.

Preview

Show Strokes Shows the strokes in the Vectorized Image panel.

Stroke Thickness Shows the size of the strokes.

Help Tab

The Help tab contains the most advanced vectorization settings which you type in the Advanced Option fields 
at the bottom of the Vectorization Parameters dialog box.

File IO Options

-file <filename (including extension)> [ options ]
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-infile <filename (including extension)>; same as -file

-outfile <filename>; alternate output file

-informat <format>; the input format. Used if reading from stdin

-debug; turn on debug mode

-noforce; don't force output if image is inconsistent

-version; print version information and quit

-output_version <version>; output files of this version. Valid versions can be: 0 or 604

-force_unamed_palette_for_texture; will generate a texture in TVG's internal palette

Registration Options 

-register <dpi side strictness>; perform optical registration.

• Side can be one of left, right, top, bottom or l, r, t, b.

• Strictness can be either loose, strict or l, s.

-register_center_peg_holes; will use only round holes in 16 fields page

-rcph; short form of register_center_peg_holes

-registration_looseness_factor <factor>; registration looseness factor (default 2.000000)

-rlf; short form of registration_looseness_factor

-rdebug; output registration debug messages

-pegpitch <inch (default 8.000000)>; distance between peg bars

-threshr < (default 0.500000)>; threshold for optical registration; range 0.0 to 1.0

-rmargin <inch (default 1)>; region size where to look for peg bars 

-peg_distance_from_center <inch (default 5.25)>; peg distance from centre of the image 

-pdfc; short form of -peg_distance_from_center 

-out_peg_position <side (default same)>; wanted position of the peg on the drawing.

• Can be one of right, left, top, bottom (or r, l, t, b) or same.

• A rotation will be performed if it is different from the side passed to -register.

-output_peg_matrix; output the peg transformation matrix on standard output.

-scanner_calibrate; < (default 1.0000 1.0000) > x and y scale factors to be applied to scanner image.

Filtering Options 

-pixel <pixel_shape (default '4x3')>; Valid values: 4x3
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-gap <worldUnits (default 10)>; close gaps up to this big

-pencil; generate line art only

-keep_dirt; don't filter out dirt

-thresh <threshold (default 0.2)>; range 0.0 to 1.0

-rmv_hairs <worldUnits (default 1)> <passes (default 1)> 

• remove hairs of size smaller than "size" in "passes" passes 

-rmv_holes <area (default 7)>; remove holes smaller than "area" 

-rmv_dirt <area (default 1)>; remove dirt smaller than "area" 

• try values between 100 and 500 for rmv_holes and rmv_dirt. The area is in world units squared

-rmv_triangles <worldUnits (default 30.000000)>; remove triangles at "pixels" 

• distance from each other. Use -no_break to remove all triangles

-no_texture; don't generate textured strokes

-color_as_texture; will vectorize the alpha channel and put the RGB colour in a textured colour

-noclosegap; disable all gap closing algorithms

-no_break; disable the breaking of line art

-jag_filter <pixels (default 0>; expand the pixels in the vectorization bitmap

-expand_bitmap <pixels (default 0>; expand the pixels in the vectorization bitmap

-fit_errorc <error (default 1.000000>; fitting error for the colour art

-fit_errorl <error (default 1.000000>; fitting error for the line art

-smoothl <passes (default 1>; number of smooth passes for line art

-smoothc <passes (default 1>; number of smooth passes for colour art

-first_smooth <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothl <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothc <passes (default 0>; number of smooth passes for line art in colour art pass (needs -2pass)

-2pass; specify two sets of parameters; one for line art "l", one for colour art "c"

(-thresh, -rmv_holes and -rmv_dirt will be overridden by -threshl, threshc, -rmv_holesl,

-rmv_holesc, -rmv_dirtl and -rmv_dirtc)

-threshl <threshold for line art (default 0.5)>; range 0.0 to 1.0

-threshc <threshold for color art (default 0.5)>; range 0.0 to 1.0

-jag_filterl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art
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-jag_filterc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-expand_bitmapl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-expand_bitmapc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-rmv_holesl <area (default 7)>; remove line art holes smaller than "area" 

-rmv_holesc <area (default 7)>; remove colour art holes smaller than "area" 

-rmv_dirtl <area (default 1)>; remove line art dirt smaller than "area" 

-rmv_dirtc <area (default 1)>; remove colour art dirt smaller than "area" 

try values between 100 and 500 for rmv_holesl, rmv_holesc, rmv_dirtl and rmv_dirtc. The values are in 
world units squared 

-margins <inch (default 0.25)>; remove margin around bitmap 

-top_margin <inch (default 0.25)>; remove margin at top of bitmap 

-bottom_margin <inch (default 0.25)>; remove margin at bottom of bitmap 

-left_margin <inch (default 0.25)>; remove margin at left of bitmap 

-right_margin <inch (default 0.25)>; remove margin at right of bitmap 

-remove_peg_bars; remove the peg bar holes

-field_size <fields (default 12 or use value in scan file)>; set the drawing to this field size

-fs; short hand for -field_size

-peg_bar_size <inch (default 1)>; the size of the peg bar region

-noframe; do not put a frame around the colour art

-frame_fields <default -1.000000>; put a frame of the specified dimension around the colour art

-downscale_input <default 1>; downscale the raw input by this integer factor

-downscale_texture <default 1>; downscale the output texture by this integer factor

-buildmatte; generate a matte on underlay for line test

-buildmatte_colourart; generate a matte on colour art for line test

NOTE 

-buildmatte and -buildmatte_colourart are mutually exclusive

-copystrokes; copy original strokes when building matte.

Options for bitmap that has no registration information 

-pixel_margins <inch (default 0)>; remove margin around bitmap 
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-top_pixel_margin <inch (default 0)>; remove margin at top of bitmap 

-bottom_pixel_margin <inch (default 0)>; remove margin at bottom of bitmap 

-left_pixel_margin <inch (default 0)>; remove margin at left of bitmap 

-right_pixel_margin <inch (default 0)>; remove margin at right of bitmap 

-dpi <(default -1)>; dpi information of input bitmap 

RGB Keying Options 

-rgb; generate separate zones for red, green and blue lines

-rgb_alpha <value (default 255)>; generate red, green and blue colour with alpha of this value

-no_red; ignore red colour in vectorization

-no_green; ignore green colour in vectorization

-no_blue; ignore blue colour in vectorization

-flatten; flatten the drawing after generating colours

-rmv_rgb_dirt <threshold area default 0.0>; remove red, green and blue regions smaller than area

-expand_bitmap_rgb <pixels (default 0>; expand the pixels in the vectorization bitmap for rgb

-threshrgb <value> <threshold for rgb vectorization default 0.200000>;

-threshsv <saturation threshold default 0.500000> <value threshold default 0.500000>; thresholds on 
saturation and value to consider a pixel to be grey

Colour Vectorization Options 

-color_vectorize; perform a colour vectorization

-file2 <colour art filename>; specify the colour art bitmap

-penstyle <center alpha (0.0-20.0)> <edge alpha (0.0-20.0)> <gamma (0-10)><centre pressure effect (0.0-
1.0)> <edge pressure effect (0.0-1.0)><texture bitmap downscaling (0.2-20)> <texture bitmap file (valid 
filename or "" if no file)>; generate brush texture for the line art

-pressure_variation <strategy (0, 1 or 2)> <min pressure (0.0-1.0)> <max pressure (0.0-1.0)> <max variation 
(0.0-1.0)>; specify a pressure strategy for the centre line. 

-blur_radius <pixels (default 0)>; blur the penstyle texture generated

-color_contour_smooth_passes <times (default 3)>; perform number of smooth passes on contour before 
computing texture

-ccsp <times (default 3)>; short for -color_contour_smooth_passes

-color_rmv_holesl <world units (default 0.000000)>; remove holes of this size when computing texture

-color_fill_holesl <world units (default 0.000000)>; fill holes of this size for colour line art
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Bubble Usage (implemented only for colour vectorization's line art)

-create_bubbles; add bubbles into the LineArt. Implemented for colour vectorization only 

-bubble_gap <value (default 3)>; max number of colour art points between 2 bubbles

-bubble_length <value (default 10)>; max number of circles in a bubble

-min_radius <value (default 1.5000)>; min radius of a circle in a bubble relative to the line thickness (must be 
>= 1.0)

-max_radius <value (default 3.5000)>; max radius of a circle in a bubble relative to the line thickness (must be 
>= 1.0)

-uniform_gap; the space between bubbles is constant 

4 Colour Vectorization

-4colours [key:value] ... [key:value] ; The key value list can be empty. The list of keys is:

rgbdiff:value ; between [0.0-1.0] or [0-255]

dark:value    ; between [0.0-1.0] or [0-255]

grey:value    ; between [0.0-1.0] or [0-255]

white:value   ; between [0.0-1.0] or [0-255]

dirt:value    ; dirt area. 200 is a good value

rt:value      ; between [0.0-1.0] or [0-255]

gt:value      ; between [0.0-1.0] or [0-255]

bt:value      ; between [0.0-1.0] or [0-255]

NOTE 

There must be no space between the colon and the key/value. For example: -4colours rgbdiff:20 
dark:20 grey:120 white:250 dirt:200 rt:240 gt:240 bt:240
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Versions Dialog Box
The Versions window lets you delete any unnecessary versions of scenes when working with Harmony Server. 
When working with multiple versions of a scene, you may to clean up the database by deleting the ones you 
no longer need.

How to access the Versions window

 1. Make sure you have the necessary rights. If you do not, select File > Rights to Modify Scene. 

 2. Select File > Manage Versions. 

Parameter Description

Existing Versions Displays the different versions of a scene that you can delete.

Description Displays information about the selected version.

Delete

Removes the selected version of a scene. 

IMPORTANT 

This operation cannot be undone.
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OpenQuickTime Video Options Dialog Box (GNU/Linux)
The OpenQuickTime Video Options dialog box (titled MediaSettings) allows you to configure the video 
compression settings when exporting a QuickTime movie on Linux. 

On GNU/Linux, Harmony uses the OpenQuickTime framework to export QuickTime movies. This framework 
uses its own user interfaces to allow you to configure the video and audio compression settings for a movie. 
Because OpenQuickTime only comes bundled with non-prorprietary codecs, its compression options are 
limited.

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on macOS.

How to access the OpenQuickTime Video Options  dialog box                                       from the Export Movie 
dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the OpenQuickTime Video Options  dialog box from the Export 
OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.
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The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Video Options button.

How to access the OpenQuickTime Video Options  dialog box from the Write node 
Layer Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.
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The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select QuickTime Movie 
(*.mov).

 2. To the right of Video Options, click Customize.

Parameter Description

codec

Allows you to select a video compression algorithm. By default, the following 
codecs are available:

 l Motion-JPEG A: A very portable codec that performs lossy JPEG 
compression and interlaces the frames. Motion-JPEG A compression is 
less efficient than Photo JPEG in terms of quality and file size, but may be 
a more portable alternative for software that does not support Photo 
JPEG. 

 l Photo JPEG: Encodes the movie as a sequence of JPEG images. JPEG 
images have lossy compression. This is the most efficient codec for file 
size. 

 l Portable Network Graphics (PNG): Encodes the movie as a sequence of 
PNG images. PNG images have lossless compression.
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 l Tag Image File Format (TIFF): Encodes the movie as a sequence of 
uncompressed TIFF images. This codec is lossless. 

 l Uncompressed (RGB): Encodes the movie as uncompressed bitmap data. 
This codec is lossless. 

NOTE 

Portable Network Graphics (PNG) and Photo JPEG are the only 
codecs in this list that are natively supported by both Harmonyand 
GNOME's Totem Video Player. Other codecs may require additional 
software to play on GNU/Linux workstations. 

quality
When using a JPEG-based codec, this allows you to set the JPEG compression 
quality. By default, this will be set to 85. Possible values range from 0 to 100. 
The higher the quality, the more disk space the resulting video file will take.

fieldDominance

For codecs with interlacing. This is set to 1 by default. If set to 1, the first field 
will be encoded on odd frames, and the second field will be encoded on even 
frames. If set to 2, the first field will be encoded on even frames, and the second 
field will be encoded on odd frames.

compression
The amount of lossless compression to perform when exporting in PNG format. 
PNG compression is lossless, but higher compression settings will take longer 
to encode and decode.

packbits
For movies encoded in TIFF. When enabled, this option adds extra lossless 
compression to the encoding.

lendian
For movies encoded in TIFF. When enabled, the video data is encoded in little 
endian byte order, instead of big endian. 
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Windows Media Video Settings Dialog Box (Windows)
The WMV Settings dialog box allows you to configure the video and audio settings when exporting a movie in 
Windows Media Video (.wmv) format. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 l This dialog can only be accessed on Windows.

How to access the WMV Options dialog box                                       from the Export Movie dialog                

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.
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 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.

 4. In the Codec drop-down, select any of the movie options.

How to access the WMV Options dialog box from the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.
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 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select Windows Media Video (*.wmv).

 4. Click on the Movie Options button.

How to access the WMV Options dialog box from the Write node Layer Properties

 1. In the Node view, locate your scene's Write node.

 2. Open the Write node's Layer Properties by doing one of the following:

 l Click on the yellow square  at the left end of the Write node.

 l Right-click on the Write node, then select Layer Properties.
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The Write node's Layer Properties dialog appears.

 3. In the Write node's Layer Properties, enable the Movie option.

 1. To the right of the Movie check box, open the drop-down menu and select Windows Media Video 
(*.wmv).

 2. To the right of Movie Options, click Customize.

Parameter Description

Video

Variable Bit Rate 
Quality

Allows you choose a quality setting ranging from 5 to 100 for the video stream. 
The higher the quality of the export, the larger the resulting file.

Sound

Uncheck this checkbox if you want to export a movie without an audio track.

NOTE 

The Sound section of this dialog is not available if you are exporting an 
EDL/AAF/XML sequence, as this type of export creates video files with no 
audio track and export sound clips in separate sound files. 
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Profile

Allows you to select one of the preset combinations of audio sample rates, 
sample sizes and channel modes for the audio stream:

 l Sample rate: Available sample rates are 8000 Hz, 16000 Hz, 22050 Hz 
and 44100 Hz. The higher the sample rate, the better the audio quality. 

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 
kHz. If you select a higher sample rate, your project's audio will be 
upsampled, which means it will take more disc space without 
increasing in quality. 

 l Sample size: Also known as bit depth, this determines the amount of 
precision used to record each wavelength in the audio track. The standard 
size is 16-bit. If you choose 8-bit, the amount of disk space the audio 
track of your movie file requires is halved, but the audio quality will be 
significantly lower.

NOTE 

Exporting in 8-bit audio requires Apple QuickTime to be 
installed. 

 l Channel mode:  Available channel modes are Stereo and Mono. Stereo 
sound has a separate audio track for the left and the right speakers, 
whereas mono sound uses a single track for all speakers.
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Xsheet Column Width Dialog Box
The Xsheet Column Width dialog box lets modify the width of a column in the Xsheet view and use it as the 
default column width.

How to access the Xsheet Column Width Dialog Box

 1. In the Xsheet view, select a column.

 2. From the Xsheet menu, select View > Set Columns Width.

The Xsheet Column Width dialog box opens.

Parameter Description

Columns Width (pixels) Lets you set the width of the selected columns (in pixels).

Apply
Applies the value you entered to the selected column without closing the dialog 
box.

Set As Default Uses the value you entered as the default for all columns in the Xsheet.
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Chapter 2: Menus
The Menus section covers all the menu entries available in Harmony. There are several types of menus in 
Harmony: main menus, quick-access menus and view menus. Menus contains most of the functions available. 
They may also have a toolbar button or keyboard shortcut equivalent.

Main Menus 288

Animation Menu 289

Drawing Menu 299

Edit Menu 307

File Menu 311

Help Menu 315

Insert Menu 317

Play Menu 319

Scene Menu 321

View Menu 323

Windows Menu 330

View Menus 332

3D Graph View Menu 333

Camera View Menu 335

Colour View Menu 352

Drawing View Menu 355

Function View Menu 368

Library View Menu 370

Model View Menu 372

Node View Menu 374

Node Library View Menu 379

Onion Skin View Menu 380

Perspective View Menu 382

Script Editor View Menu 388

Side View Menu 393

Timeline View Menu 398
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Top View Menu 403

Xsheet View Menu 408
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Main Menus
The top menu contains most of the commands available in Harmony. Depending on the view you're working in 
and the selected element, some commands are available and others not. The top menu is always located at the 
very top of the interface.

On macOS, there is also a Harmony Premium category that contains the following commands: Preferences, 
About, and Quit.

Animation Menu 289

Drawing Menu 299

Edit Menu 307

File Menu 311

Help Menu 315

Insert Menu 317

Play Menu 319

Scene Menu 321

View Menu 323

Windows Menu 330
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Animation Menu
The Animation menu lets you access tools, adjust animation timing, set deformation, morphing and IK 
parameters, lock or unlock layers, and select elements in the Xsheet and Timeline views.

How to access the Animation menu

 l At the top of the interface, select Animation.

Command Description

Animate

Animate Current Frame

When this option is selected, every time you use  the  Transform, 
 Advanced Animation or  Inverse Kinematic tools 

to manipulate an element in your scene, the position of the element 
will be stored in a keyframe at the current frame. This allows you to 
animate elements in your scene without creating keyframes manually.

Animate Onion Skin Range

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformations to an 

element in your scene, the transformations will be stored as keyframes 
at the beginning and at the end of the current Onion Skin range, as 
well as on every existing keyframe in-between. This can be useful if 
you want to reposition an element that you have already animated, but 
only during a specific range of frames, which you can define by 
enabling Onion Skin and setting the Onion Skin range to cover that 
range of frames.

Animate Off

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformation to an 

element in your scene, the transformations will affect the element 
throughout the whole scene. This can be useful if you want to 
reposition an element after you have already animated it. 

Stop-Motion Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a 
stop-motion keyframe and the next keyframe, Harmony does not 
generate any animation and the element remains static until the next 
keyframe. 

Delete Keyframe Deletes the selected keyframes.
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Tools

Transform
Allows you to select drawing layers and position, rotate, scale and 
skew them. 

Inverse Kinematics
Allows you to pose a character model by pulling on its extremities, 
such as hands and feet, and have the other connected limbs follow. 
Can be used on any piece connected in a hierarchy. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an 
object up to make it larger or down to make it smaller. Press Shift to 
scale the element while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you 
move them towards or away from the camera.

Spline Offset

Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 
fields. If your elements were drawn in a different location than the 
centre of the drawing area, it will look like the trajectory is not aligned 
with your drawing. Also, if you have several elements attached to one 
trajectory, you might want your trajectory to be at a different location 
to represent the group's motion better.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every 
drawing included in a layer. 

Cell

Increase Exposure

Adds one more exposure to a selected cell; repeating this action adds 
an extra cell each time. This is an efficient way to extend a drawing's 
exposure and is always set in Insert mode. Increasing an exposure 
pushes the existing exposure forward.

Decrease Exposure Decreases exposure of a selected cell by one; repeating this action 
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decreases one exposure adds an extra cell each time. This is an 
efficient way to shorten a drawing's exposure. Decreasing an exposure 
pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure

Lets you enter the frame up to which you want to extend the exposure. 
You can expose the drawing in the frames and replace the drawings 
that were originally there or move the subsequent frames forward in 
time. 

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure Removes key exposures from the selected cells.

Remove Duplicate Key Exposure

When working with drawings to adjust the timing of a mouth in a 
lipsync, for example, and forcing the use of specific key exposures, 
unnecessary key exposures will be created. You can delete these 
duplicates without affecting the rest of the drawing. The first drawing 
of the selection will be used for the range.

NOTE 

Duplicate key exposures may occur when pasting with the 
Enforce Key Exposure option selected.

Fill Empty Cells

Fills the empty frames in the selection with the exposure just before. 
For example, if you select a range of frame that starts with an exposed 
drawing and then ends with empty cells, all of the empty cells in the 
selection will be filled with the exposed drawing just before the 
empty cells. 

Insert Blank Cell Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and Pull
Replaces the exposure from the selected cell with exposures that 
follow it.

Fill Selection
Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many 
columns, an entire column, or many columns. You can use numbers, 
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words, letters, or any alphanumeric value.

Sequence Fill

Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a 
cycle, and so on. The selection can be over one cell or a cell range in 
one column or more or an entire column or many entire columns.

Fill Cells Randomly

Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to 
choose the random values from. The selection can be over one cell or 
a cell range in one column or more or an entire column or many entire 
columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Deformation

Set Curves and Offsets 
Independent from Parent

When you transfer a curve's position to its parent offset, first you 
must to set curves and offsets independent from parent.

Transfer Curve Values to Offset

Lets you transfer all of the information from first curve deformer to its 
parent Offset node. This is useful for a legacy scene created using 
Curve deformations where the Offset's position has been placed far 
away from the drawing to make sure it doesn't affect  the drawing's 
deformation. You can bring back the offset and give it the first curve's 
position. The Envelope deformation lets you animate the offset of 
each curve separately. The offset no longer needs to be placed far 
away.

Convert Elliptic Deformation ROI 
to Shape

After you have created a deformation chain using Elliptic as the Zone 
of Influence type, you can select your deformer and click on this 
button to convert it to a Shaped type. Control points will appear 
around the shape making it easy to customize.You can also convert 
the Elliptic zone of influence to a shape. Select Animation > 
Deformation > Convert Elliptic Deformation ROI to Shape. This will 
create a much smaller  initial zone of influence than if you were to 
convert it directly to a shape.

Convert Deformed Drawing to 
Drawings

Convert deformation animations to drawing sequences, so you can 
adjust the drawings using the drawing tools. You may also want to 
change the timing and set it on double frames instead of single frame.

Convert to New Drawing and Takes the pose/drawing and the deformer of the selected frame and 
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Add Deformation Chain converts it to a new pose/drawing with the corresponding deformer. 

Envelope Creator

Create Envelope

Opens the Envelope Creator dialog, which allows you to 
automatically generate a deformation chain based on the artwork in 
the current layer. 

Among other things, the Envelope Creator dialog allows you to set 
the parameters for the amount of deformation points in the envelope 
as well as its shape and type.

Draw Envelope

Opens the Envelope Drawer dialog, which allows you to draw a 
deformation chain in the Camera view using a mouse or pen tablet. 
The deformation chain will be created as a parent of the current layer. 

Among other things, the Envelope Drawer dialog allows you to set 
the parameters for the amount of deformation points are created and 
how the shape of your drawing is processed.

Exposure Fill

Using Render Change

Modifies the timing (exposure) of the selected layer, lets you adjust 
the parameters to assign when the texture exposure changes will 
occur. You can adjust the type of filter to use for the motion detection, 
as well as threshold values to indicate what will be considered a big 
enough motion variation for an exposure change.

Master Controller

Launch Stack Wizard

Opens the Master Controller Stack Wizard, which allows you to create 
a Master Controller that combines a 2D point widget and a slider. The 
2D point widget can be used to rotate part of your rig in any direction, 
used a grid of preset poses, and the slider can be used to switch 
between different grids of poses.

Launch Grid Wizard

Opens the Master Controller Grid Wizard, which allows you to create 
a Master Controller with a 2D point widget that can be used to rotate 
part of your rig in any direction, using a grid of preset poses—see 
Master Controller Grid Wizard Dialog Box on page 124. 

Launch Slider Wizard
Opens the Master Controller Slider Wizard, which allows you to 
create a Master Controller with a slider widget which can be used to 
change the pose of part or all of your rig, based on a line-up of 2 or 

293

Harmony 21 Premium Reference Guide                          



Chapter 2: Menus

more poses—see Master Controller Slider Wizard Dialog Box on page 
236. 

Morphing

Create Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the 
current layer. 

Insert Morphing Key Drawing Creates a morphing keyframe from a selected morphing frame.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire 
sequence between the two keyframes.

Convert Morphing to Drawing

Lets you convert your morphing inbetweens to real drawings you can 
edit. This is useful when manually editing a morphing sequence or if 
you prefer to have animation timing in double frame (on twos) instead 
of single frame (on ones). 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; 
in other words, on Contour vectors. It allows you to control the line 
thickness and contour position. Also, if a contour is not animated 
correctly, you can use hints to correct the animation. For example, if a 
flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough 
away from the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity 
rule. The Zone Hint is placed in the centre of the colour zone. 
Sometimes a colour zone is not associated with the corresponding 
one by default. For example, in a splash animation there are many 
water droplets that are the same colour. Harmony automatically 
morphs the droplet to the nearest one. This is not always the one you 
may have predicted. A Zone Hint will force a colour zone to morph 
with another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as 
central vector. It can be used on drawings that were done using the 
Pencil, Polyline, Ellipse, Line and Rectangle tools. Like the Contour 
Hint, the Pencil Hint snaps to the central vector. Make sure to place it 
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far enough away from the line so you will see it snap when you move 
it.

Pencil Hint points are magenta in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an 
appearing shape. A shape will appear in the destination drawing when 
there is no corresponding shape in the source drawing. If you do not 
place an Appearing Point Hint to control the point of appearance, the 
shape will appear from its centre and expand outwards.

Appearing Point Hint points are violet in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing 
shape. A shape will vanish from the source drawing when there is no 
corresponding shape in the destination drawing. If you do not place a 
Vanishing Point Hint to control the point of disappearance, the shape 
will vanish into its centre.

Vanishing Point Hint points are green in colour.

Switch Between Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. 
This option is useful while setting hints. You can use the default 
keyboard shortcut F4 to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame
Goes to the previous frame of the selected frame in the morphing 
sequence.

Go to Next Frame
Goes to the next frame of the selected frame in the morphing 
sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest Hints
Automatically sets hint points on key drawings as a help tool. If 
you're not sure where to set hints, you can use this option. It will set 
the main hints which you can then fine tune.

Hide Hints
Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you 
would like to see.
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IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold Orientation Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Remove All Constraints Removes all nails except the minimum and maximum angles.

Lip-Sync

Change Mouth Shape to
Lets you change the mouth shape to one of the following: A, B, C, D, 
E, F, G, X.

Auto Lip-Sync Detection Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps drawings in an element to the mouth chart you 
have generated for a sound. This can save time when you are lip-
synching a voice track.

Flip

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Flip Scale X

Once your drawing layer is rotated, the original horizontal and vertical 
axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original 
X-axis of the layer and flips the element following it.

Flip Scale Y
Remembers the original Y-axis of the layer and flips the element 
following it.

Linear Motion Switches between a linear and curved corner.
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Lock in Time

Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it 
freely as other points are being added, moved, or adjusted (control 
point).

No Z Dragging
Keeps the Z value constant when you drag a character using the 
Transform or Translate tool.

Substitute Drawing Previous
Replaces the drawing or cell's symbol on the current frame by the 
previous drawing.

Substitute Drawing Next
Replaces the drawing or cell's symbol on the current frame by the 
next drawing.

Go to Previous Keyframe Goes to the previous keyframe.

Go to Next Keyframe Goes to the next keyframe.

Select Previous Keyframe /Point Select the previous keyframe/point.

Select Next Keyframe /Point Select the next keyframe/point.

Select Child Skipping Effects
Lets you select the first element parented to the selected peg element 
in the Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element 
in the Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in 
the Timeline view.

Select Group Content Selects all of the contents of the group.

Select Parent Skipping Effects
Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent
Lets you select the parent of the selected element in the Timeline 
view.

Select Previous Sibling Lets you select the previous element (above current element) in the 
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Timeline view.

Select Next Sibling
Lets you select the next element (below current element) in the 
Timeline view.

Lock

Lock Locks one or a multiple selection of layers. 

Unlock Unlocks one or a multiple selection of locked layers.

Lock All Locks all the layers in the Timeline view. 

Unlock All Unlocks all the layers in the Timeline view. 

Lock All Others Locks every layer except the selected ones.

Reset

Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation 
angle will be reset to 0 and if the Transform  tool is active, all the 
transformation values will be reset.

Reset All

Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting 
value. All transformations are reset regardless of the tool you're 
using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often 
have a particular Z ordering for the different views of a character. You 
might want to reset the transformation, but not necessarily the Z 
position. 
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Drawing Menu
The Drawing menu lets you access many tools related to drawing, painting, dirt removal, optimizing strokes, 
and more.

How to access the Drawing menu

 l At the top of the interface, select Drawing.

Command Description

Drawing Tools Allows you to select one of the drawing tools available in Harmony.

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil lines, 
shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes in 
your artwork. You can add, remove, tweak and move vector points, move the Bezier 
handles of the vector points as well as  deform vector outlines. 

Centerline 
Editor

Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Allows you to adjust the thickness of a pencil line at its different points and corners, 
tweak the shape of its extremities and scale its texture.

Cutter Allows you to cut a part of your artwork, then reposition, scale, rotate and skew it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making them 
easier to edit. 

Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope Allows you to deform and warp artwork by moving points and tweaking lines in a grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want its 
location to be.
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Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line effect, 
as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central vector 
lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour 
Eyedropper

Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing
Allows you to create and configure a morphing sequence, which will automatically 
generate the in-betweens between two drawings in the current layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking to 
create each point in the sequence of line segments. 

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush   Like the Brush tool, but only paints over existing brush strokes. 

Close Gap
Allows you to close open shapes so that they can be filled with the Paint tool. By 
drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.
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Stroke
Allows you to create invisible lines that can serve as colour zones that can be filled, or 
close the gaps in existing colour zones.

Edit 
Gradient/Texture

Allows you to adjust the position, angle and size of gradients and textures in a colour 
zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View Lets you rotate the Camera and Drawing views just like with a real animation disc.

Shift and Trace
Allows you to temporarily move drawings so you can trace over them in other 
drawings using Onion Skin. 

Clean Up

Remove Dirt
Opens the Remove Dirt dialog box where you can specify the number and size of dots 
removal from a selected drawing.

Remove Hair

Opens the Remove Hair dialog box where you can specify the number and length of 
hairs for removal from a selected drawing. This removes any small strokes created in 
the Colour Art layer from very thick lines or filled zones. Increase the value to select 
larger strokes for removal from the drawing. 

Close Gaps

Closes small gaps in a drawing by creating small, invisible strokes between the two 
closest points to close the colour zone. You do not need to trace directly over the gap. 
You can draw it a few millimeters away. The two closest points automatically close 
the gap.

Remove Art 
Inside Selection

Removes any art inside a selection. It is recommended that you clean your Colour Art 
level as well. If you have a stroke accumulation in the Colour Art, it can result in large 
output files, especially if you work in high definition resolutions. 

Remove Art 
Inside Selection 
on All Drawings

Removes any art inside all drawings selected with the Permanent Selection  option in 
the Select tool.

Remove Art 
Outside 
Selection

Removes any art existing outside a selection. It is recommended that you clean the 
Colour Art level as well. If you have a stroke accumulation in the Colour Art, it can 
result in large output files, especially if you work in high-definition resolutions.

301

Harmony 21 Premium Reference Guide                          



Chapter 2: Menus

Remove Art 
Outside 
Selection on All 
Drawings

Removes any art outside all drawings selected with the Permanent Selection  option in 
the Select tool.

Paint

NOTE 

The Paint commands require you to use the Permanent Selection option in the Select tool so you can maintain a 
selection over multiple drawings.

Unpaint 
Selection

Unpaints any art existing inside a selection. 

Unpaint 
Selection on All 
Drawings

Unpaints all art contained inside a selection on all the drawings within the same layer.

Unpaint Outside 
Selection

Unpaints any art existing outside a selection. If no selection have been drawn using 
the Select tool, the entire drawing will be unpainted.

Unpaint Outside 
Selection on All 
Drawings

Unpaints all art outside a selection on all the drawings within the same layer. 

Repaint 
Selection

Repaints any art inside a selection.

Repaint 
Selection on All 
Drawings

Repaints any art inside a selection on all the drawings contained within the same 
layer. 

Repaint Outside 
Selection

Repaints any art outside a selection. If no selection has been drawn using the Select 
tool, the entire drawing will be repainted.

Repaint Outside 
Selection on All 
Drawings

Repaints any art outside a selection on all the drawings contained within the same 
layer. 

Convert
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Pencil Lines to 
Brush Strokes

Converts the selected centreline pencil strokes into contour strokes brush lines.

Brush Strokes to 
Pencil Lines

Converts selected contour strokes into centreline pencil strokes. The brush stroke 
thickness will be lost.

Strokes to 
Pencil Lines

Converts the selected invisible line to a pencil line.

Break Apart Text 
Layers

Text is treated as a single drawing object. This separates the text so each character 
becomes an individual drawing object you can select and modify independently.

Optimize

Flatten

Merges drawing objects and brush strokes into a single layer. If you draw new lines to 
fix a drawing or line with many brush strokes, it can be useful to flatten them all into a 
single shape. By default, lines are drawn one on top of each other. If you intend to 
repaint the lines or modify their shape, it will be easier if they are flattened. 

Smooth Smooths selected drawing strokes and removes extra points.

Create Contour 
Strokes

Adds a permanent invisible line around a shape that was drawn directly in Harmony. 
This allows you to unpaint lines with the Paint  tool but maintain the shape of the 
lines, should you need to repaint later.

Remove 
Contour Strokes

Remove any permanently invisible lines that were created while scanning and 
vectorizing drawings or manually adding contour strokes. This is useful for removing 
the intersection triangles created during vectorization.

Remove Extra 
Strokes

Removes strokes inside painted area. This option only works after the painted drawing 
is flattened.

Optimize
Reduces the number of layers, such as overlapping brush strokes, in the selected 
drawing objects. Drawing objects will only be flattened and optimized if the selected 
objects do not change the appearance of the final image when they are merged. 

Crop Brush 
Textures

Crops an unnecessarily large texture bitmap that lies unseen beneath the vector 
contour of a textured line. This often occurs when you cut and paste textured lines 
from one drawing into another. If you cut a portion from a textured line and paste it 
into a different drawing, Harmony pastes the entire unseen texture bitmap from the 
source drawing into the new one, even if you only took a small portion of the source 
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drawing. Using the Crop Brush Texture command will crop away extraneous texture 
that does not touch the vector area. If there are many textured lines in your scene, this 
will greatly reduce the file size.

Reduce Drawing 
Texture 
Resolution

When you import and vectorize as texture (colour) a high resolution image, the size of 
your drawing can be heavy. You can reduce the size and resolution of the textures in a 
drawing. 

Transform

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 CW Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW Rotates the current selection 90 degrees counter-clockwise.

Rotate 180 Rotates the current selection 180 degrees.

Arrange

Bring to Front Moves the selected art to the front (on top).

Bring Forward Moves the selected art one level forward (closer to the front).

Send Backward Moves the selected art one level lower (behind).

Send to Back Moves the selected art behind everything (bottom / back).

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may already be 
exposed in that cell and the following ones until it meets another drawing, key 
exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing will be 
exposed at the selected frame instead of the original drawing. Hence, this command 
allows you to instantly start working on a duplicate of the current drawing and retain 
the original. 
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NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced with 
the new drawing, up until the next key exposure.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these drawings 
cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Rename Drawing with 
Prefix

Lets you rename a drawing sequence with a prefix, which can be quite useful for cut-
out puppet breakdown and deformation animation. This applies to any deformation 
work done in pre-Harmony 12 versions.

Rename by Frame
Lets you rename a series of drawings relative to their frame position. This is useful in 
hand-drawn animation.

Select Strokes with 
Current Colour

Lets you select drawing elements and painted areas with the same colour as the 
currently selected colour in your colour palette.

Distribute to Layers

Every selected stroke in the Camera view is placed on separate layers; one layer per 
stroke. If artwork is composed of several strokes, you must group them to put them on 
the same layer. 

This operation cannot be done in the Drawing view.

Create Colour Art from 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings on 
separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the four 
embedded layers.

Create Breaking 
Triangles

Useful for brush strokes, creates triangular breaks at natural line intersections. These 
intersections are the probable locations where colour line breaks may occur, such as 
where a sleeve meets a hand. 

This makes it easier to soft trace lines in different colours when there are flattened or 
unflattened clean brush strokes.

Generate Auto-Matte
Fills colour based on currently selected colour swatch on different drawing layers 
(overlay, underlay) so overlapping lines are more visible during a line test.
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Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Vector Drawing 
Brush Resolution

Allows you to change the pixel density of textured brush strokes in vector drawings in 
your scene. 

NOTE 

When you create a new vector drawing, its pixel density for textured brush 
strokes is based on the settings in the Drawing Resolution tab of the Scene 
Settings dialog. 

Change Bitmap 
Drawing Resolution

Allows you to change the pixel density and canvas size of existing bitmap drawings in 
your scene. 

NOTE 

When you create a new bitmap drawing, its canvas size and pixel density are 
based on the settings in the Drawing Resolution tab of the Scene Settings 
dialog. 

Previous Drawing When a cell is selected in the Timeline or Xsheet view, displays the previous drawing.

Next Drawing When a cell is selected in the Timeline or Xsheet view, displays the next drawing.

Previous Layer When a cell is selected in the Timeline or Xsheet view, displays the previous layer.

Next Layer

Once a cell is selected in the Timeline or Xsheet view, you can navigate between the 
drawings, frames, and layers. Displays the previous drawing, next drawing, previous 
layer or next layer.

When a cell is selected in the Timeline or Xsheet view, displays the next layer.

Colour Protection

Toggle Current 
Colour 
Protection

Temporarily enables/disables the Colour Protection feature so you can quickly correct 
wrongly inked or painted areas under protected colour without readjusting the Current 
Colour Protection option.

Respect Colour 
Protection

In the Colour view, you can protect a colour swatch to avoid repainting or unpainting 
the zones linked to that swatch. If you using the Paint tool and this option is 
deselected, you will repaint or unpaint the protected colours on your drawings until 
you enable the option again.
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Edit Menu
The Edit menu lets you repeat and undo actions, cut/copy/paste selected objects, select and manipulate 
objects, work with symbols, and access the Preferences dialog box.

How to access the Edit menu

 l From the top menu, select Edit.

Command Description

Undo
Removes the last change made to your project. Harmony supports 
multiple undo, so you can undo changes you made in the order you 
made them.

Redo
Redoes an operation you have undone. This command is active only 
after you use the Undo command.

Cut
Removes selected objects. You can then paste the object or its 
properties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location you select in a 
view.

Paste Special

Opens the Paste Special dialog box which lets you determine how 
templates and symbols are imported in the Timeline view. 

There are advanced paste options for drawings, timings, keyframes, 
layers, as well as palettes and symbols.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the 
number of cycles to paste and select a type of cycle: Normal, Reverse, 
Forward-Reverse and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection 
after copying.
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Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the 
Drawing, Timeline and Camera views. This helps you manage multiple 
objects as one when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that 
were not selected. For example, if some lines are selected in a 
drawing, this command will deselect them and select any other lines 
in the drawing that were not selected.

Auto-Apply

Automatically applies changes you make to a property window or 
dialog box. Harmony applies the modification automatically and 
displays the result in the Camera view. When working on a heavy 
scene, it is useful to turn off this option.If you want to always work in 
Auto-Apply mode, you can deselect the Auto-Apply option in the 
Preferences dialog box (General tab). Then, each time you start 
Harmony, the Auto-Apply  mode will be off. You must click the Apply 
button to see any modifications.

Create Symbol
Creates a symbol from selected drawing elements in the Drawing or 
Camera view, nodes in the Node view, or a layer or cells in the 
Timeline view.

Open Merge Editor
Lets you bring together (merge) the layer or drawings from different 
versions of the same scene.

Expand Symbol

Extracts a symbol's contents and places it on the root timeline. Its 
contents will be copied and inserted into the root timeline. The 
symbol will not be removed from the Timeline view once it is 
expanded. 

The symbol's layers will be parented to it in case you created motions 
and transformations on the drawing layer that contain the symbol. 
Breaking the hierarchy could result in the loss of any scaling and 
animation you may have created.

Expand Selected Symbol in Groups
Expands a symbol within a group to avoid crowding the timeline with 
a series of layers. When you expand the symbols, the layers will be 
contained in a group node that you can expand to see the content.
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Duplicate Selected Symbol
Creates a duplicate of a selected symbol. If other symbols are nested 
inside the new symbol, they are not duplicated. If you modify them, 
the original and other instances will also be modified.

Create Drawing from Drawing Selection
Breaks a character into its main body parts. There is no need to create 
any layers prior to this process. Make sure your model is well centered 
and sized in the Camera view.

Clone: Drawings Only
Creates a copy of the drawings in the selected layer in the Timeline 
view or column in the Xsheet view. The timing it not copied.

Clone: Drawings and Timing
Creates a copy of the drawings and their timings in the selected layer 
in the Timeline view or column in the Xsheet view.

Duplicate

Duplicates a layer to have a copy of the drawings that are independent 
from the original ones, as well as an independent timing (exposure). 
When you need the drawings to be modified independently, you will 
want to duplicate the layer instead of cloning it.

Merge

There are two methods of merging drawings. 

 l You can merge selected drawings in adjacent elements. The 
columns and layers will be left intact, and each new merged 
drawing will reside in the frames of the left-most column or 
lower layer.

 l You can merge elements. All drawings will be merged. 
Unused columns and layers will be deleted, but the original 
drawing files are still accessible.

Group

Group Groups selected drawing objects in the Camera or Drawing view.

Ungroup
Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

Group Selected Layers
Groups selected layers in the Timeline view or nodes selected in the 
Node view.

Ungroup Selected Layers Ungroups a selected group in the Timeline or Node views.

Move to Parent Group Moves selected nodes in the Node view up to the parent group level, 
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maintaining all connections.

Edit Drawing Mode

When the Auto-Get Rights to Modify Drawings option is selected in 
the Preferences dialog box (General tab), the system automatically 
gets the rights to modify drawings when you select a drawing. 
Otherwise, you must manually get the rights to modify drawings.

Edit Palette List Mode

When the Auto-Get Rights to Modify Palette option is selected in the 
Preferences dialog box (General tab), the system automatically gets 
the rights to modify palettes and palette lists when you select a 
colour from a palette. Otherwise, you must manually get the rights to 
modify a palette or palette list.

Get Rights to Modify Drawing Manually releases the rights to modify a selected drawing.

Release Rights to Modify Drawing Manually releases rights to modify a selected drawing.

Force Release Rights to Modify Drawing
This option is always available even if the Get Rights to Modify All 
Scene Assets option is not selected in the Database Selector dialog 
box.

Preferences
Opens the Preferences dialog box where you can set your preferences 
for Harmony.
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File Menu
The File menu lets you open, close, save, scan, print, and import and export files.

How to access the File menu

 l From the top menu, select File.

Command Description

New
Creates a new scene while closing any scene already open. The New Scene dialog box 
opens, asking for directory, name, and resolution information.

Open
Displays the Open Scene dialog box where you can browse for a scene file.  You can open a 
new scene from the current one and the previous scene will close.

Open Recent Displays a list of the most recently opened scenes.

Clear Clears the list of recently opened scenes.

Close Closes the currently opened scene, but does not close the Harmony application.

Save Saves all changes made to the opened scene, drawings, palettes, and palette lists.

Advanced Save

Lets you do the following:

 l Save the scene as the current version.

 l Save different versions representing different stages of the production of your scene.

 l Save different versions representing different scene setups.

 l Choose specific assets that you want to save, such as drawings or palettes. 

Rights to Modify 
Scene Version

Allows you to modify the selected version of the scene as well as to manage and overwrite 
other versions. Other users will not be able to open a different version of the scene until 
you close the scene.

Rights to Modify 
Scene

Allows you to modify the currently selected scene version only. Unless the Get rights to 
modify the scene option is also checked, you will not be able to change other versions of 
the scene. This allows other users to modify different versions of the scene while you are 
working on the selected version.
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Read Changed 
Drawings

Determines which drawing files have been modified on disk since you loaded them. All 
updated drawings will be reloaded. 

NOTE 

Reloading a locked drawing will discard unsaved changes.

Manage Versions Allows you to manage all the versions of the current scene.

Manage Local 
Cache

Opens the Manage Local Cache dialog, in which you can see all the Harmony Server 
database scenes that were cached locally, delete unused caches and check if the data in a 
scene's cache matches the data on the database server. 

Save As

Saves the current file with a different name and at a different location.

Saves the current state of a scene as another scene. The Save As window prompts you for a 
new name and a different location for this scene before saving it. This will create a complete 
scene directory for the new scene.

NOTE 

The scene name cannot exceed 23 characters.

Save as New 
Version

Saves the current scene as another version. The Save Version dialog box prompts you to 
give a name for this new version. This will create a new .xstage file in your current project 
directory.

Back Up Scene Backs up the current scene to a location you choose.

Update Database 
Scene

Updates your database with only the changes you made to the scene. To do this, you must 
enter your host name and host port in the Preferences dialog box, General tab.

Download 
Database Changes

If any changes were made to the scene you downloaded, you can perform an update by 
downloading these changes, which will be integrated into your scene.

Remove Unused 
Files

Removes the unused palettes from the scene list.

Import

From 
Scanner

Imports drawings from a TWAIN scanner.
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Images Imports bitmap images which you can choose to vectorize.

3D Models

Once you have exported a model using a 3D authoring software, you can import it and 
integrate it in your 2D animation scene.  You have the possibility to convert your 3D models 
to *.osb files upon import to Harmony and save them as such. This will allow Harmony to 
render 3D files with the associated textures without the need to copy them manually (as 
long as the auxiliary files are linked correctly and named appropriately on your disk).

Link to 
Images

Links to images stored on a centralizer server when working with Harmony Server.

Movie Lets you convert a QuickTime movie to an image sequence and audio file.

Sound Lets you import sound files into your project.

Colour 
Model

Lets you import TVG drawing file into your project. Once imported, it is display in the Model 
view for use as a colour model which you can load into any Harmony scene.

SWF, 
Illustrator 
Files to 
Library

Lets you import SWF files into your project.

Export

Movie Exports animation as a QuickTime movie.

Render 
Write 
Nodes

Renders all the Write nodes in a node structure. 

When working with Harmony Server, you can send your scene to batch processing and to a 
render farm.

Soundtrack
Exports a sound file as a merged soundtrack or series of individual files. The exported 
soundtracks are generated as *.wav files.

SWF

Exports a Flash movie file. 

Harmony supports exporting Flash movie files with a limited subset of vector and bitmap 
effects, the latter which can be previewed in Render View  mode.

OpenGL 
Frames

Exports OpenGL frames (fast display mode) for a quick screen renders of a scene that 
contain no transparency channel. Heavier scenes containing 3D, multiple effects and 
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camera moves can be fairly long to export.

Layout 
Image

Exports all the elements in your scene to a layout .psd file.

Layout 
Image from 
Selection

Exports only the selected elements to a layout .psd file.

Print

Xsheet
Prints the exposure sheet so you can take it to your animation table,  provide a copy to the 
animator, or create your Xsheet skeleton directly in Harmony.

Node View Prints the Node view for reference purposes.

Quit Closes the application.
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Help Menu
The Help menu lets you display the Harmony documentation, Welcome screen and end user license 
agreement, as well as access the Toon Boom website, and identify the product name and version number.

How to access the Help menu

 l At the top of the interface, select Help.

Command Description

Online Help
Opens the Harmony Help system, complete with instructions on how 
to use the system. This requires an internet connection.

Getting Started
Opens the Harmony Getting Started Guide (in PDF format) in a 
browser window. Requires Acrobat Reader.

Toon Boom on the Web
Opens the Toon Boom website, which features a Support and 
Community > Forum section.

Customer Experience Improvement 
Program

The Customer Experience Improvement Program allows Toon Boom 
to collect usage information. The data does not contain any 
personally identifiable information and cannot be used to identify you. 
The data will consist of a basic hardware description, a project 
summary and usage information. The information is used only for 
software improvement purposes, as well as for sharing with third 
parties for the same reason.

This program is enabled by default but is voluntary. If you prefer not 
to participate, you can opt out when you first launch the software, by 
using a global preference, or by a command line argument.

About Identifies the product name and version number. 

Show Welcome Screen Displays the Harmony Welcome screen.

Show End User License Agreement Displays the End User License Agreement.

Debug Mode

When enabled, information is logged in the Message Log view about 
the preview generated in the Camera view, each time the preview is 
refreshed. In OpenGL preview mode, summary information is logged 
about the amount of nodes to process and the time it takes to generate 
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the preview. In Render Preview mode, detailed information about each 
composite and effect that is processed is logged.

Additionally, this option makes the Node view display information on 
each of its node about the amount of time a node must be processed 
to generate the OpenGL preview, and the total amount of time (in 
milliseconds) it takes for the node to process all its ingoing 
connections. 

This can be useful if the complexity of a scene is impacting 
application performance, as it may help you identify the parts of your 
node system that have the most impact on the time it takes to generate 
the preview. 

NOTE 

The time indicated is cumulative from the top-down. This 
means a child node will always indicate that it takes at least 
as much time to process as its parent. 

Shortcuts Displays the complete list of keyboard shortcuts for Harmony.
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Insert Menu
The Insert menu lets you create empty symbols in the Library view, different types of layers in the Timeline 
view, keyframes and control points.

How to access the Insert menu

 l At the top of the interface, select Insert.

Command Description

Create Empty Symbol in Library
Creates an empty symbol in the Library view to which you can edit 
(add content).

Bone Adds a new Bone layer to the Timeline view.

Camera Adds a new Camera layer to the Timeline view.

Colour-Card Adds a new Colour-Card layer to the Timeline view.

Drawing
Adds a new Drawing layer to the Timeline view and a column in the 
Xsheet view.

Game Bone Adds a new Game Bone layer to the Timeline and Node views.

Group Adds a new Group layer to the Timeline and Node views.

Kinematic Output
Adds dd a new Kinematic Output layer to the Timeline and Node 
views.

Peg Adds a new Peg layer to the Timeline and Node views.

Quadmap Adds a new Quadmap layer to the Timeline and Node views.

Particle

Basic Particle System
Adds a new layer with a basic particle system in the Timeline and 
Node views. 
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Basic Gravity-based System
Adds a new layer with a basic gravity-based particle system in the 
Timeline view. 

Keyframe Adds a keyframe to the selected cell in the Timeline view.

Keyframe and Duplicate Drawing
Adds a keyframe to the selected drawing layer cell in the Timeline 
view and creates a duplicate of the drawing, which sits on top of the 
original drawing.

Position Keyframe
Adds a position keyframe whereby keyframes will only be added on 
the X, Y and Z parameters of the selected layer. Keyframes are not 
added on the Angle, Scale and Skew parameters.

Control Point

Adds a control point to the trajectory of the selected element or peg in 
the Camera view when the element or peg is in a 3D path. Note that 
you must have a 3D path in the peg portion in order to add a control 
point.
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Play Menu
The Play menu lets you play back animation and sound. Use it to scrub the sound to create your lip-sync, loop 
the playback, navigate through frames, and change the playback range and speed.

How to access the Play menu

 l At the top of the interface, select Play.

Command Description

Play Plays the scene in the Camera or Drawing view. 

Render and Play

Renders your scene's frames, then opens the rendered frames in Play 
for playback. 

This allows you to preview your scene's animation in real time, with 
the effects rendered and with no risk of slowdown. 

Record and Play

Exports your scene as it appears in the Camera view into a movie file, 
then opens it in your workstation's default video player. 

This allows you to preview your animation without any risk of 
slowdown, but it does not preview the effects in your scene. However, 
it is much faster than Render and Play. 

This button automates the usage of the Export OpenGL Frames dialog 
see 

Test SWF Movie
Quickly exports your scene as a Flash Movie (.swf), then opens it in 
your workstation's default web browser.

Stop Stops playback.

Mini Playback

Open the Mini Playback dialog. This dialog allows you to set the 
amount of frames before and after the current frame to playback when 
using Mini Playback, to set the speed of Mini Playback and to start 
Mini Playback.

Start Mini Playback
Begins Mini Playback using the last settings entered in the Mini 
Playback dialog. By default, Mini Playback will play 5 frames before 
and after the current frame, at the scene's frame rate. 
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Playback Speed
Opens the Set New Frame Rate dialog box where you can set the 
frame rate at which the playback plays.

Loop
If pressed, your scene will repeat indefinitely when playing. 
Otherwise, it will stop when the end is reached.

Enable Sound Turns on sound during playback.

Enable Sound Scrubbing Turns on sound scrubbing during playback.

Start Frame
Opens the Set Playback Start Frame dialog box , in which you can 
enter the frame number from which to start playback.

Stop Frame
Opens the Set Playback Stop Frame dialog box, in which you can set 
the frame number at which to stop playback.

First Frame Moves the red playhead to the first frame.

Previous Frame Moves the red playhead to the previous frame.

Next Frame Moves the red playhead to the next frame.

Last Frame Moves the red playhead to the last frame.

Go to Frame
Opens the Go to Frame dialog box where you can enter the frame 
number on which the red playhead to be positioned in the Timeline 
view.

Enable Playback

Top View Plays back your animation in the Top view.

Side View Plays back your animation in the Side view.

Perspective View Plays back your animation in the Perspective view.
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Scene Menu
The Scene menu lets you set the scene length, add frames to the scene, view different displays of the scene, 
set render options, access the Scene Settings dialog box and Elements Manager window, and verify the 
drawing and palette files in your project.

How to access the Scene menu

 l At the top of the interface, select Scene.

Command Description

Scene Length Lets you set the length of the scene in frames.

Frame

Add Frames at Start Adds the number of frames you specify to the beginning of the scene.

Add Frames at End Adds the number of frames you specify to the end of the scene.

Add Frames Before Selection

Adds the number of frames you specify before or after your selection.

Add Frames After Selection

Remove Selected Frames Deletes the selected frames from your scene.

Camera

Default Camera
Lets you select a camera. If you only add one camera to your scene, 
you will only see Default Camera in your list.

Default Display

Display All
Shows the contents of a specific Display node, updating the contents 
of the Camera, Top, Side, Perspective, and Timeline views.

Display

Scene Settings
Opens the Scene Settings dialog box where you can set the 
resolution, alignment, bitmap resolution and many other parameters.
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Render

Auto Render

Automatically recalculates the preview image whenever you modify a 
parameter. If your scene is heavy and you do not want the preview 
rendered automatically, deselect the Auto-Render option and do the 
preview update manually.Note that this will slow down Harmony as it 
takes resources to update every frame.

Auto Render Write

Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this 
command.

Recalculate All
Refreshes the node structure and rerenders the display when the 
Camera view is in render mode.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected 
elements when the Camera View is in render mode.

Cancel Preview Render Cancels a render that was started.

Element Manager

Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing 
folders that are not linked to a column in your scene, use the Element 
Manager to delete them if needed. See xref Reference > Windows > 
Element Manager. 

Check Files Verifies the integrity of the drawing and palette files in your project. 
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View Menu
The View menu lets you manipulate the view by zooming, panning, or rotating. You can also display the grid 
and change its size, use the onion skin feature to help with drawing, and set the preview resolution. 

How to access the View menu

 l At the top of the interface, select View.

Command Description

Toggle Full Screen

Cycles through the following display modes:

 l Normal Full-Screen: The main application window becomes 
full screen.

 l View Full-Screen: The selected view becomes full screen and 
all other views are collapsed.

 l Normal: The main application window is restored to its 
original size and collapsed views are expanded.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Rotate View CW
Rotates the Camera view 30 degrees clockwise, like an animation 
table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an 
animation table.

Mirror View
Temporarily flips the Camera or Drawing view horizontally, allowing 
you to view and edit your artwork as if it was being mirrored.

Reset Zoom Resets the view’s zoom to its default position.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.
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Next Colour Goes to the next colour in the Colour view.

Previous Colour Goes to the previous colour in the Colour view.

Grid

Show Grid Displays the grid.

Grid Outline Only Displays the outline of the grid only.

Underlay Displays the grid under the drawing elements.

Overlay Displays the grid over the drawing elements.

Square Grid Displays a standard square grid.

12 Field Grid Displays a 12-field size grid.

16 Field Grid Displays a 16-field size grid.

Onion Skin

Show Onion Skin

Lets you preview the previous and next drawings. By default, the 
previous drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Add to Onion Skin Adds a series of selected elements to the onion skin preview.

Remove from Onion Skin Removes a series of selected elements from the onion skin preview.

Remove Unselected from Onion 
Skin

Removes all elements except the ones selected from the onion skin 
preview.

Add All to Onion Skin Adds all of the scene's elements to the onion skin preview.

Remove All from Onion Skin Removes all of the scene's elements from the onion skin preview. 
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Onion Skinning by Frames

Selects the drawings to display in the Onion Skin by their frame 
number relative to the current frame. For example, if the Onion Skin is 
set to include 2 drawings before and after the current frame, it will 
include the drawings up to two frames before and up to two frames 
after the current frame, even if those drawings are the same as the one 
in the current frame. This is more useful for cut-out animation as it 
allows you to position a drawing relative to its position in adjacent 
frames.

NOTE 

This option only works in the Camera view. 

Onion Skinning by Drawings

Selects the drawings to display in the Onion Skin by the amount of 
different drawings before and after the current frame. For example, if 
the Onion Skin is set to include 2 drawings before and after the 
current frame, this will display the nearest two different drawings 
before and after the drawing in the current frame in the Onion Skin, 
even if those drawings are further than 2 frames away from the current 
frame. This is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to 
adjust the extent of the Onion Skin in the Timeline view are 
not available. 

No Previous Drawing
Removes the previous drawing's onion skin and displays only the next 
drawing.

Previous Drawing Displays the previous drawing.

Previous Two Drawings Displays the previous two drawings.

Previous Three Drawings Displays the previous three drawings.

No Next Drawing Do not show the onion skin for all of the next drawings.

Next Drawing Show the onion skin for the next drawing.

Next Two Drawings Show the onion skin for the next two drawings.
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Next Three Drawings Show the onion skin for the next three drawings.

Reduce One Previous Drawing Reduces the number of previous visible drawings by one.

Add One Previous Drawing Adds one drawing to the number of previous visible drawings.

Reduce One Next Drawing Reduces the number of next visible drawings by one.

Add One Next Drawing Adds one drawing to the number of next visible drawings.

Light Table
Turns on the light table so you can see the previous and subsequent 
active layers in washed-out colours. It is useful for seeing the other 
layers when designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of 
the ink and paint process. Any unpainted zones can be seen as the 
light shows through the unpainted areas of the silhouetted drawing.

Show

Symbol Pivot

Displays a symbol's pivot. The Symbol pivot is similar to the Drawing 
pivot. Each symbol cell can have its own pivot and act the same as the 
Drawing pivot. The Symbol pivot can also be referred to as embedded 
pivot. Inside a symbol, each drawing can have its own pivot. 

Safe Area
Displays the TV safety zone and the centre of the camera frame. The 
safe area adapts to the scene resolution, as well as the safety zone 
and frame’s centre.

Camera Mask

Displays a black mask around the scene’s frame to avoid seeing the 
unnecessary artwork. This option is handy when you're animating and 
setting up the scene. It allows you to see your scene’s composition 
better.

Control Displays the controls of the selected element.

Current Drawing on Top

Displays the selected drawing on top of everything while you draw. 
By enabling this option, each time you select a drawing tool, the 
selected drawing is displayed in front of everything in the Camera 
view. The Timeline and Node view ordering remain unchanged.You 
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only need to enable this option once, it is not necessary to do it each 
time you select a drawing tool. 

Outline Locked Drawings
Displays drawing that are locked in the Timeline view (cannot be 
selected in the Camera view) as wireframes.

Show Strokes
Displays the strokes in your drawings so that the invisible lines stand 
out.

Show Strokes with Colour Wash Displays strokes with washed-out colours.

Hide All Controls Hides the controls of the selected element.

Deformation

Show Current Deformers and 
Hide All Others

Shows all current deformers and hides all other manipulators 
displayed in the Camera view.

Alignment Guides Alignment Guides

Show Alignment Guides

When enabled, alignment guides will be visible in the Camera and 
Drawing views.

This is enabled by default. Disabling this option will hide and disable 
alignment guides, meaning that animation and drawing tools will not 
snap to them, even if the  Snap to Alignment Guides option is 
enabled in the Tool Properties view. 

Lock Alignment Guides

It is possible to reposition alignment guides in the current panel by 
dragging them using the  Transform tool. Enabling this option will 
lock the alignment guides in their current position, allowing you to 
manipulate layers and artwork in your scene without accidentally 
moving alignment guides.

Clear Alignment Guides Removes all the alignment guides from your scene.

New Horizontal Alignment 
Guide

Adds a horizontal alignment guide to the middle of the stage.

TIP 

You can move the alignment guide from its default position 

using the   Transforml  tool or the  Select tool.
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New Vertical Alignment Guide

Adds a vertical alignment guide to the middle of the stage.

TIP 

You can move the alignment guide from its default position 

using the  Transforml  tool or the  Select tool.

Particle

Show Particles as Dots in 
OpenGL

Displays the particles as dots in the OpenGL preview mode. This 
makes the playback speed faster for a heavy scene.

Preview Manager
Opens the Preview Manager where you can set options for the quality 
of previews, and clearing and updating the cache.

Preview Resolution

Same as Scene Resolution

Lets you choose a resolution for previewing a scene.

3/4 of Scene Resolution

1/2 of Scene Resolution

1/3 of Scene Resolution

1/4 of Scene Resolution

Custom
Lets you select a resolution from a list of presets or enter X and Y 
values for a  custom preview resolution.

Bitmap File Quality

Let's you increase or decrease the preview quality of raw bitmap 
images. By default, bitmap files imported in Harmony will display in a 
low resolution in the Camera view to avoid hindering performance. 

TIP 

You can change the default resolution in which bitmap files 
are displayed in the Camera view by changing the Small 
Bitmap Resolution preference located in the Camera tab of 
the Preferences dialog.
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NOTE 

This only affects the way bitmap images display in the 
OpenGL preview of the scene in the Camera view. The 
preview quality of bitmap images does not affect the final 
render. 

329

Harmony 21 Premium Reference Guide                          



Chapter 2: Menus

Windows Menu
The Windows menu lets you customize your workspace to suit your working style, save it as a new workspace, 
and load it from the Workspace toolbar. You can also show or hide the different toolbars and views in 
Harmony.

How to access the Windows menu

 l From the top menu, select Windows.

Command Description

Restore Default Workspace
Returns modified workspaces to their original default layout if you do 
not like the current modifications or inadvertently closed some 
windows.

Workspace

Workspace Manager
Opens the Workspace Manager where you can modify, create, delete, 
rename and reorder your workspaces.

Save Workspace Saves the current workspace along with any modifications you made.

Save Workspace As...
Saves the workspace as a new version to avoid overwriting the current 
one.

Workspace
Lets you open workspaces designed specifically for animating, 
compositing, hand drawing, scripting and the default workspace.

Toolbars

Allows you to add or remove toolbars from your workspace. 

NOTE 

For information on the different toolbars in Harmony, see 
Toolbars.

Camera Shows or hides the Camera view.

Colour Shows or hides the Colour view.
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Coord. and Control Points Shows or hides the Coordinates and Control Points view.

Drawing Shows or hides the  Drawing view.

Function Shows or hides the Function view.

Layer Properties Shows or hides the Layer Properties view.

Library Shows or hides the Library view.

Message Log Shows or hides the Message Log view.

Model Shows or hides the Model view.

Node Library Shows or hides the Library view.

Node View Shows or hides the Node view.

Perspective Shows or hides the Perspective view.

Side Shows or hides the Side view.

Timeline Shows or hides the Timeline view.

Tool Properties Shows or hides the Tool Properties view.

Top Shows or hides the  Top view.

Xsheet Shows or hides the Xsheet view.

3D Graph Shows or hides the 3D Graph view.

Integrated Help Shows or hides the Integrated Help view.

Metadata Editor Shows or Hides the Metadata Editor view.

Script Editor Shows or hides the Script Editor view.
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View Menus
A view menu contains commands specifically related to that view.

How to access a  view menu 

 1. In the top-left corner of a view, click the Menu  button.

3D Graph View Menu 333

Camera View Menu 335

Colour View Menu 352

Drawing View Menu 355

Function View Menu 368

Library View Menu 370

Model View Menu 372

Node View Menu 374

Node Library View Menu 379

Onion Skin View Menu 380

Perspective View Menu 382

Script Editor View Menu 388

Side View Menu 393

Timeline View Menu 398

Top View Menu 403

Xsheet View Menu 408
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3D Graph View Menu
The 3D Graph View menu lets you access commands related to the 3D Graph view, such as selecting different 
subnodes, disabling and enabling subnodes and inserting the 3D Kinematic Output node.

How to access the 3D Graph menu

 l In the upper-left corner of the 3D Graph view, click the menu button.

Command Description

Edit

Copy Subnode Name

Copies the name of the currently selected subnode. This can be useful if you 
need to enter the name of a subnode in the properties of a 3D Kinematic Output 
node. 

TIP 

You can also automatically create a 3D Kinematic Output node with the 
selected subnode's name in its properties by selecting the subnode in 

the 3D Graph view, then clicking on Add 3D Kinematic Output  in 
the 3D Graph toolbar.

Select All Selects all the listed subnodes.

Deselect All Deselects all the subnodes. 

Select Child Subnodes
Changes the selection to the first subnode that is a child of the currently 
selected subnode. 

Select Parent Subnode Changes the selection to the parent of the currently selected subnode.

Select Next Sibling 
Subnode

Changes the selection to the subnode just below the currently selected 
subnode in the list, provided that they have the same parent.

Select Previous Sibling 
Subnode

Changes the selection to the subnode just above the currently selected 
subnode in the list, provided that they have the same parent. 

Subnodes
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Enable
Enables the selected subnode, making it and all its enabled children visible. 
You can also enable a selection of multiple subnodes.

Disable
Disables the selected subnode, making it and all its children invisible. You can 
also disable a selection of multiple subnodes.

Insert

Make Properties 
Available

When the 3D model is connected to a Subnode Animation node, this will add 
the properties (ie: position, angle, scale) of the selected subnode to the 
Subnode Animation node's list of properties in the Timeline view. This is 
useful if you want to add keyframes to a subnode before animating it or if you 
want to outline which subnodes should be animated and which ones should 
not.

3D Kinematic Output

Creates a 3D Kinematic Output node and connects it under the 3D Model's 
Subnode Animation node. This 3D Kinematic Output node will be configured 
to use the currently selected subnode's animation. You can then connect this 
3D Kinematic Output node to an element in your scene to apply the selected 
subnode's animation to that element.

Extended Mode

Displays  non-key subnodes in the subnode list. By default, those nodes are 
hidden because they are not useful for animation and they can significantly 
bloat up the subnode list. However, it may be useful to have access to these 
nodes in order to debug issues with the visbility of parts of your 3D model. 
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Camera View Menu
The Camera View menu lets you do many things in the Camera view, including selecting and editing objects in 
different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Camera menu

 l In the upper-left corner of the Camera view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one when 
moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Strokes With 
Current Colour

Selects all the strokes that are filled with the colour or texture that’s currently 
selected in the Colour view.

Select Strokes With 
Current Pencil 
Texture

Selects all the pencil lines that use the pencil line texture that’s currently selected 
in the Colour view. 

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child Lets you select the first element parented to the selected peg element in the 
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Skipping Effects Timeline view skipping effects in the hierarchy.

Select Child 
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent 
Skipping Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Group

Group: Groups selected drawing objects in the Camera or Drawing view.

Ungroup: Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

View

Navigation

Zoom In: Zooms in the view.

Zoom Out: Zooms out the view.

Rotate View CW: Rotates the Camera view 30 degrees clockwise, like an 
animation table.

Rotate View CCW: Rotates the Camera view 30 degrees counter-clockwise, like 
an animation table.

Reset Zoom: Resets the view’s zoom to its default position.

Reset Rotation: Resets the view’s rotation to its default position.
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Reset Pan: Resets the view’s pan to its default position.

Reset View:  Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line 
Art and 
Colour Art

Displays all Art layers.

Open GL View

Switches the Camera view to fast display, letting you see your animation play in 
real time. The OpenGL display requires less memory. The final look of your effects 
is not shown in the OpenGL View Mode. You must switch to the Render View 
Mode to see your effects.

Render View

Switches the Camera view to a fully rendered display showing the final image of 
the current frame. If a modification is done to your current frame or if you move to 
a different frame, click the Update Preview button to update the display if your 
preview does not update automatically.The Render View Mode display lets you 
see the final look of your frames including effects and antialiasing. You cannot 
play back your scene in Render View Mode. To see your scene fully rendered and 
to play it back, you must press the Render and Play  button in the Playback 
toolbar.

Matte View

Switches the Camera view to a matte display showing the alpha channel of the 
elements in your scene. The transparency level ranges from 0 to 100 percent. Zero 
percent is completely transparent and represented by black and 100 percent is 
completely opaque and represented by white. Everything in between these 
extremes has a transparency level somewhere between 1 and 99 percent and is 
represented in various shades of grey. 

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.
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12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in the Preferences 
dialog box. 

Add to Onion Skin: Adds Adds a series of selected elements to the onion skin 
preview.

Remove from Onion Skin: Removes Removes a series of selected elements from 
the onion skin preview.

Remove Unselected from Onion Skin: Removes Removes all elements except 
the ones selected from the onion skin preview.

Add All to Onion Skin: Adds Adds all of the scene's elements to the onion skin 
preview.

Remove All from Onion Skin: Removes Removes all of the scene's elements 
from the onion skin preview. 

Onion Skinning by Drawing: 

No Previous Drawing: 

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.
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Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous visible 
drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see Turns on the light table so you can see the 
previous and subsequent active layers in washed-out colours. It is useful for 
seeing the other layers when designing, animating or cleaning up your animation. 

Backlight

Produces Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.

Show

Symbol Pivot: Displays a symbol's pivot. The Symbol pivot is similar to the 
Drawing pivot. Each symbol cell can have its own pivot and act the same as the 
Drawing pivot. The Symbol pivot can also be referred to as embedded pivot. 
Inside a symbol, each drawing can have its own pivot. 

Safe Area: Displays Displays the TV safety zone and the centre of the camera 
frame. The safe area adapts to the scene resolution, as well as the safety zone and 
frame’s centre.

Camera Mask: Displays Displays a black mask around the scene’s frame to avoid 
seeing the unnecessary artwork. This option is handy when you're animating and 
setting up the scene. It allows you to see your scene’s composition better.

Control: Displays the controls of the selected element.

BBox Selection Style: Lets you change the display style of selected elements to 
a bounding box style. This removes the default overlay highlight and leaves only 
the bounding box around the selected element.
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Outline Locked Drawings: Drawings that are locked in the Timeline view (cannot 
be selected in the Camera view) are displayed as wireframes.

Show Current Drawing on Top: Displays Displays the selected drawing on top 
of everything while you draw. By enabling this option, each time you select a 
drawing tool, the selected drawing is displayed in front of everything in the 
Camera view. The Timeline and Node view ordering remain unchanged.You only 
need to enable this option once, it is not necessary to do it each time you select a 
drawing tool.

Show Strokes: Displays the strokes in your drawings so that the invisible lines 
stand out.

Show Strokes with Colour Wash: Displays strokes with washed-out colours.

Highlight Selected Colour: 

Show Scan Information: Displays a status bar showing the scanning information 
at the bottom of the Drawing and Camera view.

Hide All Controls Hides the controls of the selected element.

Render Current 
Frame

Renders only the current frame.

Auto Render

Automatically recalculates the preview image whenever you modify a parameter. 
If your scene is heavy and you do not want the preview rendered automatically, 
deselect the Auto-Render option and do the preview update manually.Note that 
this will slow down Harmony as it takes resources to update every frame.

Layer Properties Displays the Layer Properties window of the selected layer in the Timeline view.

Preview Manager
Opens the Preview Manager where you can set options for the quality of 
previews, and clearing and updating the cache.

Bitmap File Quality
Let's you increase or decrease the preview quality of raw bitmap images. By 
default, bitmap files imported in Harmony will display in a low resolution in the 
Camera view to avoid hindering performance. 
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TIP 

You can change the default resolution in which bitmap files are displayed 
in the Camera view by changing the Small Bitmap Resolution preference 
located in the Camera tab of the Preferences dialog.

NOTE 

This only affects the way bitmap images display in the OpenGL preview of 
the scene in the Camera view. The preview quality of bitmap images does 
not affect the final render. 

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not need to trace 
directly over the gap. You can draw it a few millimeters away. The two closest 
points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a selection. It 
is recommended that you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside all 
drawings selected with the Permanent Selection  option in the Select tool.
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Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a selection 
on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If no 
selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a selection 
on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all the 
drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no selection 
has been drawn using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a selection 
on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil strokes 
into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into centreline 
pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. If 
you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 
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Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes: Removes strokes inside painted area. This option only 
works after the painted drawing is flattened.

Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that lies 
unseen beneath the vector contour of a textured line. This often occurs when you 
cut and paste textured lines from one drawing into another. If you cut a portion 
from a textured line and paste it into a different drawing, Harmony pastes the 
entire unseen texture bitmap from the source drawing into the new one, even if 
you only took a small portion of the source drawing. Using the Crop Brush 
Texture command will crop away extraneous texture that does not touch the 
vector area. If there are many textured lines in your scene, this will greatly reduce 
the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).
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Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art 
From Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will be 
created.
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Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent. This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the background) for 
tracing to create a matte directly in Harmony.By default, Harmony creates small 
thumbnail images when imported as bitmap in order to increase performance by 
using a small thumbnail image instead of using the original large size bitmap for 
animation work in Harmony. This will make difficult to view details or trace due to 
the low resolution (blurry). This option temporary increases the resolution of 
bitmaps up to their original bitmap resolution to make tracing easier.

Previous Drawing

Once a cell is selected in the Timeline or Xsheet view, you can navigate between 
the drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour swatch 
to avoid repainting or unpainting the zones linked to that swatch. If you using the 
Paint tool and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Drawing Tools

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil 
lines, shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes 
in your artwork. You can add, remove, tweak and move vector points, move the 
Bezier handles of the vector points as well as  deform vector outlines. 
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Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate and skew 
it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making 
them easier to edit. 

Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope
Allows you to deform and warp artwork by moving points and tweaking lines in a 
grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want 
its location to be.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central 
vector lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing Allows you to create and configure a morphing sequence, which will 
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automatically generate the in-betweens between two drawings in the current 
layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking 
to create each point in the sequence of line segments. 

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush
Lets you repaint existing brush strokes. The new brush strokes will be cropped to 
fit in existing artwork. 

Close Gap
Allows you to close open shapes so that they can be filled with the Paint tool. By 
drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.

Stroke
Allows you to create invisible lines that can serve as colour zones that can be 
filled, or close the gaps in existing colour zones.

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and textures in a 
colour zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View Lets you rotate the Camera and Drawing views just like with a real animation disc.

Animation

Insert Keyframe Adds a keyframe on the selected cell in the Timeline view. 
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Insert Control Point Adds a control point to a 3D path function.

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmony does not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to the 
value of the next keyframe. 

Flip Flips the position of an element on its axis.

Set Ease for Multiple 
Parameters

Lets you set the ease in and ease out on multiple functions and keyframes. This 
opens the Set Ease For Multiple Parameters where you can modify the Bezier or 
Ease curve. You can apply easing parameters to a certain type of function only, 
such as rotation or scale.

Linear Motion Transforms a curved path to a linear path removing tension, bias, and continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Select Previous 
Keyframe/Point

Select the previous keyframe/point.

Select Next 
Keyframe/Point
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Lock Locks a layer so it cannot be selected in the Camera view.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. This 
is useful when doing cut-out animation. Cut-out puppets often have a particular Z 
ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object up 
to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move them 
towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, it 
will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to be 
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at a different location to represent the group's motion better.

Inverse Kinematic 
Tool

Allows you to pose a character model by pulling on its extremities, such as hands 
and feet, and have the other connected limbs follow. Can be used on any piece 
connected in a hierarchy. 

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold 
Orientation

Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Set IK Min Angle
Sets limitations on the angle parameter to prevent the puppet from bending too 
far.

Set IK Max Angle

Remove All 
Constraints

Removes all nails except the minimum and maximum angles.

Morphing

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and 
contour position. Also, if a contour is not animated correctly, you can use hints to 
correct the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint The Zone Hint  point is used on a colour zone to control the proximity rule. The 
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Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone is 
not associated with the corresponding one by default. For example, in a splash 
animation there are many water droplets that are the same colour. Harmony 
automatically morphs the droplet to the nearest one. This is not always the one 
you may have predicted. A Zone Hint will force a colour zone to morph with 
another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. 
It can be used on drawings that were done using the Pencil, Polyline, Ellipse, 
Line and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the 
central vector. Make sure to place it far enough away from the line so you will see 
it snap when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding shape 
in the destination drawing. If you do not place a Vanishing Point Hint to control 
the point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. A 
shape will appear in the destination drawing when there is no corresponding 
shape in the source drawing. If you do not place an Appearing Point Hint to 
control the point of appearance, the shape will appear from its centre and expand 
outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. This 
option is useful while setting hints. You can use the default keyboard shortcut F4 
to toggle between your drawings.

Suggest HInts
Automatically sets Automatically sets hint points on key drawings as a help tool. 
If you're not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Colour View Menu
The Colour View menu lets you access commands related to the Colour view such as creating new palettes, 
adding new colour swatches, and displaying the Tint panel.

How to access the Colour menu

 l In the upper-left corner of the Colour view, click the menu button.

Command Description

Palettes

New

Creates a new colour palette.

By default, Toon Boom Harmony Premium is set to the Basic mode. For simple 
productions, it is recommended to use the Basic mode.  This setting stores the 
palettes automatically for you and saves them at the Scene level. When you use 
the Advanced Palette Lists mode, you can decide at which level you want to 
store your palettes: Environment, Job, Scene, or Element.

Link Lets you access other palettes created in the project and link them to your scene.

Link to External
Lets you you link an external palette to your scene without copying it in your 
project.

Import Imports a colour palette located on your hard drive.

Remove Removes the selected palette from the palette list.

Remove and Delete 
on Disk

Removes the selected palette from the palette list and deletes the palette file 
from the disk.

Rename Lets you five the selected colour palette a new name.

Duplicate
Creates a copy of the original palette, using the same names and colour values, 
but has a different ID and is independent from the original palette. This ensures 
that both the duplicate and original palettes are completely independent.

Clone
Creates a copy of the master palette. The colours in each palette have the same 
properties. The colours have the same identification number pointing to the same 
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colour zones, but they can have different names and RGBA values.

Pencil Texture 
Palette

Displays the colour palette containing the pencil line textures.

Move Up Moves the selected colour palette up one level.

Move Down Moves the selected colour palette down one level.

Colour Editor Opens the Colour Editor where you can pick and edit colour swatches.

Tint Panel
Opens the Tint panel where you can modify a series of colours to blend a tint in 
them or offset their RGBA values. 

Current Palette 
Overrides

When clone palettes are present in the palette list, by default, priority is given to 
the palette that is the highest in the palette list to decide which colours to apply 
to drawings. With this option enabled, priority is given to the currently selected 
palette. Selecting any of the clone palettes will make drawings use colours from 
the selected palette instead. 

Display Colour 
Values

Display the colour values beside their colour swatches in the palette list.

Colours

Cut Cuts the selected colour swatch from the palette.

Copy Copies the selected colour swatch which you can paste in a different palette.

Copy Colour ID
Copies a colour swatch's colour ID so you can keep a reference file of colour IDs 
or use them with custom plug-ins. Example of a colour ID: 075cf5b552401130.

Paste Colour Values Pastes the colour value of the copied swatch over an existing colour swatch.

Paste As New 
Colours

Creates a new colour swatch from the colour value of the copied swatch.

Paste As Clones
Pastes a copied colour to a new palette as a clone of the original one. Both 
colour use the same colour ID. They have to be in different palettes.
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New Creates a new colour swatch from the colour swatch that was last selected.

Edit
Opens the Colour Picker window in which you can edit the selected colour 
swatch.

Delete Deletes the selected colour swatch from the palette.

New Texture
Lets you add a bitmap colour swatch to your palette. You can load photos and 
textures and paint your drawings with it. The bitmap image must be a .tga or .psd 
file format.

Edit Texture
Opens the browser to replace the texture used in a textured colour swatch. All 
zones using the swatch will be updated with the new texture.

Scale Down Texture Lets you set a new maximum texture size or scaling factor.

New Default Colour Creates a new colour using the default colour set in the preferences.

Protect Colour
Locks a selected colour, so if you ever paint over it accidentally, the work already 
done will not be affected. You can also block the filling colours if you painted all 
of the animation in Line Art and plan to repaint the lines.

Swatch Mode
Displays the colour swatches with its corresponding name inside the swatch. 
When this option is not selected, the names of the colour swatches are displayed 
beside the swatch.

Independent Bitmap 
Colour

Bitmap colour selection is independent from the vector colour selection.

Bitmap Colour Sliders

RGB Displays the colour picking sliders as RGB (red, green, blue).

HSV Displays the colour picking sliders as HSV (hue, saturation, value).

354



Drawing View Menu
The Drawing View menu lets you access tools, set morphing  parameters, lock or unlock layers, and select 
elements in the Drawing view.

How to access the Drawing menu

 l In the upper-left corner of the Drawing view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one when 
moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Selects all the strokes that are filled with the colour or texture that’s currently 
selected in the Colour view.

Select Strokes With 
Current Pencil 
Texture

Selects all the pencil lines that use the pencil line texture that’s currently selected 
in the Colour view. 

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

View
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Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW Rotates the Camera view 30 degrees counter-clockwise, like an animation table.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line 
Art and 
Colour Art

Displays all Art layers.

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
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default, the previous drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in the Preferences 
dialog box. 

Show Centre Line: 

No Previous Drawing: Displays no previous drawing.

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous visible 
drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see Turns on the light table so you can see the 
previous and subsequent active layers in washed-out colours. It is useful for 
seeing the other layers when designing, animating or cleaning up your animation. 

Backlight
Produces Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
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unpainted areas of the silhouetted drawing.

Show

Show Strokes Displays the strokes in your drawings so that the invisible lines stand out.

Show Strokes with 
Colour Wash

Displays strokes with washed-out colours.

Highlight Selected 
Colour

Identify a selected colour swatch used in a drawing.

Show Morphing Key 
Drawing Thumbnail

When using the Morphing tools, this displays the source or destination drawing 
as a reference in the bottom corner of the Drawing view.

Show Scan 
Information

Displays a status bar showing the scanning information at the bottom of the 
Drawing and Camera view.

Desk

No Thumbnail

Changes the size of the drawing desk thumbnails.

Small Thumbnail

Medium Thumbnail

Large Thumbnail

Remove Selected 
Drawing

Clears selected drawing from drawing desk.

Remove All 
Drawings

Clears all drawing from drawing desk.

Drawing

Clean Up
Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.
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Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not need to trace 
directly over the gap. You can draw it a few millimeters away. The two closest 
points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a selection. It 
is recommended that you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside all 
drawings selected with the Permanent Selection  option in the Select tool.

Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a selection 
on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If no 
selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a selection 
on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all the 
drawings contained within the same layer. 
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Repaint Outside Selection: Repaints any art outside a selection. If no selection 
has been drawn using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a selection 
on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil strokes 
into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into centreline 
pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. If 
you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes: Removes strokes inside painted area. This option only 
works after the painted drawing is flattened.

Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 
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Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that lies 
unseen beneath the vector contour of a textured line. This often occurs when you 
cut and paste textured lines from one drawing into another. If you cut a portion 
from a textured line and paste it into a different drawing, Harmony pastes the 
entire unseen texture bitmap from the source drawing into the new one, even if 
you only took a small portion of the source drawing. Using the Crop Brush 
Texture command will crop away extraneous texture that does not touch the 
vector area. If there are many textured lines in your scene, this will greatly reduce 
the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 
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NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art 
From Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will be 
created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent. This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the background) for 
tracing to create a matte directly in Harmony.By default, Harmony creates small 
thumbnail images when imported as bitmap in order to increase performance by 
using a small thumbnail image instead of using the original large size bitmap for 
animation work in Harmony. This will make difficult to view details or trace due to 
the low resolution (blurry). This option temporary increases the resolution of 
bitmaps up to their original bitmap resolution to make tracing easier.
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Previous Drawing

Once a cell is selected in the Timeline or Xsheet view, you can navigate between 
the drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour swatch 
to avoid repainting or unpainting the zones linked to that swatch. If you using the 
Paint tool and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Drawing Tools

Select
Allows you to select and reposition, scale, rotate and skew brush strokes, pencil 
lines, shapes and other parts of your artwork.

Contour Editor
Allows you to edit the vector contours of brush strokes, pencil lines and shapes 
in your artwork. You can add, remove, tweak and move vector points, move the 
Bezier handles of the vector points as well as  deform vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the points at the 
centre of its line rather than its contour.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate and skew 
it. 

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, making 
them easier to edit. 

Perspective Allows you to deform artwork by applying a perspective effect on it.
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Envelope
Allows you to deform and warp artwork by moving points and tweaking lines in a 
grid. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the current layer.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where you want 
its location to be.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of central 
vector lines, making them easier to tweak and edit than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil line.

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline
Allows you to draw shapes, segmented lines or complex curved lines by clicking 
to create each point in the sequence of line segments. 

Paint Allows you to fill colour zones with a colour or texture.
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Ink
Allows you to recolour pencil lines with precision by changing the colour of one 
segment at a time. 

Repaint Brush
Lets you repaint existing brush strokes. The new brush strokes will be cropped to 
fit in existing artwork. 

Close Gap
Allows you to close open shapes so that they can be filled with the Paint tool. By 
drawing a stroke near a small gap in a shape, this tool will create a small invisible 
stroke connecting the two closest points around the gap.

Stroke
Allows you to create invisible lines that can serve as colour zones that can be 
filled, or close the gaps in existing colour zones.

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and textures in a 
colour zone. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View Lets you rotate the Camera and Drawing views just like with a real animation disc.

Morphing

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and 
contour position. Also, if a contour is not animated correctly, you can use hints to 
correct the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity rule. The 
Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone is 
not associated with the corresponding one by default. For example, in a splash 
animation there are many water droplets that are the same colour. Harmony 
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automatically morphs the droplet to the nearest one. This is not always the one 
you may have predicted. A Zone Hint will force a colour zone to morph with 
another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. 
It can be used on drawings that were done using the Pencil, Polyline, Ellipse, 
Line and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the 
central vector. Make sure to place it far enough away from the line so you will see 
it snap when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding shape 
in the destination drawing. If you do not place a Vanishing Point Hint to control 
the point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. A 
shape will appear in the destination drawing when there is no corresponding 
shape in the source drawing. If you do not place an Appearing Point Hint to 
control the point of appearance, the shape will appear from its centre and expand 
outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. This 
option is useful while setting hints. You can use the default keyboard shortcut F4 
to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous 
Frame

Goes to the previous frame of the selected frame in the morphing sequence.

Go to Next Frame Goes to the next frame of the selected frame in the morphing sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest HInts
Automatically sets Automatically sets hint points on key drawings as a help tool. 
If you're not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.
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Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Function View Menu
The Functions View menu lets you do many things in the Camera view, including selecting and editing objects 
in different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Function menu

 l In the upper-left corner of the Function view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select Next Keyframe Selects the next keyframe.

Select Previous 
Keyframe

Selects the previous keyframe.

Select Left Handle Selects the left handle of the selected keyframe.

Select Right Handle Selects the right handle of the selected keyframe.

Select All
Selects all objects in the Function view. This helps you manage multiple objects 
as one.

Deselect All Deselects all selected objects in the Function view.

View
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Show Current Frame Displays the current frame 

Toggle Grid Enables the display of the grid.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Function List

Auto Load Selection

Clear

Load Selection

Add Selection

Remove Selection

Show

Show Motion: 

Show Rotation: 

Show Scale: 

Show Skew: 

Show Other: 
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Library View Menu
The Library View menu lets you access commands specific to the Library view, such as opening a Library or 
getting the rights to modify a library folder.

How to access the Library menu

 l In the upper-left corner of the Library view, click the menu button.

Command Description

View

List Displays the contents of the selected folder as a list.

Thumbnails Displays the contents of the selected folder as a thumbnails.

Details Displays the details of the selected file.

Generate Thumbnails Creates a thumbnail to display in the preview window.

Edit

New Symbol

Creates a new symbol from a drawing or part of a drawing in the Drawing or 
Camera view, a layer in the Timeline view, or a node in the Node view. 

If your selection is in the Timeline  or Node view, the new symbol appears in the  
Symbol folder. The current selection is not replaced by the new symbol. The new 
symbol only appears in the library. You must drag it into your scene to use it.

If your selection is in the Drawing or Camera view, the new symbol appears in the 
Symbol folder and in the Timeline view as a new layer.

Cut Cuts the selected file in the Library view.

Copy Copies the selected file in the Library view.

Paste Pastes the selected file in the Library view.

Delete Deletes the selected file in the Library view.
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Delete Thumbnails Deletes any thumbnails that were generated for display in the preview window.

Edit Symbol

Places you inside the symbol where you can edit it. 

To return to the project's timeline, click the Top  button in the Camera view's 
top-left corner, press  Ctrl + Shift + E (Windows/Linux) or ⌘  + Shift + E (macOS). 

Remove Unused Files Removes any files not in use in the selected template.

Rename Template Lets you rename a selected template.

Import Files
Imports vector files such as AI, PDF, and SWF. You requires the right to modify 
the library in which you want to import the files.

Folders

New Folder
Creates a new folder in the Library view. Before you can create a new folder, you 
must have the right to modify the folder in which you are creating the new folder.

Refresh Updates the view and its contents.

Open Library Lets you open a library on your computer.

Close Library Unlinks a library folder from your library list.
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Model View Menu
The Model View menu lets you load models and view them in different ways, as well as access some drawing 
tools.

How to access the Model menu

 l In the upper-left corner of the Model view, click the menu button.

Command Description

Previous Model Shows the previous model loaded in the Model view.

Next Model Shows the next model loaded in the Model view.

Import Model Imports a TVG drawing as a model in the Model view.

Use Current Drawing as 
Model

Loads the currently selected drawing in the scene as a model in the Model view.

Load Default Models
Loads TVG drawings placed in a custom models folder located in the scene 
folder.

Clear Model Removes the model from the Model view.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW Rotates the Camera view 30 degrees counter-clockwise, like an animation table.
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Reset Rotation Resets the view’s rotation to its default position.

Select Activates the Select tool. This tools is also available on the Tools toolbar.

Cutter Selection Allows to cut a section of the model to paste it in your scene.

Dropper
Activates the Colour Eyedropper tool. This tools is also available on the Tools 
toolbar.

Zoom Activates the Zoom tool. This tools is also available on the Tools toolbar.
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Node View Menu
The Node View menu lets you organize the nodes according to how you like to work and the nodes you use 
most often. You can easily add categories and subcategories, remove categories you don't use, and rename 
categories.

How to access the Node menu

 l In the upper-left corner of the Node view, click the menu button.

Command Description

File

Print Lets you print the contents of the Node view. You must be connected to a printer.

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection Deselects the currently selected items and selects all other items that were not 
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selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Layer Properties Shows or hides the Layer Properties view.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected elements 
when the Camera View is in render mode.

Recalculate All
Refreshes the node structure and rerenders the display when the Camera view is 
in render mode.

Tag

You can tag elements in the Timeline or Node views to view only those elements. 
When you tag elements, an asterisk appears beside the item in the Timeline view. 
Once your elements are tagged and you have switched over to View Tagged 
Layers mode, the Timeline view will display only tagged elements. The red bar on 
the left of the layers indicates you are in this view mode.

Timeline Tag: Tags selected elements in the Timeline or Node views.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Auto Render Write
Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this command.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Group Content Select contents within the group node.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Lets you select the parent of the selected element in the Timeline view skipping 
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Skipping Effects effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Node View Zooms in the view.

Zoom Out Node View Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Centre on Selection
Centre the display of the Node view on the selected node. This is useful when 
you have many nodes in the Node view, you may find it hard to locate which one 
is selected. 

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Show All Nodes Display all nodes.

Editor Display the Layer Properties editor of the selected node.

Publish Attribute 
Node

To quickly access parameters for nodes that are grouped, you can select your 
most common parameters to modify and make them appear in the group Layer 
Properties editor. This way, you can access them directly without having to enter 
the group every time.

Show Selected 
Thumbnails

Displays the thumbnails of selected nodes.

Hide All Thumbnails Hides all the thumbnails of selected nodes.
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Navigator

Hide Navigator: Hides the navigator.

Top Right: Places the navigator in the top-right corner of the Node view.

Top Left: Places the navigator in the top-left corner of the Node view.

Bottom Right: Places the navigator in the bottom-right corner of the Node view.

Bottom Left: Places the navigator in the top-left corner of the Node view.

Cable Style

Line: Use straight lines to show the connections between nodes.

Bezier: Use curved (Bezier) lines to show the connections between nodes.

Nodes

Enable Activate the selected node.

Disable Deactivate the selected node.

Enable All Activate all nodes.

Disable All Others
Deactivates all nodes except for those those selected. This operation only affects 
the current level layers. It does not affect the nested nodes within a group. 
Deactivated nodes appear in red.

Clone Selected 
Nodes: Drawings and 
Timing

Creates a copy of the selected element that is linked to the original. If a drawing 
is modified in the original or cloned layer, both will be updated. However, cloned 
layers can have different timings.

When you clone a node, it does not automatically connect itself to the 
Composite node of your scene.

You can clone the drawings only or both the drawings and timing.

Clone Selected 
Nodes: Drawings 
Only

Duplicate Selected 
Nodes

Creates an independent copy of the selected element.  This useful when you need 
to modify the element independently, including the timing (exposure). Changes 
to the original element do not propagate to the duplicate.

Group Selection
Creates a simple group from your selection. The resulting group displays the 
same number of connections as elements in the group.
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Group Selection with 
Composite

Group a selection.

Ungroup Ungroups the selected group of nodes.

Move to Parent 
Group

Moves selected nodes up to the parent group level.

Exit Group Exits the group.

Clear Published 
Attributes

Removes the most common parameters you selected for quick access in the Layer 
Properties editor of a group.

Insert

Composite Adds a Composite node to the Node view.

Display Adds a Display node to the Node view.

Drawing
Opens the Add Drawing Layer dialog box where you can specify the type of layer 
to add.

Group Adds a Group node to the Node view.

Parent Peg Adds a new peg to the timeline as a parent of the selected layer.

Peg Adds a Peg node to the Node view.

Effects
Lets you add effects from these categories: 3D, Combine, Deformation, 
Favourites, Filter, Generator, Group, Misc, Move, Output, Particle, Sapphire, 
Shading and Plugins.

Backdrop
Adds a backdrop to the Node view. Backdrops are a way to work with complex 
node systems that let you associate a selected set of nodes by colour. 
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Node Library View Menu
The Node Library View menu lets you organize the nodes according to how you like to work and the nodes you 
use most often. You can easily add categories and subcategories, remove categories you don't use, and rename 
categories.

How to access the Node Library menu

 l In the upper-left corner of the Node Library view, click the menu button.

Command Description

New Category
Adds a new category to the list of categories to which you can organize nodes 
according to how you like to work and the nodes you use most often.

Rename Category Renames an existing category.

Remove Category Remove a category you no longer need.

Remove Node Removes a node from a category.

Refresh Updates the view and its contents.
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Onion Skin View Menu
The Onion Skin view menu contains extra options for controlling the Advanced Onion Skin. It is accessible via 
the Onion Skin view—see Onion Skin View on page 1282.

How to access the Onion Skin view menu

 1. In the top-left corner of the Onion Skin view, click on the  View Menu button.

Command Description

Advanced 
Onion 
Skin

Enables Advanced Onion Skin. Advanced Onion Skin allows you to select, on the fly, which 
drawings to include in your Onion Skin, even if those drawings are not consecutive drawings, as 
well as the opacity scales for the drawings before and after the current frame. 

The controls for selecting which drawings to display in the Onion Skin as well as their opacity 
sliders are only accessible when Advanced Onion Skin is enabled. Otherwise, when using regular 
Onion Skin, the opacity of drawings in the Onion Skin is determined by the Onion Skin settings in 
the Preferences dialog. The amount of drawings to include in the Onion Skin is set using the Onion 
Skin Add / Reduce One Previous Drawng and Onion Skin Add / Reduce One Next Drawing 
commands, available in the Camera and Drawing toolbars as well as in View > Onion Skin in the top 
menu. 

Original 
Colors

Displays the onion skin using the actual colours of the drawings. 

Coloured
Displays the onion skin using the colours selected for the previous and next drawings in the Onion 
Skin view. 

Coloured 
Outlines

Displays the onion skin using the colours selected for the previous and next drawings, but only as 
outlines instead of filled shapes. 

Onion 
Skin by 
Frames

Selects the drawings to display in the Onion Skin by the amount of different drawings before and 
after the current frame. For example, if the Onion Skin is set to include 2 drawings before and after 
the current frame, this will display the nearest two different drawings before and after the drawing 
in the current frame in the Onion Skin, even if those drawings are further than 2 frames away from 
the current frame. This is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust the extent of the Onion Skin 
in the Timeline view are not available. 
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Command Description

Onion 
Skin by 
Drawings

Selects the drawings to display in the Onion Skin by the amount of different drawings before and 
after the current frame. For example, if the Onion Skin is set to include 2 drawings before and after 
the current frame, this will display the nearest two different drawings before and after the drawing 
in the current frame in the Onion Skin, even if those drawings are further than 2 frames away from 
the current frame. This is more useful for frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust the extent of the Onion Skin 
in the Timeline view are not available. 

Apply 
Colour 
Wash

Displays onion skins with a lighter, less saturated colour. The further away the drawing is from the 
current frame, the more washed its colour appears. 

NOTE 

The minimum and maximum colour wash values for Onion Skin can be customized in the 
Drawing tab of the Preferences dialog.

Enable 
Onion 
Skin for 
Other 
Elements

In the Drawing View, when the Light Table is enabled, making other layers visible alongside the 
current layer, this will make the Onion Skin for other visible layers appear alongside the Onion Skin 
for the current layer. Drawings for elements above the current layer will appear in blue, and 
drawings for elements below will appear in yellow. 

NOTE 

The drawings from other elements that get displayed in the Onion Skin are the drawings that 
are exposed at the same time as the drawings displayed in the current layer's Onion Skin. 

Link 
Sliders

When enabled, the opacity sliders in the Onion Skin view will move simultaneously as you adjust 
one of them, so that the opacity levels for previous and next drawings progresses from the opacity 
level of the first drawing to the opacity level of the last drawing.

When this mode is enabled, you can adjust the first and last sliders for previous or next drawings, 
then, optionally, adjust a single one of the sliders in-between to create a segmented progression. 

However, if you want to make the opacity of Onion Skin drawings to vary in any way that is more 
complex, you must disable this option.
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Perspective View Menu
The Perspective View menu lets you select and edit elements, manipulate the view during scene setup, set 
parameters for animation and access animation tools.

How to access the Perspective menu

 l In the upper-left corner of the Perspective view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children Lets you select all elements parented to the selected peg element in the 
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Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms into the view, towards the view's pivot point, up to 80,000%.

Zoom Out Zooms out of the view, away from the view's pivot point, up to 1%.

Move Forward
Moves infinitely forward into the view, using the direction set by the current 
position and angle of rotation.

Move Backward
Moves infinitely backwards out of the view, using the direction set by the 
current position and angle of rotation.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Face Selected to Draw
Resets any rotations made and brings the selected object to the center of the 
view. Displaying the drawing object at this perspective is intended to facilitate 
drawing  on the object. 

Look at Selected
Resets view to have the selected object at the center, without resetting the 
rotation angles or zoom.

Layer Properties Shows or hides the Layer Properties view.
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Light Table

Turns on the light table so you can see Turns on the light table so you can 
see the previous and subsequent active layers in washed-out colours. It is 
useful for seeing the other layers when designing, animating or cleaning up 
your animation. 

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate Animate

Animate 
Current 
Frame

When this option is selected, every time you use  the  Transform, 
 Advanced Animation or  Inverse Kinematic tools to manipulate 

an element in your scene, the position of the element will be stored in a 
keyframe at the current frame. This allows you to animate elements in your 
scene without creating keyframes manually.

Animate Onion 
Skin Range

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformations to an element in your 
scene, the transformations will be stored as keyframes at the beginning and at 
the end of the current Onion Skin range, as well as on every existing keyframe 
in-between. This can be useful if you want to reposition an element that you 
have already animated, but only during a specific range of frames, which you 
can define by enabling Onion Skin and setting the Onion Skin range to cover 
that range of frames.

Animate Off

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformation to an element in your 
scene, the transformations will affect the element throughout the whole 
scene. This can be useful if you want to reposition an element after you have 
already animated it. 

Insert Keyframe Adds a keyframe to the currently selected frame in the Timeline view.

Insert Control Point
Adds a control point to the motion path at the currently selected frame. This 
control point does not appear in the Timeline, but can be used to reshape the 
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motion path. In order for this command to work,  layers must be set to 3D 
Path. 

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmony does not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion 
keyframes, Harmony generates the interpolation between the motion keyframe 
and the next keyframe. This means that a value for each frame between the 
keyframes is calculated by Harmony to progress from the value of the 
previous keyframe to the value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis 
of the layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.

Linear Motion Straightens out the motion path on either sides of the selected control point.

Lock in Time
Indicates whether the point is locked to a specific frame (keyframe) or only 
locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Locks the Z value when you're animating in 3D space. This means you can 
only reposition your object along the x and y axes. 

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the next 

drawing.

Substitute Drawing Next
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Select Previous Keyframe 
/Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. 
All transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform
Allows you to select drawing layers and position, rotate, scale and skew 
them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale Increases or decreases the size of a selected element. You can scale an object 
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up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every 
drawing included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or 
modifying your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your drawing. 
Also, if you have several elements attached to one trajectory, you might want 
your trajectory to be at a different location to represent the group's motion 
better.
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Script Editor View Menu
The Script Editor view menu gives you access to all of the commands needed for editing and testing scripts in 
the Script Editor view—see Script Editor View on page 1291.

How to access the Script Editor view menu

 1. Add the Script Editor view to your workspace by doing one of the following:

 l In the top-right corner of an existing view, click on the  Add View button and select Script 
Editor.

 l In the top menu, select Windows > Script Editor.

 2. In the top-left corner of the Script Editor view, click on the  Menu button.

Button Description

File

New Script

Creates a new script. When you click on this button, you are first prompted to type in a 
name for the script. Then, you will be prompted to select which location to save the 
script in:

 l User: Saves the script to a directory in your user preferences directory. You will 
be able to run and edit the script from any scene as long as you are logged in as 
the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using Harmony 
Server, the script will be saved to the preferences for your Harmony 
database user.

 l Global: If you are using Harmony Server, select this option to save the script to 
the Harmony database's global script directory. Anyone who is logged in to the 
database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save the 
script to the current scene's environment. Anyone will be able to edit and run 
the script as long as they are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the 
current scene's job. Anyone will be able to edit and run the script as long as 
they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able 
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Button Description

to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable. This option is only available if this 
environment variable is set.

NOTE 

For more information on script locations, see Script list on page 1291.

Import Script

Allows you to import a script from your machine into Harmony. When you click on this 
button, you are prompted to browse for and select a script on your file system. Then, 
you are prompted to select which location to import the script in:

 l User: Saves the script to a directory in your user preferences directory. You will 
be able to run and edit the script from any scene as long as you are logged in as 
the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using Harmony 
Server, the script will be saved to the preferences for your Harmony 
database user.

 l Global: If you are using Harmony Server, select this option to save the script to 
the Harmony database's global script directory. Anyone who is logged in to the 
database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save the 
script to the current scene's environment. Anyone will be able to edit and run 
the script as long as they are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the 
current scene's job. Anyone will be able to edit and run the script as long as 
they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able 
to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable. This option is only available if this 
environment variable is set.
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Button Description

NOTES 

 l When you import a script, any user interface (.ui) or icon (.png) file 
that is in the same directory and has the same filename as the script 
will also be imported.

 l For more information on script locations, see Script Editor View on 
page 1291.

Delete Script

Deletes the selected script. 

NOTES 

 l You cannot delete a script if it is in the Application Resources location, 
as those are scripts that are installed with Harmony.

 l If you delete a script that was originally in Application Resources but 
which you copied to another location so you could make changes to it, 
the original version of the script in the Application Resources folder 
will be restored to the list. 

Refresh Script 
File List

Refresh the list of scripts in the Script Editor. If there are new scripts in your user 
preferences or your scene's scripts sub-folder, click on this button to be able to open 
them in the Script Editor. 

Editor

Set External 
Editor

Allows you to type in the path and name for your preferred text editing software.

NOTES 

 l On macOS, only typing the name of your preferred text editing 
software is enough if that application supports the AppleScript Open 
Document protocol. 

 l On Windows and GNU/Linux, unless your text editor is in your 
system's PATH environment variable, you will have to type in the full 
path to the editor. 

External Editor Opens the selected script in the chosen external text editing software. 
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Button Description

Play/Debug

Set Target

Prompts you to select which script and which function to use with the Run and Debug 
commands.

NOTES 

 l You can set the entire script as the target by selecting the <Nothing> 
function from the functions list.

 l You cannot link an entire script to a toolbar button. Only functions 
within scripts can be added as toolbar buttons. Therefore, running or 
debugging an entire script rather than one of its functions should be 
done for testing purposes only.

Run

Runs the target script and function. 

NOTES 

 l If you have not set a target script and function, you will be prompted to 
set one when you select this command.

 l You can set or change the target script and function by selecting Set 
Target from this menu.

 l If you are editing <<<Sandbox>>>, this button will simply run what 
you typed into the sandbox, regardless of whether another target is 
set.

Debug

Open the target script and function in the Qt Script Debugger, in which you can test and 
debug the function.

NOTES 

 l If you have not set a target script and function, you will be prompted to 
set one when you select this command.

 l You can set or change the target script and function by selecting Set 
Target from this menu.

 l If you are editing <<<Sandbox>>>, this button will simply debug what 
you typed into the sandbox, regardless of whether another target is 
set.
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Button Description

Stop If a script is currently running, this interrupts its execution.

Help

Scripting 
Interface 
Documentation

Opens the reference documentation for the Harmony scripting interface in a web 
browser. 

NOTE 

This documentation is installed with Harmony and does not require Internet 
access. 
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Side View Menu
The Side View menu lets you position elements in 3D space, set parameters for animation and access 
animation tools—see Side View on page 1296.

How to access the Side menu

 l In the upper-left corner of the Side view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.
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Select Parent 
Skipping Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Animate 
Current 
Frame

When this option is selected, every time you use  the  Transform, 
 Advanced Animation or  Inverse Kinematic tools to manipulate an 
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element in your scene, the position of the element will be stored in a keyframe at 
the current frame. This allows you to animate elements in your scene without 
creating keyframes manually.

Animate 
Onion Skin 
Range

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformations to an element in your scene, 
the transformations will be stored as keyframes at the beginning and at the end 
of the current Onion Skin range, as well as on every existing keyframe in-
between. This can be useful if you want to reposition an element that you have 
already animated, but only during a specific range of frames, which you can 
define by enabling Onion Skin and setting the Onion Skin range to cover that 
range of frames.

Animate Off

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformation to an element in your scene, 
the transformations will affect the element throughout the whole scene. This can 
be useful if you want to reposition an element after you have already animated it. 

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmony does not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to the 
value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the 
layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
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following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

Linear Motion Transforms a curved path to a linear path removing tension, bias, and continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.
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Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. This 
is useful when doing cut-out animation. Cut-out puppets often have a particular 
Z ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object up 
to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move them 
towards or away from the camera.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, it 
will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to be 
at a different location to represent the group's motion better.
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Timeline View Menu
The Timeline View menu lets you modify layers, keyframe and timing.

How to access the Timeline menu

 l In the upper-left corner of the Timeline view, click the menu  button.

Parameter Description

Import

From Scanner Imports drawings from a TWAIN scanner.

Images Imports bitmap images which you can choose to vectorize.

Sounds Lets you import sound files into your project.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from 
Xsheet

Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse and 
Reverse-Forward.

Paste Reverse Reverses the timing of drawings or keyframes in range of selection after copying.
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Delete Removes selected objects.

Modify Paste Presets
Lets you modify existing presets when pasting keyframes and exposures. There 
are three presets you can modify: the default presets for both key frames and 
exposures, key frames only and exposures only. 

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Synced Layers
Selects all the layers synced to the selected layer. The selected layer must be a 
synced in order for this option to be enabled.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent 
Skipping Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Lock Lock: Locks Locks one or a multiple selection of layers. 
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Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Tag

Timeline Tag: You can tag elements in the Timeline or Node views to view only 
those elements. When you tag elements, an asterisk appears beside the item in 
the Timeline view. Once your elements are tagged and you have switched over to 
View Tagged Layers mode, the Timeline view will display only tagged elements. 
The red bar on the left of the layers indicates you are in this view mode.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Scene Markers

Mark Current Frame: Places a scene marker on the current frame on which the 
playhead is parked. The marker appears in the frame counter area of the Timeline 
view. You can customize the colour of the scene marker and add text to display 
as a tooltip when you hover over the marker—see .

Create Scene Marker: Creates a scene marker from a selected frame range in the 
frame counter area of the Timeline view.

Edit Scene Marker: Lets you edit an existing scene marker. 

NOTE: It's important to select the entire length of the scene marker, otherwise the 
Timeline Scene Marker dialog box will not open for editing.

Delete Scene Marker: Removes an existing scene marker.

Share Functions
Lets you share an existing function curve. By default, all function curves can only 
be used and modified using their original parameter. If you want another layer or 
parameter to use the same function curve, you must share it.

View
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Cycle to Next View 
Mode

Displays the new view mode.

Normal View Mode

Displays the Normal view mode, the default in the Timeline view. It shows 
everything connected to the chosen display. In this mode, anything not 
connected to the currently set default display will not be shown in the Timeline 
view. This also means that you cannot add certain elements to the Timeline view, 
as by default, when added they are not connected to any display or composite 
node. An example of such an element is a peg.

Selection Only Mode
Displays only elements currently selected in the Camera or Node view. This 
makes it easier to concentrate on one or a few elements at a time.

View Tagged Layers

Lets you see only elements which have been assigned a Tagged status. An item 
that has been tagged will appear in the Timeline view with a small asterisk beside 
its name. 

Once your elements are tagged and you have switched over to View Tagged 
Layers mode, the Timeline view will display only tagged elements. The red bar on 
the left of the layers indicates you are in this view mode. While in this mode, the 
asterisks are not displayed beside the tagged elements.

Show Functions  

Centre on Selection
Scrolls the layers list to the currently selected layer. This is useful if you want to 
select a layer in the Camera view, then manipulate its timing Timeline view. 

Change Track Colour Opens the colour picker window to modify the colour of the selected layer.

Default Track Colour Resets the layer colour.

Collapse/Expand
Toggles between expanding and collapsing all parent layers in the Timeline 
view.

Collapse All Collapses all parented layers in the Timeline view.

Expand All Expands all parented layers in the Timeline view.

Set Tempo Marker

Lets you set a marker that synchronizes your animation with a musical score. This 
lets you reproduce the FPB (Frames Per Beat) and use the tempo signature as 
tempo markers. The Xsheet view lets you pace your animation according to the 
tempo or beat of the soundtrack music or to any rhythmic sound, such as the 
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ticking of a clock or water leaking from a spout. See .

Layers

Add Synced Drawing Layer
Creates a new drawing layer whose timing is synced immediately with the 
currently selected drawing layer.

Sync Layer With
Opens the Convert to Synced Drawing Layer dialog box. In this dialog box, every 
other drawing layer in the project can be selected, parented and have its timing 
synced to the currently selected layer.

Unsync Layer Unsyncs the parent layer of a synced pairing, when the child layer is selected.
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Top View Menu
The Top View menu lets you position elements in 3D space, set parameters for animation and access animation 
tools—see Top View on page 1309.

How to access the Top menu

 l In the upper-left corner of the Top view, click the menu button.

Command Description

Edit  

Cut Drawing Object
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Drawing Object Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Drawing 
Object

Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Lets you select the parent of the selected element in the Timeline view.
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Select Previous 
Sibling

Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Animate 
Current 
Frame

When this option is selected, every time you use  the  Transform, 
 Advanced Animation or  Inverse Kinematic tools to manipulate an 

element in your scene, the position of the element will be stored in a keyframe at 
the current frame. This allows you to animate elements in your scene without 
creating keyframes manually.

Animate 
Onion Skin 

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformations to an element in your scene, 
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Range

the transformations will be stored as keyframes at the beginning and at the end 
of the current Onion Skin range, as well as on every existing keyframe in-
between. This can be useful if you want to reposition an element that you have 
already animated, but only during a specific range of frames, which you can 
define by enabling Onion Skin and setting the Onion Skin range to cover that 
range of frames.

Animate Off

When this option is selected, if you use the  Transform or  
Advanced Animation tools to make transformation to an element in your scene, 
the transformations will affect the element throughout the whole scene. This can 
be useful if you want to reposition an element after you have already animated it. 

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmony does not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to the 
value of the next keyframe. 

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the 
layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

405

Harmony 21 Premium Reference Guide                          



Chapter 2: Menus

Linear Motion

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z Resets Resets all transformations on the current frame except the Z position. This 
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is useful when doing cut-out animation. Cut-out puppets often have a particular 
Z ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform Allows you to select drawing layers and position, rotate, scale and skew them. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object up 
to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move them 
towards or away from the camera.

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, it 
will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to be 
at a different location to represent the group's motion better.
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Xsheet View Menu
The Xsheet View  menu lets you modify columns, keyframe and timing.

How to access the Xsheet menu

 l In the upper-left corner of the Xsheet view, click the menu button.

Parameter Description

File

Import

Images: Imports bitmap images which you can choose to vectorize.

From Scanner: Imports drawings from a TWAIN scanner.

Sounds: Lets you import sound files into your project.

Print
Prints the exposure sheet so you can take it to your animation table,  provide a 
copy to the animator, or create your Xsheet skeleton directly in Harmony.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from 
Xsheet

Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse and 
Reverse-Forward.
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Paste Reverse Reverses the timing of drawings or keyframes in range of selection after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Insert Mode

Adds a new value or a new value sequence over existing ones, the new values 
are inserted between the old ones. The existing timing sequence is pushed down 
the column. The Insert mode opposite of the Overwrite mode, which is the Xsheet 
default mode.

Gestural Drag Mode

Lets you drag a cell to any other frame in the same column or into another 
column.

This feature does not apply to Annotation columns.

Send to Function 
View

Sends selected objects to the Function view where you can edit and adjust its 
function curve and parameters.

View

Zoom In Xsheet Zooms in the view.

Zoom Out Xsheet Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Set Tempo Marker  

Expand/Collapse

Collapse Selection: 

Expand Selection: 
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Collapse All: 

Expand All: 

Column Properties

Lets you rename a column, and enable or disable a column. To view additional 
properties, select Edit > Preferences from the top menu. In the Preferences 
dialog box, select the Advanced tab, then select the Advanced Element Mode 
option.

Show Column List  

Column Types 
Manager

Lets you add advanced column types to create particular animation paths. When 
you create these columns, they are not linked automatically to any particular 
drawing layer. You can create a motion path using these columns and then link or 
unlink several drawing or peg layers to it. 

Show Thumbnails
Displays column thumbnails making it easier to identify a particular column. This 
option displays a small thumbnail picture of the current frame below the column 
header.

Show Selection  

Set Columns Width Lets you change the column width (in pixels) and set it as the default.

All Columns to 
Default Width

Returns all columns to their default width of 100 pixels.

Change Columns 
Colour

Lets you customize the colour of the column by selecting one from the Select 
Colour dialog box. The colour you select is also reflected in the correspondng 
layer in the Timeline view.

Default Column 
Colour

Removes the colour you assigned to a column (if any).

Hide Selected 
Columns

Hides selected columns.

Unhide All Columns Displays all columns.

Show Hidden 
Columns

Displays columns that were previously hidden.
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Enable Playback Plays back your animation in the Perspective view.

Columns

Add Columns
Lets you add a column. You can specify the column name, type, and set drawing 
layer options in the Add Column dialog box that opens.

Delete Columns
Removes the selected column. You have the option to delete the associated 
drawing files and element folders.

Clone Selected 
Columns: Drawings 
Only

Creates a copy of the selected column that is linked to the original. If a drawing is 
modified in the original or cloned column, both will be updated. However, 
cloned columns can have different timings. 

You can clone the drawings only or both the drawings and timing.
Clone Selected 
Columns: Drawings 
and Timing

Duplicate Selected 
Columns

Creates an independent copy of the selected column.  This useful when you need 
to modify the element independently, including the timing (exposure). Changes 
to the original element do not propagate to the duplicate.

Merge Selected 
Columns

There are two methods of merging drawings. 

 l You can merge selected drawings in adjacent elements. The columns and 
layers will be left intact, and each new merged drawing will reside in the 
frames of the left-most column or lower layer.

 l You can merge elements. All drawings will be merged. Unused columns 
and layers will be deleted, but the original drawing files are still 
accessible.

Frames  

Add Frames At Start

Adds the number of frames you specify to the end of the scene.

Add Frames At End

Add Frames Before 
Selection

Adds the number of frames you specify before or after your selection.

Add Frames After 
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Selection

Remove Selected 
Frames

Deletes the selected frames from your scene.

Drawings

Create Empty 
Drawing

Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Creates a duplicate of the selected drawing in the layer. The duplicate drawing 
will be exposed at the selected frame instead of the original drawing. Hence, this 
command allows you to instantly start working on a duplicate of the current 
drawing and retain the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced 
with the new drawing, up until the next key exposure.

Rename Drawing Lets you give a selected drawing a new name.

Mark Drawing As

Marks selected drawings as one of the following: Key, Breakdown, In-between, 
RetakeKey, RetakeBD or RetakeIB.

This helps to keep the Xsheet well organized while animating.

When working with several animators, directors or even other studios, the 
necessity for retakes will often arise. Harmony gives you the possibility to mark 
new drawings as either Retake Key, Retake Breakdown, or Retake In-betweens.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.

Substitute Drawing 
Next

Exposure

Increase
Adds Adds one more exposure to a selected cell; repeating this action adds an 
extra cell each time. This is an efficient way to extend a drawing's exposure and is 
always set in Insert mode. Increasing an exposure pushes the existing exposure 
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forward.

Decrease
Decreases exposure of a selected cell by one; repeating this action decreases one 
exposure adds an extra cell each time. This is an efficient way to shorten a 
drawing's exposure. Decreasing an exposure pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure Lets you extend the length of a selected cell.

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key 
Exposure

Removes key exposures from the selected cells.

Remove Duplicate 
Key Exposure

When working with drawings to adjust the timing of a mouth in a lipsync, for 
example, and forcing the use of specific key exposures, unnecessary key 
exposures will be created. You can delete these duplicates without affecting the 
rest of the drawing. The first drawing of the selection will be used for the range.

NOTE 

Duplicate key exposures may occur when pasting with the Enforce Key 
Exposure option selected.

Fill Empty Cells

Lets you Fills the empty frames in the selection with the exposure just before. For 
example, if you select a range of frame that starts with an exposed drawing and 
then ends with empty cells, all of the empty cells in the selection will be filled 
with the exposed drawing just before the empty cells. 

Insert Blank Cell Adds Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Fill Selection

Lets you Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many columns, an 
entire column, or many columns. You can use numbers, words, letters, or any 
alphanumeric value.
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Sequence Fill

Lets you Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a cycle, and so 
on. The selection can be over one cell or a cell range in one column or more or an 
entire column or many entire columns.

Fill Cells Randomly

Lets you Lets you fill in random values over a selection. You can give a maximum 
and a minimum value and create a range for Harmony to choose the random 
values from. The selection can be over one cell or a cell range in one column or 
more or an entire column or many entire columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Motion

Insert Keyframe

Insert Keyframe and 
Duplicate Drawing

 

Delete Keyframes Deletes the selected keyframes.

Go to Previous 
Keyframe

 

Go to Next Keyframe  

Set Stop-Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-
motion keyframe and the next keyframe, Harmony does not generate any 
animation and the element remains static until the next keyframe. 

Set Motion Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is 
calculated by Harmony to progress from the value of the previous keyframe to the 
value of the next keyframe. 

Morphing

Create Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the current 
layer. 
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Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire sequence 
between the two keyframes.

Insert Morphing Key 
Drawing

Creates a morphing keyframe from a selected morphing frame.

Convert Morphing to 
Drawing

Lets Lets you convert your morphing inbetweens to real drawings you can edit. 
This is useful when manually editing a morphing sequence or if you prefer to 
have animation timing in double frame (on twos) instead of single frame (on 
ones). 

Lip-Sync

Change Mouth Shape 
to

Lets you change the mouth shape to one of the following: A, B, C, D, E, F, G, X.

Auto Lip-Sync 
Detection

Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps Automatically maps drawings in an element to the mouth 
chart you have generated for a sound. This can save time when you are lip-
synching a voice track.

Sound Display

Sound Name
Shows the name of the sound file, as well as the file format. The line running 
vertically through the column frames between the same file name indicates a 
continuity of the same sound file in these frames.

Mouth Shapes

Shows the letter (or name depending on the way you named your character's 
different mouth positions) in the column's frames. There is only one mouth 
position allotted per frame and this position should correspond to the sound file 
after performing a lip-sync.

Waveform

Shows a vertical display of the sound file's actual waveform. In the column 
header, in the field under the column name, you can type in a percentage to zoom 
in or zoom out on the waveform, or pass the scroll cursor  over the Zoom 
Waveform  icon.

Sound Edit
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Insert Blank Cell Places an empty cell between other cells. 

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Annotation

Import File Lets you import an image file in an Annotation column.

Change Pen Colour
Lets you change the pen colour by selecting one from the Select Colour dialog 
box.

Pen Width Lets you select a pen preset or change the pen width (in pixels).

Eraser Width Lets you modify the width of the Eraser tool.

Erase All
Removes all text and drawn annotations. Annotations that you type in cannot be 
erased using this method.

Erase Selected 
Images

Removes images you select in the Annotation column.

Erase Selected Texts Removes text you select in the Annotation column.

Enable Drawing Lets you draw in the Annotation column using your mouse or pen tablet.
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Chapter 3: Nodes / Layers
The Node view is a visual representation of how every element in your scene, be it drawing layers, pegs, effects 
and others are combined together to form the final composited image. It allows you to rig the elements in your 
scene together and add a wide range of effects to your scene. Getting to know how to use the Node view is 
important especially for rigging cut-out models, adding effects to scene or managing the way your scene is 
composited, rendered and displayed in Harmony. 

3D Nodes 425

3D Kinematic Output Node 426

Flatten Node 429

Render Maya Batch Node 431

Subnode Animation Node 436

Z Buffer Smoothing Node 440

Combine Nodes 442

Blending Node 443

Composite Node 449

Composite-Generic Node 454

Cutter Node 460

Highlight Node 462

Image Switch Node 466

Matte-Composite Node 468

Tone Node 471
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Transformation Switch Node 475

Constraint Nodes 477

Constraint Switch Node 479

Dynamic Spring Node 482

Multi-Points Constraint Node 487

Static Transformation Node 490

Three-Points Constraint Node 493

Transformation Gate Node 496

Transformation Limit Node 498

Two-Points Constraint Node 504

Deformation Nodes 510

Articulation Node 511

Auto Fold Node 514

Auto Muscle Node 516

Bone Nodes 520

Curve Node 524

Deformation Composite Node 528

Deformation Root Node 531

Deformation Scale Node 532

Deformation Switch Node 537

Deformation Uniform Scale Node 539

Deformation Wave Node 541

Fold Node 544

Game Bone Node 548

Glue Node 550

Kinematic Output Node 552

Mesh Warp Node 553

Offset Node 557

Point Kinematic Output Node 559

Connections 560
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Refract 566

Stick Node 568

Turbulence Node 570

Weighted Deform Node 574

Filter Nodes 578

Anti-Flicker Node 580

Auto-Patch Node 582

Bloom Node 584

Blur-Box Node 588

Blur-Directional Node 591

Connection 592

Layer Properties 593

Blur-Gaussian Node 595

Blur-Radial Node 598

Blur-Radial-Zoom Node 600

Blur-Variable Node 604

Brightness Contrast Node 606

Channel Selector Node 608

Channel Swap Node 610

Chroma-Keying Node 612

Colour Banding Node 618

Colour Art Node 621

Colour Curves Node Properties 624

Colour Fade Node 629

Palette Overrides 630

Individual Colour Overrides 632

Colour Levels Node 636

Colour-Override Node 639

Colour-Scale Node 644

Colour Selector Node 646
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Contrast Node 649

Dither Node 651

Focus Node 653

Focus Multiplier Node 656

Gamma Node 658

Glow Node 661

Grain Node 665

Greyscale Node 667

Hue-Saturation Node 669

Increase Opacity Node 676

Layer Selector Node 679

Line Art Node 682

Luminance Threshold Node 684

Matte-Blur Node 687

Matte-Resize Node 690

Median Node 692

Motion Blur Node 695

Motion-Blur-Legacy Node 699

Negate Node 702

Overlay Layer Node 704

Pixelate Node 706

Remove Transparency Node 708

RGB Difference Keyer Node 710

Shadow Node 715

Transparency Node 718

Underlay Layer Node 720

Generator Nodes 723

Animated Matte Generator Node 724

Burn-In Node 735

Colour-Card Node 739
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Element / Drawing Node 742

Connection 743

Field Chart Node 760

Gradient Node 765

Grid Node 771

Lens Flare Node 774

Turbulent Noise Node 777

Group Nodes 781

Group Node 782

Multi-Port-In Node 783

Multi-Port-Out Node 784

Miscellaneous Nodes 785

External Node 786

Master Controller Node 789

Note Node 795

OpenGL Bypass Node 796

OpenGL-Cache-Lock Node 798

Pre-Render Cache Node 801

Connection 802

Render Preview Node 805

Script Node 806

Visibility Node 809

Move Nodes 810

Apply Image Transformation Node 811

Apply Peg Transformation Node 814

Camera Node 818

OrthoLock Node 820

Peg Node 822

Shake Node 824

Transform-Loop Node 828
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Quadmap Node 831

Quake Node 834

Output Nodes 837

Crop Node 838

Display Node 841

Multi-Layer Write Node 842

Scale Output Node 846

Write Node 848

Particle Nodes 863

3D Region 865

Baker 867

Baker Composite 870

Bounce 871

Explosion 873

Gravity 875

Image Fracture 877

Kill 883

Move Particles 885

Orbit 887

Planar Region 890

Random 894

Region Composite 895

Repulse 896

Rotation Velocity 897

Sink 900

Size 901

Sprite Emitter 903

System Composite 913

Velocity 914

Visualizer 917
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Vortex 919

Wind-Friction 921

Shading Nodes 922

Ambient Occlusion Node 923

Cast Shadow Node 927

Light Position Node 934

Light Shader Node 936

Light Shader Properties - Surface Light Tab 940

Normal Map Node 941

Normal Map Converter Node 945

Shape Curve Node 947

Shape Line Node 950

Shape Render Node 952

Surface Map Node 955

Layer Properties 956

Surface Normal Node 959

Tone Shader Node 961

Tone Share Properties - Surface Light tab 964

Volume Object Node 965

Plugin Nodes 967

Sparkle 968

Selection Preset Note Node 971

Sound Layer 972
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3D Nodes
The nodes found in the 3D category are used to handle and render 3D objects such as animating the sub-
nodes or rendering using Maya.

3D Kinematic Output Node 426

Flatten Node 429

Render Maya Batch Node 431

Subnode Animation Node 436

Z Buffer Smoothing Node 440
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3D Kinematic Output Node
A 3D Kinematic Output node can be used to connect the animation for a subnode to another node. This allows 
to use a subnode's animation on other elements in the scene, as if it was part of a hierarchy of peg and the 
subnode was the parent peg.

Connection

The 3D Kinematic Output node must be connected under a Subnode Animation node, from which it will take 
one of the subnode's animation, and then connected as a parent of the node on which it must apply that 
animation. 
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TIP 

You can quickly create a 3D Kinematic Output node by selecting a subnode in the 3D Graph view, 
then clicking on the Add 3D Kinematic Ouput  button. The 3D Kinematic node will be connected 
under the model's Subnode Animation node, and configured to apply the selected subnode's 
animation to its child. It must then be connected to a child element in the Node view.

NOTE 

It is not possible to animate the subnodes of a 3D model without a Subnode Animation node. 
Hence, the 3D Kinematic Output node must be connected under a Subnode Animation node, and 
not directly under a 3D model—see Subnode Animation Node on page 436.

Properties

The Subnode Name attribute of a 3D Kinematic Output node determines which of the 3D model's subnode will 
be used to animate the node's child.

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no 
visible effect on the rendered image, nor on the preview in the Camera, 
Perspective, Side and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the 
Node view. 

Name
Allows you to enter a name for the node.

It is recommended to use the name of the subnode followed by -Output.
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Subnode Name

Use this field to enter in the part of the 3D model whose movements you 
would like to track. Entering the name of the 3D model subnode into this 
field is what lets the 3D Kinematic Output node know which part of the 
model to read.
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Flatten Node
The Flatten node is used to transform 3D objects into flat planes when ordered in the Composite node. That 
plane can then be moved arouned like any other drawing. Instead of intersecting with 2D layers, the 3D object 
will either be behind or in front.

When all objects are at the same distance (z value) from the camera, the order is based on the Composite 
ports. When elements are placed at different distances from the camera, the z axis value overrides the 
composite port ordering. 

Connection

The Flatten Node takes a 3D image in its input port and outputs a 2D image. 

Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 
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Parameter Description

Name Allows you to enter a name for the node.
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Render Maya Batch Node
By default, 3D models imported in Harmony are rendered using OpenGL. The Maya Batch Render can be used 
to render a 3D model connected to it through Autodesk Maya, then output the rendered image to the scene so 
that it can be composited. It can be configured to use one of several of the rendering engines supported by 
Maya, such as RenderMan, Mental Ray and Maya Software. 

NOTE 

The Maya Batch Render node is basically a Script Node pre-configured to take the input image and 
process it through the renderMayaBatch() built-in function of the Harmony scripting 
interface—see Script Node.

Connection 

The MayaBatchRender node takes a 3D model in its input port, and outputs a 2D rendered image when the 
scene is rendered. 

NOTE 

The Maya Batch Render node does not affect the OpenGL preview of the scene in the Camera 
view. To see the effect of the Maya Batch Render node in Harmony, you must set the preview mode 
of the Camera view to Render View  mode.

Configuration

For the Maya Batch Render node to work, the following conditions must be met:

 l The path to Autodesk Maya and, if needed, to RenderMan, must have been set on your machine using 
the TB_Set_3dRenderer_Paths.js script which is bundled with Harmony.

 l The original Maya project in which the 3D model was created must be in the element folder of the 3D 
model you imported into your Harmony scene, and must have the same file name as the 3D model you 
imported, but with the appropriate extension. Additionally, the model's textures should also be in the 
element folder. 
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In the following example, the 3D model is a Filmbox (.fbx) model that was imported in a Harmony 
scene into an element named Ship. The .fbx file was named Ship-1.fbx. Hence, for the Maya Batch 
Render node to render it, the original Maya project must be in the folder of the Ship element. Since the 
Maya project has the extension .ma and the 3D model is named Ship-1.fbx, the Maya project must 
be named Ship-1.ma:

NOTES 

 l You can also make the Maya Batch Render node source the Maya project from its original 
location—see Specifications Tab on page 433.

 l For detailed steps on how to use the Maya Batch Render node, refer to the 3D Integration 
chapter of the User Guide.

Layer Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Allows you to enter a name for the node.

Attributes Tab

Parameter Description

Renderer

Specify the rendering engine to use. The following engines are supported:

 l 'renderMan' (or 'reyes')

 l 'renderManRIS' (or 'RIS')

 l 'arnold'

 l 'mentalRay'

 l 'mayaSoftware' (or 'maya')

Specifications Tab

The specification tab is used to define the attributes in the Attributes tab as well as the input and output ports 
of the node. By default, it is configured to have one input image port, one output image port, and a Renderer 
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parameter in the Attributes tab, which allows you decide which rendering engine to use to render the 3D 
model. The following is the default Specifications script for the Maya Batch Render node:

<specs>
   <ports>
     <in type="IMAGE"/>
     <out type="IMAGE"/>
   </ports>
   <attributes>
     <attr type="string" name="renderer" value="" tooltip="If this attribute is not set, then the MayaBatchRender node will use the default renderer specified in the Maya file. If this attribute is set, then it forces the use of a specific renderer other than the default. The following renderers are currently supported: 'renderMan' (or 'reyes'), 'renderManRIS' (or 'RIS'), 'arnold', 'mentalRay', 'mayaSoftware' (or 'maya'). Note that those values are case insensitive."/>
   </attributes>
</specs>

By default, the Maya Batch Render node expects the Maya project for the 3D model to be in the same directory 
as the 3D model itself, with the same file name, but a different extension. However, you can add another 
attribute to the node which allows you to specify the path to the Maya project to use for rendering the 3D 
model. To do this, add the bolded line to the Specifications tab:

<specs>
   <ports>
     <in type="IMAGE"/>
     <out type="IMAGE"/>
   </ports>
   <attributes>
     <attr type="string" name="renderer" value="" tooltip="If this attribute is not set, then the MayaBatchRender node will use the default renderer specified in the Maya file. If this attribute is set, then it forces the use of a specific renderer other than the default. The following renderers are currently supported: 'renderMan' (or 'reyes'), 'renderManRIS' (or 'RIS'), 'arnold', 'mentalRay', 'mayaSoftware' (or 'maya'). Note that those values are case insensitive."/>
    <attr type="string" name="OriginalMayaFileName" value="" tooltip="Write your project path here"/>
   </attributes>
</specs>

After changing the content of the Specifications tab, you must save, close and re-open the scene before you 
can see the new OriginalMayaFileName field in the Attributes tab. You can then type in the path to the Maya 
project that the Maya Batch Render node should render. 
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NOTES 

 l The path should include the name of the project file as well as its extension.

 l You must use forward slashes (/) to separate the directories in the path, even on Windows, like 
in this example:

C:/Users/username/Documents/MyProject.ma

 l You can use a relative path. The path is relative to the element folder containing the 3D model 
used in the Harmony scene. For example, ../../ points to the scene directory. 

Softrender Tab

This tab contains the script to execute when the scene is rendered. By default, it contains this single function:

renderMayaBatch();

This function takes the 3D model in the input image and renders it using Autodesk Maya, using the rendering 
engine specified in the Attributes tab. To do this, it uses the original Maya project for the 3D model and 
instructs Autodesk Maya to render it, but with the transformations in position, angle and scale applied to it in 
the current frame of the Harmony scene. Autodesk Maya then produces an OpenEXR (.exr) image with deep 
pixels, which Harmony integrates into the scene and composites it with other elements and effects. 

NOTE 

The other tabs in the Maya Batch Render node properties are the standard tabs for a Script node. 
This is because the Maya Batch Render node is just a Script node set up to execute 
renderMayaBatch();. For more information, see Script Node on page 806.
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Subnode Animation Node
When manipulating 3D models, by default, it is only possible to animate the transformation on the whole 
model. Transformations on their individual parts (subnodes) are static. In order to be able to animate the 
subnodes in a 3D model, it must be connected to a Subnode Animation node, which will store the animation 
information for individual subnodes and apply it to the model. 

Connection

The Subnode Animation node takes a 3D model in its input port. As soon as a 3D model is connected to a 
Subnode-Animation node, its subnodes become animatable individually. Once you start animating the model's 
subnodes, the node outputs the 3D model with its subnodes animated. 

The parameters for each subnode that is animated will appear in the node's parameters in the timeline.
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TIP 

You can add the parameters for a subnode to the Subnode Animation node without animating it 
first. To do this, select the subnode, then click on the Make Properties Available  button in the 
3D Graph view. This can be useful if you want to make a keyframe with the subnode's resting 
position before animating it.

Layer Properties

All animatable 3D model subnodes appear in a list in the Subnode Animation Layer Properties. Expand any of 
the subnodes in the list to view its individual properties.

Click on any of the Function  buttons  to open the Function Editor for that parameter. 

If movements have already been created in the Camera view, you may not be able to edit some of the fields. 
They just display the value of that parameter at the given position in the Timeline. If you would like to edit 
these fields, change the field type to Local.
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path: When the 3D Path option is selected, lets you choose the path type. You 
can do this form the field menu, located after the Function button .

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 
movement occurs across the X, Y and Z axes.

Rotation

Quaternion: Rotations made on the X, Y and Z axes are linked, as is the velocity 
which acts on the three rotation functions simultaneously. 

Euler Angles: Rotations can be made on the X, Y and Z axes  independent of each 
other; each has its own velocity.

3D Rotation: When the Quaternion option is selected, lets you choose the path 
type. You can do this form the field menu, located after the Function button .

(x) Axis: Lets you enter the horizontal rotation value in degrees.

(y) Axis: Lets you enter the vertical rotation value in degrees.

(z) Axis: Lets you enter the depth scale value in degrees.

Velocity: When the Quaternion option is selected, lets you set the speed at 
which rotation occurs across the X, Y and Z axes.

Scale
Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally
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Separate: Resizes the element allowing to modify the ratio (squash and stretch).

(x) Axis: Lets you enter the horizontal scale value.

(y) Axis: Lets you enter the vertical scale value.

(z) Axis: Lets you enter the depth scale value.

Scale in Fields: Instead of using the standard scaling units, when this option is 
enabled, images are scaled using field units, based on the traditional animation 
field chart. Enter in the x, y, z values respectively in the fields below. 
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Z Buffer Smoothing Node
Rendering engines such as Maya and Mental Ray output images in a format that uses a simple Z-buffer that 
does not allow for proper antialiasing around the edges of the geometry. Hence, it is ultimately better for 
image quality to render using RenderMan or Arnold if possible. Otherwise, if a different rendering engine must 
be used and there appears to be pixelated hard seams around 3D models, the Z Buffer Smoothing node can be 
used to smooth out the edges of the rendered model.

Connection

The Z-Buffer-Smoothing node takes the rendered 3D model output by a MayaBatchRender node as its input 
image, and outputs the rendered 3D model with its edges smoothed.

Layer Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Allows you to enter a name for the node.

Histogram Range

Lets you define the range of clean pixels in the depth histogram when rendering 
3D models.  Only opaque or semi-transparent values are considered.  

A low value means fewer pixels are used in the depth calculations and may 
flatten your object, while a higher value uses more pixels in the depth 
calculations, but may not eliminate all the image artifacts.

Kernel Size

Lets you determine the size of the matrix used for calculating the depth of a 
single pixel.  For example, for an operation with a kernel size of 3 pixels, Harmony 
uses the pixels within a 1-pixel radius to calculate the effect. A larger kernel size 
means longer calculations.
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Combine Nodes
The nodes found in the Combine category are used to take two or more elements are combine them into a new 
image.

Blending Node 443

Composite Node 449

Composite-Generic Node 454

Cutter Node 460

Highlight Node 462

Image Switch Node 466

Matte-Composite Node 468

Tone Node 471

Transformation Switch Node 475
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Blending Node
T-COMP2-005-001

By default, layers are composited onto each other directly. This means that opaque pixels in front-most layers 
hide pixels in layers further back, and semi-transparent pixels on front-most layers are blended with pixels 
further back proportionally to their alpha ratio. This does the job for solid objects. However, some types of 
layers and effects may look better when composited into the scene using more advanced approaches. The 
Blending node can be used to composite an element, effect or composite using one of many different 
algorithms that may make it look much better in the final render.

NOTE 

The effect of the Blending node is only visible when the Camera view is in Render Preview  
mode.

Connection

A Blending node can be connected under a layer, an effect or a composite to affect the way it will be 
composited into the scene.
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Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side and 
Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name Allows you to change the name given to the node.

Blend Mode Choose the blending effect mode you wish to apply to your layer. 
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NOTE 

Some of the available blending modes have a BETA or Legacy variant to them.
                         

 l A BETA blending mode is one that has been recently added in 
Harmony and which was made to more closely resemble results 
obtained in professional photo editing software such as Adobe 
Photoshop.

 l A Legacy blending mode is a blending mode that was present in 
older versions of Harmony. Starting from Harmony 10, these 
blending modes were enhanced by de-multiplying colours before 
compositing the image then re-multiplying them. Their legacy 
version remain available to ensure scenes created in older versions 
of Harmony do not render differently. 

 l Normal: Composites the image without any specific blending effect.

 l Add / Add Legacy: Adds the colour values of each channel in the overlay 
pixel and the underlay pixel. For example, adding two dark grey pixels with a 
value of 100 in each channel will result in a light grey pixel with a value of 
200 in each channel. Likewise, if one of the pixels is red and the other is 
green, the resulting pixel will be yellow. 

 l Burn / BETA Colour Burn: Darkens each channel in the underlay pixel with 
the darkness value of the corresponding channel in the overlay pixel, by 
increasing the contrast of the underlay pixel. 

 l Darken / BETA Darken: For each channel, uses the value that is the darkest 
between the underlay pixel and the overlay pixel. 

 l BETA Linear Burn: Darkens each channel in the underlay pixel with the 
darkness value of the corresponding channel in the overlay pixel, by reducing 
the brightness of the underlay pixel. 

 l Multiply / BETA Multiply: Multiplies the value of each channel in the 
underlay pixel with the value of each channel in the overlay pixel, treating 
those values as ratios. Multiplying anything with black will result in black, 
and multiplying anything with white will leave the colour unchanged.

 l Dodge / BETA Colour Dodge: Lightens each channel in the underlay pixel 
with the brightness value of the corresponding channel in the overlay pixel, 
by decreasing the contrast of the underlay pixel. 

 l Erase: Subtracts the overlay pixel's alpha from the underlay pixel, "cutting 
out" the overlay from the underlay. The overlay pixel's colour information is 
ignored. 

 l Lighten / Lighten Legacy / BETA Lighten: For each channel, uses the value 
that is the brightest between the underlay pixel and the overlay pixel.

 l BETA Linear Dodge: Lightens each channel in the underlay pixel with the 
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brightness value of the corresponding channel in the overlay pixel, by 
increasing the brightness of the underlay pixel. 

 l Screen / BETA Screen: The reverse of multiply. Multiplies the reverse value 
of each channel in the underlay and overlay pixel, treating those values as 
ratios. Multiplying anything with white will result in white, and multiplying 
anything with black will leave the colour unchanged. 

 l Vividlight: This colour dodges overlay pixels with a value above 50% onto 
underlay pixels, and colour burns overlay pixels with a value below 50% 
onto underlay pixels. The brighter the overlay pixel is, the more intense the 
colour dodging effect will be. The darker the overlay pixel is, the more intense 
the colour burning effect will be. 

 l Hardlight / Hardlight Legacy / BETA Hardlight: This screens overlay pixels 
with a value above 50% onto underlay pixels, and multiplies overlay pixels 
with a value below 50% onto underlay pixels. The brighter the overlay pixel 
is, the more intense the screen effect will be. The darker the overlay pixel is, 
the more intense the multiplying effect will be. Blending any colour with 
white or black will result in white or black, and blending a colour with plain 
grey will leave the colour unchanged. 

 l Linearlight: This linear dodges overlay pixels with a value above 50% onto 
underlay pixels, and linear burns overlay pixels with a value below 50% onto 
underlay pixels. The brighter the overlay pixel is, the more intense the linear 
dodging effect will be. The darker the overlay pixel is, the more intense the 
linear burning effect will be. 

 l Overlay / Overlay Legacy / BETA Overlay: Like hardlight, exept it screens or 
multiplies the underlay pixel over the overlay pixel, based on the value of the 
underlay pixel.

 l Pin Light: For each channel, if the overlay pixel's value is above 50%, use the 
lightest pixel between the underlay and overlay pixels. If the overlay pixel's 
value is below 50%, use the darkest pixel between the underlay and overlay 
pixels.

 l Softlight / BETA Softlight: Each channel of the overlay pixel lightens or 
darkens the corresponding channel of the underlay pixel on a softer  scale. 
The effect is proportional to how dark or bright the overlay pixel is, but 
inversely proportional to how dark or bright the underlay pixel is. 

 l Difference / Difference Legacy: For each channel, this takes the darkest pixel 
among the overlay and underlay pixels, subtract it from the lightest pixel, and 
outputs the result. 

 l Divide / Divide Legacy / BETA Divide: For each channel, this divides the 
value of the underlay pixel by the value overlay pixel. Both values are treated 
as ratios, so the resulting colour is brighter. A white overlay pixel will leave 
the underlay colour unaffected, and a black overlay pixel will always result in 
white. 

 l Exclusion / BETA Exclusion: Adds the overlay and underlay pixel, then 
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subtracts the multiplied value of both pixels twice. This results in an effect 
similar to Difference, except that while the Difference mode produces 
consistently high contrast pixels, the contrast of the resulting pixels with the 
Exclusion mode is proportional to how dark or bright the overlay pixels are. 

 l Subtract / Subtract Legacy / BETA Subtract: For each channel, subtracts 
the value of the overlay pxiel from the value of the underlay pxiel. For 
example, if the underlay pixel is white, and the overlay pixel is dark gray, the 
resulting pixel will be light gray. Likewise, if the underlay pixel is yellow, and 
the overlay pixel is red, the resulting pixel will be green, as yellow is a mix of 
green and red. 

 l Alpha: Adds the opacity of the overlay pixel to the opacity of the underlay 
pixel, ignoring the colour of the overlay pixel.

NOTE 

The effect of this blending mode can only be observed if you render 
images with an alpha channel or if you set the Camera view to Matte 

View  mode. To do this, click on the Render View  mode button 

while it is selected to open its menu, then select  Matte View.

 l Colour: Outputs a colour with the hue and saturation of the overlay pixel, and 
the luminosity of the underlay pixel. The overlay layer can hence be used to 
"colourize" the underlay layer.

 l Hue: Outputs a colour with the luminosity and saturation of the underlay 
pixel and the hue of the overlay pixel.

 l Invert: Inverts the underlay pixel proportionally to the alpha value of the 
overlay pixel. The overlay image hence acts as a "matte" for an invert effect. 

 l Luminosity / BETA Luminosity: Outputs a colour with the hue and saturation 
of the underlay pixel and the luminosity of the overlay pixel. This is the 
reverse of the Colour blending mode. 

 l Replace: Ignores the underlay pixel completely, outputting the overlay pixel 
as if nothing existed behind it. This applies to all overlay pixels that have an 
alpha value of at least 1, so the negative space of the overlay image will not 
hide the underlay image. If the overlay pixel is not fully opaque, it will be 
mixed with black. 

 l Saturation: Outputs a colour with the luminosity and hue of the underlying 
colour, and the saturation of the source colour.

SWF Blend Mode

If you intend to export your scene in SWF format, you can use this option to choose 
which blend mode to use for this effect in the exported Flash movie. Since Flash 
does not support all the blending modes supported by Harmony, this is left as a 
separate option. You can ignore this option if you don't intend to export your scene in 
SWF format. 
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 l Normal: Composites the image without any specific blending effect.

 l Multiply: Multiplies the value of each channel in the underlay pixel with the 
value of each channel in the overlay pixel, treating those values as ratios. 
Multiplying anything with black will result in black, and multiplying anything 
with white will leave the colour unchanged.

 l Screen: The reverse of multiply. Multiplies the reverse value of each channel 
in the underlay and overlay pixel, treating those values as ratios. Multiplying 
anything with white will result in white, and multiplying anything with black 
will leave the colour unchanged. 

 l Lighten: For each channel, uses the value that is the brightest between the 
underlay pixel and the overlay pixel.

 l Darken: For each channel, uses the value that is the darkest between the 
underlay pixel and the overlay pixel. 

 l Difference: For each channel, this takes the darkest pixel among the overlay 
and underlay pixels, subtract it from the lightest pixel, and outputs the result. 

 l Add: Adds the colour values of each channel in the overlay pixel and the 
underlay pixel. For example, adding two dark grey pixels with a value of 100 
in each channel will result in a light grey pixel with a value of 200 in each 
channel. Likewise, if one of the pixels is red and the other is green, the 
resulting pixel will be yellow. 

 l Subtract: For each channel, subtracts the value of the overlay pxiel from the 
value of the underlay pxiel. For example, if the underlay pixel is white, and the 
overlay pixel is dark gray, the resulting pixel will be light gray. Likewise, if the 
underlay pixel is yellow, and the overlay pixel is red, the resulting pixel will 
be green, as yellow is a mix of green and red. 

 l Invert: Inverts the underlay pixel proportionally to the alpha value of the 
overlay pixel. The overlay image hence acts as a "matte" for an invert effect. 

 l Overlay:Like hardlight, exept it screens or multiplies the underlay pixel over 
the overlay pixel, based on the value of the underlay pixel.

 l Hardlight: This screens overlay pixels with a value above 50% onto underlay 
pixels, and multiplies overlay pixels with a value below 50% onto underlay 
pixels. The brighter the overlay pixel is, the more intense the screen effect will 
be. The darker the overlay pixel is, the more intense the multiplying effect will 
be. Blending any colour with white or black will result in white or black, and 
blending a colour with plain grey will leave the colour unchanged. 
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Composite Node
The Composite node allows you to use several images and output a single image. You can compare that to 
doing pre-compositions in editing software. You can connect several drawing, image generators and effect 
nodes in your Composite node and one bitmap (or vector in some cases) comes out of it. 

Using Composites is necessary if you wish to apply effects to several layers combined. For example, if you want 
a character rig that is composed of several layers to appear transparent, you must connect all the layers of your 
character's rig to the same composite, and connect a Transparency effect to that composite.
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Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Mode

 l As Bitmap: This is the default mode for composites. A bitmap composite 
outputs a single composited image. 

 l As Seamless Bitmap: mode works very similarly to bitmap mode, except 
it prevents seams from appearing between vector shapes that have 
matching outlines or when vector drawings are 3D-rotated and made to 
mesh together. 
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NOTE 

Shadow, Glow, Blending and Focus effects do not work when 
connected to a Seamless Bitmap composite.

 l As Vector: This mode outputs a flat vector drawing made of all the 
connected drawings. Vector composites should be used only when 
necessary, as they ignore any effect and bitmap information that is sent to 
them.

 l Pass Through: This mode simply passes all the information sent to the 
Composite, including artwork, effects and transformations, onto the next 
composite as is, as a multi-layered image. This means that if an effect is 
applied to the output of that composite, the effect will be applied 
individually to each layer connected to that composite. Hence, a pass 
through composite does not really perform any composition. It is 
essentially an organization tool. 

NOTES 

 l The cable coming from a Pass Through composite will 
be thicker and have a darker centreline. This can be 
useful to identify areas of your node system that carry a 
lot of information.

 l If a Composite set to Pass Through is at the bottom of 
the composite chain, it will act the same as a Bitmap 
composite.

Input Ordering 2D: Elements connected in the node are composited based on their port ordering. 

451

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

The Z-axis (forward-backward) values are ignored. The scaling value will be 
correct, but the actual position on the Z-axis is ignored. 

You can use the 2D composite type to create effects such as a camera recording 
overlay on your scene. Since you always want this element to be in front 
regardless of the other elementsè Z-axis position, you can set the option to 2D.

3D Flat: The Z-axis value of the elements connected in the Composite node are 
considered, so the visual representation is correct in the Camera view. The output 
is a flat image.

3D: The Z-axis value of the elements connected in the composite node are 
considered, so the visual representation is correct in the Camera view. The image 
is not flattened. The 3D aspect of the elements are kept. For example, if you 
rotated elements on the three axes, the information is retained and elements 
composited in lower levels are able to intersect with the elements coming from a 
3D Composite node.
The 3D Composite node should only be used in advanced cases. It is better to 
use a Pass Through composite type than a 3D composite type. This way, all the 
elements are composited in the final Composite node.

Output Options

Output Z: Identifies which element’s front-back value from the current 
composition is applied to the entire composited image in the next operation. If 
you select Portnumber, identify the appropriate port by its position using the Port 
For Output Z menu.

Port for Output Z: When using the Portnumber option in the Output Z menu, 
you can select which port you want to use as the Z value for the Composite node. 
The port used appears in a bright green colour on the Composite node. By 
default, the leftmost port is displayed in front and the rightmost port is displayed 
behind.
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Bitmap Options

These options are active when you select the As Bitmap mode.

Apply Focus: Activates the Focus effect for this node in the composite operation.

Focus Multiplier: The value entered in this field is used as a multiplier for the 
radius value specified in the Focus or Focus-Multiplier nodes. 

Vector Options

These options are active when you select the As Vector mode.

Palette Name: When you render files using As Vector Composite nodes, use 
this field to set the name of the palette files that Toon Boom Harmony Premium 
will create for them.

Flatten: Flattens vector drawings into one vector drawing file. Any transparency 
will be lost in the process. This creates smaller vector files, but might increase 
the time required to composite the drawings. This can be useful when reusing 
drawings. Because they will be vector files, you can still apply vector-based 
transformations and effects.
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Composite-Generic Node
T-COMP2-005-002

The Composite-Generic node is a customizable effect that can be used to fit scenarios where the colours and 
alpha values of elements must be processed and combined in very specific ways. It can be configured to 
reproduce the effects of a Tone or Highlight node, or many of the blending effects available in the Blending 
node, but it offers significantly more control the way the effect is applied. 

Among other things, the Composite Generic can be configured to apply a simple blending effect. However, 
contrary to the Blending node, the Composite Generic node does not composite its input image onto every 
element that is behind it in the scene. Rather, it composites one image, connected to its left input port, onto 
another, connected to its right input port. The resulting composited image is then composited onto the scene 
as normal. 

Another interesting capability of the Composite Generic node is that it can use the colours and the alpha of 
either or both the overlay and the underlay image to make the output image. With the Colour Operation and 
Alpha Operation parameters, the colours and alpha values can be composited in different ways. 

NOTE 

In Harmony, colours with an alpha value are premultiplied with black. This means that their actual 
values in the back-end are different than what they appear to be in the rendered image, as they 
are multiplied by their alpha values. . Hence, mixing a colour operation and alpha operation that 
are not meant to work together may not only have undesired results on the way the overlay image 
is blended into the underlay image, it may even have undesired results on the colour composition 
of elements behind the Composite Generic node.

Connection

The Composite Generic node has two input ports and one output port. It will composite the image connected to 
its left input port (the overlay) onto the image connected to its right input port (the underlay) based on its 
properties, and will output the resulting composited image. 
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Properties

 

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Colour Operation
The algorithm used to composite the colours of the underlay and overlay images 
together. Note that the way the alpha of the under and overlay images are 
composited depends entirely on the Alpha Operation parameter.
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NOTE 

Some of the available blending modes have a BETA or Legacy variant to 
them.                         

 l A BETA blending mode is one that has been recently added in 
Harmony and which was made to more closely resemble results 
obtained in professional photo editing software such as Adobe 
Photoshop.

 l A Legacy blending mode is a blending mode that was present in 
older versions of Harmony. Starting from Harmony 10, these 
blending modes were enhanced by de-multiplying colours 
before compositing the image then re-multiplying them. Their 
legacy version remain available to ensure scenes created in older 
versions of Harmony do not render differently. 

In the following descriptions, the underlay image is the image connected to the 
right input port of the node, and the overlay image is the image connected to the 
left input port of the node.

Right: Only outputs colour values from the underlay image and ignores colour 
values from the overlay image.

Left: Only outputs colour values from the overlay image and ignores colour 
values from the underlay images.

Apply With Alpha: Composites the overlay pixel onto the underlay pixel 
proportionally to its alpha value. This is the standard composition technique 
when layers are connected to a composite.

Apply Tone Highlight: Applies the colour of overlay pixel the same way a  Tone 
or Highlight effect would apply its colour to the underlay pixel.

Apply Add / Apply Add Legacy:Adds the colour values of each channel in the 
overlay pixel and the underlay pixel. For example, adding two dark grey pixels 
with a value of 100 in each channel will result in a light grey pixel with a value of 
200 in each channel. Likewise, if one of the pixels is red and the other is green, 
the resulting pixel will be yellow. 

Apply Matte For Overlay:  Multiplies the colour values of the underlay image 
with the transparency ratio of the overlay image. This uses the overlay image as a 
"matte" to remove colours from the underlay image. You can then combine the 
resulting image with the colour values of the other image element by connecting 
this Composite Generic node to another Composite Generic node with its Colour 
Operation parameter set to Apply Overlay Into Matte. This is useful if the matte of 
the overlay and the colours of the overlay are to be stored in separate images. 

Apply Overlay Into Matte:  Multiplies the colour values of the overlay by the 
alpha values of the underlay image, then adds the resulting colour to the colour 
values of the underlay image. This is useful if you have darkened an area of an 
underlay with a matte using a different Composite Generic with its Colour 
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Operation parameter set to Apply Matte for Overlay. This parameter will take the 
colours from the overlay and apply them on the area darkened by the matte. 

Apply Transparency:  Multiplies the colour values of the underlay image with the 
transparency ratio of the overlay image. This setting is designed to be combined 
with the Apply Transparency Matte alpha operation. However, it is technically the 
same as Apply Matte For Overlay.

Apply Multiplicative Tone: Multiplies the value of each channel in the underlay 
pixel with the value of each channel in the overlay pixel, treating those values as 
ratios. Multiplying anything with black will result in black, and multiplying 
anything with white will leave the colour unchanged.

Multiply Colours: Multiplies the value of each channel in the underlay pixel with 
the value of each channel in the overlay pixel, treating those values as ratios. 
Multiplying anything with black will result in black, and multiplying anything 
with white will leave the colour unchanged.

Divide Colours / Divide Colours Legacy: For each channel, this divides the value 
of the underlay pixel by the value overlay pixel. Both values are treated as ratios, 
so the resulting colour is brighter. A white overlay pixel will leave the underlay 
colour unaffected, and a black overlay pixel will always result in white. 

Lighten / Lighten Legacy / BETA Lighten: For each channel, uses the value that 
is the brightest between the underlay pixel and the overlay pixel.

Softlight / Softlight Legacy / BETA Softlight: Each channel of the overlay pixel 
lightens or darkens the corresponding channel of the underlay pixel on a softer  
scale. The effect is proportional to how dark or bright the overlay pixel is, but 
inversely proportional to how dark or bright the underlay pixel is. 

Hardlight / Hardlight Legacy / BETA Hardlight: This screens overlay pixels with 
a value above 50% onto underlay pixels, and multiplies overlay pixels with a 
value below 50% onto underlay pixels. The brighter the overlay pixel is, the more 
intense the screen effect will be. The darker the overlay pixel is, the more intense 
the multiplying effect will be. Blending any colour with white or black will result 
in white or black, and blending a colour with plain grey will leave the colour 
unchanged. 

Overlay / Overlay Legacy / BETA Overlay: Like hardlight, exept it screens or 
multiplies the underlay pixel over the overlay pixel, based on the value of the 
underlay pixel.

Linear Light: This linear dodges overlay pixels with a value above 50% onto 
underlay pixels, and linear burns overlay pixels with a value below 50% onto 
underlay pixels. The brighter the overlay pixel is, the more intense the linear 
dodging effect will be. The darker the overlay pixel is, the more intense the linear 
burning effect will be. 

Pinlight: For each channel, if the overlay pixel's value is above 50%, use the 
lightest pixel between the underlay and overlay pixels. If the overlay pixel's value 
is below 50%, use the darkest pixel between the underlay and overlay pixels.
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Vividlight: This colour dodges overlay pixels with a value above 50% onto 
underlay pixels, and colour burns overlay pixels with a value below 50% onto 
underlay pixels. The brighter the overlay pixel is, the more intense the colour 
dodging effect will be. The darker the overlay pixel is, the more intense the colour 
burning effect will be. 

Exclusion: Adds the overlay and underlay pixel, then subtracts the multiplied 
value of both pixels twice. This results in an effect similar to Difference, except 
that while the Difference mode produces consistently high contrast pixels, the 
contrast of the resulting pixels with the Exclusion mode is proportional to how 
dark or bright the overlay pixels are. 

Dodge: Lightens each channel in the underlay pixel with the brightness value of 
the corresponding channel in the overlay pixel, by decreasing the contrast of the 
underlay pixel. 

Burn: Darkens each channel in the underlay pixel with the darkness value of the 
corresponding channel in the overlay pixel, by increasing the contrast of the 
underlay pixel. 

Hue: Outputs a colour with the luminosity and saturation of the underlay pixel 
and the hue of the overlay pixel.

Saturation: Outputs a colour with the luminosity and hue of the underlying 
colour, and the saturation of the source colour.

Colour: Outputs a colour with the hue and saturation of the overlay pixel, and the 
luminosity of the underlay pixel. The overlay layer can hence be used to 
"colourize" the underlay layer.

Luminosity: Outputs a colour with the hue and saturation of the underlay pixel 
and the luminosity of the overlay pixel. This is the reverse of the Colour blending 
mode. 

Intensity Red / Green / Blue

The factor by which to multiply each channel in the overlay image. You can set 
this to a value between 0 and 1 to reduce the impact of the corresponding 
channel in the overlay image, or to a value above 1 to increase it.

NOTE 

These parameters are only available when a BETA Colour Operation is 
selected. 

Opacity

A value between 0 and 100 determining the opacity level of the overlay image 
when composited onto the underlay image. 

NOTE 

This parameter is only available for certain Colour Operation settings. 
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Alpha Operation

Right: The transparency of the output image is based on the alpha values of the 
underlay image only. 

Left: The transparency of the output image is based on the alpha values of the 
overlay image only. 

Apply: Combines the alpha values of the overlay and underlay image. When 
combined with the Apply with Alpha colour operation, this results in standard 
alpha-based compositing. 

Add:  The alpha value of each pixel is the sum of the alpha value of the underlay 
pixel and of the alpha value of the overlay pixel.

Subtract:  The alpha value of each pixel is based on the alpha value of the 
underlay pixel subtracted by the alpha value of the overlay pixel. 

Apply Transparent Matte: The alpha value of each pixel is based on the alpha 
value of the underlay pixel, multiplied by the transparency of the overlay pixel, 
effectively multiplying their transparency. 

Black: Outputs every pixel as fully transparent of both the output as fully 
transparent, leaving behind only the effect of premultiplication of their colour 
values onto the rendered image. 

White: Sets the matte of the entire output image to white, so that it is fully 
opaque. The bounding box of the output image will be filled with black and 
semi-transparent pixels will be mixed with black.

Output Z

Leftmost: Indicates that the Z value for the output image will be taken from the 
node in the left port.

Rightmost: Indicates that the Z value for the output image will be taken from the 
node in the right port.

Backmost: Indicates that the Z value for the output image will be taken from the 
image that is the farthest back in the scene.

Frontmost: Indicates that the Z value for the output image will be taken from the 
image that is closest to the front of the scene.

Portnumber: Indicates that the Z value for the output image will be taken from 
the node in the selected port. Enter the appropriate port in the Port for Output Z 
field.
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Cutter Node
T-HFND-010-009

The Cutter effect cuts out a portion of an image. To do this, it needs to be connected to the drawing it is 
intended to cut as well as to a matte  layer. The cutter will take the shape of the drawing in the matte layer and 
cut this shape out of the drawing layer. This is especially useful if you want to make a character disappear 
between a background element, or if you want to cut out a hole in the middle of a character. 

Like all effects that use a matte, the Cutter's effect has an Inverted parameter, which is disabled by default. 
When enabled, the Cutter will have the reverse effect: Instead of cutting the matte's shape out of the drawing, 
it will cut everything outside of the matte's shape out of the drawing, leaving only the parts of the drawing 
that are covered by the matte. 

The Cutter effect can be used with 2D-3D integration. Rendered 2D drawings, integrated with 3D models, 
display soft, anti-aliased edges, even where the Cutter effect is applied.

Refer to the following example to connect this effect:

Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Allows you to enter a name for the node.

Inverted
When this option is enabled, the Cutter node will invert the matte shape to cut 
the drawing. Instead of cutting the image intersecting with the matte, it will cut 
any artwork outside of the matte shape.
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Highlight Node
T-HFND-010-009C

The Highlight node allows you to brighten an image's area to simulate a light source. For this effect, you will 
need to create a matte to determine the shape and position of the highlight on a separate element, so that you 
can blur the edges to create a softer effect. By adjusting the Highlight properties, you can control the type and 
amount of blur, as well as the colour of the Highlight effect.

Connection

The Highlight node takes an image of any type in the right (Image) input port, and a matte drawing in the left 
(Matte) input port. It outputs a version of the input image with a highlight applied over it everywhere where 
the input image and the matte drawing intersect. 
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Layer Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must 
have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change of 
depth or scale. When disabled, the effect's values will remain unchanged regardless of depth 
or scale changes. It is recommended that this option be disabled when multiple drawings are 
composited and attached this effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make up the edge 
of the matte.

 l Directional: The matte is blurred in the direction configured with the Directional Angle 
and Directional Falloff Rate parameters.
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Parameter Description

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur effect. The blur 
radius is affected by the drawing scale and camera position.

Directional 
Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value goes from 0 to 
360, with 0 meaning west, and angles going counterclockwise. For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional 
Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal value between 0 
and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the image.

Multiplicative
Multiplies the colours of the effect with the colours of the source image. This intensifies the 
effect. 

Colour

Red The amount of red to add to the colour of the source image.

Green The amount of green to add to the colour of the source image. 

Blue The amount of blue to add to the colour of the source image. 

Alpha The alpha value of the effect. 

Colour Swatch Opens the Colour Picker dialog, in which you can visually select a colour for the effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This parameter can 
take a decimal value between 0 and 1. At 1, the effect is fully applied. At 0, the effect is not 
visible. 

Matte
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Parameter Description

Invert Matte
Inverts the matte used to generate the effect. By default, the affect is applied to opaque areas of 
the matte and transparent areas of the matte are ignored. When this option is enabled, the effect 
is applied to transparent areas of the matte and opaque areas of the matte are ignored. 

Use Matte 
Colour

Instead of using the colour in the Colour parameters, this uses the colours in the matte drawing 
to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 
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Image Switch Node
T-COMP2-005-004

The Image Switch  effect lets you use multiple effects, such as Colour Override, and choose which port will be 
sent to rendering if you want to apply different variations of an effect that cannot be changed over time. You 
then create multiple separate versions of the effect, connect them all to the Image Switch, and then if you want 
to change to a different version of the effect at different points in your scene, you would add a curve and 
animate the port number. Image Switch simply lets you change over time which port is being rendered.

 

Refer to the following example to connect this effect:

Properties 
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Port Index

Switches from one image to another. There is no gradual animation from one 
colour to another as you are only changing (over time) which port will be 
rendered. Use whole values.

Click the Function  button to open the Function editor to animate a parameter 
over time—see .
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Matte-Composite Node
T-COMP2-005-003

The Matte-Composite node is a type of composite that is specifically designed to combine different matte 
drawings into a single matte, which can then be connected to the matte port of an effect or drawing node. 

Contrary to a regular composite, the Matte-Composite node allows deciding whether each drawing connected 
to it is added, subtracted or intersected with the resulting composited matte, and each drawing connected to it 
can be composited as is, or inverted. 

NOTE 

Since the Matte-Composite node is meant to output mattes, it ignores colours and only composites 
alpha levels. The output image will be in plain white, with varying degrees of transparency.

Connection

Like a regular composite, the Matte-Composite node can be connected to as many input images as needed, 
and combines them together. Its output port should be connected to the matte port of an effect. 

The matte is generated by creating a matte from the first drawing connected to it, then compositing each 
subsequent drawing on top of it. Like with a Composite node, the order in which connected drawings are 
composited goes from right to left.

Each node connected to the Matte-Composite's input ports has its own composite mode as well as its own 
invert setting. In the Node view, you can immediately tell the mode in which the node is applied by looking at 
the symbol just below each input port:

 l A  sign means the drawing is added to the composite matte. 

 l A  sign means the drawing is subtracted from the composite matte.

 l A  sign means the drawing is intersected with the composite matte.
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You can also tell whether the node is composited as is if the sign is black on white , or inverted if the sign is 
white on black . 

TIP 

In the Node view, you can quickly toggle between composite modes by double-clicking on the 
symbol. This will cycle between Add , Add Inverted , Subtract  and Intersect  . If you 
want to set a connection to another combination of composite mode and invert setting, you must 
do it in the layer properties of the Matte-Composite node. 

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Input Parameters
Each input connection has its own set of Input parameters, which determines 
how each node connected to the Matte-Composite node is composited into the 
resulting matte.

Mode

Each node connected to the Matte Composite node can be composited into the 
resulting matte in one of the following ways:

 l Add: The alpha of each pixel is added to the matte, resulting in combined 
shapes. 
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 l Subtract: The alpha of each pixel is subtracted from the matte. This cuts 
the drawing's shape out of the  matte.

 l Intersect: The alpha ratio of each pixel is multiplied by the alpha ratio of 
the corresponding pixel on the matte. The resulting matte is made of the 
areas where the drawings intersect. 

Invert

When enabled, the drawing is composited onto the matte with its alpha values 
reversed, as if its transparent pixels were opaque and its opaque pixels were 
transparent. This means that the shape of the negative space of the drawing will 
be composited to the matte instead of its actual shape. 

470



Tone Node
T-COMP2-004-004

The Tone effect allows you to add a dark-coloured region to your drawing and simulate the shaded area away 
from a light source. To produce the tone effect, create a drawing to control where the tone will appear. The 
Tone effect uses a matte to determine the shape and position of the tone on your drawing and can be blurred 
at the edges to create a softer effect. 

Connection

The Tone node takes an image of any type in the right (Image) input port, and a matte drawing in the left 
(Matte) input port. It outputs a version of the input image with a tone applied over it everywhere where the 
input image and the matte drawing intersect. 
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Layer Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must 
have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change of 
depth or scale. When disabled, the effect's values will remain unchanged regardless of depth 
or scale changes. It is recommended that this option be disabled when multiple drawings are 
composited and attached this effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make up the edge 
of the matte.

 l Directional: The matte is blurred in the direction configured with the Directional Angle 
and Directional Falloff Rate parameters.
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Parameter Description

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur effect. The blur 
radius is affected by the drawing scale and camera position.

Directional 
Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value goes from 0 to 
360, with 0 meaning west, and angles going counterclockwise. For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional 
Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal value between 0 
and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the image.

Multiplicative
Multiplies the colours of the effect with the colours of the source image. This intensifies the 
effect. 

Colour

Red
The amount of red to subtract from the colour of the source image. To obtain a shadow effect, 
the value must be negative.

Green
The amount of green to subtract from the colour of the source image.  To obtain a shadow 
effect, the value must be negative.

Blue
The amount of blue to subtract from the colour of the source image.  To obtain a shadow effect, 
the value must be negative.

Alpha The alpha value of the effect. 

Colour Swatch Opens the Colour Picker dialog, in which you can visually select a colour for the effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This parameter can 
take a decimal value between 0 and 1. At 1, the effect is fully applied. At 0, the effect is not 
visible. 
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Parameter Description

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the affect is applied to opaque areas of 
the matte and transparent areas of the matte are ignored. When this option is enabled, the effect 
is applied to transparent areas of the matte and opaque areas of the matte are ignored. 

Use Matte 
Colour

Instead of using the colour in the Colour parameters, this uses the colours in the matte drawing 
to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 
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Transformation Switch Node
The Transformation-Switch node acts as a on and off switch for the deformation chains. It is used when 
building multi-pose (multiple deformation chains) rigs. the Transformation-Switch can also be used with other 
node types than Deformation nodes. It can be used with any transformation nodes such as Peg and Quadmap 
nodes. 

Refer to the following example to connect this effect:

The Transformation-Switch replaces the Deformation-Switch node. 

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node 
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view. 

Name Use this field to rename the node.

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the paper 
on which the animation was drawn.

Transformation Names
List the drawing names associated to each transformation chain. You can enter 
additional drawings and separate the names with semi-colons (;).
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Constraint Nodes
Constraint nodes are a series of nodes that can be used to subject parts of a cut-out character rig to certain 
physical constraints. Specifically, they are designed to add the following capabilities for rigging and animation:

 l Create points on drawings which, when moved, will translate, rotate and scale the drawing so that the 
parts of the drawings those points are attached remain locked to those points. 

 l Lock the different parts of a rig by their articulations. This makes it so moving a part of a rig that is 
constrained to its adjacent parts will move those other body parts along it, and rotate the part being 
moved as needed. 

 l Automate a "spring" like movement based on a simple translation. Specifically, the Dynamic Spring 
node is able to apply a delayed movement on a part of a character rig based on the movement of its 
parents. This can also be wielded to automate follow-through action for parts like hair, ears, whiskers, 
and such. 

 l Limit, switch between, turn on and off or interpolate different transformations applied by pegs onto 
elements. 

 l Bake transformations into the resting position of elements. 

Constraint nodes use the pivot point of pegs connected to them to define their constraint points. Rigging with 
constraint nodes is more complicated than rigging with a mere hierarchy of pegs and elements, as it requires 
using the different nodes together, like building blocks, to define precisely the relationship between adjacent 
parts of a rig. They however allow the animator to pose and animate a character rig by moving the pivot points 
of its articulations rather than by transforming its individual layers, while the constraint nodes take care of 
making the appropriate transformations to the adjacent body parts. The resulting procedure is potentially 
much more natural and streamlined. 

Harmony features the following Constraint nodes:

 l Two-Point Constraint: Constrains a drawing between the pivot-point of two pegs. This node can be 
configured to stretch and squash the drawing it transforms automatically, as well as to stop stretching 
or squashing the drawing past specified limits. This can be especially useful for rigging limbs together 
and allow the animator to manipulate them by their articulations. 

 l Three-Point Constraint: Constrains a drawing between the pivot-point of three pegs. 

 l Multi-Point Constraint: Constrains a drawing between the pivot-point of multiple pegs. 

 l Dynamic Spring: Applies the movement of the parent peg with inertia and tension factors onto the 
child element. This can be used to automatically generate life-like ease and overshoot, as well as 
follow-through animation.

 l Transform Limit: Filters the transformations from the parent node by multiplying each type of 
transformation (ie: translations, rotation, scale, etc.) by a factor going from 0% to 100%, before applying 
it to the child node. 
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 l Transformation-Gate: This node can be used to dynamically select which one of several 
transformations from several connected parent nodes is applied to its child. It is also able to make an 
interpolation between two transformations from two of its parents, and apply the interpolated 
transformation to its child. It can be used with constraint nodes or any other node that outputs a 
transformation, such as pegs and quadmaps. 

 l Constraint Switch: This node can be connected to the leftmost input port of any other constraint node 
to temper its effect. It does so by applying a ratio ranging from 0% to 100% to the transformations 
applied by the constraint node it is connected to. If connected to a Transformation-Gate, it can remotely 
control which input port the Transformation-Gate uses to apply transformations to its child.

 l Static Constraint: Can be used to permanently store (or "bake") the transformation applied by its parent 
or parents. Once transformations are baked into the node, it can be disconnected from the parent, then 
connected to a child to apply the baked transformation onto it, acting like a transformation template or 
a resting position.

NOTE 

Constraint nodes do not deform drawings like deformation nodes do, they apply standard 
transformations such as translations, rotations and scaling on them. The Multi-Point Constraint 
can optionally apply a perspective (quadmap) transformation on elements. 
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Constraint Switch Node
The Constraint Switch node is used to remotely affect the Value and/or Target Gate parameter of other 
Constraint nodes. 

Each node in the Constraint category has an Active parameter that can be set to a value ranging from 0 to 
100. This value is used to determine how much of the transformation calculated by a constraint node should 
actually be applied to its child element. When set to 100, the transformation is fully applied. Then set to 0, the 
transformation is not applied at all. When set to a value between 0 and 100, the effect the constraint node has 
on its child is proportionally tempered.

The Constraint Switch has its own Active parameter. When connected to a constraint node, the Active value 
of that constraint node is multiplied by the Active value of the Constraint Switch. For example, if a Constraint 
Switch with an Active parameter set to 50 is connected to a Two-Points Constraint node with an Active 
parameter of 50, the effective Active value of the Two-Points Constraint node will be 25, and only 25% of its 
transformation will be applied. Likewise, if the Active value of the Constraint Switch is set to 0, it will 
effectively "switch off" the constraint node, and if it is set to any value below 0, it will reverse the effect of the 
constraint node.

A Constraint Switch can also be used to remotely control the Target Gate parameter of a Transformation Gate. 
A Transformation Gate takes several transformations as inputs and outputs one of the transformations. The 
Target Gate is the numerical index of the port the Transformation Gate takes the transformation from when its 
Value parameter is set to 100. The Target Gate for a Transformation Gate can be set within its own properties, 
but if a Constraint Switch is connected to it, the Constraint Switch's Target Gate parameter will override the 
Transformation Gate's Target Gate parameter.

Connection

The Constraint Switch node can be connected to the leftmost input port of any constraint node, except for the 
Static-Transformation node. The input port for a Constraint Switch will be the same shade of aquamarine as 
the Constraint-Switch node itself. 

A Constraint-Switch node can be connected to several constraint nodes to control them simultaneously. 
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Controls

When the control of a Transformation Switch is displayed, a slider displays in the Camera view which can be 
used to manually set the value of the Active parameter.

Properties

Parameter Description
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Active

Defines the influence applied to the constraint node the Constraint Switch node 
is connected to. This value is multiplied with the value of the Active parameter of 
the constraint node to calculate its effective Active parameter. 

For example, if a Constraint Switch with an Active parameter set to 50 is 
connected to a Two-Points Constraint node with an Active parameter of 50, the 
effective Active value of the Two-Points Constraint node will be 25, and only 
25% of its transformation will be applied. Likewise, if the Active value of the 
Constraint Switch is set to 0, it will effectively "switch off" the constraint node, 
and if it is set to any value below 0, it will reverse the effect of the constraint 
node.

Target Gate
If the Constraint Switch is connected to a Transformation Gate node, this 
parameter overrides the Target Gate parameter. of the Transformation Gate. 

GUI Offset 
When displaying this node's control, a slider displays in the Camera view to 
control the node's Active parameter. The following parameters affect the way the 
slider is displayed.

(x) Axis Offsets the horizontal position of the slider in the Camera view.. 

(y) Axis Offsets the vertical position of the slider in the Camera view. 

GUI Scale
Multiplies the size of the slider in the Camera view. This parameter is set to 1 by 
default.
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Dynamic Spring Node
The Dynamic Spring node takes the animated transformation from the parent node then applies tension and 
inertia to make it into a "spring" motion. 

When filtered with a Dynamic-Spring node, a peg that performs a simple translation from point A to point B 
with no ease-in or ease-out will result in an ease-in from point A, an ease-out to point B followed by a realistic 
overshoot. 

Connection

A Dynamic Spring node must be connected to a peg or other transformation node through its rightmost input 
port. The spring effect will be applied to the transformation sent through this port.

Rigged together with a Two-Points Constraint node and another peg to offset the pivot point of the original, 
you can automate the follow through action. In this example, the Movement-Peg node animates the Hair 
element from its top part. The same animation is also sent through a Dynamic-Spring node, then a peg that 
offsets the pivot point towards the bottom of the hair (via its own Pivot parameters) which results in the top of 
the hair being pulled by a regular motion while the bottom follows through with realistic ease and overshoot. 

The spring effect the Dynamic Spring applies is based on the motion of the entire hierarchy of its parents, not 
just on the motion of its immediate parent. This may cause undesired effects. For example, if a Dynamic-Spring 
is connected to a hand drawing, and the forearm the hand is rigged to rotates, the hand will track behind the 
motion of the arm and appear detached from its wrist. This can be cancelled out by using the middle port of the 
Dynamic-Spring node. This port is used to cancel out the spring effect of another motion before applying the 
spring to its element. Hence, in this example, you would circumvent this issue by connecting the forearm peg to 
the middle port of the dynamic spring.
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NOTE 

The same effect can be achieved using the Ignore Parents and Parent Name properties of the 
Dynamic Spring node.

At last, the leftmost port of the Dynamic-Spring node can be connected to a Constraint Switch, the Active 
parameter of which is multiplied against the Active parameter of the Dynamic Spring node to reduce or disable 
its effect. 

Properties
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Parameter Description

Active

The percentage of influence the Dynamic Spring node has on the transformation.

If a Transformation Switch node is connected to the Dynamic Spring node, the 
Active parameters of the Transformation Switch and the Dynamic Spring nodes 
will be multiplied together. 

Match Animation on Active 
Attribute

When enabled, the Dynamic Spring node will only perform a movement when its 
own attributes have a keyframe or an interpolation. This option can be useful if, 
for example, the animation must be done on twos or threes. You can enable this 
option, then add stop-motion keyframes on the Dynamic Spring node in the 
Timeline view on every frame where you want it to update the child element's 
position. The latter will remain static between keyframes. 

In the example below, the Match Animation on Active Attribute option has been 
enabled, and stop-motion keyframes have been added to the Dynamic Spring 
node to match the timing of the hand's animation. The frames are a light shade of 
blue where the Dynamic Spring node applies a movement to the child element, 
and are grey where it does not. 

NOTE 

The Dynamic Spring node will animate on ones after its last keyframe. 
Hence, to animate on twos, you must add keyframes on the Dynamic 
Spring node until it completely stops moving the element. The animation 
of the Dynamic Spring node often stops several frames later than the 
animation of the parent peg, because it adds an extra overshoot a 
movement. 

Tension 
(X/Y/Z/Scale/Skew/Rotate)

The tension applied to each parameter of the animation. The higher it is, the more 
the child element will appear to "snap" to the position of the original movement.
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TIP 

You can set the Tension for all parameters to the same value by creating a 
function for the Tension X parameter, then linking every other Tension 
parameter to that function. If you create a single keyframe in this function, 
the parameter will remain constant throughout the scene.

Inertia 
(X/Y/Z/Scale/Skew/Rotate)

The inertia applied to each parameter of the animation. The higher it is, the more 
the child element will appear to be weighted against the spring effect. 

TIP 

You can set the Inertia for all parameters to the same value by creating a 
function for the Inertia X parameter, then linking every other Inertia 
parameter to that function. If you create a single keyframe in this function, 
the parameter will remain constant throughout the scene.

Ignore Parents
If this property is set to any value but 0, the Dynamic Spring will go up its own 
hierarchy up to the value of this property, and consider the node at this level to 
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be the "Ignored parent". The transformations applied by this parent and all its 
parents will not be taken in account for the spring effect. 

NOTE 

This has the same effect as connecting one of the node's parents to its 
middle port. 

Parent’s Name

If the Ignore Parents property is set to any value but 0, this property will also be 
used in determining which parent to consider as the "Ignored parent". When 
looking up the parent hierarchy of the Dynamic Spring node, if it finds any node 
with a matching name, it will consider it the "Ignored parent", and the 
transformations applied by this parent and all its parents will not be taken in 
account for the spring effect.

NOTE 

When both the Ignore Parents and the Parent's Name parameters are set, 
the "Ignored parent" will be the first node in the Dynamic Spring node's 
parent hierarchy that either matches the name of the Parent's Name 
parameter or the parent level in the Ignore Parents parameter.

TIP 

This parameter only works if the Ignore Parents parameter is set to any 
value but 0. If you want the ignored parent to only be matched by its 
name and not its level in the hierarchy, you can set the Ignore Parents 
parameter to an improbably high number (ie: 100 or 1000), and set the 
Parent's Name to the name of the parent to ignore. 
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Multi-Points Constraint Node
The Multi-Points Constraint translates, rotates and scales a drawing to make it follow the pivots of the pegs 
that are connected to it. Optionally, it can also apply a perspective transformation on the element. 

Connection

The Multi-Points Constraint node must be connected to at least two Peg nodes, and can be connected to as 
many Peg nodes as needed. The pivot point of each peg will define the resting position of one of the points 
used to transform the drawing connected under it. When one of the pegs is moved, the Multi-Points 
Constraint will transform the drawing so that it follows the pivot point of that peg. 

NOTE 

The resting position of the points is based on the pivot point of the peg. The pivot point of a peg 
can be set by selecting the peg with the Translate , Rotate , Scale  or Skew  tool, then 
clicking and dragging the pivot in the Camera view, or by entering its coordinates in the layer 
properties of the peg. 

Only the position of the pegs is considered by the Multi-Point Constraint. The position of the peg connected to 
the rightmost input port on the Z-axis will be applied to the element.

Optionally, the Three-Points Constraint node can be connected to a Constraint-Switch, which can be used to 
reduce the effect of the Three-Points Constraint node on the element it is connected by setting its Active 
parameter between 0 and 100. 

Controls

When the controls of the Multi-Points Constraint are displayed, the position of the points are displayed with 
blue squares linked by a green line. 
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These points are only a visual representation and cannot be manipulated. 

How to animate an element connected to a Multi-Points Constraint 

 1. In the Tools toolbar, select the Transform tool or press Shift + T.

 2. Do one of the following:

 l Select one of the pegs the Three-Points Constraint is connected to, then move the peg by 
clicking and dragging the centre point in the Camera view.

 l In the layer properties of the element, disable the Animate Using Animation Tools option. 
Then, select the element, and click and drag the element near one of the  points. The point 
that is the closest to the mouse cursor will be automatically selected and moved. 

Optionally, the leftmost input port of a Multi-Points Constraint node can be connected to a Constraint-Switch, 
which can be used to reduce the effect of the Multi-Points Constraint node on the element it is connected by 
setting its Active parameter between 0 and 100. 

Parameter Description

Active

The percentage of influence the constraint has on its child element. If set to 100, 
the element will follow the points closely. If set to 0, the element will not be 
affected by the constraint. 

If a Transformation Switch node is connected to the Multi-Points Constraint 
node, the Active parameters of the Transformation Switch and the Multi-Points 
Constraint nodes will be multiplied together. 

Flatten Type

This parameter defines what happens if one of the pegs defining the constraint 
points is moved on the Z-axis:

 l Ignore 3D Transform:  The element will be constrained to the vertical 
and horizontal position of the pegs, and will ignore their position on the Z 
axis. 

 l Allow 3D Transform: The element will be 3D-rotated to follow the 
position of the pegs in the 3D space. 
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 l Project to Plane: The element will be constrained in 2D, but will be 
made to follow the perceived position of the points from the camera's 
point of view. This means the 3D position of the points will be projected 
on a 2D plane that is parallel to the camera. 

NOTE 

This projection is based on the position of the primary point peg 
on the Z-axis. Hence, if the three pegs are on a different position 
on the Z-axis, there may be a perceived offset between the 
position of the non-primary points and their effect on the element. 

Ignore Internal Points

If enabled, internal points will be ignored by the Multi-Point Constraint.

The envelope used to transform the element is always a convex shape. If any 
point connected to the Multi-Points Constraint is not an extreme point in its 
resting position, it is considered an internal point. 

Allow Perspective Transform

If this option is enabled, the Multi-Point Constraint node will apply a perspective 
deformation to the drawing instead of scaling, rotating and skewing the drawing 
to try to make it track the points. 
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Static Transformation Node
The Static Transformation node can be used to store, or "bake" the transformation from its immediate parent or 
from its entire hierarchy of parents, then be connected to a node to apply this transformation to it. The 
transformation the node stores cannot be animated nor reset. It can hence be used to act as a sort of "resting" 
position for an element, without having to apply the required transformations to the element or to its parent 
peg. 

Connection

To store transformations into a Static Transformation node, you must first connect a node containing these 
transformations to its input port. 

Once the transformations from the parent node have been baked into the Static Transformation node via its 
layer properties, you must disconnect the Static Transformation node from its parent, then connect it to a child 
so that this transformation is applied to it.

The Static-Transformation node will also dynamically apply its parent's transformations onto the child on top 
of its own static transformations, so it can be used as an intermediary in a rig. 

Properties

The layer properties of the Static Transformation allow you to bake the transformations of its parent or parent 
hierarchy into its own attributes. Optionally, you can also fine-tune the stored transformation. 
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Parameter Description

Bake Immediate Parent's 
Transformations

Copies the transformations applied by its parents at the current frame into its 
own attributes, making the node into a static template of the immediate parent 
peg's transformations. 

Bake All Incoming 
Transformations

Bakes the transformations of the node's entire hierarchy of parents added up into 
its own attributes, making the node into a static template of all the 
transformations applied by its parents combined into a single set of coordinates.

Active If unchecked, the node will not apply transformations to its child. 

Static Transformations

The static transformations baked into the node:

 l (x) Axis: The horizontal translation baked into the node.

 l (y) Axis: The vertical translation baked into the node.

 l (z) Axis: The translation on the Z-axis baked into the node.

 l Locked: Use a single value for the scale factor baked into the node, 
preserving the child's proportions.

 l Separate: Use a separate value for the horizontal, vertical and depth 
scale factors. 
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 l (x) Axis: The horizontal scale factor baked into the node.

 l (y) Axis: The vertical scale factor baked into the node.

 l (z) Axis: The depth scale factor baked into the node.

 l Scale in Field: When checked, the scale factor will be expressed in a 
proportion based on the amount of fields for the scene's camera. 

 l (x) Axis: The rotation around the X-axis baked into the node.

 l (y) Axis: The rotation around the Y-axis baked into the node.

 l (z) Axis: The rotation around the Z-axis baked into the node.

 l Skew X: The skew angle on the X-axis baked into the node.

 l Skew Y: The skew angle on the Y-axis baked into the node.

 l Skew Z: The skew angle on the Z-axis baked into the node.

Invert Transformations If checked, all transformations baked into the node will be applied negatively. 
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Three-Points Constraint Node
The Three-Points Constraint translates, rotates and scales a drawing to make it follow the pivots of the three 
pegs connected to it.

Connection

The Three-Points Constraint node must be connected to three Peg nodes. The pivot point of each peg will 
define the resting position of one of the points used to transform the drawing connected under it. When one of 
the pegs is moved, the Three-Points Constraint will transform the drawing so that it follows the pivot point of 
that peg. 

NOTE 

The resting position of the points is based on the pivot point of the peg. The pivot point of a peg 
can be set by selecting the peg with the Translate , Rotate , Scale  or Skew  tool, then 
clicking and dragging the pivot in the Camera view, or by entering its coordinates in the layer 
properties of the peg. 

Optionally, the leftmost input port of a Three-Points Constraint node can be connected to a Constraint-
Switch, which can be used to reduce the effect of the Three-Points Constraint node on the element it is 
connected by setting its Active parameter between 0 and 100. 

Controls

When the controls of the Three-Points Constraint are displayed, the position of the three points are displayed 
with blue squares linked by a green line. 

These points are only a visual representation and cannot be manipulated. 
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How to animate an element connected to a Three-Points Constraint 

 1. In the Tools toolbar, select the Transform tool or press Shift + T.

 2. Do one of the following:

 l Select one of the pegs the Three-Points Constraint is connected to, then move the peg by 
clicking and dragging the centre point in the Camera view.

 l In the layer properties of the element, disable the Animate Using Animation Tools option. 
Then, select the element, and click and drag the element near one of the  points. The point 
that is the closest to the mouse cursor will be automatically selected and moved. 

Properties

Parameter Description

Active

The percentage of influence the constraint has on its child element. If set to 100, 
the element will follow the three points closely. If set to 0, the element will not 
be affected by the constraint. 

If a Transformation Switch node is connected to the Three-Points Constraint 
node, the Active parameters of the Transformation Switch and the Three-Points 
Constraint nodes will be multiplied together. 

Flatten Type

This parameter defines what happens if one of the pegs defining the constraint 
points is moved on the Z-axis:

 l Ignore 3D Transform:  The element will be constrained to the vertical 
and horizontal position of the pegs, and will ignore their position on the Z 
axis. 

 l Allow 3D Transform: The element will be 3D-rotated to follow the 
position of the pegs in the 3D space. 

 l Project to Plane: The element will be constrained in 2D, but will be 
made to follow the perceived position of the points from the camera's 
point of view. This means the 3D position of the points will be projected 
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on a 2D plane that is parallel to the camera. 

NOTE 

This projection is based on the position of the primary point peg 
on the Z-axis. Hence, if the three pegs are on a different position 
on the Z-axis, there may be a perceived offset between the 
position of the non-primary points and their effect on the element. 

Transform Type

By default, only the position of the points is used to transform the element. Since 
those points are defined by pegs, these pegs can also be subjected to scale, 
angle and skew transformations that would be normally ignored by the Three-
Points Constraint node. This parameter can be used to apply the other 
transformations done on the peg of the primary point on the element, rather than 
ignoring them. 

 l Translate: Ignores the transformations done on the primary peg, only 
applies the transformations required for the element to track the three 
points.

 l Transform: Applies the transformations calculated by the Three-Points 
Constraint node to make the element to track the three points, then 
applies the scale, angle and skew values of the primary peg on top of 
them.

 l Local Transform: Applies the scale, angle and skew values of the 
primary peg on the element, then applies the transformations calculated 
by the Three-Points Constraint node for the element to track the three 
points. 

Primary Port

Defines which one of the ports, and hence, which one of the pegs the node is 
connected to, is used to define the primary point. 

The primary point affects the other parameters in the following ways:

 l When the Flatten Type is set to Ignore 3D Transform or Project to 
Plane, the position of the element on the Z-axis will be the one of the 
primary point. 

 l When the Flatten Type is set to Project to Plane, the position of the 
primary point on the Z-axis is used as the plane on which to project the 
3D positions of the points. 

 l If the Transform Type is set to Transform or Local Transform, the scale, 
angle and skew transformations of the primary peg will be applied to the 
element. 
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Transformation Gate Node
The Transformation Gate can be connected to several pegs, or any node that outputs a geometric 
transformation, and dynamically select which one of these nodes controls its child element. For example, it is 
possible to connect two pegs to the Transformation Gate, and have the first peg transform the child element of 
the Transformation Gate for the first half of the scene, then the second peg transform the child element for the 
second half of the scene.

The Transformation Gate is also able to make an interpolation between two of the input transformations, and 
apply this combined transformation to its child. 

Connection

The Transformation-Gate can be connected to as many nodes that output as transformation, such as Pegs, 
Quadmaps or other Constraint nodes, as needed. 

In the Node view, the colour of the input ports indicate which ports are active. The lightest input port is the 
target gate, which is the gate from which the transformation applied to the child element is sourced. The 
darkest input port is the default gate. The other ports are ignored.

If the Active parameter of the node is set to any value between 0 and 100, the shade difference between the 
target gate and default gate will fade. This indicates that the transformations going through the target gate 
and default gate are combined to create the transformation applied to the child element. 

Optionally, a Transformation-Gate node can also be connected to a Constraint-Switch node, which can be 
used to multiply the Active parameter of the Transformation-Gate and override its Target Gate parameter. 
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Properties

Parameter Description

Active

The percentage of the transformation sent to the target gate that is applied to the 
child element. If set to 100, only the transformation sent through the target gate 
will be applied. If set to 0, only the transformation sent through the default gate 
will be applied. If set to any value between 0 and 100, an interpolation of the 
transformations sent through the target gate and the default gate will be 
generated and applied to the child element. 

Local Target Gate

The index of the input port referred to as the target gate. 

The input ports are numbered starting from 0. In the node view, they are ordered 
from right to left. Set this parameter to 0 to make the rightmost input port the 
target gate, to 1 to make the second rightmost port the target gate, etc. 

NOTE 

If the Transformation Gate is connected to a Constraint Switch, the Target 
Gate parameter of the Constraint Switch will override this value. 

Default Gate

The index of the input port referred to as the default gate.

The input ports are numbered starting from 0. In the node view, they are ordered 
from right to left. Set this parameter to 0 to make the rightmost input port the 
target gate, to 1 to make the second rightmost port the target gate, etc. 
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Transformation Limit Node
The Transformation Limit node can be used as an intermediary between two nodes to limit the effect of the 
parent peg's transformations onto the child, by applying a ration to the transformations applied to the parent 
before applying them to the child. This ratio can be set for each coordinate in the node's properties and can be 
animated.

NOTE 

This node is designed to limit 2D and 3D translations, but not 3D rotations or scaling.

Connection

The Transformation Limit node must be connected to its parent peg by its right input port, and must be 
connected to the peg or element it will apply the transformation to via its output port. Transformations applied 
by the parent peg will be recalculated by the Transformation Limit node, then applied on its child.

The transformations that are processed by the Transform Limit node are not the ones of its immediate parent, 
but rather, the ones of the entire hierarchy of parents it is connected to combined. If you need the 
Transformation-Limit node to only process the transformations of one or some of its parents and ignore the 
parents past a certain point in the hierarchy, simply connect the first parent the Transformation-Limit node 
should ignore to its middle input port.

The effect of the Transformation Limit node on the transformation can be tempered by lowering its Active 
parameter. The Transformation Limit node can also be connected to a Constraint Switch node, the Active 
parameter of which will be multiplied with the Active parameter of the Transformation limit node, and hence 
can also be used to temper its effect on its child. 
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Controls

Because the Transformation Limit node can significantly influence the position of its child element relative to 
its peg pivot, the Transformation Limit has its own pivot point. The position of this pivot can be set in its layer 
properties, but can also be set visually by displaying its control in the Camera view and dragging it to the 
desired position using the Transform tool.
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Properties

Parameter Description

Active

The percentage of influence the Transformation Limit node has on the 
transformation before it applies it to the child. For example, if its Translate X 
parameter is set to 50, and its Active parameter is set to 50, the effective Translate 
X limit will be 75. 

Switch Effects

Defines which coordinate limits the Active parameter affects. If set to Active 
value, it will affect the limits for all coordinates. If set to XYZ Translation, Scale, 
Rotation, Scale/Skew or Skew, it will affect the limit on the corresponding 
coordinates. If the Transformation-Limit node is connected to a Constraint 
Switch, this parameter will also dictate the effect of the switch. 

Translate X The percentage of the parent's horizontal translation to apply to the child. 

Translate Y The percentage of the parent's vertical translation to apply to the child.

Translate Z The percentage of the parent's translation on the Z axis to apply to the child. 
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Rotate The percentage of the parent's rotation to apply to the child.

Skew The percentage of the parent's skew to apply to the child. 

Scale X The percentage of the parent's horizontal scale to apply to the child.

Scale Y The percentage of the parent's vertical scale to apply to the child.

Allow Flipping
If disabled, the child element will not be flipped when one of the parent's scale 
transformations is negative. 

Uniform Scale
Averages the horizontal and vertical scale factors to preserve the proportions of 
the child. 

Ignore Parents

If this property is set to any value but 0, the Transformation Limit node will go up 
its own hierarchy up to the value of this property, and consider the node at this 
level to be the "Ignored parent". The transformations applied by this parent and 
all its parents will not be affected by the Transform Limit. 

NOTE 

This has the same effect as connecting one of the node's parents to its 
middle port. 

Parent’s Name

If the Ignore Parents property is set to any value but 0, this property will also be 
used in determining which parent to consider as the "Ignored parent". When 
looking up the parent hierarchy of the Transformation Limit node, if it finds any 
node with a matching name, it will consider it the "Ignored parent", and the 
transformations applied by this parent and all its parents will not be taken in 
account for the spring effect.

NOTE 

When both the Ignore Parents and the Parent's Name parameters are set, 
the "Ignored parent" will be the first node in the node's parent hierarchy 
that either matches the name of the Parent's Name parameter or the 
parent level in the Ignore Parents parameter.
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TIP 

This parameter only works if the Ignore Parents parameter is set to any 
value but 0. If you want the ignored parent to only be matched by its 
name and not its level in the hierarchy, you can set the Ignore Parents 
parameter to an improbably high number (ie: 100 or 1000), and set the 
Parent's Name to the name of the parent to ignore. 

Flatten Type

Affects how the translations are applied in the 3D space.

 l Allow 3D Translate: The parent's translation on the Z-axis will be 
affected by the Translate Z parameter, then applied to the Z axis position 
of the child, as with other parameters. This is the default behavior.

 l Project 3D Translate to Plane: The parent's translation on the Z-axis 
will be projected on the X and Y translations based on the position of the 
camera. This gives the illusion that the apparent position  of the element 
from the point of view of the camera changes realistically depending on 
its position on the Z-axis, but without actually moving it on the Z-axis 
and hence without changing its order relative to other elements. 

 l Project and Scale 3D Translate to Plane: The parent's translation on 
the Z-axis will be projected on the X and Y translations and on the X and 
Y scales, based on the position of the camera. This gives the illusion that 
the apparent position and size of the element from the point of view of the 
camera changes realistically depending on its position on the Z-axis, but 
without actually moving it on the Z-axis and hence without changing its 
order relative to other elements. 

Skew Type

Affects how Skew of the parent is applied to the child.

 l Skew Applied as Rotation: Adds the value of the skew calculated by the 
Transformation Limit node to the rotation applied to the child. 

 l Skew Ignored by Rotation: Processes the skew and rotation coordinates 
separately. Because the effect of these parameters is intertwined, this may 
wield unexpected results, but which may be preferable when 
transformations are fine tuned and manually calculated. 

 l Skew Optimized for Rotation: Processes the skew and rotation 
coordinates together before applying them to the child element. The 
result will look more like what the human eye would guess the element 
would look like with a limit applied to its rotation and skew. 

Control Position

The following parameters affect the pivot point used to apply the transformations 
calculated by the Transformation Limit node.

2D Path: The horizontal and vertical position of the pivot point are stored in a 
single function of control points. This makes the trajectory curvilinear and the 
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pace of the movement set to a velocity function. 

Separate: The horizontal and vertical position of the pivot point are stored in 
separate functions of coordinates. This makes a trajectory where each point is 
joined by a straight line and each coordinate can have its own curve. 

Path: If the 2D Path option is selected, this allows you to create or link to a 2D 
Path function.

(x) Axis: The position of the pivot point on the horizontal axis.

(y) Axis: The position of the pivot point on the vertical axis. 
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Two-Points Constraint Node
The Two-Points Constraint translates, rotates and scales a drawing to make it follow the pivots of the two 
pegs connected to it. Hence, it allows an animator to position an element (for example, a limb) by moving the 
two points at its extremities (the articulations).

Contrary to Three-Points Constraint and Multi-Points Constraint nodes, Two-Points Constraint can 
automatically stretch and squash the element they are connected to depending on the distance between the 
two points. This effect can be fine-tuned in the layer properties of the Two-Point Constraint node.

Connection

The Two-Points Constraint node must be connected to two Peg nodes. The pivot point of each peg will define 
the resting position of one of the points used to transform the drawing connected under it. When one of the 
pegs is moved, the Two-Points Constraint will transform the drawing so that it follows the pivot point of that 
peg. 

NOTE 

The resting position of the points is based on the pivot point of the peg. The pivot point of a peg 
can be set by selecting the peg with the Translate , Rotate , Scale  or Skew  tool, then 
clicking and dragging the pivot in the Camera view, or by entering its coordinates in the layer 
properties of the peg. 

It is possible to rig multiple Two-Points Constraint nodes together in order to connect adjacent parts of a 
character rig by their articulation. For example, the upper and lower part of an arm or a leg could be rigged 
together in the following fashion, to allow the animator to manipulate them by their articulations:
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Optionally, the leftmost input port of a Two-Points Constraint node can be connected to a Constraint-Switch, 
which can be used to reduce the effect of the Two-Points Constraint node on the element it is connected by 
setting its Active parameter between 0 and 100. 

TIP 

It is recommended to disable the Animate Using Animation Tools property of the element the 
Two-Points Constraint node is connected to. This will allow the animator to animate the Two-
Points Constraint by selecting the element, then clicking and dragging near one of the two points 
using the Transform tool. The Two-Points Constraint will automatically select the closest point to 
the mouse cursor and move it. 
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Controls

When the controls of the Two-Points Constraint are displayed, the position of the two points are displayed 
with blue squares linked by a green line. 

These points are only a visual representation and cannot be manipulated. 

How to animate an element connected to a Two-Points Constraint 

 1. In the Tools toolbar, select the Transform tool or press Shift + T.

 2. Do one of the following:

 l Select one of the pegs the Two-Points Constraint is connected to, then move the peg by 
clicking and dragging the centre point in the Camera view.

 l In the layer properties of the element, disable the Animate Using Animation Tools option. 
Then, select the element, and click and drag the element near one of the two points. The 
point that is the closest to the mouse cursor will be automatically selected and moved. 

Properties

Parameter Description

Active

The percentage of influence the constraint has on its child element. If set to 100, 
the element will follow the two points closely. If set to 0, the element will not be 
affected by the constraint. 

If a Transformation Switch node is connected to the Two-Points Constraint node, 
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the Active parameters of the Transformation Switch and the Two-Points 
Constraint nodes will be multiplied together. 

Volume Modifier

Defines how much the Two-Points Constraint node should preserve the width of 
the child element when the distance between the points causes it to stretch or 
squash. 

If set to 100, the width of the element will increase when squashed and 
decreased when stretched based on the Volume Max and Volume Min 
parameters. If set to 0, the element will always have the same width regardless of 
how much it is stretched or squashed. The value can be set to a number between 
0 and 100 to reduce the effect of the volume modifications, to a number above 
100 to increase it, or to a negative number to reverse the volume modification 
logic. 

Volume Max

The maximum width of the element when squashed. 

This value represents a percentage of the element's original width. If set to 0, no 
minimum width will be applied.

Volume Min

The minimum width of the element when stretched.

The value represents a percentage of the element's original width. If set to 0, no 
maximum width will be applied.

Distance Min

The minimum distance between the two points. If the points are brought closer 
together than their minimum distance, the element will stop transforming. 

This value represents a percentage of the distance between the two points when 
in their respective resting positions.

Distance Max

The maximum distance between the two points. If the points are brought farther 
from each other than their maximum distance, the element will stop transforming. 

This value represents a percentage of the distance between the two points when 
in their respective resting positions.

Skew Modifier

When set to 0, the element is rotated to follow the two points. If set to 100, the 
element will skew to follow the two points. If set between 0 and 100, the 
element will be transform with a combination of rotation and skewing to follow 
the two points.

Smoothing

When the two points are moved away from each other and reach their maximum 
distance, this value will adds an extra buffer of distance that the two points can 
reach before the element stops stretching. In this buffer, the way the element 
stretches is tapered, making it stop stretching smoothly instead of abruptly. 
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This value represents a percentage of the distance between the two points when 
in their respective resting positions.

Point Balance

This parameter comes in effect when the two points are being moved at a 
distance exceeding their maximum distance. If set to 0, the element will stop 
stretching and remain locked against the primary point. If set to 100, the element 
will stop stretching and remain locked against the second point. If set to a value 
between 0 and 100, the element will be moved between both points, at a 
distance from the primary point that is proportional to this setting.

Flatten Type

This parameter defines what happens if one of the pegs defining the constraint 
points is moved on the Z-axis:

 l Ignore 3D Transform:  The element will be constrained to the vertical 
and horizontal position of the pegs, and will ignore their position on the Z 
axis. 

 l Allow 3D Transform: The element will be 3D-rotated to follow the 
position of the pegs in the 3D space. 

 l Project to Plane: The element will be constrained in 2D, but will be 
made to follow the perceived position of the points from the camera's 
point of view. This means the 3D position of the points will be projected 
on a 2D plane that is parallel to the camera. 

NOTE 

This projection is based on the position of the primary point peg 
on the Z-axis. Hence, if the two pegs are on a different position on 
the Z-axis, there may be a perceived offset between the 
secondary point and its effect on the element. 

Transform Type

By default, only the position of the points is used to transform the element. Since 
those points are defined by pegs, these pegs can also be subjected to scale, 
angle and skew transformations that would be normally ignored by the Two-
Points Constraint node. This parameter can be used to apply the other 
transformations done on the peg of the primary point on the element, rather than 
ignoring them. 

 l Translate: Ignores the transformations done on the primary peg, only 
applies the transformations required for the element to track the two 
points.

 l Transform: Applies the transformations calculated by the Two-Points 
Constraint node to make the element to track the two points, then applies 
the scale, angle and skew values of the primary peg on top of them.

 l Local Transform: Applies the scale, angle and skew values of the 
primary peg on the element, then applies the transformations calculated 
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by the Two-Points Constraint node for the element to track the two 
points. 

Primary Port

Defines which one of the ports, and hence, which one of the pegs the node is 
connected to, is used to define the primary point, leaving the other port for the 
secondary point. 

The primary point affects the other parameters in several ways:

 l The Point Balance parameter ranges from 0 to 100, with 0 making the 
element balance towards the primary point and 100 making it balance 
towards the secondary point. 

 l When the Flatten Type is set to Ignore 3D Transform or Project to 
Plane, the position of the element on the Z-axis will be the one of the 
primary point. 

 l When the Flatten Type is set to Project to Plane, the position of the 
primary point on the Z-axis is used as the plane on which to project the 
3D positions of the points. 

 l If the Transform Type is set to Transform or Local Transform, the scale, 
angle and skew transformations of the primary peg will be applied to the 
element. 
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Deformation Nodes
The Deformation nodes category includes all the nodes which are used to make deformers. In Harmony, 
deformers are made of chains of deformation nodes connected in a hierarchy. By default, deformation chains 
made with the Rigging tool are created in groups by default to avoid cluttering the Node and Timeline views. 
Each deformation node  represents a point in a deformation chain.

This category also includes nodes that are made to deform drawings without being part of a deformation chain, 
such as the Mesh Warp node. 

Articulation Node 511

Auto Fold Node 514

Auto Muscle Node 516

Bone Nodes 520

Curve Node 524

Deformation Composite Node 528

Deformation Root Node 531

Deformation Scale Node 532

Deformation Switch Node 537

Deformation Uniform Scale Node 539

Deformation Wave Node 541

Fold Node 544

Game Bone Node 548

Glue Node 550

Kinematic Output Node 552

Mesh Warp Node 553

Offset Node 557

Point Kinematic Output Node 559

Connections 560

Refract 566

Stick Node 568

Turbulence Node 570

Weighted Deform Node 574
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Articulation Node
The Articulation node is no longer used in the current release of Harmony. This node is still available for 
compatibility purposes with previous deformation rigs.

The Articulation node is used between two bones (legacy) to create a joint where the limb or element will 
rotate. The current Bone and Game Bone nodes include the articulation parameters. 

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node 
has no visible effect on the rendered image, nor on the preview in the 
Camera, Perspective, Side and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in 
the Node view. 

Name Use this field to rename the node.

Resting Parameters

Rest Radius Lets you set the resting radius of the articulation (size of the circle).
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Resting Orientation Lets you set the resting rotation angle value of the articulation.

Rest Bias

Lets you set the resting bias value of the articulation, which can also 
be seen as the steepness of the articulation. The smaller the bias 
value, the smoother the articulation angle, and the larger the bias 
value, the more angular the articulation is.

Deformation Parameters

Radius
Lets you set the radius of the articulation (size of the circle). When 
animated, this value will be connected to a function.

Orientation
Lets you set the rotation angle value of the articulation. When 
animated, this value will be connected to a function.

Bias
Lets you set the bias value, which can also be seen as the steepness 
of the articulation. When animated, this value will be connected to a 
function.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls the 
Left and Right transversal radius values. When disabled, it controls the size of 
the left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 2.
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Longitudinal Influence 
Radius Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, 
it controls the size of the Begin Longitudinal radius. By default, this value is set 
to 0.25.

Longitudinal Influence 
Radius End

When the Symmetric Ellipse of Influence option is enabled, this field controls 
both the Begin and End Longitudinal radius values. When this option is disabled, 
it controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.

Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Auto Fold Node
The AutoFold node lets you automatically fix the folding area of a deformer, so no line overlap occurs. If your 
drawing pieces are separated on different layers, you will not need the AutoFold node. The AutoFold node is 
similar to the Fold node, but since it's automated, it is optimized to fit the most standard folding point with 
fewer controls to set up. You can also avoid this issue by separating your drawing onto two layers or separating 
your drawing in two pieces using the Cutter tool and repasting it in place in the same drawing.

Connect the AutoFold node directly under the Deformation node which is causing the unwanted line effect, for 
example the forearm.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
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and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Name this field to rename the node.

Enable AutoFold

Type 1 to enable it or 0 to disable the effect.

If you connect this option to a function, then you can enable or disable the effect 
at a specific point in your animation.

Length

Sets the length of the fold axis line.
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Auto Muscle Node
The Auto-Muscle node is used to simulate muscle movement. This will allow your characters to flex their 
muscles when they lift something or to create muscle tone when they move. When the Auto-Muscle node is 
connected to a Bone Deformer that is rotated, the drawing is automatically inflated to simulate muscle 
movement in the limb. 

NOTE 

Connect the Auto-Muscle node above the drawing you want to add a muscle to and after the Bone 
chain.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on 
the rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name Use this field to rename the node.

Muscle Left
This option is enabled by default. When enabled, the left side of the Bone Deformer will 
inflate as the articulation is rotated toward the direction of the Bone Deformer. Disable 
this option if you do not want the left side of the bone to inflate.
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Left Start

The default value of the starting position of the left muscle is set to -2. This means it will 
start at the deformer situated two steps before the position where the Auto-Muscle is 
connected. You can change the starting point by typing the number corresponding to the 
deformer node.

Left Span
This parameter controls the length (muscle length) over which the effect node will be 
applied to the left side of the deformer. By default the setting is 1, representing the length 
of the deformer to which it is applied.

Left Amplitude

This parameter controls the physical size of the left muscle. Increase the value to make the 
muscle bigger, decrease the value to make it smaller.
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Muscle Right

This option is enabled by default. When enabled, the right side of the Bone Deformer will 
inflate as the articulation is rotated toward the direction of the Bone Deformer. Disable 
this option if you don't want the right side of the bone to inflate.

Same as Left

This option is enabled by default, allowing each side of the Bone Deformer to inflate to 
follow the rotation of the articulation. Enable this option to synchronize the right muscle 
with the left so both muscles inflate when the articulation is rotated to the left.

Right Start

The default value of the starting position of the right muscle is set to -2. This means it will 
start at the deformer situated two steps before where the Auto-Muscle is connected, in 
this case, Bone. You can change the starting point by typing the number corresponding to 
the deformer node.
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Right Span
This parameter controls the length (muscle length) over which the effect node will be 
applied to the right side of the deformer. By default the setting is 1, representing the 
length of the deformer to which it is applied.

Right Amplitude
This parameter controls the physical size of the right muscle. Increase the value to make 
the muscle bigger, decrease the value to make it smaller.
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Bone Nodes
The Bone node is one of the main nodes used to build a deformation rig. Each Bone node consists of a bone and 
an articulation. You can chain Bone nodes to create a skeleton chain for your character. The Rigging tool can be 
used to create and connect those nodes automatically. 

Properties

Parameter Descriptions

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Resting Parameters Rest Offset

(x) Axis This is the bone x-axis (horizontal) coordinates for the resting position.
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(y) Axis This is the bone y-axis (vertical) coordinates for the resting position.

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Bias
This is the articulation's bias (roundness and smoothness) for the resting 
position.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y-axis parameters are controlled by the 
same 2D path function.

Separate
When this option is enabled, the X and Y-axis parameters are individual one from 
another.

Path When using a 2D Path, this field displays the name of the function.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

(y) Axis
This is the bone y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation position. 
This parameter can be linked to a function to be animated over time.

Orientation
This is the bone's orientation angle for the animation position. This parameter can 
be linked to a function to be animated over time.

Bias
This is the articulation's bias (roundness and smoothness) for the animation 
position. This parameter can be linked to a function to be animated over time.

Length
This is the bone's length for the animation position. This parameter can be linked 
to a function to be animated over time.
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Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls the 
Left and Right transversal radius values. When disabled, it controls the size of the 
left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 2.

Longitudinal Influence 
Radius Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Begin Longitudinal radius. By default, this value is set to 
0.25.

Longitudinal Influence 
Radius End

When the Symmetric Ellipse of Influence option is enabled, this field controls both 
the Begin and End Longitudinal radius values. When this option is disabled, it 
controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.
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Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Curve Node
The Curve node is one of the main nodes for building a deformation rig. You can chaining Curve nodes to create 
a Bezier handles skeleton. The Rigging tool can be used to create and connect the nodes automatically. 

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Resting Parameters Resting Offset

(x) Axis This is the curve x-axis (horizontal) coordinates for the resting position.
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(y) Axis This is the curve y-axis (vertical) coordinates for the resting position.

Resting Orientation 0 This is the orientation for the first Bezier handle for the resting position.

Rest Length 0 This is the length for the first Bezier handle for the resting position.

Resting Orientation 1 This is the orientation for the second Bezier handle for the resting position.

Rest Length 1 This is the length for the second Bezier handle for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y-axis parameters are controlled by the 
same 2D path function.

Separate
When this option is enabled, the X and Y-axis parameters are individual one from 
another.

(x) Axis This is the curve X-axis (horizontal) coordinates for the animation position.

(y) Axis This is the curve Y-axis (vertical) coordinates for the animation position.

Orientation 0 This is the orientation for the first Bezier handle for the animation position.

Length 0 This is the length for the first Bezier handle for the animation position.

Orientation 1 This is the orientation for the second Bezier handle for the animation position.

Length 1 This is the length for the second Bezier handle for the animation position.

Envelope Parameters

Apply Parent Modifier's 
Transformation

When this option is disabled, the deformation from the parent curves are no 
longer affecting the current curve. Interesting effects can be achieved when 
disabling this effect on the last child curve and rotating the Offset point. The 
curve tail end will remain pinned on the spot while the rest of the curves 
deforms.

Close Contour When this option is enabled, the extrimity of the curve is snapped to the initial 
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chain's Offset point. This creates an Envelope deformation. More than one curve 
can be linked to the Offset point.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls the 
Left and Right transversal radius values. When disabled, it controls the size of the 
left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 2.

Longitudinal Influence 
Radius Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Begin Longitudinal radius. By default, this value is set to 
0.25.

Longitudinal Influence 
Radius End

When the Symmetric Ellipse of Influence option is enabled, this field controls both 
the Begin and End Longitudinal radius values. When this option is disabled, it 
controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.
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Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Deformation Composite Node
The Deformation-Composite node is automatically added to a rig when creating a split deformation chain. It is 
used to link the different nodes of a split deformation chain together before deforming the drawing it is linked 
to. You can customize its parameters to influence the result of the combination.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has 
no visible effect on the rendered image, nor on the preview in the 
Camera, Perspective, Side and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the 
Node view. 

Name Use this field to rename the node.

Output Kinematic Only

This option is disabled by default, allowing the deformation chain to 
output deformation and position information. This option should be 
enabled in order to output the chain information position only. This will 
allow you to connect a part to the hierarchy without it undergoing the 
deformation applied to the rest of the chain.

Output Selected Port Only 

This option is important if you have several deformation chains for one 
element, as in the case of a character with multiple poses. 

• When this option is enabled, it will only use the selected chain, 
which you will be able to define in the Output Kinematic Chain 
options of the Deformation-Composite. In some situations, this 
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option is enabled and setup automatically (For example, when 
you are working with the Create Posed Deformer in Create 
Deformation Above/Under enabled).

• When this option is disabled, all the different chains for this 
element will be used at once. 

Output Kinematic Chain

Lets you select a deformation chain option to use. This parameter is 
used when the Output Selected Port Only option is enabled. 

Rightmost: Only the first chain connected to the right of the composite 
node will be used.

Leftmost: Only the first chain connected to the left of the composite 
node will be used.

Select: If you select this option, you can define which chain to output 
according to the order they are connected from left to right. 

Use First Connected Element’s Exposure as Key: Allows the 
deformation effect to automatically detect which deformation chain to 
use (subgroup) by detecting the exposure of the first element 
connected to the deformation. This option is used in the case of a 
multiple pose rig.

Use Parent Composite’s Connected Element Exposure: When the 
Output Kinematic Only option enabled, the information from the parent 
element’s exposure is used to attach the child to the correct chain, 
following which pose is exposed—see 

Output Kinematic Chain Selection
When the Output Selected Port Only option is selected AND the Select 
option is used as the Output Kinematic Chain setting, this field defines 
which deformation chain you want to use on your element. Select the 
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number which corresponds to the left to right order that the chains are 
connected to the Deformation-Composite node.

You can attach this value to a function and enable different chains over 
a period of time on specific frames. This value can be modified in the 
Timeline view by using the Deformation-Switch layer. Since the 
Deformation-Composite node is only visible in the Node view, the layer 
has a reference to this parameter enabling you to easily edit the value 
when working in the Timeline view.
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Deformation Root Node
The Deformation-Root is used when creating manual legacy multi-pose rigs. It can be placed at the start of the 
deformation chains. This node is no longer used for the current multi-pose rig structure.

You can modify the quality level of the Deformation effect in the Deformation-Root Layer Properties window:

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Use this field to rename the node.

Quality

Defines the number of slices the graphic is split into and used when undergoing 
a deformation. The higher the quality level, the more slices are created and the 
smoother the deformation applied to the graphic. There are five levels of quality:

• Low

• Medium

• High

• Very High (default value)

• Extreme
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Deformation Scale Node
The deformers can only be scaled along the centre axis to adjust the length of the limb. The Deformation-
Scale can be used in combination with a Bone or Curve deformer to scale a drawing so it follows the opposite 
direction of the deformer axis (the width). For example, when combined with function curves this can be used 
to create advanced muscle effects. All these settings can be animated over time.

How to set up the Deformation-Scale effect node

 1. In the Node view, navigate to the node to which you want to add a Deformation-Scale effect.

 2. In the Node Library view, select a Deformation-Scale node and drag it to the Node view.

 3. Connect the Deformation-Scale node directly under the lower deformer node of your chain.

 4. In the Node view, select the Deformation-Scale node and select View > Show > Control to display 
its controls in the Camera view.

TIP 

You can animate the different parameters of the Deformation-Scale node. To do this, 
make sure the Animate mode is set to  Animate Current Frame in the Tools toolbar 
before you manipulate it.
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NOTE 

If the controls are too far away from the deformer, you can change the default display of 
the Deformation-Scale and Deformation-Uniform-Scale controls in the Preferences 
dialog box to bring them closer.

 5. Click on the square yellow button of the Deformation-Scale node to open the Layer Properties 
window. 

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 
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Name Use this field to rename the node.

This series of options controls the left scaling deformation. 

Scale Left

This option is enabled by default. It allows the left side of the deformer to be 
scaled. In the Camera view, the dark blue controls are used for the left side. If you 
disable this option, the controls will be hidden and no scaling deformation will 
occur for this side.

Left Fade In
The value is set to 0 (no fade) by default. Increase the value to add a fade effect to 
smooth the transition between the starting point of the scale and the area before it.

Left Fade Out
The value is set to 0 (no fade) by default. Increase the value to add a fade effect to 
smooth the transition between the Left Span point of the scale and the area after it.

Left Start

Defines the starting point of the left scale deformation. The default value is 0 and 
represents the Deformation-Root. Each main control point count for +1.

Move the first blue arrow along the deformer’s central axis to set the starting point 
of the Deformation-Scale and the last arrow to set the length (span) of the 
transformation.

Left Span Defines the length of the left scale effect.

Left Start Scale

Defines the start of the left scale effect.

Drag the square scaling curve control points away and forward from the deformer 
axis to set the scaling value at the starting and ending point.
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Left End Scale Defines the end of the left scale effect.

Left Start Handle Position

Defines the starting position of the left handle.

Drag the two middle blue arrows along the deformer’s centre axis to set the 
position of the curve handles.

Left End Handle Position Defines the ending position of the left handle.
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Left Start Handle Scale

Defines the starting position of the left scale handle.

To modify the scaling value of the curve, drag the two control handles away and 
forward from the deformation axis. 

Left End Handle Scale Defines the ending position of the left scale handle.

Scale Right

This option is enabled by default. It allows the right side of the deformer to be 
scaled. In the Camera view, the light blue controls are used for the right side. If you 
disable this option, the controls will be hidden and no scaling deformation will 
occur for this side.

Same as Left

This option is disabled by default. It means that the left and right sides will use 
different scaling parameters. If you enable this option, the right side controls will be 
hidden in the Camera view and the left parameters will be used for both side for a 
symmetrical scaling effect.

The right side parameters are a mirror of the left side parameters
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Deformation Switch Node
The Deformation-Switch (Legacy) node acts as a on and off switch for the deformation chain. It is used when 
building legacy multi-pose rigs. It is also the node which controls the Region of Influence Fade area. The 
Deformation-Switch also displays a Kinematic Chain Selection Reference option, which allows you to modify 
the chain selection directly in the Timeline view.

The Deformation-Switch has been replaced with the Transformation-Switch node.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Use this field to rename the node.

Vector Quality

Defines the quality of the deformation effect when your drawings are stretched 
and deformed. There are five levels of quality:

• Low

• Medium

• High

• Very High (default value)

• Extreme

Influence Fade Exponent
A value of 1 is similar to a linear curve. A higher value will result in an ease-in 
type of curve. A lower value will result in an ease-out type of curve.
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Fade Inside Region
This option is disabled by default. The fade effect will occur outside the zone of 
influence. Enable this option to have the fade effect inside the Zone of Influence.

Enable Deformation
Acts as an on/off switch for the deformation. The value of this field is set to 1 by 
default, which means the deformation is enabled. Enter a value of 0 to disable it.

Kinematic Chain Selection 
Reference

Determines which chain is selected and used at a specific frame. It is a reference 
to the option in the Deformation-Composite node. Having this reference in the 
Deformation-Switch node allows you to use and modify the chain selection 
value directly in the Timeline view since the Deformation-Composite node is only 
visible in the Node view.
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Deformation Uniform Scale Node
The Deformation-Uniform-Scale effect node let you create the squash and stretch effect on your animated 
deformation rig. You can scale the rigged element on the opposite axis of the deformer (width). 

How to use the Deformation-Uniform-Scale node

 1. In the Node view, navigate to the deformation node to which you want to add a Deformation-
Uniform-Scale node.

 2. In the Node Library view, select the Deformation-Uniform-Scale node and drag it to the Node view.

 3. Connect the Deformation-Uniform-Scale node directly below the lowest deformation node in your 
chain.

 4. Connect the Deform-Uniform-Scale node to all the drawing nodes it should scale.

 5. In the Node view, select the Deformation-Uniform-Scale node.

 6. Display the Uniform Scale controls in the Camera view by pressing Shift + F11.

 7. In the Camera view, drag the handle to resize the width of the limb. You can also use the Scale field 
to enter a specific value. These parameters can be animated over time.
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NOTE 

If the controls are too far away from the deformer, you can change the default display of the 
Deformation-Scale and Deformation-Uniform-Scale controls in the Preferences dialog box to 
bring them closer.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no 
visible effect on the rendered image, nor on the preview in the Camera, 
Perspective, Side and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the 
Node view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Scale Use this field to type in the value to resize the width of the limb.
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Deformation Wave Node
The Deformation-Wave effect deforms the chain by adjusting the scaling in a waveform style. It can be used to 
animate a wave deformation effect on your deformation chain over a period of time. 

How to use the Deformation-Wave effect

 1. In the Node view, navigate inside the Deformation node to which you want to add a Deformation-
Wave effect.

 2. In the Node Library view, select an Deformation-Wave node and drag it to the Node view.

 3. Connect the Deformation-Wave node to your deformation chain.

A wave deformation is applied to the limb or art connected to the deformation chain.

 4. In the Node view, open the Layer Properties window of the Deformation-Wave node.

Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name Use this field to rename the node.

Wave Left
This option is enabled by default, allowing the Deformation-Wave effect to be 
applied on the left side of the deformer chain. Disable this option to prevent the 
effect from being applied.

Left Start Defines the length of the left wave effect.

Left Span
Defines the starting point of the left wave deformation. The default value is 0 and 
represents the root point. Each main control point count for +1.

Left Offset Deformer
This is the parameter you may want to connect to a function. It controls the offset 
of the deformation on the left side and allows you to create a fluid wave 
animation along the deformer axis.

Left Amplitude Controls the height of the left wave effect.

Left Offset Scaling
Used to apply an offset value to the amplitude of the left wave. The wave will be 
lifted and become higher, or dropped and become lower, depending whether the 
value is increased or decreased.

Left Period
Controls the interval of occurrence of the left waves. By default the value is 1, 
meaning that a wave will occur for every deformer. If you decrease the value to 
0.5, it will result in a wave occurring every half deformer.

Wave Right
By default this option is enabled, allowing the Deformation-Wave effect to be 
applied on the right side of the deformer chain. Disable this option to prevent the 
effect from being applied.

Same as Left
This option is disabled by default. It allows the left and right size of the 
Deformation-Wave to be controlled separately. Select this option if you want the 
effect to be symmetrical and controlled by the left side parameters.
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Right Start
Defines the starting point of the right wave deformation. The default value is 0 
and represents the Deformation-Root. Each main control point count for +1.

Right Span Defines the length of the right wave effect.

Right Offset Deformer
This is the parameter you might want to connect to a function. It controls the 
offset of the deformation on the right side, allowing you to create a fluid wave 
animation along the deformer axis.

Right Amplitude Controls the height of the right wave effect.

Right Offset Scaling
Used to apply an offset value to the amplitude of the right wave. The wave will 
be lifted and become higher, or dropped and become lower, depending whether 
the value is increased or decreased.

Right Period
Controls the interval of occurrence of the right side waves. By default the value is 
1, meaning that a wave will occur for every deformer. If you decrease the value at 
0.5 it will result in a wave occurring every half deformer.
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Fold Node
The Fold effect is used when bending a deformation further than the drawing is able to take it. This may result 
in an unwanted overlap of the line art at the junction of the articulation or deformation. The Fold effect lets you 
control certain parameters that will help eliminate the unwanted line effect. You can also avoid this issue by 
separating your drawing onto two layers or separating your drawing in two pieces using the Cutter tool and 
repasting it in place in the same drawing.

The Fold effect works best with the Curve deformers.

How to set up the Fold node

 1. In  the Node view, navigate to the Deformation node causing the unwanted overlap (in this case, an 
articulation).

 2. In the Node Library view, select the Fold node and drag it to the Node view.

 3. Connect the Deformation-Fold node directly under the deformation effect node which is causing 
the unwanted line effect.

 4. In the Node view, select the Deformation-Fold node.

 5. From the top menu, select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + 
F11 (macOS) to display its controls in the Camera view.

 6. In the Tools toolbar, select the Transform  tool.
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 7. In the Camera view, set up the Deformation-Fold. You can also set these parameters directly in the 
Deformation-Fold properties:

‣ Click on the fold axis and rotate it to match the angle of the bend articulation.

‣ Use the middle arrow to position the axis along the deformer’s central line. It should be in the 
corner of the bending area.

‣ Use the right and left arrows to control the appearance of the two overlapping lines.
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‣ Use the axis’s square handle to lengthen or shorten the axis.

 8. If your character moves a lot and you need to adjust the fold at different positions to follow the limb 
animation, you can set up the Deformation-Fold node in a different position over time. To be able to 
do this, make sure that the Animate mode is set to  Animate Current Frame in the Tools toolbar. 

 9. You can also enable/disable the Deformation-Fold node over time by connecting a function to the 
Enable Fold parameter in the Layer Properties. A value of 1 enables the effect, a value of 0 disables 
the effect.
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Game Bone Node
The Bone node is one of the main node used to build a deformation rig. Each Bone node consists of a bone and 
an articulation. Chaining Bone nodes will create a skeleton chain for your character. The Rigging tool can be 
used to create and connect those nodes automatically.

Parameter Descriptions

Resting Parameters Rest Offset

(x) Axis This is the bone X-axis (horizontal) coordinates for the resting position.

(y) Axis This is the bone Y-axis (vertical) coordinates for the resting position.

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y axis parameters are controlled by the 
same 2D path function.
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Separate
When this option is enabled, the X and Y axis parameters are individual from each 
other.

Path When using a 2D Path, this field displays the name of the function curve.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

(y) Axis
This is the bone Y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation position. 
This parameter can be linked to a function curve to be animated over time.

Orientation
This is the bone's orientation angle for the animation position. This parameter can 
be linked to a function curve to be animated over time.

Length
This is the bone's length for the animation position. This parameter can be linked 
to a function curve to be animated over time.
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Glue Node

The Glue effect lets you repair the cracks that appear between joints during animation.

The Glue node has three ports:

• Left Port (Matte): Receives the matte.

• Middle Port (Port A): Receives the element that will not be used to fill the joint.

• Right Port (Port B): Receives the element that will be used to fill the joint.

For most effects with the Glue node, the default options are sufficient. However, you can modify these options 
using the Glue editor.

Glue Properties

Parameter Description

Invert Matte Activate this option to invert the matte used to fill the joint. If you want to use the 
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Parameter Description

"B" element as the matte, you must select this element.

Bias
Indicates the tendency to favour the static or moving element. Set to 0, it favours 
element A; set to 1 it favours element B; set to 0.5 it is in between A and B.

Tension
Indicates how tight the joint will be. Set to 1, the tension has no effect; set less 
than 1, the tension decreases; set greater than 1, the tension increases. 

Type
From this menu, select the type of joint to create. You can choose from among 
Curve (default), Line and Corner.

Use Z for Composition Order
You can use this option to choose the drawing with the higher front-back value 
to create the joint.

A Over B
Indicates which image is rendered on top in the final image. By default, A is 
rendered on top of B, which indicates that the image in the middle port (A) is 
rendered on top of the image in the right port (B).

Spread A

By default, the image in port B is spread to fill the joint. You can use this option 
to choose the image in the A port to create the joint. If you select this option, the 
drawing node must receive position information from the "B" element. Thus, you 
must connect the Drawing node of the "B" element to the Drawing node of the 
matte.
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Kinematic Output Node
The Kinematic Output node lets you hook a separate element that you want to be linked to the deformation 
chain but not be part of the deformation, such as a hand to an arm or an arm to the body. These elements will 
follow the movement of the chain just like a regular cut-out character hierarchy piece without being influenced 
by the deformation of the arm. If you don't use the Kinematic Output, the piece's pivot will not follow the 
deformation.

Connect a Kinematic Output node below the deformation node you want your drawing to follow.

NOTE 

The Kinematic Output node can only rig a drawing to a deformation point. To rig a drawing to a 
specific position in a deformation chain, see Point Kinematic Output Node on page 559.
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Mesh Warp Node

Use the Mesh Warp effect to distort your drawings. With this node you can create effects such as a character in 
a warped mirror and looking through a glass jar. You can also animate the position of the grid to perform the 
distortion over time.

The Mesh Warp node is a position node, same as a Peg node.

How to use the Mesh Warp Effect

 1. In the Node Library, under the Filter tab, select the Mesh Warp node and drag it to the Node view.

 2. In the Node view, connect the Mesh-Warp node to your drawing or group nodes to deform.
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 3. In the Node view, select the Mesh Warp node.

 4. Select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + F11 (macOS) to display 
the deformation grid.

 5. Move the intersection points and move the Bezier handles to deform the grid.
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 6. Grab the grid in the void spaces to pan it around. Using keyframes, you can animate its position over 
time.

Mesh Warp Properties

Use the Mesh Warp editor to adjust the grid size, deformation quality and the region of interest.

Parameter Description

Rows
Increase or decrease the Rows value to change the amount of rows to use in the 
deformation grid.

Columns
Increase or decrease the Columns value to change the amount of columns to use 
in the deformation grid.

Region of Interest
Select the 2D Path option if you want both your X and Y curves to be controlled 
by the same velocity function. Select the Separate option if you want your X and 
Y curves to be independent and have independent velocity.

(x) Axis
This is the X position of the gird. This value can be animated overtime to move 
the grid horizontally.

(y) Axis
This is the Y position of the gird. This value can be animated overtime to move the 
grid vertically.

Width
This is the width value of the gird. This value can be animated overtime to squash 
or stretch the grid horizontally.
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Height
This is the height value of the gird. This value can be animated overtime to 
squash or stretch the grid vertically.

Deformation Quality
This is the quality of the warm deformation. It ranges from Low to Extreme. The 
higher the quality, the better the formation will look, but the longer it will take to 
render.
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Offset Node
The Offset node lets you position the root of your deformation chain. It is automatically added to your 
deformation rig when you create a Curve or Envelope deformation rig using the Rigging  tool. 

Parameter Description

Name Use this field to rename the node.

(x) Axis Sets the resting position on the X (east/west) axis.

(y) Axis Sets the resting position on the Y (north/south) axis. 

Resting Orientation Sets the rotation angle of the resting position. 

Offset Type

Lets you choose the type of coordinates to use: 

Separate: The two coordinates are set separately. If they are connected to a 
function, each one will have its own function curve. This is the default setting. 

2DPath: The two coordinates are set together within a single 2D path function.

(x) Axis

(y) Axis

This option is only available when the Type is set to Separate. It is used to set the 
active position value of the Deformation-Root on the X (east/west) and Y 
(north/south) axis. 

You can enter the value, use the up and down arrow buttons to choose a value, 
or use the Transform tool, when Setup mode is NOT enabled, to move the 
deformation chain. Remember, that if you want to add a keyframe, you need to 
enable Animation mode from the Tools toolbar.
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Path

This option is only available when the Type is set to 2D Path. It is used to set the 
active position value of both the Y and X axis. Use the Transform tool when 
Setup mode is NOT enabled to move the deformation chain along the 2D path. 
Remember, if you want to add a keyframe, you need to enable the Animation 
mode on the Tools toolbar.

Orientation

Sets the rotation angle of the active position of the Deformation-Root. You can 
enter the angle, use the up and down arrow buttons to choose the desired value, 
or use the Transform tool when Setup mode is NOT enabled to rotate the 
deformation chain. Remember, if you want to add a keyframe, you need to enable 
Animation mode on the Tools toolbar.

Apply Parent Modifier's 
Transformation

When this option is disabled, the parent's deformations no longer affect the 
current deformer.
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Point Kinematic Output Node
The Point Kinematic Output node is a more advanced version of the Kinematic Output node. It tracks a point 
that can be placed anywhere on a deformation curve, and moves the drawing that is attached to it so that it 
remains stuck on that deformation curve, without deforming the drawing itself. 

Additionally, it can:

 l Make the angle of the drawing match the angle of the curve at the point where it’s rigged.

 l Scale the drawing to make it match the size of the area of the curve the drawing is rigged to.

 l Rig the drawing to three points in the deformed drawing, which can be useful for rigging a drawing 
somewhere inside the deformed drawing without necessarily making it stick to the curve. 

NOTE 

A similar, simpler node, the Kinematic Output node, can be used to rig the position and angle of a 
drawing to a deformation point without any configuration. For more information, see Kinematic 
Output Node
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Connections

The Point Kinematic Output has a deformation input port (rightmost) and an offset transformation port 
(leftmost). It takes the deformation sent to its rightmost port and outputs a transformation, without any 
deformation, through its only output port. If no deformation is attached to the node, the node will have no 
effect in the rig.

When no node is connected to the offset transformation port, the positions that the node tracks within the 
deformation will be based on the tracking positions in the node’s properties. This is the most simple usage 
scenario.

When a transformation module, such as a peg, is attached to the leftmost port, the tracking points will be 
offset based on the attached transformation to the port.

The leftmost port can then be used to offset the tracking points in a rig based on the transformation of other 
attached nodes in that rig.
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Layer Properties

Parameter Description

Main 
Position 
Tracker

The position of the central point used in all sampling types. 

In One-Point Sampling, this point is used to track the translation in the deformation.   In the other 
sampling-types, it is used to help define the transformation with the other relative points. 

TIP 

You can display this point in the Camera view and manipulate it with the Transform tool by 
displaying the node’s controls. To do this, select the node in the Node View and do one of the 
following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

If you set the Sampling Type to use two or three points, you can also see and manipulate 
the other points in the Camera view. 

Tracker 2 The second sampling point is used in Two-Point Sampling, Two-Point Sampling with Scaling and 
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Parameter Description

Three-Point Sampling. 

This point is used to help define the orientation in Two-Point Sampling, It helps to define the 
orientation and scale in Two-Point with Scale sampling, and helps to define the orientation, scale 
and skew in Three-Point Sampling. 

Tracker 3
The third sampling point is used in Three-Point Sampling. It helps to define the orientation, scale 
and skew of the resulting transformation.

Sampling 
Type

The Sampling Type defines the number of points that track the deformation and which are then 
used to transform the attached drawing, as well as how those points are used to transform the 
drawing.

 l One-Point Sampling: A single point, the Main Position Tracker, follows the deformation 
curve. It  is used  to translate drawing so that it remains on the deformation curve, but the 
drawing is not rotated or scaled. 

 l Two-Point Sampling: Uses two points, the Main Position Tracker and Tracker 2, to track 
the deformation curve. The two points follow the position and angle of the curve. As a 
result, the attached drawing is translated to follow the deformation curve and rotated to 
match its angle.

 l Two-Point Sampling with Scale: Uses two points, the Main Position Tracker and Tracker 
2, to track the deformation curve. The two points follow the position and angle of the curve, 
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Parameter Description

but also, their distance relative to each other changes with the length of the curve. 

As a result, the attached drawing is translated to follow the deformation curve and rotated 
to match its angle, but also, the drawing’s scale on the axis between the Main Position 
Tracker and Tracker 2 points will match the distance between those two points. This 
distance changes as the curve becomes longer or shorter.

Additionally, scaling is applied to the drawing on the perpendicular axis so as to preserve 
the drawing’s volume. If the drawing becomes smaller on the axis between the Main 
Position Tracker and the Tracker 2 points, it will become larger on the perpendicular axis, 
and if it becomes larger on the axis between the Main Position Tracker and the Tracker 2 
points, it will become smaller on the perpendicular axis.

TIP 

How much scaling is applied to the perpendicular axis is relative to the Volume 
Modifier parameter. Setting it to a value between 0 and 1 can prevent the 
perpendicular scaling from deforming the drawing too much, but it won’t preserve the 
entire volume of the drawing. Setting its value to 0 will make it so no scaling is 
applied to the perpendicular axis. 

 l Three-Point Sampling: Uses all three tracking points, the Main Position Tracker, Tracker 
2 and Tracker 3. It will translate, rotate, scale and skew the attached drawing as necessary 
to make it track all three points. The initial position of all three points will define the 
regions of the drawing that will be constrained to the deformation.
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Parameter Description

"This mode can be useful when rigging a drawing inside the surface of a deformed drawing. 
Instead of simply tracking along the deformation curve, it will transform a drawing to best 
match the tracking points within the deformed surface, such as the inside of an Envelope 
deformation or a Free Form Deformation.

Volume 
Modifier

The Volume Modifier is applied only when using the 2-Point with Scale sampling type. 

With this sampling type, the drawing is scaled on the axis between the Main Position Tracker 
point and the Tracker 2 point based on the distance between those two points. The distance 
between those points varies relative to the length of the deformation curve as it is modified. In 
other words, the drawing is stretched when the curve is made longer, and it is squashed when the 
curve is made shorter.

To preserve the drawing’s volume, a scale is also applied on the perpendicular axis. This scale is 
automatically calculated so that the drawing always keeps the same volume. So as to give you 
control on this, the scaling applied on the perpendicular axis is proportional to the Volume 
Modifier parameter. 

A Volume Modifier set to 1.0 will result in a squash-and-stretch that preserves the volume of the 
transformation. As the axis defined by the two tracking points is squashed, the perpendicular axis 
is stretched to preserve the volume. If the axis is stretched, then the perpendicular axis is squashed 
instead.

A Volume Modifier set to 0.0 will result in a transformation that does not attempt to preserve the 
volume of the transformation. As the axis defined by the two tracking points is squashed, no scale 
is applied to the perpendicular axis.
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Parameter Description

You can set the Volume Modifier parameter to any value between 0 and 1 so as to mitigate the 
effect of the perpendicular scaling and prevent it from deforming the drawing too much, but any 
value lower than 1 means the volume of the drawing will not be fully preserved.
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Refract 

Use the Refract effect to create effects such as ripples and heat haze. This effect is based on the refraction of 
light, which occurs when a beam of light passes through media of different density, causing the light to refract 
or change angles. This effect makes objects appear distorted or offset from their actual positions. If you imagine 
an object in a pool of water the part beneath the surface of the water appears offset from its true position.

This creates the effect of a volume passing over an image, refracting the light that bounces off the contents 
below. 

The refraction effect uses the matte's alpha values to taper the refractions. Hence, you can create a nice 
refraction effect with a drawing containing solid strokes if you run it through a Blur-Radial effect to blur its 
alpha values.

You can make the ripple effect move across the image by hooking the matte drawing to a peg and animating 
the peg.
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Refract Properties

Parameter Description

Name Allows you to change the name given to the node.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

Intensity
The amount of refraction to apply to the image. 

You can attach the value to a function curve to change its  value over time.

Height

The amount of depth to add to the refraction effect. When coupled with the 
Intensity effect, this value can create the effect of bending the objects below the 
refraction matte.

You can attach the value to a function curve to change its  value over time.
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Stick Node
The Stick node is available for compatibility with previous versions of deformation rigs. This node is the legacy 
Bone node. When the Stick node is imported in the Node view, it is renamed Bone.

Parameter Descriptions

Rest Length This is the bone's length for the resting position.

Length
This is the bone's length for the animation position. This parameter can be linked 
to a function to be animated over time.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls the 
Left and Right transversal radius values. When disabled, it controls the size of the 
left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 2.
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Longitudinal Influence 
Radius Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Begin Longitudinal radius. By default, this value is set to 
0.25.

Longitudinal Influence 
Radius End

When the Symmetric Ellipse of Influence option is enabled, this field controls both 
the Begin and End Longitudinal radius values. When this option is disabled, it 
controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.

Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Turbulence Node
The Turbulence effect is a mathematically generated effect that uses fractal noise to create turbulent 
distortions in an image. You can see the effect when used with an image as the background. You can create 
flowing water, funhouse mirrors, and waving flags.

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects
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Turbulence Properties 

Parameter Description

Noise Type

The algorithm used to generate the noise:

 l Perlin: Creates pseudo random patterns. The greyscale contains a 
continuity between different tones of grey.

 l Simplex: Creates a more contrasted noise pattern with more variation 
than Perlin. There is a smooth variation of intensity.

 l Sinusoidal: Creates a repeated wavelike pattern.

 l Sub Scaling: Applies Perlin noise twice. The second noise is added 
where dark areas appear in the original. The frequency of the second 
iteration is higher so the noise is smaller.
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 l Rocky: Uses the Perlin pattern but converts the very high and low values 
to more moderate values. For example, the whites become light greys and 
the blacks become dark greys.

 l Small Bumps: Uses the Perlin pattern. The transitional grey areas 
between blacks and whites become inverted so they look like dark lines. 
The extremes, black and white areas, become whitish.

Fractal Type

Transforms the noise pattern generated by the Noise type and controls the way 
layers are composited. These are variations of the basic noise.

 l Turbulent Twist: Applies a turbulent effect on the pattern so it changes 
the transition between black and white by adding more modulation.

 l Fractional Brownian: Applies a basic application of noise and 
composites by adding subsequent layer with the Complexity parameter.

 l Threshold: Changes the dark greys into black values so there is more 
black in the noise for higher contrast.

 l Invert Threshold: Inverts all the values of the Threshold type so a 
negative image of it is created.

 l Terrain: Adds contrast and converts the dark greys into white or light 
greys.

Pinning Constrains the effect within the image boundaries.

Amount Specifies the amplitude of displacement.

Frequency
The density of displacement appearing in the noise. A higher value produces a 
greater amount of displacement in a given area; a lower value produces a smaller 
amount.

Offset Moves the entire image.

Seed
This value determines the starting noise pattern on the first evolution of the 
effect.

Locked Applies parameter value while retaining the X and Y ratio.

Separate Allows you to apply different parameter values to X and Y.

xy
When locked, applies parameter values to both X and Y. When separated, allows 
you to apply different value to X and Y.

572



Evolution Determines the displacement pattern over time.

Evolution Frequency  
This factor makes the complexity iterations animate or transform at a higher 
speed. In other words, the second, third, etc. passes, controlled by the 
Complexity parameter, will mutate faster than the main one.

Complexity

The number of noise layers that make up the noise. Each successive layer has a 
higher frequency, resulting in a smaller noise effect. You can have up to seven 
passes. Increasing this number increases the depth and amount of detail in the 
noise. Use Complexity with Sub Scaling when the value is 1 or greater. 

NOTE 

Increasing the Complexity results in longer rendering times. 

Gain

Controls the amount of opacity present in the iteration of noise. This also affects 
the layer when using Sub Scaling. With a value of 0, you will not see the sub 
noise. A value of 1 will show the sub noise just as strong as the main one. For 
example, with water ripples, a higher amount of Gain will reveal more ripple or 
subripples.

Sub Scaling:

The factor by which the main noise is modified at each iteration of complexity. A 
value of 1 make the two noises identical. A value of 2 makes the sub noise twice 
as small. The next iteration would be 4 times smaller. Values must be greater 
than 1.
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Weighted Deform Node

The Weighted Deform node is a deformation node that creates a blended deformation from the regions 
defined by multiple sources. The deformation blends the points in a drawing or image  based on the distance to 
a deformation source and is used to provide a clean deformed surface.

Connection

The Weighted Deform node acts as a composite for several kinds of transformations, and outputs the 
composited transformations onto a Drawing node.

The rightmost input port of the Weighted Deform node is for the base transformation for the drawing. This 
port should be connected to what would have otherwise been the parent peg of the child Drawing node. For 
example, if the node connected under the Weighted Deform node is Arm_R, then the peg Arm_R-P should be 
connected to this port. It will pass this transformation onto the Drawing node, but it will also composite the 
other transformations onto it. 
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If you connect any other transformation or deformation (green) cable to the Weighted Deform node, an extra 
input port (light green) will appear. Those transformations are composited together to make a weighted 
deformation that is applied to the child element. The following transformations are supported:

 l Deformation nodes: Bone, Curve and Envelope deformations are converted by the Weighted Deform 
node to deform the entire texture of the drawing, instead of only deforming its outlines. This is 
especially useful to create Envelope deformations around textured or detail-heavy drawings. 

 l Peg nodes: Pegs are used as deformation points to create a “cloth” like deformation. They work very 
similarly to the Free Form Transformation node. The position of the peg’s pivot point acts as the resting 
position of the point, and the actual position of the peg is the point’s offset.

Like all transformation and deformation nodes, the output port of the Weighted Deform node outputs a 
transformation and should be connected to the input port of an Drawing node. 

Layer Properties

Parameter Description

Name  

Pre-Blend 
Amount

The blend amounts are used to define the rigidity of the deformation map. The values are added at 
different points in the computation and result in a different result when used.

The Pre-Blend Amount is added when calculating the distance from the deformation regions. It 
blends the regions by making the regions less influential when close to the contours. 
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Parameter Description

Post-Blend 
Amount

The Post-Blend Amount is added after calculating the deformation mapping of the weighting of 
the Weighted Deform’s regional influences. It is used to round out the influence of the 
deformation region by applying the value as an exponent to the calculated deformation weights.

A value of 0 will create a linearly interpolated deformation. A higher value will cause regions 
further from the source to have increasingly less influence as it recedes from the control.

A negative value can be used to apply the blending inversely.
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Parameter Description

Deformation 
Quality

This is the quality of the deformation. It ranges from Low to Extreme. The higher the quality, the 
better the deformation will look, but the longer it will take to render.
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Filter Nodes
Here is the list of the main filter effects available in Harmony.

Anti-Flicker Node 580

Auto-Patch Node 582

Bloom Node 584

Blur-Box Node 588

Blur-Directional Node 591

Connection 592

Layer Properties 593

Blur-Gaussian Node 595

Blur-Radial Node 598

Blur-Radial-Zoom Node 600

Blur-Variable Node 604

Brightness Contrast Node 606

Channel Selector Node 608

Channel Swap Node 610

Chroma-Keying Node 612

Colour Banding Node 618

Colour Art Node 621

Colour Curves Node Properties 624

Colour Fade Node 629

Palette Overrides 630

Individual Colour Overrides 632

Colour Levels Node 636

Colour-Override Node 639

Colour-Scale Node 644

Colour Selector Node 646

Contrast Node 649

Dither Node 651

Focus Node 653
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Focus Multiplier Node 656

Gamma Node 658

Glow Node 661

Grain Node 665

Greyscale Node 667

Hue-Saturation Node 669

Increase Opacity Node 676

Layer Selector Node 679

Line Art Node 682

Luminance Threshold Node 684

Matte-Blur Node 687

Matte-Resize Node 690

Median Node 692

Motion Blur Node 695

Motion-Blur-Legacy Node 699

Negate Node 702

Overlay Layer Node 704

Pixelate Node 706

Remove Transparency Node 708

RGB Difference Keyer Node 710

Shadow Node 715

Transparency Node 718

Underlay Layer Node 720
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Anti-Flicker Node
Use the Anti-Flicker to compensate for flickering in your output to TV formats. The Anti-Flicker effect applies a 
vertical blur to the rendered output. You should place the Anti-Flicker before a Write node in the Node view.

Refer to the following example to connect this effect:

Use the Anti-Flicker editor to control the amount of blur that is applied to rendered output. In the Radius field, 
enter a value for the number of pixels to be considered in the blur.

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.
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Auto-Patch Node
T-RIG-005-001

The Auto Patch node is used mainly when creating joint patches for cut-out puppets drawn with pencil lines 
and painted in the Colour Art layer. Instead of removing a portion of the outline to attempt to create a 
seamless joint, you can draw complete pieces, and with the Auto Patch node, automatically create a perfect 
articulation.

The requirements for this effect to work are:

 l Drawing outlines must be drawn in pencil lines

 l Drawing outlines must be drawn in the Line Art layer

 l Drawing fill colours must be painted in the Colour Art layer

Pencil lines are central vector lines. The vector is located along the centre of the line. This means that when 
you paint a zone delimited by a pencil line, the colour fill will expand to the centre of the pencil line.

When using the regular patch technique, recommended for the brush line, the result with pencil lines is very 
odd looking because the colour fill zone is bigger than the pencil line inner contour.

Instead of using the regular patch method, you can use the Auto Patch node. It will automatically extract the 
Colour Art and clip it to the right size. Then, you can connect it in front of the piece to be covered.
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The node connection for the Auto Patch is quite simple. Once your basic character rigging is done, add the 
Auto Patch node to the joints you want to cover. There is no need to set any parameters. 

Refer to the following example to connect this effect:

 

Properties 

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.
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Bloom Node
The Bloom effect is used to make a specular area blurrier on a bitmap image, such as street lamps at night.

Connection

The Bloom node takes an image of any type as its input and outputs an image in which pixels that pass the 
threshold are softened, blurred and their gamma is adjusted.

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.

The Bloom node is a combination of the Luminance Threshold, Cutter, Blur-Gaussian and Composite Generic 
nodes—see Luminance Threshold Node on page 684, Cutter Node on page 460 Blur-Gaussian Node on page 
595, and Composite-Generic Node on page 454.
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Layer Properties

Parameter Description

Name Allows you to enter a name for the node.

Threshold
Controls how much of the dark value to clamp off. A high value will keep only the bright 
areas of your image.
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Parameter Description

Soften Colours

Brings back the entire spectrum of luminance in areas defined by the threshold to avoid 
having only bright values.

Gamma 
Correction

Multiplies the gamma value to make the area brighter or darker.  A value of 1 keeps the gamma 
the same as the original image.  You can use the gamma modification on the whole image if 
you use a threshold of 0 for example.
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Parameter Description

Output 
Greyscale Matte

Allows you output an image in levels of grey. This can be used in combination with a 
Blending or Cutter  node, or other effects that use greyscale mattes. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to the opaque 
areas of the matte drawing. When this option is enabled, the effect is applied to the 
transparent areas of the matte instead.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change of 
depth or scale. When this option is deselected, the effect's values remain unchanged 
regardless of any depth or scale changes. This option should be deselected when multiple 
drawings are composited and attached to this effect.

Radius Adjusts the amount of blur applied to the image.

Quality
Controls the quality of the blur. A higher quality yields better results, but will be slower to 
render.

Composite with 
Source Image

Blends the area defined by the threshold with the original image.

Blend Mode
Defines the blending mode between the original image and the area defined by the threshold 
to avoid having to add a Composite Generic node after the Bloom node.
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Blur-Box Node
T-COMP2-003-003

The Blur - Box effect  is a quick and easy way to create a blurring effect. The Box blur changes the colour value 
of each pixel based on the pixels next to it in the vertical and horizontal directions. The look of the blur is 
similar to the look achieved using Gaussian blur, but renders much faster. This effect is useful when a fast 
rendering time is important, and the quality of the blur is less important. Also, you can use a matte with this 
effect to isolate areas of the image.

Refer to the following example to connect this effect:

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects
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Properties 

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Repeat Edge Pixels
Makes the blur algorithm operate as if the pixel values beyond the edge of the 
layer are the same as the values of the edge pixels. This keeps edges sharp, 
preventing them from darkening and becoming more transparent.

Blurriness

Directional
Blurs according to the length, width, and angle you specify. For example, if a 
character is walking east, the blur may fall to the west.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.

Length Length of the blur.
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Parameter Description

Width Thickness of the blur.

Angle
The direction in which the blur is applied: sideways, up, down,  90 degrees, 45 
degrees, and so on.

Bidirectional Applies the blur on both sides of the pixel.

Fall Off

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, 
distributing the blur evenly from the edge of the character to the farthest edge of 
the blur. A fall-off rate of 1 causes the blur to fade out quickly, so the blur is 
heaviest closer to the edge of the image.

Number of Iterations
The number of times the blur is applied to the image. A higher number of 
iterations creates smoother transitions between colours and increases the blur, 
but also increases render time.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

Precision
Blurs the image the number of times the precision indicates at different radius 
(between 0 and the specified radius).
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Blur-Directional Node
T-COMP2-003-005

The Blur-Directional effect creates the effect of a motion blur that pulls and smears the image from one contour 
edge to a different direction or angle. This effect is useful in creating the impression of speed, such as the 
streaks of colour that follow a car travelling at high speed. 
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Connection
The Blur-Directional node takes an image of any type as its input and outputs a blurred bitmap image. 

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.
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Layer Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.

Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, 
distributing the blur evenly from the edge of the character to the farthest edge of 
the blur. A fall-off rate of 1 causes the blur to fade out quickly, so the blur is 
heaviest closer to the edge of the image.

Angle

The angle of the blur. The value goes from 0 to 360, with 0 meaning west, and 
angles going counterclockwise. For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.
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Parameter Description

Direction of trail
If you do not set an Angle for the direction of the blur, you can select a direction 
(north, south, east, or west) from this menu. The calculations for this feature are 
faster than the calculations for the Angle setting.

Ignore Alpha
Controls the leading edge of the blur. Deselect this option for a solid or hard 
leading edge on the blur.

Extra Final Blur
Adds a second blur after the Blur-Directional is created. If you have a Blur-
Directional that begins at 0 and gradually gets stronger, deselect this option to 
ensure a smooth progression.

Number of Iterations
The number of times the blur is applied to the image. A higher number of 
iterations creates smoother transitions between colours and increases the blur, 
but also increases render time.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Blur-Gaussian Node
T-COMP2-003-002

The Blur-Gaussian effect softens the image, reducing the amount of noise and detail. The look of the Gaussian 
blur is smooth, but does take some rendering time. This effect is useful when rendering time is less important, 
and quality is more important. Also, you can use a matte with this effect to isolate areas of the image.

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Refer to the following example to connect this effect:
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Properties 

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Repeat Edge Pixels
Makes the blur algorithm operate as if the pixel values beyond the edge of the 
layer are the same as the values of the edge pixels. This keeps edges sharp, 
preventing them from darkening and becoming more transparent.

Blurriness

Directional
Blurs according to the length, width, and angle you specify. For example, if a 
character is walking east, the blur may fall to the west.

Blurriness Amount of blur applied to the layer.

Horizontal Blurriness Length of the blur.

Vertical Blurriness Thickness of the blur.

Angle
The direction in which the blur is applied: sideways, up, down,  90 degrees, 45 
degrees, and so on.
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Parameter Description

Bidirectional Blurs in both horizontal and vertical directions.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

Precision
Blurs the image the number of times the precision indicates at different radius 
(between 0 and the specified radius).

597

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Blur-Radial Node
T-HFND-010-007

The Blur-Radial effect creates an effect that softens, fogs or obscures the image evenly in all directions. This 
effect is useful when you want to make cloudy images not realistically seen in detail, such as a drawing object 
that is farther back or in the background of your scene, usually blurry due to the laws of atmospheric 
perspective. Other uses include the general softening of objects such as snow, stars and shadows that do not 
naturally have a hard outline.

Refer to the following example to connect this effect:

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.

Quality
Select High for a slow and accurate operation or Low for a faster operation with a 
more raw look.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Blur-Radial-Zoom Node
T-COMP2-003-007

The Blur - Radial Zoom effect creates blurs around a centre point, simulating the look of a zooming or rotating 
camera. You can use a matte to isolate the area of the image from which you want the effect to radiate from. For 
example, in the illustration below, a circular matte was created to mask the eyeball and a Negate effect was 
applied so the blur is outside the matte. Then the centre point was positioned on the character's iris, which is 
the centre of the matte.

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Refer to the following example to connect this effect:
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Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Focus The focus point is the point from which the radial-zoom blur radiates. By default, 
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Parameter Description

it is in the centre of the stage, but it can be positioned anywhere and it can also 
be animated.

If you want to animate the focus point, you can choose which type of function to 
use to store the animation.

 l 2D Path: The horizontal and vertical position are on the same function. 
This makes the point move in a curvilinear trajectory between each 
keyframe. 

 l Separate: The horizontal and vertical position are on separate functions. 
This makes the point move in a straight line between each keyframe and it 
allows you to modulate the trajectory differently on each axis. 

NOTE 

The position of the Focus point is also influenced by the transformation 
information sent to the node's middle input (Focus Point) port. You can 
attach a peg to the middle input-port and position or animate the focus 
point by positioning or animating the peg. 

(x) Axis The horizontal position of the focus point.

(y) Axis The vertical position of the focus point. 

Blurriness Amount of blur applied to the layer.

Variation

Constant: An equal, constant blur is applied on all pixels.

Linear: A gradual blur is applied on all pixels.

Quadratic: An exponential blur is applied on all pixels.

Direction Lets you select preset blur types or create a custom blur.

Presets
A set of preset radial, zoom, and spiral blurs to get you started. You can then 
adjust the type to customize the blur.

Custom Create your own blur by entering a value for the direction of the blur lines.

Fall Off
The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, 
distributing the blur evenly from the edge of the character to the farthest edge of 
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Parameter Description

the blur. A fall-off rate of 1 causes the blur to fade out quickly, so the blur is 
heaviest closer to the edge of the image.

Bidirectional Applies the blur on both sides of the pixel.

Quality
Affects the quality of the blur by defining how fine the reference radial grid is on 
the image.  This determines the width of all the wedges.   A higher quality yields 
achieve better results, but will be slower to render.

Matte

Precision
Blurs the image the number of times the precision indicates at different radius 
(between 0 and the specified radius).
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Blur-Variable Node
T-COMP2-003-004

Use the Blur-Variable effect to create a radial blur that varies within a single image based on the white and 
black values in the matte you supply. You can set one blur value for the black regions in the matte, and another 
blur value for the white regions. The blur value for each grey region is interpolated between your black and 
white blur settings.

The following example is a network for a Variable Blur effect. A black and white copy of the character was 
used to create the effect. Use the Blur-Variable editor to control the blur value for the white and black radius. 

Refer to the following example to connect this effect:

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Black radius
The amount of blur to apply to the black (transparent) values in the matte. Higher 
values create more blur in the colour image's regions that correspond to the 
black matte region.

White radius
The amount of blur to apply to the white (opaque) values in the matte. Higher 
values create more blur in the colour image's regions that correspond to the 
white matte region.

Quality
Select High for a slow and accurate operation or Low for a faster operation with a 
more raw look.

Keep inside source image This option confines the blur to the source image.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Brightness Contrast Node
The Brightness and Contrast effect allows you to modify the brilliance or dullness of an image or to create a 
greater difference between the lights and darks of an image by increasing their respective intensities. This 
effect can be used when an image appears too flat. Increasing the brightness or contrast can give a drawing a 
more attractive and 3D quality. This can be useful if you want to push your background to the rear by making it 
look dull and flat and pulling your foreground elements to the front by giving them a higher contrast.

Connection

The Brightness Contrast node takes an image of any type as its input and outputs an image with different 
brightness and contrast parameters.

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.

Layer Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Legacy Brightness
If you created this effect in an older version of Harmony, this option is enabled by 
default to prevent enhancements done to the effect in more recent versions of 
Harmony from affecting the rendered image. 

Brightness
A value less than 0 will darken the image; a value greater than 0 will brighten it. 
Attach a Bezier or Ease function to change the brightness over time.

Contrast
A value less than 0 will reduce contrast; a value greater than 0 will increase 
contrast. Attach a Bezier or Ease function to change the contrast over time.

Legacy Contrast
If you created this effect in an older version of Harmony, this option is enabled by 
default to prevent enhancements done to the effect in more recent versions of 
Harmony from affecting the rendered image. 

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Channel Selector Node
The Channel Selector effect allows you to filter out some of the colour channels in an image.

Refer to the following example to connect this effect:

Properties

Parameter Description

Name Allows you to enter a name for the node.

Red Allows the red values to go through.
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Parameter Description

Green Allows the green values to go through.

Blue Allows the blue values to go through.

Alpha

Allows the alpha values to go through.

NOTE 

When this parameter is disabled, the input image is composited with the 
scene as if the alpha value of each pixel was the sum of the red, green 
and blue values. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Channel Swap Node
The Channel Swap effect lets you take the image information from one channel and use it in another channel 
to achieve interesting effects. You can extract the following: red, green, blue, alpha values, hue, saturation, 
lightness, and luminance, as well as turn the information on or off. 

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Refer to the following example to connect this effect:

Properties 
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Red Channel From Allows you to select from which channel to get the red values.

Green Channel From Allows you to select from which channel to get the green values.

Blue Channel From Allows you to select from which channel to get the blue values.

Alpha Channel From Allows you to select from which channel to get the alpha values.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Chroma-Keying Node
The Chroma-Keying effect lets you create an alpha channel (transparency zone) for a bitmap image or image 
sequence. For example, if you have a series of bitmap images with a character filmed on a green or blue screen, 
you can use this node to create an alpha channel based on the screen colour and cut it out from your image 
sequence.

Refer to the following example to connect this effect:

NOTES 

 l The input image must be a bitmap image. 

 l If a matte drawing is connected to the Chroma-Keying node, only the parts of the input image 
that intersect with the matte will be keyed out. 
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Properties

Parameter Description

Name Allows you to enter a name for the node.

Colour

Colour

The colour to filter out of the image. This should be set to the colour of the 
background in the image.

 l Red: The red value of the background colour.

 l Green: The green value of the background colour.

 l Blue: The blue value of the background colour.

 l Alpha: The alpha value of the background colour. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.
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Parameter Description

TIP 

Since the Chroma Key node works better if its colour is set to the exact 
colour of the background of your image, it is recommended to open the 

Colour Picker dialog, then click and drag on the Dropper  and drop it 
over the background of your image to instantly select its background 
colour. 

Matte

Black Point
Increases the transparent (black) portion of the Chroma Key matte. This will 
reduce the edge of the visible image.
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Parameter Description

White Point

Reduces the transparent (black) portion of the Chroma Key matte. This will 
increase the edge of the visible image.
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Parameter Description

Blur Passes

Allows you to set the number of times the input image is blurred before it is 
processed, which smooths out the small areas. 

Adjacent Pixels per Pass

When blurring the matte edge's with the Blur Passes parameter, the Adjacent 
Pixel parameter will blur the matte border with the next few pixels (amount 
indicated in the field) to create a nicer edge.

Invert Matte

If a matte drawing is connected to the node, by default, only parts of the input 
image that intersect with opaque areas of the matte drawing are keyed out. If this 
option is enabled, only parts of the input image that intersect with transparent 
areas of the matte drawing are keyed out.

Output

Threshold Matte
Applies a threshold (tolerance) to the selected colour to be removed. The 
Threshold amount is set in the Threshold field.

Threshold 

Increases or decreases the tolerance for the selected colour to be removed from 
the image. The higher the value, the more coloured pixels will be considered in 
the  Chroma-Keying  matte. The pixel colour value will not have to be as close to 
the RGB value as the one selected in the colour swatch. A lower Threshold value 
means the RGB values must be closer to the selected colour in order to be part of 
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Parameter Description

the matte.

Cut Colour

Removes the selected colour from the image and leaves a transparent zone so 
you can see the background and other layers behind the image. If the option is 
disabled, the colour will remain, but an alpha channel is created that you can use 
with any other nodes with a a Matte input.
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Colour Banding Node
Use the Colour Banding effect to add a colour banding visual effect to your elements. The node will associate a 
flat colour to the different regions of your element. These regions are delimited according the alpha values that 
are set up in the effect node and which will be recognized on the original element. You can use this effect to 
change the visual style of a particle node, for example, by giving it a more cartoonish look.

In this example, a Colour Banding node has been connected to a fire created with particle effects. 

Refer to the following example to connect this effect:

Properties

The Colour Banding node requires you to configure it with four colours, and to assign each of these colours with 
a threshold. Colours with a high threshold will replace brighter areas of the input image, and colours with a 
low threshold will replace its darker areas. Hence, the order in which you configure these colours does not 
matter. 

TIP 

If you only want to use 1, 2 or 3 colours, you can exclude a colour by setting its threshold to 100. 
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Threshold

The minimum value required in the source pixel for this colour to replace the 
source image colour. The threshold can be set to a value between 0 and 100. A 
high setting will make the colour replace brighter areas of the input image, 
whereas a low setting will make it replace darker areas. 

Colours are applied on the output image in order of their threshold. The colour 
with the lowest threshold is applied first, then the one with the second lowest 
threshold is applied over it, followed by the one with the second highest 
threshold and finally the one with the highest threshold. 

Setting this parameter to 100 will remove the colour from the effect, allowing 
you to use less than four colours if preferred.

Colour
The colour with which to fill the zone that exceeds the threshold:

 l Red: The amount of red in the colour.
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Parameter Description

 l Green: The amount of green in the colour.

 l Blue: The amount of blue in the colour.

 l Alpha: The amount of alpha in the colour. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
zone. 

Blur The amount of blurriness to apply to the zone. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Colour Art Node
The Colour-Art effect lets you isolate the colour art in a layer. Placing a Colour Art node after a drawing node 
in the Node view only displays the Colour Art output. You can connect the Colour-Art node after nodes of any 
type. Any bitmap information will pass through the node and be processed.

This effect will only work if there is something on the Colour Art layer of the drawing. 

Refer to the following example to connect this effect:
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Properties

Parameter Description

Name Allows you to enter a name for the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option 
to cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works 
with both pencil lines and brush strokes.

Apply to Matte Ports on 
Input Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want 
to also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality

Smoothness setting applied to Colour-Art. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the setting, 
the greater the amount of antialiasing applied. Higher quality images require more 
time to render and more memory from your system. Use a lower quality when 
rendering a pencil test.

Antialiasing Exponent
Controls the extent of the area around the Colour-Art edges used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
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Quality value is set to Low (no antialiasing), this value is ignored.
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Colour Curves Node Properties
The Colour Curves properties presents a 4x4 grid. Since the Input and Output values are separated within a 
range of 0 and 1, which 0 represents 0% and 1 represents 100%, each line of the grid represents a graduation 
of 25%.

By moving the control points and handles of the diagonal line that goes through the 4x4 grid, you can modify 
the curve and create a more progressive setup. But the main distinction between the Colour Curves node and 
the Colour Levels node is the possibility to add more control point to the curve, which lets you create a more 
complex setup that gives you more control over the image.

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side, and Top views.

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view.

Name Allows you to change the name given to the node.

Channels
Lets you select which channel you want to modify:

 l RGB: Lets you modify every colour channel (red, green and blue) at the same time with a 
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Parameter Description

single curve.

 l Red: Lets you modify only the red channel.

 l Green: Lets you modify only the green channel.

 l Blue: Lets you modify only the blue channel.

 l Alpha: Lets you modify only the alpha channel.

Input

Lets you reduce the range of the input colours (by dragging left and right).

Modifying the first control point to a higher input value will create a more contrasted version of 
the picture. If the value is set near 1, every medium colour will become darker, extremely light 
colours will stay visible and white will remain white. Once the input is set to 1, only the white 
colour will remain.

For example, the first control point has an output of 0 and an input of 0.5 instead of 0.
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Parameter Description

  

Modifying the last control point to a smaller input value will create a more contrast version of 
the picture. If the value is set near 0, medium colours will become brighter, extremely dark 
colours will stay visible and black will remain black. Once the input is set to 0, only the white 
colour will remain.

For example, the first control point has an output of 1 and an input of 0.5 instead of 1.

Output

Reducing the range of the output colours (dragging up and down) will reduce the levels in the 
output image but will not clamp the upper and lower pixels (by interpolating the values to a 
lower overall range). The perceived contrast might drop, but that’s only because the overall 
levels in the image have been reduced.
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Parameter Description

Modifying the first control point to a higher output value lets you transform the image to a 
brighter version of it. The contrast in the picture will mostly remain the same.

For example, the first control point has an output of 0.5 instead of 0 and an input of 0.

Modifying the last control point to a smaller output value lets you transform the image to a 
darker version of it. The contrast in the picture will mostly remain the same.

For example, the last control point has an output of 0.5 instead  of 1 and an input of 1.
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Parameter Description

  

Reset
Lets you reset all values of the first and last control point. It will also remove every added 
control point.
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Colour Fade Node
The Colour-Fade effect allows you to animate a change in colours for an element in your scene.

The Colour-Fade node works a lot like the Colour-Override node, in that it allows you to replace the palettes 
used by elements in your scene with different palettes, and to replace individual colours with different colours. 
But it also has a “Fade” function, that has a value between 0 and 100, which interpolates between the original 
colours and the replacement colours. Hence, by animating this function to go from 0 to 100 over a couple 
frames, you can animate the transition between the original colours and the replacement colours. 

Connection

To use the Colour-Fade node, simply connect it under the element, effect or composite on which you want to 
perform a colour fade. The Colour-Fade node will take the image sent to its input (top) port, and output the 
image with the colour fade applied to it through its output (bottom) port. 

Just like the Colour-Override node, the Colour-Fade node works by travelling up the node system to replace 
the colours in the vector artwork. Hence, it does not work with bitmap images, but it does work with vector 
images connected to bitmap composites and bitmap effects. 

Properties

The Layer Properties for the Colour-Fade node are similar to the Colour-Override node, except that it has a 
Fade function and does not support overriding textures. 

General Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have 
a name that is unique to its containing group.

Fade

An animatable function for the percentage of interpolation between the input image’s original 
colours and the override colours. This parameter can be set to any value between 0 and 100. At 0, 
the input image preserves its original colours. At 100, the input image’s colours are fully replaced 
by the override colours. At 50, the input image’s colour are interpolated halfway towards the 
override colours.
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Parameter Description

Colour 
Interpolation

This allows you to customize how the interpolation between the original colours and the override 
colours is calculated.

By default, colours are interpolated in RGB mode, which means that the red, green and blue 
values are interpolated from their original values to their override values directly. This may not 
produce the best results. You can choose between the following colour spaces:

 l RGB (Red, Green & Blue): Interpolates from the original colour’s red, green and blue 
values to the override colour’s red, green and blue values.

 l HSV (Hue, Saturation, Value): Interpolates from the original colour’s hue, saturation and 
value to the override colour’s hue, saturation and value.

 l HSL (Hue, Saturation, Lightness): Interpolates from the original colour’s hue, saturation 
and lightness to the override colour’s hue, saturation and lightness.

NOTE 

This parameter is not related to the colour space management functionalities of Harmony, 
such as your scene’s colour space or the rendering colour space. 

Hue 
Interpolation

This option allows selecting the type of interpolation used for the hue value and is available 
when the Colour Interpolation is set to HSL or HSV. The following options are available: 

 l  Linear: Interpolates the hue value linearly between 0 and 360. Provided for legacy 
reasons. 

 l Circular Shortest: Linear hue value interpolation from the source colour to the 
destination colour using the shortest distance, passing through 360 to 0, and vice versa if 
shortest.

 l Circular Clockwise: Clockwise value interpolation, wrapping around 360 to 0 if 
necessary. 

 l Circular Counterclockwise: Counterclockwise value interpolation, wrapping around 0 to 
360 if necessary.

Palette Overrides

This section of the Colour-Fade node allows you to fade from the input image’s original palettes to alternate 
palettes.

For this to work, the colour swatches in the original palette and in the alternate palette must have the same 
colour IDs. This can be achieved in one of the following ways:

630



 l By “cloning” the palette, a new palette is created with swatches that have the same colour IDs. You can 
modify the colours in a cloned palette without affecting the colours in the original palette. Hence, you 
can fade from a palette to its clone. 

To clone a palette, right-click on that palette in the Palettes list of the Colour view, and select Clone in 
the context menu.

 l By “cloning” the original colour swatches to a different palette. This can be useful in the case where you 
already cloned a palette, but added a new swatch to the original palette. You can clone the new swatch 
to the cloned palette and give it a different colour if needed.

To clone a colour swatch, right click on that swatch in the Colour view and select Copy in the context 
menu. Then, select the palette where you want to clone the swatch, right-click in the swatches list and 
select Paste As Clones in the context menu.

Icon Parameter Description

 
Add 
database 
palette

Allows you to add a palette that is located anywhere in your Harmony Server database to 
the list of palettes that can be used as overrides.

If you’re working on an Harmony Stand Alone scene, this allows you to add a palette that 
is located in your scene’s environment, job, scene or element palettes to the list of 
palettes that can be used as overrides. 

NOTE 

Typically, a Harmony Stand Alone scene only has environment and job palettes if 
it was exported from a Harmony Server database with those palettes. 

 
Add 
filesystem 
palette

Allows you to add a palette that is located anywhere in your workstation’s file system to 
the list of palettes that can be used as overrides.

  Palettes

The list of palettes that can be added to the Whole Palette Overrides list. By default, this 
list contains all of the scene palettes as well as palettes linked to the elements affected 
by the Colour-Fade effect. Palettes can also be added using the Add database palette 
and Add filesystem palette buttons above. 

 

Delete 
current 
palette 
entry

Removes the currently selected palette from the Whole Palette Overrides list.

 
Whole 
Palette 
Overrides

The list of palettes that will override the palettes in the input image. When a palette is 
added to this list, any colour in the input image that has the same colour ID as any colour 
in one of the palettes in the list will be replaced with the colour in that palette.
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Icon Parameter Description

For example, if your character uses the palette MyCharacter_Day, and you’ve cloned that 
palette to create an alternate palette for this character named MyCharacter_Night, adding 
MyCharacter_Night to this list will make the Colour-Fade effect fade all of the colours 
from MyCharacter_Day to the colours in MyCharacter_Night.

You do not need to add the original palette to any list in the Colour-Fade’s layer 
properties. As long as the colours in the override palette have the same colour IDs as the 
ones used in the input image, the Colour-Fade node will find the original colours and 
replace them—see Palette Overrides on page 630.

To add a palette to this list, select it in the Palettes list, then click on the Add button 
between the two lists.

Individual Colour Overrides

This section allows you to fade specific colours in the input image to new custom colours. 

Icon Parameter Description

 
Colours 
Eyedropper

Allows you to pick a colour from the Camera or Drawing views. To do this, click on the 
icon once, then click on the colour you want to select in the Camera or Drawing view. 
The colour’s palette will become selected in the Palettes list, and the colour swatch 
itself will become selected in the Colours list. 

NOTE 

If the colour you clicked on is not in one of the palettes listed in the Palettes list, it 
will not be selected. By default, the Palettes list only list palettes that are used by 
the input image of the Colour-Fade node, so make sure the node is properly 
connected to its input image in the Node View.

  Colours
The list of colours in the palette selected in the Palettes list in the section above. 
Allows you to select which colour to add to the Individual Colour Overrides list.

  Add Adds the selected colour from the Colours list to the Individual Colour Overrides list.

 
Delete 
current 
entry

Removes the currently selected colour from the Individual Colour Overrides list. 

 
Individual 
Colour 

The list of colours in the input image that the Colour-Fade effect must override. To add a 
colour to the list:
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Icon Parameter Description

Overrides

 1. Select the palette containing the colour in the Palettes list in the top left corner.

 2. Select the colour to override in the Colours list in the bottom left corner.

 3. Click on the Add button between the Colours list and the Individual Colour 
Overrides list.

The selected colour will be added to the list. To select what to do with this colour:

 1. Click on the drop-down arrow in the Mode column and select one of the 
following:

 l Override Colour: If this colour is overridden by one of the palettes in the 
Whole Palette Overrides list, this option will prevent this specific colour 
from being overridden.

 l Colour Not Visible: Fades out the selected colour.

 l New RGB Only: Fades the selected colour to a new colour with custom 
red, green and blue values, without affecting the colour’s alpha value.

 l New Alpha Only: Changes the colour’s alpha value without affecting its 
red, green and blue values.

 l New RGBA: Fades the selected colour to a new colour with custom red, 
green, blue and alpha values. 

 2. If you’ve selected New RGB ONly, New Alpha Only or New RGBA, click on the 
colour swatch in the New column to open a Colour Picker dialog in which you 
can select the new colour to replace the selected colour with.

Render Selected Colours Only

This section allows you to make the Colour-Fade node make all but a sub-set of colours in the input image fade 
out. 

Icon Parameter Description

 
Colours 
Eyedropper

Allows you to pick a colour from the Camera or Drawing views. To do this, click on the 
icon once, then click on the colour you want to select in the Camera or Drawing view. 
The colour’s palette will become selected in the Palettes list, and the colour swatch 
itself will become selected in the Colours list. 
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Icon Parameter Description

NOTE 

If the colour you clicked on is not in one of the palettes listed in the Palettes list, 
it will not be selected. By default, the Palettes list only list palettes that are used 
by the input image of the Colour-Fade node, so make sure the node is properly 
connected to its input image in the Node View.

  Colours
The list of colours in the palette selected in the Palettes list in the section above. 
Allows you to select which colour to add to the Render Selected Colours Only list.

  Add Adds the selected colour from the Colours list to the Render Selected Colours Only list.

 
Delete 
current entry

Removes the currently selected colour from the Individual Colour Overrides list. 

 

Render All / 
Render 
Selected 
Colours 
Only drop-
down

This drop-down allows you to select whether Render Selected Colours Only mode of 
the Colour-Fade node is enabled:

 l Render All: All colours in the input image are rendered. 

 l Render Selected Colours Only: Only the colours in the Render Selected Colours 
Only list are rendered, regardless of whether or not they are overridden with a 
different colour. Other colours are filtered out and appear invisible. 

 

Apply to 
Matte Ports 
on Input 
Effects

If the output image of the Colour-Fade effect is connected to the Matte port of any 
effect, by default, even if the Colour-Fade effect is configured to only render selected 
colours, 

 
Individual 
Colour 
Overrides

The list of colours in the input image that the Colour-Fade effect must override. To add a 
colour to the list:

 1. Select the palette containing the colour in the Palettes list in the top left corner.

 2. Select the colour to override in the Colours list in the bottom left corner.

 3. Click on the Add button between the Colours list and the Individual Colour 
Overrides list.

The selected colour will be added to the list. To select what to do with this colour:

 1. Click on the drop-down arrow in the Mode column and select one of the 
following:

 l Override Colour: If this colour is overridden by one of the palettes in the 
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Icon Parameter Description

Whole Palette Overrides list, this option will prevent this specific colour 
from being overridden.

 l Colour Not Visible: Areas filled with the selected colour become 
invisible.

 l New RGB Only: Areas filled with the selected colour fade to a new 
colour with custom red, green and blue values, but the colour’s alpha 
value remain unchanged.

 l New Alpha Only: Areas filled with the selected colour value fade to the 
same colour with a different alpha value.

 l New RGBA: Areas filled with the selected colour fade to a new colour 
with custom red, green, blue and alpha values.

 2. If you’ve selected New RGB ONly, New Alpha Only or New RGBA, click on the 
colour swatch in the New column to open a Colour Picker dialog in which you 
can select the new colour to replace the selected colour with.
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Colour Levels Node
The Colour Levels node allows you to adjust the levels in an element in your scene or for your entire scene. The 
levels can be adjusted for all the colour channels, for a specific colour channel or even for the alpha channel. 

Colour Levels are a way to fine tune the balance of black and white in an image. A good way to illustrate how 
levels work is by taking a scanned pencil drawing. When you look at a clean pencil drawing in real life, your 
eyes will mostly see clean outlines unless you focus on the erroneous details on purpose. A scanner will 
however pick up on the details indiscriminately, resulting in smudges and feathered pale outlines. By tweaking 
the input levels of an image, you can process a pencil drawing like so:

 l Increasing the Input Black level will make the darkest parts of the drawing black, or closer to black. This 
results in darker, crisper outlines.

 l Decreasing the Input White level will make the lightest parts of the drawing white, or closer to white. 
This results in removing smudges. Also, if the background is grey, it will turn white. 

By tweaking the output levels of an image, you can perform the reverse effect:

 l Increasing the Output Black level will make the black pixels in the drawing appear lighter. All other 
pixels in the drawing will also appear lighter, but the closer to white they are, the less lightness is 
added to them. This can result in grey outlines.

 l Decreasing the Output Black level will make 

Connection

To use the Colour Levels node, simply connect it under the element, effect or composite to which you want to 
apply the levels effect. The node will take the input image from its top port, apply the level settings to it and 
output the modified image out of its bottom port.

Properties

The Colour-Levels node has five tabs, each with the same parameters. What is different between tabs is the 
colour channels that they affect:

 l The RGB is for adjusting the levels of all colours.

 l The Red, Green and Blue tabs is for adjusting the levels of a single one of these three colour channels. 

 l The Alpha tab is used for adjusting the level of the Alpha channel. 
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

Input Black

The level under which a colour value is rendered as black. This varies between 0 and 1 and is set to 
0 by default. At 0, only a colour with a level of 0 is rendered as black. At 1, all colours are rendered 
as black. At 0.5, all colours with a level between 0 and 0.5 are output as black, and colours with a 
level between 0.5 and 1 are rendered darker, proportionally to how close they are to 0.5.

Input 
White

The level past which a colour value is rendered as white. This varies between 0 and 1 and is set to 
1 by default. At 1, only a colour with a level of 1 is rendered as white. At 0, all colours are rendered 
as white. At 0.5, all colours with a level between 0.5 and 1 are rendered as white, and colours with 
a level between 0 and 0.5 are rendered lighter, proportionally to how close they are to 0.5.

Gamma

The gamma correction to apply to the colours after the input levels are applied and before the 
output levels are applied.

Gamma correction is a curvilinear function applied to the colour values. It is used to modulate the 
difference in intensity between colour values. In other words, it affects how much differences 
between low, medium and high colour values translate to actual variations of intensity between 
colours. For example:

 l A gamma correction between 0 and 1 will make low values lower progressively lower, 
causing a bigger spectrum of dark colours to appear closer to black. The contrast between 
high values is increased to compensate.

 l A gamma correction above 1 will increase the value of dark colours proportionally to their 
actual values, increasing the contrast between them and making them lighter. The contrast 
between high values is decreased to compensate.

Output 
Black

The level at which black is output in the image. This varies between 0 and 1 and is set to 0 by 
default. For example, if you set this to 0.5, then black pixels in the image will actually appear gray, 
and all pixels will be made lighter proportionally to how close to black they are.
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Parameter Description

Output 
White

The level at which white is output in the image. This varies between 0 and 1 and is set to 1 by 
default. If you set this to 0.5, white pixels in the image will appear grey, and all other pixels will be 
made darker proportionally to how close to white they are.
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Colour-Override Node
The Colour-Override effects processes the colours in a drawing layer. Using this effect, you can change colours 
from the palette without affecting the actual palette, swap clone palettes, or even replace a specific colour 
zone.  You can also substitute colour areas with bitmap textures. The drawings in this layer must be .tvg files as 
the Colour-Override uses the colour palettes linked to them.

The Colour-Override effect lets you:

 l Change colour values in drawings during the compositing process.

 l Use colour values from a specific colour palette in the palette list.

 l Establish the priority of override palettes in the palette list. For example, you may have different clones 
of the same palette, such as a daytime and nighttime version.

 l Isolate specific areas of a drawing by selecting certain colours. For example, using specific colours to 
generate a matte for a glow effect.

 l Hide certain colours.

Refer to the following example to connect this effect:
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Interface

Palettes

The Palettes section displays the palettes in the palette list of the selected layer. You can move these palettes 
into the Whole Palette Overrides section to reorder them. If you have cloned palettes, the higher one in the list 
will override the others. This is useful for overriding the clone palette ordering set in the scene through the 
Colour view. 

You can load additional palettes in the palette list from either your project, by clicking on The Palette  
button, or your computer by clicking on the Browse  button.

 l The Palette  button allows you to load a palette contained within the project hierarchy 
(Environment, Job, Scene and Elements).

 l The Browse  button allows you to load a palette located outside the project hierarchy, anywhere on 
your system or server. If you link to a palette outside of your project, you will be prompted with the 
following warning message:

You can hover your mouse over the palette name in any of the override sections to display the path to the 
palette.
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Colours

The Colours section displays the colour swatches of the selected palette. Move a swatch into the Colour-
Overrides section to change its value.

Whole Palette Overrides

The Whole Palette Overrides section forces the use of a particular palette (clone palette) or palette list 
ordering during the compositing process. You must drag palettes from the Palettes section to change their 
order. Harmony uses the palettes in the order they appear in the palette list to find the colour values 
associated with the colour IDs of each colour zone. To apply a different version of a colour palette to, for 
example, switch from a day to a night palette, use the Override section to change the order of the colour 
palettes (you must be working with cloned palettes).
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Individual Colour Overrides

When you drag a swatch from the Colours section to this section, you can override its value. You can also 
override a colour with a texture. The default override mode is set to New RGBA so you can override the RGB 
value as well as the transparency value.

The Current column always displays the colours from the currently active palette.  Selecting a clone palette in 
the Palettes area will not change the colours if you haven't changed the active palette in the Whole Palette 
Overrides section. The update will be done once you close and reopen the Colour Override Layer Properties 
window.

Render Selected Colours Only

The Render Selected Colours Only section is used to display some colours and ignore all others. You may, for 
example, want to display only the colour used for the character outline and ignore all the filling colours.

Only the colour swatches listed in the Rendered Selected Colours Only section will be rendered. The option is 
not activated by default. If you want to display only the selected colours, you must select the correct option 
from the Rendering menu:

 l Render All: This is the default option. All colours in the palettes are rendered regardless of the listed 
selection. This allows you to quickly switch back and forth between your selection of colours and all the 
colours without having to delete and add your swatches from and to the list.

 l Render Selected Colours: When this option is selected, the Colour Override module displays only the 
colours listed in your selection.
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 l Rendered Selected Colours and Bitmaps: This option displays all colours listed as well as any bitmap 
images passing through the Colour Override node. For example, if you have a Composite node grouping 
a series of drawing and bitmap nodes, the vector colours will be filtered through the Colour Override 
nodes but the bitmap images will pass through without being affected. Note that you must be in Render 
View mode to see the colours and bitmaps. 

You might have situations where your Colour Override node is placed below a Cutter node using a mask input 
and a drawing input. By default, the Colour Override only processes the colours in the drawing input. The 
mask drawing remains untouched. If you want the Colour Override to also filter the mask drawing, select the 
Apply to Matte Ports on Input Effects option.
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Colour-Scale Node
The Colour-Scale effect offsets an image's colours. This effect is useful in creating ambient transitions, such as 
from daytime to nighttime.

Refer to the following example to connect this effect:

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Red The factor by which to multiply red values in the image.

Green The factor by which to multiply green values in the image.

Blue The factor by which to multiply blue values in the image.

Alpha The factor by which to multiply alpha values in the image.

Hue The colour or hue to offset the image.

Saturation The amount of colour to offset the image.

Value

Enter the value for the colour to offset the image. The actual colour values of the 
image are not changed; instead, the channels are multiplied by a selected 
amount. For example:

 l A value of 1 does not change the colour values.

 l A value greater than 1 brings the colour channel value closer to 255 (or 
white).

 l A value less than 1 brings the colour channel value closer to zero (0 or 
black).

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

645

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Colour Selector Node
The Colour-Selector node filters colours in the input image and outputs an image containing only the selected 
colours. The colours to display can be selected in the Layer Properties of the Colour-Selector. 

The Colour-Selector does not just cut out the colours that are not selected from the input image, it outputs the 
image it is connected to as if these colours were invisible. Hence, if two brush strokes with different colours 
overlay each other, and the colour of the overlaying brush stroke is filtered out, the underlay brush stroke will 
not be cropped, it will display as if the overlay stroke did not exist. 

NOTE 

The Colour-Selector node works exactly as when using the Render Selected Colours Only tab of 
the Colour Override node, except that it is made for that specific purpose, allowing the use of this 
feature to be more simple and streamlined. 

Connection

To use the Colour-Selector, simply connect it as the intermediary between an image output (such as a drawing 
or composite's output port) and an image input (such as a composite's input port):
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The Colour-Selector node will take the input image and output the image without the colours that are not in its 
colours list in its layer properties. By default, no colours are in the Colour-Selector's list, so the output image 
will be completely invisible until colours are added. 

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Apply to Matte Ports on 
Input Effects

By default, the Colour-Selector does not filter out colours in drawings that are 
connected to the matte port of a node. This is because drawings connected to a 
matte port are used for their shape and transparency levels, and not their colours. 
If this option is checked, the Colour-Selector will filter out the colours that are 
not in the list, even in drawings that are connected to a matte port. 

Add Colour Menu

The Add Colour menu allows you to add colours to the list of selected colours. 
You must add colours to the list for the Colour-Selector to know which colours 
to let through.
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The Add Colour menu has three sections:

 l The palette list: The first section lists all palettes in the scene. When 
you select one of the palettes, it will list all the colours in that palette. 
This allows you to add any colour available in your scene to the list of 
selected colours. 

 l The drawing list: The second section lists all drawings connected to the 
Colour-Selector node. When you select a drawing, it will only list the 
colours used by that drawing. This allows you to quickly select a colour 
that is used by one of the drawings being filtered, without having to go 
through every colour in the scene.

 l Add All Colours: This option will instantly add all colours used by all 
drawings connected to the Colour-Selector node. You can then remove 
the colours you want to hide using the Remove Colour button. This can 
be useful if you only want to filter out a few of many colours.

Remove Colour Removes the selected colour from the list.

Selected colour list
The list of colour that the Colour-Selector will let through. Every other colour in 
the input image will be filtered out.
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Contrast Node
Use the Contrast effect to increase or decrease the level of contrast in an image. This is done by changing the 
contrast in the dark and bright pixels and setting the transition point between dark and bright.

You can enter static values in the dialog box fields or you can attach these values to function curves to change 
over time.

Refer to the following example to connect this effect:

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

Mid Point

The value that separates dark from bright colours. The midpoint is a value between 0 and 1 that 
represents the percentage of the 0 to 255 RGB channel range.

 l Pixels with colour values lower than the midpoint: These are considered dark pixels. 

 l Pixels with colour values higher than the midpoint: These are considered bright pixels.

Dark Pixel 
Adjustment

Bright Pixel 
Adjustment

The amount of contrast to be applied to pixels that fall on either side of the Mid Point value.

 l A value equal to 1: No change.

 l A value less than 1: Makes the pixel brighter.

 l A value greater than 1: Makes the pixel darker. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to the opaque areas of 
the matte drawing. When this option is enabled, the effect is applied to the transparent areas of the 
matte instead.
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Dither Node
Dithering is the process of approximating a higher number of colours in a low bit-depth colour system. Use the 
Dither effect to give the appearance of greater colour variability in 8-bit per channel colour images. 

Refer to the following example to connect this effect:

The Dither effect is useful in the case of a gradient that varies between 100 and 105 in the blue channel, for 
example. Since the difference in the colour values is not great, banding might appear in the image. In this case, 
use the Dither node to give the impression of greater values of blue, decreasing the unwanted banding effect.

The results of the dither operation may be imperceptible.

Properties
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Magnitude

A magnitude of 1 performs a normal dithering operation, using all bands of 
colour. A magnitude greater than 1 introduces a bias towards brighter colours. A 
magnitude of less than 1 creates a faster transition between bands of colour, 
lessening the bias towards brighter colours.

Correlate
When selected, the three colour channels (RGB) are changed simultaneously, for 
better colour accuracy. When this option is not selected, the three channels are 
dithered separately, resulting in smoother transitions.

Random The standard algorithm for the dithering operation.
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Focus Node
T-COMP2-011-006

Use the Focus effect to set up depth-of-field effects for your scene. The Focus node is used to determine how 
much blur will be applied to images, based on their distance from the focal point. 

The focal point can be the zero value of your scene or you can link the Focus node to another node, such as a 
drawing or peg layer, to retrieve the focal point from the node's Z-axis position. 

Refer to the following example to connect this effect:

Use the Focus editor to determine how the focus will change as objects move farther from the focal point.

In the Side view window, you can see how the blur values change based on their distance from the focal point. 
Select the Focus node in the Node view, make sure you are using the Transform tool, then right-click on the 
Side view window and select Control from the pop-up menu.
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If you edited the function curve and adjusted the velocity, you can also adjust the Bezier handles in the Side 
view.
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Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Mirror Select this option to also blur images in front of the focal point.

Mirror Front/Back Ratio
When the Mirror option is selected, this ratio is applied to the calculation of the 
blur on images in front of the focal point. The default ratio of 1:2 produces 
realistic results. Experiment with different values to create customized effects.

Radius
Controls the amount of blur applied to an element based on its distance from the 
focal point. Click on the Edit Curve button to change these values by adjusting 
the function curve.

Quality
Controls the quality of the blur. A higher quality will achieve better results but 
will be slower to render.
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Focus Multiplier Node
T-COMP2-011-006A

The Focus Multiplier effect works with the Focus node. This node applies a blur to the selected layer, based on 
the blur radius in the Focus node.

Use the Focus Multiplier node when you want to apply the focus to selected elements or when you need to 
apply the focus before doing more effects in a composite operation. 

Refer to the following example to connect this effect:

You must disable the Apply Focus option in the Composite node in order to apply the focus effect to the 
selected node only. If you do not disable that option, the focus effect will be calculated twice on the selected 
node.

Use the Focus Multiplier editor to multiply the Focus Radius by a selected value. You can enter a static value in 
the Multiplier field or attach it to a function curve. 
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Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Multiplier This is the value by which the normal focus radius value is multiplied.
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 Gamma Node
The Gamma node allows you to apply gamma correction to an element in your scene or to your entire scene. 
The gamma correction can be applied to all colour channels, to a specific colour channel or even to the image’s 
alpha channel. 

Gamma correction is a curvilinear function applied to the colour values. It is used to modulate the difference in 
intensity between colour values. In other words, it affects how much differences between low, medium and 
high colour values translate to actual variations of intensity between colours. For example:

 l A gamma correction between 0 and 1 will make low values lower progressively lower, causing a bigger 
spectrum of dark colours to appear closer to black. The contrast between high values is increased to 
compensate.

 l A gamma correction above 1 will increase the value of dark colours proportionally to their actual values, 
increasing the contrast between them and making them lighter. The contrast between high values is 
decreased to compensate.

Connection

To use the Gamma node, simply connect it under the element, effect or composite to which you want to apply 
the gamma correction. The node will take the input image from its top port, apply the gamma correction to it 
and output the corrected image out of its bottom port.

If you only need to apply gamma correction to the rendered frames without affecting the preview image in the 
Camera view, simply connect it between your scene’s main Composite node and its Write node. Likewise, if you 
only need to apply a gamma correction to the preview image in the Camera view, but you don’t want it to be 
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applied to the rendered frames, simply connect it between your scene’s main Composite node and its Display 
node. 

NOTE 

Like with most effects, the effect of the Gamma correction node are only visible in the Camera view 
when it is in  Render View mode.

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

RGB 
Gamma

The gamma correction value or function to apply to red, green and blue channels simultaneously.

Red 
Gamma

The gamma correction value or function to apply to red colour values only.
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Parameter Description

Green 
Gamma

The gamma correction value or function to apply to green colour values only.

Blue 
Gamma

The gamma correction value or function to apply to blue colour values only.

Alpha 
Gamma

The gamma correction value or function to apply to alpha values only. 
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Glow Node
T-HFND-010-009B

The Glow effect turns your image into a glow area with a bright soft-edged light or diffuse light region around 
an image. The Glow effect is useful for creating a shining rim around objects, such as the sun or stars. Clone 
your layer or connect it a second time to the Composite node to display the original image on top of the glow.

Refer to the following example to connect this effect:

NOTE 

If this effect is connected below a Composite node set to Pass-Through, the effect will be applied 
to each element connected in the Composite node individually. If some of these elements are 
overlapping, the effect will also overlap.
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Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make 
up the edge of the matte.

 l Directional: The matte is blurred in the direction configured with the 
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Parameter Description

Directional Angle and Directional Falloff Rate parameters.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value 
goes from 0 to 360, with 0 meaning west, and angles going counterclockwise. 
For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal 
value between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the 
edge of the character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge 
of the image.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
opaque areas of the drawing. When this option is enabled, the effect is applied to 
transparent or empty areas of the drawing. 

Use Source Colour

Instead of using the colour in the Colour parameters, this uses the colours in the 
source drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 

Multiplicative
Multiplies the colours of the effect with the colours of the background. This 
intensifies the effect. 

Colour

Red The amount of red to add to the colour in the background image.
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Parameter Description

Green The amount of green to add to the colour in the background image.

Blue The amount of blue to add to the colour in the background image.

Alpha The alpha value of the effect. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This 
parameter can take a decimal value between 0 and 1. At 1, the effect is fully 
applied. At 0, the effect is not visible. 
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Grain Node
Use the Grain effect to add a film grain to an image; the film grain looks like video noise.

Refer to the following example to connect this effect:

The Grain node has two input ports. 

• On the left port, attach the element that will act as the matte defining the grain area.

• On the right port, attach the element on which you want to apply the grain effect.

The Grain node requires a matte drawing. If you simply want to apply a grain over the source drawing, simply 
connect it to both the image input port and the matte input port of the node:

Properties

In the Layer Properties of the Grain node, you can adjust the amount of grain to add to an image as well as the 
sharpness and softness of the grain.
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Noise
The amount of grain to add to the image based on the percentage of pixels to 
alter. The larger the value, the courser the grain. The smaller the value is to 0 
(zero), the finer the grain.

Smooth
The amount of blending to apply to the grain effect, based on the blur radius, to 
make the effect appear less pixelated. The larger the value, the greater the 
smoothing.

Random at Each Frame

Computes the colour shift in the grain using a different value at each composite. 
This means that your images will look different each time you render them. 
Deselect this option and select a Seed Value to ensure the same result every time 
you composite the grain effect.

Seed Value
This value corresponds to a unique pattern in the grain. If you want to retain this 
pattern in other frames, you can reuse this value.

Matte

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Greyscale Node 
The Greyscale effect lets you convert a colour image to greyscale. This example demonstrates what happens 
when you set the greyscale to 100% using the Greyscale node.

TIP 

You can use this effect in combination with the Brightness Contrast effect to adjust the different 
levels of grey in the output image.  

Refer to the following example to connect this effect:

Properties
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Parameter Description

Name Allows you to change the name given to the node.

Percent
The percentage of greyscale to apply to the input image. Lowering this parameter 
will only partially desaturate the image's colours.

Matte Output

Preserves the colours of the input image, but applies the greyscale version of the 
input image to the alpha channel of the output image. As a result, the darker a 
pixel in the image is, the more transparent it is. White pixels will remain opaque, 
and black pixels will become invisible. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Hue-Saturation Node
The Hue-Saturation effect lets you adjust the hue, saturation and lightness values individually or by using the 
HLS picker or Hue Range picker. You can achieve effects over the entire image, such as a sepia tone. Changes 
you make to the values are additive to the final image.

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Connection

The Hue-Saturation node takes an image of any type as its input and outputs an image with different hue, 
saturation and lightness parameters.

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.
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Layer Properties 

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

670



Master Tab

The master tab allows you to adjust the hue, saturation and lightness settings for all the hues in the source 
drawing simultaneously. It should be used unless you want to apply specific parameters on specific ranges of 
hues. 

Parameter Description

Hue Range Picker 

Opens the Hue Range Picker. In the Master tab, the Hue Range Picker can only be 
used to see the original colour spectrum of the image and compare it to the 
colour spectrum as processed by the Hue-Saturation effect. 

Hue
Offsets the hues in the source image. The hue of every pixel in the source image 
is offset on the spectrum of hues. This parameter can be set to a value between -
360 and 360.

Saturation

Changes the saturation of the source image. This parameter can be set to a value 
between -100 and 100. Negative values make the image closer to a greyscale 
image. Positive values make the colours appear more saturated by exacerbating 
the difference between each channel. 
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Parameter Description

Lightness

Changes the lightness of the source image. The lightness can vary between -100 
and 100, where -100 makes the image solid back and 100 makes the image solid 
white. Hence, negative values darkens the colours by making every pixel 
proportionally closer to black, and positive values lighten the colours by making 
every pixel proportionally closer to white. 

Colourize

Enables colourization. Instead of affecting the existing colours of the input 
image, the Hue-Saturation effect will convert the image to greyscale, then add a 
single colour over the levels of grey based on the Hue, Saturation and Lightness 
settings you input below. 

NOTE 

When the Colourize parameter is enabled, fields below the check box are 
accessible and fields above the check box are greyed out. 

Hue The colour with which to colourize the image. 

Saturation
The saturation with which to colourize the image. A lower setting will make the 
colourized image closer to a greyscale image. A higher setting will make the 
colour more saturated.

Lightness

Changes the lightness of the source image. The lightness can vary between -100 
and 100, where -100 makes the image solid back and 100 makes the image solid 
white. Hence, negative values darkens the colours by making every pixel 
proportionally closer to black, and positive values lightens the colours by 
making every pixel proportionally closer to white. 

Colour Swatch

When Colourize mode is enabled, you can click on the colour swatch to open a 
Hue, Saturation and Lightness picker. 

The lightness can be selected by moving the slider at the top. The hue and 
saturation can be selected by moving the cursor in the box underneath the slider. 
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Parameter Description

Hue Tabs

The other tabs in the Hue-Saturation Layer Properties are meant to allow you to specify the hue, saturation 
and lightness parameters for specific colour ranges. By default, each tab is configured to affect a specific colour 
range corresponding to their tab name, namely:

 l Reds

 l Greens

 l Blues

 l Cyans

 l Magentas

 l Yellows
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At their default settings, all tabs combined cover the entire spectrum of hues. The colour spectrum that each 
tab affects can however be customized. 

Parameter Description

Hue Range Picker 

Open the Hue Range Picker dialog. This allows you to tweak the range of hues 
that the settings in the current tab affects. For example, this is the default range 
for the Blue tab:

Every pixel in the source drawing that has a hue within the hard range will be 
affected by the settings in the tab. 

As for pixels with a hue within the soft range, how much they are affected by the 
settings in the tab depends on how much their hue is closer to the hard range or 
to the limit of the soft range. The further away from the hard range the hue of a 
pixel is, the lesser the effect of the hue, saturation and lightness settings on this 
pixels is. This allows you to taper the effect of the ranges so as to not create hard 
seams between areas of different colours. 

Hue
Offsets the hues in the area covered by the selected hue range. The hue of every 
pixel in this area is offset on the spectrum of hues. This parameter can be set to a 
value between -360 and 360.

Saturation

Changes the saturation of the area covered by the selected hue range. This 
parameter can be set to a value between -100 and 100. Negative values make the 
area closer to greyscale. Positive values make the colours in the area appear more 
saturated by exacerbating the difference between each channel. 

Lightness

Changes the lightness of the area covered by the selected hue range. The 
lightness can vary between -100 and 100, where -100 makes the area solid back 
and 100 makes the area solid white. Hence, negative values darkens the colours 
by making every pixel proportionally closer to black, and positive values lighten 
the colours by making every pixel proportionally closer to white. 

Reset Range
Resets the range selected in the Hue Range Picker to the default range for the 
current colour tab.
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IO Tab

The IO tab contains parameters relating to the input and out ports of the effect. 

Parameter Description

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.
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Increase Opacity Node
The Increase-Opacity node allows you to increase the opacity of a visual element. It works by multiplying the 
opacity level of each pixel in the input image by a customizable factor, and outputs the result in the output 
image. 

This can be used to fix a commonly encountered issue in digital animation, where a seam is visible between two 
elements in a rig because one element is used as the matte for a cutter for the other element. A known work-
around to this is to connect the problematic parts of the rig several times to the same composite so as to 
increase the opacity on their edges, but this can negatively impact performance. This node will increase the 
opacity around the edges of scene elements without causing unnecessary overhead. 
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Connection

To use the Increase-Opacity node, simply connect the visual element for which you want to increase opacity 
into its input port, then connect its output port to a composite, or to the next effect you want to apply to the 
output image.

Optionally, you can use another visual element as the matte for the Increase Opacity effect by connecting this 
visual element to the left edge of the node. When you do this, only parts of the input image that intersect with 
the matte image will have their opacity increased.

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

Factor
The number by which to multiply the opacity of each pixel in the input image. For example, if this 
parameter is set to 2, a pixel that has an alpha value of 85 out of 255 will be output with an alpha 
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Parameter Description

value of 170 out of 255. 

The default value for this parameter is 1.8. It can be set to any value between 1 and 100. 

Invert 
Matte

Inverts the matte used to generate the effect. By default, the affect is applied to opaque areas of the 
matte and transparent areas of the matte are ignored. When this option is enabled, the effect is 
applied to transparent areas of the matte and opaque areas of the matte are ignored. 
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Layer Selector Node 
The Layer Selector effect lets you isolate and display one or more art layers:

 l Overlay

 l Line Art

 l Colour Art

 l Underlay 

Refer to the following example to connect this effect:
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Properties

Parameter Description

Name Allows you to change the name given to the node.

Read Overlay, Line Art, 
Colour Art, Underlay

Turns the display of the Overlay, Line Art, Colour Art and Underlay layers on or 
off.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option 
to cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works 
with both pencil lines and brush strokes.

Apply to Matte Ports on 
Input Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want 
to also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality
Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality of 
the chosen setting, the greater the amount of antialiasing that is applied. Higher 

680



quality images require more time to render and more memory from your system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Line Art Node
The Line Art effect lets you read only the Line Art in an element. Place a Line Art node after a drawing node in 
the Node view to display only the node's Line Art output. The Line Art node can be connected after nodes of 
any type. Any bitmap information will pass through and be processed. 

This effect will only work if you drew something on the Line Art layer of the drawing. 

Refer to the following example to connect this effect:
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Properties

Parameter Description

Name Allows you to change the name given to the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option 
to cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works 
with both pencil lines and brush strokes.

Apply to Matte Ports on 
Input Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want 
to also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality of 
the chosen setting, the greater the amount of antialiasing that is applied. Higher 
quality images require more time to render and more memory from your system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Luminance Threshold Node
The Luminance Threshold effect generates a matte by thresholding the luminance of an image. This works 
well with bitmap images that have many shades of colours. A pure vector image with flat colors could use a 
color override to isolate areas.

Thresholding is a method to segment or isolate certain zones in an image. This effect will isolate areas based 
on the image's luminance. Thresholding is used within the Bloom effect—see Bloom Node on page 584. 

Connection

The Luminance-Threshold node takes an image of any type as its input and outputs an image in which pixels 
that do not pass the threshold are filtered out and the remaining pixels are softened and have their gamma 
adjusted. 

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.

Layer Properties 
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must 
have a name that is unique to its containing group.

Threshold

Controls how much of the dark value to clamp off. A high value will keep only the bright 
areas of your image.

Soften Colours

Brings back the entire spectrum of luminance in areas defined by the threshold to avoid 
having only bright values.

Gamma Multiplies the gamma value to make the area brighter or darker.  A value of 1 keeps the gamma 
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Parameter Description

Correction

the same as the original image.  You can use the gamma modification on the whole image if 
you use a threshold of 0 for example.

Output 
Greyscale Matte

Allows you output an image in levels of grey. This can be used in combination with a 
Blending or Cutter  node, or other effects that use greyscale mattes. 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to the opaque 
areas of the matte drawing. When this option is enabled, the effect is applied to the 
transparent areas of the matte instead.

686



Matte-Blur Node
Use the Matte-Blureffect to blur a matte or change its colour. Here is an example of a network with the result 
of a Matte-Blur effect.

Refer to the following example to connect this effect:

NOTE 

If this effect is connected below a Composite node set to Pass-Through, the effect will be applied 
to each element connected in the Composite node individually. If some of these elements are 
overlapping, the effect will also overlap.
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Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this 
effect.

Blur Type

Directional: Blurs the matte in the direction you select. For example, if a 
character is walking east, the blur may fall to the west. 

Radial: Blurs the edges of the matte evenly around points that make up its edge.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you select a Blur Directional type, you can select the direction of the blur by 
entering a value from 0 to 360 in this field.

‣ 0: Blurs the image to the west.

‣ 90: Blurs the image to the south.

‣ 180: Blurs the image to the east.
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‣ 270: Blurs the image to the north.

Directional Fall-off Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

 l A fall-off rate of zero causes the blur to fade out slowly, distributing the 
blur evenly from the edge of the character to the farthest edge of the blur.

 l A fall-off rate of 1 causes the blur to fade out quickly so that the blur is 
heaviest closer to the edge of the image.

Invert Matte
Inverts the matte used to create the glow. The matte will become a black 
silhouette while the glow fills the background space.

Use Source Colour
Uses the colours painted in the matte for the glow effect. If you deselect this 
option, select a colour and alpha values in the Colour section.

Multiplicative Creates a more diffused glow.

Colour Lets you choose the colour and alpha values for the glow effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This 
parameter can take a decimal value between 0 and 1. At 1, the effect is fully 
applied. At 0, the effect is not visible. 
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Matte-Resize Node 
The Matte-Resize effect lets you evenly expand a matte outward in all directions. The matte increases size 
from its centre. 

Refer to the following example to connect this effect:

If you use the Matte-Resize node to create a pulsating glow, you can enlarge the region without softening the 
edges. Using the Blur-Radial effect, the effect may be softer than you intend. This node produces a limited 
antialiased matte, which can have slightly jagged edges. You could use this node in combination with other 
nodes, such as:

 l Tone

 l Highlight

 l Glow
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 l Shadow

 l Matte-Blur

Properties

Parameter Description

Name Allows you to change the name given to the node.

Radius
Lets you enter a static value for the radius (size increase or decrease) of the matte. 
You can also attach the Radius value to a function column to change the value 
over time. 
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Median Node
The Median effect lets you reduce the noise in a drawing while preserving its edges. Harmony sorts the values 
of pixels within a specified radius and uses the median value. You can also use this effect to create a 
Impressionist type of style.

Connection

The Luminance-Threshold node takes a bitmap image as its input and outputs a bitmap image in which pixels 
that do not pass the threshold are filtered out.

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.
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Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must 
have a name that is unique to its containing group.

Radius

Lets you specify the size of the area of values to consider determining the median value. A 
median is calculated by sorting all the pixel values from the surrounding area into numerical 
order. Then the middle pixel value is used to replace the pixel being considered. 

The median tends to make an image look a bit blurrier because it reduces the contrast of 
adjacent pixels. However, it does a good job of smoothing the image and removing artifacts.

Colour Depth

Determines the number of levels per colour channel. The larger the number, the more levels 
of colour are used in the image and the more time it takes to render. Conversely, the lower the 
colour depth, the fewer colours are used, the faster it is to render. 
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Parameter Description

 

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to the opaque 
areas of the matte drawing. When this option is enabled, the effect is applied to the 
transparent areas of the matte instead.
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Motion Blur Node
The Motion-Blur node allows you to generate a motion blur effect for animated elements in your scene.

The Motion-Blur node works by taking the position of the input element at the current frame as well as in 
previous frames. It then generates intermediary poses between each frame and combines the actual poses and 
the intermediary poses into a stack of “samples”. It then proceeds to lower the opacity of each sample, 
composite them together and add a directional blur between each sample.

The Motion-Blur node can work with standard transformations such as translations, rotations, scaling and 
skewing. It can be used on single elements, or on several elements simultaneously, whether composited 
together or separately.

NOTE 

The Motion-Blur effect does not work with deformations.

Connection

The Motion-Blur node has an image (rightmost) input port and a motion (leftmost) input port. It takes the 
image sent to its image input port and outputs the motion-blurred image through its only output port.

When nothing is connected to the motion input input port, the direction of the motion blur is based on the 
transformations done on the element connected to the image input port. This is the most simple usage 
scenario.

However, if the Motion-Blur node is connected to a composite node, the motion blur will be generated 
differently based on the composite’s mode:
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 l If the input image comes from a passthrough composite (wide cable), each input connected to the 
passthrough composite will have its own motion blur effect generated for it, using each input image’s 
own motion.

 l If the input image comes from a non-passthrough composite, the motion-blur will be applied to the 
composited output image as a whole. It will however only use the motion of the element connected to 
the composite’s Output Z port to generate the motion-blur effect. By default, a composite’s Output Z 
port is its leftmost input port.

It is also possible to use the motion of any other node in your scene to determine the direction of the motion-
blur effect. To do this, connect this node to the Motion-Blur’s motion (leftmost) input port, like so:
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When a node is connected to the Motion-Blur node’s left input port, is uses the motion of this node, rather 
than the motion of the input image, but it still applies the blur to the input image.

TIP 

The Motion-Blur node can also use the motion of the scene’s active camera to generate the motion 
blur. This can be done by enabling the Use Camera Motion option in the node’s Layer Properties. 
When enabled, the Motion-Blur node ignores the motion of the input image and the left input 
port, and only uses the camera motion.

Layer Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

Use 
Camera 
Motion

When enabled, motion-blur is generated based on the motion of currently active camera. This 
option will override the transformation of the input image and the peg-port.

Duration 
(Number of 
Frames)

The span of animation before and up to the current frame to use to generate the motion blur effect, 
in frames. For example, if this parameter is set to 3, the motion blur effect will be generated using 
the trajectory of the element starting from 2 frames before the current frame up to the current frame.
 

NOTE 

This number can be a decimal value. 
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Parameter Description

Samples 
per Frame

This parameter sets the amount of in-betweens to add to the blur effect between each frame of 
animation used. 

For example, if the Duration parameter is set to 3, setting this parameter to 1 will only use the 
position of the element in the current frame and the two previous frames to generate the motion 
blur. However, if this parameter is set to 2, the Motion-Blur node will generate one extra inbetween 
sample between each frame used to generate the motion blur, to simulate a smoother motion.  

Fall-of 
Rate

Defines the rate at which each trailing sample drops in weight and opacity as they get further and 
further from the position of the element in the current frame. This can be set to a decimal value 
between 0 and 1, where: 

 l At 0, each sample used to generate the motion blur has the same opacity.  

 l At 1, the sample at the current frame is almost opaque, and the opacity of each preceding 
sample is determined by a cubic function. 

A value between 0 and 1 will result in a compromise between those two functions.

Preroll 
Motion

When enabled, samples are generated before the first frame of the scene, so that the motion blur 
effect is already in full effect when the scene begins. This can be useful in cases where the scene 
begins while the object is already in motion.  
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Motion-Blur-Legacy Node
The Motion-Blur-Legacy effect is used to create a faded trail behind objects animated on a motion path. You 
cannot create a Motion-Blur-Legacy on a hand-drawn animation. The layer must be moving along a trajectory 
(motion path) in order to work properly.

NOTE 

For information on the new, non-legacy Motion-Blur node, see Motion Blur Node on page 695

Connection

As a filter-type effect, the Motion-Blur-Legacy node takes an input image in its right-most input port, and 
outputs the blurred image from its only output port. 

You can also connect another drawing to its left-most input port to act as the matte. The shape of the matte 
input drawing will determine the area of the actual input drawing to blur.
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Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Number of Frames in Trail The number of frames before the current frame that will be used in the trail.

Number of Samples
The number of copies of each drawing used in the trail. The higher the number, 
the more continuous the trail appears.

Fall-off Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. 

 l A fall-off rate of 0 causes the trail to fade out slowly, distributing the 
colour evenly from the edge of the character to the farthest edge of the 
trail. 

 l A fall-off rate of 1 causes the trail to fade out quickly so that the trail is 
more opaque closer to the edge of the image and transparent at the end of 
the trail.

Intensity
Select a value to define the opacity of the trail between 0 and 10. A value of 10 
will make the trail very dark and almost opaque, where as a value of 0 will make 
the trail quite pale and ghostly transparent.
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Use Mirror on Edges

When enabled this option appear when the image is close to the edge of the 
camera frame. It forces the software to use a mirror of the image to calculate the 
blur so that it appears on both sides of the drawing object. Without this option 
once your drawing reaches the edge of the Camera frame, it gets cropped so does 
the trail.
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Negate Node
The Negate effect lets you invert the colour and/or alpha values in the Colour Art and Line Art of an image. The 
original value of each channel (RGB or A) is subtracted from the maximum value of that channel (255 for 8-bit 
channels) to produce the negative image.

Connection

The Negate node takes an image of any type as its input and outputs an image in which colour values are 
inverted relative to their maximum. 

Optionally, it can also be connected to a matte image. In this case, only the parts of the input image that 
intersect with the matte will be affected by the effect.

Layer Properties
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no 
visible effect on the rendered image, nor on the preview in the Camera, 
Perspective, Side and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. 
Each node must have a name that is unique to its containing group.

Negate Colour Inverts the values of the colour channels.

Negate Alpha Inverts the transparency value (alpha channel).

Negate Colour Clamp to Alpha Limits the negated area to the alpha channel.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied 
to the opaque areas of the matte drawing. When this option is enabled, the 
effect is applied to the transparent areas of the matte instead.
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Overlay Layer Node
The Overlay Layer effect lets you read an element's Overlay Art layer. By placing an Overlay Layer node after 
a drawing node in the Node view, you can display only the node's Overlay layer output. The Overlay Layer 
node can be connected after nodes of any type. Any bitmap information will pass through and be processed. 

This effect will only work if something has been drawn or painted on a drawing's Overlay Art layer. 

Refer to the following example to connect this effect:
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Properties

Parameter Description

Name Allows you to change the name given to the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option 
to cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works 
with both pencil lines and brush strokes.

Apply to Matte Ports on 
Input Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want 
to also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality of 
the chosen setting, the greater the amount of antialiasing that is applied. Higher 
quality images require more time to render and more memory from your system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Pixelate Node
The Pixelate effect lets you apply a mosaic effect to an image (and its matte) based on the matte you supply. 
Pixelation makes the image look like it is made up of square tiles.

Connection

The Pixelate node takes an image of any type in the right (Image) input port, and a matte drawing in the left 
(Matte) input port. It outputs a version of the input image where the parts of the image that intersect with the 
matte are pixelated.

The Pixelate node requires a matte drawing. If you want to pixelate the entire input image, simply connect it to 
both the Image input port and the Matte input port.
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Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
the opaque areas of the matte drawing. When this option is enabled, the effect is 
applied to the transparent areas of the matte instead.

Factor

The pixelation factor. This parameter takes a decimal value between 0 and 1. The 
higher the value, the bigger the pixels. The default value is 0.0125 and creates 
sizeable pixels, so this parameter must be set to low values unless you want the 
pixels to take up the whole stage.
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Remove Transparency Node
The Remove Transparency effect negates transparent values in an image. You can use the Remove 
Transparency node to remove the result of antialiasing around an image.

Refer to the following example to connect this effect:

Properties

Parameter Description
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Name Allows you to change the name given to the node.

Threshold
All values above the Threshold represent a transparent value. In this field, you 
must identify the value above which all alpha values are considered transparent. 
Alpha is measured from 0 to 255.

Remove Colour 
Transparency

Determines which pixels in the Colour-Art (RGB channels) to make fully opaque 
or fully transparent.

Remove Alpha Transparency
When selected, the Threshold value is used to determine which pixels in the 
alpha channel to make fully opaque or fully transparent.
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RGB Difference Keyer Node
The RGB-Difference-Keyer node allows you to take an input image, and output it with an area of the image 
filtered out. The area of the image that is filtered out is determined by its colour, referred to as the key colour. 
This effect is typically used to take photos or live video footage shot against a green or blue screen and filter 
out the green or blue screen, so that it can be composited against the background.

Connection

The RGB-Difference-Keyer node has two image input ports.

If you only use the rightmost image input port, the RGB-Difference-Keyer will take the input image, generate a 
matte based on how much of the image matches the key colour, and remove the part of the image covered by 
this matte.

If you use both the left and right image input ports, the RGB-Difference-Keyer will generate a matte based on 
how much of the left input image matches the key colour, and cut that matte out of the right input image.
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Properties

Parameter Description

Name The name of the node as it appears in the Node View and the Timeline view. Each node must have 
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Parameter Description

a name that is unique to its containing group.

Key Colour

The colour used to generate the matte.  This is used to set the colour of the image background.  The 
matte is extracted by comparing the similarity of colour channel differences between key colour 
and the pixel colour.  

 l Red: The red value of the background colour. 

 l Green: The green value of the background colour. 

 l Blue: The blue value of the background colour. 

 l Alpha: The alpha value of the background colour. 

TIP 

If you click on the colour swatch below the Alpha field, a Colour Picker window will appear. 

In this video, you can click and drag on the  dropper and drop it over a pixel in the 
background of your photo or video to pick its colour. 

NOTE 

This keyer requires chromatic differences between the red, green or blue colour channels, so 
greyscale images cannot be keyed using this effect. 

Pre-
Multiplied 
Alpha

When checked, the RGB values of the input image are un-premultiplied before they are keyed.  The 
output image is then re-pre-multiplied against the alpha channel.

If the input image has alpha values and is pre-multiplied, this option will prevent the 
premultiplication from evening out the differences between the RGB channels. 

Key

Key Weight Increasing values result in fewer pixels colours being selected in the background.
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Parameter Description

Background 
Bias

Increasing this parameter will increase the tendency of the effect to find pixels that match the key 
colour and to key them out.

Low 
Intensity 
Threshold 

Increasing this parameter will make the node tend to key out darker pixels. 

Blend Input 
Alpha

When enabled, the alpha values of the input image are carried over to the alpha values of the 
output image. This option is only useful if the input image contains transparency, and that 
transparency needs to be preserved.

Despill 
Matte

When enabled, the effect removes the primary channel of the key colour from the edges of the 
output image, resulting in smoother contours. 

Spill 
Reduction

The amount of the colour key that should be removed from the edges of the output image. A 
higher setting will make the contours blend in better with the background of the scene.

Replace 
Colour

If the Despill Matte parameter is unchecked, this colour is used to fill the areas of the keyed matte 
that are semi-transparent.  

Matte
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Parameter Description

Clip Black Determines how much the effect should key out dark pixels.

Clip White Determines how much the effect should key out light pixels. 

Invert 
Output 
Matte

Inverts the matte applied to the output image. When enabled, pixels that are keyed will be opaque, 
and pixels that are not keyed will be transparent. 
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Shadow Node
With the Shadow effect, you can turn a drawing into a shadow. It doesn't matter if the drawing layer is a fully 
coloured character. The Shadow effect will render it into a grey, semitransparent, slightly blurry silhouette. 
You must connect your layer a second time to the your Composite node to see the original image displayed on 
top of the shadow.

Refer to the following example to connect this effect:

NOTE 

If this effect is connected below a Composite node set to Pass-Through, the effect will be applied 
to each element connected in the Composite node individually. If some of these elements are 
overlapping, the effect will also overlap.

Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node 
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Parameter Description

view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Allows you to choose between the following blur types for the effect:

 l Radial: The edges of the matte are blurred evenly around points that make 
up the edge of the matte.

 l Directional: The matte is blurred in the direction configured with the 
Directional Angle and Directional Falloff Rate parameters.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you set the Blur Type to Directional, this sets the angle of the blur. The value 
goes from 0 to 360, with 0 meaning west, and angles going counterclockwise. 
For example:

 l 0: Blurs the image to the west.

 l 90: Blurs the image to the south.

 l 180: Blurs the image to the east.

 l 270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a decimal 
value between 0 and 1. For example:

 l 0: Makes the blur fade out slowly, distributing the blur evenly from the 
edge of the character to the farthest edge of the blur.

 l 1: Makes the blur fade out quickly. The blur is heaviest closer to the edge 
of the image.

Invert Matte
Inverts the matte used to generate the effect. By default, the effect is applied to 
opaque areas of the drawing. When this option is enabled, the effect is applied to 
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Parameter Description

transparent or empty areas of the drawing. 

Use Source Colour

Instead of using the colour in the Colour parameters, this uses the colours in the 
source drawing to generate the effect.

NOTE 

The effect of this parameter is only visible in Render View  mode. 

Multiplicative
Multiplies the colours of the effect with the colours of the background. This 
intensifies the effect. 

Colour

Red
The amount of red to subtract from the colour in the background image. To 
obtain a shadow effect, this value must be negative.

Green
The amount of green to subtract from the colour in the background image. To 
obtain a shadow effect, this value must be negative.

Blue
The amount of blue to subtract from the colour in the background image. To 
obtain a shadow effect, this value must be negative.

Alpha The alpha value of the effect. 

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.

Intensity
Allows you to set the factor by which to multiply the intensity of the effect. This 
parameter can take a decimal value between 0 and 1. At 1, the effect is fully 
applied. At 0, the effect is not visible. 
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Transparency Node
T-HFND-010-008

The Transparency effect is used to make an image partially transparent. The Transparency effect is useful 
when fading images in and out, such as a phantom or to make something partially see-through, such as a 
window.

Refer to the following example to connect this effect:

You can enter a value in the Transparency field or change the transparency value over time by linking it to a 
function curve. Entering a value of 100 in the Transparency field will make the element 100% transparent, in 
other words, invisible. Entering a value of 0 will render the element completely opaque.

It is also possible to adjust a drawing layer's transparency directly in the Layer Properties window without 
using the Transparency node. In the layer's properties, go to the Drawing tab and adjust the Opacity 
parameter. This parameter is visible in OpenGL mode.
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Properties

Parameter Description

Name Allows you to enter a name for the node.

Transparency
Lets you set the opacity of an element.  Values range from 0 to 100. A value of 
100 will make the element 100% transparent and a value of 0 will render the 
element completely opaque.
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Underlay Layer Node
The Underlay Layer effect lets you read an element's Underlay Art layer. By placing an Underlay Layer node 
after a drawing node in the Node view, you can display only the node's Underlay layer output. The Underlay 
Layer node can be connected after nodes of any type. Any bitmap information will pass through and be 
processed. 

This effect will only work if something has been drawn or painted on a drawing's Underlay layer. 

Refer to the following example to connect this effect:

720



Properties

Parameter Description

Name Allows you to change the name given to the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option 
to cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works 
with both pencil lines and brush strokes.

Apply to Matte Ports on 
Input Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want 
to also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality of 
the chosen setting, the greater the amount of antialiasing that is applied. Higher 
quality images require more time to render and more memory from your system.

Antialiasing Exponent
Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
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Quality value is set to Low (no antialiasing), this value is ignored.
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Generator Nodes
The nodes found in the Generator category are nodes that output an image without requiring an input image. 
Hence, they generate an image rather than transforming an existing image. Among those nodes is the 
Element node, also known as drawing layers, which generate an image based on the drawing exposed at the 
current frame. Other nodes in this category generate an image based on their parameters.

Animated Matte Generator Node 724

Burn-In Node 735

Colour-Card Node 739

Element / Drawing Node 742

Connection 743

Field Chart Node 760

Gradient Node 765

Grid Node 771

Lens Flare Node 774

Turbulent Noise Node 777
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Animated Matte Generator Node
The animated matte generator is a very advanced tool in Harmony's suite of effects which, once connect to a 
drawing or character model, gives you three important capabilities.

 l Digitally animate the lines and contours of vector drawings

 l Create animated feathered (gradient) visual effects in specific shapes. 

 l Snap to the contours of a drawing to make the shape of its effect match the shape of the drawing. 

The resulting image can be used as a deformed drawing or an effect, and can also be used as a transparency 
mask for other drawings or effects. 

At the very least, the Animated Matte Generator node requires a vector drawing to be connected to its Image 
Source (right) input port. The node will generate animatable control points for each of the vector shapes in 
each of the drawings in its matte drawing layer, which can be manipulated and animated, allowing you to 
animate your drawing's vector points directly. 

TIP 

If the image source layer is moved, rotated or scaled, either directly or because of a parent peg, the 
control points of the Animated Matte Generator will follow these transformations. If you want the 
matte generated by the Animated Matte Generator node to follow the animation of another 
drawing, you can simply connect that drawing's output port to the image source drawing's input 
port.

IMPORTANT 

If the Overlay and Underlay Arts preference is enabled, the Overlay art layer of the  source 
drawing is reserved for annotations. Any artwork in the Overlay art layer of the source drawing 
will be ignored by the Animated Matte Generator node.

Based on its parameters, the Animated Matte Generator node will either output the source drawing after 
deforming it to match the position of the control points, or a feathered special effects matte gradating from its 
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inner contour to its outer contour. In either case, this allows to animate the image source, either as a simple 
vector drawing, as a special effect or as part of a more complex rig, without making new drawings for it. 

Optionally, another vector drawing may be connected to the node's Snapping Source (left) input port. Using 
the Set to Snap editing mode in the Animated Matte Generator view, you can set some of the points and 
contours of the input drawing to automatically snap to the snapping source drawing's contours, making it 
easier to animate a matte to follow the contours of a drawing in your scene. A contour that is set to snap to one 
of the snapping source's contours will even match the precise shape of this contour. 

IMPORTANT 

Only single vector drawing layers can be used for the image source and the snapping source of an 
Animated Matte Generator. The input ports of an Animated Matte Generator node should not be 
connected to a composite, an effect, or anything but a vector drawing node. 

Often, an Animated-Matte-Generator will be used to add a fine-tuned effect, such as a glow or shadow, on 
part of a drawing. A typical set-up to accomplish this will make use of the Colour Selector node and Cutter 
nodes to trim the effect generated by the Animated Matte Generator so that it only affects zones of the 
drawing that are painted with the specific colour. Since the effect generated for this drawing should follow 
that drawing's movements, if any, pegging the Animated Matte Generator's drawing source to the drawing 
the effect is applied over will lock their position together. Likewise, it may be useful to connect the drawing the 
effect will be applied over as the Animated Matte Generator's snapping source, since the matte might need to 
be snapped to that drawing's contours. 
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You can instantly add this template to your scene by clicking on the Add Matte Generator button in the 
Animated Matte Generator view. As an alternative, the Add Matte Generator as Mask button will add a similar 
template, except that the Animated-Matte Generator will be connected to the Cutter's matte port, and the 
drawing's Colour-Selector will be connected to the Cutter's input port. This can be used for example to use the 
Animated Matte Generator as a sophisticated transparency filter for an effect or element in your scene. 

The contours of an Animated Matte Generator can be configured and animated by using the Animated Matte 
Generator view along with its control points in the Camera view. 

How to access the Animated Matte Generator view

 1. Do one of the following:

 l From the top-right corner of any currently visible view, click the Add View  button and 
select Animated Matte Generator.

 l From the top menu, select Windows > Animated Matte Generator.

How to display the Animated Matte Generator controls and enable the Animated 
Matte Generator view options

 1. In the Tools toolbar, select the Transform tool or press Shift + T.

 2. In the Timeline or Node view, select the Animated Matte Generator node you wish to configure or 
animate.

 3. In the Camera view toolbar, click on Show Controls  or press Shift + F11.

NOTE 

For more information on the Animated Matte Generator view, see Animated Matte Generator View 
on page 1224.

Layer Properties

Using the Layer Properties dialog or view, you can configure the kind of matte the Animated Matte Generator 
should output, how the matte's points and contours should snap to its snapping source as well as the colours 
and other parameters for generating a feathered effect.

NOTE 

The examples below demonstrate the effects of using the Animate Matte Generator with a simple 
drawing of a square. However, it is able to deform vector drawings of any shape and complexity. 
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Matte tab

The matte tab allows you to configure whether the Animated Matte Generator node will output a deformed 
version of its input source drawing or a feathered effect based on its outer and inner contour as well as how the 
contour's control points and lines should snap to the snapping source's contours, if any.

Property Description

Output

Type

Determines which one of the following type of matte the node generates:

 l Feathered: Generates a matte that gradates from the inner contour's colour to 
the outer contour's colour, based on the parameters in the Advanced tab. 

 l Outer Contour: Displays the matte drawing as deformed by the outer contour's 
control points.
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 l Inner Contour: Displays the matte drawing as deformed by the inner contour's 
control points.

 l Interpolate between contours: Displays the matte drawing as deformed by a 
contour that is an intermediate between the outer contour and the inner contour. 
How close to the inner or outer contour this intermediate contour is is based on 
the Interpolation Factor parameter below. 

Interpolation Factor

When the output type is set to Interpolate between contours, the matte drawing is 
deformed according to a contour that is an intermediate between the outer contour and 
the inner contour. 

The interpolation factor determines the percentage by which the intermediate contour is 
interpolated from the outer contour to the inner contour. For example, if the 
interpolation factor is set to 50, the intermediate contour will be halfway between the 
outer contour and the inner contour. By default, it is set to 0, which means the 
intermediate contour is the same shape as the outer contour. If it is set to 100, the 
intermediate contour will match the inner contour. 
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TIP 

The Interpolation Factor parameter can be  animated. This can be useful if you 
want your drawing to morph back and forth between two different shapes, one 
of which would be defined by the outer contour and the other defined by the 
inner contour.

Snap

Drag-to-Snap Distance

If the Animated Matte Generator mode has a drawing connected to its Snapping Source 
port, and some of the matte's control points or contours are set to snap to that drawing, 
those points will always snap to the closest contour in the snapping source drawing, 
as long as it can find a contour within a certain distance. 

This distance is determined by the Drag-to-Snap distance parameter. By default, it is set 
to 15. You can increase it if you want the snapping points to snap to contours from a 
further distance to their actual position, or decrease it if you only want snapping points 
to snap to contours that are very close to their actual position.

Snap to Outlines Only

Make Snapping points and contours only snap to the outlines of the snapping source 
drawing. In this case, a contour is an outline that defines the silhouette of the drawing.

Snap to

Allows you to select which ones of the snapping source drawing's art layers the 
matte's points and contours will snap to, if they are set to snap. This can be useful if 
your snapping source drawing has its line art and colour art on different layers, as both 
art layers are likely to have a lot of meshing contours.

Advanced Tab

The settings in the Advanced tab are only available when the matte's output type is set to Feathered. A 
feathered matte ignores the colours and pencil lines in the drawing and, instead, uses the outer and inner 
matte's shape to generate a gradated colour effect, the colours and parameters of which can be set in the 
Advanced tab.
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Property Description

Feathering

Interpolation Mode

Determines the way the colour is gradated from the inner contour to the outer contour:

 l None: The outer and the inner contour are solid shapes, filled with their 
respective colours.

 l Parametric: Generates a linear gradient going from each side of the inner 
contour to the corresponding side of the outer contour. This mode is different 
from the Distance interpolation mode by how it makes the gradients track the 
matching sides of the inner and outer contours.
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 l Dot: Generates a gradient going from the inner contour to the outer contour, but 
based on a power function that creates the illusion of a thinner, harder outline.

 l Distance: Generates a linear gradient going from the inner contour to the outer 
contour.

Colour

Colour Interpolation

Determines the way the colours between the inner and outer contours are generated:

 l Constant: Generates a gradient based on the inner colour, gradating in 
transparency only. The inner contour will have the opacity of the inner colour, 
and will gradate towards full transparency towards the outer contour. 
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 l Linear 2 Colours: Creates a gradient that steadily gradates from the inner colour 
to the outer colour.

 l Gamma 2 Colours: Creates a gradient that gradates from the inner colour to the 
outer colour on a Gamma curve, the power of which can be set in the Colour 
Gamma field. For more information, see the Colour Gamma field section below. 

Colour Gamma

When the Colour Interpolation parameter is set to Gamma 2 Colours, use this field to 
enter the gamma power used to generate the gradient. By default, it is set to 1, creating 
a linear gradient. When set to any value between 0 and 1, the gradient will ease in from 
the inner colour to the outer colour. When set to any value above 1, the gradient will 
ease out from the inner colour to the outer colour. 

Inner Colour The colour used to fill the matte's inner contour. 

Outer Colour The colour used for the matter's outer contour. 
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NOTE 

If the Interpolation mode is set to None, this colour will fill the outer contour. 
Otherwise, it is used to create a gradient going from the inner contour to the 
outer contour.

NOTE 

If the Colour Interpolation parameter is set to Constant, this parameter is ignored 
and the outer colour will be set to the same colour as the inner colour, except 
with an alpha value of zero, making the matter a single solid colour with a 
transparency gradient. 

Alpha

Alpha Mapping

Determines the way the alpha between the inner contour and the outer contour is 
gradated:

 l Linear: Steadily gradates from the inner contour's alpha to the outer contour's 
aplha.

 l Gamma: Calculates the alpha going from the inner contour to the outer contour 
based on a Gamma curve, the power of which can be set in the Alpha Gamma 
field. For more information, see the Alpha Gamma field section below. 

Alpha Gamma

When the Colour Mapping parameter is set to Gamma, use this field to enter the 
gamma power used to calculate the alpha values in the gradient. By default, it is set to 
1, creating a linear alpha gradient. When set to any value between 0 and 1, the 
gradient's alpha values will ease in from the inner contour's alpha value to the outer 
contour's alpha value. When set to any value above 1, the alpha values of the gradient 
will ease out from the inner contour's alpha value to the outer contour's alpha value. 
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Burn-In Node

The Burn-In effect lets you add scene information which is visible in the Camera view. The information is 
displayed on top of any content in the scene. You can choose to display the scene name, timecode, frame count, 
environment and job, as well as add a frame offset if you need blank frames to precede the scene content. Also, 
to make the information more visible, you can also add a background and choose its colour, and customize the 
text font and alignment.

When you attach a Burn-In node to a Composite node, the burn-in information is rendered when you export 
the scene.

NOTE 

When you're working with 3D objects with a high Z position value, you may find the objects 
obscuring the scene information. To work around this, use a peg to ensure the burned in scene 
information is always visible.
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How to add burn in scene information

 1. In the Node Library, drag a Burn-In node to the Node view.

 2. Connect it to the Composite node.

 3. On the Burn-In node, click the square yellow properties button. 

The Burn-In property window displays.

 4. In the Show section, enter the following information:

‣ Frame Number: The frame number to start the burn-in information.

‣ Time code: The time code at which the burn-in information starts.

‣ Scene name: By default the scene name, environment and job information is display. Type the 
following to display specific types of information. 

Scene Name: %s

Environment: %e

Job: %j

‣ Frame Offset: Add lead-in frames before the scene begins or at a specific frame. Use positive 
values for frames that precede the scene content and negative values to start your scene 
information at a certain frame number.
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 5. In the Text section, customize the text that is displayed.

 6. In the Background section, add a background box to make the text more visible and then customize 
the colour.

Burn-In Properties

Parameter Description

Name Allows you to enter a name for the node.

Show

Frame Number Displays the number of the current frame.

Time Code Displays the time code of the current frame.

Scene Name

Lets you display different types of information, including the scene name, 
environment and job. You can display one or all of these pieces of information. 
To do so, type the following in the Scene Name field:

• Scene Name: %s

• Environment: %e

• Job: %j
You can rearrange the order in which the information is displayed. For example, 
you may want to see the job before the environment.

Frame Offset
Lets you add blank lead-in frames before the scene or somewhere in the scene. 
Use positive values for frames that precede the scene content and negative 
values to start your scene information at a certain frame number.

Text

Font Lets you select a font for the information displayed.

Alignment Lets you set the alignment of the text: Left, Center, Right.

Size Lets you set the size of the text.

Background
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Add Background Box
Adds a box behind the scene information which is useful when the scene 
contains colours or content that may make it difficult to read the scene 
information.

Colour

Red/Green/Blue/Alpha Lets you enter R, G, B and A values for the colour of the background box.

Colour Swatch
Opens the Colour Picker dialog, in which you can visually select a colour for the 
effect.
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Colour-Card Node
T-ANIMPA-012-001

The Colour Card allows you to fill the scene's background with a solid colour when there is no background 
image. If no drawing or colour-card is present to cover the scene's background, the scene will be rendered on a 
pitch black canvas.

NOTE 

By default, the Colour Card has a Z ordering value of 12 Backward. This puts the Colour card 
behind all elements that have a value lower than 12 Backward. Most of the time, the Colour card 
will appear automatically behind all the scene elements as they are all set to 0 Backward, unless 
you have changed the Z ordering of the scene components. If so, the Colour Card will be in front of 
the elements that are pushed back to more than 12 fields backward.

Connection

The Colour Card only needs to be connected to a composite, and does not require an input image. 
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It is recommended to connect your Colour Card to the right-most port of the Composite for coherence, but 
because a Colour Card has a default position on the z-axis of 12 Backward, it will appear behind all the 
elements in your scene regardless of where you connect it on the scene's composite. 

Optionally, a Colour Card can also be connected to a matte image. In this case, the Colour Card will only fill the 
shape of the matte with its colour, rather than the whole scene.

 

Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Depth
This parameter can be used to determine whether the colour card displays behind 
or in front of elements with the same position on the z-axis. Elements and 
Gradient nodes also have a depth parameter.
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Parameter Description

Offset Z

The position of the Colour Card on the Z-axis. By default, this is set to 12 B to 
ensure the Colour Card appears behind other elements in the scene. You can set 
this to 0 F to make the Colour Card respect the order in which nodes are 
connected to the composite.

Colour

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Invert Matte
If an image is connected to the Colour Card's matte port, by default, the colour is 
only applied on the opaque areas of the matte. If this parameter is enabled, the 
colour is applied to the transparent areas of the matte instead.
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Element / Drawing Node
The Element node is at the very core of a scene's structure. An element is a directory in which drawings are 
stored, which is associate to an Xsheet column indicating when and for how long each drawing is exposed, and 
which is in turn linked to a layer which indicates the position of the drawings in the scene. The Element node 
allows you to connect the element to effects, pegs and composites, determining how its drawings are 
processed and rendered. 

742



Connection
The Element node does not need an input image. It generates its output image from the drawings in its 
element and their exposure. Hence, it can be simply connected to a composite. 

Although Element nodes can be transformed and animated on their own, it is typical to connect their input 
port to a Peg. This allows you to keep the position and animation information of the element in a separate 
node, making it easier to manipulate the exposure and the transformations separately. This is especially useful 
in digital cut-out animation where manipulating and transforming layers is often the main method of 
simulating movement, and changing drawings is the secondary method. 

You can also connect an Element node to another Element node. Just like with pegs, any transformation done 
on the parent Element node, whether on itself or through one of its parents, will also be applied to the child 
Element node.

Optionally, you can connect a matte drawing to the left edge of an Element node. When an Element node is 
connected to a matte drawing, only the parts of the drawings that intersect with the opaque areas of the 
matte drawing will be rendered. This allows you to accomplish the same effect as connecting the Element 
node to a cutter node, without using an extra node. 
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Layer Properties

The drawing node's properties are organized in the following tabs:

 l Transformation Tab

 l Drawing Tab

 l Controls Tab

 l Line Thickness

 l Advanced Tab

Transformation Tab

The Transformation tab contains parameters for adjusting the position, scale, rotation, skew and pivots of an 
element.
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Parameter Description

Enable 3D
Allows the layer to be rotated and scaled in 3D. This means it can be rotated on 
the X and Y axes and scaled on the Z axis. 

Position

3D Path: Use a 3D path to position the element. A 3D path uses a single 
function to define the position on the X, Y and Z axes. This function is made of 
control points linked by a curvilinear path, making the movement follow a natural 
curve. The pace and ease of the movement is determined by a single velocity 
function.

Separate: Positions the element using separate functions for the X, Y and Z axes. 
This allows to control the direction and pace of the movement across all three 
axes separately. Unless ease is applied to the axes, the trajectory of the element 
will follow straight lines going between each keyframe.

Path: If the 3D Path option is selected, this field allows you to create or select 
the 3D Path function used to position the element.
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Path (x) Axis: The position of the element on the East-West axis, in fields.

Path (y) Axis: The position of the element on the South-North axis, in fields.

Path (z) Axis: The position of the element in the Back-Front axis, in fields. 

Velocity: If the 3D Path option is selected, this function is used to control the 
pace at which the element moves towards each control point in the 3D Path 
function, on all three axes simultaneously.

Scale

Locked: Uses a single scale parameter to scale the element, preserving its 
proportions.

Separate: Uses a separate parameter to scale the element on the X and Y axis, as 
well as on the Y axis if the element is 3D-enabled, allowing to stretch or squash 
the element. 

 

(x) Axis: The horizontal scale factor. The default value is 1.

(y) Axis: The vertical scale factor. The default value is 1.

(z) Axis: The depth scale factor for 3D-enabled elements. The default value is 1.

Scale in Fields: With this option enabled, the scale factor is based on the 
amount of fields in the scene. For example, to shrink one of the dimensions of an 
element to half its original size, the scale factor would normally bet set to  0.5. If 
this option is enabled and the amount of fields in the scene is 12, then the scale 
factor to shrink the element by half would be 6. 

Ignore Parent Scaling: When this option is enabled, scaling factors applied to a 
parent layer will not be applied to the current layer. This can be handy in cut-out 
rigs when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: The angle at which the element is rotated, based on the 360 degrees 
scale. Values below 0 or above 360 degrees will cause the rotation to cycle. 

Rotation (3D enabled)

Quaternion: Similar to a 3D Path, the Quaternion determines the angle of a 3D 
object using a single function. 

Euler Angles: Determines the angle of a 3D object by rotating it on the X, Y and Z 
axes using separate angles.

3D Rotation: If the Quaternion option is selected, this field allows you to create 
or select the Quaternion function used to rotate the element.

(x) Axis:  The angle at which the element is rotated on the horizontal axis.

(y) Axis: The angle at which the element is rotated at the vertical axis.

(z) Axis: The angle at which the element is rotated on the depth axis. 

Velocity: If the Quaternion option is selected, this function is used to control the 
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speed at which the element is rotated on all 3 axes.

Skew
Skew: The angle at which the element is skewed. This value can range from -90 
to 90 degrees. 

Pivot

(x) Axis: The horizontal position of the pivot point of the element relative to the 
pivot point of the drawing, in fields.

(y) Axis: The vertical position of the pivot point of the element relative to the 
pivot point of the drawing, in fields. 

NOTE 

These parameters can be changed visually by clicking and dragging the 
pivot point when using on of the tools in the Advanced Animation toolbar. 

Drawing Pivot

An element layer has two pivots:

 l The pivot of the element, which is set by the Pivot parameters above.

 l The pivot of the currently exposed drawing, which is set using the 
Drawing Pivot  tool. 

This preference is used to determine what to do with the pivot point of the 
currently exposed drawing:

 l Don't Use Embedded Pivot: Ignores the pivot point of the exposed 
drawing. The pivot point of the element is positioned using the Pivot 
parameters above, relative to the centre of the drawing. 

 l Apply Embedded Pivot on Parent Peg: Use the pivot point of the 
exposed drawing to determine the position of the pivot point of the parent 
peg of the drawing layer. This is useful when making a character rig 
where each element has a parent peg, and those parent pegs are intended 
to be used for animation. The pivot point of these parent pegs will be 
based on the pivot point set for the exposed drawing.

 l Apply Embedded Pivot on Drawing Layer: Use the pivot point of the 
drawing to determine the pivot point of the element. This means the pivot 
point is positioned using the Pivot parameters above, but relative to the 
pivot point of the drawing. 
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TIP 

The two latter options are useful when making a character rig where a 
layer can represent a body part from different angles. Since each angle is 
represented by a drawing, and each angle is liable to have a different 
pivot point, you can set the pivot point of each angle by using the Drawing 

Pivot  tool on each drawing. Then, if you want to animate the drawing 

layers directly, you can set this parameter to the Apply Embedded 
Pivot on Drawing Layer option, and if you want to animate using the 
parent pegs of the drawing layers, you can set this parameter to the 
Apply Embedded Pivot on Parent Peg option, so that these pivots 
are used when animating the different parts of the rigs. 

Drawing Tab

The Drawing tab contains parameters for element and timing columns, the art layers, bitmap images and the 
element's matte drawing.
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Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Synced Sub Element: If the layer is synced to another layer, this field displays 
the name of the layer's sub-element. A sub-element is an element stored inside 
another element for syncing layers. 

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: The path to the drawing file the element links to.

Timing Column: The name of the Xsheet timing column used for the layer's 
timing. 

Extension: The extension of the drawing file the element links to.  

Field Chart: The size of the field chart used for the drawings the element links to. 
This setting is useful when linking to traditional animation drawings. 
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Art Layers

These parameters allow you to set whether each art layer in the drawing layer is 
enabled, and whether they should contain vector or bitmap artwork. By default, 
options for the Line Art and Colour Art layers will be available. If the Enable 
Overlay and Underlay Arts preference is enabled, options for the Overlay Art and 
Underlay Art layers will also be available. 

Enabled: Determines whether the art layer is displayed.

Vector: Makes the art layer enabled for vector artwork, Vector drawing tools will 
be used to draw in this art layer, and vector artwork information will be 
preserved.

Bitmap: Makes the art layer enabled for bitmap artwork. Only bitmap-compatible 
drawing tools will be enabled when drawing on this layer, and all artwork will 
be rasterized into a bitmap image. 

Bitmap File Options

Colour: Determines whether or not the colours in the image is  processed. If 
unchecked, the image will be solid black. 

Transparency: Determines whether or not the transparency in the image is 
processed. If unchecked, the image will be fully opaque.

Transparency Type: If the layer contains bitmap images with a transparency 
channel, there are several approaches to rendering the image's transparency. You 
may need to select the proper transparency type to make sure Harmony renders 
the image as intended.  

 l Premultiplied with Black: Semi-transparent pixels in the original image 
are blended with black. 

 l Premultiplied with White: Semi-transparent pixels in the original image 
are blended with white. 

 l Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

 l Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so 
that a color value never exceed the alpha value for a given pixel. When 
the RGB values are multiplied with the alpha value, that is to say, if you 
have a pixel of value R=247, G=188, B=29 and the alpha is 50% or the 
image has a 50% transparency, then the actual RGB values output would 
be half of the amounts listed above.

Tile Horizontally: Repeats the bitmap image infinitely to the left and to the right 
of the layer. This can be useful for making looping backgrounds. 

Tile Vertically: Repeats the bitmap image infinitely to over and underneath the 
layer. This can be useful for making looping backgrounds.
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NOTE 

When both the Tile Horizontally and Tile Vertically options are used 
together, the bitmap image is tiled all over the scene. 

Matte

Invert Matte: If a drawing, composite or effect is connected to the drawing's 
matte input port, the part of the drawing that intersect with the matte's opaque 
areas will be cut out by default. If this parameter is enabled, the part of the 
drawing that intersect with the matte's transparent areas will be cut out instead. 

Colour Space

Colour Space: The colour space in which the element’s colours should be 
interpreted. If the element’s colour space is different from the project colour 
space, then the element’s colours will be converted from the element’s colour 
space to the project’s colour space as they are processed, before being 
composited together with the scene’s special effects.

 l Undefined Colour Space: No colour space is defined for the drawing. 
The drawing’s colours will be interpreted as if they were the same colour 
space the one selected in the Colour Space tab of the Scene Settings 
dialog. 

 l Linear: The same primaries and white point as sRGB and Rec. 709, but 
with no gamma transfer curve applied to the colour values. This colour 
space is useful for compositing intermediary images that are meant to be 
rendered in sRGB or Rec. 709.

 l Display P3: A colour space commonly used for digital projection. It has 
the same primaries as DCI-P3, the same white point as sRGB and the 
same gamma transfer curve as sRGB.

 l Display P3 Linear: The same as Display P3, except with no gamma 
transfer curve. This colour space is useful for compositing intermediary 
images that are meant to be rendered in Display P3.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and 
white point as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a 
gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
of the standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It 
has a complex gamma transfer curve and primaries that cover more of the 
human-perceivable colour space than other colour spaces, especially in 
the area of human-perceivable greens. 

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple 
gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
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of the standard gamma curve for Rec. 2020.

 l Rec. 2020 Linear: The same colour space as Rec. 2020, except with no 
gamma transfer curve. This colour space is useful for compositing 
intermediary images that are meant to be rendered in Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It 
has the same primaries and white point as Rec. 709, but has a different 
gamma transfer curve.

NOTE 

In the  OpenGL View mode of the Camera view, the colour space of 
drawing layers is ignored and only the colour space of original bitmap files 
is taken in account. To test the colours of your drawing in their selected 

colour space, you must activate  Render View mode. 

Controls Tab

The Controls tab contains animation control options.

Parameter Description

Animation

Animate Using Animation Tools: By default, a drawing layer can be animated 
directly, as if it was its own peg. If you disable this option, it will only be 
possible to animate the layer using its parent peg. If the layer has no parent peg, 
it will be immutable. 

This can be useful if you want to create cut-out character rigs that should only be 
animated using pegs, which can help separate the drawing exposure from the 
transformations on the drawings. If every drawing layer in a character rig has this 
option disabled, only layers that have a parent peg will be animatable, and the 
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animator will only be able to animate on the pegs. This also rules out the 
possibility of accidentally animating an element directly and using its parent peg 
concurrently. 

When this option is disabled, clicking on the drawing layer in the Camera view 
with the Transform tool will automatically select the layer's parent peg. 

Angle Limit Values

Lets you set a maximum and minimum rotation angle for a drawing. This option is 
used mainly for a cut-out character when you do not want an elbow to bend too 
far in or out. 

Enable Min/Max Angle: Activates the minimum and maximum angle constraints. 

Min Angle: The minimum rotation angle for the element.  

Max Angle: The maximum rotation angle for the element.

Spline Offset

If the layer's controls are displayed, you can see its animation trajectory in the 
Camera view. This is referred to as the spline. By default, the position of each 
point in the spline is based on the element's pivot point. However, you can use 
the spline offset to give it a more fitting position if desired. You can do this by 
using the Spline Offset tool of the Advanced Animation toolbar, or by manually 
entering the offset values in the Spline Offset fields.

(x) Axis: The horizontal offset of the spline, in fields.

(y) Axis: The vertical offset of the spline, in fields.

(z) Axis: The depth offset of the spline, in fields.

TIP 

To display the animation trajectory of the layer in the Camera view, select 
the layer, then do one of the following:        

 l In the Camera toolbar, click on Show Control .

 l From the top menu, select View > Show > Control. 

 l Press Shift + F11 (Windows/Linux) or ⌘  + F11 (macOS).

Line Thickness

The Line Thickness tab contains options regarding the way pencil lines in the element are rendered. These 
options can be very useful to enhance the quality of line art without having to work on it. 
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Parameter Description

Line Thickness

Adjust Pencil Lines Thickness: Enables the options below to adjust the line 
thickness in the rendered image. 

Normal Thickness:  This setting makes the line thickness adjustments take one 
of two very different behaviors:

 l Enabled: The line thickness settings are applied to pencil lines in all art 
layers in the element. This setting should be used if you want to adjust 
the line thickness of pencil lines. 

 l Disabled: The line thickness settings are applied to all art, whether brush 
strokes or pencil lines, in the line art layer, so that it fits the desired 
thickness pattern around art in the colour art layer. This setting should be 
used for drawings that have their line art on the line art layer and their 
colour art on the colour art layer, which is typical of traditional and 
paperless animation productions. 

NOTE 

When this option is disabled, all artwork in the line art layer that 
does not surround artwork in the colour art layer will be cropped 
out.

Zoom Independent Thickness: Makes the thickness of pencil lines remain 
unchanged when the camera zooms in or zooms out. 

Proportional: The factor by which to adjust line thickness. The original line 
thickness in the drawing will be multiplied by this value. A value between 0 and 
1 can be used to make pencil lines thinner. 

Constant:  The offset by which to adjust line thickness. This value will be added 
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to the original line thickness in the drawing. A negative number can be entered to 
make pencil lines thinner. 

Minimum: The minimum pencil line thickness allowed. Line thickness will not go 
below this value.

Maximum: The maximum pencil line thickness allowed. Line thickness will not 
go above this value. Set it to 0 to disable maximum line thickness.

Deformation

Pencil Lines Quality: The quality of the rendered pencil lines when deformed by 
deformation chains. Increasing this parameter is unlikely to wield noticeable 
result unless rendering in very high resolutions. 

Preserve Line Thickness: If this option is checked, the thickness of pencil lines 
will not be affected by deformations. Only their directions will be affected. Also, 
if a pencil line is textured, it will not be stretched or squashed by deformations. 

NOTE 

This setting must be enabled for the Pencil Lines Smoothing and Fit Error 
parameters to be available.

Pencil Lines Smoothing: The smoothing factor applied to pencil lines when 
rendering. This value can range from 0 to 10. The higher it is, the more corners 
and points will appear smoothed out.

Fit Error: When this parameter is increased, pencil lines in the rendered image 
will have less vector points and the curves between the remaining vector points 
will be adjusted to fit the original shape. This setting can be increased if the 
amount of details and points in the pencil lines creates problems around 
deformation articulations and corners. Its value can range from 1 to 100. 

NOTE 

The Fit Error parameter will have no effect if the Pencil Lines Smoothing 
parameter is set to 0.

Advanced Tab 

The Advanced tab contains options for setting the alignment of drawings, clipping, line thickness, vector 
render options, and more.
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Parameter Description

Alignment

Alignment Rule: The alignment rule selections are intended to deal with 
drawings that were created on paper of a different size or orientation from the 
default alignment rule (set up in the Scene Settings dialog box) or imported 
bitmap images. The drawings are then scaled to match the Harmony alignment 
rectangle. Note that alignment rules are not based on the camera frame, but on 
the scene frame. Refer to the Fundamentals Guide to learn more about scene 
alignment and scene settings.

 l Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

 l Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

 l Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

 l Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.

 l Centre Fit: Centers the drawings.

 l Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.
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 l Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the 
height of the alignment rectangle of the scene.

 l Centre TB: Aligns the drawings in the top-bottom centre of the 
alignment rectangle. Harmony scales the drawings to match their widths 
to the width of the alignment rectangle of the scene.

 l Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear 
on the corners of the image, making it difficult to manipulate the 
quadmap. In this case, you would set the drawing layer of the quadmap 
images to Stretch to make the handles appear on the corner of the image. 
This can have the effect of distorting the images, but it is not an issue 
with images that will be distorted through the Quadmap node anyways.

 l As Is: Leaves the drawings aligned as they are. 

 l Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on 
paper of a different size or orientation than the other paper in the scene, and 
requires alignment  so they are treated accurately.

Flip Horizontal: Flips the drawing on the horizontal axis.

Flip Vertical: Flips the drawing on the vertical axis.

Clipping

No Clipping: By default, when using the Apply-Image-Transformation node on a 
bitmap layer, the image is clipped by the camera frame before the transformation. 
This can cause the resulting image to appear cropped if the peg connected to the 
Apply-Image-Transformation node brings the element from outside of the camera 
frame, or shrinks it. Enable this option to avoid clipping the image—see Apply 
Image Transformation Node on page 811.

NOTE 

In the great majority of cases, it is recommended to use an Apply-Peg-
Transformation node instead to avoid clipping—see Apply Peg 
Transformation Node on page 814. 
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Clipping Factor (X): This parameter would extend the horizontal clipping area of 
vector drawings before effects are applied to it. Using this parameter is no longer 
required as Harmony manages the clipping areas of vector drawings 
automatically, and is only made available for legacy support.

Clipping Factor (Y): This parameter would extend the vertical clipping area of 
vector drawings before effects are applied to it. Using this parameter is no longer 
required as Harmony manages the clipping areas of vector drawings 
automatically, and is only made available for legacy support.

Vector Render Options

Antialiasing Quality: The smoothness (antialiasing) setting used to make the 
crisp vector contours appear smooth. 

 l None - No Transparency: Dsables antialiasing, renders semi-transparent 
pixels either fully opaque or fully transparent, and fills single-pixel gaps 
with an opaque pixel to avoid generating out-of-place gaps when lines 
intersect each other.

 l Low: Disables antialiasing, but renders transparency. 

 l Medium Low: Renders vector artwork with basic antialiasing.

 l Medium: Renders vector shapes with improved antialiasing. Bitmap 
texture fills will appear blurred.

 l High: Renders vector shapes with improved antialiasing, without blurring 
bitmap texture fills.

TIP 

It is recommended to leave this setting to High unless you are working on 
a pencil test, or another type of scene where rendering speed is more 
important than rendering quality.

TIP 

If the production requires exporting line art without antialiasing to colour 
them in a third-party software, it is recommended to use the None - No 
Transparency setting. This setting automatically fills one-pixel gaps 
created by crisp lines intersecting each other, which would otherwise need 
to be filled manually in the third-party software.

Antialiasing Exponent: Determines how much the artwork is scaled up to apply 
antialiasing onto it. A higher value will results in sharper edges, and a lower 
value will result in softer edges. Typical values range between 0 and 3. Higher 
values may be attempted but may result in overly crisp outlines. Negative values 
will cause the outlines to appear blurry.

Texture Filter: This setting determines how textures in the element are 
resampled when rendering:
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 l Bilinear: This option takes the four pixels around each point and makes a 
bilinear interpolation between them, which may make them look blurry. 

 l Nearest: When sampling the texture up, this option generates extra 
pixels by using the colour of the nearest defined pixel. When sampling 
the texture down, this option simply removes pixels from the texture. 

 l Nearest (Filtered): This option is similar to Nearest, but it adds an extra 
layer of resampling to make all pixels look like they are the same size. 

Miscellaneous

Depth:  Overrides the order of cables in the node system to determine the 
forward/backward order in which this element is rendered. The Z position value 
overrides the depth value.

Morphing Velocity: When morphing drawings in the element using the 
Morphing tool, this parameter can be used to create or select the velocity 
function used to determine the pace of the morphing animation.

Opacity: Lets you quickly change the transparency of the selected element. 
Opacity settings here will be reflected in both OpenGL preview, and full render.
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Field Chart Node

The Field Chart node displays a traditional animation field chart, which allows you to position elements in the 
Camera view. The Field Chart node doesn't export. If you want to export a field chart, use the Grid node—see 
Grid Node on page 771.
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Field Chart Properties

Parameter Description

Name Allows you to change the name given to the node.

Drawing

Size
Adjusts the number of units in the grid (field chart). The grid size will always be a 
4:3 ratio, as per traditional animation standards. The gird is available in 12 or 16 
fields.

Opaque
Inserts  a white background behind the grid and covers everything else behind it. 
By default, you can see through the grid.

Antialiasing

Antialiasing Quality: The smoothness (antialiasing) setting used to make the 
crisp vector contours appear smooth. 

 l None - No Transparency: Dsables antialiasing, renders semi-transparent 
pixels either fully opaque or fully transparent, and fills single-pixel gaps 
with an opaque pixel to avoid generating out-of-place gaps when lines 
intersect each other.

 l Low: Disables antialiasing, but renders transparency. 

 l Medium Low: Renders vector artwork with basic antialiasing.

 l Medium: Renders vector shapes with improved antialiasing. Bitmap 
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texture fills will appear blurred.

 l High: Renders vector shapes with improved antialiasing, without blurring 
bitmap texture fills.

TIP 

It is recommended to leave this setting to High unless you are working on 
a pencil test, or another type of scene where rendering speed is more 
important than rendering quality.

TIP 

If the production requires exporting line art without antialiasing to colour 
them in a third-party software, it is recommended to use the None - No 
Transparency setting. This setting automatically fills one-pixel gaps 
created by crisp lines intersecting each other, which would otherwise need 
to be filled manually in the third-party software.

Antialiasing Exponent: Determines how much the artwork is scaled up to apply 
antialiasing onto it. A higher value will results in sharper edges, and a lower 
value will result in softer edges. Typical values range between 0 and 3. Higher 
values may be attempted but may result in overly crisp outlines. Negative values 
will cause the outlines to appear blurry.

Alignment Rule

The alignment rule selections are intended to deal with drawings that were 
created on paper of a different size or orientation from the default alignment rule 
(set up in the Scene Settings dialog box) or imported bitmap images. The 
drawings are then scaled to match the Harmony alignment rectangle. Note that 
alignment rules are not based on the camera frame, but on the scene frame. Refer 
to the Fundamentals Guide to learn more about scene alignment and scene 
settings.

 l Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

 l Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

 l Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

 l Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.

 l Centre Fit: Centers the drawings.
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 l Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.

 l Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the 
height of the alignment rectangle of the scene.

 l Centre TB: Aligns the drawings in the top-bottom centre of the 
alignment rectangle. Harmony scales the drawings to match their widths 
to the width of the alignment rectangle of the scene.

 l Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear 
on the corners of the image, making it difficult to manipulate the 
quadmap. In this case, you would set the drawing layer of the quadmap 
images to Stretch to make the handles appear on the corner of the image. 
This can have the effect of distorting the images, but it is not an issue 
with images that will be distorted through the Quadmap node anyways.

 l As Is: Leaves the drawings aligned as they are. 

 l Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on 
paper of a different size or orientation than the other paper in the scene, and 
requires alignment  so they are treated accurately.

Depth
Overrides the order of cables in the node system to determine the 
forward/backward order in which this element is rendered. The Z position value 
overrides the depth value.

Position

Animate Using Animation 
Tools

By default, the grid can be animated using the same parameters as a peg, but you 
can disable this feature so the field chart remains in place. You can connect it to a 
peg to animate it or move it.

When  this option is deselected, you cannot move the layer in the Camera view 
using the Transform and Advanced tools. This prevents you from accidentally 
displacing or modifying a layer.

763

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Position

3D Path: Use a 3D path to position the element. A 3D path uses a single 
function to define the position on the X, Y and Z axes. This function is made of 
control points linked by a curvilinear path, making the movement follow a natural 
curve. The pace and ease of the movement is determined by a single velocity 
function.

Separate: Positions the element using separate functions for the X, Y and Z axes. 
This allows to control the direction and pace of the movement across all three 
axes separately. Unless ease is applied to the axes, the trajectory of the element 
will follow straight lines going between each keyframe.

Path: If the 3D Path option is selected, this field allows you to create or select 
the 3D Path function used to position the element.

Path (x) Axis: The position of the element on the East-West axis, in fields.

Path (y) Axis: The position of the element on the South-North axis, in fields.

Path (z) Axis: The position of the element in the Back-Front axis, in fields. 

Velocity: If the 3D Path option is selected, this function is used to control the 
pace at which the element moves towards each control point in the 3D Path 
function, on all three axes simultaneously.

Scale

Locked: Uses a single scale parameter to scale the element, preserving its 
proportions.

Separate: Uses a separate parameter to scale the element on the X and Y axis, as 
well as on the Y axis if the element is 3D-enabled, allowing to stretch or squash 
the element. 

(x) Axis: The horizontal scale factor. The default value is 1.

(y) Axis: The vertical scale factor. The default value is 1.

(z) Axis: The depth scale factor for 3D-enabled elements. The default value is 1.

Scale in Fields: With this option enabled, the scale factor is based on the 
amount of fields in the scene. For example, to shrink one of the dimensions of an 
element to half its original size, the scale factor would normally bet set to  0.5. If 
this option is enabled and the amount of fields in the scene is 12, then the scale 
factor to shrink the element by half would be 6. 

Angle Z
Lets you  type in a degree value for the rotation angle. Note that you can enter 
values greater than 360 and -360 degrees. If you enter 720, the object will rotate 
twice.

Pivot

(x) Axis: The horizontal position of the pivot point of the element relative to the 
pivot point of the drawing, in fields.

(y) Axis: The vertical position of the pivot point of the element relative to the 
pivot point of the drawing, in fields. 
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Gradient Node
The Gradient node is similar to a Colour Card in which it fills all of the space in the stage, except that instead of 
filling it with a solid colour, it fills it with a configurable gradient. A gradient is a colour that tapers into another 
colour. The Gradient node can generate linear or radial gradient, between colours with or without 
transparency. The colours as well as the start and end points of the gradient in the stage can be configured 
and animated. 

The Gradient node covers the entire camera frame and beyond. You do not need to scale it up or down. It will 
automatically cover an infinite zone. You simply need to connect it behind your scene's elements. You can 
connect it in front of some elements you want to cover. By default, the Gradient has a Z ordering value of 0. 
When you select the Gradient node, the Camera view displays yellow triangles to indicate that it's selected.

Connection

Being a generator, the Gradient node does not need an input image. It generates a gradient on its own, based 
on its parameters alone.

Just like Element nodes, Gradient nodes can be hooked to a peg, allowing you to easily move, rotate, scale and 
animate the gradient.
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Optionally, the Gradient node can be connected to a matte image. In this case, the gradient will only be 
applied over the opaque areas of the matte. 

Controls

If you want to control the gradient's orientation and points position in the Camera view, you can use the 
Control command to display the points and move them.

How to control the gradient in the Camera view

 1. In the Tools toolbar, select the Transform  tool.

 2. In the Timeline or Node view, select the Gradient node.

 3. Do one of the following:

 l In the Camera toolbar, click on the Show Control  button.

 l From the top menu, select View > Show > Control.

The starting and ending points of the gradient will appear in the Camera view, like so:

 4. Click and drag on one of the points to change its position. 
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Layer Properties

Use the Gradient property editor to modify the values of the gradient and the position of its output.

Parameter Description

Gradient Type

Allows you to select between the following types of gradient:

 l Linear: Lines of colour are drawn perpendicular to the axis between point 
0 and point 1. 
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 l Radial: Circles of colour are drawn with point 0 as their center, with a ray 
progressing between point 0 and point 1. 

Point 0

Colour

The colour of point 0. The gradient will start with this colour and taper to the 
colour of point 1. 

 l Red: The value of red in the colour.

 l Green: The value of green in the colour.

 l Blue: The value of blue in the colour.

 l Alpha: The opacity of the colour. 

Position 0

The position of point 0 in the stage. The gradient will start from this position and 
end at the position of point 1.

If you want to animate the point, you can choose which type of function to use to 
store the animation.
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 l 2D Path: The horizontal and vertical position are on the same function. 
This makes the point move in a curvilinear trajectory between each 
keyframe. 

 l Separate: The horizontal and vertical position are on separate functions. 
This makes the point move in a straight line between each keyframe and it 
allows you to modulate the trajectory differently on each axis. 

(x) Axis The position of point 0 on the x-axis.

(z) Axis The position of point 0 on the y-axis.

Point 1

Colour

The colour of point 1. The gradient will start with the colour in point 0 and taper 
to this colour. 

 l Red: The value of red in the colour.

 l Green: The value of green in the colour.

 l Blue: The value of blue in the colour.

 l Alpha: The opacity of the colour. 

Position 1

The position of point 1 in the stage. The gradient will start from the position of 
point 0 and end in this position.

If you want to animate the point, you can choose which type of function to use to 
store the animation.

 l 2D Path: The horizontal and vertical position are on the same function. 
This makes the point move in a curvilinear trajectory between each 
keyframe. 

 l Separate: The horizontal and vertical position are on separate functions. 
This makes the point move in a straight line between each keyframe and it 
allows you to modulate the trajectory differently on each axis. 

(x) Axis The position of point 1 on the x-axis.

(z) Axis The position of point 1 on the y-axis.

Position

Offset Z The position of the Gradient layer on the z-axis. 
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Depth
This parameter can be used to determine whether the gradient displays behind or 
in front of elements with the same position on the z-axis. Elements and Colour 
Cards also have a depth parameter.

Matte

Invert Matte
If an image is connected to the Gradient node's matte port, by default, the 
gradient is only applied on the opaque areas of the matte. If this parameter is 
enabled, the gradient is applied to the transparent areas of the matte instead.
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Grid Node

The Grid node displays a grid, in field chart unit, which allows you to position elements in the Camera view.
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Grid Properties

Parameter Description

Name Allows you to change the name given to the node.

Size

Adjusts the amount of units in the grid (field chart). The grid size will always be a 
4:3 ratio, as per traditional animation standards, but will adjust the camera frame 
width. You can change the grid to adjust to the camera frame by deselecting the 
Fit Vertical option.
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Aspect

The grid size default format is 4:3 ratio, as per traditional animation standards, 
but will adjust the camera frame width. You can change the grid ratio by entering 
a new ratio. To find your scene ratio, select Scene > Scene Settings.

Fit Vertical

Makes the grid size adjust the camera width or height.

Display Text Turns the display of numbers on or off.

Fill
Makes the grid's background opaque. Nothing behind will be shown. You can 
also click on the colour swatch to open the Colour Picker window and select a 
background colour.

RGBA
The colour and alpha values of the corresponding point. You can also click on 
the colour swatch to open the Colour Picker window and select a grid or 
background colour. Default values: 0,0,0 and 255, 255, 255.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.
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Lens Flare Node

The Lens Flare effect simulates the refraction caused by shining a bright light into a camera lens. The shape of 
the lens flare can be circular or hexagonal.

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Here is how a typical lens flare can be set up:
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Lens Flare Properties 

Parameter Description

Flares
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Flare Type

Custom: Lets you use your own custom art or drawing.

Type 1: Circular lens flare.

Type 2: Hexagonal lens flare.

Blend Mode: Normal/Screen

Lets you apply a normal or screen blending mode to the image.

Normal: When selected, this operation will not create any blending mode effect.

Screen: When deselected, this operation multiplies the inverted colour of the 
blending element with the image. This lightens the colour of the overlapping 
area. Screen is the default blending mode.

Position X, Y, Z Lets you precisely orient the flare in the x, y, and z axes.

Brightness

Intensity The strength of the lens flare.

Red Red values of the image.

Green Green values of the image.

Blue Blue values of the image.

Alpha Alpha values of the image.

Colour Swatch Opens the Colour Picker where you can specify the colour of the main flare.

Flare 1–10
Lets you create custom lens flares by associating them with specific drawings. 
You can create up to 10 different flares.

 

Drawing: Lets you specify a drawing to use for the flare.

Position: The position of the flare. 

Size: The size of the flare.

Blur Intensity: The strength of the flare.
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Turbulent Noise Node

The Turbulent Noise effect uses Perlin noise to create greyscale noise for organic-looking backgrounds, 
displacement maps and textures. Among other things, it can be used to simulate fluid effects like clouds, fire, 
lava, steam, flowing water, or vapour. The Turbulent Noise effect models turbulent systems with smaller noise 
features moving more quickly than larger noise features.  The Turbulent Noise effect creates smooth animations 
and takes less time to render than other noise or grain effects. 

For detailed video tutorials and sample scenes by Adam Phillips, see:

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects

Connection

Being a generator, the Turbulent Noise node does not require an input image. It generates noise using its Layer 
Properties. However, its default settings will only output solid black. 

The Turbulent Noise node can be hooked to a peg, allowing you to transform and animate the effect. 
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NOTE 

In the example above, it is hooked to a Quadmap to simulate a perspective effect.

Optionally, a Turbulent Noise node can also be connected to a matte image. In this case, the noise will only fill 
the shape of the matte. 

Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 
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Parameter Description

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Noise Type

The algorithm used to generate the noise:

 l Perlin: Creates pseudo random patterns. The greyscale contains a 
continuity between different tones of grey.

 l Simplex: Creates a more contrasted noise pattern with more variation 
than Perlin. There is a smooth variation of intensity.

 l Sinusoidal: Creates a repeated wavelike pattern.

 l Sub Scaling: Applies Perlin noise twice. The second noise is added 
where dark areas appear in the original. The frequency of the second 
iteration is higher so the noise is smaller.

 l Rocky: Uses the Perlin pattern but converts the very high and low values 
to more moderate values. For example, the whites become light greys and 
the blacks become dark greys.

 l Small Bumps: Uses the Perlin pattern. The transitional grey areas 
between blacks and whites become inverted so they look like dark lines. 
The extremes, black and white areas, become whitish.

Frequency
The density of displacement appearing in the noise. A higher value produces a 
greater amount of displacement in a given area; a lower value produces a smaller 
amount.

Offset Moves the entire image.

Locked Applies parameter value while retaining the X and Y ratio.

Separate Allows you to apply different parameter values to X and Y.

xy
When locked, applies parameter values to both X and Y. When separated, allows 
you to apply different value to X and Y.

Evolution Determines the displacement pattern over time.
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Parameter Description

Evolution Frequency  
This factor makes the complexity iterations animate or transform at a higher 
speed. In other words, the second, third, etc. passes, controlled by the 
Complexity parameter, will mutate faster than the main one.

Complexity

The number of noise layers that make up the noise. Each successive layer has a 
higher frequency, resulting in a smaller noise effect. You can have up to seven 
passes. Increasing this number increases the depth and amount of detail in the 
noise. Use Complexity with Sub Scaling when the value is 1 or greater. 

NOTE 

Increasing the Complexity results in longer rendering times. 

Gain

Controls the amount of opacity present in the iteration of noise. This also affects 
the layer when using Sub Scaling. With a value of 0, you will not see the sub 
noise. A value of 1 will show the sub noise just as strong as the main one. For 
example, with water ripples, a higher amount of Gain will reveal more ripple or 
subripples.

Sub Scaling:

The factor by which the main noise is modified at each iteration of complexity. A 
value of 1 make the two noises identical. A value of 2 makes the sub noise twice 
as small. The next iteration would be 4 times smaller. Values must be greater 
than 1.

Depth 
This value determines the composition order when the Z value of two elements is 
the same.

Matte

Invert Matte
If the Turbulent Noise node is connected to a matte image, by default, the noise 
will only fill the opaque areas of the matte. If this parameter is enabled, the noise 
will fill the transparent areas of the matte instead.
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Group Nodes
The nodes found in the group category are used to organize the Node view by grouping nodes and providing 
input and output ports for these groups.

Group Node 782

Multi-Port-In Node 783

Multi-Port-Out Node 784
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Group Node
The Group node is the node containing all the layers in a group. In the Timeline view, a Group node appears as 
a layer that you can expand or collapse to display or hide the layers it contains in the layer list. In the Node 
view, a Group appears as a node that can be entered by clicking on the arrow in the right end of the node. 
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Multi-Port-In Node
A Multi-Port-In node is added by default in a new Group node. Use it to add one or more input ports to the 
Group node so that you can process an image through the nodes in the Group node. 

When you plug an element to a Multi-Port-In node, an input port appears at the top of the Group node. You 
can add additional ports to the nodes as needed.

Pass your cursor over the Group node input port to see the name of the Port Image In node that it connects to. 
You will notice that the Group node in these examples has no output port. It requires a Multi-Port-Out node to 
output data from its network.

A Multi-Port-In is automatically added when you create a group.

Use the Multi-Port-In editor to rename the node.
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Multi-Port-Out Node
A Multi-Port-Out node is added in a new Group node by default. Use it to add output ports to the Group node 
so that you can output the result of the group operation to the rest of the network. After you plug an element 
to a Multi-Port-Out node, an output port appears on the bottom of your Group node. You can add additional 
output ports as needed.

A Multi-Port-Out is automatically added when you create a group.

Use the Multi-Port-Out editor to rename the node in the network.
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Miscellaneous Nodes
The nodes found in the Miscellaneous category are various nodes used to either add notes to the Node view, 
use external scripts or previous and hide elements in OpenGL and Render view.

External Node 786

Master Controller Node 789

Note Node 795

OpenGL Bypass Node 796

OpenGL-Cache-Lock Node 798

Pre-Render Cache Node 801

Connection 802

Render Preview Node 805

Script Node 806

Visibility Node 809
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External Node
Use the External node to process images through external programs and input the resulting images back into 
the network. Note that not all programs work with the External node.

Using the External node lets you avoid having to export your animation to another software to do some 
processing over it and then bringing it back to Harmony. This way, you can modify your scene and animation as 
much as you want and still use the effects or render process from a third-party software.

NOTE 

Harmony also supports OpenFX plugins.

The External node writes input files to temporary files on the system. It then calls the external program, which 
will process the input images. If two images are input into the node, the program must composite them 
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together to produce one output image. Finally, the file produced by the external program is read back into the 
network.

The command is sent to the external program in the following format:

program_name file_1 file_2 output_file numerical_param extension

Use the External editor to control the program that is launched by the node, the files that it reads, and the file 
that it outputs into the network.

In this example, the ImageMagick 6.3 software was used without a matte connection.

Use the External editor to write down the parameters matching the chosen external program.

External Properties

Parameter Description

External Program
The name of the program launched by the External node. This field can include a 
full or relative path to the executable file. If no path is entered, the user's path is 
searched to locate the program.
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Enter the command directly into this field. 

For example:

mogrify -spread $NUM $IN1

Where:

mogrify: Is the name of the program

spread: Is the option to be applied, 

$NUM and $IN1: Are the numerical parameter and first input file variable declared 
in the External node.

Program First Input File 
($IN1)

The name and location of the temporary file that Harmony will write to the file 
system for the external program to read. It must not include the dot or the 
extension; the External node will add these based on the Extension field.

Program Second Input File 
($IN2)

When processing two files through this node (such as an image and a matte), 
this is the name and location of the second temporary file that Harmony writes to 
the file system for the external program to read. It must not include the dot or the 
extension; the External node will add these based on the Extension field.

Program Output File ($OUT)
The name and location of the temporary file that the external program will write 
to the file system so that Harmony can read it back into the network.

Extension ($EXT) The file type that will be processed by the external program.

Numerical Parameter($NUM)
A value passed to the external program as a file processing option. It can be 
attached to a function curve to change over time.

The program files are temporary files that are overwritten at each frame as the node is executed. They are only meant 
to temporarily store the image that is being processed at each frame.

Generate Unique FileNames

If this option is enabled, the temporary output file will have a unique 
identification number added to its name to avoid any file override if another scene 
or External script is rendered at the same time. It could be possible to have an 
override when two scenes using the External nodes are rendered in batch 
processing.
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Master Controller Node
The master controller node is a special kind of script node that allows you to create visual widgets that you can 
display in the Camera view, and script to programmatically affect a character rig when manipulated by the 
user. 

For information and examples on how to use the Master Controller node, refer to the Master Controller sub-
section of the Rigging chapter of the User Guide.

Connection

The Master Controller does not need to be connected to a node in order to work, unless it is scripted to affect 
nodes that are connected to it. 

If a Master Controller is connected to a node, the node system it is connected to should ultimately end up 
connected to a Display node in order for the Master Controller to work.

If you configure the Master Controller's first (rightmost) input port to be a transformation (peg) input port, you 
can connect a peg to the Master Controller, and use this peg to move its widget around in the Camera view, 
allowing you to easily set the widget's default position in the scene.
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IMPORTANT 

A Master Controller node must have at least one output port to function, even if this port is not 
connected to anything.

Controls

The Master Controller can be scripted to display any one of the following kinds of controls in the Camera view:

Control Appearance Description

Slider
A slider that allows the user to slide a handle up or down. When manipulated, it 
provides a value between its minimum and maximum values. 

2D Line 
Display

Displays a line going between two 2D Point widgets, make a "bone" type 
manipulator that can be moved by either end.

2D Point
A point that the user can freely drag around the stage. When manipulated, it 
provides its position.

3D 
Rotation

A 3D sphere that the user can rotate in all directions. When manipulated, it 
provides an object with a rotation angle for each axis. 
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Control Appearance Description

X Rotation
A circle that can be rotated around the x-axis. When manipulated, it provides a 
rotation angle.

Y Rotation
A circle that can be rotated around the y-axis. When manipulated, it provides a 
rotation angle.

Z Rotation
A circle that can be rotated around the z-axis. When manipulated, it provides a 
rotation angle.

X 
Translation

An arrow that can be dragged along the x-axis. When manipulated, it provides 
an offset.

Y 
Translation

An arrow that can be dragged along the y-axis. When manipulated, it provides 
an offset.
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Control Appearance Description

Z 
Translation

An arrow that can be dragged along the z-axis. When manipulated, it provides 
an offset.

Scripting Interface

To access the scripting interface reference, open the Script Editor view. Then, open the  View Menu and 
select Help > Scripting Interface Documentation.

Layer Properties

The Master Controller node is essentially a Script node with an extra layer of functionality in its scripting 
interface. Hence, its layer properties are very similar to that of the Script node. However, its most important tab 
is the UI Script tab. The script in this tab is executed when the layer is selected and the user clicks on the  
Show Control button in the Camera toolbar. This is where you can define which widget the node displays, and 
what happens when the user manipulates the widget.

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.
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Parameter Description

Tabs

Attributes
This tab allows you to set values for the attributes defined in the Specifications 
tab.  

Specifications

This tab allows you to define the attributes as well as the input and output ports 
for the Master Controller. 

The Master Controller supports the following types of attributes:

 l bool

 l int

 l double

 l String

 l Text

 l Colour

 l Position2d

 l Position3d

The Master Controller supports the following types of ports:

 l Image

 l Peg

Softrender

This tab allows you to write or link to a script that will be executed when 
rendering the node. 

NOTE 

Scripts in this tab are ignored by the Master Controller node. The 
Softrender tab is only executed by Script nodes. 

Initialization
This tab allows you to write or link to a script that will be executed when loading 
the scene.

Cleanup
This tab allows you to write or link to a script that will be executed when closing 
the scene.

UI Script This tab allows you to write or link to a script that will be executed when using 
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Parameter Description

the Show Control command while the node is selected. This is where widgets 
and their functionalities should be defined. 

Extra Files

This tab allows you to define folders or files from root directory of the scene that 
should be preserved when creating templates or saving the scene in a different 
location. Any asset, such as external scripts, user interface files, data files or 
images that the Master Controller requires should be listed in this tab.

NOTES 

 l To add Extra Files to the Extra Files attribute, click on the 
Function button right of the Extra Files field to create the Extra 
Files attribute, then click on it again to open a dialog box in 
which you can type the file path of each file or folder that you 
want to copy with the Master Controller, with one file path per 
line. 

 l File paths must use forward slashes (/) and must be relative to 
the scene directory. They can point to files or folders. For 
example, if you want to copy everything in the scripts sub-
directory of your scene with your Master Controller, you can 
simply add scripts to the list. 
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Note Node
The Note node allows you to record any textual information that is relevant to your project. You can add 
comments, suggestions or reminders. You can add Note nodes anywhere in the network, including groups.
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OpenGL Bypass Node
The OpenGL Bypass node can be used to define what is displayed in the OpenGL preview of the Camera view 
separately from what appears in the final rendered image. This can be used to help with performance when 
working on a scene or during playback. The OpenGL preview can be made to only display elements that are 
important to the animator as they are working on the scene, making the generation of the OpenGL preview a 
lot less demanding for Harmony, without affecting the rendered image.

Connection

The OpenGL Bypass node has two input ports and one output port. What is connected to the left input port 
displays in the OpenGL preview, and what is connected to the right input port appears in the rendered image. 

How to connect an OpenGL Bypass node

 1. Identify a part of the scene's node system that adds a lot of unnecessary load to the OpenGL 
preview. 

 2. If that part of the node system is not connected to a composite, add a Composite node and connect 
all the elements of that area to this composite. This will be the render composite. 

 3. Connect the OpenGL Bypass node under the render composite through its right input port. 

 4. Create another composite. This will be the preview composite. 

 5. Connect only the parts of the node system that are useful to the animator to the preview composite.

 6. Connect the preview composite to the left input port of the OpenGL Bypass node. 

In the following example the scene includes a background, a character (which is rigged to be cut by part of the 
background), a drop shadow, light and shadow effects, a node system deformed by a Quadmap to make a 
computer or television screen effect, a snowstorm particle system and an overlay. All of these elements are 
connected to a composite that is connected to the right port of the OpenGL Bypass. Connected to the left port 
of the OpenGL Bypass is a composite that is only connected to the character without the cutter, the 
background, and the content of the screen without the Quadmap deformation, which would typically be all the 
animator needs to work on the scene. 
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NOTE 

This example showcases the OpenGL Bypass node being used for the scene's main composite. It is 
also possible to use it for very precise areas of a node system, such as individual body parts of a 
character, as long as they are linked together by a composite.

Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.
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OpenGL-Cache-Lock Node
The OpenGL Cache Lock node can significantly increase the performance of Harmony when working in heavy 
scenes with many characters, very complex rigs or an otherwise heavy node system. 

Without the OpenGL-Cache-Lock node, Harmony must regenerate the OpenGL preview displayed in the 
Camera view every time an element is changed or manipulated from scratch. This means it has to process 
every node in the scene's node system all over again. Although the OpenGL preview is optimized for quick 
real-time rendering, a complex enough node system can make this process slow enough that each action done 
on the scene causes a delay, ultimately making working on heavy scenes excessively time-consuming.

A typical way to circumvent this is to temporarily disable elements in the scene that are not being worked on. 
For example, an animator working on a scene with several characters can disable the characters they are not 
working on at the time, and can also temporarily disable the scene's background and props, so that only the 
elements they need to manipulate are visible which reduces the load on OpenGL previewing. 

The purpose of the OpenGL-Cache-Lock is to obtain virtually the same benefit in performance without having 
to hide any element in the scene. When connected under a node system, this node creates a cache of the 
OpenGL preview of the elements it is connected to. Every time a change is made to any element in the scene 
and the OpenGL preview must be refreshed, the OpenGL-Cache-Lock node checks if the change affects one of 
the elements it is connected to. If it does not, it will simply output the cached image for the preview, saving 
Harmony the burden of regenerating the preview for these elements.

Hence, in the previous example, an OpenGL-Cache-Lock node could be connected under the main composite 
of each character. Harmony would then cache the preview of each character separately, and would only 
regenerate the preview of a character when one of its parts is manipulated or modified. The animator would 
not need to disable any characters as Harmony will keep re-using the cached previews of the characters they 
are not currently working on. 

NOTE 

The OpenGL Cache Lock node only affects the way the OpenGL preview is generated and has no 
effect on the actual rendered image.

Connection

The OpenGL-Cache-Lock node must be connected under elements or composites that should be cached 
separately for the OpenGL preview. Typically, this means adding an OpenGL-Cache-Lock node under 
elements that will be animated individually. In the example below, an OpenGL-Cache-Lock node can be 
connected under the main composite of each character. But for a scene with very complex character rigs, an 
OpenGL-Cache-Lock node could also be connected under composites for each limb of the character, for their 
torso, for their head, etc.

798



An OpenGL-Cache-Lock node can also be connected between the scene's main composite and its main 
display. This can help with performance when zooming in, panning and rotating the scene. Harmony will use 
the cached preview while zooming in, panning or rotating, and will only regenerate the preview half a second 
after the operation is done.

IMPORTANT 

The OpenGL-Cache-Lock node must be used with some caution:    

 l If the user begins zooming in, rotating or panning the Camera view, the preview will not 
regenerate immediately. Rather, it will regenerate half a second after the user releases is done. 
During that short delay, because the preview cached by the OpenGL-Cache-Lock is a bitmap 
image and that it does not extend the borders of the Camera view, zoomed-in areas will appear 
pixelated, and areas that are brought from outside of the Camera view's borders by zooming 
out or panning will appear blank until the preview is regenerated. 

 l It is important not to add too many OpenGL-Cache-Lock nodes, and to only use them for 
complex node systems. If a scene has too many OpenGL-Cache-Lock nodes and that they are 
used on node systems that are too simple, the caching overhead as well as the need to 
composite all the different caches is liable to cause more load on Harmony than it would save. 

 l Likewise, whether adding an OpenGL-Cache-Lock node under layout elements such as 
backgrounds, underlays and overlays will enhance performance depends on how complex they 
are. For example, a single vector drawing layer might benefit from an OpenGL-Cache-Lock if it 
has an exceptionally high amount of detail. Otherwise, the performance gain for a few drawing 
layers is unlikely to surpass the incurred caching overhead. You should use them with discretion 
with such elements, and test whether they cause a noticeable improvement or decrease in 
performance.
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Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Input Ordering

Determines the way the elements connected to the OpenGL-Cache-Lock node 
are ordered in the preview:

 l 2D: Elements connected to the node will appear flattened together. Their 
apparent position on the Z axis relative to other elements in the scene will 
be the one of the foremost element.

 l 3D: Elements will appear in their appropriate order based on their position 
on the Z axis relative to other elements in the scene. 

NOTE 

This only affects the way elements are displayed in the OpenGL preview. 
The OpenGL-Cache-Lock node does not affect the way elements are 
rendered in the final render. 
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Pre-Render Cache Node
The Pre-render Cache node is a special type of Composite node that can create and store a cache of its 
rendered image on demand, and only output that cached image in the Camera view when it is in Render View 
mode.

This node can be very useful when working on a scene that contains an element that is extremely long to 
render, such as a 3D model, a complex special effect or even a scene rendered in 4K.

Typically, when you view a frame of your scene in Render View mode, Harmony renders every element of your 
scene one by one to composite them into the preview image. Then, if you change anything in your scene, 
Harmony has to render every element in your scene from scratch again to ensure that the preview is accurate. 
For example, in a scene with one character and a very resource-intensive special effect, making a change to the 
character requires Harmony to re-render every element in the scene including the resource-intensive special 
effect, which is very time consuming.

The Pre-render Cache node allows you to control when certain elements in your scene are rendered again. In 
the previous example, you can connect the resource-intensive special effect to a Pre-render Cache node, then 
make it generate a cache of the rendered special effect. From that point on, when the Camera view is in Render 
View mode, it will pull the rendered special effect from the Pre-render Cache node’s cache instead of 
regenerating it every time. If you make a change to the special effect that requires its preview image to be 
regenerated, you can manually render the Pre-Render Cache node again, which will update its preview image 
in the Camera view.

The Pre-render Cache node now shows green frames in the Timeline once a frame is rendered and available in 
the cache.

NOTE 

 l The Pre-render Cache node is not intended to be used in the design department (Backgrounds, 
Props and Rigs) nor in the animation department since they do need to modify too often the 
contents of the scene. The Pre-render Cache node is in fact more efficient in the Compositing 
department.

 l The Pre-render Cache node can only output a flat bitmap image.

 l The cached rendered images are only used when generating a preview image for the Camera 
view. When rendering your scene’s frames as images or as a movie, the nodes connected to the 
Pre-render Cache nodes are rendered again, and the cached images are ignored.

 l Effects that require vector images, such as the Colour Override or the Apply Peg 
Transformation effects, will not work when connected under a Pre-render Cache node, since 
the Pre-render cache node acts like a bitmap Composite.
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Connection

The Pre-render Cache node should be connected as the intermediary node between the element, effect or 
composite for which you want to cache the rendered image, and the composite for the remainder of the scene. 
For example, if a character is made of various effects, the most efficient place to put the Pre-render Cache node 
will be under the character’s group on the scene level.

Example: One Pre-render Cache node by character’s rig

Being a “composite” type node, you can connect as many input images as you want to the Pre-render Cache 
node. 

The Pre-render Cache outputs a bitmap image and, contrary to regular Composite nodes, it does not allow 
vector effects to travel up its node system. Hence, effects such as the Colour Override or the Apply Peg 
Transformation effects will not work when connected under a Pre-render Cache node.

The Pre-Render Cache node shares some of its properties with the Composite node.
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible effect on the 
rendered image, nor on the preview in the Camera, Perspective, Side and Top views.

Colour Swatch Sets the colour of the layer in the Timeline view and of the node in the Node view.

Name Allows you to enter a name for the node.

Input ordering 
(Requires 
Cache 
Rendering)

 l 2D: Elements connected in the node are composited based on their port ordering. The Z-
axis (forward-backward) values are ignored. The scaling value will be correct, but the 
actual position on the Z-axis is ignored.

You can use the 2D composite type to create effects such as a camera recording overlay 
on your scene. Since you always want this element to be in front regardless of the other 
elements' Z-axis position, you can set the option to 2D.
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 l 3D Flat: The Z-axis value of the elements connected in the Composite node are 
considered, so the visual representation is correct in the Camera view. The output is a 
flat image.

 

Output 
Options

 l Output Z: Identifies which element’s front-back value from the current composition is 
applied to the entire composited image in the next operation. If you select Portnumber, 
identify the appropriate port by its position using the Port For Output Z menu.

 l Port for Output Z: When using the Portnumber option in the Output Z menu, you can 
select which port you want to use as the Z value for the Composite node. The port used 
appears in a bright green colour on the Composite node. By default, the leftmost port is 
displayed in front and the rightmost port is displayed behind.

Manage Cache

 l All Frames: Select All Frames if you want to pre-render the entire scene.

 l Current Frames: Select Current Frames if you want to pre-render the current scene.

 l Selected Frames: Select Selected Frames if you want to render a part of your scene. 
Then, in the field From, type in the first frame of the sequence you want to export, and in 
the other field, the last frame of the sequence you want to render.

 l Render: Renders the frames into cache images within the prerender.db folder of the 
current Pre-render Cache node. Those images will be rendered as .rpng files. 

 l Clear: Removes every cache image rendered within the prerender.db folder of the 
current Pre-render Cache node.
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Render Preview Node
To adjust the effect's visual controls in OpenGL mode, from the Node Library view, drag a Render Preview 
node to the Node view. Connect it between the effect and the Composite nodes.
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Script Node
You can use the script node to create a custom node that processes peg and image information from other 
nodes using the Harmony scripting interface. 

Connection

By default, the Script node has one image input port and one image output port, which do not have any 
purpose until you add scripts to it. 

The Script node can be configured to have as many input and output ports as needed. Each port can be 
configured to carry image information or transformation (peg) information.

Scripting Interface

For a reference on the modules and methods available in the scripting interface used by the Script node, refer 
to the Script Node reference guide, which is packaged with Harmony and can be found on the following 
location on your system:

 l Windows: C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 21 
Premium\help\scriptmodule\index.html

 l macOS: /Applications/Toon Boom Harmony 21 Premium/Harmony 
Premium.app/Contents/Documentation/scriptmodule/index.html

 l GNU/Linux: /usr/local/ToonBoomAnimation/harmonyPremium_
21/help/scriptmodule/index.html
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Layer Properties

The layer properties of a Script Node allow you to configure which properties and ports it has, to set values for 
the properties you added to it, to link it to files and to script its behaviour in various events.

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Tabs

Attributes
This tab allows you to set values for the attributes defined in the Specifications 
tab.  

Specifications

This tab allows you to define the attributes as well as the input and output ports 
for the Script node. 

The Script node supports the following types of attributes:

 l bool

 l int

 l double

 l String

 l Text

 l Colour
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Parameter Description

 l Position2d

 l Position3d

The Script node supports the following types of ports:

 l Image

 l Peg

Softrender
This tab allows you to write or link to a script that will be executed when 
rendering the node. 

Initialization
This tab allows you to write or link to a script that will be executed when loading 
the scene.

Cleanup
This tab allows you to write or link to a script that will be executed when closing 
the scene.

UI Script
This tab allows you to write or link to a script that will be executed when using 
the Show Control command while the node is selected. 

Extra Files

This tab allows you to define folders or files from root directory of the scene that 
should be preserved when creating templates or saving the scene in a different 
location. Any asset, such as external scripts, user interface files, data files or 
images that the Script node requires should be listed in this tab.

NOTES 

 l To add Extra Files to the Extra Files attribute, click on the 
Function button right of the Extra Files field to create the Extra 
Files attribute, then click on it again to open a dialog box in 
which you can type the file path of each file or folder that you 
want to copy with the Master Controller, with one file path per 
line. 

 l File paths must use forward slashes (/) and must be relative to 
the scene directory. They can point to files or folders. For 
example, if you want to copy everything in the scripts sub-
directory of your scene with your Master Controller, you can 
simply add scripts to the list. 
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Visibility Node
The Visibility node lets you control whether an item is visible in OpenGL mode versus the Soft Render mode in 
the Camera view. If the Soft Render option is not enabled, the layer will not be exported.

Visibility Properties

Parameter Description

Display in OpenGL View Displays your render in OpenGL mode.

Soft Render  
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Move Nodes
The nodes found in the Move category are used to animate layers as well as camera motions. 

Apply Image Transformation Node 811

Apply Peg Transformation Node 814

Camera Node 818

OrthoLock Node 820

Peg Node 822

Shake Node 824

Transform-Loop Node 828

Quadmap Node 831

Quake Node 834
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Apply Image Transformation Node
The Apply Image Transformation effect is mainly used when you want to pan an object out of the camera frame 
and that object has an effect such as a Glow or a Blur on it. When you use a peg or the Apply Peg 
Transformation node to translate an object such as the sun out of the camera frame, as soon as the sun starts to 
go outside of the camera frame, the sun's circle is cropped and the blur is applied on the shape left over. This 
also means that when the sun is completely out of the frame, the Blur is not calculated anymore and the Blur 
pops out.

To prevent this from happening, you must use the Apply Image Transformation node to pan the sun out.

The Apply Image Transformation node applies the panning transformation once the full drawing of the sun is 
blurred, once the image is composited. Here is an example of this network:

Here is how to connect the Blur effect for a sun panning out:

Here is the visual result of the blurred sun:
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Look at the following example to understand better why using the Apply Image Transformation instead of a 
regular peg or the Apply Peg Transformation node.

The normal rendering behaviour is to crop the image before applying the effects. When planning a sunset 
using either a Peg or the Apply Peg Transformation node, as soon as the drawing of the sun is out of the 
camera frame, the drawing is cropped and there is no image left to blur. This means that the glowing edge 
pops out of the camera instead of panning out gradually. Using the Apply Image Transformation node, the 
image is blurred before being panned out, so this means that even once the drawing is out of the camera frame, 
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its glowing edge will still show until the drawing is far enough from the camera border. This way, there is no 
pop when panning out blurred objects.

Use the Apply Image Transformation editor to change the name of the node.
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Apply Peg Transformation Node
Use the Apply Peg Transformation node to apply a transformation coming from a Peg, Ortholock, or Quadmap 
node on a single node or a group of nodes. When using the drawing layer's No Clipping option, you can use 
this node to apply all Camera and Peg transformations once all of the effects and nodes connected above the 
drawing node are calculated.

You can use this effect node to create a simple highlight on a cut-out puppet or use the No Clipping option 
available in the drawing layer.

The No Clipping option, found under the drawing Layer Properties' Advanced tab is used when you do not 
want to crop your images before all effects are applied to your drawing. No camera motion or peg 
transformation will be applied to your drawing until you connect an Apply Peg Transformation.

The advantage of this node is that you can create a second output of your image or puppet and offset it, scale it 
or apply any kind of transformation on it.

The transformations set in the Peg, Ortholock, or Quadmap node connected to the Apply Peg Transformation 
node are applied BEFORE the image is composited.

Here is an example of how to connect the Apply Peg Transformation node:

The transformation set in the Peg node from the example above is applied before the image is composited, 
which is the equivalent of the following network:
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In the following images you can see the result of the transformation without the Apply Peg Transformation 
node and with it:

Using the Apply Peg Transformation you can apply transformation on drawings that are outside the camera 
frame and make them appear inside the frame.

If you are using the Apply Image Transformation node to create a drop-down shadow for a character, it will 
work correctly so long as the character is not going outside of the camera frame or that the drawing connected 
in it is a VECTOR drawing. The reason is the Apply Image Transformation node applies the transformation 
once the drawing is rendered, moved by its own set of Pegs, motion paths and quadmap and cropped to the 
camera frame size. This crop operation does not occur if the drawing is a vector drawing (*.TVG). Although, as 
soon as the drawing is passed through an effect node or a bitmap type Composite node, the drawing is turned 
into a bitmap image and gets cropped.

So, if you offset a bitmap half inside and half outside the camera frame, the outside part is cropped out and then 
moved by the Apply Image Transformation node. A part of the original drawing is cut. You need to use the 
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Apply Peg Transformation node for the transformation to be applied before the image is processed and 
cropped.

Advanced Apply Peg Transformation 

You can use the Apply Peg Transformation's middle port to apply the transformation you connected to the 
node after one of the Peg or Quadmap connected above the drawing node.

In the following example, two pegs were added to control the different motions on independent trajectories:

 l Peg-Translation

 l Peg-Scale
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When there is no Apply Peg Transformation node, the Peg-Translation is the first trajectory to affect the 
drawing node. Then, once the translation is applied, the Scale trajectory affects the drawing node.

When using an Apply Peg Transformation node without using the middle port, the Peg-Rotation connected in 
the APT node is applied at the top of everything. The order in which the trajectories are applied to the 
drawing node is:

 1. Peg-Rotation

 2. Peg-Translation

 3. Peg-Scale 

When the Peg-Translation is connected in the Apply Peg Transformation's middle port, the Peg-Rotation is 
applied after the Peg-Translation and before the Peg-Scale. This means that the translation is done before the 
rotation instead of the rotation before the translation.

The order in which the trajectories are applied to the drawing node is:

 1. Peg-Translation

 2. Peg-Rotation

 3. Peg-Scale

Use the Apply Peg Transformation editor to rename the node.
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Camera Node
You can setup the camera position by entering coordinates and values in the Layer Properties view.

Parameter Description

Enable/Disable Turns the camera layer on or off.

Change Track Colour

The Change Track Colour  button lets you change the colour of the exposed 
frames; this helps you to quickly locate a layer in the Timeline view. Click the 
Change Track Colour  button to open the Select Colour window and choose a 
new colour. You can modify the colour for any type of layer, such as group, peg, 
drawing, and effects.

Name
Displays the current layer name. You can rename the layer by typing in a new 
layer name.

Position

Displays the current position of the camera layer using X-axis (East/West), Y-axis 
(North/South) and Z-axis (Forward/Backward) coordinates. To reposition your 
camera frame, type in the new values corresponding to the desired position 
coordinates. You can also use the up and down arrows to set the value of each 
field.

Angle
Displays the current rotation value. To set a new rotation position, type in a new 
angle value. You can also use the up and down arrows to set the new angle 
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value.

Pivot

Displays the current position of the rotation pivot of the camera layer. The camera 
will perform a rotation taking the position of the pivot as its angle centre. By 
default, the pivot is set at the centre of the camera frame. To reposition the pivot 
point, enter new X and Y coordinates values in the appropriate field. To see the 
pivot's position, the Rotate tool must be selected.

Clipping Planes

You can change the near and far clipping planes of the camera. The near plane is 
the point on the camera cone where the camera is located. The far clipping plane 
is the far end of the camera cone. Nothing outside that range is visible. This is 
useful when dealing with 3D elements and 3D sets.  For example, the camera can 
be looking inside a 3D box or room and you might want the foreground wall to 
not obstruct the view of the interior. By default, the near clipping plane is set to 1 
field and the far clipping plane is set to 1000 fields.

Override Scene FOV Enable the FOV field in which you can type in a new field-of-view value. 

FOV

Displays the current field-of-view default value. When enabled, you can type in a 
new zoom value for your camera frame. You can also use the up and down 
arrows to set the new zoom value.

Click on the Create Function button to animate the camera zoom value.

Set Default FOV Resets the custom zoom value to its default value. 
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OrthoLock Node
When you create a 3D camera move in your scene, notice that layers are treated as flat objects. That is, 
animation layers that are supposed to face the camera at all times will look like a flat sheet of rotating paper.

Use the Ortholock layer when mixing flat animation layers with a set built in 3D. Ortholock forces your 
drawing layer to always follow the Camera angle. It does not follow its position or zooming level, only the 
rotation. This prevents drawings from being distorted by the camera motion.

Connection

The OrthoLock node can be connected as a parent of the drawing or drawings which you want to face the 
camera. 

Layer Properties

Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views. 

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view. 
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Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each 
node must have a name that is unique to its containing group.

Rotation Axis

The axes on which to rotate the input image to keep facing the camera.

 l X and Y Axes: The drawing will be rotated on the x and y axes to keep 
facing the camera regardless of its position in the 3D space.

 l X Axis Only: The drawing will be rotated on the x-axis when the camera 
is rotated in the x-axis. The drawing will keep facing the camera if it 
moves to a low or high angle view, but not if it moves around it while 
staying on the ground. 

 l Y Axis Only: The drawing will be rotated on the y-axis when the camera is 
rotated on the y-axis. The drawing will keep facing the camera if it moves 
around it while staying on the ground, but not if it moves to a low or high 
angle view. 

Max Angle

The maximum angle at which the drawings can appear to be relative to the 
camera angle, on both the x and y axes, in either direction. 

For example, at the default setting, 0, the input image will always be facing the 
camera. If however you set this parameter to 30°, you can rotate the camera 
around the drawing up to 30° in either direction  and the drawing will appear in 
perspective, but past 30°, the drawing will appear to rotate to keep its angle 
relative to the camera.
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Peg Node
Find below a description of all the Peg node parameters.

Transformation Tab

Parameter Description

Enable 3D Displays additional parameters for working with 3D objects.

Position

3D Path: Use a 3D path to position the element. A 3D path uses a single 
function to define the position on the X, Y and Z axes. This function is made of 
control points linked by a curvilinear path, making the movement follow a natural 
curve. The pace and ease of the movement is determined by a single velocity 
function.

Separate: Positions the element using separate functions for the X, Y and Z axes. 
This allows to control the direction and pace of the movement across all three 
axes separately. Unless ease is applied to the axes, the trajectory of the element 
will follow straight lines going between each keyframe.

Path: If the 3D Path option is selected, this field allows you to create or select 
the 3D Path function used to position the element.

Path (x) Axis: The position of the element on the East-West axis, in fields.

Path (y) Axis: The position of the element on the South-North axis, in fields.

Path (z) Axis: The position of the element in the Back-Front axis, in fields. 

Velocity: If the 3D Path option is selected, this function is used to control the 
pace at which the element moves towards each control point in the 3D Path 
function, on all three axes simultaneously.

Scale

Locked: Uses a single scale parameter to scale the element, preserving its 
proportions.

Separate: Uses a separate parameter to scale the element on the X and Y axis, as 
well as on the Y axis if the element is 3D-enabled, allowing to stretch or squash 
the element. 

(x) Axis: The horizontal scale factor. The default value is 1.

(y) Axis: The vertical scale factor. The default value is 1.

(z) Axis: The depth scale factor for 3D-enabled elements. The default value is 1.

Scale in Fields: With this option enabled, the scale factor is based on the 
amount of fields in the scene. For example, to shrink one of the dimensions of an 
element to half its original size, the scale factor would normally bet set to  0.5. If 
this option is enabled and the amount of fields in the scene is 12, then the scale 
factor to shrink the element by half would be 6. 
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Ignore Parent Scaling: When this option is enabled, any scaling value applied 
to a parent layer is ignored in the current layer. This can be handy in cut-out rigs 
when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: Lets you  type in a degree value for the rotation angle. Note that you can 
enter values greater than 360 and -360 degrees. If you enter 720, the object will 
rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: The horizontal position of the pivot point of the element relative to the 
pivot point of the drawing, in fields.

(y) Axis: The vertical position of the pivot point of the element relative to the 
pivot point of the drawing, in fields. 
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Shake Node
T-H16NEW-004-001

The Shake node allows you to generate a fully animated, fully customizable shake animation, which can be 
used to create camera shakes or to make an element in your scene shake.

The Shake node is a more advanced version of the Quake node. Among many enhancements, you can make 
each shaking motion interpolate over several frames by reducing its Frequency parameter, and you can make 
each movement hold for 2 or more frames, if needed, by increasing its Step parameter. Additionally, you can 
configure each big shaking motion to have several smaller shaking motion across it, to make a more erratic 
looking shaking movement. 

Connection

Just like a peg, you can connect the Shake node as a parent of the element you want it to move. Hence, if you 
want to shake an element in your scene, connect the Shake node as a parent of that element. 

To create a Camera shake, connect the Shake node as a parent of the scene's Camera node. 

Like pegs, Shake nodes can be connected in chain, either with other Shake nodes or with other Move-type 
nodes, such as Peg nodes. 
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Layer Properties

Parameter Description

Name Allows you to change the name given to the node.

Frequency

The speed of the big vibrations. This field takes a decimal value between 0 and 1. 
At 1, each vibration only takes a single frame. At 0.5, each vibration takes 2 
frames, etc. 

When set to 0, the Shake node produces no vibration. You can animate this 
parameter to control when the Shake node has an effect and when it doesn't, as 
well as to increase or decrease the speed of the shake.

Octaves
With the Octave parameter, you can add smaller vibrations to the big vibrations, 
making for a more erratic, forceful shake. This parameters takes an integer, which 
determines the amount of smaller vibrations to add to each big vibration. 
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Parameter Description

Multiplier
The strength of the smaller vibrations, relative to the big vibrations. This is set to 
0.5 by default, which means smaller vibrations will have, at most, half the 
amplitude of big vibrations. 

Random Seed

This parameter determines the pattern of random motions it uses to simulate 
shaking. There is no wrong  value for this parameter. Entering any value will 
simply make it uses a different random pattern. 

If you have two or more Shake nodes in your scene and they have the same 
Random Seed value, their shaking will be similar, if not exactly the same, as it 
will be based on the same pattern of random motions. Hence, you might need to 
assign different Random Seed values to all of your Shake nodes to make sure 
their motion pattern feel different. 

You should also assign a different Random Seed value to each Shake node if they 
make a shaking motion that goes on throughout several scenes so that it doesn't 
look like the motion pattern is repeating itself.

You can also change the value of this parameter just to make the Shake node use 
a different shake pattern, and see if you can find a pattern that fits your 
expectations better.

Amplitude

Position X The maximum distance, in fields, to shake left or right. 

Position Y The maximum distance, in fields, to shake up or down.

Position Z The maximum distance, in fields, to shake closer to or further from the camera.

Rotation X The maximum angle, in degrees, to shake around the horizontal axis. 

Rotation Y The maximum angle, in degrees, to shake around the vertical axis. 
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Parameter Description

Rotation Z The maximum angle, in degrees, to shake clockwise or counterclockwise. 

Pivot

Pivot X
The horizontal offset of the pivot point, in fields, relative to its default horizontal 
position.

Pivot Y
The vertical offset of the pivot point, in fields, relative to its default vertical 
position.

Pivot Z

The offset of the pivot point on the z-axis, in fields, relative to its default position 
on the z-axis. 

NOTES 

 l The position of the pivot is used for rotations in the shaking 
motions. 

 l The pivot of the Shake node is positioned in the centre by 
default. However, if an element connected under it has the Use 
Embedded Pivots property set to Apply Embedded Pivot on 
Parent Peg, the default pivot position of the Shake node will be 
the same as the pivot of that element. 

Steps

Steps

The amount of frames to hold each movement. By default, this is set to 1, which 
means the Shake node will move each frame. You can set this to 2 or 3 if you 
animate on twos or threes, so that the motions of the Shake node match the pace 
of your animation.
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Transform-Loop Node
The Transform-Loop node allows you to automatically loop a transformation applied by a peg onto its element, 
so that you do not have to copy and paste this animation over and over again throughout your scene. This is 
especially useful if you need to repeat the pan animation of a looping background.

The Transform-Loop node will take the animation that is fed to it by its parent node, for a given frame range, 
and repeat this animation onto its child node throughout the entire scene. It can automatically detect the 
range of frames to repeat, or you can manually set this range. It can  loop the animation in three ways:

 l Repeat will simply repeat the animation as is, going from the start all the way to the end, and instantly 
playing it again from the start. 

When the Transform-Loop node repeats the animation, it skips the first frame of the animation. This is 
useful when using looping backgrounds. Typically, with a looping background, the first frame of the 
looping animation looks exactly like the last frame of the looping animation. Hence, skipping the first 
frame avoids having two frames that look exactly the same when the animation loops, making a smooth 
infinite loop.

 l Ping-Pong plays the animation, then plays it again backward, then forward again, etc.

 l Repeat and Offset repeats the transformation, but also accumulates the effect of the transformation. 
Hence, if the animation is, for example, of a ball bouncing once towards the right, then the Transform-
Loop node will make it bounce further and further towards the right  until it exits the camera field. 

Connection

The Transform-Loop node repeats the transformations that are sent to it from its top (input) port, and outputs 
the looped transformation through its bottom (output) port. 

The Transform-Loop node repeats the transformations from all the nodes connected directly or indirectly to its 
top (input) port, not just the one connected right above it. 
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Layer Properties

Parameter Description

Name Allows you to change the name given to the node.

Automatic Range Detection

Automatically sets the range of the animation to loop based on the animation in 
its parent peg. It will start the range at the first keyframe in the parent peg, and 
end it at the last keyframe in the parent peg. 

NOTE 

If there are several peg nodes connected in a chain to the top port of the 
Transform-Loop node, it will loop the animation of all these Peg nodes 
combined. However, it will only use the keyframes in the node right above 
it to determine the range of animation to loop. In this case, you have to 
disable Automatic Range Detection and set the range manually to make 
sure the Transform-Loop node repeats all of the animation you want it to 
repeat.

Range The range of animation frames to loop. 
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Parameter Description

 l Start: The number of the first frame of the animation that the Transform-
Loop node should loop.

 l End: The number of the last frame of the animation that the Transform-
Loop node should loop.

Loop Type

The way the Transform-Loop node should loop the animation:

 l Repeat will simply repeat the animation as is, going from the start all the 
way to the end, and instantly playing it again from the start. 

When the Transform-Loop node repeats the animation, it skips the first 
frame of the animation. This is useful when using looping backgrounds. 
Typically, with a looping background, the first frame of the looping 
animation looks exactly like the last frame of the looping animation. 
Hence, skipping the first frame avoids having two frames that look exactly 
the same when the animation loops, making a smooth infinite loop.

 l Ping-Pong plays the animation, then plays it again backward, then 
forward again, etc.

 l Repeat and Offset repeats the transformation, but also accumulates the 
effect of the transformation. Hence, if the animation is, for example, of a 
ball bouncing once towards the right, then the Transform-Loop node will 
make it bounce further and further towards the right  until it exits the 
camera field. 
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Quadmap Node
T-COMP2-010-001

The Quadmap transformation layer lets you deform the shape of an element. For example, you can use it to 
create a drop-shadow effect on an element.

You can edit the Quadmap visually in the Camera view.

How to edit the Quadmap in the Camera view

 1. In the Timeline view, click the Add Layer  button and select Quadmap.

 2. Connect the drawing you want to deformto the Quadmap.

‣ In the Node view, add a Quadmap node and connect to the drawing element node that you 
want the effect to act on.

 3. In the Tools toolbar, disable the Animate mode to change the value for the Quadmap over the 
entire duration of the element.

 4. In the Timeline view, click on the Quadmap layer to select it.

 5. From the top menu, select View > Show > Control or pressShift + F11.
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The quadmap handles appear around the element in the window. There is also a pivot point at the 
centre of the quadmap frame that you can reposition.

 6. In the Camera view window, use the Transform tool to move the points on the quadmap. Shift + 
click to select multiple points.

TIP 

The position of the points can be animated. To do this, open the Quadmap node layer properties 
and create functions for each of the coordinates.

Properties

Parameter Description
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Name Allows you to change the name given to the node.

2D Path
Changes the X and Y values simultaneously and control the velocity of the 
change.

Separate
Changes the X and Y values separately. Each one can be attached to separate 
function curves.

 

833

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Quake Node
The Quake node allows you to to create a very common camera move, the camera shake. Using the Quake 
node, you can generate an automated quake instead of manually entering random keyframes. This way, you 
can simulate the shock of something heavy falling on the ground, like an earthquake or a strong vibration.

How to use the Quake node to create a camera shake

 1. From the Node Library view, drag a Quake node to the Node view.

 2. If you do not have a Camera node already, drag one from the Node Library view to the Node view.

 3. Connect the Quake node to the Camera node.

 4. Click on the Quake node's yellow square properties button to open the Quake properties.

 5. In the Quake properties window, adjust the properties.
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Layer Properties

Parameter Description

Name Allows you to change the name given to the node.

Hold Time
Allows you to enter the number of frames you want one of the quake vibrations 
(position) to hold for. Most camera shakes are done in a single frame (1) or 
double frame (2).

Interpolate
An interpolation is generated between the random values. Instead of jumping to 
the next position, it will slowly progress forwards to the next position. It is the 
same principle as stop-motion keyframes and motion keyframes.

Move Amplitude

This is the strength of the quake. The higher the value, the stronger the quake. If 
the value is set to 0, there will be no  motion. To have the motion start and stop at 
a specific frame during the scene, you can create a function curve and animate the 
amplitude over time. Simply click the Function  button to generate the 
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function, then click on it again to open the Function editor.

Apply on X, Y, Z Applies the quake to the X, Y and Z-axis.

Rotation Amplitude
When the value is higher than 0, a rotating quake is applied. The higher the value, 
the stronger the quake.

Random Seed

This parameter determines the pattern of random motions it uses to simulate 
shaking. There is no wrong  value for this parameter. Entering any value will 
simply make it uses a different random pattern. 

If you have two or more Quake nodes in your scene and they have the same 
Random Seed value, their shaking will be similar, if not exactly the same, as it 
will be based on the same pattern of random motions. Hence, you might need to 
assign different Random Seed values to all of your Quake nodes to make sure 
their motion pattern feel different. 

You should also assign a different Random Seed value to each Quake node if 
they make a shaking motion that goes on throughout several scenes so that it 
doesn't look like the motion pattern is repeating itself.

You can also change the value of this parameter just to make the Quake node use 
a different shake pattern, and see if you can find a pattern that fits your 
expectations better.
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Output Nodes
The nodes found in the Output category are used to control the image outputted in the various views as well as 
during the rendering process.

Crop Node 838

Display Node 841

Multi-Layer Write Node 842

Scale Output Node 846

Write Node 848
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Crop Node
To output two files with different aspect ratios, such as 16:9 and 4:3, you can use the Crop node. This node is 
used to crop the final image in order to discard excess information without distorting the render.

If you want to export your scene in a resolution that is smaller than your scene's resolution and which does not 
have the same aspect ratio, you should use a Scale-Output node to shrink the output, but preserve the scene's 
proportions, then a Crop node to adjust the output to fit the desired aspect ratio.

Find below the Crop node properties.

Cropping Tab

Parameter Description

X Resolution This is the X (width) value in pixel of the resolution to crop the final image to.

Y Resolution This is the Y (height) value in pixel of the resolution to crop the final image to.

X Offset
This is the X (horizontal) offset value in pixel to move the crop box to in the final 
image.

838



Y Offset
This is the Y (vertical) offset value in pixel to move the crop box to in the final 
image.

Draw Frame
Enable the Draw Frame option if, instead of cropping the images, you prefer to 
have Harmony draw a frame over the rendered scene.

Red, Green, Blue, Alpha
These are the RGBA values used for the frame colour if you enabled the Draw 
Frame option.

Colour Swatch
Displays the selected colour for the frame to draw. You can click on the Colour 
Swatch to open the Colour Picker dialog and select a colour for the frame.

Enabling Tab

Using the options in the Enabling tab, you can set up some Crop nodes to only be enabled if the scene is 
rendered at a specific resolution. This is mostly useful on Harmony Server, as Harmony Server allows you select 
the resolution at which to render a scene when sending a scene for rendering by the Harmony database's 
render farm. 

This can be useful if you want your scene to render differently depending on the resolution in which you render 
it. For example, you could have a storyboard thumbnail in a small corner of your scene, and a crop node that 
connects between your scene's main Composite node and your Write node. Then, by setting up this Crop node 
to only be enabled when the scene is rendered at the storyboard thumbnail's resolution, you can decide 
whether your scene will render its animation or its storyboard by deciding whether to render at the scene's 
resolution or the storyboard thumbnail's resolution. 

This option allows you to filter with either resolution presets, or by specifying the width and height of the 
chosen resolution in pixels. You can hence create custom resolution presets named after the Crop node's 
purpose, to make it easier to choose the resolution when rendering a scene. 

Parameter Description

Always Enabled
Makes this Crop node render every time the scene is rendered. This is the 
default option.
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Enabled when Resolution Name is
Makes this Crop node render only when the scene is rendered at the 
specified resolution preset. 

Filter Name
Select the resolution preset at which to render the scene to activate this 
Crop node.

Enabled when Resolution is
Make this Crop node render only when the scene is rendered at the 
resolution with the specified width and height, in pixels. 

X Resolution
The width (in pixels) of the resolution at which to render the scene to 
activate this Crop node.

Y Resolution
The height (in pixels) of the resolution at which to render the scene to 
activate this Crop node. 
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Display Node
The Display node is an important node; it is used by the export and views to display your scene, primarily the 
Camera and Timeline views. By default, a scene's node system always has a Display node which can be used to 
show your entire scene, a single node or a group of nodes through a Composite or Group node. You might use it 
to see one single character as you animate it, debug your node system as you create complex effects or export 
your complete scene or a portion of it. 
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Multi-Layer Write Node
The Multi-Layer Write node allows you to export Photoshop Document (.psd) or OpenEXR (.exr) files with 
multiple layers inside them. It works just like a Write node, except that it takes several input images instead of 
just one, and each input image is used to generate one of the layers of the image files it outputs when 
rendering.

NOTE 

To learn more about the Write node, see Write Node on page 848.

Connection

Like the Write node, the Multi-Layer Write node only takes input images. Its output is stored in image files 
when your scene is rendered. However, contrary to the Write node, the Multi-Layer Write node takes several 
input images. 

Each image connected to the Multi-Layer Write node will be used to make one of the layers of the image files 
the node creates. The image connected to the rightmost port will be the bottom layer, and the image 
connected to the leftmost port will be the top layer. 

Layer Properties

Inputs Tab

The Inputs tab displays a list of the elements connected to the node's input ports. The input ports are listed 
from right to left. The layers listed in this list are ordered from the bottommost layer to the topmost layer. 
Hence, the layer appearing at the top of the list will be the bottom layer. 
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The layers will be named in the output file as they appear in the Name column. By default, each layer is named 
after their respective input node. If you prefer, you can customize the name of each layer. Simply double-click 
on a layer's name to be prompted to type a new name.

A coloured square appears to the left of each name to indicate whether the name is based on the node or is a 
custom name. If the square is yellow, the name is based on the node. If it is green, it is a custom name. Once a 
layer name has been customized, it will no longer automatically update based on the connected node's name. 

Output Tab

The output tab can be used to configure the path, file naming pattern and file type of images exported by the 
Multi-Layer Write node.

Parameter Description

Drawing Folder

The path to the folder in which to save the rendered frames. This path can be 
absolute or relative to the scene's folder. For example, the default path for 
rendered frames is frames, which means the images are saved in the frames 
subfolder of the scene folder. If you want to select an absolute path, you can 
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Parameter Description

click on the Choose button at the right of the text field and select the folder in 
which your scenes should export their frames. You can also click on the Default 
button to set the export path to the default value.

Drawing Filename

The prefix for the file name of each exported frame. Frames will be named with 
this value, followed by the frame number and their image type extension. It is 
recommended to leave the hyphen (-) at the end of the prefix to separate the 
prefix from the frame number.

Drawing

Start Select the starting number for the image sequence.

Leading Zeros
Allows you to select the number of digits in the number used to identify each 
frame.

Drawing Type

Allows you to select the image type in which to export the frames. You can 
choose between the following file types:

 l PSD: A multi-layer Photoshop Document (.psd) file. 

 l EXR: A multi-layer OpenEXR (.exr) file, compressed in ZIPS format, which 
compresses the image in blocks of 16 scanlines.

 l EXR_ZIP_1LINE: A multi-layer OpenEXR (.exr) file, compressed in ZIP1 
format, which compresses the image in blocks of 1 scanline.

Enabling Tab

You can create several Write nodes for a single scene and, by default, when a scene is rendered, all of its Write 
nodes will perform their render.  However, using the options in the Enabling tab, you can set up some Write 
nodes to only perform their render if the scene is rendered at a specific resolution. This is mostly useful on 
Harmony Server, as Harmony Server allows you select the resolution at which to render a scene when sending 
a scene for rendering by the Harmony database's render farm. 

A good example of how this can be useful is if your scene has storyboard thumbnails in the corner, and a Write 
node connected to a composite that crops the picture to only include the storyboard thumbnail, so that your 
scene can export both the final animation and the animated storyboard when rendered. You can set up your 
scene's main Write node to only work when exporting the scene at the scene's original resolution, and the 
storyboard thumbnails Write node to only work when exporting at the desired resolution for an animated 
storyboard. 
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This option allows you to filter with either resolution presets, or by specifying the width and height of the 
chosen resolution in pixels. You can hence create custom resolution presets named after their Write node's 
purpose, to make it easier to choose the resolution when rendering a scene. 

Parameter Description

Always Enabled
Makes this Write node render every time the scene is rendered. This is the default 
option.

Enabled when 
Resolution Name is

Makes this Write node render only when the scene is rendered at the specified 
resolution preset. 

Filter Name Select the resolution preset at which to render the scene to activate this Write node.

Enabled when 
Resolution is

Make this Write node render only when the scene is rendered at the resolution with the 
specified width and height, in pixels. 

X Resolution
The width (in pixels) of the resolution at which to render the scene to activate this 
Write node.

Y Resolution
The height (in pixels) of the resolution at which to render the scene to activate this 
Write node. 
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Scale Output Node
Once your Write nodes are connected, you need some Scale-Output nodes to change the resolution output of 
the Write node without changing the scene settings. For example, if you export in a high resolution and a low 
resolution, you need one Scale-Output node.

NOTE 

If you use a Scale-Output node to scale up the image, it will look pixelated. If you want to export a 
scene in multiple resolutions, you should set your scene's resolution to be the highest resolution in 
which you want to render, and use Scale-Output nodes to scale down the output.

Find below the Scale-Output node properties.

Parameter Description

Resolution Name
Select one of the existing resolution preset from the list to indicate the resolution 
you want the finale images to be scaled at. Always make sure the selected 
resolution is smaller than the scene setting one.

Custom Resolution
Enable this option to set a resolution that is not available in the Resolution 
preset list.

Width X (horizontal) value in pixels of the resolution to scale the images down to.
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Height Y (vertical) value in pixels of the resolution to scale the images down to.
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Write Node
The Write node is the node that is used by Harmony to render a scene. When rendering a scene, Harmony 
renders the image information sent to the Write node, and outputs it using the parameters in the Write node's 
layer properties.

The Node view allows you to branch out and merge elements of your scene in specific ways. By default, a scene 
has a Write node connected to its main composite, meaning all of the scene's elements are rendered. However, 
a Write node can be connected to any node in your scene that outputs image information, even a drawing or 
an effect. A scene's renders are based on the image information that is sent to its Write node, and nothing 
else. Hence, you can control exactly what gets rendered, which is especially useful if you want to have 
elements in your scene that are only visible in the Camera view, such as a storyboard overlay or a camera 
guide, without having them appear in the renders. 

You can also set up a scene to create multiple renders by connecting several Write nodes to it. Your Write 
nodes can be connected  to different elements of your scene, which allows you to create separate renders for 
different parts of your Node view every time your scene is rendered. For example, a scene can have a Write 
node for rendering the scene without any annotations, so that render can be used in post production, and 
another one for rendering the scene with its storyboard and annotations for reviewing. A scene can also have 
multiple Write Nodes connected to the same composite, which can allow you to render the same image in 
multiple file formats or locations at the same time.

Each Write node can be configured to export individual frames as image files, a video file, or both 
simultaneously.
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Layer Properties

Output Tab

The output tab can be used to configure whether the Write node creates individual frame images, a movie file, 
or both. Further more, you can configure the path, file naming pattern and file type of frames exported by the 
Write node, as well as the path, file name and encoding options of the movie file created by the Write node.

Parameter Description

Image Folder

The path to the folder in which to save the rendered frames. This path can be 
absolute or relative to the scene's folder. For example, the default path for 
rendered frames is frames, which means the images are saved in the frames 
subfolder of the scene folder. If you want to select an absolute path, you can 
click on the Choose button at the right of the text field and select the folder in 
which your scenes should export their frames. You can also click on the Default 
button to set the export path to the default value.

Movie Folder

Only available when the Movie option is enabled. The folder in which to export 
the movie file. You can click Choose to the right of the text field to browse for the 
directory where you want the movie to be exported, or click Default to set the 
export path to the default value. You can also type a path relative to the scene's 
directory. For example, the default value is frames, which exports the movie to 
the scene's frames subdirectory.

Image Filename

The prefix for the file name of each exported frame. Frames will be named with 
this value, followed by the frame number and their image type extension. It is 
recommended to leave the hyphen (-) at the end of the prefix to separate the 
prefix from the frame number.

Movie Filename
Only available when the Movie option is enabled. The name of the movie file to 
export. Do not enter the file's extension. 
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Image Sequence Select this option to create an image sequence.

Start Select the starting number for the image sequence.

Leading Zeros
Allows you to select the number of digits in the number used to identify each 
frame.

Image Format

The image format in which the exported frames will be saved. The following 
formats are supported:

Format Specification Description

TVG                                              

Toon Boom Vector Graphic (*.tvg)

Toon Boom's proprietary format for storing 
vector drawings. TVG images contain vector 
shape, colour and texture information.

NOTE 

To export TVG files, your 
Write node must be connected 
to a vector drawing layer or to 
a vector composite node. The 
exported TVG files will contain 
the vector and bitmap drawing 
information, but will ignore  
effects and deformations. 

TGA                                              Full colour

Truevision TGA/TARGA (*.tga)

A standard image format with lossless 
compression and support for transparency. 

TGA files use more disk space than PNG 
files, but rendering in TGA is faster. 

TGA1                                              Greyscale

TGA3                                              Full colour

TGA4                                              
Full colour 
with 
transparency

SGI                                              
Full colour / 
8 bits per 
channel

Silicon Graphics Image (*.sgi)

A highly capable format with lossless 
compression as well as support for double 
precision and transparency.
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Format Specification Description

SGI1                                              
Greyscale / 8 
bits per 
channel

SGI1                                              
Greyscale / 8 
bits per 
channel

SGI1                                              
Greyscale / 8 
bits per 
channel

SGI3                                              
Full colour / 
8 bits per 
channel

SGI4                                              

Full colour 
with 
transparency 
/ 8 bits per 
channel

SGIDP                                              
Full colour / 
16 bits per 
channel

SGIDP3                                              
Full colour / 
16 bits per 
channel

SGIDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

PSD                                              
Full colour / 
8 bits per 
channel

Photoshop Document (*.psd)

An Adobe Photoshop proprietary format used 
for image editing. 

PSD files exported by Harmony contain a 
single background layer with the rasterized 
image. 

NOTE 

PSD files exported from 
Harmony are tagged with their 
colour space information in 
their metadata, except for PSD 
files exported in greyscale. 

PSD1                                              
Greyscale / 8 
bits per 
channel

PSD3                                              
Full colour / 
8 bits per 
channel

PSD4                                              
Full colour 
with 
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Format Specification Description

transparency 
/ 8 bits per 
channel

transparency 
/ 8 bits per 
channel

transparency 
/ 8 bits per 
channel

PSDDP                                              
Full colour / 
16 bits per 
channel

PSDDP1                                              
Greyscale / 
16 bits per 
channel

PSDDP3                                              
Full colour / 
16 bits per 
channel

PSDDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

YUV                                              

Y'UV frame (*.yuv)

A legacy format optimized for NTSC 
television. The image information is encoded 
in the Y'UV color space, which means Luma 
(Y') and Chrominance (UV). 

NOTE 

YUV images must be exported 
in NTSC resolution (720 x 540), 
or they will not be legible.

PAL                                              
PAL frame (*.pal)

A legacy format optimized for PAL television.
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Format Specification Description

NOTE 

PAL images must be exported 
in PAL resolution (768 x 576), 
or they will not be legible. 

SCAN                                              

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used by 
Scan to store scanned image information 
along with its registration (peg), resolution 
and field chart metadata. SCAN files are in 
gresycale. 

PNG                                              
Full colour / 
8 bits per 
channel

Portable Network Graphics (*.png)

A highly portable image format with high 
lossless compression as well as support for 
transparency and double-precision. PNG is 
typically used for Web applications, graphical 
user interfaces and image sharing. 

Rendering in PNG takes more time than 
rendering in TGA or in uncompressed image 
formats, but saves a lot of disk space. 

NOTE 

PNG files exported from 
Harmony are tagged with their 
colour space information in 
their metadata.

PNG4                                              

Full colour 
with 
transparency 
/ 8 bits per 
channel

PNGDP                                              
Full colour / 
16 bits per 
channel

PNGDP3                                              
Full colour / 
16 bits per 
channel

PNGDP4                                              

Full colour 
with 
transparency 
/ 16 bits per 
channel

JPG                                              

Jpeg (*.jpg)

A very compact image format with lossy 
compression. It is typically used for Web 
pages and photo sharing. Because it does not 
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Format Specification Description

preserve image quality, it is recommended to 
never render in Jpeg format unless you are 
exporting stills for a Web page or are making 
quick render tests. 

BMP                                              Full colour
Bitmap (*.bmp)

A standard uncompressed image format 
commonly used on Microsoft operating 
systems. 

BMP4                                              
Full colour 
with 
transparency

OPT                                              Full colour

Toon Boom Optimized image (*.opt)

A legacy Toon Boom proprietary format that 
stores bitmap image data with lossless 
compression. It supports transparency.

OPT1                                              Greyscale

OPT3                                              Full colour

OPT4                                              
Full colour 
with 
transparency

VAR                                              

Toon Boom Variable Header image 
(*.var)

A legacy Toon Boom proprietary format that 
stores greyscale bitmap image data with 
lossless compression.

TIF                                              

Tagged Image File Format (*.tiff)

An image format with many compression and 
encoding settings. It is often used for image 
exchange in visual arts and publishing.

TIFF images exported by Harmony are 
uncompressed, encoded on a per-pixel 
(interleaved) basis in PC byte order. 

DPX                                              

8 bits per 
channel / 
Full color / 
RGB channel 
order

Digital Picture Exchange (*.dpx)

A professional photo format that supports 
various different approaches to storing colour 
information, which can be used for storing, 
exchanging and editing raw information 
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Format Specification Description

recorded by cameras. It is commonly used in 
film production. 

DPX3_8                                             

8 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_10                                             

10 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_12                                            

12 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_16                                           

16 bits per 
channel / 
Full color / 
RGB channel 
order

DPX3_10_
INVERTED_
CHANNELS                                             

10 bits per 
channel / 
Full color / 
BGR channel 
order

DPX3_12_
INVERTED_
CHANNELS                                             

12 bits per 
channel / 
Full color / 
BGR channel 
order

DPX3_16_
INVERTED_
CHANNELS                                             

16 bits per 
channel / 
Full color / 
BGR channel 
order
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Format Specification Description

EXR                                              
16 lines Zip 
compression

OpenEXR (*.exr)

A highly capable deep image format. Each 
pixel in an EXR file is exported with its Z-
depth information. Additionally, if a pixel is 
semi-transparent, the color and depth 
information of pixels further back is stored 
along with it. If your scene has multiplane or 
3D elements, this format can be used for 
compositing your animation with other 
graphical elements in 3D animation software.

NOTES 

 l OpenEXR files exported 
from Harmony are 
tagged with the white 
point and primaries 
coordinates for their 
colour space.

 l OpenEXR files are 
always exported by 
Harmony always have 1 
line Zip compression if 
they contain a 3D image.

EXR_ZIP_
1LINE

1 line Zip 
compression

PDF                                              

Portable Document File (*.pdf)

Typically, PDF files are used to store, archive, 
share and print documents. However, 
Harmony uses the PDF format for its 
capability to store bitmap images and vector 
graphics.

If the write node is connected to a vector 
drawing layer or to a vector composite, the 
exported PDF files will contain the image as 
a vector graphic. It will ignore bitmap layers, 
effects and deformations. Otherwise, the PDF 
files will contain the rendered image as a 
bitmap.

DTEX                                              

Deep Texture (*.dtex)

A commonly used deep image format. Each 
pixel in an DTEX file is exported with its Z-
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Format Specification Description

depth information. Additionally, if a pixel is 
semi-transparent, the color and depth 
information of pixels further back is stored 
along with it. If your scene has multiplane or 
3D elements, this format can be used for 
compositing your animation with other 
graphical elements in 3D animation software.

NOTE 

Exporting in Deep Texture 
requires RenderMan to be 
installed on the machine and 
the path to RenderMan 
properly configured in 
Harmony. For more 
information, see the Setting 
3D Renderer Paths topic of 
the User Guide.

Colour Space

The colour space in which to render your scene’s frames. When a specific colour 
space is selected for a Write node, frames rendered by this Write node will be 
converted from the project’s working colour space to the Write node’s colour 
space.

The following colour spaces are supported in Harmony:

 l Scene Working Colour Space: The same colour space as the one 
selected in the Colour Space tab of the Scene Settings dialog. 

 l Linear: The same primaries and white point as sRGB and Rec. 709, but 
with no gamma transfer curve applied to the colour values. This colour 
space is useful for compositing intermediary images that are meant to be 
rendered in sRGB or Rec. 709.

 l Display P3: A colour space commonly used for digital projection. It has 
the same primaries as DCI-P3, the same white point as sRGB and the 
same gamma transfer curve as sRGB.

 l Display P3 Linear: The same as Display P3, except with no gamma 
transfer curve. This colour space is useful for compositing intermediary 
images that are meant to be rendered in Display P3.

 l Rec. 709: The colour space used for HDTV. It has the same primaries and 
white point as sRGB, but has a different gamma transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, except with a 
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gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
of the standard gamma curve for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV (UHDTV). It 
has a complex gamma transfer curve and primaries that cover more of the 
human-perceivable colour space than other colour spaces, especially in 
the area of human-perceivable greens. 

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with a simple 
gamma transfer curve of 2.4 (per ITU-R BT.1886). This colour space exists 
because some editing systems use a gamma transfer curve of 2.4 instead 
of the standard gamma curve for Rec. 2020.

 l Rec. 2020 Linear: The same colour space as Rec. 2020, except with no 
gamma transfer curve. This colour space is useful for compositing 
intermediary images that are meant to be rendered in Rec. 2020.

 l sRGB: A colour space typically used for standard computer monitors. It 
has the same primaries and white point as Rec. 709, but has a different 
gamma transfer curve.

NOTES 

 l When rendering a movie in a specific colour space in QuickTime 
Movie (*.mov) format on macOS, the movie buffer data will be 
tagged with the corresponding ICC colour profile.

 l When rendering a movie in a specific colour space in QuickTime 
Prores Movie (*mov) format, the movie colour space ‘nclc’ tag 
will be only set as:

 l HD (1-1-1) if using “Rec. 709” colour space

 l BT.2020 (9-1-9) if using “Rec. 2020” colour space

 l P3 D65 (12-1-1) if using “Display P3” colour space

 l When rendering frames in a specific colour space,  the following 
file formats will be tagged with their colour space information:

 l Portable Network Graphic (.png)

 l Photoshop Document (.psd)

 l OpenEXR (.exr)

OpenEXR files are only tagged with the coordinates for their 
white point and primaries.

Colours

Drop list with colour modes. Available modes depend on the selected file type.

 l Greyscale

 l Colour

 l Colour + Alpha
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Depth (bits/channel)

Drop list with bit depth value and a label next to it "bits/channel". Available bit 
depth depends on the selected file type.

 l 8

 l 10

 l 12

 l 16

Compression

Drop list that appears for EXR only.

 l Zip (per scanline)

 l Zip (16 scanlines)

Inverted Channels A checkbox that appears for DPX only.

Movie

Select this option to create a QuickTime movie. When enabled, the Movie Folder 
and the Movie Filename fields appear among the Drawing Folder and Drawing 
Filename fields. 

Video Format

The drop down list to the right of the Movie option. Allows you to select one of 
the following formats: 

 l QuickTime ProRes Movie (*.mov): The Apple QuickTime format. This is 
the default export format and is recommended for its portability, and also 
because it allows you to choose among several video codecs.
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NOTES 

 l On Windows, Apple QuickTime must be installed to 
allow Harmony to export QuickTime movies. You can 
configure the export of QuickTime movies to use any 
codec that is compatible with QuickTime, including 
H.264, MPEG-4 and Animation.

 l On macOS, Harmony uses Apple AVFoundation to 
export QuickTime movies, which allows you to export 
using codecs such as H.264, Apple ProRes 422 and 
Apple ProRes 4444, among others.

 l If you are looking to export a QuickTime movie with 
transparency, be sure to choose a codec that supports 
encoding with an alpha channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime 
library to export QuickTime movies. This only allows you 
to export videos in non-proprietary formats such as 
Motion-JPEG, Photo JPEG, PNG or Uncompressed 
(RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 
codec, which is supported by most web browsers.

NOTES 

 l Using this format does not require additional software. 
However, if this is the first time you export a movie in 
H.264/MPEG-4 format, you will be prompted to 
download the OpenH264 library from Cisco. Simply click 
Yes when prompted, and Harmony will automatically 
download the library, then export the movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 4096×2304. 
Each dimension must be a multiple of 16 pixels. 

 l Audio exported in this format is encoded in PCM 16-bit 
stereo, 22.05 kHz.

 l Windows Media Video (*.wmv): The native format for Windows Media 
Player.
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NOTES 

 l Windows Media Video (.wmv) files can only be exported 
on Windows. 

 l Video players and editors on non-Windows systems can 
generally not open Windows Media Video (.wmv) files.

 l Flash (.swf)

 l Image sequence in Jpeg (.jpg), Targa (.tga) or Portable Network 
Graphics (.png) format.

Movie Options

Opens the movie settings dialog box for your selected video format, in which you 
can set the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on Windows: Movie Options Dialog Box 
(macOS),

 l QuickTime Movie (*.mov) on macOS: QuickTime Movie Settings Dialog 
Box (Windows)

 l Windows Media Video (*.wmv): Windows Media Video Settings Dialog 
Box (Windows)

NOTE 

This button is available on Windows and macOS only.

Video Options

Opens the video settings dialog box, which allows you to set the video 
compression settings for your video file—see OpenQuickTime Video Options 
Dialog Box (GNU/Linux).

NOTE 

This button is available on GNU/Linux only.

Sound Option

Opens the audio settings dialog box, which allows you to set the audio 
compression settings for your video file—see OpenQuickTime Sound Options 
Dialog Box (GNU/Linux). 

NOTE 

This button is available on GNU/Linux only.
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Enabling Tab

You can create several Write nodes for a single scene and, by default, when a scene is rendered, all of its Write 
nodes will perform their render.  However, using the options in the Enabling tab, you can set up some Write 
nodes to only perform their render if the scene is rendered at a specific resolution. This is mostly useful on 
Harmony Server, as Harmony Server allows you select the resolution at which to render a scene when sending 
a scene for rendering by the Harmony database's render farm. 

A good example of how this can be useful is if your scene has storyboard thumbnails in the corner, and a Write 
node connected to a composite that crops the picture to only include the storyboard thumbnail, so that your 
scene can export both the final animation and the animated storyboard when rendered. You can set up your 
scene's main Write node to only work when exporting the scene at the scene's original resolution, and the 
storyboard thumbnails Write node to only work when exporting at the desired resolution for an animated 
storyboard. 

This option allows you to filter with either resolution presets, or by specifying the width and height of the 
chosen resolution in pixels. You can hence create custom resolution presets named after their Write node's 
purpose, to make it easier to choose the resolution when rendering a scene. 

Parameter Description

Always Enabled
Makes this Write node render every time the scene is rendered. This is the default 
option.

Enabled when 
Resolution Name is

Makes this Write node render only when the scene is rendered at the specified 
resolution preset. 

Filter Name Select the resolution preset at which to render the scene to activate this Write node.

Enabled when 
Resolution is

Make this Write node render only when the scene is rendered at the resolution with the 
specified width and height, in pixels. 

X Resolution
The width (in pixels) of the resolution at which to render the scene to activate this 
Write node.

Y Resolution
The height (in pixels) of the resolution at which to render the scene to activate this 
Write node. 
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Particle Nodes
You can access the Particle effects through the Node Library view. The Particle category contains all the nodes 
needed to build various Particle effect systems.

This section explains each node's purpose, its layer properties and how to adjust these properties. 

3D Region 865

Baker 867

Baker Composite 870

Bounce 871

Explosion 873

Gravity 875

Image Fracture 877

Kill 883

Move Particles 885

Orbit 887

Planar Region 890

Random 894

Region Composite 895

Repulse 896

Rotation Velocity 897

Sink 900

Size 901
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Sprite Emitter 903

System Composite 913

Velocity 914

Visualizer 917

Vortex 919

Wind-Friction 921
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3D Region

The 3D Region effect lets you define the 3D region, which can take many forms, such as a sphere, cone, 
cylinder or box. The 3D Region node acts in contrast to the Planer Region node, which generates and emits 
particles from a 2D plane.

You can connect a 3D Region to a Sprite-Emitter to define the region from which particles are generated. It 
could also be connected to a Bounce node to define a region against which particles bounce. If connected to a 
Sink node, it will define a region where the particles will disappear.

How to preview the 3D Region

 1. From the top menu, select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + 
F11 (macOS).
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3D Region Properties

Parameter Description

Name Allows you to change the name given to the node.

Shape

Choose a shape for the 3D Region by clicking on the Type drop-down menu and 
selecting either Box, Cylinder, Cones, Sphere or Image.

If you select Image, you must connect the node of a vector drawing or a 
vectorized bitmap image to the left port (blue node) of the 3D Region node. The 
particles will then be emitted from that image' shape. Don't forget that you can 
rotate your vector drawing in 3D space by enabling the 3D option in its Layer 
Properties.

Size

Enter different values into the Width, Height and Depth fields to change the 
dimensions of the 3D Region's selected shape. Depending on the shape selected, 
some fields may be greyed-out if they are not applicable. You can also modify the 
shape with the Transform Tool by grabbing the control handles (turquoise 
squares) in the Camera or Perspective views. You can also change the 
dimensions of the region over time by click on the function button at the end of 
each field.

Radius

Enter different values in the Max or Min fields to change the inner or outer radius 
of applicable shapes, such as a cylinder, cone or sphere. You can also change the 
radii by grabbing the control handles (turquoise squares) in the Camera or 
Perspective views. The radii of the region can be changed over time by clicking 
the function button at the end of each field.
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Baker

The Baker effect, also known as Particle-Baker, lets you make decisions about the particle system's position, 
angle, number, etc. in the same way that a baker would make decisions about the ingredients that go into 
baking a cake. The Baker performs the particle simulation, combining all the ingredients specified to get the 
final result. The Baker must always be connected to the Particle-Visualizer.
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Particle Baker Properties

Parameter Description

Name Allows you to change the name given to the node.

Seed

Allows you to apply a random effect to the particle system. There may be times 
when you want to copy the particle system to two different locations on your 
screen. You can take the out-port of the Particle System Composite node, and 
plug this into two separate Bakers and Visualizers. Then you could move one 
system over by attaching a peg into the left side of one Visualizer. This makes the 
two systems look exactly the same. Add a random Seed to make them look 
different.

Simulation Quality

Defines how many simulation steps per frame are performed. The lowest quality 
creates one step per frame. Raising the quality will divide the simulation time and 
create two or more steps of simulation for each frame. This increases the 
computation time, but also increases the quality of the result.

Number of Pre-roll Frames

Allows you to select a start position in the particle effect sequence, other than 
the start (generation) of the sequence. This allows you to start the particle effect 
part-way through its cycle, even if it starts on frame 1 of your project. An example 
of when this parameter might come in handy is when you want it to be already 
raining at the start of your scene. If you don't change the number of Pre-roll 
Frames, it will always start to rain at the beginning of the scene.

Maximum Number of 
Particles

Lets you put a limit on the number of particles that will be created; particles will 
stop being generated once this number is reached. 

Age Particles
Tracks how long a particle has existed in its cycle from the time of its inception. 
Knowing a particles "age"  means you can tack other parameters onto its life span, 
such as having the particle start to disappear or change colour at a certain 
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time.age.

Move Position

Allows the particles to move position, otherwise the particles cannot flow in a 
specified direction. This option also exists in the Move Particles node. You do not 
always need a Move Particles node; this is why this option exists in the Baker. 
This option is also useful when your Move Particles node is cut off by a sink—
see Sink on page 900. 

Move Angle

Allow particles to flow from different angles. This option also exists in the Move 
Particles node. You do not always need a Move Particles node; this is why this 
option exists in the Baker. This option is also useful for when your Move 
Particles node is cut off by a sink—see Sink on page 900. 
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Baker Composite

The Baker Composite effect is used to composite more than one Particle-Baker, as well as any other elements 
that need to be combined before they pass through the Particle Visualizer.

870



Bounce

The Bounce effect lets you to make particles bounce off a surface with realistic physical modelling. This node 
should have a region connected to it, and that region will act as a bounce plane so when any particle hits it, it 
will bounce off at the correct angle.

Bounce Properties

Parameter Description
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Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Friction

Enter a value in this field to increase the amount of friction each particle 
experiences as it makes contact with the planar surface. A positive value creates 
more friction and slows the particle down. A negative value lessens the friction 
and makes the surface appear more slippery.

Resilience

Increases or decreases the bounciness of the particle. A value of zero causes the 
particle to hit the planar surface once and slide off any downward facing angle. A 
positive value, even by decimal increments, causes the particle to become 
bouncy. A negative value deadens the effect, the same way a lack of Region 
would.

Cutoff Speed
Increasing this value widens the bounce arc. If the connected Planar Region is 
completely flat, a value of zero will cause the particle to bounce up and down in 
place. A tilted plane in the direction of the bounce will also widen the arc.
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Explosion

The Explosion effect lets you create an explosion. As it is an Action node, it should be connected to the Particle 
System Composite after the Sprite Emitter. As the explosion occurs, the particles will burst rapidly away from 
the centre of the explosion (the centre of the defined Region), then gradually slow down.
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Explosion Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Coordinates
Use the X, Y and Z fields to enter different position values to move the particle 
system around in 3D space. You can also connect a Peg node to the Explosion to 
manipulate its position with the Transform or Move tool.

Radius

Defines the surface of an invisible sphere. As the explosion occurs, the exploded 
particles inside the boundaries of this sphere will be effected by the force of the 
explosion, while the particles that eventually pass through will remain 
unaffected.

Sigma
The higher the Sigma value, the longer it takes for the particles to completely 
disappear, even if the initial explosion seems to occur just as rapidly.

Magnitude
Defines the magnitude of the explosion. The greater the magnitude, the faster the 
particles break up.

Epsilon

This value works in opposition to the Sigma value. The higher the value, the 
slower the initial explosion occurs. If the value is high (an integer value) then 
larger particles remain suspended for a longer period of time from the initial 
explosion and takes a while to gradually break down. A smaller (decimal) value 
breaks the particles down to smaller forms more rapidly from the time of the 
initial explosion. 

: 
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Gravity

The Gravity effect lets you define the gravity of the particle system.

Gravity Properties

Parameter Description
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Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Apply Gravity

Forces the particle system to adhere to the force of gravity. Values must be 
entered into the Direction fields, along with enabling this option, in order for it to 
work. If this option is not selected, the particle system will explode outwards 
from its origin point.

X Direction
Directs the particle stream to the left or right (along the X-axis). A value of 1 
forces the particle stream to the right, while a value of -1 forces the particle 
stream to the left.

Y Direction
Directs the particle stream up or down (along the Y-axis). A value of 1 forces the 
particle stream to flow upwards, while a value of -1 forces the particle stream to 
flow downwards.

Z Direction
Directs the particle stream forwards or backwards (along the Z-axis). A value of 1 
forces the particle stream to flow forwards, while a value of -1 forces the particle 
stream to flow backwards.

Apply Gravity between 
Particles (Relative Gravity)

Applies gravity between each particle, taking their masses into account. The 
mass of the particle can be specified at emission time via the Sprite or Image 
Emitter. 

Relative Gravity Magnitude Adjust the amount of gravity applied between particles. 

Relative Gravity Epsilon
The acceleration falls off the further the particles get from each other. When the 
particles are very close to each other, the acceleration becomes very high, so you 
should define a small region around the particles so they never actually touch.

Relative Gravity Maximum 
Distance

Adjusts the radius beyond which particles do not affect each other.
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Image Fracture

The Image Fracture effect breaks an image into pieces. This effect requires two image objects: the image to be 
cut and the shape of the cut pieces (matte). The image to be cut can be anything from a vector drawing to a 
bitmap image to an entire scene's composite—effects and all. The image to be cut should be hooked to the 
Image Fracture's right port.

The matte should be flattened if you want it to work like a cookie cutter (hollow shape with a frame) and can 
be composed of brush or pencil lines. It can also be a solid shape, many solid filled shapes, and even many solid 
filled overlapping shapes. When the matte is made of overlapping pieces, the cut image will be multiplied at 
those zones to break apart in multiple layers. The matte drawing should be hooked to the Image Fracture's left 
port.

The two image objects overlap perfectly when combined in the Image Fracture. This means that you must take 
the 12 by 12 field into account when judging the scale and proportion of these objects. If the matte does not 
overlap a part of the image, that part of the image will not be cut. The matte does not have to be a continuous 
shape. It could be three separate circles, which would then be cut and pulled away from the image.
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NOTE 

You can display the grid and use the Light Table feature in the Drawing view while drawing or 
scaling the image and matte to ensure that they're the correct size relative to one another.

Here's an example of a node structure with the Image Fracture effect:
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Image Fracture Properties

Generation Tab

Parameter Description

Emission

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Type

You may want to design a variety of different drawings that will vary the 
appearance of the particle system. In this case, you should put each drawing on 
its own cell in the drawing layer. Each drawing will then be a new type of 
particle.

Type Generation Strategy
Lets you sequentially or randomly assign a type (moving from one drawing to the 
next).

Particle Type 0
This is the frame number of the first drawing. If you have a 5-frame cycle that 
starts on frame 1, you would put a 1 here.
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Particle Type 1
This is the frame number of the last drawing. If you have a 5-frame cycle that 
starts on frame 1, you would put 5 here.

Age

Age at Birth
A different start frame number can be entered in this field. This means that a 
particle can start with a different drawing than the drawing on frame 1.

Age at Birth Standard 
Deviation

Allows a random deviation for the birth of the particles. If you have a five-frame 
cycle that starts on frame 1, but you want the particles to be a random type, then 
you may want to set the Age and Birth to 3 with a standard deviation of 2. That 
means the particles will randomly be born at any frame from 1 to 5.

Advanced

Particles Mass
Defines a mass for the particles which will affect how the particles interact with 
gravity.

Align Initial Velocity
Aligns the initial velocity with the region from which the particles are being 
emitted. If you are emitting from a sphere, the particles will all start out moving 
away from the centre of the sphere.

Rendering Tab

Parameter Description

Transformation

Size over Age
Lets you determine the size of the particle as it ages. Attach a function to this 
attribute if you would like to, for example, have the particles get smaller as time 
goes on.

Directional Scale Scales the particle in the direction of its movement.

Directional Scale Exponent 
Factor

Sets an exponent here for how much you would like that particle to scale.

Align with Direction Aligns the particle in the direction of its movement.

Axis to Align Select the axis that you want to align. This axis refers to the axis of the Drawing 

880



grid from the Drawing node plugged into the emitter.

Flip X Axis to Match 
Direction

You may want to have the particle align to the X direction of movement. You can 
see this property being used in the Lemmings example.

Flip Y Axis to Match 
Direction

Similar to flipping the X axis, you may want to flip the Y axis of a drawing to 
match the direction of the particle movement.

Use Rotation of Particle Enables rotation on the particle.

Keep Volume
When you choose to do a Directional Scale, this will automatically maintain the 
volume of the particle by squashing it proportionally to how much it stretches as 
a result of the directional scale.

Colouring

Colouring Strategy Lets you choose how to define the colour of the particle.

Use Drawing Colour The particle remains the same colour as it was drawn with.

Map RGB Based on Age
Attach a function to this to vary the Red, Green, and Blue values of the particle as 
it ages.

Map RGBA Based on Age
Attach a function to this to vary the Red, Green, Blue, and Alpha values of the 
particle as it ages.

Apply Opacity Based on Age
Keeps the original RGB values from the drawing, but vary the Alpha (Opacity) 
according to a function that you define here.

Map RGB Based on Frame
Changes the Red, Green, and Blue values of the particles based on the frame. 
Changing based on the frame means that ALL particles will change colour on 
that frame, regardless of their age.

Map RGBA Based on Frame
Changes the Red, Green, Blue, and Alpha values of all particles on a given frame 
by attaching a function.

Apply Opacity Based on 
Frame

Uses the original RGB values from your drawing, but varies the Alpha (Opacity) 
of the particles on a certain frame by attaching a function to this.

Red, Blue, Green, Alpha This is where you can attach functions to the Red, Blue, Green and Alpha values. 
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You can also click on the colour swatch to adjust the colour.

Compositing

Blur

Lets you attach a function to define how you want the particles to blur based on 
the age, frame or camera distance of each particle. There are low and high quality 
blurs. Also, you can attach a function to define how all particles should be 
blurred. 

Blur Intensity
Lets you set a value or attach a function to animate the blur according to the type 
of blur that was defined from the drop-down list.

Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

A falloff rate of 0 causes the blur to fade out slowly, distributing the blur evenly 
from the edge of the drawing to the farthest edge of the blur.

A falloff rate of 1 causes the blur to fade out quickly so that the blur is heaviest 
at the edge of the drawing. 

Blend Mode Defines a blend mode for the particles to get cool effects.

Blend Intensity
This is a percentage of how opaque you want the particles to be blended. 50 = 
50% transparent. 100 = opaque.
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Kill
The Kill effect lets you determine when particles disappear.

Kill Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Use Maximum Lifespan Makes particles disappear when they reach their maximum lifespan.

Kill Younger

To use this parameter, you must attach a function to this property because if you 
select this option at time 0, you will never see any particles. If you set Kill 
Younger to 10, at time 0, there will be no particles older than 10, so you will 
never see any particles. 

It may be useful to have the particles animating over time, and at some point in 
time, you may want to kill all the younger particles. An example would be an 
animation where the particles change from blue to yellow. At every frame, new 
particles are generated, and the particles that already exist age. Then you would 
add an explosion that kills all particles younger than 10 frames. It would kill all 
the blue particles, leaving only the yellow particles.

883

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Kill Younger Than This is where you can animate the effect for Kill Younger.

Kill Older Makes particles disappear when they reach a certain level of maturity.

Kill Older Than Lets you set the age at which particles disappear.
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Move Particles

The Move Particles effect lets you determine whether the particles are stationary (like grass) or moving (like 
rain), and you can animate this function on and off. 

Move Particles Properties

Parameter Description

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Age Particles

Ages the particles. Note that if you select the Move Position and Move Angle, 
then the particles will age implicitly. If you do not want the particles to move, but 
still want them to age, deselect Move Position and Move Angle, and select Age 
Particles. 

The Age Particles parameter also exists in the Baker, however whatever happens 
in the Baker happens after everything else in the particle system. So, if for 
example you have a Kill node, it will kill the particles before they age. You 
probably want to age the particles before you determine whether to kill them. 
Therefore, if you have a Kill node, make sure to age the particles in your Move 
node before you kill them. If you age the particles both in the Move and Baker 
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node, then the particles will age twice on that frame instead of once.

Move Position

Lets you enable movement on the particles. There is also a Move Particles option 
in the Baker. If it's deselected in the Baker and in the Move node, the particles will 
not move; they will simply generate in place and stay there. If the option is 
selected on the Baker, the particles will move. But if you need the particles to 
interact with another Action, say a Sink, then you want the particles to move 
before they reach the sink. This is why you have a separate Move node, so you 
can place this Move before (to the right of) the Sink in your particle system 
composite.

Move Angle
Like the Move Position, this enables the rotation of particles in the particle 
system.

Move Particles Follow Each 
Other

Allows one particle to follow another particle, through an attraction between the 
particles. This is particularly useful when you want to create a snake-like effect, 
where the particles are animating across the screen and following each other.

Follow Intensity
Lets you adjust the strength of the attraction between particles following each 
other.
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Orbit

The Orbit effect lets you define an axis the particles will be attracted to and orbit around. You can place a Peg 
layer into the orbit to move the position of the orbit without adjusting the parameters in the Layer Properties.

Fine-tuning the Orbit effect can take a bit of finesse because the orbit takes into account the velocity of the 
particles, and uses this to determine whether:

• The particle will orbit around the axis

• The particle will be influenced but eventually escape

• The particle will hardly be influenced at all. 

This is just like how gravity between astral bodies works in space. Here are some examples of how having the 
orbit in the wrong place can give some cool (but perhaps not useful) effects:

You will also want to make sure that your initial velocity is varied, so use an interpolated speed and set two 
different values. That way, there will be a spread between them. If not, then you will get the effects as shown 
above.

Also, you should use the Peg layer to move the position of the Orbit node around until you find the right spot to 
get the look you're trying to achieve. It also helps to set some pre-roll frames on your Baker to get things 
ramped-up before you start to manipulate the position of the Orbit node.

Here's an example of what a typical node structure with an Orbit node looks like:
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Orbit Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Orbit Type
Lets you select the type of Orbit you want to use. For most scenarios, like 
asteroids orbiting a planet, a point will suffice. If you want to rotate around an 
axis instead, choose between the X, Y, Z axes or set up your own custom axis.

Magnitude Adjust the amount that the acceleration of each particle will be adjusted. The 
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higher the value, the more the particle will accelerate towards the orbit. A 
magnitude of 0.001 is a good number to use for this. When the magnitude is set 
too high, the particles will simply fly out into space.

   

Point X
Defines the X position of the centre of the Orbit. You may also leave this at 0 and 
use a peg to move the position of the Orbit node.

Point Y and Z Defines the Y and Z position of the centre of the Orbit.

Direction X

Defines the X component of the axis of rotation for the orbit. This is only taken 
into account if you choose to set up a custom axis. If this is set to 1, and Y and Z 
are set to 0, then the axis will be going in the same direction as the X axis. If the X 
component is set to 1, and the Y component is also set to 1, then the axis will be 
at a 45 degree angle between the two.

Direction Y and Z Defines the Y and Z components of the axis of rotation for the orbit.
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Planar Region

Like the 3D region, this determines a region that you can use as a source or as a bounce plane, but instead of a 
3D region, it's a 2D plane. Connect a peg to the right in-port to adjust the position of the plane.
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Planar Region Properties

Parameter Description

Name Allows you to change the name given to the node.

Shape Type

Allows you to define the type of shape of the plane. 

The following shape types are available:

 l Basic shape types:

Those are simple shapes that are defined by a small set of coordinates.

Depending on the type of shape you choose, the parameters below will 
be available or greyed out so that you can adjust the actual shape of the 
plane. However, you can also adjust the shape of the plane visually using 
the  Transform tool. To do that, you must display the Planar-Region’s 
control by selecting the Planar-Region node in the Node view, then doing 
one of the following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

The following basic shape types are available:

 l Rectangle: A rectangle. You can set the size of the rectangle 
using the Width and Height parameters.
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 l Disc: A circle with a circular hole in the middle. You can adjust the 
disc’s size by changing the Radius parameters, where Minimum is 
the radius of the hole and Maximum is the radius of the disc. 

 l Triangle: A triangle. The coordinates of all three points can be set 
in the X and Y fields under P1, P2 and P3.

 l Line: A line. The coordinates of the two points defining the lines  
can be set in the X and Y fields under P1 and P2.

 l Point: A single point. Its coordinates can be set in the X and Y 
fields under P1.

 l Image shape types:

Those shape types use an input image to define the plane. To use them, 
connect a single drawing layer to the left input port of the Planar-Region 
node.

The two following image shape types are available, and produce slightly 
different results:

 l Image: With this option, the input image shape is used to 
determine the planar region, but its alpha is also used to modulate 
the density of the particles. For example, semi-transparent areas 
will have less particles than fully opaque ones. 

However, with this option, the region is cropped to the input 
drawing’s 4:3 grid. By default, this grid is shrunk to fit the vertical 
resolution of the scene. Hence, with this option, the particles will 
be cropped by a frame that has a 4:3 aspect ratio and will not 
reach all the way to the left and right edges of the camera frame. 
To work around this, you can use the Vector Drawing option, or 
set your scene’s field of view to Horizontal Fit—see Scene 
Settings Dialog Box on page 210.

 l Vector Drawing: This uses the entire shape of the input drawing 
to define the planar region, without accounting for the drawing’s 
grid. As a side effect, an input drawing that is considerably bigger 
than the camera frame will result in more sparse particles. This 
option ignores the alpha of the input image, and only uses its 
shape. 

Mirror Negative Frames Mirrors the input peg transformation to generate positions for frames before the 
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scene begins.  

Size
Width: The width of a rectangular shape.

Height: Adjust the height of a rectangular shape.

Radius
Minimum: The radius of the hole for a disc shape. 

Maximum: The radius of the whole disc for a disc shape. 

P1

X: The X position of Point 1. Point 1 could refer to the point on a triangle, line, or 
point.

Y: The Y position of Point 1.

P2
X: The X position of Point 2. Point 2 could refer to the point on a triangle or line.

Y: The Y position of Point 2.

P3
X: The X position of Point 3. Point 3 refers to a point on a triangle.

Y: The Y position of Point 3.
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Random
The Random effects lets you put a random seed on some qualities like acceleration, speed, rotation speed, and 
position. There's also a Seed value in the Baker, but you may only want to make one particular aspect of the 
system random. This effect gives you control over the randomness of a particular property.

Random Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Parameter
Lets you choose a parameter to make random: None, Acceleration, Speed, 
Rotation Speed, and Position.
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Region Composite

The Region Composite effect lets you composite multiple regions, 3D regions or planar regions. You may want 
to emit particles from multiple regions in the same particle system.
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Repulse
The Repulse effect repulses a particle around a region, but is different than the Bounce node as it is repelled 
before it physically hits the region.

Repulse Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Magnitude
This value should be between 0 and 2. The higher the value, the more drastically 
the particles will be repulsed.

Look Ahead
Determines how far ahead of the particle's current position to see whether there's 
an obstacle coming. This value should be between 0 and 100.

Epsilon
Affects how quickly the effect of the repulse wears off. The smaller the number, 
the longer the effect lasts. This value should be between 0.1 and 0.0001.
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Rotation Velocity

The Rotation Velocity effect lets you define the initial rotational velocity of the particles. The values that you 
set up for this node refer to each individual particle's drawing axes. This means that if you choose to rotate 
around the X-axis, it will rotate around each particle's local X-axis as defined by its drawing plane.

The rotational velocity should be set before you emit the particles, such as to the right, so the velocity is taken 
into account when the particles are created.
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Rotation Velocity Properties

Parameter Description

Name Allows you to change the name given to the node.

General

Trigger: An on/off switch using binary code. 1 = on, 0 = off.

Axis Type: Lets you select the type of axis to use.

• Use Input Shape: Uses a region to define the rotational axis of the 
particles. The axis of each particle's rotation will be perpendicular to the 
plane that particle is created on.

• Constant Axis: If you choose to rotate the particles around a constant 
axis, then each particle will rotate around the same axis. This axis will 
then be defined as Axis0.

• Interpolated Axis: If you choose to rotate the particles around an 
interpolated axis, that means each particle will have its own rotational 
velocity which lies somewhere between Axis0 and Axis1.

Axis

Axis0 X: Defines the X component of Axis0. If you set the X to 1, and the Y and Z 
to 0, then the particle will rotate around its X-axis as defined by its drawing 
plane. If you set X to 1 and also Y to 1, then it will rotate around an axis that is 45 
degrees between X and Y.

Axis0 Y: Defines the Y component of Axis0.

Axis0 Z: Defines the Z component of Axis0.
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Axis1 X: Defines the X component of Axis1. This applies only when you have 
selected an Interpolated axis.

Axis1 Y: Defines the Y component of Axis1.

Axis1 Z: Defines the Z component of Axis1.

Speed (Degrees/Frame)

Minimum: The minimum initial rotation that a particle can have, in degrees per 
frame.

Maximum: The maximum initial rotation that a particle can have, in degrees per 
frame.
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Sink
The Sink effect causes particles to disappear when outside the region that is plugged into the sink. It can also 
be inverted, so the particles disappear when they enter the region instead.

Sink Properties

Parameter Description

Name Allows you to change the name given to the node.

Invert
The default behaviour of the sink is for particles to disappear when they depart 
the region. When inverted, the particles disappear when they enter the region 
instead.
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Size
The Size effect lets you animate the size of the particles.

Size Properties

Parameter Description

Name Allows you to change the name given to the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.
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Size Type

Lets you select a type for the size. If you choose Constant Size, then all particles 
will be animated to have the same size. If you choose Input Shape instead, then 
you must input a Region into the in-port of the Size node. It will use this region 
to determine the size of the particles.

Size Lets you adjust the size of the particles.

: 

: 
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Sprite Emitter

The Sprite Emitter effect is an all-purpose emitter. You can plug it into a drawing layer to generate particles 
that look like your drawing layer. You could also just output dot particles if you have no image layer connected. 
There are many parameters to control how particles are emitted. 

Sprite Emitter Properties

Generation Tab

Parameter Description

Emission Trigger: An on/off switch using binary code. 1 = on, 0 = off.
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Number of Particles: This is where you can define how many particles will be 
emitted on each frame.

Probability of Generating Any Particles: This is a probability percentage between 
0 and 100. If the probability is set to 100%, it will generate the Number of Particles 
specified. If you set the percentage to 50%, then there's only a 50% chance that it 
will generate the number of particles set in the Number of Particles. You can play 
with this value to add random spacing to the generation of particles.

Generator

Streak Seed: The number of streaks to generate.

Source Sampling Time Offset: Sets the streak start at a different time to offset its 
position.

Source Sampling Duration: This parameter is the key to generating streaks. If set to 
0, the behaviour is the same as before. If set to -10 for example, it will sample the 
input region (in this example the Planar-Region) 10 frames in the past. If in this 
mode, the Number of Particles parameter is the number of streaks to generate. If you 
want to generate five streaks for example, you need to set the Streak Size to a value 
different than 0, otherwise all the streaks will be at the same spot.

Source Samples Per Frame: The number of subdivisions for each frame. A value of 
1 generates a particle for each frame. A value of 16 generates a particle on each 
1/16th of a frame.

Streak Size: The radius of the sphere used for sampling the offset of the streak.

Region Size for Baked Particle Input: The Baked Particle Input property refers to 
when you use a Baker as an input to a Sprite Emitter. You can do this when you want 
to generate particles from other particles. When you do this, you have the option of 
setting a sphere around the source particle from which the new particle system will 
generate particles. That is the region which is referred to in this value. If you look at 
the following example, you'll see that the purple smiley faces are generating smaller 
green, blue, and yellow smiley faces. This is done by plugging the Baker from the 
purple smiley faces into the Sprite Emitter of the other smiley faces. See the 
following images:
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Type

You may want to design a variety of different drawings that will vary the appearance 
of your particle system. To do this, you should put each drawing on its own cell in 
the drawing layer. Each drawing will then be a new Type of particle.

Type Generation Strategy: 

Lets you sequentially or randomly assign a type (moving from one drawing to the 
next).

Particle Type 0: 

This is the frame number of the first drawing. If you have a 5-frame cycle that starts 
on frame 1, you would put a 1 here.

Particle Type 1:

This is the frame number of the last drawing. If you have a 5-frame cycle that starts 
on frame 1, you would put 5 here.
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Initial Parameters Tab

Parameter Description

Age

Age at Birth: A different start frame number can be entered in this field. This means 
that a particle can start with a different drawing than the drawing that you have on 
frame 1.

Age at Birth Standard Deviation: Allows a random deviation for the birth of the 
particles. If you have a 5-frame cycle that starts on frame 1, but you want the 
particles to be of a random type, then you may want to set the Age and Birth to 3 
with a standard deviation of 2. That means that particles will randomly be born at 
any frame from 1 to 5.

Set Maximum Lifespan: Makes particles die automatically.

Maximum Lifespan: This is how long the particle will exist before dying.

Maximum Lifespan Sigma: The lifespan variation of particles. If set to 0, all 
particles will have the same lifespan. A larger value means that particle lifespans 
will be distributed over a larger range.

Advanced

Particles Mass: Define a mass for the particles. This mass will affect how the 
particles interact with gravity.

Copy Particle Velocity for Baked Particle Input: If you select this option, the 
velocity of the parent system will be applied to the child system when a Baker is 
used as the region for a Sprite Emitter.

Add Particle Age for Baked Particle Input: If you select this option, the age of the 
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parent system will be inherited by the child system when a Baker is used as the 
region for a Sprite Emitter.

Align Initial Velocity: This aligns the initial velocity with the region from which the 
particles are being emitted. If you are emitting from a sphere, then the particles will 
all start out moving away from the centre of the sphere.

Minimum Initial Rotation: Define a minimum rotation in degrees that the particle 
can have when it is generated. There is also a separate Rotation-Velocity node in 
which you can define this parameter.

Maximum Initial Rotation: Define a maximum rotation in degrees that the particle 
can have when it is generated.

Rendering Tab

Parameter Description
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Sprite Selection

Rendering Strategy: Select a method to determine the particle type defined 
for each particle that is created.

• Render as Dot: Renders each particle as a dot. This is useful 
mainly for previewing the effects of your particle system without 
using the drawing layer (sprite).

• Use Frame Number: As the frame number increases, the type of 
particle will change to match the frame number. This means that 
ALL particles in the system will change together as the frame 
number changes. If you only have a few drawings, then you may 
want to enable Cycling to cycle those drawings.

• Use Frame Number as Index in Selector: When you select this 
option, you can use the Selector to animate the Frame Number it 
uses over time. So, instead of taking the current frame as the 
Frame Number, you can write your own function instead. For 
example, if you animate the selector so that at frame 1, it starts 
out at 2, then 8 frames later you add another keyframe to set the 
value to 4. Between frame 1 and frame 8, the particles will all 
change type together from what they look like on frame 2 to what 
they look like on frame 4.

• Use Particle Type: Each particle that is generated will look like 
the Particle Type that was assigned on the Generation tab. For 
example, if you use a value of 1 for Particle Type 0, and 6 for 
Particle Type 1, then each particle will be assigned a type from 1 
to 6. This type corresponds to the drawing that appears on the 
sprite on that frame number. So if you have a drawing layer called 
Sprite that is plugged into the left in-port of the Emitter, it will 
look for the drawings in cells 1 to 6 of Sprite to assign those 
drawings to each particle.

• Use Particle Type as Index in Selector: This option allows you 
to use the Selector to manually create a function that assigns 
how many of which particle will be created. 

For example, you can set the Particle Type to go from 1 to 100 in 
the Generation tab. Then use the Selector to remap the particle 
types to a certain drawing. So for example you could create five 
drawings, labelled 1 to 5, and use the selector to create mainly 
1s, no 2s, a few 3s, 4s, and a very few 5s. What it's doing is 
looking at the X-axis to find what the particle "type" is, then 
looking at the Y-axis to find out which drawing to assign to that 
"type." When you use 1 to 100 as a type, then when you're 
setting the values, they act as a percentage.
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• Use Age: As the particle ages, it will change appearance from 
what appears on the Sprite's first drawing to the subsequent 
drawings. This means that each particle can have its appearance 
animated as it gets older.

• Use Age as Index in Selector: You can animate the Selector to 
change how a particle ages over time. For example, if you have a 
Sprite with six drawings on it, you might want to animate it so it 
changes from drawing 1, on frame 1, to drawing 2, on frame 10, 
then drawing 3 on frame 14, drawing 4 on frame 16, drawing 5 
on frame 17, etc. so the particle rapidly ages. This allows you to 
change the timing of the aging dynamically through the selector, 
instead of having to modify the exposure of the cells on the 
Sprite.

Selector: Animates the Selector in conjunction with the Rendering Strategy 
to adjust the parameters that control the particle’s appearance at birth and 
over time.

Cycling: If you're using rendering strategies like Frame Number or Age, you 
may want to cycle the drawings. For example, if you are using Frame 
Number, but you've only got 5 frames worth of drawings in your Sprite, then 
if you use "No Cycle," your Particles will disappear after frame 5. You can 
choose to cycle Normally (1-2-3-4-5-1-2-3-4-5) or Back and Forth (1-2-3-
4-5-4-3-2-1).

Number of Drawings in Cycle: Lets you indicate how many frames from 
your Sprite you'd like to cycle.
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Transformation

Size over Age: Lets you determine the size of the particle as it ages. Attach 
a function to this attribute if you want to, for example, have the particles get 
smaller as time goes on.

Directional Scale: Scales the particle in the direction of its movement.

Directional Scale Exponent Factor: Sets an exponent here for how much 
you want that particle to scale.

Align with Direction: Aligns the particle in the direction of its movement.

Axis to Align: Select the axis that you want to align. This axis refers to the 
axis of the Drawing grid from the Drawing node plugged into the emitter.

Flip X Axis to Match Direction: You may want to have the particle align to 
the X direction of movement. You can see this property being used in the 
Lemmings example.

Flip Y Axis to Match Direction: Similar to flipping the X axis, you may want 
to flip the Y axis of a drawing to match the direction of the particle 
movement..

Use Rotation of Particle: Enables rotation on the particle.

Keep Volume: When you choose to do a Directional Scale, this will 
automatically maintain the volume of the particle by squashing it 
proportionally to how much it stretches as a result of the directional scale.

Colouring

Colouring Strategy: Lets you choose how to define the colour of the 
particle.

• Use Drawing Colour: The particle remains the same colour as it 
was drawn with.

• Map RGB Based on Age: Attach a function to this to vary the 
Red, Green, and Blue values of the particle as it ages.

• Map RGBA Based on Age: Attach a function to this to vary the 
Red, Green, Blue, and Alpha values of the particle as it ages.

• Apply Opacity Based on Age: Keeps the original RGB values 
from the drawing, but vary the Alpha (Opacity) according to a 
function that you define here.

• Map RGB Based on Frame: Changes the Red, Green, and Blue 
values of the particles based on the frame. Changing based on 
the frame means that ALL particles will change colour on that 
frame, regardless of their age.

• Map RGBA Based on Frame: Changes the Red, Green, Blue, and 
Alpha values of all particles on a given frame by attaching a 
function.

• Apply Opacity Based on Frame: Uses the original RGB values 
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from your drawing, but varies the Alpha (Opacity) of the particles 
on a certain frame by attaching a function to this.

• Use Particle Colour: Particles are created using the Red, Green, 
Blue and Alpha values at the current frame. The colour and alpha 
of each particle remain static. If those values are animated, the 
colour of new particles  change, while existing particles remain 
the same colour. 

• Use Particle Alpha: Particles are created with the Red, Green, 
Blue and Alpha value of the current frame. While their colours 
remain synchronized with the Red, Green and Blue values, the 
alpha of each particle remains static. So if the Red, Green, Blue 
and Alpha values are animated, the colour of all the particles will 
be animated, but each particle will retain the alpha they had 
when they were created.

Red, Blue, Green, Alpha: This is where you can attach functions to the Red, 
Blue, Green and Alpha values. You can also click on the colour swatch to 
adjust the colour.

Compositing

Blur: Lets you determine the Blur to apply to the particles.

• No Blur: No blur will be applied to the particles.

• Directional Blur Based on Age: Attaches a function to define 
how you want the particles to blur based on the age of each 
particle. The particle will blur in the direction of movement.

• Directional Blur Based on Frame: Attaches a function to define 
how all particles should be blurred at a particular frame. The 
particle will blur in the direction of movement.

• Low Quality Radial Blur Based on Age: Attaches a function to 
define how you want the particles to blur based on the age of 
each particle. This will be a low quality blur.

• Low Quality Radial Blur Based on Frame: Attaches a function 
to define how all particles should be blurred at a particular 
frame. This will be a low quality blur.

• Low Quality Radial Blur Based on Camera Distance: Defines 
how you want the particles to blur based on their distance from 
the camera. This is a low quality blur. 

• High Quality Radial Blur Based on Age: Attaches a function to 
define how you want the particles to blur based on the age of 
each particle. This is a high quality blur.

• High Quality Radial Blur Based on Frame: Attaches a function 
to define how all particles should be blurred at a particular 
frame. This is a high quality blur.
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• High Quality Radial Blur Based on Camera Distance: Defines 
how you want the particles to blur based on their distance from 
the camera. This is a high quality blur. 

Blur Intensity: Lets you set a value or attach a function to animate the blur 
according to the type of blur that was defined from the drop-down list.

Falloff Rate: The distance where the blur fades from the edge of the image. 
Select a value between 0 and 1. A falloff rate of 0 causes the blur to fade out 
slowly, distributing the blur evenly from the edge of the drawing to the 
farthest edge of the blur. A falloff rate of 1 causes the blur to fade out 
quickly so that the blur is heaviest at the edge of the drawing.

Blend Mode: Defines a blend mode for the particles to get cool effects.

Blend Intensity: This is a percentage of how opaque you want the particles 
to be blended. 50 = 50% transparent. 100 = opaque.
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System Composite
The System Composite node is where you connect all the "Actions" of your particle system. An action includes 
any of the light-purple nodes, like Gravity, Emitters, and velocity parameters. All of the "Actions" help to 
define the behaviour of the particle system.
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Velocity
The Velocity effect defines the initial velocity of the particles that are emitted in the particle system. You can 
select this node and select View > Show > Control to display the manipulation handles to help you set the 
parameters of this node. Use your Transform tool to modify the manipulation handles in the Camera or 
Perspective view.

Velocity Properties

Parameter Description

General

Trigger: Is an on/off switch using binary code, where 1 = on, while 0 = off.

Velocity Type

• Use Input Shape: If you plug a Region into the in-port of the Velocity 
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node, it will take the shape of this region to determine the initial 
velocity of the particles. They will take a velocity that is perpendicular 
to the surface of the shape.

• Constant Speed: Sets a constant speed for the initial velocity of the 
particles.

• Interpolated Speed: Each particle is assigned an initial speed that is 
somewhere between the two values set for Interpolated Speed.

• Random in All Directions 2D: All particles will be assigned a random 
velocity in any direction on a 2D plane.

• Random in All Directions 3D: All particles will be assigned a random 
velocity in any direction.

• Random in Cone: Particles will be assigned an initial velocity 
anywhere in the shape of a cone.

• Random in 2D-Pie: Particles will be assigned an initial velocity 
anywhere in the shape of a pie slice on a 2D plane.

Bilateral: Generates positive and negative velocities in a given direction. For 
example, you can generate particles with cone-shaped velocity, (e.g. a bazooka 
firing) going only in the forward direction, but you can also generate velocities in 
the opposite direction.

Direction of Normal (for 
Random in all Directions 2D)

Lets you input values for the perpendicular direction for the Random property in 
All Directions 2D.

X: Sets a value between 0 and 1 to determine how much influence the X-axis has 
over the direction of the normal. For example, if the X value is set to 1, and Y and 
Z are set to 0, then the perpendicular (normal) will be going in the X direction. If 
X is set to 1, and Y is also set to 1, then the axis will be 45 degrees, halfway 
between X and Y. Feel free to use the Manipulation Handles for the velocity node 
by selecting the Velocity node and then selecting View > Show > Control. This 
will allow you to use the Transform tool in the Camera View or the Perspective 
View to set the appropriate values.

Y: Set a value between 0 and 1 to determine how much influence the Y-axis has 
over the direction of the normal.

Z: Set a value between 0 and 1 to determine how much influence the Z-axis has 
over the direction of the normal.

Speed

Minimum: There are some speeds that are constant, and some that are a range of 
values between a minimum and maximum. Set the minimum speed here.

Maximum: Set the maximum speed for interpolated speeds.

Deviation from Direction Minimum Angle: This is used for Cone and Pie shapes. Put a non-zero value here 
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if you want there to be a hole in the middle of your cone or pie.

Maximum Angle: Set the maximum angle for your cone or pie here.
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Visualizer
The Particle-Visualizer effect renders and flattens the particle system down to a single plane. You can plug a 
peg module into the left port to animate the position of the whole particle system. Plugging a peg into the 
right port will move the depth where the flat plane is generated, so you can move it behind or in front of 
various other drawing layers in your scene. You can even have two Visualizers with pegs in the right in-ports 
that are at different depths to display some particles in front of and some particles behind a character or 
drawing in the scene.

Visualizer Properties

Parameter Description

Force Render as Dots

Temporarily renders your system as Dots when previewing a simulation. All 
drawings are ignored and the system is forced to render as dots.  
Note: You can also use the option View > Particle > Show Particles as Dots in 
OpenGL. When enabled, the particles will always be displayed as dots in the 
OpenGL preview mode to make playback speed faster for heavy scenes.

Rendering Order

Lets you set the order in which you want the particles to appear in the render.  

Back to Front: Added particles will appear behind existing particles.  

Front to Back: Added particles will appear in front of existing particles.  

Oldest to Youngest: Older particles will appear behind younger particles.  

Youngest to Oldest: Older particles will appear in front of younger particles. 

Ascending Types: Lower types will appear behind higher types.  

Descending Types: Lower types will appear in front of higher types.
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Fix Output Alpha

This is an important option when using some filters like Screen or Multiply in the 
Blend Mode that can be specified in the Rendering tab of the Emitter. When 
working with premultiplied images, if the alpha is not fixed in the visualizer, you 
may see some unusual artifacts. 

Scale Particle System Using 
Parent Peg

Respects the scaling of a particle system so you can position and resize it as you 
like. Old scenes with particle system will still work as this option is disabled.

Global Scaling Factor Lets you set the scaling factor for particle system.
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Vortex

The Vortext effect allows you to define an axis as a vortex, so the particles will spin around this axis.
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Vortex Properties

Parameter Description

Trigger An on/off switch using binary code, where 1 = on and 0 = off.

X Direction Defines the X portion of the axis of rotation for the Vortex.

Y Direction Defines the Y portion of the axis of rotation for the Vortex.

Z Direction Defines the Z portion of the axis of rotation of the Vortex.

Radius Defines the radius at the top of the vortex.

Exponent (1=cone)
Defines a curve that gives the Vortex a certain silhouette. 1 forms a cone, greater 
than 1 curves inward.

Up Acceleration Defines the vertical acceleration of the particles that are inside the Vortex.

In Acceleration Defines the inward acceleration of particles that are outside the Vortex.

Around Acceleration Defines the acceleration around the vortex of particles that are inside the Vortex.
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Wind-Friction
The Wind-Friction effect lets you define the amount of wind in the scene, and animate the wind over time.

Wind-Friction Properties

Parameter Description

Trigger An on/off switch using binary code, where 1 = on and 0 = off.

Friction/Wind X, Y, Z
Defines the amount that the wind will dampen or increase the speed of the 
particles in the X, Y or Z direction.

Min Speed
The minimum speed of particles that will be affected by the wind. Particles 
moving slower than this will not be affected

Max Speed
The maximum speed of particles that will be affected by the wind. Particles 
moving faster than this will not be affected.
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Shading Nodes
Harmony provides you with a wide series of parameters to customize your light shading effects.

Ambient Occlusion Node 923

Cast Shadow Node 927

Light Position Node 934

Light Shader Node 936

Light Shader Properties - Surface Light Tab 940

Normal Map Node 941

Normal Map Converter Node 945

Shape Curve Node 947

Shape Line Node 950

Shape Render Node 952

Surface Map Node 955

Layer Properties 956

Surface Normal Node 959

Tone Shader Node 961

Tone Share Properties - Surface Light tab 964

Volume Object Node 965
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Ambient Occlusion Node
The Ambient Occlusion node is part of the Surface Shading set of nodes and uses the Surface Map node to 
calculate the shadows.

The ambient occlusion node creates a shadow that helps to emphasize the depth and roundness of a 
character. This node shades areas on a surface that would be difficult for any ambient lighting to reach. The 
value of the shadow is relative to the depth of the pixel compared to depth of the surrounding pixels in a 
range. This shadow does not refer to the position of the light, but instead behaves as an ambient shadow in 
the scene.

NOTE 

For more information on how to use the Surface Shading set of nodes, refer to the User Guide.
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Layer Properties

Parameter Description

Shading All properties relating to the shading method appear in the Shading category.

Darkness

The percentage multiplier defining the darkness of the shadow.

A higher value will produce a darker shadow. Often, the ambient occlusion requires a larger 
multiplier in order to amplify its effect.

Affected 
Range

The range in pixels that is scanned when calculating the ambient occlusion. A lower value will 
produce a smaller, sharper shadow.

Shadow 
Max Depth 
Range 

In order to prevent major differences in shadows from surface to surface, the Shadow Max Depth 
Range limits the maximum difference between surface depths to the value defined.
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Parameter Description

Shadow 
Bias

The Shadow Bias can be used to lighten a shadow. This value is subtracted from the shadow’s 
value when calculated.

Darker shadows will be kept, but values below the shadow bias will be removed.

Abruptness

The Abruptness is a value that is used to change the sharpness of a shadow and affects its rate of 
change.

A value of one produces a linear shadow that falls off smoothly, a higher value will cause darker 
areas to become darker, and lighter areas to become lighter.

Shadow 
Gamma

Defines the rate of change in a shadow.

A lower value will produce a shadow that appears softer and changes from light to dark slowly. A 
higher value will appear sharper and darker, and changes from light to dark quickly.

Post-Blur The range of the blur applied to the calculated Ambient-Occlusion effect. 

Post-Blur 
Depth 
Threshold

In order to separate different surface elevations, this depth range defines a bucket-range in which 
the shadows are separated and blurred together. This can be used to keep certain edges of the cast 
shadow sharp, and other areas blended. 

Colour All properties relating to colour and value of the shadow. 

Use Image When checked, the colour of the cast shadow is tinted by the source image provided in the first 

925

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Parameter Description

Colour image port of the Cast Shadow node.

Colour 
(Red, 
Green, Blue 
and Alpha)

The colour used for the Cast Shadow.

If the Use Image Colour option is checked, this colour is used as a tint and is applied to the image 
colour based on the Image Colour Intensity parameter.

Matte
Properties relating to the optional Matte port of the Cast Shadow node. If you connect a node that 
outputs an image to the left edge of the Cast Shadow node, it will create a matte connection, and 
this image will be used as the matte for the Cast Shadow node effect.

Invert Matte

The Matte Port of the Cast Shadow node masks out pixels based on the opacity of the attached 
image.

When unchecked, the default behaviour is to render cast shadows only in areas with transparent or 
translucent pixels.

When checked, this behaviour is inverted and cast shadows will render only in areas with opaque 
or translucent pixels.
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Cast Shadow Node
The Cast Shadow node is part of the Surface Shading set of nodes. It uses the Surface Map node generate cast 
shadows over the generated surface of a rig.

The Cast Shadow is connected to an image source, the Surface Map node and a Light Position node. Based on 
the relative heights in the Surface Map and the Light Position, shadows are created when the light on a 
surface is being occluded by another surface in the way of the light.

NOTE 

For more information on how to use the Surface Shading set of nodes, refer to the User Guide.
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Layer Properties

Shadow Tab

Parameter Description

Shading All properties relating to the shading method appear in the Shading category.

Light Type

 l Directional: A light that is parallel in the scene. Each “beam” of light follows the direction 
defined by the light source and target, and point in the same direction. This type of light is 
used when the light source is far away or very big, like the sun. 

 l Point: A light that illuminates everything around it. Its “beam” of light will go in all 
directions like a fire.
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Parameter Description

Shading 
Type 

 l Smooth: The shadow effect will have smooth edges. 

 l Sharp: The shadow effect will have sharp edges. 

Shadow 
Length 

The shadow length defines how far, in pixels, the shadow will be cast after first being occluded on 
the surface.  

A value of 0 will not limit the shadow length, and instead, it will be defined by the position of the 
light source. 

A lower value will create a smaller shadow and a higher value will create a longer shadow that 
falls off as it recedes from the occluded point. 

Angle Bias

When calculating the cast shadows, this value is used as a bias comparing the light’s angle and 
the occlusion angle. A positive value will increase the occlusion angle and the shaded areas will 
appear darker. A negative value will decrease the occlusion angle and the shaded areas will 
lighten.  

This bias is applied prior to all further calculations. 

Expand 
Render 
Source 

In order to avoid over-rendering content out of screen this value defaults to 0. Otherwise, this 
value defines the range that the cast shadow will scan outside of the frame when rendering the 
shadow. 

Consider 
Truck 
Factor

Keeps the same ratio for the Light Shading system when the camera zooms in or out. 

Blur All properties relating to blurring the final cast image appear in the Blur category. 

Final Blur The range of the blur applied to the calculated cast shadow effect. 

Final Blur 
Threshold

In order to separate different surface elevations, the final blur threshold defines a bucket-range in 
which the shadows are separated and blurred together. 

This can be used to keep certain edges of the cast shadow sharp, and other areas blended. 
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Parameter Description

  

Anti-Alias 
Bias

This value works in conjunction with the Anti-Alias Blend.

When a shadow begins on an occluded surface, the bias is the amount of pixels ignored before 
rendering the shadow . This allows you to recede a shadow from its initial occlusion source.

Anti-Alias 
Blend

This value works in conjunction with the Anti-Alias Bias.

When a shadow begins on a surface, the shadow is blended with the surface for the amount of 
pixels defined by the Anti-Alias Blend.

Anti-Alias 
Blur

This value defines a blur range that is applied specifically to the starting-edge of a shadow. 

Colour All properties relating to colour and value of the shadow.

Shadow 
Darkness

A percentage value defining the opacity of the cast shadow. 

Shadow 
Gamma

Defines the rate of change in a shadow.

A lower value will produce a shadow that appears softer and changes from light to dark slowly. A 
higher value will appear sharper and darker, and changes from light to dark quickly.

Shadow 
Bias

The Shadow Bias can be used to lighten a shadow. This value is subtracted from the shadow’s 
value when calculated.
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Parameter Description

Abruptness

The Abruptness is a value that is used to change the sharpness of a shadow and affects its rate of 
change.

A value of one produces a linear shadow that falls off smoothly, a higher value will cause darker 
areas to become darker, and lighter areas to become lighter.

Use Image 
Colour

When checked, the colour of the cast shadow is tinted by the source image provided in the first 
image port of the Cast Shadow node.

Colour 
(Red, 
Green, Blue 
and Alpha)

The colour used for the Cast Shadow.

When the Cast Shadow uses the Image Colour, this colour is used as a tint and is applied to the 
image colour based on the Image Colour Intensity.

Image 
Colour 
Intensity

When Use Image Colour is checked, the incoming colour and value of the source image is used to 
tint the Cast Shadow colour.

This percentage value defines how much of the Cast Shadow colour is provided by the source 
image.

Matte
Properties relating to the optional Matte port of the Cast Shadow node. If you connect a node that 
outputs an image to the left edge of the Cast Shadow node, it will create a matte connection, and 
this image will be used as the matte for the Cast Shadow node effect.

Invert Matte

The Matte Port of the Cast Shadow node masks out pixels based on the opacity of the attached 
image.

When unchecked, the default behaviour is to render cast shadows only in areas with transparent or 
translucent pixels.

When checked, this behaviour is inverted and cast shadows will render only in areas with opaque 
or translucent pixels.

931

Harmony 21 Premium Reference Guide                          



Chapter 3: Nodes / Layers

Sampling Tab

Parameter Description

Sample 
Count

For more advanced cast shadows, the sampling values define the number of times the cast shadow 
is calculated in order to produce a higher quality render.

The Sample Count defines the number of points on the light source that are sampled in a radius 
parallel with the surface.

A higher number will produce a more rounded shadow with more refined edges.

Sample 
Size

When using a higher Sampling Count, the sample size defines the range used when sampling 
points from the light source. The samples are taken in an even distribution around the point of the 
light source at a radius defined by the sample size.

Soft The Soft Shadow Sample Count defines the number of points on the light source that are sampled 
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Parameter Description

Shadow 
Sample 
Count

in a line perpendicular with the surface.

This has less effect than the Sample Count, but is useful when calculating softer shadows with a 
larger Soft Shadow Sample Size.

This value defines how many times the shadow is resampled when occluded.

Soft 
Shadow 
Sample 
Size

The Soft Shadow Sample Size is a useful attribute that helps to define the falloff of a shadow as it 
recedes from the light source. A higher value will cause the trailing edge of a shadow to appear 
softer. 

Soft 
Shadow 
Weight

The Soft Shadow Weight defines the exponential weighting of the Soft Sampling. A value of one 
will maintain a linear sampling rate. A higher value will cause each subsequent sample to be taken 
from a further source than the last.

Shadow 
Noise

When rendering Cast Shadows, adding noise to the sampling can often produce a result more 
organic in appearance. 

Increasing the Shadow Noise property will add an offset of random noise to each sample taken. 
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Light Position Node
The Light Position node is the actual light source interacting with all the defined volume objects. You can set its 
position in relation to the objects and animate it over time. All volumes will react according to the light's 
motion.

This is not where you set the light type or colour. You'll be adjusting these in the Light Shader and Tone 
Shader nodes.

Light Position Properties

Parameter Description

Source Lets you control the value of the light source.

Target The point or direction at which the light is pointing

  3D Path: Lets you use a 3D path when animating the light.
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Separate: Lets you enter separate values for the X, Y and Z axes.

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you type in a new North/South coordinate corresponding to the 
desired position.

(z) Axis: Lets you type in a new Forward/Backward coordinate corresponding to 
the desired position.
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Light Shader Node
The Light Shader node lets you adjust the highlight parameters, such as the colour, to create the desired 
ambiance. You can animate most parameters over time to create a mood change, sunset or any other type of 
light transition. The beveling height and smoothing is set in the Normal Map node.

Light Shader Properties - Parameters tab

The Parameters tab can be used for both Light Shading and Surface Shading features.
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views.

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view.

Name Allows you to change the name given to the node.

Light
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Light Type

Directional: A light that is parallel in the scene. Each “beam” of light follows the 
direction defined by the light source and target, and point in the same direction. 
This type of light is used when the light source is far away or very big, like the 
sun.

Point: A light that illuminates everything around it. Its “beam” of light will go in 
all directions like a fire.

Spot: A light that forms a conical shape like a flashlight.

Cone Angle
The value that defines the light’s cone angle. This option is only accessible with 
the Light Type set to Spot.

Diffusion
Lets you play with the diffusion of the light on the surface of the drawing. In 
other words, it is the edge softness. This option is only accessible with the Light 
Type set to Spot.

Light Source Elevation
Defines the height of the spotlight. This option is only accessible when the Light 
Type set to Spot or Point.

Shading Type
Smooth: The light and tone fx will have smooth edges.

Sharp: The light and tone fx will have sharp edges.

Bias

Define the polarization of the light. 

When the Shade type is set to Smooth, it defines the width of the light’s smooth 
zone. 

When the Shade type is set to Sharp, the Bias defines the antialiasing on the edge 
of the hightlight or tone zone. But,if the Shade type is set to Sharp, the Bias 
option need a small value such as 0.1 or 0.2. The exponent will be able to 
compensate the limitation of this small value.

Abruptness
This is a multiplier value of the Bias option. It will define how quick the 
polarization of the light will change from a value to another.

Adjust Light Intensity Lets you adjust the light intensity.

Intensity Lets you set the strength of the light.

Multiplier Multiplies the value of the Intensity option.

Surface Reflectivity
This option is useful for exaggerating the light on the edge of the 3D geometry. 
The closer an edge is to the light source, the more intense the light will be.
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Colour

Red/Green/Blue/Alpha

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Use Image Colour
Lets you use the colour of the drawing in a lighter or darker colour for the 
highlight and tone fx.

Image Colour Intensity Lets you blend the colour of the light with the image colour.

Flatten Fx
This is useful when there are several highlight and tone fx, one over the other, 
but are supposed to be merged together. Sometimes, shadows and lights look 
better when they do not overlap.
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Light Shader Properties - Surface Light Tab

The Surface Light tab can be used only with the Surface Shading feature, therefore it should be ignored when 
using the Light Shading feature.

Parameter Description

Use Surface Light

Checking the Use Surface Lighting will have the Light Shader node/Tone 
Shader node consider the Surface depth when rendering the Light/Tone.

The specular detail and falloff is only available when this property is enabled.

Specular Transparency
The Specular Transparency property defines the opacity of the specular 
highlight. A higher value will make the specular more visible and a lower 
value will have the specular blend into the diffuse.

Specular Strength
The Specular Strength defines the sharpness of the highlight. A higher value 
results in a more defined, sharper highlight, a lower value results in a more 
diffused render.

Distance Falloff

The Distance Falloff is a percentage value defining the amount of light that 
falls off between the Light Position’s source and the Light Position’s target.

A value of 0 will result in a render in which the light has no falloff and 
remains consistent between the source and the target.
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Normal Map Node
The Normal Map node lets you centralize all Volume Object nodes and chisel out the shading 3D geometry 
(bevel height, smoothing, carving, etc.). It could be described as carving a bas relief. You only need one Normal 
Map node per light shading effect and, in general, only one per scene.

A normal map can be used to create other effects. If you're are working with an OpenFX plugin or other plugin 
requiring a normal map, you can use the Normal Map Converter node to translate the Harmony normal map to 
a format supported by your plugin. The Normal Map Converter node has been optimized to work with 
GenArts® plugins, but you also have the ability to use it on custom plugins..
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Normal Map Properties

Parameter Description

Volume Creation
Lists all the different volume object IDs are listed. This is where you can define 
the basic volumetric shape of each Volume Object node connect to the Normal 
Map.

Object

Let you add or remove Volume Object nodes that are connected to the Normal 
Map node.

Add All Defined Objects: Adds all Volume Object nodes connected to the 
Normal Map node.

Remove Selected Objects: Removes all Volume Object nodes from the Volume 
Creation list.

Name

The name that was previously set ineach Volume Object node. This information 
can be really helpful when there are many  volume objects listed. With a good 
name, it is easy to discover what the ID number is related to.    When you hover 
over this column, a tooltip appears listing all volume objects with the same ID.
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In the following image, the tooltip indicates that three copies were made from 
FootR-Object. By keeping the same name, you can easily see that each time you 
see a Volume Object named “FootR-Object”, the ID will be the same.

In the second example, a specific name was created for each volume object, even 
if they have the same ID. That way, it is easy to find a specific nodenode when 
searching for an element with the Search tool in the NetworkNode view.

ID

The identity number that was previously set in the volume object nodenode 
appears here. The tooltip in the ID column lists all drawing elements that are 
connected to the volume object with this identity number.

Bevel Size
Defines the size of the bevel on the contour of all the drawings related to a 
specific ID number
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Elevation
Defines the elevation of a specific volume object. The higher the value, the more 
the volumetry of this Volume Object resembles a conical or pyramidal shape.

Elevation Smoothness
Complementary to the Elevation column. Instead of keeping a conical or 
pyramidal shape, the shape will be smoothed to create a sphere or a bump shape. 
The edge will be round instead of sharp.

Bevel Multiplier A multiplier of the Bevel Size value in the board. This affects every object listed.

Elevation Multiplier A multiplier of the Elevation value in the board. This affects every object listed.

Elevation Smoothness 
Multiplier

A multiplier of the Elevation Smoothness value in the list. This affects every 
object listed.

Consider Truck Factor

Keeps the same ratio for the Light Shading system when the camera zooms in or 
out. This parameter cannot work properly if the size of the drawing, with a 
volume object nodenode, is changed on the drawing itself. In other words, if the 
animation is directly created on the drawing layer.

Override Modelling by Colour

Add Colour
Lets you add or remove any colour that will affect the Adding/ Carving options in 
the list beneath.  When you select this button, each colour palette in the scene is 
listed and all their swatches are displayed.

Swatches
The first column of the Override Modelling by Colour board is the Swatches. This 
column does not have a name. When you select a colour swatch from the Add 
Colour list, the colour swatch appears at the beginning of the list. 

Generate Normals Activates or deactivates the generation of the Normal Map.

Normal Map Quality Lets you change the Quality of the Normal Map from low to high. 

Output Elevation in Blue 
Channel

When selected, the Elevation is calculated and appears in the soft render mode. 

When deselected, the object ID appears in the soft render mode. 

Because it is connected to the blue channel of a drawing, the result will only 
affect the blue channel.
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Normal Map Converter Node
The normal map will carve and emboss a flat plane using vectors. The X, Y and Z coordinates of the normal 
map vectors are stored in RGB values to convert the 3D aspect into a visual result and use it to create various 
effects, such as light reflections (light shading). The X value is stored in the Red channel. The Y value is stored 
in the Green channel. The Z value is stored in the Blue channel.

NOTE 

Note that not all normal map formats are supported.

The Normal Map Converter uses the following formula per channel:

 l value * (+/- length) + offset

 l * +/- depending if inverse is set to true ("-" if true)

Parameter Description

Conversion Type
By default, the conversion type is set to Genarts. If you work with a different 
manufacturer and want to adjust the parameters, set the conversion type to 
Custom.

Offset
Offsets the original position of the vector. You need to read the plugin 
documentation to know the offset you need to use. You must use the same offset 
value as the manufacturer is using. By default the offset is set to 0.

Length
The Normal Map Converter normalizes Harmony vectors to 1. By default the 
length value is set to 1. If your plugin requires shorter or longer vectors, enter a 
value smaller or greater than 1. It will multiply the vector length.

Invert Red
Inverts the red value (x). If your value is 125, the invert setting will transform it to 
-125.
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Invert Green
Inverts the green value (y). If your value is 125, the invert setting will transform it 
to -125.

Invert Blue
Inverts the blue value (z). If your value is 125, the invert setting will transform it 
to -125.
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Shape Curve Node
The Shape Curve node is part of the Height Shape suite of nodes. It is used to define a curved region of a height 
map and it is rendered with the Shape Render node.

Shape Curve nodes help to define bezier segments on a height map that can be used for the Height Map port 
of a Volume Object node. Each Shape Curve node creates a control point to define the height shape. When 
Shape Curve and Shape Line nodes are chained together and connected to a Shape Render node, it generates 
a whole height shape. 

NOTE 

For more information on how to use the Height Shape nodes for a surface shading system, refer to 
the User Guide.
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Layer Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
name that is unique to its containing group.

Control 
Point

The position of the control point for this node in the stage. 

Just like the position of a drawing layer or a peg, the point can be positioned with a single 3D Path 
function or separate functions for the x, y and z axes.  The position of the point can be animated so 
as to animate the whole height shape. 
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Parameter Description

TIPS 

 l Using the  Transform tool, you can manipulate the control point of a Shape 
Curve  in the Camera view by displaying its control. To do this, select the node in 
the Node View, then do one of the following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

 l You can also display and manipulate all the control points for the entire height 
shape by selecting the Shape Render node that your Shape Curve nodes are 
connected to and displaying its controls.  

Handles

The position of the Bezier handles on each side of the control point. These handles affect the curve 
of the contour on each side of the control point. The position of these handles can also be defined 
with either a 3D Path or with separate functions, and they can be animated as well. 

TIPS 

 l Using the  Transform tool, you can also manipulate the Bezier handles of the 
Shape Curve’s control point in the Camera view. To do this, select the node in the 
Node View, then do one of the following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

 l You can also display and manipulate all the control points for the entire height 
shape by selecting the Shape Render node that your Shape Curve nodes are 
connected to and displaying its controls.  

Flatten Z

This nullifies the camera’s parallax effect when the point is moved back and forth on the z-axis. In 
other words, when enabled, moving the point on the z-axis will not change its apparent horizontal 
and vertical position. It will make the point higher on the height map without affecting how the 
shape is rendered.  

Close 
Shape 
Contour

This option is useful for the last point in a chain of Shape Line or Shape Curve nodes. The nodes 
that are chained together are automatically linked by a contour, but the first and last nodes are not 
linked by a contour by default. Enable this option on the last point in the chain to create and 
contour between the first and last point in the chain and make a closed shape. 
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Shape Line Node
The Shape Line node is part of the Height Shape suite of nodes. It is used to define a linear region of a height 
map and it is rendered with the Shape Render node.

Shape Line nodes help to define rigid linear surfaces on a height map that can be used in the Volume Object’s 
Height Map port. Each Shape Line node creates a control point to define the height shape. When Shape Curve 
and Shape Line nodes are chained together and connected to a Shape Render node, it generates a whole 
height shape. 

NOTE 

For more information on how to use the Height Shape nodes for a surface shading system, refer to 
the User Guide.

Layer Properties

Parameter Description

Name The name of the node as it appears in the Node View and the Timeline view. Each node must have a 
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Parameter Description

name that is unique to its containing group.

Control 
Point

The position of the control point for this node in the stage. 

Just like the position of a drawing layer or a peg, the point can be positioned with a single 3D Path 
function or separate functions for the x, y and z axes.  The position of the point can be animated so 
as to animate the whole height shape. 

TIPS 

 l Using the  Transform tool, you can manipulate the control point of a Line 
Curve  in the Camera view by displaying its control. To do this, select the node in 
the Node View, then do one of the following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

 l You can also display and manipulate all the control points for the entire height 
shape by selecting the Shape Render node that your Shape Line nodes are 
connected to and displaying its controls.  

Flatten Z

This nullifies the camera’s parallax effect when the point is moved back and forth on the z-axis. In 
other words, when enabled, moving the point on the z-axis will not change its apparent horizontal 
and vertical position. It will make the point higher on the height map without affecting how the 
shape is rendered.  

Close 
Shape 
Contour

This option is useful for the last point in a chain of Shape Line or Shape Curve nodes. The nodes 
that are chained together are automatically linked by a contour, but the first and last nodes are not 
linked by a contour by default. Enable this option on the last point in the chain to create and 
contour between the first and last point in the chain and make a closed shape. 
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Shape Render Node
The Shape Render node is the base node that uses Shape Curve nodes and Shape Line nodes to define and 
interpolate a surface. The Shape renders a height-map representing the height with a pixel value that can be 
used in the Volume Object’s Height Map port.

To generate shapes with the Shape Render node, you must connect several Shape Line or Shape Curve nodes 
in a chain, and connect the output port of the node at the bottom of the chain to theShape Render node. Each 
Shape Line or Shape Curve in the chain will represent a point in the shape.

You can combine several shapes in the same Shape Render node by creating several chains and connecting 
them in parallel to the Shape Render node. 

You can display and manipulate the control points for all of the Shape Line and Shape Curve nodes connected 
to your Shape Render node in the Camera view by selecting the Shape Render node in the Node View and 
doing one of the following:

 l In the Camera view toolbar, click on  Show Control .

 l From the top menu, select View > Show > Control.

 l Press Shift + F11.

NOTE 

For more information on how to use the Height Shape nodes for a surface shading system, refer to 
the User Guide.
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Layer Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must 
have a name that is unique to its containing group.

Edge Type

The Edge Type defines how the height is interpolated past the bounds of the defined shape. 

 l Hard Edge:  The render will not render past the edges of the defined shape. Anything 
outside of the shape will be transparent. 

 l Expand: The render will expand past the edges of the defined shape and interpolates by 
extrapolating the values within the shape.

Scale
On larger shapes, a smooth interpolated height map can be expensive to render. The scale 
property allows you to shrink the scale of the render, lowering the quality in favour of speed. 
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Parameter Description

Discretization 
Scale

The discretization scale defines the map detail in the defined shape. A lower value will add more 
interpolation points to the mask, creating a higher quality height map but taking more time to 
render. 

Pre-Blur
The Pre-Blur defines how rigidly the height map will adhere to the defined shape. A higher value 
will loosen the mapping, resulting in a less rigid map. 

Post-Blur The Post-Blur applies a blur to the final rendered height map.
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Surface Map Node
The Surface Map is part of the Surface Shading set of nodes. It is a more advanced version of the Normal Map 
node and system. It provides a surface mapping that is used by the Surface Normal, Cast Shadow and Ambient 
Occlusion nodes, and it allows you to define height ranges in a rig or a scene that help define the surface being 
lit and shaded.

This mapping is different from the Normal Map, as it allows for the height ranges to interact relative to each 
other. A Surface Map is able to Cast Shadows from one elevation to another and interacts within the scene in 
field units.

The Surface Map requires that Volume Objects be set up to appropriately define the surfaces. Once these 
Volume Objects have been created above the Surface Map, the map can be initialized.

NOTE 

For more information on how to use the Surface Shading set of nodes, refer to the User Guide.
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Layer Properties

Parameter Description

Name
The name of the node as it appears in the Node View and the Timeline view. Each node must have 
a name that is unique to its containing group.

Volume Creation

Object

Allows you to add or remove Volume Object nodes that are connected to the Surface Map node to 
the Volume Creation list, so that you can specify their properties. 

The drop-down menu will list every Volume Object node connected to the Surface Map node so 
that you can add them individually, as well as the following commands:

 l Add All Defined Objects: Adds all Volume Object nodes connected to the Surface Map 
node. 

 l Remove Selected Objects: Removes all Volume Object nodes from the Volume Creation 
list. 
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Parameter Description

Volume 
Creation list

Lists the different volume objects that are connected to the Surface Map node and which were 
added through the Object menu. In this list, you can define the basic volumetric shape and height 
range of each Volume Object node using the following fields:

 l Name: The name that was previously set in each Volume Object node. This information 
can be really helpful when there are many volume objects listed. With a good name, it is 
easy to identify to which Volume Object node the ID number relates.

When you hover over this column, a tooltip appears listing all volume objects with the 
same ID. The star (*) denotes multiple Volume Objects share the same ID.

 l ID: The identity number that was previously set in the volume object node appears here. 
The tooltip in the ID column lists all drawing elements that are connected to the volume 
object with this identity number.

 l Bevel Size: Defines the size of the bevel on the contour of all the drawings related to a 
specific ID number. The bevel is applied by blurring the Volume Objects sharing the same 
ID.

 l Elevation Min: The Z position in Field Units at which the lowest point of the Volume is 
mapped. Any baseline height, or Carving values at 0% will be mapped to this minimum Z 
value. Otherwise, the surface height is mapped to an interpolated value between the 
Elevation Min and Elevation Max.

 l Elevation Max: The Z position in Field Units at which the highest point of the Volume is 
mapped. Any baseline height, or Carving values at 100% will be mapped to this maximum 
Z value. Otherwise, the surface height is mapped to an interpolated value between the 
Elevation Min and Elevation Max.

 l Elevation Smoothness: Complementary to the Elevation column. Instead of keeping a 
conical or pyramidal shape, the shape will be smoothed to create a sphere or a bump 
shape. The edge will be round instead of sharp.

Elevation 
Smoothness 
Multiplier

A multiplier of the Elevation Smoothness value in the list. This affects every object listed.

Consider 
Truck Factor

Keeps the same ratio for the Light Shading system when the camera zooms in or out. 

Override Modelling by Colour
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Parameter Description

Add Colour

Allows you to add or remove a Override Modelling by Colour list below. 

Zones that are painted with the colours added to the list will have more or less elevation. This 
allows you to use specific colours to carve from or add to the surface of the volume object, and 
add complexity to its surface.

You can draw with one of the colours in the list on the Colour Art or Underlay Art layer so that the 
colour itself is hidden behind the artwork in the Line Art layer. The shape of the zone painted with 
this colour will still affect the surface.

Override 
Modelling 
by Colour 
list

The list of colours that are used to override the surface of the volume object. Zones painted with 
the colours in this list will have a different elevation than the remainder of the volume object.

Whether the elevation of the surface painted by the colour is lower or higher, and by how much, is 
determined by the value in the Carving <------> Adding field for that colour. If that value is higher 
than the Volume Object’s Elevation Baseline parameter, then the zones painted with that colour 
will be more elevated. If the value is lower than the Volume Object’s Baseline parameter, then the 
zones painted with that colour will be less elevated.
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Surface Normal Node
The Surface Normal node is part of the Surface Shading set of nodes. It converts the output of a Surface Map 
node into a directional normal map, which is the same kind of output that is given by the Normal Map node in 
the legacy Light Shading system, and which is used by the Light Shader and Tone Shader nodes to create 
light shading effects.

Using the Surface Map and Surface Normal node instead of the Normal Map node allows you to use the more 
detailed height maps and height mattes from the Volume Objects with the  Light and Tone shaders, as well as 
to animate the surface definition on a rig. 

NOTE 

For more information on how to use the Surface Shading set of nodes, refer to the User Guide.

Layer Properties

Parameter Description

Name The name of the node as it appears in the Node View and the Timeline view. Each node must 
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Parameter Description

have a name that is unique to its containing group.

Surface 
Normal 
Quality

The surface normal quality provides three levels of quality when calculating and rendering the 
normal:

 l Low: Renders very fast and provides the first immediate normal direction.

 l Medium: Renders all four available surfaces orientations at a given pixel and averages 
the result.

 l High: Medium render speed. Calculates all available normals on a surface and blends the 
nearest normals at the given pixel.
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Tone Shader Node
The Tone Shader node lets you adjust the tone parameters, such as the colour, to create the desired ambiance. 
You can animate most parameters over time to create shade transitions. The beveling height and smoothing is 
set in the Normal Map node.

Tone Shader Properties - Parameters tab

The Parameters tab can be used for both Light Shading and Surface Shading features.
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Parameter Description

Enable/Disable
Allows you to enable or disable the node. When disabled, a node has no visible 
effect on the rendered image, nor on the preview in the Camera, Perspective, Side 
and Top views.

Colour Swatch
Sets the colour of the layer in the Timeline view and of the node in the Node 
view.

Name Allows you to change the name given to the node.

Light

Light Type

Directional: A light that is parallel in the scene. Each “beam” of light follows the 
direction defined by the light source and target, and point in the same direction. 
This type of light is used when the light source is far away or very big, like the 
sun.

Point: A light that illuminates everything around it. Its “beam” of light will go in 
all directions like a fire.

Spot: A light that forms a conical shape like a flashlight.

Cone Angle
The value that defines the light’s cone angle. This option is only accessible with 
the Light Type set to Spot.

Diffusion
Lets you play with the diffusion of the light on the surface of the drawing. In 
other words, it is the edge softness. This option is only accessible with the Light 
Type set to Spot.

Light Source Elevation
Defines the height of the spotlight. This option is only accessible when the Light 
Type set to Spot or Point.

Shading Type
Smooth: The light and tone fx will have smooth edges.

Sharp: The light and tone fx will have sharp edges.

Bias

Define the polarization of the light. 

When the Shade type is set to Smooth, it defines the width of the light’s smooth 
zone. 

When the Shade type is set to Sharp, the Bias defines the antialiasing on the edge 
of the hightlight or tone zone. But,if the Shade type is set to Sharp, the Bias 
option need a small value such as 0.1 or 0.2. The exponent will be able to 
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compensate the limitation of this small value.

Abruptness
This is a multiplier value of the Bias option. It will define how quick the 
polarization of the light will change from a value to another.

Adjust Light Intensity Lets you adjust the light intensity.

Intensity Lets you set the strength of the light.

Multiplier Multiplies the value of the Intensity option.

Surface Reflectivity
This option is useful for exaggerating the light on the edge of the 3D geometry. 
The closer an edge is to the light source, the more intense the light will be.

Colour

Red/Green/Blue/Alpha

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Use Image Colour
Lets you use the colour of the drawing in a lighter or darker colour for the 
highlight and tone fx.

Image Colour Intensity Lets you blend the colour of the light with the image colour.

Flatten Fx
This is useful when there are several highlight and tone fx, one over the other, 
but are supposed to be merged together. Sometimes, shadows and lights look 
better when they do not overlap.
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Tone Share Properties - Surface Light tab

The Surface Light tab can be used only with the Surface Shading feature, therefore it should be ignored when 
using the Light Shading feature.

Parameter Description

Use Surface Light

Checking the Use Surface Lighting will have the Light Shader node/Tone 
Shader node consider the Surface depth when rendering the Light/Tone.

The specular detail and falloff is only available when this property is enabled.

Specular Transparency
The Specular Transparency property defines the opacity of the specular 
highlight. A higher value will make the specular more visible and a lower 
value will have the specular blend into the diffuse.

Specular Strength
The Specular Strength defines the sharpness of the highlight. A higher value 
results in a more defined, sharper highlight, a lower value results in a more 
diffused render.

Distance Falloff

The Distance Falloff is a percentage value defining the amount of light that 
falls off between the Light Position’s source and the Light Position’s target.

A value of 0 will result in a render in which the light has no falloff and 
remains consistent between the source and the target.
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Volume Object Node
The Volume Object node allows you to define which parts of your rig constitute a single volume to which 
shading should be applied. For example, if you need the arm, forearm and hand of your character to be shaded 
together, you can connected all the nodes that constitute these body parts to the same Volume Object node, 
and the shading will be applied to these parts of your rig as if they were a single object.

NOTES 

 l Even if you want to apply shading separately to a single drawing, you must connect a Volume 
Object node under that drawing.

 l If you create separate Volume Object nodes for parts of your rig that are attached together, you 
may see bumps in the shading where the joints overlap. 

Volume Object Properties

NOTE 

Volume Object nodes are connected to a Normal Map or Surface Map node to be composited 
together. You can define the parameters of each volume in your rig in the properties of the Normal 
Map or Surface Map node to which they are connected. 

Parameter Description
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Name

With the light shading feature, the naming of the nodes becomes important. 
Since there isn’t any limitation on the number of Volume Object nodes that can 
be added to a node structure, it's quite important to give a good name to each 
Volume Object node. These names will later appear in the Normal Map node, in 
the Volume Creation section.

ID

This is the identity number you assign to a drawing or a group of drawings that 
will be represented in the same volume once it is generated by the Normal Map 
node. This ID is also in the Normal Map node, where a list of all Volume Objects 
is applied.

Cut Volume Cues with 
Geometry

When this option is not selected, Harmony cuts the 3D geometry (shading bas 
relief) of the drawing after it has been generated by the Normal Map node. 

Some nodes, such as filters, can affect the shape or colour of the drawing. Those 
nodes will be processed and recognized by the Normal Map node. Therefore, it is 
possible to limit the 3D geometry only on a part of the drawing, but not all of it. 
The 3D geometry follows the edge of the entire drawing and will not be affect by 
the filters.

Use Drawing to Create 
Volume

During the generation created by the Normal Map node, the shape of the drawing 
or group of drawings identified with the same ID will be recognized to create the 
volume. When this option is selected, the Light Shader and Tone Shader effect 
appear inside the contour of those drawings.

Elevation Baseline

The baseline defines how much you can add or carve the Volume Object. The 
drawing or group of drawings connected to this Volume Object node share the 
same baseline value. Because this setting is closely tied to the adding/curving 
option called Intensity (0-100) (accessible in the Volumetric Colour Information 
of the Normal Map node), both places need to have some parameters set. Playing 
only with the Geometry Intensity won’t change anything if there aren’t any 
parameters set in the Normal Map node.
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Plugin Nodes
There are 2 plug-in node effects available in Harmony:

 l Brightness-Contrast—see Brightness Contrast Node on page 606

 l Sparkle
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Sparkle 

The Sparkle effect transforms a vector drawing into sparkles. You have a high degree of control over the 
appearance of the sparkles.

The sparkle effect can only be used with vector drawings. If the sparkle effect node is attached to a composite, 
verify that the Composite editor is set to Vector Flatten Output.

Use the Sparkle editor to modify how the Sparkle node creates the sparkle effect. You can also use Bezier and 
Ease function curves to change the values of factors over time.
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Sparkle Properties

Parameter Description

Start Angle
Enter a value between -360 and 360 to indicate the angle of rotation of each 
sparkle.

Scale
Sparkles are determined by the size of the bounding box of the coloured areas in 
the drawing. Enter the multiple to use to scale the sparkle size.

Factor
Enter a value between 0.1 and 1 to determine how pointy the sparkle is. A value 
closer to 0 will result in a more pointed sparkle. A value closer to 1 will result in 
a more rounded sparkle.

Density Adjusts the density level.

Number of Points Enter the number of points you want each sparkle to have.

Probability of Appearing
Enter the percentage of possibility that sparkles will be displayed. Enter 100 to 
always show sparkles. Enter 0 to always hide sparkles.

Point Noise
Enter a value between 0.1 and 1 to indicate the amount by which points in a 
sparkle will distort.
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Centre Noise
Enter a value between 0.1 and 1 to indicate the amount by which the angles 
between each point in a sparkle will distort.

Angle Noise
Enter a value between 0.1 and 1 to indicate the amount by which the Start Angle 
in a sparkle will distort.

Random Seed Enter a positive integer value that will be used to determine the sparkle pattern.

Use Drawing Colours
Select this option to use the colour attributes of the drawing for the sparkle 
colour. When this selection is disabled (default setting), the colour values will 
be used as they are entered in the editor.

Flatten Sparkles of Same 
Colour

Flatten all drawings of the same colour into a single layer.

Red/Green/Blue/Alpha In the RGBA fields, enter the values to use for the sparkle colour. 

970



Selection Preset Note Node
The Selection Preset Note node appears in the Node view after an initial Selection Preset is created.

Selection Preset Note Properties

Parameter Description

Enable/Disable
Checking this option enables the node. Unchecking this option disables the 
node.

Track Colour

Click on this swatch to open the Select Colour window. Select a colour and click 
OK to mark the node with the selected colour.

Name Allows you to change the name given to the node.

Text
Displays the code text for the Selection Presets list that can be found in the 
Selection Presets window.

Close Closers the Properties window.
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Sound Layer
When you select a sound layer in the Timeline view, the options related to that layer appear in the Layer 
Properties view.

If you double-click on a sound layer in the Timeline view, or in a sound column in the Xsheet view, the Sound 
Element Editor dialog will open. This dialog allows you to fine-tune the sound track's lip sync, start time, stop 
time and volume.
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NOTE 

Contrary to all other layers, sound layers are not represented by nodes in the Node view.
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Chapter 4: Tools Properties
Harmony has a wide variety of drawing and manipulation tools and each one of them has a series of options 
and modes available in the Tool Properties view. This section covers these options.  

Brush Tool Properties 976

Centerline Editor Tool Properties 999

Close Gap Tool Properties 1001

Colour Eyedropper Tool Properties 1002

Contour Editor Tool Properties 1003

Cutter Tool Properties 1008

Drawing Pivot Tool Properties 1013

Edit Gradient/Texture Tool Properties 1015

Ellipse Tool Properties 1016

Envelope Tool Properties 1026

Eraser Tool Properties 1029

Ink Tool Properties 1051

Inverse Kinematics Tool Properties 1053

Line Tool Properties 1056

Morphing Tool Properties 1068

Node Caching Toolbar 1072

Paint Tool Properties 1073

Pencil Tool Properties 1080

Pencil Editor Tool Properties 1091

Perspective Tool Properties 1096
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Polyline Tool Properties 1099

Rectangle Tool Properties 1107

Reposition All Drawings Tool Properties 1117

Rigging Tool Properties 1119

Select Tool Properties 1122

Shift and Trace Tool Properties 1135

Smooth Editor Tool Properties 1138

Stamp Tool Properties 1140

Stroke Tool Properties 1148

Text Tool Properties 1150

Transform Tool Properties 1153

Zoom Tool Properties 1157
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Brush Tool Properties
The Brush tool allows you to draw by creating shapes based on your drawing strokes and filling them with 
colour or textures. When used with a tablet, it is pressure sensitive, just like a real life brush.

How to access the Brush tool properties

 1. In the Tools toolbar, select the Brush  tool.

The tool's properties are displayed in the Tool Properties view.

Brush Properties

The following properties affect the brush's size, smoothing and other properties for the drawing style of your 
brush. Those properties can be saved into brush presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Brush Properties Dialog The arrow button right of the preview area opens the Brush Properties dialog. 
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Property Description

While the Tool Properties view only gives you access to a few of the brush 
properties, a list of brush presets and other drawing options, the Brush Properties 
dialog gives you access to all the available options for your brush's tip and texture. 
For more information on the Brush Properties dialog, see the Brush Properties 
Dialog section below.

Maximum Size

Defines the maximum width of brush strokes.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will 
vary between its maximum size and minimum size depending on the amount of 
pressure used. If used with a mouse, the width of the stroke will always be its 
maximum size. 

Flow

Allows you to set the opacity for each instance of the brush tip that gets printed into 
your canvas. Contrary to the Opacity parameter, the flow parameter has a cumulative 
effect. This means that a lower flow will make your brush strokes more transparent 
towards its extremities and more opaque in its center. Your stroke's flow will also 
accumulate if you draw over it. By default, your brush's flow varies with the amount 
of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your 
whole brush stroke's opacity will not exceed the Opacity parameter. By default, the 
Opacity parameter varies depending on the amount of pressure you put on your 
tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Brush Presets

These options allow you to select, create and manage brush presets.
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Icon Property Description

  Presets list

By default, Harmony has preloaded brush presets. You can also create 
your own brush presets by configuring your brush, then saving its 
properties into a new preset. It is also possible to export and import 
brush presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

978



Drawing Options

These options affect the way your drawing strokes are added to your artwork.

Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  
button.

 2. Click on the  Set Current Brush Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
your outline.

 3. Click on the  Set Current Paint Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
the fill. 

Repaint Brush
When enabled, your brush strokes will only repaint existing artwork and 
will not add colour to empty areas. If you repaint semi-transparent 

979

Harmony 21 Premium Reference Guide                          



Chapter 4: Tools Properties

artwork, your artwork will not become more opaque than it already is.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

NOTE 

This option is only available when drawing on a vector layer.

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as 
a separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 

NOTE 

This option is only available when drawing on a vector layer. 
When drawing on a bitmap layer, artwork is always flattened. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.
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Respect Protected 
Colour

In the Colour view, it is possible to make some of the colours in your 
palettes protected from change. When enabled, the Respect Protected 
Colour option will prevent the brush tool from drawing over areas filled 
with a protected colour.

NOTE 

This option is only available when drawing on a vector layer. 
When drawing on a bitmap layer, colour is not linked to your 
palettes and cannot be protected.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with a 
gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a 
gradient by selecting a zone painted with a gradient with the Select tool, 
then clicking on Store Colour Gradient  in the Tool Properties view.

NOTE 

This option is only available when drawing on a vector layer.

Brush Properties Dialog

Brushes have an extensive set of options and properties that are not displayed in the Tool Properties view, but 
rather, in a dialog you can access from it. To open the Brush Properties dialog, click on the arrow button right of 
the stroke display area. 

The Brush Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 
layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 981

 l Smoothing Tab    on page 988

 l Transparency Tab on page 989

 l Dual Tip Tab on page 993

 l Paper Texture Tab on page 996

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your brush tip.
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NOTE 

The "Size Proportional to Camera" option has been moved to the new Size Properties window.

Property Description

Brush Type

Allows you to select between one of the following brush types:

 l Solid Vector Brush: Creates vector shapes filled with a solid colour. 
Makes artwork lightweight, scalable and easy to tweak. Since this kind of 
brush can only create solid colour shapes, solid vector brushes have a 
limited set of options including size, roundness, angle, centerline 
smoothing and contour smoothing.

 l Textured Vector Brush: Creates vector shapes filled with a texture. This 
gives you access to bitmap brush tips, paper textures, transparency and 
several other options.
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NOTE 

This option is not available when working on a bitmap layer. With bitmap 
layers, brushes are always textured, and textured brush options are 
always available.

Brush Tip Library

This is where you select the shape of the brush tip. By default it is round. Note 
that some tips are designed to have semitransparent areas, even when the 
maximum brush opacity is set to 100%.

To create a custom brush tip, you must prepare the file ahead of time, either in 
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 
supported and transparency is not supported in the traditional sense. Black 
appears as 100% opaque, white appears as 100% transparent and all the shades 
of grey in between appear as varying degrees of semitransparency. A range of 
file formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha 
channels are disregarded on import. It is recommended that your file be between 
100 x 100 pixels and 400 x 400 pixels. 

You can also import brush tips that you exported from Harmony, so you can 
share them with colleagues.

Minimum and Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and 
thin effect on your stroke. This works with the pressure sensitivity of a pen 
tablet.

 l Maximum Size: Defines the maximum  width of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to 
and as a percentage of the maximum size.

You can control the size properties by clicking on the arrow button on right and 
the dialog box will appear as shown below.
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 l Pressure: Allows you to apply more pressure and increases the size of 
the brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You 
can check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast 
speed.  You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke 
be drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the 
end of each stroke. The value can be expressed using two options: 
Distance and Percentage. Distance is selected by default. For example: 
A taper of 200 will be the same length as the width (diameter) of a stroke 
that has its size set at 200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of 
start taper can be visualized as the stroke is drawn. 

 l End Taper: When distance or percentage is selected as a Taper value,  the 
effect of end taper can be visualized once the stroke is complete and 
vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 
distance. It uses the same units as the size and is applied as the stroke is 
drawn.

 l Size Proportional to Camera: If you check this option, the size of the  
will be adjusted to the position of the camera on the z-axis. This means 
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that if the camera is zoomed in on the scene, the  will be proportionally 
smaller so that it appears the same size in the rendered image. Likewise, 
if the camera is zoomed out, the  will be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of 
creating width variation on your stroke. In other words, you would be 
forcing a uniform line width using the Maximum Size value.

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and 
orientation of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 
squashes the tip vertically, allowing you to turn round or square tips into 
flat tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the 
squashing will still be done relative to the tip's original orientation.

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set 
whether your brush takes your pen's tilt angle into account, and how much. 

When your pen is fully tilted, your brush tip will be stretched by the percentage 
you set in this parameter, in the angle in which you tilt it. For example, if you set 
the Pen Tilt Sensitivity to 50%, and you tilt your pen all the way up or down, 
your brush tip will be stretched vertically by 50%. With the same setting, if you 
tilt your pen all the way left or right, your brush tip will be stretched horizontally 
by 50%.
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Angle Function

If enabled, your brush tip will rotate with the angle of your pen tip. You can 
select one of the following options:

 l Constant: The static orientation of the brush tip expressed in degrees.

 l Heading: The orientation of the brush tip is determined by the direction 
in which the stroke is drawn. It changes dynamically as the stroke is 
drawn.

 l Azimuth: When the pen is tilted, it uses the direction in which the pen 
eraser is facing.

 l Twist (if supported by pen): It uses the twist angle of the stylus and is 
only available with Wacom Art Pen.

Hardness

The hardness value corresponds to the softness of the brush tip's edges. The 
lower the value, the softer the tip edge. The higher the value, the sharper the tip 
edge. Be aware that some brush tips are not 100% opaque, so they will always 
appear somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the brush. A value of 100% 
sets the stamp marks edge to edge, if there is no white space around the shape. 
The larger the value, the greater the space between marks. A really large value 
can make the brush stroke appear as a string of individual marks. Conversely, a 
small spacing value will give the appearance of a fluid brush stroke. 
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Spacing is only evident when making a continuous stroke. 

Random Size

You can create variation between the thick and thin of your brush stroke just by 
setting the Maximum and Minimum Size values. If you add randomness to the 
mix, pressure sensitivity from your drawing tablet will still be applied. Light 
pressure will create random values around the minimum, while heavy pressure 
will create random values closer to the maximum. The larger the percentage, the 
larger the range of random variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating 
width variation on your stroke, whether you are applying randomness or 
not. Therefore, you would be forcing a uniform line width using the 
Maximum Size value.

Random Angle

Sets the range for random rotation around the set Angle value. For example, if 
the Angle is set to 45° and the Random Angle set to 10°, the software will 
choose values between 40°–50° (plus or minus 5 degrees, equaling a total of 10 
degrees).
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Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if 
the Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony 
will choose values between 45%–55% (plus or minus 5 percent, equaling a 
total of 10 percent).

Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your brush 
strokes as you paint. 
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NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 
support smoothing.

Property Description

Centerline Smoothing
Defines the amount of smoothing Harmony should perform on the central line of the 
brush stroke. A higher setting will prevent your line from being shaky, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing
Defines the amount of smoothing Harmony should perform on the outer contour of 
the brush stroke. A higher setting will round sharp corners and reduce the amount of 
control points for the resulting vector shape. 

Transparency Tab

The Transparency tab allows you to decide if your brush has antialiasing as well as to set its flow and opacity 
settings. 
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NOTE 

The Transparency tab's options are only available on vector layers if the Brush Type option of the 
Tip tab is set to Textured Vector Brush. On bitmap layers, those options are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the brush strokes to 
blend with the surrounding colours, to create an illusion of smoothness 
otherwise not possible due to the picture resolution.

If antialiasing is disabled, the brush's texture will only render fully transparent 
or fully opaque pixels. Disabling this option can be useful if you need your 
outlines to be very crisp, if you want to make pixel art or if you need your brush 
strokes to render in solid colors with no variation, which makes them easier to 
repaint or process in third party software.

NOTE 

When disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate at 
which paint flows from your brush. The analogy works better with a pen. The 
greater the flow, the more ink comes out, hence the more consistent the colour 
and texture of the line. If the flow is light,  then the colour and texture of the line 
may look spotty. This feature works with the pressure sensitivity of a pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture are 
applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 
applied as you create a fluid stroke. It is defined as a percentage of the 
Maximum Flow value. If the Minimum Flow value is set to 100%, then 
tablet pressure sensitivity will no longer be applicable. The flow will be 
set to the constant rate of the Maximum Flow value.

You can control the flow properties by clicking on the arrow button on right and 
the dialog box will appear same as shown for size properties above. Minimum 
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and Maximum Size on page 983.

Maximum Opacity and 
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity 
range for a brush mark. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the brush mark when 
the pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the brush mark when 
the pressure is very light. It is defined as a percentage of the Maximum 
Opacity value. If the Minimum Opacity value is set to 100%, then tablet 
pressure sensitivity will no longer be applicable. The opacity will be set 
to the constant rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right 
and the dialog box will appear same as shown for size properties above. Please 
refer Minimum and Maximum Size on page 983

Randomness
Th Randomness parameter lets you set the range for the randomness of the flow 
and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your brush stroke just by setting the 
Maximum and Minimum Flow values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light pressure 
will create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation. 
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NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of 
creating flow variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform flow using the 
Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the 
Maximum and Minimum Opacity values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light pressure 
will create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation.
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NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of 
creating opacity variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform opacity using 
the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and 
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 
Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab must be set 
to Textured Vector Brush. 

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your brush uses a 
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be 
disabled. 

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. When the two brush tips are combined in this mode, 
they essentially cut each other out in overlapping areas, where one or both tips have 
an area of 100% transparency. The less opaque the brush tips are, the lighter their 
combination. 

Colour Dodge
In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes 
overlap, within the boundaries of the primary shape, the colour and opacity appear 
darker.
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Property Description

Combine
This mode treats the two tips as two different and separate brushes that have the 
same colour and follow the same path.
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Property Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your brush. You can also add textures by 
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 
Texture tab. Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab 
must be set to Textured Vector Brush. 

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your brush uses a 
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will 
be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive
This option layers the texture on top of itself as you scribble overlapping lines in one 
continuous stroke.  If this option is turned off, areas of overlapping lines from a 
single, continuous stroke will appear the same, in terms of darkness and texture, as 
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Property Description

non-overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 
enabled, the paper texture's position does not change with each sweep of the brush. 
If this option is disabled, each sweep of the brush produces a different texture 
position. The texture orientation always stays the same.
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Centerline Editor Tool Properties
The Centerline Editor tool allows you to edit brush strokes by their centreline rather than by their contour.  
This makes it easier to tweak the tips, curves and corners of brush strokes. The purpose of this tool is to make it 
as easy to edit brush strokes as it is to edit pencil lines with the Contour Editor tool.

How to access the Centerline Editor tool properties 

 1. In the Tools toolbar, select the Centerline Editor  tool.

 2. The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 
elements:

 l Lasso: Allows you to select multiple elements by 
drawing an irregular closed shape around them with your 
mouse.

 l Marquee: Allows you to select multiple elements by 
drawing a rectangle around them. This is faster, as you 
only need to drag your mouse from one corner of the 
rectangle to its opposite corner, but it may not be as 
precise as you want.

TIP 

You can press and hold the Alt key to temporarily use 
the other selection mode.

Show Centerline Editor Controls
When enabled, selecting several control points will make a 
manipulator bounding box appear. You can use this manipulator 
to scale and rotate the selection of points.
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Icon Property Description

Apply to Line and Colour Art

Allows you to perform drawing operations on both the Line Art 
and Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, 
they will also be affected when this option is enabled.

  Centerline Smoothness

Allows you to adjust the amount of control points on the 
centreline that is generated from the selected stroke. A lower 
value will create a centreline with less points, which makes it 
easier to manipulate large lengths of the stroke, and a higher 
value will generate a centreline with more points, allowing you 
to tweak details. 
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Close Gap Tool Properties
The paint tool requires the area you attempt to fill to be closed in order to know exactly what area of your 
artwork must be filled. However, it is common for artists to accidentally leave small gaps in their artwork. 

The Close Gap tool allows you to quickly close small gaps in a shape by creating an invisible stroke connecting 
two extremities of the gap. You can then fill the area using the Paint tool, as this invisible stroke will be taken 
in account to determine the outline of the shape to fill. 

TIP 

You do not need to use the Close Gap tool with precision. If you draw a crude stroke near the gap 
you want to close, the tool will automatically detect the two closest line extremities and will draw 
an invisible straight line connecting them. closing the gap between them. 

How to access the Close Gap tool properties

 1. In the Tools toolbar, select the Close Gap  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Auto 
Flatten

The Close Gap tool creates an invisible drawing stroke to close the shape. Enabling this 
option will merge the stroke into the artwork instead of adding the stroke on top of it.

NOTE 

The area you close with the Close Gap tool will be fillable regardless of whether 
or not this option is enabled.
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Colour Eyedropper Tool Properties
The Colour Eyedropper tool allows you to pick a colour from your drawing without going to the Colour view. 

NOTE 

The following options will only have an effect when picking colours from a bitmap layer, as they 
affect the colour that gets picked. When working on a vector layer, you can only pick colours that 
are available in one of the palettes in your scene. Therefore, the colour you pick will always be 
exactly the colour that was used to fill the shape or stroke you clicked on.

How to access the Colour Eyedropper tool properties

 1. In the Tools toolbar, select the Colour Eyedropper  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

Sample All 
Layers

By default, the Colour Eyedropper tool picks the colour from the active drawing 
layer only. This means that if the colour is semi-transparent, it will still only take 
the colour from the active layer, along with its transparency, and ignore the colours 
from layers behind it. 

With this option enabled, the Colour Eyedropper tool will pick the colour as it 
appears on the screen instead, allowing you to pick colours that are the result of 
several layers composited together.

Do Not Pick 
Transparency

By default, the Colour Eyedroppertool picks the colour's alpha value as well as its 
colour values. When enabled, the colour picked will always have an alpha value of 
255.
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Contour Editor Tool Properties
The Contour Editor lets you reshape vector shapes, brush strokes and lines in your drawings. 

Artwork in Harmony is made of vector shapes. Vector shapes are defined by points, the lines joining the points 
together (contours) and the curve vectors, represented by Bezier handles, which make the curve of said lines.

The Contour Editor tool allows you to select a contour or point, and change the position of points, add and 
remove points from the shape, rotate, lengthen and shorten curve handles to influence the curve of contours 
between those points, or drag contours between points to change their curve directly. 

How to access the Contour Editor tool properties

 1. In the Tools toolbar, select the Contour Editor  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Modes

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 
elements:

 l Lasso: Allows you to select multiple elements by drawing 
an irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by 
drawing a rectangle around them. This is faster, as you only 
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Icon Property Description

need to drag your mouse from one corner of the rectangle to 
its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the 
other selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to 
select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can 
also click on this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on to re-enable 
the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, moving the control point in 
a contour near another contour will snap that control point 
against that contour. This will lock the point and the contour 
together, and moving the control point will deform the 
contour. 

This option can be especially useful if you need to makes the 
edges of two shapes snap together, like so:

You can also use this option to make a control point snap 
against another control point, allowing you to join lines 
together.
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Icon Property Description

NOTE 

When a control point is snapped against a contour or 
another control point in your drawing, the Contour 
Editor will manipulate them together. However, even 
if you make a point in one drawing stroke snap 
against another drawing stroke, they will remain 
separate drawing strokes unless they are flattened 
together, and you will still be able to manipulate them 

individually with the Select tool. 

 l Snap to Alignment Guides: While moving the selection or 
one of its control points, it will snap against nearby alignment 
guides.

 l Snap and Align: Snaps the selected anchor point to any 
existing line while displaying temporary rulers as a guide that 
you can also snap your anchor point to. 

 l Snap to Grid: While moving the selection, the mouse cursor 
will snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show 
Grid from the top menu or press Ctrl + '.

Show Contour Editor 
Controls

When enabled, selecting several control points will make a 
manipulator bounding box appear. You can use this manipulator to 
scale and rotate the selection of points.

Tip Style
If you select and remove part of a pencil line, this option allows you 
to choose which kind of line tip the removed segment should leave 
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Icon Property Description

behind:

 l  Tip Style: Round: Leaves rounded tips at the extremities of 
the deleted line segment.

 l  Tip Style: Flat: Leaves flat tips at the extremities of the 
deleted line segment.

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they 
will also be affected when this option is enabled.

Operations

Icon Property Description

Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes 
and remove extra points.

TIP 

You can also smooth the selection by selecting Drawing> 
Optimize > Smooth from the top menu or by pressing Alt + 
Shift + S.             
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Icon Property Description

Split Pencil Line 

Join Pencil Lines

When drawing with the Polyline tool, your drawing has an even line 
thickness. You can use the Pencil Editor to adjust the thickness point 
by point, but if you want to adjust it quicker, you can use the Split 
Pencil Line and Point Pencil Lines options to create segments and 
apply a pencil stencil to your drawing. Note that if you did not join the 
pencil lines on your polyline stroke, the segments between the points 
will act as separated segments.
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Cutter Tool Properties
The Cutter tool lets you cut out part of a drawing so that you can transform it, copy it or delete it. It also allows 
you to trim overshot lines.

How to access the Cutter tool properties

 1. In the Tools toolbar, select the Cutter  tool. In the Tools toolbar, click and hold on the Select  
tool to display the menu beneath and select the Cutter  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 
rectangle around them. This is faster, as you only need to drag your 
mouse from one corner of the rectangle to its opposite corner, but it 
may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Easy Drag
When enabled, you can drag the selection by clicking anywhere inside its 
bounding box. By default, you must click on the artwork in the selection to be 
able to drag it. 
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Icon Property Description

Use Mouse 
Gesture 

When this option is enabled along with the Lasso  selection type, quickly 
drawing a line with the Cutter tool over a line segment in your artwork will 
instantly delete it. This can be useful if you want to use the Cutter tool to 
quickly clean up your artwork. 

It allows you to cut in two modes as follows:

 l Single Line Cutting Gesture: It deletes first line segment over which a 
straight gesture is drawn with the cutter.

 l Multiple Lines Cutting Gesture: It deletes all line segments over 
which a straight gesture is drawn with the cutter.

NOTE 

This option will only work when using the Cutter tool on separate brush 
or pencil strokes. Hence, it is important not to flatten your artwork if you 
intend to use this option to clean up your drawings. This option has no 
effect on bitmap layers as the artwork in bitmap layers is always 
flattened.

Use Mouse 
Gesture Breaker 
Mode

When using the Lasso  selection type, the Use Mouse Gesture Breaker Mode  
option lets you draw an invisible stroke on a pencil line to cut it in two 
individual objects. Once a pencil line is cut with this option, you will be able to 
select the two portions independently with either the Cutter tool, Pencil Editor 
tool or Select tool.
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Icon Property Description

NOTE 

This option only works with pencil lines.

Tip Style

When cutting through pencil lines, this option decides what kind of pencil line 
tips to put at the extremities of the remaining pencil line segments, where they 
were cut. 

By default, this is set to Bevel , which will leave the tip of the pencil line cut 
at the same angle as your cutter stroke. If you prefer, you can make pencil lines 
that you split with the Cutter tool have Flat  or Round  tips instead. 

Antialiasing

When working on bitmap artwork, enabling this will smooth the edges of the 
artwork you cut out, so that they do not appear pixelated. 

NOTE 

This option is only available with bitmap layers.

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can be 
toggled on or off. When toggled on, it has two different modes. You can select 
a mode by clicking and holding on the button.
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 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool will 
work on all these layers simultaneously. 

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer is 
synced with another layer, the tool will work on both the current layer 
and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All 
Frames

This option allows you to determine which drawings in the current layer the 
tool should affect. It can be toggled on or off. When toggled on, it has two 
different modes. You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
drawing in the current frame.

 l Apply to All Frames: The tool will work on every exposed drawing 
in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every drawing 
displayed in the Onion Skin. Onion Skin must be enabled for this option 
to work. 

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and Colour Art 
layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also be 
affected when this option is enabled.

Operations

Icon Property Description

Flip Horizontal Flips the current selection horizontally.
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Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees 
CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees 
CCW

Rotates the current selection 90 degrees counter-clockwise.
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Drawing Pivot Tool Properties
The Drawing Pivot  tool lets you set the pivots on your character. You can set the drawing pivots on drawings 
and symbols.

Tool Options

Icon Property Description

Setting the Drawing Pivot for Symbols on 
All Frames

The Set the Pivot for Symbol on All Frames  option is 
enabled by default. When you set a drawing pivot on 
a symbol, all of its cells use the same drawing pivot. 
This means you do not have to set a drawing pivot on 
all frames. Once you set it, it is done.

If you prefer to set a different drawing pivot for a 
series of cells, you can deselect the option and set 
your pivots on each cell or cell range.

NOTE 

If you have already set several different 
pivots on your symbol's cells and selected 
the Set the Pivot for Symbol on All Frames 
option, once you set a new pivot on the 
same symbol, all of its pivots will be reset 
and will use your new pivot.

Snapping

Allows you to enable or disable snapping for this 
tool and all other animation and drawing tools that 
support snapping, as well as to select which types of 
snapping are enabled. 

If you double-click or long-click on this button, it will 
open a pop-up menu in which you can toggle 
different snapping modes. You can also click on this 
button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on 
to re-enable the snapping modes which were 
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Icon Property Description

previously enabled. 

This tool supports the following snapping modes :

 l Snap to Contour: When moving the pivot, it 
will snap against the nearby points and 
contours of your artwork.

 l Snap to Alignment Guides: When moving 
the pivot, it will snap against nearby 
alignment guides.

 l Snap and Align: When moving the pivot, it 
will align with the edges of elements in the 
drawing.

 l Snap to Grid: When moving the pivot, it will 
snap against the intersecting points of the 
grid. 

TIP 

To display the grid, select View > 
Grid > Show Grid from the top 
menu or press Ctrl + '.

Reset Pivot
When you click the Reset Pivot  option, the drawing 
pivot of the selected drawing or symbol is reset to the 
centre of the Camera view.

Copying Pivot on Parent Symbol

When you import new extra drawings, such as hands 
and mouths, you can use the drawing pivot that was 
set on your drawings and report them to the symbol's 
cells. Use the Copy Pivot to Parent Symbol   command 
for this.

NOTE 

When you copy drawing pivots to the parent 
symbol, there is no link between the 
drawings' pivots and the symbol's pivots. If 
you modify the drawing pivot later, it will 
not link to the symbol. You would need to 
perform the operation again. If you need to 
modify the symbol's pivots, you can do it 
directly on the symbol's cells.
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Edit Gradient/Texture Tool Properties
The Edit/Gradient Texture tool allows you to move, rotate and scale a gradient or texture fill within the shape 
it fills, without modifying the shape itself. 

How to access the Edit Gradient/Texture tool properties

 1. In the Tools toolbar, select the Edit Gradient/Texture  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can be 
toggled on or off. When toggled on, it has two different modes. You can select 
a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool will 
work on all these layers simultaneously. 

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer is 
synced with another layer, the tool will work on both the current layer 
and its synced layer. 

NOTE 

This option only works in the Camera view. 
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Ellipse Tool Properties
The Ellipse tool allows you to quickly draw an ellipse or a circle.

How to access the Ellipse tool properties

 1. In the Tools toolbar, select the Ellipse  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.
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Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives 
you access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 
1021 section below.

Size Defines the width of the pencil line used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import those 
that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your shape is added to your artwork.
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Draw Behind

When enabled, your brush strokes will appear behind the existing artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as you 
draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, the shape you draw is automatically filled with the 
selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  
button.

 2. Click on the  Set Current Pencil Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
your outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in 
the colour list, select the desired colour swatch for the 
fill. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
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Icon Property Description

click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the mouse 
cursor will snap to the nearby contours of the artwork in your 
drawing. 

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.

 l Snap and Align: When enabled, while you're drawing, the mouse 
cursor will automatically align to the rectangular bounding boxes 
of other strokes and shapes in your drawing.

 l Snap to Grid: While moving the selection, the mouse cursor will 
snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option automatically 
merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with a 
gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a gradient 
by selecting a zone painted with a gradient with the Select tool, then 
clicking on Store Colour Gradient  in the Tool Properties view.

Draw Circle

When enabled, the ellipsis tool will always draw an ellipsis of equal 
width and height, making it a perfect circle.

TIP 

You can also draw a perfect circle by holding the Shift key while 
drawing.

Pencil Properties Dialog

The Ellipse tool draws the same type of line as the Pencil tool. Hence, you can configure the Ellipse tool's lines 
using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 
display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally 
bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will 
reduce the amount of control points it has, making it easier to tweak, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
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have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view—see Colour View on page 1241. 
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Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, so 
it will be added to your new scenes in the exact state it is when you make 
it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the 
current pencil texture palette. The pencil texture's effect on your pencil 
line will be based on the image's transparency channel, and will follow 
your pencil lines on its horizontal axis. This option is also available from 
the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil texture 
palette. This option is also available from the menu button.

  Pencil Texture Display Displays the pencil textures in the current pencil texture palette and 
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allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it in 
the Colour view—see Colour View on page 1241.
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Envelope Tool Properties
Selecting the Envelope tool displays its properties and options in the Tool Properties view. 

Icon Tool Name Description

 
Width and 
Height

Increase the width and height values to add more columns and rows to the 
deformation grids.

Lasso

Sets the selection mode to Lasso, which allows you to select multiple items by 
drawing a lasso around them.

TIP 

When this option is enabled, you can press and hold the Alt key to temporarily 
use Marquee mode.

Marquee
Sets the selection mode to Marquee, which allows you to select multiple items by 
drawing a rectangle around them. 
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TIP 

When this option is enabled, you can press and hold the Alt key to temporarily 
use Lasso mode.

Snapping

Allows you to enable or disable snapping for this tool and all other animation and 
drawing tools that support snapping, as well as to select which types of snapping are 
enabled. 

If you double-click or long-click on this button, it will open a pop-up menu in which 
you can toggle different snapping modes. You can also click on this button to toggle it 
off, which will disable all snapping modes, and click on it again and toggle it on to re-
enable the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its control points, it 
will snap against the nearby points and contours of your artwork, allowing you 
to snap parts of your artwork together. 

 l Snap to Alignment Guides: While moving the selection or one of its control 
points, it will snap against nearby alignment guides.

 l Snap and Align: When enabled, while moving a selection, the rectangular 
bounding box of the selection will snap to the rectangular bounding box of 
any other drawing stroke in the drawing, allowing you to align drawing strokes 
laterally.

 l Snap to Grid: While moving the selection, the mouse cursor will snap against 
the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid from the top 
menu or press Ctrl + '.

Show 
Advanced 
Controls

To display more controls,you can click on the Show Advanced Controls  button.
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Icon Tool Name Description

Apply to 
Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and Colour Art layers 
of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also be affected 
when this option is enabled.

Flip 
Horizontal

Flips the current selection horizontally.

Flip 
Vertical

Flips the current selection vertically.

Rotate 90 
Degrees 
CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 
Degrees 
CCW

Rotates the current selection 90 degrees counter-clockwise.

Smooth

You can modify the central line smoothness  of your line using this option. This 
parameter smooths the deformed lines. Increasing the value will result in a smoother 
line with fewer control points. The more you increase the value, the less details and 
curves you will get. Use the left and right arrows to increment the value by one full 
unit. Use the Up - Down slider to quickly increment the value.
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Eraser Tool Properties
The Eraser tool allows you to erase artwork by drawing eraser strokes over it. When using the Eraser tool with 
a tablet, it is pressure sensitive, like with the Brush and Pencil tool. 

How to access the Eraser tool properties

 1. In the Tools toolbar, select the Eraser  tool.

The tool's properties are displayed in the Tool Properties view.

Eraser Properties

The way the Eraser tool is configured is almost identical to the way the Brush tool is configured.

Property Description

Stroke Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Eraser Properties 
Dialog

The arrow button right of the display area opens the Eraser Properties dialog, which 
gives you access to all the parameters and options for your eraser. The Tool Properties 
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Property Description

view only gives you access to a few of the eraser properties, a list of eraser presets and 
options for the Eraser tool that are  not related to the eraser properties. For more 
information on the Eraser Properties dialog, see the Eraser Properties Dialog section 
below.

Maximum Size

Defines the maximum size of the eraser. 

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary 
between its maximum size and minimum size depending on the amount of pressure 
used. If used with a mouse, the width of the stroke will always be its maximum size. 

Flow

Lets you set the opacity for each instance of the eraser tip that gets erased from your 
artwork. Contrary to the Opacity parameter, the flow parameter has a cumulative effect. 
This means that a lower flow will make your eraser strokes less effective towards its 
extremities and more effective in its center. Your stroke's flow will also accumulate if 
you draw over it. By default, your eraser's flow varies with the amount of pressure you 
put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your whole 
brush stroke's opacity will not exceed the Opacity parameter. By default, the Opacity 
parameter varies depending on the amount of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 
bitmap layer.

Eraser Presets

These options allow you to select, create and manage eraser presets.
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  Presets list

By default, Harmony has preloaded eraser presets. You can also create 
your own eraser presets by configuring your eraser, then saving its 
properties into a new preset. It is also possible to export and import 
eraser presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail Displays presets in a grid of small thumbnails with a preview of their tip.

  Large Thumbnail
Displays presets in a grid of big thumbnails, with their name and a 
preview of their tip.

  Stroke View
Displays presets in a list, with their name and a preview of a stroke done 
with each preset. 

Erasing Options

These options affect the way your eraser strokes are applied to your artwork.

Icon Property Description

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will 
also be affected when this option is enabled.
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Icon Property Description

Tip Style

When you erase part of a pencil line, this option determines the shape of 
the extremity of the pencil line where you erased:

 l  Round:  Leaves a round tip at the extremities of the pencil line 
you erased.

 l  Flat: Leaves a flat tip at the extremities of the pencil line you 
erased. A flat tip is always perpendicular to the angle of the 
centreline of the pencil line, so it may not match the angle of your 
eraser stroke. 

 l  Bevel: Leaves a bevel tip at the extremities of the pencil line 
you erased. A bevel tip is flat, but its angle matches the angle of 
your eraser stroke.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While erasing, the eraser will snap 
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against nearby alignment guides.

Apply to Synced 
Drawing Layers

If the currently selected layer is synced with another layer, the tool will 
work on both the current layer and its synced layer. 

Eraser Properties Dialog

Erasers have an extensive set of options and properties that are not displayed in the Tool Properties view, but 
rather, in a dialog you can access from it. To open the Eraser Properties dialog, click on the arrow button right 
of the stroke display area. 

The Eraser Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 
layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 1033

 l Smoothing Tab    on page 1040

 l Transparency Tab on page 1041

 l Dual Tip Tab on page 1044

 l Paper Texture Tab on page 1048

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your eraser tip.
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Property Description

Eraser Type

Allows you to select between one of the following eraser types:

 l Solid Vector: Simply cuts out the eraser stroke's shape from the vector 
artwork. A solid vector eraser always completely erase the artworks leaving 
hard seams. 

 l Textured  Eraser: Allows to configure the eraser with the same options as with 
a textured brush. A textured eraser will decrease the opacity of bitmap textures 
in textured brush strokes if it doesn't completely erase it. If it completely erases 
a brush stroke, it will cut out the erased part from the vector artwork.

 l Textured, Preserve Vector: Like a Textured Eraser, except that it will not cut 
out from the vector shapes, even if it fully erases pixels in a textured brush 
stroke's texture.
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NOTE 

Textured erasers only work as expected on textured brush strokes. Using a 
Textured eraser on a solid vector brush stroke or on a pencil line will only cut 
the eraser stroke's shape out of it. If you use a Textured, Preserve Vector type 
eraser on a solid vector shape or on a pencil line, the eraser will not erase 
anything.

NOTE 

This option is not available when working on a bitmap layer. With bitmap 
layers, erasers are always textured, and textured eraser options are always 
available.

Eraser Tip Library

This is where you select the shape of the eraser tip. By default, it is round. Note that 
some tips are designed to have semitransparent areas, even when the maximum eraser 
opacity is set to 100%.

To create a custom eraser tip, you must prepare the file ahead of time, either in 
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 
supported and transparency is not supported in the traditional sense. Black appears as 
100% opaque, white appears as 100% transparent and all the shades of grey in 
between appear as varying degrees of semitransparency. A range of file formats are 
supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels are disregarded 
on import. It is recommended that your file be between 100 x 100 pixels and 400 x 400 
pixels. 

You can also import eraser tips that you exported from Harmony, so you can share 
them with colleagues.

Minimum and Maximum 
Size

The minimum and maximum sizes of your drawing tool produce the thick and thin 
effect on your stroke. This works with the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  width of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to and as a 
percentage of the maximum size.
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Property Description

You can control the size properties by clicking on the arrow button on right and the 
dialog box will appear as shown below.

 l Pressure: Allows you to apply more pressure and increases the size of the 
brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 
check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  
You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 
drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 
each stroke. The value can be expressed using two options: Distance and 
Percentage. Distance is selected by default. For example: A taper of 200 will 
be the same length as the width (diameter) of a stroke that has its size set at 
200.

You can enable Start and End Tapering option individually.

 l Start Taper: When distance is selected as a Taper value, the effect of start 
taper can be visualized as the stroke is drawn. 
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 l End Taper: When distance or percentage is selected as a Taper value,  the effect 
of end taper can be visualized once the stroke is complete and vectorized as the 
length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given distance. 
It uses the same units as the size and is applied as the stroke is drawn.

 l Size Proportional to Camera: If you check this option, the size of the  will be 
adjusted to the position of the camera on the z-axis. This means that if the 
camera is zoomed in on the scene, the  will be proportionally smaller so that it 
appears the same size in the rendered image. Likewise, if the camera is zoomed 
out, the  will be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of creating 
width variation on your stroke. In other words, you would be forcing a uniform 
line width using the Maximum Size value.

Proportional to Camera

If you check this option, the size of the eraser will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
eraser will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the eraser will be proportionally bigger. 

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and orientation 
of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 
squashes the tip vertically, allowing you to turn round or square tips into flat 
tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the squashing 
will still be done relative to the tip's original orientation.

Pen Tilt Sensitivity If your pen and tablet support tilt sensitivity, this option allows you to set whether 
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your eraser takes your pen's tilt angle in account, and how much. 

When your pen is fully tilted, your eraser tip will be stretched by the percentage you 
set in this parameter, in the angle in which you tilt it. For example, if you set the Pen 
Tilt Sensitivity to 50%, and you tilt your pen all the way up or down, your eraser tip 
will be stretched vertically by 50%. With the same setting, if you tilt your pen all the 
way left or right, your eraser tip will be stretched horizontally by 50%.

Use Pen Rotation

If enabled, and if your pen and tablet support tip rotation, your eraser tip will rotate 
with the angle of your pen tip. 

Hardness

The Hardness and Spacing parameters allow you to change the softness and spacing 
of the marks made by the eraser tip. You can preview the hardness and spacing at the 
top of the Eraser Properties window, stroke preview area.

The hardness value corresponds to the softness of the eraser tip's edges. The lower 
the value, the softer the tip edge. The higher the value, the sharper the tip edge. Be 
aware that some eraser tips are not 100% opaque, so they will always appear 
somewhat soft, even at 100% hardness.

Spacing
Defines the amount of space between each stamp of the eraser. A value of 100% sets 
the stamp marks edge to edge, if there is no white space around the shape. The larger 
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the value, the greater the space between marks. A really large value can make the 
eraser stroke appear as a string of individual marks. Conversely, a small spacing value 
will give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 

Randomness
The Randomness parameters let you create a varied bitmap eraser stroke. Refining 
these options can give your stroke a lovely, non-mechanical look.

Random Size

You can create variation between the thick and thin of your eraser stroke just by setting 
the Maximum and Minimum Size values. If you add randomness to the mix, pressure 
sensitivity from your drawing tablet will still be applied. Light pressure will create 
random values around the minimum, while heavy pressure will create random values 
closer to the maximum. The larger the percentage, the larger the range of random 
variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating width 
variation on your stroke, whether you are applying randomness or not. 
Therefore, you would be forcing a uniform line width using the Maximum Size 
value.

Random Angle
Sets the range for random rotation around the set Angle value. For example, if the 
Angle is set to 45° and the Random Angle set to 10°, the software will choose values 
between 40°–50° (plus or minus 5 degrees, equaling a total of 10 degrees).
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Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if the 
Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony will 
choose values between 45%–55% (plus or minus 5 percent, equaling a total of 10 
percent).

Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your eraser 
strokes as you paint. 
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NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 
support smoothing.

Property Description

Centerline Smoothing
Defines the amount of smoothing Harmony should perform on your eraser stroke's 
direction, curves and corners. A higher setting will prevent your line from being 
shaky, but is liable to reduce drawing precision and turn sharp angles into curves.

Contour Smoothing
  Defines the amount of smoothing Harmony should perform on outer contour of the 

eraser stroke. A higher setting will round sharp corners and reduce the amount of 
control points for the resulting vector shape. 

Transparency Tab

The Transparency tab allows you to decide if your eraser has antialiasing as well as to set its flow and opacity 
settings. 
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NOTE 

The Transparency tab's options are only available on vector layers if the Eraser Type option of the 
Tip tab is set to Textured Vector or Textured, Preserve Vector.. On bitmap layers, those options 
are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the eraser strokes to 
blend with the surrounding colours, to create an illusion of smoothness 
otherwise not possible due to the picture resolution.

If antialiasing is disabled, the eraser will either fully erase pixels or leave them 
intact.

NOTE 

When disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate at 
which your eraser's effect flows. The greater the flow, the more consistent the 
effect is. If the flow is light,  then the effect may look spotty. This feature works 
with the pressure sensitivity of a pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture are 
applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 
applied as you create a fluid stroke. It is defined as a percentage of the 
Maximum Flow value. If the Minimum Flow value is set to 100%, then 
tablet pressure sensitivity will no longer be applicable. The flow will be 
set to the constant rate of the Maximum Flow value.

Maximum Opacity and 
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity 
range for a eraser mark. This works with the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the eraser mark when 
the pressure is heavy. 
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 l Minimum Opacity: Sets the transparency limit of the eraser mark when 
the pressure is very light. It is defined as a percentage of the Maximum 
Opacity value. If the Minimum Opacity value is set to 100%, then tablet 
pressure sensitivity will no longer be applicable. The opacity will be set 
to the constant rate of the Maximum Opacity value.

Randomness
Th Randomness parameter lets you set the range for the randomness of the flow 
and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your eraser stroke just by setting the 
Maximum and Minimum Flow values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light pressure 
will create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation. 

NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of 
creating flow variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform flow using the 
Maximum Flow value.
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Random Opacity

You can create variation in the opacity of your eraser stroke just by setting the 
Maximum and Minimum Opacity values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light pressure 
will create random values around the minimum, while heavy pressure will create 
random values closer to the maximum. The larger the percentage, the larger the 
range of random variation.

NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of 
creating opacity variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform opacity using 
the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip eraser. The primary bitmap eraser tip and 
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 
Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab must be set 
to Textured Vector or Textured, Preserve Vector.

Tool Name Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your eraser uses a 
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be 
disabled. 

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply
This is the default blend mode. When the two eraser tips are combined in this mode, 
they essentially cut each other out in overlapping areas, where one or both tips have 
an area of 100% transparency. The less opaque the eraser tips are, the lighter their 
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Tool Name Description

combination. 

Colour Dodge
In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes 
overlap, within the boundaries of the primary shape, the colour and opacity appear 
darker.
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Combine
This mode treats the two tips as two different and separate erasers that have the 
same colour and follow the same path.
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Tool Name Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your eraser. You can also add textures by 
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 
Texture tab. Additionally, if you are working on a vector layer, the Eraser Type option of the Tip 
tab must be set to Textured Vector or Textured, Preserve Vector.

Property Description

Enable/Disable
The checkbox inside the tab allows you to decide whether or not your eraser uses a 
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will 
be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive
This option layers the texture on top of itself as you scribble overlapping lines in one 
continuous stroke.  If this option is turned off, areas of overlapping lines from a 
single, continuous stroke will appear the same, in terms of darkness and texture, as 
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Property Description

non-overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 
enabled, the paper texture's position does not change with each sweep of the eraser. 
If this option is disabled, each sweep of the eraser produces a different texture 
position. The texture orientation always stays the same.
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Ink Tool Properties
When you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Tool

Lasso

Sets the selection mode to Lasso, which allows 
you to select multiple items by drawing a lasso 
around them.

TIP 

When this option is enabled, you can 
press and hold the Alt key to temporarily 
use Marquee mode.

Marquee

Sets the selection mode to Marquee, which allows 
you to select multiple items by drawing a 
rectangle around them. 

TIP 

When this option is enabled, you can 
press and hold the Alt key to temporarily 
use Lasso mode.

Show Inkable Lines

Highlights all pencil lines (no brush strokes) on 
the selected layer. Pencil line segments that are 
already inked with the selected swatch colour 
from the colour palette are also not highlighted.

Be Smart on Connecting Lines

As you hover and move the cursor across 
intersecting pencil lines, the path that you create 
will be highlighted. When you click on your 
mouse or stylus the highlighted segments are 
inked.  With this option disabled, all the 
intersecting segments that your cursor comes near 
will be highlighted and become part of the 
selection, even if they were not situated in the 
direction of the chosen path.
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NOTE 

This option only works if the Ink tool is in 
Hover mode.

Select Mode

Use this mode instead of the Hover Mode. In the 
Hover Mode, any potentially inkable pencil line 
will have its central vector line highlighted as the 
Ink tool’s cursor hovers over it. Use Ctrl 
(Windows/Linux) or ⌘  (macOS) to toggle 
between the two modes.

Select Newly Painted, Repainted, 
and Unpainted Contours/Lines

In the Paint   tool properties, this option  keeps a 
selection highlighted around the latest painted 
zone after using the Paint, Repaint, Unpaint, or 
Paint Unpainted tool.

Raise

As you ink the pencil line, the segment will be 
moved on top of the other intersecting strokes. 
Disable this option for the line to be sent behind. 
Hold down the Alt key to perform the opposite 
operation as you ink.

Mitre

As you hover over two perpendicular or nearly 
perpendicular segments, a highlighted path with a 
corner is created. Clicking on these highlighted 
segments inks both segments and makes them 
appear as a single stroke with a corner or bend. 
Options include: As Is, Round, Miter, and Bevel.

Tip Style
Lets you customize the edge of the Ink tool. 
Options include: Round, Flat, and Bevel.
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Inverse Kinematics Tool Properties
The IK tool has a series of different modes and options available in the Tool Properties view.

Mode

Mode Button Description

Bone Selection

Enabled by default, this mode lets you click on any bone in a 
character and move it without having to select the actual layer.

When you disable this mode, you cannot move any bone except the 
selected one. This allows you to grab and rotate the selected part 
from many angles and locations. You can click completely outside the 
character and move the pieces.

Chain

•  Simple Chain Mode: This is the default mode and will 
only allow for the movement of parts attached to a single 
chain up to the point of intersection. A single chain is a 
straight line with no secondary chain attached.

•  Direct Chain Mode: This mode allows you to move parts 
up a simple secondary chain to a principle chain, as long as 
translation movement is possible (the principle chain is 
attached to its own peg), but will ignore all secondary chains. 
A direct chain is a single chain which goes directly to the core.

•  All Chain Mode: This mode allows you to move all parts 
attached to all chains in the IK skeleton. All chains are 
attached and move simultaneously when one part is moved.

IK Manipulation

The main working mode for the IK tool. Enable this mode when you 
want to animate and position a puppet.

Ctrl + click (Windows/Linux) or ⌘  + click (macOS) on a body part to 
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select it. You do not need to select a part to be able to move it.

Apply IK Constraints
Lets you correct a part's position on a series of frames. For example, if 
the character's foot is sinking into the floor, you can correct its 
position and angle over a series of frames.

Edit Min/Max Angle
Lets you set a rotation restriction on some of your parts, such as 
elbows, knees and ankles.

Bone Editing
Lets you fix the bone orientation on extremities, such as hands and 
feet.

IK Options

Parameter Description

IK Keyframe
Used in combination with the IK Constraints mode, this option determines the 
starting frame of the constraint you will apply.

Ease Shape While animating with the IK tool and before doing a movement,  set an easing 
preset so the motion is not so mechanical.

Before moving the part, select a preset from the Ease Shape menu:

If you select a new preset in the list and move the part again on the same 
keyframe, the easing will automatically update.
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Selection

Parameter Description

Enable Translation If Top of 
Hierarchy

Used only on master pegs. This option is useful when you have this particluar 
situation: You want the character to do a perfect split (sitting down with the legs 
at right angles to the body or at the sides with the torso facing forwards), then 
the hip will need to translate and not just rotate on the spot. And since IK is all 
about rotation, you would select the hip layer and enable the translation option.

Enable Rotation

This option is enabled by default. The pivot disappears but you can still see the 
bone.  When this option is disabled, the selected part cannot be rotated and will 
remain in the same position. You can use this option to simulate an arm in a 
plaster cast.

Exclude from IK
This option lets you exclude certain parts of the puppet from the IK influence, 
such as the eyes and mouth.

IK Nails
These options let you temporarily fix a part of a character to a spot either in 
translation or rotation, or enable maximum and minimum angle usage.

Stiffness

When a certain part is selected, you can apply a stiffness value to it. A different 
stiffness value can be set to each body part individually. The greater the stiffness, 
the more difficult it is to make that part rotate, thereby rendering it stiff while the 
other parts continue to move freely on their joints.
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Line Tool Properties
The Line tool allows you to quickly draw a line segment by dragging the mouse from its starting point to its 
end point.

How to access the Line tool properties

 1. In the Tools toolbar, select the Line  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.
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Tool Name Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives 
you access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog section 
below.

Size Defines the width of the pencil line used to draw the line.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import those 
that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Icon Tool Name Description

Draw Behind

When enabled, your brush strokes will appear behind the existing artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as you draw it, 
until you release the mouse cursor or tablet pen. 

Snapping

Allows you to enable or disable snapping for this tool and all other animation and 
drawing tools that support snapping, as well as to select which types of snapping 
are enabled. 

If you double-click or long-click on this button, it will open a pop-up menu in 
which you can toggle different snapping modes. You can also click on this button 
to toggle it off, which will disable all snapping modes, and click on it again and 
toggle it on to re-enable the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the mouse cursor 
will automatically snap to the nearby contours of existing artwork, 
allowing you to draw shapes that connect with other parts of your drawing. 

NOTE 

If you draw a line with the Line tool and make its tip snap to a 
contour or another control point in your artwork, they will be locked 
together. You can then manipulate both simultaneously using the 

 Contour Editor  tool. You can also separate two drawing strokes 
that have been snapped together by selecting one of them with the 

 Select  tool and moving it away.

 l Snap to Alignment Guides: While drawing, the drawing tool will snap 
against nearby alignment guides.
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Icon Tool Name Description

 l Snap and Align: When enabled, while you're drawing, the mouse cursor 
will automatically align with the edges of strokes and shapes in your 
artwork, allowing you to draw shapes that align with parts of your drawing.

 l When enabled, while you're drawing, the mouse cursor will snap against 
the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid from the top 
menu or press Ctrl + '.

Automatically 
Create Colour 
Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  option 
instantly creates the corresponding strokes in the Colour Art layer.

Auto-Flatten 
Mode

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other parts of the 
artwork. When enabled, the Auto-Flatten option automatically merges strokes into 
existing artwork. 
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Icon Tool Name Description

NOTE 

Using the Select tool, you can use select and remove a segment of flattened 
pencil lines. Overlapping pencil lines drawn with the Auto-Flatten mode are 
essentially cut into segments by the overlap and can be treated as 
individual lines.

Auto-Close 
Gap

When enabled, small gaps between the pencil lines you draw will be closed by an 
invisible stroke to make sure your shapes are closed and that they can be filled 
with the Paint tool.

When drawing contours with pencil lines, the centreline is used to determine 
whether or not the contour is closed, but the visible tips of the pencil line will 
extend a bit beyond the tips of its centreline, making it possible to have shapes that 
appear closed, but are not really. This can prevent the shape from being filled with 
the Paint tool. Enabling this option when drawing with the Pencil or Line tool will 
prevent you from leaving invisible gaps in your contours.

 

Line Building 
Mode

The Line Building mode is very useful when drawing long lines and curves in 
small increments with pencil lines or the Line tool. As the pencil lines are central 
vector lines, it may be difficult to align the line tips perfectly to create a uniform 
stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are merge into 
one single stroke.
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Icon Tool Name Description

NOTE 

This mode only works with pencil lines or the line  tool.

Use Stored 
Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with a gradient 
colour to always position the gradient in the same way it was stored, making it 
consistent across brush strokes. You can store a gradient by selecting a zone 
painted with a gradient with the Select tool, then clicking on Store Colour Gradient 

 in the Tool Properties view.

Straight Line 
Mode

Draws a straight line. 

In this mode, you can draw curved lines with the following method:

 1. Draw the line by clicking and dragging from the start point to the end point 
of the line, but don’t release the mouse button or pen yet.

 2. While holding the mouse button or pen down, press and hold the Ctrl 
(Windows/Linux) or ⌘  (macOS) and move the mouse or pen to define the 
line’s curve.

 3. Once the line’s curve looks right, release the mouse button or pen.

Curve Line 
Mode

This mode allows you to draws a simple curved (quadratic Bezier) line in two 
clicks:

 1. Draw the line by clicking and dragging from the start point to the end point 
of the line.

 2. Move the mouse or pen to define the curve of the line and click.
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Icon Tool Name Description

S Curve Line 
Mode

Draws an S-shaped (cubic Bezier) line. This mode allows you to draw lines with 
finely tuned or even S-shaped curves with three clicks:

 1. Draw the line by clicking and dragging from the start point to the end point 
of the line.

 2. Move the mouse or pen to define the Bezier position of the beginning of the 
line and click.

 3. Move the mouse or pen to define the Bezier position of the end of the line 
and click.
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Pencil Properties Dialog

Since the Line tool draws pencil lines, you can use the Pencil Properties dialog to customize the type of lines it 
draws. To open the Pencil Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 

Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally 
bigger. 

Centerline Smoothing Defines the amount of smoothing Harmony should perform on the central line of the 
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Property Description

pencil stroke. A higher setting will prevent your line from being shaky and will 
reduce the amount of control points it has, making it easier to tweak, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view—see Colour View on page 1241. 
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Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, so 
it will be added to your new scenes in the exact state it is when you make 
it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the 
current pencil texture palette. The pencil texture's effect on your pencil 
line will be based on the image's transparency channel, and will follow 
your pencil lines on its horizontal axis. This option is also available from 
the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil texture 
palette. This option is also available from the menu button.

  Pencil Texture Display Displays the pencil textures in the current pencil texture palette and 
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allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it in 
the Colour view—see Colour View on page 1241.
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Morphing Tool Properties
As you create and adjust your morphing sequences, you will often use the Tool Properties view. Using this view 
allows you to do things such as toggle between your key drawings, adjust the easing or select a hint type.  

Icon Tool Name Description

Hint Type

The Hint Type drop-down menu allows you to select 
the correct hint to remedy any problem areas in your 
drawing.

You can have more than one hint type in your 
drawings. You can mix all of the hint types in your 
morphing sequence.

Do not Pick 
Transparency

The Hide Hints  button temporarily Temporarily hides 
the hint points from the key drawings. Use this option 
when you have a series of hint points hiding some 
lines you would like to see.
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Show Morphing in Place

The Show Morphing In Place  option is used with 
morphing layers. Enabling this option prevents the 
currently selected morphing layer from being shown 
on top of the others and maintains the correct layer 
ordering.

Suggest Hints

The Suggest Hints  option is used to automatically set 
Automatically sets hint points on key drawings as a 
help tool. If you're not sure where to set hints, you 
can use this option. It will set the main hints which 
you can then fine tune.

Switch Between 
Drawings

The Switch Between Drawings  button is used to 
toggle Toggles between the two key drawings in your 
morphing sequence. This option is useful while 
setting hints. You can use the default keyboard 
shortcut F4 to toggle between your drawings.

Flatten
The Flatten  option is used when you have to morph a 
sequence with a semi-transparent or transparent 
colour in it.

  Quality

The Quality setting is used to make the lines of the 
morphed drawings smoother. Adjust this parameter 
when you are doing an extreme close up of your 
animation.

  Morphing Layers
The Morphing Layers option is used when working 
with morphing layers. You can add, remove and 
manage your different morphing layers in this space.
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To create new drawings, double-click on the blank 
area under the From section to create the source 
drawing and the To section for the destination 
drawing and type a different value than the ones used 
for the main layer.

Add Layer Adds a new Morphing layer.

Delete Layer Deletes the selected Morphing layer.

Move Up Moves the new layer up in the stack.

Move Down Moves the new lower up in the stack.

  Start

Indicates the start frame of the selected Morphing 
layer. 

  Stop
Indicates the end frame of the selected Morphing 
layer. 

  Ease in and Ease out

The Easing option is used to adjust the starting and 
ending velocity of your morphing sequence so that 
the motion is smooth and not mechanical.

You can adjust the Ease In and Ease Out value by 
dragging your cursor up and down or typing a new 
value. The values go from -1.0 to 1.0.
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Convert Hints

The Convert Hints  option is used to switch the type of 
the selected hint points. This option is useful when 
you position hints and then realize they are not the 
right type. You can select them and convert them to 
the correct type instead of deleting them and setting 
new ones.

Use the Morphing tool to select the hints and then 
convert them by going to the Tool Properties view 
and selecting the new hint type from the Convert 
Hints drop-down menu.

  Time

The Time field is used to set the timing on Appearing 
Point and Vanishing Point hints. These hints are used 
to set the trajectory of appearing and vanishing 
objects, With the Time field, select your Appearing 
Point or Vanishing Point hint and type the frame 
number on which the object will start its appearing or 
vanishing animation.
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Node Caching Toolbar
The Node Caching toolbar allows you to control how nodes in your scene are cached.

Icon Button Description

Toggle 
Node's Cache

Toggles the Cached property of every selected node on or off. 

Show cached 
preview

Re-enables cache for every element or rig in your scene for which it was temporarily 
disabled.

Always 
Playback with 
Cached 
Previews

When toggled on, if you play your scene, the cache will be re-enabled for every 
element for which it was temporarily disabled. 

Disable 
Preview 
Cache when 
selecting 
nodes

When toggled on, selecting a node in the Timeline or Node view will disable 
caching for this node, or for any node connected underneath it.

NOTE 

Selecting an element in the Camera view always disables the cache for this 
element and its children, regardless of whether this option is enabled or 
disabled. This option only affects what happens when selecting in the 
Timeline or Node view. 
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Paint Tool Properties
The Paint tool allows you to fill closed areas of your drawing with the selected colour. 

How to access the Paint tool properties

 1. In the Tools toolbar, select the Paint , Paint Unpainted , Repaint  or Unpaint  tool.

The tool's properties are displayed in the Tool Properties view.

Paint Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an irregular 
closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 
rectangle around them. This is faster, as you only need to drag your 
mouse from one corner of the rectangle to its opposite corner, but it may 
not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other selection 
mode.
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Icon Property Description

Paint Mode

The Paint tool has four different modes:

 l Paint:  Paints or repaints selected zones, whether or not they are 
already filled.

 l Paint Unpainted:  Only paints empty zones, and does not repaint 
zones that are already filled with colour. 

 l Repaint:   Only paints zones that are already filled with colour, and 
does not fill empty zones.

 l Unpaint: Removes colour from the selected zone, replacing it with 
transparency.

Paint and 
Remove 
Textures

The Paint and Remove Texture  option is used when you vectorized images as 
greyscale texture style. An image vectorized as texture is a mix of bitmap filling 
encapsulated in a vector-based frame. Painting a textured zones with the Paint 
tool will change the tint of the textured lines. Painting the textured zones using 
the Paint and Remove Texture option transforms the bitmap filling into a 100% 
vector based zone and fills it with a solid colour.

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It can be 
toggled on or off. When toggled on, it has two different modes. You can select a 
mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the currently 
selected layers. If several layers are selected, the tool will work on all 
these layers simultaneously. 

 l  Apply to Visible Drawing Layers: The tool will work on all the 
visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer is 
synced with another layer, the tool will work on both the current layer 
and its synced layer. 

NOTE 

This option only works in the Camera view. 
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Apply to All 
Frames

This option allows you to determine which drawings in the current layer the tool 
should affect. It can be toggled on or off. When toggled on, it has two different 
modes. You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the drawing 
in the current frame.

 l Apply to All Frames: The tool will work on every exposed drawing in 
the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every drawing 
displayed in the Onion Skin. Onion Skin must be enabled for this option 
to work. 

Respect 
Protected 
Colour

The Respect Protected Colour option is enabled by default. In your Colour view, 
you can protect some colour swatches to avoid repainting or unpainting the 
zones linked to that swatch. 

If you disable this option the Paint tool will not follow the protect colour rule 
and will repaint or unpaint the protected colours on your drawings until you 
enable the option again.

Use Stored 
Colour Gradient

When you paint a zone with a gradient or textured colour swatch, the gradient or 
texture’s position is set relative to the size of the zone you are painting. If you 
want the Paint tool to use a particular size and position, you must first store your 
desired position and size using the Select  tool and then enable the Use Stored 
Colour Gradient   option in the Paint tool properties.
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Icon Property Description

Select Newly 
Painted, 
Repainted, and 
Unpainted 
Contours/Lines

In the Paint   tool properties, this option  keeps a selection highlighted around the 
latest painted zone after using the Paint, Repaint, Unpaint, or Paint Unpainted 
tool.

Close Gap

By default, if you attempt to fill a shape that has a small gap in its contour, the 
Paint tool will not be able to fill the shape. This option allows you to make the 
Paint tool automatically add a stroke to close the shape when it detects a small 
gap between two strokes in the shape. 

The Close Gap setting can be set to a value between 0 and 10. This determines 
the maximum size of a gap to close, in pixels. You can also use one of the 
following presets:

 l No Close Gap: Sets the Close Gap setting to 0, disabling the feature. 

 l Close Small Gap: Sets the Close Gap setting to 2, making the Paint 
tool close gaps that are barely visible. 

 l Close Medium Gap: Sets the Close Gap setting to 4, making the Paint 
tool close gaps that are somewhat visible. 

 l Close Large Gap: Sets the Close Gap setting to 8, making the Paint 
tool close gaps that are easy to notice. 
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Bitmap Options

Since bitmap drawings are made of pixels instead of shapes, and that the outlines of shapes in bitmap 
drawings are often feathered, it can be complicated to figure out exactly the area the Paint tool must fill when 
trying to fill a zone in a bitmap drawing. For example, if the Paint tool only replaces pixels with the exact same 
colour as the one you click on with the selected colour, it will leave a small gap near the outlines of the shape. 

The following settings determine how the Paint tool figures out the area it must fill. When any of these 
settings are increased, the Paint tool's tolerance for colour or alpha differences increases and it will a bigger 
area that it otherwise would. 

Icon Property Description

Source

Allows you to select which art layer to use in order to determine the 
fillable zone. By default, this is set to Current Art , which means the 
layer you are filling will be used to determine the fillable zone. However, 
if you want to keep your colour art on the Colour Art layer and the line 
art on the Line Art layer, you can set the Source to Line Art , and then 
use the Paint tool on the Colour Art layer. The Paint tool will use the 
artwork in the Line Art layer to determine the area to fill with colour, but 
will still add this colour to the Colour Art layer.

This property has the following options:

 l Current Art: Bases the zone to fill on the current art layer.

 l Line Art: Bases the zone to fill on the Line Art layer, 
regardless of which layer you are painting on.

 l Colour Art: Bases the zone to fill on the Colour Art layer, 
regardless of which layer you are painting on.

-- Alpha

The alpha threshold that separates opaque and transparent zones. 
When filling a "transparent" zone, the paint tool will apply the colour 
under semi-transparent pixels, making them opaque. Then filling an 
"opaque" zone, the paint tool will replace the colour of semi-transparent 
pixels without affecting their transparency. 

If you want to repaint lineart or shapes that have no outlines, you can do 
so by decreasing this setting completely. This will make it fill any pixel 
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Icon Property Description

that isn't 100% transparent, so it will paint your outlines completely. 
However, if you're using this method to repaint outlines, they must not 
be filled yet for this method to work. 

If you want to paint transparent zones that have dirt or semi-transparent 
spots, you can increase this setting to make the Paint tool paint behind 
them instead of around them. 

NOTE 

Raising this setting too high may cause the paint tool to ignore 
outlines that are not 100% opaque, which can cause it to think 
the shape is not closed. Hence, it might fail to find a zone to fill 
and not do anything.

-- Colour Tolerance

The amount of tolerance the paint tool has for changes in colour when 
filling an area. Raising this setting will allow the paint tool to fill over 
areas that have some variations in colour, but may cause it to fill beyond 
the areas you meant to paint.

-- Maximum Overlap

The maximum amount of pixels beyond the fillable zone that the Paint 
tool can fill.

When this setting is set to any value above zero, the paint tool will fill 
the zone until it finds a pixel that is a different colour, value or 
transparency as the one you clicked on. Then, it will start filling pixels 
beyond that point, up until it filled the amount of pixels in the Maximum 
Overlap setting. 

If it lands outside of a fillable zone before it reached the maximum 
overlap, it will stop filling at that point. However, if it lands into another 
fillable zone before reaching its maximum overlap, it will fill that zone 
as well. Therefore, if you're filling shapes inside other shapes, you have 
to set this setting to the approximate width of your outlines. Setting it 
higher will make the colour spill beyond the zone you clicked on and fill 
the zone outside of it, and setting it lower is liable to leave a small gap 
between the fill and the outlines.
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NOTE 

When you fill a zone with overlap, Harmony tries to detect and 
preserve the outlines of your shape. This is easy to do when 
filling a transparent shape, or when repainting a shape made of 
solid outlines and a solid fill. However, if you are trying to 
repaint an already painted zone, it may fail to detect your 
outlines and may repaint over them if the colour of your outlines 
or inside the shape isn't consistent. Therefore, it is highly 
recommended to avoid repainting painted zones as much as 
possible when working with bitmap layers. 

Antialiasing

When enabled, the outlines of the fill will be smoothed so that they do 
not look pixelated. 

NOTE 

The effect of this setting will not be visible if you fill all the way 
to the outlines, as the Paint tool will preserve the antialiasing of 
existing outlines when filling up to them. 
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 Pencil Tool Properties
The Pencil tool allows you to draw simple contour lines that are defined by their centerline and their thickness. 

When you select the Pencil tool, the Tool Properties view displays the different Pencil modes that control how 
the pencil line is drawn.

How to access the Pencil tool properties

 1. In the Tools toolbar, select the Pencil  tool. 

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

The following properties affect the pencil's size, smoothing, shape and other properties for the drawing style 
of your pencil. Those properties can be saved into pencil presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.
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Property Description

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives 
you access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog section 
below.

Maximum Size

Defines the maximum width of the pencil line.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary 
between its maximum size and minimum size depending on the amount of pressure 
used. If used with a mouse, the width of the stroke will always be its maximum size. 

Centerline Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import those 
that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Draw Behind

When enabled, your brush strokes will appear behind the existing artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as you 
draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  
button.

 2. Click on the  Set Current Pencil Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
your outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in 
the colour list, select the desired colour swatch for the 
fill. 

Trim Extra Lines
When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 
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Icon Property Description

Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make 
the point where the beginning and end of the stroke meet into a smooth 
curve rather than a hard corner. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto Flatten

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option automatically 
merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.                         

Auto-Close Gap

When enabled, small gaps between the pencil lines you draw will be 
closed by an invisible stroke to make sure your shapes are closed and that 
they can be filled with the Paint tool.

When drawing contours with pencil lines, the centreline is used to 
determine whether or not the contour is closed, but the visible tips of the 
pencil line will extend a bit beyond the tips of its centreline, making it 
possible to have shapes that appear closed, but are not really. This can 
prevent the shape from being filled with the Paint tool. Enabling this 
option when drawing with the Pencil or Line tool will prevent you from 
leaving invisible gaps in your contours.

 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.
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Icon Property Description

Line Building Mode

The Line Building mode is very useful when drawing long lines and curves 
in small increments with pencil lines or the Line tool. As the pencil lines 
are central vector lines, it may be difficult to align the line tips perfectly to 
create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are 
merge into one single stroke.

NOTE 

This mode only works with pencil lines or the line  tool.

Auto Adjust Thickness

The Auto Adjust Thickness  tool is useful when you want to render a 
portion of a line thicker. When tracing a drawing on paper, you will often 
go back to a section of a curve to make it thicker to add dynamism to the 
line. Using the Auto Adjust Thickness tool, you can draw highlight 
strokes over the section to make thicker. Once you release the pen or 
mouse, the line becomes thicker following the shape and curve of the 
original stroke. This way is much faster and smoother than using the 
Pencil Editor tool. You do not have to add extra points and adjust the 
position and Bezier handles.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode
The Line Pushing Mode  option lets you draw highlight strokes over 
existing pencil lines. You can reshape the curves. Depending how you 
draw the pushing stroke over your line, the highlighted section will be 
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Icon Property Description

reshaped in one direction or the other.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

  Colour

You can change the colour of the temporary strokes that appear in the 
drawing space when using the Line Pushing Mode or the Auto Adjust 
Thickness option by clicking on the Colour swatch and selecting a new 
colour in the Colour Picker dialog. 

Pencil Properties Dialog

Pencils have extra parameters which are not accessible from the Tool Properties view. To open the Pencil 
Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally 
bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will 
reduce the amount of control points it has, making it easier to tweak, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.
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 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view—see Colour View on page 1241. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, so 
it will be added to your new scenes in the exact state it is when you make 
it the default pencil texture palette.
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Icon Property Description

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the 
current pencil texture palette. The pencil texture's effect on your pencil 
line will be based on the image's transparency channel, and will follow 
your pencil lines on its horizontal axis. This option is also available from 
the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil texture 
palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it in 
the Colour view—see Colour View on page 1241.
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Pencil Editor Tool Properties
When you select the Pencil Editor  tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing 
a rectangle around them. This is faster, as you only need to drag 
your mouse from one corner of the rectangle to its opposite 
corner, but it may not be as precise as you want.
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TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Apply to Visible 
Drawing Layers

This option allows you to select which layers the tool should affect. It 
can be toggled on or off. When toggled on, it has two different modes. 
You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool 
will work on all these layers simultaneously. 

 l  Apply to Visible Drawing Layers: The tool will work on all 
the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 
layer is synced with another layer, the tool will work on both the 
current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

  Maximum Size

Defines the maximum width of the pencil line. 

If the pencil line has a constant size, this will define the width of the 
pencil line all over. If the pencil line has a varying size, this will define the 
width of its larger areas. Areas that are in-between the maximum and 
minimum size will be resized proportionally.

  Minimum Size
Defines the minimum width of the pencil line. If the pencil line has a 
varying size, this will define the width of its smaller areas. Areas that are 
in-betwen the maximum and minimum size will be resized proportionally.

  Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first 
tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.
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 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the corner 
style. You can choose between Round, Mitre and Bevel style.

  Presets

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import those 
that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Allows to create a new preset from the selected pencil line.

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, 
so it will be added to your new scenes in the exact state it is when you 
make it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

  New Texture Adds a new custom pencil texture to the list.
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  Delete Texture Deletes a texture preset from the list.

  Rename Texture Renames the selected texture to keep the list organized.

  Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

  Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use the 
Colour View menu to assign a new palette.

Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes and 
remove extra points.

TIP 

You can also smooth the selection by selecting Drawing> 
Optimize > Smooth from the top menu or by pressing Alt + 
Shift + S.             

Pump Pencil Pressure

The Pump Pencil Pressure  option is used to increase the line thickness of 
a selected area on a pencil line.

Deflate Pencil Pressure
The Deflate Pencil Pressure option is used to decrease the line thickness 
of a selected area on a pencil line.
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Merge Pencil Lines

Because pencil lines are defined by their centre lines, two pencil lines 
that brush against each other may not actually make a closed shape, even 
if they appear closed. If you select several pencil lines that are close 
together, you can use this button to close the small gaps between these 
pencil lines and make them into a single pencil line.

 

Reverse Pencil 
Thickness

The Reverse Pencil Thickness  option inverts the thick and thin section on 
a selected pencil line. This option will take the thickest size on the line 
and apply it to the thinnest, and it will apply the thinnest to the thickest.
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Perspective Tool Properties
The perspective tool allows you to deform artwork by creating a rectangular bounding box around it and 
allowing you to manipulate any of the four corners. The selected artwork will be deformed to fit the shape you 
make by simulating a perspective effect.

How to access the Perspective tool properties

 1. In the Tools toolbar, select the Perspective   tool.

The tool's properties are displayed in the Tool Properties view.

Icon Tool Name Description

Perspective Tool Options

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing 
a rectangle around them. This is faster, as you only need to drag 
your mouse from one corner of the rectangle to its opposite 
corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
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Icon Tool Name Description

click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its 
control points, it will snap against the nearby points and 
contours of your artwork, allowing you to snap parts of your 
artwork together. 

 l Snap to Alignment Guides: While moving the selection or one 
of its control points, it will snap against nearby alignment 
guides.

 l Snap and Align: When enabled, while moving a selection, the 
rectangular bounding box of the selection will snap to the 
rectangular bounding box of any other drawing stroke in the 
drawing, allowing you to align drawing strokes laterally.

 l Snap to Grid: While moving the selection, the mouse cursor will 
snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will 
also be affected when this option is enabled.

Deformation Mode

Allows you to select between one of the two following deformation 
modes:

 l  Perspective: Deforms the selection by simulating a 
perspective effect. 

 l  Lattice: Deforms the selection by simply making the artwork 
fit the bounding box, without applying a perspective effect. 

The difference between both modes becomes easier to understand if you 
apply a transformation to a drawing of a grid to make it look like it's laid 
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Icon Tool Name Description

down on a surface: 

Operations

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Rotate 90 CW Rotates the selection 90° clockwise.

Rotate 90 CCW Rotates the selection 90° counterclockwise.
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Polyline Tool Properties
The Polyline tool allows you to draw complex lines or shapes by defining each point and their Bezier handles 
one by one. 

How to access the Polyline tool properties

 1. In the Tools toolbar, select the Polyline  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.

Icon Property Description

  Preview Area

The Preview area lets you see a preview of the stroke your drawing tool 
will make.
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Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties 
dialog. 

While the Tool Properties view only gives you access to the pencil size, a 
list of pencil presets and other drawing options, the Pencil Properties 
dialog gives you access to all the available options for your pencil's 
shape and texture. For more information on the Pencil Properties dialog, 
see the Polyline Tool Properties section below.

  Size Defines the width of the pencil line used to draw the shape.

Pencil Presets

Icon Property Description

  Presets list

Harmony provides a variety of presets and also lets you create and save 
your own. It is a good idea to create and save pencils with precise sizes 
and parameters when you draw and design for efficiency and 
consistency. 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset 
list.

New Preset Creates a new preset based on the current tool properties. 

Delete Preset Deletes the currently selected preset.

Presets Menu Gives access to more options for managing presets.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail Displays presets in a grid of small thumbnails with a preview of their tip.
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  Large Thumbnail
Displays presets in a grid of big thumbnails, with their name and a 
preview of their tip.

  Stroke View
Displays presets in a list, with their name and a preview of a stroke done 
with each preset. 

Drawing Options

Icon Property Description

Snap to Contour

When this option is enabled, clicking close to a contour in your drawing 
will add the point to that contour. The line you are building will be linked 
to that contour.

If this option is disabled, attempting to click on existing contours will 
always create a point very close to that contour, but not exactly on it. 
Therefore, it is necessary to enable this mode if you want to create lines 
that branch from into existing contours in your drawing.

NOTE 

If you draw a line with the Line tool and make its tip snap to a 
contour or another control point in your artwork, they will be 
locked together. You can then manipulate both simultaneously 

using the  Contour Editor  tool. You can also separate two 
drawing strokes that have been snapped together by selecting 

one of them with the  Select  tool and moving it away.

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 
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TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  
button.

 2. Click on the  Set Current Pencil Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
your outline.

 3. Click on the  Set Current Paint Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
the fill. 

Trim Extra Lines

When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 

Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make 
the point where the beginning and end of the stroke meet into a smooth 
curve rather than a hard corner. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto-Flatten Mode
By default, when drawing on a vector layer, each new stroke is created as 
a separate drawing object, which can be edited independently from other 
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parts of the artwork. When enabled, the Auto-Flatten option 
automatically merges strokes into existing artwork. 

NOTE 

Using the Select tool, you can use select and remove a segment 
of flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.

Pencil Properties Dialog

The Polyline tool draws the same type of line as the Pencil tool. Hence, you can configure the Polyline tool's 
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 
display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally 
bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will 
reduce the amount of control points it has, making it easier to tweak, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.
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Property Description

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view—see Colour View on page 1241. 

Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, so 
it will be added to your new scenes in the exact state it is when you make 
it the default pencil texture palette.
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Icon Property Description

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the 
current pencil texture palette. The pencil texture's effect on your pencil 
line will be based on the image's transparency channel, and will follow 
your pencil lines on its horizontal axis. This option is also available from 
the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil texture 
palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 
allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it in 
the Colour view—see Colour View on page 1241.

NOTE 

L
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Rectangle Tool Properties
The Rectangle tool allows you to quickly draw a rectangle or a square.

How to access the Rectangle tool properties

 1. In the Tools toolbar, select the Rectangle  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the 
Pencil tool and it can be used with pencil presets.

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

Pencil Properties 
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 
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Property Description

While the Tool Properties view only gives you access to a few of the pencil properties, 
a list of pencil presets and other drawing options, the Pencil Properties dialog gives 
you access to all the available options for your pencil's shape and texture. For more 
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 
1112 section below.

Size Defines the width of the pencil line used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 
can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Drawing Options

These options affect the way your shape is added to your artwork.

Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing artwork. 
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Icon Property Description

NOTE 

Your brush stroke will temporarily appear over your artwork as you 
draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

When enabled, the shape you draw is automatically filled with the 
selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil line and its fill will be the same colour. To 
select different colours for the line and its fill, do the following:

 1. In the Colour view, click the Unlock Three Colours  
button.

 2. Click on the  Set Current Pencil Colour swatch. Then, 
in the colour list, select the desired colour swatch for 
your outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in 
the colour list, select the desired colour swatch for the 
fill. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: When enabled, while you're drawing, the mouse 
cursor will snap to the nearby contours of the artwork in your 
drawing. 
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Icon Property Description

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.

 l Snap and Align: When enabled, while you're drawing, the mouse 
cursor will automatically align to the rectangular bounding boxes 
of other strokes and shapes in your drawing.

 l When enabled, while you're drawing, the mouse cursor will snap 
against the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other 
parts of the artwork. When enabled, the Auto-Flatten option automatically 
merges strokes into existing artwork. 

NOTE 

Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the 
Auto-Flatten mode are essentially cut into segments by the 
overlap and can be treated as individual lines.
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Icon Property Description

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option can be used when painting with a 
gradient colour to always position the gradient in the same way it was 
stored, making it consistent across brush strokes. You can store a gradient 
by selecting a zone painted with a gradient with the Select tool, then 
clicking on Store Colour Gradient  in the Tool Properties view.

Draw Square

When enabled, the rectangle tool will always draw a rectangle of equal 
width and height, making it a perfect square.

TIP 

You can also draw a perfect square by holding the Shift key while 
drawing.

Pencil Presets

These options allow you to select, create and manage pencil presets.

Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw for 
efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while drawing, 
or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or to import your own.

You can  export the pencil presets that you have created and import those 
that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.
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Icon Property Description

Brush Presets Menu

Open a menu that contains the following options:

 l New Brush Preset: Creates a new preset based on the current 
tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 
preset.

 l Import Brushes: Allows you to import brush presets exported 
from Harmony.

 l Export Brushes: Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Pencil Properties Dialog

The Rectangle tool draws the same type of line as the Pencil tool. Hence, you can configure the Rectangle 
tool's lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the 
stroke display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the 
shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure 
sensitive pen tablet, the width of the stroke will vary between its maximum size and 
minimum size depending on the amount of pressure used. If used with a mouse, the 
width of the stroke will always be its maximum size. 

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If you 
do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the 
camera on the z-axis. This means that if the camera is zoomed in on the scene, the 
pencil will be proportionally smaller so that it appears the same size in the rendered 
image. Likewise, if the camera is zoomed out, the pencil will be proportionally 
bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the 
pencil stroke. A higher setting will prevent your line from being shaky and will 
reduce the amount of control points it has, making it easier to tweak, but is liable to 
reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 
the pencil stroke. 

A pencil line is defined by its centreline and its variations in thickness, rather than its 
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform. 
Therefore, its outer contour does not have any control point, except at its extremities, 
and no smoothing is required for its contour. 

However, when drawing a pencil line with a pressure sensitive tablet, its contour will 
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Property Description

have control points and Bezier curves to define the line's variations in thickness, and 
thus smoothing must be performed on its contour. An increased contour smoothing 
will reduce the amount of control points on the line's thickness and smoothen its 
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the 
current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 
Colour view—see Colour View on page 1241. 
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Icon Property Description

Use as Default Pencil 
Texture Palette

This option is available from the menu button. Sets the currently 
selected pencil texture palette as the default pencil texture palette in your 
user preferences. The default pencil texture palette is added to every 
scene you create in Harmony. The palette is copied in your preferences, so 
it will be added to your new scenes in the exact state it is when you make 
it the default pencil texture palette.

Reload Default Texture 
Palette

Imports the default pencil texture palette as a new pencil texture palette 
into your scene's palette list, and selects it as the current pencil texture 
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the 
current pencil texture palette. The pencil texture's effect on your pencil 
line will be based on the image's transparency channel, and will follow 
your pencil lines on its horizontal axis. This option is also available from 
the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 
This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil texture 
palette. This option is also available from the menu button.

  Pencil Texture Display Displays the pencil textures in the current pencil texture palette and 
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Icon Property Description

allows you to select one to use with the Pencil tool.

  Pencil Texture Palette
Displays the name of the currently selected pencil texture palette, for 
reference. To select a different pencil texture palette, you must select it in 
the Colour view—see Colour View on page 1241.
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Reposition All Drawings Tool Properties
When you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view. 

Tool Options

Icon Option Description

Easy Drag
When enabled, you can drag the selection by clicking anywhere inside its bounding 
box. By default, you must click on the artwork in the selection to be able to drag it. 

Apply to 
Synced 
Drawing 
Layers

If the currently selected layer is synced with another layer, the tool will work on 
both the current layer and its synced layer. 

Operations

Icon Option Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 
Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 
Degrees CCW

Rotates the current selection 90 degrees counter-clockwise.

  Offset X and Y
Use the Offset X and Offset Y operation fields to enter specific values and 
precisely reposition the selected shape.
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Icon Option Description

 1. X: Type a value in this field to reposition your selection along the X-axis.

 2. Y: Type a value in this field to reposition your selection along the Y-axis.

 3. Up/Down arrows: Use the up and down arrows to modify the value in the 
X or Y value field.

 
Width and 
Height

Use the Width and Height operation fields to enter specific values to resize the 
selected shape with precision.

 1. Width: Type a value in this field to resize the width of your selection.

 2. Height: Type a value in this field to resize the height of your selection.

 3. Up/Down arrows: Use the up and down arrows to modify the value in the 
Width or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio between the 
Width and Height values.

  Angle

The Angle operation lets you to enter specific values and accurately rotate the 
selected shape.

 1. Angle: Type a degree value in this field to rotate your selection.

 2. Up/Down arrows: Use the up and down arrows to modify the value in the 
Angle value field.
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Rigging Tool Properties
In the Tool Properties view, you can customize not only the behaviour of the tool but also the settings of the 
deformers that you will create.

Mode

Button Name Description

Automatic Mode
Sets the Rigging tool to automatically create a Bone or Curve 
deformer, corresponding to the movement of the cursor in the 
Camera view.

Bone Mode Sets the Rigging tool to create Bone deformations.

Curve Mode Sets the Rigging tool to create Curve deformations.

Envelope Mode Sets the Rigging tool to create Envelope deformations.

Game Bone Mode Sets the Rigging tool to create Game Bone deformations.

Free Form Mode Sets the Rigging too to create Free Form deformations.
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Options

Button Parameter Description

Show All Manipulators 
Lets you immediately see the resting position in red (Setup) and the 
animated position in green.

Show All Regions of 
Influence

Lets you visualize the area within which the art will be influenced by 
the deformation effect—see Rigging Tool Properties on page 1119.

Automatically Create 
Group when Creating a 
New Deformation Rig

This option automatically creates a deformation group connected to 
the input port of the selected element. This group includes all the 
necessary deformation nodes  you created.

  Bone

Sets the zone of influence for newly created Bone deformation points:

 l Zero Influence: The Zone of Influence does not exist. No 
deformation will happen.

 l Infinite Influence: This is the default option and is the most 
commonly used. The Zone of Influence has no boundary and 
covers the whole element to which the deformer is linked and 
its children, excluding areas that are already part of another 
elliptic or shaped Zone of Influence. The Infinite Influence 
zone will extend from the centre of your skeleton to infinity, 
working perpendicularly to the skeleton.

 l Elliptic Influence: The Zone of Influence boundary is defined 
by an elliptical shape; its size can be customized using the 
Bone, Articulation or Curve node properties or by using the 
Transform  tool. The Elliptic Influence will most likely be used 
on a bitmap picture you want to deform.

 l Shaped Influence: The Zone of Influence boundary is defined 
by a shape which you can customize using the Transform tool. 
The Shaped Influence will most likely be used on a bitmap 
picture you want to deform.

  Influence Radius
For Bone deformations with an Elliptic Influence, this sets the size of 
the influence zone.

  Curve

Sets the zone of influence for newly created Curve deformation 
points:

 l Zero Influence: The Zone of Influence does not exist. No 
deformation will happen.
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Button Parameter Description

 l Infinite Influence: This is the default option and is the most 
commonly used. The Zone of Influence has no boundary and 
covers the whole element to which the deformer is linked and 
its children, excluding areas that are already part of another 
elliptic or shaped Zone of Influence. The Infinite Influence 
zone will extend from the centre of your skeleton to infinity, 
working perpendicularly to the skeleton.

 l Elliptic Influence: The Zone of Influence boundary is defined 
by an elliptical shape; its size can be customized using the 
Bone, Articulation or Curve node properties or by using the 
Transform  tool. The Elliptic Influence will most likely be used 
on a bitmap picture you want to deform.

 l Shaped Influence: The Zone of Influence boundary is defined 
by a shape which you can customize using the Transform tool. 
The Shaped Influence will most likely be used on a bitmap 
picture you want to deform.

  Influence Radius
For Curve deformations with an Elliptic Influence, this sets the size of 
the influence zone.

Operations

Button Name Description

Convert Elliptic Zone of 
Influence to Shape

After you have created a deformation chain using Elliptic as the 
Zone of Influence type, you can select your deformer and click on 
this button to convert it to a Shaped type. Control points will 
appear around the shape making it easy to customize.You can also 
convert the Elliptic zone of influence to a shape. Select Animation 
> Deformation > Convert Elliptic Deformation ROI to Shape. 
This will create a much smaller  initial zone of influence than if you 
were to convert it directly to a shape.

Reset Deform (Reset Current 
Keyframe)

Copies the resting position of the deformation skeleton to the 
current frame.
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Select Tool Properties
The Select tool lets you select strokes and apply basic transformations such as repositioning, rotating, scaling 
or skewing, using the different handles of the bounding box.

If you have text or pencil lines selected with the Select tool, their properties will display in the Tool Properties 
view, allowing you to make changes to your selection.

How to access the Select tool properties

 1. In the Tools toolbar, select either the Select  tool. 

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 
irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing 
a rectangle around them. This is faster, as you only need to drag 
your mouse from one corner of the rectangle to its opposite 
corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 
selection mode.

1122



Icon Property Description

Easy Drag
When enabled, you can drag the selection by clicking anywhere inside its 
bounding box. By default, you must click on the artwork in the selection 
to be able to drag it. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Contour: While moving the selection or one of its control 
points, it will snap against the nearby points and contours of your 
artwork, allowing you to snap parts of your artwork together. 

 l Snap to Alignment Guides: While moving the selection or one of 
its control points, it will snap against nearby alignment guides.

 l Snap and Align: While moving the selection, the rectangular 
bounding box of the selection will align with the rectangular 
bounding boxes of other strokes and shapes in your artwork. If 
you move one of your selection's control points, it will also align 
with the bounding boxes of other strokes and shapes in your 
artwork.

 l Snap to Grid: While moving the selection, the mouse cursor will 
snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 
from the top menu or press Ctrl + '.
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Icon Property Description

Scale Pencil Line 
Thickness

When enabled, the width of pencil lines will be adjusted when scaling 
them with the Select tool.

TIP 

You can quickly enable this mode by selecting the Scale Pencil 

Line Thickness  tool, in the Select  tool's properties dialog.

Select by Colour

When enabled, clicking on a coloured zone in your artwork will instantly 
select all the zones that are filled with the same colour.

Select by Colour can also be accessed from the Tools toolbar.

NOTE 

Only the zones painted with the same colour swatch in your 
palette will be selected. If another zone is coloured with the exact 
same colour, but not the same colour swatch, it will not be 
selected.

Permanent Selection

Allows you maintain a selection while editing multiple drawings. Once 
this option is enabled, the selection zone made using the Select tool will 
remain as you navigate through drawings of the same layer and drawings 
from other drawing layers. 
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Icon Property Description

Apply to Visible Drawing 
Layers

This option allows you to select which layers the tool should affect. It 
can be toggled on or off. When toggled on, it has two different modes. 
You can select a mode by clicking and holding on the button.

 l Off: When this button is toggled off, the tool only works on the 
currently selected layers. If several layers are selected, the tool 
will work on all these layers simultaneously. 

 l  Apply to Visible Drawing Layers: The tool will work on all 
the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 
layer is synced with another layer, the tool will work on both the 
current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All Frames
This option allows you to determine which drawings in the current layer 
the tool should affect. It can be toggled on or off. When toggled on, it has 
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Icon Property Description

two different modes. You can select a mode by clicking and holding on 
the button.

 l Off: When this button is toggled off, the tool only works on the 
drawing in the current frame.

 l Apply to All Frames: The tool will work on every exposed 
drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool will work on every 
drawing displayed in the Onion Skin. Onion Skin must be enabled 
for this option to work. 

Apply to Line and Colour 
Art

Allows you to perform drawing operations on both the Line Art and 
Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will 
also be affected when this option is enabled.

Operations

Icon Property Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.
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Icon Property Description

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

Smooth

Smooth out selected drawing strokes and remove extra points.

Flatten 

Merges drawing objects and brush strokes into a single layer. If you draw 
new lines to fix a drawing or line with many brush strokes, it can be useful 
to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it 
will be easier if they are flattened. 

Create Colour Art from 
Line Art

Lets you use the outline you traced on one of the four embedded layers 
(line art, colour art, overlay, underlay) and create invisible strokes to paint 
your drawings on separate layers. This provides more inking and painting 
flexibility. 

You can also configure this option to create the invisible strokes on any of 
the four embedded layers.

Distribute to Layers

The Distribute to Layers  option is used to separate the selected art strokes 
and send them to new drawing layers. In the Camera view, once you have 
drawn your artwork, you can select the strokes you want to distribute 
using the Select  tool and click on the Distribute to Layers  button; you can 
also select Drawing > Distribute to Layers. It will automatically take 
every stroke from the drawing selection made in the Camera view and 
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Icon Property Description

separate them into a different layer for each. If an artwork is composed of 
several strokes, you must group them using Edit > Group > Group before 
using the Distribute to Layers option. This option cannot be done from the 
Drawing view.

Store Colour Gradient 

Use the Store Colour Gradient  operation to record the selected gradient’s 
position. This reuses the stored position of the gradient when drawing 
new brush lines or painting colour zones. Enable the Use Stored Colour 
Gradient  option in the Paint or Brush Tool Properties view to do this.

Pencil to Brush

Converts the selected centre line pencil strokes into contour strokes brush 
lines.

Merge Pencil Lines

Because pencil lines are defined by their centre lines, two pencil lines that 
brush against each other may not actually make a closed shape, even if 
they appear closed. If you select several pencil lines that are close 
together, you can use this button to close the small gaps between these 
pencil lines and make them into a single pencil line.

 

NOTE 

Points must be close enough to be merged. If there is a large gap 
between the lines, they will not be merged.

Reverse Pencil Thickness
The Reverse Pencil Thickness  option inverts the thick and thin section on 
a selected pencil line. This option will take the thickest size on the line 
and apply it to the thinnest, and it will apply the thinnest to the thickest.
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Icon Property Description

Offset X Lets you enter a value to reposition the selection along the X-axis.

Offset Y Lets you enter a value to reposition the selection along the Y-axis.

Width Lets you enter a value to resize the width of the selection.

Height Lets you enter a value to resize the height of the selection.

Lock Locks or unlocks the ratio between the Width and Height values.

Angle
Lets you enter specific values to rotate the selection. A positive value 
rotates the selection counter clockwise and a negative value rotates the 
selection clockwise. 

Pencil Selection

If the selection contains pencil lines, the Pencil Selection section appears at the bottom of the Tool Properties 
view, allowing you to adjust the properties of those pencil lines.
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Icon Property Description

  Maximum Size
Adjusts the size of the parts of the pencil lines that are the thickest. Parts 
of the pencil lines that are between the minimum and maximum sizes will 
be adjusted proportionally.

  Minimum Size
Adjusts the size of the parts of the pencil lines that are the thinnest. Parts 
of the pencil lines that are between the minimum and maximum sizes will 
be adjusted proportionally.

  Pencil Line Shape

You can adjust the start, end, and join  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first 
tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the corner 
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Icon Property Description

style. You can choose between Round, Mitre and Bevel style.

  Pencil Stencils

Allows you to apply one of the available line thickness stencils to the 
selected pencil lines. Stencils set the width of a pencil lines all along its 
length. You can use one of the preloaded presets, or create your own 
pencil stencils. 

 
Adding Texture to a 
Pencil Line

Pencil lines support texture. Once a pencil line is drawn, you can apply a 
preset texture or load your own. Textures are independent from pencil 
stencils.

Text Selection

If your selection include text boxes created with the Text tool, a Text Selection section will appear at the 
bottom of the Tool Properties view, allowing you to adjust the formatting of the whole text box. 

TIP 

You can also adjust the formatting of parts of the text in the text box using the Text tool—see Text 
Tool Properties on page 1150.
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Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic

Makes the selected text italic.

Align Left

Aligns the text in the selected text box to the left.

Align Center

Aligns the text in the selected text box to the centre.

Align Right Aligns the text in the selected text box to the right.
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Justify

Makes the text in the selected text box take all the horizontal space by 
adjusting the spacing between each word. Text that use a single line and 
text in the last line of a paragraph is aligned to the left.

  Size

Allows you to set the size of the selected text.

  Kerning

Allows you to increase or decrease the spacing between each character.

  Auto Kern Sets the kerning automatically based on the font’s predefined standard. 

  Indent
Allows you to increase or decrease the indentation of the first line of 
text in each paragraph.
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Icon Property Description

  Line Spacing

Increases or decreases the space between each line of text.
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Shift and Trace Tool Properties
The Shift and Trace tool allows you to temporarily move, rotate and scale drawings, then trace over them in 
other drawings, using Onion Skin to keep the outlines of the shifted drawings in your drawing space.  Contrary 
to Shift and Trace with the Drawing Desk, you can use the Shift and Trace tool in the Camera view. 

How to access the Shift and Trace Tool Properties

 1. Do one of the following:

 l In the Tools toolbar, double-click on the Hand  tool and select Shift and Trace  in the 
pop-up menu.

 l In the top menu, select Drawing > Drawing Tools > Shift and Trace.

The Shift and Trace tool properties appear in the Tool Properties view. 

Icon Tool Name Description

Shift and Trace Tool Options

Enable/Disable 
Shift and Trace

Enabled by default. When disabled, drawings that were repositioned, rotated or 
scaled with the Shift and Trace tool appear in their original position.

Display Cross 
Hair

Enabled by default. When disabled, cross hairs added with the Shift and Trace 
tool are invisible. 

Show 
manipulators for 

Enabled by default. This displays the manipulator allowing you to rotate and 
scale drawings for Shift and Trace, as well as to re-position their pivot point. 
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Icon Tool Name Description

shift and trace When hidden, you can only shift drawings laterally. 

Show the 
outline of the 
selected shift 
and trace 
drawing

When enabled, the contours of each brush stroke for the current drawing will 
appear highlighted in cyan.

Show/Hide Pegs

Enabled by default. When using the Shift and Trace tool, peg holes are displayed 
at the bottom of every drawing to help keep track of how offset drawings are from 
their original position and from each other. You can also click and drag on the left 
or right peg hole of a drawing to rotate it around the centre peg hole. When 
disabled, those peg holes are hidden.

Peg Position
Allows you to select on which edge of the drawings to display peg holes. By 
default, they are displayed at the bottom of the drawings.

Modes and Operations

Set Add Cross 
Hair Mode

When selected, clicking on the drawing will add a cross hair where you click. 
Cross hairs are marks that appear on the same location on every drawing in the 
current layer and which move when you offset a drawing with the Shift and Trace 
tool, and they appear in the Onion Skin rendition of neighbouring drawings as 
well. This allows you to keep track of how offset each drawing is. 

Remove All 
Cross Hair

Removes all the cross hairs created for shift and trace.

Reset Selected 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on the selected 
drawings, resetting them to their original position, angle and scale.

Reset All 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on all drawings, 
resetting them to their original position, angle and scale. 

Info

Selected Drawings The element name and drawing name of the currently selected drawing.
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Icon Tool Name Description

Position
The offset of the current drawing from its original position on the x and y axes, in 
fields, when moved with the Shift and Trace tool.

Scale
The Shift and Trace scale factor of the currently selected drawing, when scaled 
with the Shift and Trace tool.

Rotation
The Shift and Trace rotation angle of the currently selected drawing, in degrees, 
counterclockwise, when rotated with the Shift and Trace tool.

Pivot
The offset, in fields, of the current drawing's pivot point from its centre, on the x 
and y axes. The pivot point is the point from which drawings are rotated and 
scaled.
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Smooth Editor Tool Properties
When you select the Smooth Editor tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Smoothing Style 

The Smoothing Style options allow you to smooth a 
portion of your drawing by tracing a smoothing stroke 
over the zone to optimize or by selecting an area of 
the drawing with the Marquee or Lasso.

Note that by default, the Smooth Editor tool colour is 
yellow, it was changed to orange for screen grab 
clarity.

Show Control Points 

The Show Control Points  option allows you to show 
or hide the Bezier points around lines. When the 
Bezier points are displayed, you can see the result of 
your smoothing and the number of points left on the 
curve. When it is turned off, only the original artwork 
is displayed.

 
Minimum Size and 
Maximum Size 

This is where you set the minimum and maximum 
sizes of your drawing tool which will produce the 
thick and thin effect on your stroke. This works with 
the pressure sensitivity of a pen tablet.

This options is available while using the Brush 
Smoothing  style.

 l Maximum and Minimum Size: Defines the 
maximum and minimum width of the stroke.
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 l Up/Down arrows: Use the up and down 
arrows to set the minimum and maximum size 
value.

Smoothness 

The Smoothness impacts the strength of the 
smoothing result. The higher the value, the more 
points are removed and the smoother the curve. The 
Smoothness range is from 0 to 100; the default value 
is 20.

  Colour 

You can modify the colour of the control points 
displayed on the artwork while working with the 
Smooth Editor tool by double-clicking on the colour 
swatch.
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Stamp Tool Properties
The Stamp tool allows you to create and use stamps, which can contain one or several drawings that can be 
stamped individually or in sequence onto your artwork.

How to access the Stamp tool properties

 1. In the Tools toolbar, select the Stamp  tool.

The tool's properties are displayed in the Tool Properties view.

Stamp Properties

The following options allow you, among other things, to preview your stamp, to change the size of your stamp 
as well as to flip it horizontally and vertically.

Property Description

Preview 
Area

The Preview area lets you see a preview of what will appear if you draw a stroke with the Stamp 
tool.
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Property Description

Stamp 
Properties 
Dialog

The arrow button right of the preview area opens the Stamp Properties dialog. 

While the Tool Properties view only gives you access to a few of the stamp properties and a list of 
stamp presets, the Stamp Properties dialog gives you access to all the available options for the 
way your stamp will be applied. For more information on the Stamp Properties dialog, see the 
Stamp Properties Dialog on page 1144 section below.

Flip 
Horizontally 
/ Flip 
Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 
horizontally or vertically.

Maximum 
Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was used to 
create the stamp. This means that, at 100%, the drawing will be stamped into your artwork in its 
original size.

NOTE 

If the tool is used with a pressure sensitive tablet, the scale of the stamp can be made to be 
relative to the amount of pressure you put on your pen. To do this, you must reducing the 
Minimum Scale property of your stamp in the Stamp Properties dialog. If the Minimum Scale 
setting is left at its default value, which is 100%, the size of the stamp will not vary.

Stamp

When using a multi-drawing stamp, this is the number of the drawing in the series that will be 
stamped on the next time you use the Stamp tool. For example, if your stamp has 3 drawings and 
this is set to 2, the next drawing that will be stamped on is the second drawing in the series. 

If your stamp's Cycle setting is set to Hold, then you have to use this slider to select which 
drawing to stamp with the Stamp tool. 

If your stamp's Reset Cycle for Each Stroke option is enabled, then you can use this slider to 
select which drawing to start each stroke with.

Otherwise, when you draw a stroke with the Stamp tool, the Stamp slider will automatically 
update to the next drawing in the sequence.
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Property Description

TIP 

You can also cycle through the drawings in your stamp by using the Left Arrow and Right 
Arrow keys. 

NOTE 

The Cycle and Reset Cycle for Each Strokee options are available in the Stamp 
Properties dialog. 

Stamp Presets

These options allow you to select, create and manage stamp presets. 

Contrary to the Brush and Pencil tools, creating a Stamp preset is required to use the Stamp tool, as this preset 
will contain the drawings to stamp onto your artwork. A Stamp preset is created by selecting one or several 
layers, then adding a preset to the Stamp Presets list. If several layers are selected, the Stamp will contain a 
series of drawings, which it will stamp onto your artwork in a sequence as you draw strokes with the Stamp 
tool. 

Icon Property Description

  Presets list
The list of Stamp presets. Click on one of the presets to select it and use 
it in your drawing. 

New Brush Preset

Creates a new Stamp preset based on the selected artwork. The artwork 
can either be a selection made with the Select  tool, or by selecting a 
layer. 

If several layers are selected, this will create a multi-drawing Stamp. As 
you draw a stroke with the Stamp tool using a multi-drawing stamp, each 
drawing in the stamp will be applied onto your artwork, one after the 
other. 

Delete Brush Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains all of the previous options, along with all of 
the following options:

 l New Brush Preset: Creates a new stamp based on the selected 
artwork.
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 l Rename Preset:Allows you to rename the currently selected 
preset.

 l Import Brushes:Allows you to import brush presets exported 
from Harmony.

 l Export Brushes:Allows you to export your brush presets into an
 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 
with a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 
with their name and a preview of their tip.

 l Stroke View: Displays presets in a list, with their name and a 
preview of a stroke done with each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork

Icon Property Description

Draw Behind

When enabled, your brush strokes will appear behind the existing 
artwork. 

NOTE 

Your brush stroke will temporarily appear over your artwork as 
you draw it, until you release the mouse cursor or tablet pen. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to select 
which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-up 
menu in which you can toggle different snapping modes. You can also 
click on this button to toggle it off, which will disable all snapping 
modes, and click on it again and toggle it on to re-enable the snapping 
modes which were previously enabled. 
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This tool supports the following snapping mode:

 l Snap to Alignment Guides: While drawing, the drawing tool will 
snap against nearby alignment guides.

Stamp Properties Dialog

The Stamp Properties dialog allows you to set more specific settings for your stamp, such as pressure 
sensitivity, spacing, angle, randomness and, for multi-drawing stamps, how to cycle through each drawing in 
the stamp. To open the Stamp Properties dialog, click on the arrow button right of the stroke display area.

Property Description

Maximum Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was 
used to create the stamp. This means that, at 100%, the drawing will be stamped into your 
artwork in its original size.

Minimum Scale
The minimum scaling factor to apply to the stamp before stamping it onto your drawing. 
When using the Stamp tool with a pressure-sensitive pen tablet, the size of the stamps 
applied onto your artwork will vary between its Minimum Scale and Maximum Scale 

1144



Property Description

properties, relative to the amount of pressure you apply to the pen.

This setting is relative to the Maximum Scale property. This means that if the Maximum 
Scale is set to 50% and the Minimum Scale is set to 50%, the actual scaling factor applied 
to the stamp will vary between 25% and 50%. 

This setting is also used with the Random Size setting. 

Flip Horizontally / 
Flip Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 
horizontally or vertically.

Roundness & 
Angle

The Roundness and Angle parameters allow you to change the shape and orientation of the 
stamp.

 l Roundness: The vertical scaling to apply to the stamp. Reducing this setting 
squashes the stamp vertically, allowing you to turn round or square stamps into flat 
stamps. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the stamp is rotated, the squashing will 
still be done relative to the stamp's original orientation.

Spacing
Defines the amount of space between each stamp that is applied onto the artwork. The 
larger the value, the greater the space between each stamp. 
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Property Description

Random Size

The percentage of randomness to apply to the size of the stamp. This makes the size of the 
stamp randomly vary between its Maximum Scale and Minimum Scale settings each time it 
is applied to your artwork. 

The greater the value of the Random Size property, the closer to its Minimum Scale the size 
of each stamp can get. For example, if the Random Size setting is set to 50% and the 
Minimum Scale is set to 50%, the size of the stamp will randomly vary between 75% and 
100% of its Maximum Scale. 

Random Angle

The maximum value of randomness to apply to the angle of the stamp. This makes the 
angle of the stamp randomly vary within the range of degrees in this setting, in either 
direction, each time it is applied to your artwork. For example, if the stamp's Angle is set to 
0°, and the Random Angle is set to 180°, each instance of the stamp will be at a random 
angle varying between -90° and 90°.

Random Spacing

The maximum amount of randomness to apply to the spacing of the stamp. Increasing this 
setting makes the distance between each instance of the stamp vary randomly as you draw 
a stroke. At 100%, this makes the distance between each stroke vary between 0% and 
200% of its Spacing property.

Cycle

For multi-drawing stamps, this decides the logic with which to cycle through the sequence 
of drawings in the stamp as you draw a stroke.

 l Forward: Starts by applying the first drawing in the sequence, then the next one, 
and so on until it reaches the last drawing in the sequence, then cycles back to the 
first one.
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 l Reverse: Starts by applying the last drawing in the sequence, then the previous one, 
and so on until it reaches the first drawing in the sequence, then cycles back to the 
last one.

 l Forward->Reverse: Starts by cycling forward through the sequence until it reaches 
the last drawing, then cycles backward to the first drawing, and so on.

 l Reverse->Forward: Starts by cycling backward through the sequence until it 
reaches the first drawing, then cycles back to the last drawing, and so on.

 l Random: Applies a random drawing in the sequence each time the stamp is applied. 

 l Hold: Applies a single one of the drawings in the sequence over and over again. 

TIP 

When this option is set to Hold, you can select which one of the drawings is stamped 

on by changing the Stamp setting in the Tool Properties view.

Reset Cycle for 
Each Stroke

For multi-drawing stamps. This makes it so each stroke you draw with the stamp too 
always starts with the first drawing in the cycle, which is decided by the Stamp option in 
the Tool Properties view. 

When disabled, the Stamp tool keeps track of which drawing it was going to stamp next 
when you finish drawing a stroke by storing the number of that drawing in the Stamp 
setting. When this option is enabled, it simply stops updating the Stamp setting. Hence, 
your strokes always start at the drawing selected with that setting. Likewise, you can 
manually decide which drawing to start your strokes with by adjusting the Stamp setting.
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Stroke Tool Properties
When you select the Stroke tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Draw Stroke as 
Straight Lines 

Enable the Draw Stroke as Straight Lines  option if you want the new strokes 
you draw to be a perfect straight line. Disable the option if you want the 
stroke to follow the mouse gesture.

Connect Line Ends 
Enable the Connect Line Ends  option if you want the start or end point of 
your new stroke to connect to your existing strokes to make sure no gaps are 
left in your drawing.

Auto Fill

When enabled, drawing a closed shape will automatically fill it with the 
currently selected Paint colour. 

Trim Extra Lines

When enabled, drawing a closed shape will automatically remove the 
outstanding  lines. 

Align Handles After 
Trim

When the Trim Extra Lines option is enabled, enable this option to make the 
point where the beginning and end of the stroke meet into a smooth curve 
rather than a hard corner. 
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Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a 
separate drawing object, which can be edited independently from other parts 
of the artwork. When enabled, the Auto-Flatten option automatically merges 
strokes into existing artwork. 

Apply to Line and 
Colour Art

Allows you to perform drawing operations on both the Line Art and Colour 
Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they will also 
be affected when this option is enabled.

Apply to Synced 
Drawing Layers

If the currently selected layer is synced with another layer, the tool will work 
on both the current layer and its synced layer. 

  Smoothness

You can modify the central line smoothness  of your line using this option. 
This parameter smooths the initial movement of your line. Increasing the 
value will result in a smoother line with fewer control points. Use the left 
and right arrows to increment the value by one full unit. Use the Up - Down 
slider to quickly increment the value.
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Text Tool Properties
The Text tool lets you add text fields to your project, in which you can type text, then adjust its formatting 
using various fonts and text attributes. 

With the Text tool selected, you can select text within text boxes you created and change the formatting of 
the selection. You can also select and manipulate text boxes using the Select tool, and change the formatting 
of the entire text box in the Select tool properties. 

How to access the Text tool properties

 l In the Tools toolbar, select the Text  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic Makes the selected text italic.
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Icon Property Description

Align Left

Aligns the text in the selected text box to the left.

Align Center

Aligns the text in the selected text box to the centre.

Align Right

Aligns the text in the selected text box to the right.

Justify

Makes the text in the selected text box take all the horizontal space by 
adjusting the spacing between each word. Text that use a single line and 
text in the last line of a paragraph is aligned to the left.
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Icon Property Description

  Size

Allows you to set the size of the selected text.

  Kerning

Allows you to increase or decrease the spacing between each character.

  Auto Kern Sets the kerning automatically based on the font’s predefined standard. 

  Indent

Allows you to increase or decrease the indentation of the first line of 
text in each paragraph.

  Line Spacing

Increases or decreases the space between each line of text.
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Transform Tool Properties 
When selecting the Transform tool, several options are available in the Tool Properties view.

Icon Tool Name Description

Lasso

Sets the selection mode to Lasso, which allows you to select 
multiple items by drawing a lasso around them.

TIP 

When this option is enabled, you can press and hold the Alt 
key to temporarily use Marquee mode.

Marquee

Sets the selection mode to Marquee, which allows you to select 
multiple items by drawing a rectangle around them. 

TIP 

When this option is enabled, you can press and hold the Alt 
key to temporarily use Lasso mode.

Easy Drag
When enabled, you can drag the selection by clicking anywhere 
inside its bounding box. By default, you must click on the artwork 
in the selection to be able to drag it. 

Snapping

Allows you to enable or disable snapping for this tool and all other 
animation and drawing tools that support snapping, as well as to 
select which types of snapping are enabled. 

If you double-click or long-click on this button, it will open a pop-
up menu in which you can toggle different snapping modes. You 
can also click on this button to toggle it off, which will disable all 
snapping modes, and click on it again and toggle it on to re-enable 
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the snapping modes which were previously enabled. 

This tool supports the following snapping modes:

 l Snap to Alignment Guides: While moving the selection or 
one of its control points, it will snap against nearby 
alignment guides.

 l Snap and Align: While moving the selection, the 
rectangular bounding box of the selection will align with 
the rectangular bounding boxes of other elements in your 
scene. If you move one of your selection's control points, it 
will also align with the bounding boxes of other elements.

 l Snap to Grid: While moving the selection, the mouse 
cursor will snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show 
Grid from the top menu or press Ctrl + '.

Peg Selection Mode

In the Camera view, the Peg Selection Mode limits the selection to 
peg layers instead of drawing layers. This mode is useful when you 
have created a character rig using peg layers for each drawing.  That 
way, you do not accidentally select the drawing layer when you 
want to animate on the peg.

When disabled, the Transform  tool selects the drawing layers.

Control Selection Mode

When enabled, you can select several control points in the Camera 
view by drawing a lasso or marquee around them. By default, 
drawing a lasso or marquee in the Camera view will select layers in 
the area.
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NOTE 

This option works with curve and envelope deformation 
points as well as Animated Matte Generator control points. 

Mixed Manipulation Mode

Allows the selection and manipulation of different types of 
interfaces, such as pegs and curves, together in the same operation.

When enabled, certain deformation controls and extra controls will 
be able to be selected and manipulated with the Transform Tool. 
This will extend the bounding box used by the tool to encompass 
the selected controls. These controls can then be transformed at 
the same time with other selected pegs, drawings and compatible 
controls.

Hide Manipulator Controls
The Hide Manipulator Controls  button lets you hide the bounding 
box and manipulator controls from the Camera view when an 
element is selected.

Flip Horizontal

Flips the current selection horizontally. 

You can also select Animation > Flip > Flip Horizontal from the 
top menu or press 4 or 5.

Flip Vertical

Flips the current selection vertically.  

You can also select Animation > Flip > Flip Vertical from the top 
menu or press 4 or 5.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

  Offset X ad Y

Use the Offset X and Offset Y operation fields to enter specific 
values and precisely reposition the selected shape.

 1. X: Type a value in this field to reposition your selection 
along the X-axis.

 2. Y: Type a value in this field to reposition your selection 
along the Y-axis.
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 3. Up/Down arrows: Use the up and down arrows to modify 
the value in the X or Y value field.

  Width and Height

Use the Width and Height operation fields to enter specific values 
to resize the selected shape with precision.

 1. Width: Type a value in this field to resize the width of your 
selection.

 2. Height: Type a value in this field to resize the height of your 
selection.

 3. Up/Down arrows: Use the up and down arrows to modify 
the value in the Width or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio 
between the Width and Height values.

  Angle

The Angle operation lets you to enter specific values and accurately 
rotate the selected shape.

 1. Angle: Type a degree value in this field to rotate your 
selection.

 2. Up/Down arrows: Use the up and down arrows to modify 
the value in the Angle value field.

1156



Zoom Tool Properties
The Zoom tool lets you zoom in and out of the Camera, Drawing, Side and Top views. You can also use it to 
reset the zoom level.

How to access the Zoom tool properties

 1. In the Tools toolbar, select the Zoom  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Parameter Description

Zoom In Mode Use the mouse cursor to zoom in to the Camera or Drawing view.

Zoom Out Mode Use the mouse cursor to zoom out of the Camera or Drawing view.

Operations

Icon Parameter Description

Perform Zoom 
In

Zoom in the Camera or Drawing view. 

The keyboard shortcut is 2.

Perform Zoom 
Out

Zoom out the Camera or Drawing view. 

The keyboard shortcut is 1.

Reset Zoom Restores the current zoom level to 100%.

Reset View Restores the original display by resetting any pan, rotation or zoom actions.
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Chapter 5: Toolbars
Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a 
toolbar which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it 
with the tools you use most often and hide the ones you don't.

Workspace Toolbars 1160

Advanced Animation Toolbar 1161

Art Layer Toolbar 1163

Control Point Toolbar 1165

Coordinate Toolbar 1167

Deformation Toolbar 1168

Display Toolbar 1173

Easy Flipping Toolbar 1174

Edit Toolbar 1175

File Toolbar 1176

Flip Toolbar 1178

Game Toolbar 1179

Mark Drawing Toolbar 1180

Master Controller Toolbar 1181

Mini Playback Toolbar 1183

Node Caching Toolbar 1184

Onion Skin Toolbar 1185

Pen Settings Toolbar 1187

Playback Toolbar 1190

Scripting Toolbar 1193

Shift and Trace Toolbar 1194

Tool Presets Toolbar 1196

Tools Toolbar 1197

Workspace Toolbar 1203

View Toolbars 1204

3D Graph View Toolbar 1205
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Animated Matte Generator Toolbar 1206

Script Editor Toolbar 1209

Timeline View Toolbar 1214

Xsheet View Toolbar 1219
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Workspace Toolbars
Harmony has a series of toolbars that are added by default at the top of the interface. These toolbars can be 
moved on the sides of the interface as well as within specific views. 

All top toolbars can be added by selecting  Windows > Toolbars in the top menu.

Advanced Animation Toolbar 1161

Art Layer Toolbar 1163

Control Point Toolbar 1165

Coordinate Toolbar 1167

Deformation Toolbar 1168

Display Toolbar 1173

Easy Flipping Toolbar 1174

Edit Toolbar 1175

File Toolbar 1176

Flip Toolbar 1178

Game Toolbar 1179

Mark Drawing Toolbar 1180

Master Controller Toolbar 1181

Mini Playback Toolbar 1183

Node Caching Toolbar 1184

Onion Skin Toolbar 1185

Pen Settings Toolbar 1187

Playback Toolbar 1190

Scripting Toolbar 1193

Shift and Trace Toolbar 1194

Tool Presets Toolbar 1196

Tools Toolbar 1197

Workspace Toolbar 1203
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Advanced Animation Toolbar
The Advanced Animation toolbar contains tools to position and animate layers. The Scale, Translate and 
Rotate tools can be used to reposition the permanent pivot position of a layer. Unlike the Transform tool, each 
tool in the Advanced Animation toolbar performs a single operation, either rotate, scale, translate or scale in 
relation to the camera distance.

How to access the Advance Animation toolbar

 1. Select Windows > Toolbars > Advanced Animation.

Icon Tool Name Description

Translate
Lets you move the selected element along the X and Y 
axes.

Rotate Turns a selected element around its pivot point. 

Scale

Increases or decreases the size of a selected element. 
You can scale an object up to make it larger or down 
to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the 
Camera view as you move them towards or away from 
the camera.

Spline Offset

Lets you reposition the visual trajectory without 
offsetting or modifying your animation. By default, the 
trajectory is located at 0,0,0 fields. If your elements 
were drawn in a different location than the centre of 
the drawing area, it will look like the trajectory is not 
aligned with your drawing. Also, if you have several 
elements attached to one trajectory, you might want 
your trajectory to be at a different location to 
represent the group's motion better.

Reposition Drawing Lets you reposition, scale, rotate or skew all drawing 

1161

Harmony 21 Premium Reference Guide                          



Chapter 5: Toolbars

strokes on every drawing included in a layer. 

Capture Motion

Capture the mouse movement and apply to the X and 
Y position of Peg or Drawing.

It allows you to select the following options:

  Capture Speed:  It reduces or accelerate the speed at 
which keyframes are recorded as you trace the 
animation by hand.

  Keyframe Interval: It shows the number of frames 
separating keyframes generated in the animation.

  Smoothing: It shows the degree of smoothing 
applied on the animation that you trace.

  Capture: Clicking Capture button will enable the 
capture of a path in the camera view, when a drawing 
or peg is selected. 

This acts as a security lock that prevents the user from 
accidentally capturing a motion path in the camera 
view.  The button automatically resets its state when 
you complete the animation.
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Art Layer Toolbar
The Art Layer toolbar lets you access the art layers. By default, only the Line Art and Colour Art are displayed. 
A drawing is composed of two layers, a line layer and a colour layer. The colour layer is always placed under 
the line layer. These layers are accessible in the Drawing or Camera view (using drawing tools). When you 
view the final drawing, you will see the final composition of the lines and colours, not two separate layers.

You can draw and paint in all layers. If you prefer to work in a single layer, everything can be done in the Line 
Art layer.

You can change your preferences to enable the advanced use of layers and have access to four layers instead of 
two:

 l Overlay

 l Line Art

 l Colour Art

 l Underlay

How to access the Art Layer toolbar

 1. Select Windows > Toolbars > Art Layer.

How to enable the Support Overlay and Underlay Arts option

 1. Select Edit > Preferences ( Windows/Linux ) or Harmony Premium > Preferences ( macOS ).

 2. In the Preferences dialog box, select the Advanced tab.

 3. In the Advanced Options section, select the Support Overlay and Underlay Arts option.

 4. Click OK.

Icon Tool Name Description

Preview Line Art and 
Colour Art

Displays all Art layers.

Overlay Art Makes the Overlay Art layer current.
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Line Art Makes the Line Art layer current.

Colour Art Makes the Colour Art layer current.

Underlay Art Makes the Underlay Art layer current.
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Control Point Toolbar 
The Control Point toolbar displays parameters when you select a keyframe or control point in the Camera, 
Timeline or Xsheet view. You can edit keyframes and control point parameters, such as the continuity, bias, 
tension and lock-in-time. 

How to access the Control Point toolbar

 1. Select Windows > Toolbars > Control Point.

Icon Tool Name Description

  Frame Indicates the current frame.

  Locked in Time Locks a control point in time, making it a keyframe.

  Constant Keyframe
Removes any interpolation and keeps the keyframe 
value constant up to the next keyframe.

T Tension

Controls how sharply the path bends as it passes 
through a control point or keyframe.

C Continuity

Controls the smoothness of a transition between the 
segments joined by a point.

B Bias Controls the slope of the path so it flows towards 
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one side of the motion point or the other.

1166



Coordinate Toolbar
T-ANIMCO2-001-001

 

The Coordinate toolbar displays parameters of keyframes or control points in the Camera, Timeline or Xsheet 
view. You can edit keyframes and control point parameters, such as the position, scale and rotation 
coordinates.

For tasks related to this toolbar, see Coordinates and Control Points View on page 1249.

How to access the Coordinate toolbar

 1. Select Windows > Toolbars > Coordinate.

Parameter Description

Translation

The translation fields display the X, Y and Z translation values of the selected 
layer. You can enter precise values to set the first frame and last frame position of 
a layer. By default the Z value field is disabled. It will automatically become 
active when the 3D option is enabled.

Scale

The scale fields display the X, Y and Z scaling values of the selected layer. You 
can enter precise values to set the first frame and last frame size of a layer. By 
default the Z value field is disabled. It will automatically become active when the 
3D option is enabled.

Rotation

The rotation fields display the X, Y and Z rotation values of the selected layer. 
You can enter precise values to set the first frame and last frame rotation of a 
layer. By default the Z value field is disabled. It will automatically become active 
when the 3D option is enabled.

Skew
The skew field displays skew value of the selected object. You can enter a precise 
value to set the skew of the object. 
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Deformation Toolbar
T-RIG-007-009

The Deformation toolbar contains the various tools and options used to create a deformation rig. This toolbar is 
displayed in the default interface.

By default, the Deformation toolbar only contains the essential options. If you right-click on the toolbar and 
select Customize, you can add additional buttons.

Default Buttons

Icon Tool Name Description

Rigging Tool

The Rigging tool is used to create either a Bone or 
Curve deformation chain. You also use it to set up the 
resting position.

To learn more about the Rigging tool's properties, see 
Rigging Tool Properties on page 1119.

Show Selected 
Deformation Chain and 
Hide All Others

Displays the deformation controls for the selected 
element and all of its children in the Camera view, and 
hides the deformation controls for any other element 
in your scene.

Show Selected 
Deformers

Displays the deformation controls for the selected 
element and all of its children in the Camera view. If 
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deformation controls for other elements are currently 
visible, they will remain visible as well.

Show Deformation Mesh
Overlay the deformation mesh as a wireframe over the 
drawings.

Show Manipulator

When several points from a curve or envelope 
deformation chain are selected, this displays a 
manipulator bounding box around them. Using this 
manipulator, you can move, rotate and scale the 
selected points together. 

Reset Current Keyframe

The Reset Current Keyframe copies the resting 
position, the original setup of your skeleton before 
undergoing any deformation, to your current frame. 
Once you have created a deformation chain, you can 
use the Rigging tool to adjust the position and 
appearance of the rig to fit the element. When the 
skeleton is in place, you can use the Reset Current 
Keyframe button to reset the current frame position to 
the resting position.

Create New Deformation 
Chain

The Create New Deformation Chain option allows you 
to create a new deformation chain on a same 
character. For example, if you have drawings for the 
different views of your puppet (front, profile, back, 
etc.), you can use this feature to setup a new set of 
chains for each angle without having to create 
completely different puppets.

Rename Transformation
The Rename Transformation option allows you to 
give specific names to your different transformation 
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chains. By default, chains are named Transformation 
plus the number of the chain, such as Transformation 
2. You can rename these to identify them easier, such 
as front, side, back, and so on.

Transformation Selector

The Transformation Selector drop-down menu allows 
you to assign an existing chain to a set of drawings. 
For example you might want to reuse the front 
deformation chains for another series of drawing.

When creating a new drawing, the Default 
Transformation is assigned. While on the new 
drawing frames, from the drop-down menu, select a 
different chain to automatically assign it.

Enable Deformations

The Enable Deformations button allows you to 
display your drawings in their original state or with 
deformations while creating additional drawings. 
Depending on the artwork you need to create, you 
might need to refer to the other images either 
deformed or in their original position.

NOTE 

Disabling deformations is only a display 
mode. Although drawings will not appear 
deformed in the Camera view, even in 
Render View mode, they will still be 
deformed in the rendered images.

Associate Parent 
Transformation Switch 
with Selected Element

Matches the drawing name and drawing location path 
in the Transformation Switch node's Properties with 
the drawing name and drawing location path found in 
the Drawing Layer's Properties. For this button to 
work, a drawing node connect to a deformation 
group, with a Transformation Switch inside, must be 
selected.

Optional Buttons

Icon Tool Name Description

Convert Elliptic Zone of Influence to Shape
After you have created a deformation chain using 
Elliptic as the Zone of Influence type, you can select 
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your deformer and click on this button to convert it to 
a Shaped type. Control points will appear around the 
shape making it easy to customize.You can also 
convert the Elliptic zone of influence to a shape. 
Select Animation > Deformation > Convert Elliptic 
Deformation ROI to Shape. This will create a much 
smaller  initial zone of influence than if you were to 
convert it directly to a shape.

NOTE 

You can also convert the Elliptic zone of 
influence to a shape. Select Animation > 
Deformation > Convert Elliptic 
Deformation ROI to Shape. This will 
create a much smaller  initial zone of 
influence than if you were to convert it 
directly to a shape.

Convert to New Drawing and Add 
Deformation Chain

Takes the pose/drawing and the deformer of the 
selected frame and converts it to a new pose/drawing 
with the corresponding deformer. 

Remove All Keyframes
The Remove All Keyframes option removes all 
keyframes on the selected deformation chain.

Show All Controls

The Show All Controls button lets you visualize the 
resting position in red (Setup mode) and the active 
position (Animation) in green at the same time

Show All Regions of Influence 

The Show All Regions of Influence button displays 
all regions of influence in the deformers in your 
project. Note that the deformer’s controls must be 
visible in order for its zones of Influence to show. The 
regions will not be displayed when a deformer’s zone 
of Influence is set to Infinite or Zero.
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NOTE 

Region of influences are not available for 
Game Bone deformers.
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Display Toolbar 
The Display toolbar lets you select the different Display nodes available in the node system. 

When your scene does not have a Display node, it is automatically set to Display All which uses the Timeline 
view ordering and shows floating nodes from the Node view. You can also set your scene to use Display All 
using the Display toolbar.

NOTE 

If you try to add a peg or other transformation layer in the Timeline view without having a layer 
selected, an error message will display. Make sure to change to Display All. The peg layer will be 
floating in the Node view and will not be visible in the Timeline view.  The Timeline view shows 
only layers that are connected to the Composite node.

If you switch to Display All, you run the risk of not realizing when you have floating nodes that are 
not connected to your composite.  For this reason, it is not recommended to work in Display All 
mode.

How to access the Display toolbar

 1. Select Windows > Toolbars > Display.
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Easy Flipping Toolbar
T-LAY-003-007

The Easy Flipping toolbar lets you rapidly flip through drawings in the Drawing view as is done with paper 
drawings. In order for the features in this toolbar to work, you must be in the Drawing view.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Previous Drawing Displays the previous drawing of your animation.

Next Drawing Displays the next drawing of your animation.

  Slider
Lets you flip forwards or backwards through your 
drawings by moving the slider.

  Loop
Displays drawings in the first frame after you reach 
the last frame of your animation.

Easy Flip
Automatically flips through the drawings based on 
the FPS.

  Preroll

Sets  the number of drawings to be flipped through 
before the starting drawing. The starting drawing is 
determined by the position of the red playhead in the 
Timeline view.

  FPS
Sets the speed of playback in the units of frames per 
second.
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Edit Toolbar
The Edit toolbar contains common operations such as Undo, Redo, Cut, Copy and Paste. These commands can 
also be found in the Edit top menu.

How to access the Edit toolbar

 1. Select Windows > Toolbars > Edit.

Icon Tool Name Description

Undo
Removes the last change made to your project. 
Harmony supports multiple undo, so you can undo 
changes you made in the order you made them.

Redo
Redoes an operation you have undone. This command 
is active only after you use the Undo command.

Cut
Removes selected objects. You can then paste the 
object or its properties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location 
you select in a view.

Create Symbol
Creates a symbol from selected drawing elements in 
the Drawing or Camera view, nodes in the Node view, 
or a layer or cells in the Timeline view.
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File Toolbar
The File toolbar contains buttons for common file operations such as New, Save and Open. These commands 
can also be found in the File top menu.

NOTE 

The  New, and  Save As buttons are only available in Harmony Stand Alone. With Harmony 
Server,  Control Center must be used to create scenes.

How to access the File toolbar

 1. Select Windows > Toolbars > File.

Icon Tool Name Description

New (Harmony Stand 
Alone)

Creates a new scene while closing any scene already open. The New 
Scene dialog box opens, asking for directory, name, and resolution 
information.

Open
Displays the Open Scene dialog box where you can browse for a scene 
file.  You can open a new scene from the current one and the previous 
scene will close.

Save
Saves all changes made to the opened scene, drawings, palettes, and 
palette lists.

Save As

Saves the current file with a different name and at a different location.

Saves the current state of a scene as another scene. The Save As 
window prompts you for a new name and a different location for this 
scene before saving it. This will create a complete scene directory for the 
new scene.
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Icon Tool Name Description

NOTE 

The scene name cannot exceed 23 characters.

Import Images Imports bitmap images which you can choose to vectorize.
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Flip Toolbar
The Flip toolbar lets you determine the type of drawing to include in your flipping selection. You can flip 
through the key, breakdown or in-between drawings individually, or view a combination.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Show Key Drawings
Displays key drawings when flipping through 
drawings.

Show Breakdown 
Drawings

Displays breakdown drawings when flipping through 
drawings.

Show In-between 
Drawings

Displays in-between drawings when flipping through 
drawings.

Show Retake Key 
Drawings

Displays retake key drawings when flipping through 
drawings.

Show Retake Breakdown 
Drawings

Displays breakdown retake drawings when flipping 
through drawings.

Show Retake In-between 
Drawings

Displays retake in-between drawings when flipping 
through drawings.
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Game Toolbar
The Game toolbar contains tools for setting anchors and props, as well as exporting to sprite sheets and Easel 
JS.

How to access the Game toolbar

 1. Select Windows > Toolbars > Game.

Icon Tool Name Description

Toggle Anchor Adds the Anchor parameter to the selected layer.

Toggle Prop Adds the Prop parameter to the selected layer.

Export to Sprite Sheets
Opens the Export to Sprite Sheets window where you 
can export your animation as sprite sheets .

Export to Easel JS
Opens the Export to Easel JS window where you can 
export your animation as Easel JS.
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Mark Drawing Toolbar
The Mark Drawing toolbar lets you identify drawings such as key, breakdown and in-between. The drawing 
Identification feature can help the animator stay well organized and save time when identifying key, 
breakdown or in-between drawings in the Xsheet and Timeline views. 

How to access the Mark Drawing toolbar

 1. Select Windows > Toolbars > Mark Drawings.

Icon Tool Name Description

Mark as Key Drawing Identifies the selected drawing as a key drawing.

Mark as Breakdown 
Drawing 

Identifies the selected drawing as a breakdown 
drawing.

Mark as In-between 
Drawing 

Identifies the selected drawing as an in-between 
drawing.

Mark as Retake Key 
Drawing 

Identifies the selected drawing as a key retake 
drawing.

Mark as Retake 
Breakdown Drawing 

Identifies the selected drawing as a breakdown retake 
drawing.

Mark as Retake In-
between Drawing 

Identifies the selected drawing as a in-between retake 
drawing.
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Master Controller Toolbar
T-RIG3-008-002

The Master Controller toolbar allows you to launch one of the wizards that are packaged with Harmony which 
can be used to generate Master Controller widgets. 

How to access the Master Controller toolbar 

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Master Controller. 

 l Right-click on any existing toolbar and select Master Controller.

Icon Tool Name Description

Stack 
Wizard

Opens the Master Controller Stack Wizard, which allows you to create a Master 
Controller that combines a 2D point widget and a slider. The 2D point widget can be 
used to rotate part of your rig in any direction, used a grid of preset poses, and the 
slider can be used to switch between different grids of poses.

Grid Wizard

Opens the Master Controller Grid Wizard, which allows you to create a Master 
Controller with a 2D point widget that can be used to rotate part of your rig in any 
direction, using a grid of preset poses—see Master Controller Grid Wizard Dialog Box 
on page 124. 

Slider 
Wizard

Opens the Master Controller Slider Wizard, which allows you to create a Master 
Controller with a slider widget which can be used to change the pose of part or all of 
your rig, based on a line-up of 2 or more poses—see Master Controller Slider Wizard 
Dialog Box on page 236. 

Unroll 
Poses 
Wizard

Opens the Unroll Poses Wizard, which allows you to take an existing Master 
Controller and break it into the set of poses that were used to generate it. You can 
then make changes to the poses and generate an updated Master Controller.
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Icon Tool Name Description

Function 
Wizard

Opens the Function Wizard, which allows you to create a custom Master Controller 
that controls a specific parameter in a selection of one or several drawings or nodes.

Show 
Master 
Controllers

If you selected a group containing Master Controllers, or multiple nodes in which 
there are Master Controllers, this will open a dialog allowing you to select some or all 
of these Master Controllers and to display their controls in the Camera view. 

Deformer 
on 
Deformer 
Wizard

Opens the Deformer on Deformer Wizard, which allows you to create a Curve 
deformer over an Envelope deformer. The Curve deformer will be converted to a set of 
Master Controller widgets which can be used to deform the points of the Envelope 
deformer, which will in turn deform the drawing it is rigged to. This makes it possible 
to combine the versatility of an Envelope deformer with the ease of use of a Curve 
deformer—see See Deformer On Deformer Wizard Dialog Box on page 58..
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Mini Playback Toolbar
The Mini Playback toolbar allows you to quickly preview a short span of animation starting a few frames before 
the current frame and ending a few frames after the current frame, at a customizable frame rate.

How to add the Mini Playback toolbar to your workspace

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Mini Playback.

 l Right-click on any existing toolbar and select Mini Playback. 

Icon
Tool 
Name

Description

Mini 
Playback 
Dialog

Open the Mini Playback dialog. This dialog allows you to set the amount of frames 
before and after the current frame to playback when using Mini Playback, to set the 
speed of Mini Playback and to start Mini Playback.

Mini 
Playback

Begins Mini Playback using the last settings entered in the Mini Playback dialog. By 
default, Mini Playback will play 5 frames before and after the current frame, at the 
scene's frame rate. 
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Node Caching Toolbar
The Node Caching toolbar allows you to control how nodes in your scene are cached.

Icon Button Description

Toggle 
Node's Cache

Toggles the Cached property of every selected node on or off. 

Show cached 
preview

Re-enables cache for every element or rig in your scene for which it was temporarily 
disabled.

Always 
Playback with 
Cached 
Previews

When toggled on, if you play your scene, the cache will be re-enabled for every 
element for which it was temporarily disabled. 

Disable 
Preview 
Cache when 
selecting 
nodes

When toggled on, selecting a node in the Timeline or Node view will disable 
caching for this node, or for any node connected underneath it.

NOTE 

Selecting an element in the Camera view always disables the cache for this 
element and its children, regardless of whether this option is enabled or 
disabled. This option only affects what happens when selecting in the 
Timeline or Node view. 
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Onion Skin Toolbar
The Onion Skin toolbar contains a few options that can be used with Onion Skin. Specifically, you can use it to 
quickly toggle the Enable Onion Skin for other elements option, as well as to only display drawings with 
specific markers in the Onion Skin.

How to access the Onion Skin toolbar

 1. Select Windows > Toolbars > Onion Skin.

Icon Tool Name Description

Enable Onion Skin in 
Other Elements

In the Drawing View, when the Light Table is enabled, making other 
layers visible alongside the current layer, this will make the Onion Skin 
for other visible layers appear alongside the Onion Skin for the current 
layer. Drawings for elements above the current layer will appear in blue, 
and drawings for elements below will appear in yellow. 

NOTE 

The drawings from other elements that get displayed in the 
Onion Skin are the drawings that are exposed at the same time 
as the drawings displayed in the current layer's Onion Skin. 

Show Key Drawings Only displays drawings marked as key drawings in the Onion Skin.

Show Breakdown 
Drawings

Only displays drawings marked as breakdowns in the Onion Skin.

Show In-between 
Drawings

Only displays drawings with no marker in the Onion Skin. Drawings 
with no marker are considered in-betweens.

Show Retake Key 
Drawings

Only displays drawings marked as retake key drawings in the Onion 
Skin.
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Icon Tool Name Description

Show Retake Breakdown 
Drawings

Only displays drawings marked as retake breakdowns in the Onion Skin.

Show Retake In-between 
Drawings

Only displays drawings marked as retake in-betweens in the Onion Skin.
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Pen Settings Toolbar
The Pen Settings toolbar provides options for enabling and configuring the Pen Stabilizer, which can help you 
draw smooth lines with precision and minutia. It also allows you to access the Pen Pressure Feel dialog, which 
allows you to configure how the pressure you apply to your tablet pen is processed by Harmony to affect the 
size of your drawing strokes. 

NOTE 

For information on how to use the Pen Settings toolbar, refer to the User Guide.

Icon Parameter Description

Pen 
Stabilizer 
Mode

Allows you to select a method for Harmony to stabilize your drawing strokes. 

Stabilization is a process by which Harmony uses the general direction of your 
drawing strokes to create smooth, stable curves and avoid jittering and sharp corners. 

Harmony accomplishes this by his by letting you draw a stroke of a certain length 
without generating artwork right away. After your stroke has reached that length, 
Harmony starts generating an drawing stroke that keeps trailing behind your mouse 
cursor or tablet pen as you draw. Harmony uses the buffer between your mouse 
cursor or pen tablet and the actual drawing stroke to generate smooth curves and 
ignore jittering and small mistakes. 

The way Harmony does this depends on the stabilization method you choose:

 l Stabilizer Off: No stabilization is performed. When you draw a stroke, artwork 
for it is generated immediately. 

 l Average: Harmony calculates the average direction of all of your mouse or 
pen gestures between the end of the actual drawing stroke and the current 
position of your mouse cursor or pen tip, and extends the stroke in this 
average direction, effectively evening out jitter and rounding sharp turns. 

 l Pulled String: When you start drawing a stroke, Harmony positions the 
drawing tool where your stroke starts. As you move the mouse or tablet pen, 
the drawing tool remains in that position, but a "string" appears, linking your 
drawing tool to your mouse cursor or pen tip.
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Icon Parameter Description

This string has a certain maximum length. Once that length is reached, the 
string pulls the drawing tool in the direction of your mouse cursor or tablet 
pen.

NOTE 

The distance between your mouse cursor or tablet pen and the stroke 
can be adjusted. For the purpose of demonstration, these images were 
done using the largest supported distance.

Pen 
Stabilizer 
Distance

This parameter determines how far your drawing strokes trail behind your mouse 
cursor or tablet pen as you draw. 

In the case of the Average technique Harmony lets you draw an invisible stroke of a 
certain length before it starts generating the artwork based on the average direction of 
that invisible stroke. This parameter determines the invisible stroke's length.

In the case of the Pulling String, Harmony binds your drawing tool to your mouse 
cursor or tablet pen with a virtual string of a given length. This parameter sets the 
length of that string.

Pen 
Stabilizer 
Settings

Allows you to enable or disable the following options:

 l Catch Up: When using stabilization, your drawing strokes trail behind your 
mouse cursor or tablet pen. With this option enabled, when you stop moving 
your pen and just leave it pressed against your tablet, the brush stroke will 
progressively catch up to the position of your pen.

NOTES 

 l This option only works if you are drawing with a pen tablet.

 l This option only works with the Average stabilization 
method.

 l Show String: When using the Pulled String method, the virtual string 
binding your drawing tool to your mouse cursor or tablet pen will be 
displayed as you draw, allowing you to visualize how the brush stroke trails 
behind your mouse cursor or tablet pen.
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Icon Parameter Description

 l Eraser: If enabled, strokes with the  Eraser tool will also be stabilized. By 
default, the stabilizer works with the  Brush,   Pencil and  Stroke 
tools. 

Pen 
Pressure 
Feel

Opens the Pen Pressure Feel dialog, which allows you to configure how Harmony 
processes the pressure you put on your tablet pen before applying it to the thickness 
of your drawing strokes—see Pen Pressure Feel Dialog Box.
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Playback Toolbar
The Playback toolbar allows you to play your animation as well as to set some playback options such as 
looping, audio playback, playback range and playback speed. 

Name Button Description

Play

Plays the scene in the Camera or Drawing 
view. 

You can also select Play > Play or Stop from 
the top menu.

Render and Play

Renders your scene's frames, then opens the 
rendered frames in Play for playback. 

This allows you to preview your scene's 
animation in real time, with the effects 
rendered and with no risk of slowdown. 

You can click and hold this button to switch 
its mode to Record and Play or Test SWF 
Movie.

Record and Play

Exports your scene as it appears in the Camera 
view into a movie file, then opens it in your 
workstation's default video player. 

This allows you to preview your animation 
without any risk of slowdown, but it does not 
preview the effects in your scene. However, it 
is much faster than Render and Play. 

Test SWF Movie
Quickly exports your scene as a Flash Movie 
(.swf), then opens it in your workstation's 
default web browser.
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Enable Loop

If pressed, your scene will repeat indefinitely 
when playing. Otherwise, it will stop when 
the end is reached.

You can also select Play > Loop from the top 
menu.

Enable Sound

When pressed, your scene's soundtrack will 
play during playback.

You can also select Play > Enable Sound 
from the top menu.

Enable Sound Scrubbing

When pressed, you will hear a sample of your 
scene's soundtrack at the current frame when 
moving your scene's playhead in the Timeline 
view. 

This allows you to easily situate where the 
action is relative to the sound track. 

You can also select Play > Enable Sound 
Scrubbing.

Jog Frames

Allows you to quickly play your scene 
forward or backward to preview your 
animation. 

Moving the handle towards the right will play 
your scene forward, while moving it towards 
the left will play your scene backward.

The closer to the edge you move the handle, 
the faster the playback will be, allowing you 
to dose the speed at which your scene is 
played. When the handle is at the edge, your 
scene will play at its actual framerate.

Once the head is released, it returns to the 
middle and playback stops.

Frame  
Lets you manually enter the current frame 
number, setting the playhead's position.

Start  
Let's you manually enter the number of the 
first frame to play during playback. 
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TIP 

You can also click on Start (just left 
of the input field) to quickly set the 
Start frame to the current frame.

Stop  

Let's you manually enter the number of the 
first frame to play during playback. 

TIP 

You can also click on Stop (just left 
of the input field) to quickly set the 
Stop frame to the current frame.

FPS (Frames per second)  

Lets you set the amount of frames that should 
be played during every second of playback, 
which is how the playback speed is 
determined.

NOTE 

This does not change the frames per 
second setting in your scene's 
resolution settings.
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Scripting Toolbar
The scripting toolbar allows you to create buttons that run functions in your scripts. You can add one button for 
each function you want to be able to run, and clicking on the button will instantly run the script function your 
linked it to. 

How to add the Scripting toolbar to your workspace

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Scripting.

 l Right-click on any existing toolbar and select Scripting.

Icon Tool Name Description

Manage 
Scripts

Opens the Scripts Manager dialog box where you can add scripts and functions to 
your Scripting toolbar.

Stop Script Stops the execution of a script launched from the Scripting toolbar.
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Shift and Trace Toolbar
The Shift and Trace toolbar allows you to temporarily move, rotate and scale drawings, then trace over them in 
other drawings using Onion Skin. Contrary to Shift and Trace with the Drawing Desk, you can use the Shift 
and Trace toolbar in the Camera view. 

How to access the Shift and Trace toolbar

 1. Do one of the following:

 l In the top menu, select Windows > Toolbar > Shift and Trace.

 l Right-click on any existing toolbar and select Shift and Trace.

NOTE 

You can also select the Shift and Trace  tool from the Tools toolbar, under the pop-up menu of 
the Hand  tool. When the Shift and Trace tool is active, all the commands in the Shift and Trace 
toolbar are available in the Tool Properties view.

Icon Tool Name Description

Shift and Trace 
Tool

Enables the Shift and Trace tool, with which you can temporarily offset, rotate 
and scale drawings. 

The transformations done on drawings with the Shift and Trace tool are only 
meant to allow you to trace these drawings, and can be undone at any time to 
reset the drawings back to their intended position.

Selecting the Shift and Trace tool also enables Shift and Trace and Onion Skin.

Enable/Disable 
Shift and Trace

Enabled by default. When disabled, drawings that were repositioned, rotated or 
scaled with the Shift and Trace tool appear in their original position.

Set Add Cross 
Hair Mode

When selected, clicking on the drawing will add a cross hair where you click. 
Cross hairs are marks that appear on the same location on every drawing in the 
current layer and which move when you offset a drawing with the Shift and Trace 
tool, and they appear in the Onion Skin rendition of neighbouring drawings as 
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Icon Tool Name Description

well. This allows you to keep track of how offset each drawing is. 

Remove All 
Cross Hair

Removes all the cross hairs created for shift and trace.

Reset Selected 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on the selected 
drawings, resetting them to their original position, angle and scale.

Reset All 
Drawings Shift 
Position

Undoes all transformations done with the Shift and Trace tool on all drawings, 
resetting them to their original position, angle and scale. 
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Tool Presets Toolbar
The Tool Presets toolbar lets you create new tool presets and manage them.

How to access the Tool Presets toolbar

 1. Select Windows > Toolbars > Tool Presets.

Icon Tool Name Description

New Tool Preset
Creates a new tool preset from the current tool 
settings.

Manage Presets
Opens the Manage Tool Preset dialog box where you 
can update, organize, and delete existing presets.
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Tools Toolbar
The Tools toolbar contains the main tools you need to work in Harmony. In the default workspace, this toolbar 
located on the left edge of the application window.  

TIP 

Many toolbar buttons have a keyboard shortcut associated to them. You can check which keyboard 
shortcut is associated to a button by leaving your mouse cursor over the button for a second. If the 
button has a keyboard shortcut, it will be indicated in the tooltip that appears. 

By default, the Tools toolbar hides some of its tools inside pop-up menus. For example, to select the  Cutter 
tool, you must double-click or long-click the  Select tool button, and select  Cutter in the pop-up menu.
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However, it is possible to make the Tools toolbar display each tool as a separate button by enabling the Flat 
Tools Toolbar preference. This makes the selection of tools quicker. 

How to make every tool in the Tools toolbar display in buttons rather than pop-up 
menus

 1. Do one of the following to open the Preferences dialog:

 l Windows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.

 2. Select the General tab.

 3. In the Options section, check the Flat Tool Toolbar option.

 4. Click OK.

 5. Close and relaunch Harmony.

NOTE 

In Flat Tools Toolbar mode, some tools are hidden from the Tools toolbar by default. To 
customize which tools are displayed in the Tools toolbar, and the order in which they are 
displayed, right-click on the Tools toolbar and select Customize.

How to customize which tools are displayed in the Tools toolbar when it is in Flat 
mode

 1. Right-click on the Tools toolbar and select Customize.

The Toolbar Manager dialog appears. 
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 2. In the Available Tools list, select each tool that you want to add to the Tools toolbar, then click on 
the Add the selected tool to the toolbar  button.

 3. In the Toolbar list, select each tool that you want to remove from the Tools toolbar, then click on the 
Remove the selected tool from the toolbar  button.

Tool Name Icon Description

Select
Allows you to select and reposition, scale, rotate and skew brush 
strokes, pencil lines, shapes and other parts of your artwork.

Cutter
Allows you to cut a part of your artwork, then reposition, scale, rotate 
and skew it. 

Reposition All 
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the 
current layer.

Contour Editor

Allows you to edit the vector contours of brush strokes, pencil lines and 
shapes in your artwork. You can add, remove, tweak and move vector 
points, move the Bezier handles of the vector points as well as  deform 
vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating the 
points at the centre of its line rather than its contour.

Pencil Editor
Allows you to adjust the thickness of a pencil line at its different points 
and corners, tweak the shape of its extremities and scale its texture.

Smooth Editor
Allows you to optimize contours and lines by removing its extra points, 
making them easier to edit. 
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Perspective Allows you to deform artwork by applying a perspective effect on it.

Envelope
Allows you to deform and warp artwork by moving points and tweaking 
lines in a grid. 

Edit 
Gradient/Texture

Allows you to adjust the position, angle and size of gradients and 
textures in a colour zone. 

Brush
A pressure-sensitive tool for creating a contour shape with a thick and 
thin line effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing outlines. Pencil lines are made of 
central vector lines, making them easier to tweak and edit than brush 
strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Paint Allows you to fill colour zones with a colour or texture.

Ink
Allows you to recolour pencil lines with precision by changing the 
colour of one segment at a time. 

Paint Unpainted
Allows you to quickly fill empty zones in your artwork with a colour or 
texture, leaving filled zones unchanged.

Repaint
Allows you to quickly repaint painted zones in your artwork. Empty 
zones will remain empty.

Unpaint Allows you to empty filled colour zones of their colour and texture.

Stroke
Allows you to create invisible lines that can serve as colour zones that 
can be filled, or close the gaps in existing colour zones.

Close Gap
Allows you to close open shapes so that they can be filled with the 
Paint tool. By drawing a stroke near a small gap in a shape, this tool will 
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create a small invisible stroke connecting the two closest points around 
the gap.

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline 
Allows you to draw shapes, segmented lines or complex curved lines by 
clicking to create each point in the sequence of line segments. 

Colour Eyedropper Allows you to select a colour by clicking on a colour in your artwork. 

Pencil Texture 
Eyedropper

Allows you to select a pencil texture by clicking on a textured pencil 
line.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking where 
you want its location to be.

Morphing
Allows you to create and configure a morphing sequence, which will 
automatically generate the in-betweens between two drawings in the 
current layer. 

Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like with a real 
animation disc.

Shift and Trace
Allows you to temporarily move drawings so you can trace over them in 
other drawings using Onion Skin. 

Animate Current Frame
When this option is selected, every time you use  the  Transform, 

 Advanced Animation or  Inverse Kinematic tools to 
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manipulate an element in your scene, the position of the element will be 
stored in a keyframe at the current frame. This allows you to animate 
elements in your scene without creating keyframes manually.

Animate Onion 
Skin Range

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformations to an 

element in your scene, the transformations will be stored as keyframes 
at the beginning and at the end of the current Onion Skin range, as well 
as on every existing keyframe in-between. This can be useful if you want 
to reposition an element that you have already animated, but only during 
a specific range of frames, which you can define by enabling Onion Skin 
and setting the Onion Skin range to cover that range of frames.

Animate Off

When this option is selected, if you use the  Transform or 
 Advanced Animation tools to make transformation to an element 

in your scene, the transformations will affect the element throughout the 
whole scene. This can be useful if you want to reposition an element 
after you have already animated it. 

Transform
Allows you to select drawing layers and position, rotate, scale and skew 
them. 

Inverse Kinematics
Allows you to pose a character model by pulling on its extremities, such 
as hands and feet, and have the other connected limbs follow. Can be 
used on any piece connected in a hierarchy. 

Onion Skin
Displays the previous and next frames of an animation. Useful when 
animating cut-out characters.

Advanced Onion 
Skin

Enables Advanced Onion Skin, a more flexible kind of Onion Skin that 
can be easily configured using the Onion Skin view.
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Workspace Toolbar
The Workspace toolbar lets you load other workspaces. The first time you start Harmony, the default 
workspace is loaded. Other workspaces are available such as the Hand-Drawn Animation and Compositing 
workspaces; these display different views and toolbars. You can access these workspaces and any you create, 
from the Windows menu and the Workspace toolbar.

How to access the Workspace toolbar

 1. Select Windows > Toolbars > Workspace.

Icon Tool Name Description

  Workspace List Allows you to select an existing workspace.

Workspace Manager
Opens the Workspace Manager where you can 
organize, display, and remove workspace from your 
list.

Save Workspace

When the Automatically Save Workspace preference 
is disabled, the Save Workspace button becomes 
available. This allows you to manually save your new 
workspace configuration.
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View Toolbars
Harmony has a series of view specific toolbars that are only available in a given view. These toolbars can be 
moved only within their view. 

All view toolbars can be added, as long as the view is visible, through the top menu Windows > Toolbars > 
desired toolbar.

3D Graph View Toolbar 1205

Animated Matte Generator Toolbar 1206

Script Editor Toolbar 1209

Timeline View Toolbar 1214

Xsheet View Toolbar 1219
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3D Graph View Toolbar
The 3D Graph toolbar works in conjunction with the elements in the 3D Graph view.

How to access the 3D Graph toolbar

 1. With the 3D Graph view open in your workspace, do one of the following:

 l From the top menu, select Windows > Toolbars > 3D Graph.

 l Right-click on the top area of the 3D Graph view and select 3D Graph.

NOTE 

This toolbar is for use with the 3D Graph view. For more information on this view, see 3D Graph 
View on page 1222.

Icon Functionality Description

Enable Subnode
Enables the selected subnode, making it and all its enabled children 
visible. You can also enable a selection of multiple subnodes.

Disable Subnode
Disables the selected subnode, making it and all its children 
invisible. You can also disable a selection of multiple subnodes.

Make Properties Available

When the 3D model is connected to a Subnode Animation node, this 
will add the properties (ie: position, angle, scale) of the selected 
subnode to the Subnode Animation node's list of properties in the 
Timeline view. This is useful if you want to add keyframes to a 
subnode before animating it or if you want to outline which 
subnodes should be animated and which ones should not.

Add 3D Kinematic Output

Creates a 3D Kinematic Output node and connects it under the 3D 
Model's Subnode Animation node. This 3D Kinematic Output node 
will be configured to use the currently selected subnode's animation. 
You can then connect this 3D Kinematic Output node to an element 
in your scene to apply the selected subnode's animation to that 
element.
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Animated Matte Generator Toolbar
The Animated Matte Generator toolbar displays by default at the top of the Animated Matte Generator view, 
adding some extra functionalities for editing and animating Animated Matte Generator nodes.

How to access the Animated Matte Generator toolbar

 1. Add the Animated Matte Generator view to your workspace by doing one of the following:

 l From the top-right corner of any currently visible view, click the Add View  button and 
select Animated Matte Generator.

 l From the top menu, select Windows > Animated Matte Generator.

 2. Click on the Animated Matte Generator to set the focus on it.

 3. In the top menu, select Windows > Toolbars > Animated Matte Generator.

NOTE 

This toolbar is for the Animated Matte Generator view. For information about the options and 
functionalities of the Animated Matte Generator view, see Animated Matte Generator View on 
page 1224.

Icon Functionality Description

Set up the Selected Points for 
Animation

Adds the attribute for the position and handles of the selected 
matte point(s) to the list of visible attributes for the Animated 
Matte Generator node in the Timeline view. 

If you expand the parameters of an Animated Matte Generator 
toolbar in the Timeline view, by default,  you will see its 
interpolation factor and its colour properties, which are 
animatable, but you will not see the attributes of each of the 
control points of the matte contours. 
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Icon Functionality Description

Attributes for a point are automatically added to the node's list 
of attributes if you animate the point in the Camera view. A 
keyframe is created at the same time for these attributes, to 
record the point's position. 

You can use this button to add the attributes of the currently 
selected control points in the matte contour to the list of 
attributes of the Animated Matte Generator node in the Timeline 
view, without requiring you to animate them first. 

This can serve as an indication to animators as to which control 
points they are supposed to animate and which ones should be 
left in their default position.

Merge Inner and Outer Matte 
Contours

By default, the points in the animated matte generator's outer 
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Icon Functionality Description

contour and their corresponding points from the inner contour 
are locked together, allowing you to animate a single matte 
instead of two mattes. If you disable one of the contours by 
toggling off the Outer Contour  or Inner Contour  
visibility buttons in the Animated Matte Generator view, you 
can animate the other contour's points separately from the 
hidden contour, which causes the points to be separated. This 
command puts separated contour points from the inner and 
outer contours in the same position, and locks them back 
together, as they were initially. 

Delete Matte Point Animation

Deletes every keyframe in the scene for the selected matte 
points, as well as their attributes in the Timeline view. This 
resets the selected points to their original position and makes 
them static throughout the scene.

Delete Selected Matte Point

Deletes the selected matte control points from the contour.

NOTE 

If a point from one of the two contours is deleted, the 
corresponding point from the other contour will also be 
deleted. It is not possible to have a different amount of 
points on a matte's inner and outer contours. 

Delete Unused Matte Generator 
Attributes

This cleans up the list of attributes for the Animated Matte 
Generator layer in the Timeline view by removing attributes that 
have been created for points that no longer exist. For example, 
points that were created for a drawing that was deleted, or for a 
part of a drawing that was erased or modified.
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Script Editor Toolbar
The Script Editor toolbar gives you quick access to some commonly used commands for editing and testing 
scripts in the Script Editor view—see Script Editor View on page 1291.

How to access the Script Editor toolbar

 1. Add the Script Editor view to your workspace by doing one of the following:

 l In the top-right corner of an existing view, click on the  Add View button and select Script 
Editor.

 l In the top menu, select Windows > Script Editor.

 2. Click on the Script Editor view to set the focus on it.

 3. In the top menu, select Windows > Toolbars > Script Editor.

Icon Button Description

New Script

Creates a new script. When you click on this button, you are first prompted to type in a 
name for the script. Then, you will be prompted to select which location to save the 
script in:

 l User: Saves the script to a directory in your user preferences directory. You will 
be able to run and edit the script from any scene as long as you are logged in as 
the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using 
Harmony Server, the script will be saved to the preferences for your 
Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the script to 
the Harmony database's global script directory. Anyone who is logged in to the 
database will be able to edit and run this script. 
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Icon Button Description

 l Environment: If you are using Harmony Server, select this option to save the 
script to the current scene's environment. Anyone will be able to edit and run 
the script as long as they are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the 
current scene's job. Anyone will be able to edit and run the script as long as 
they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able 
to edit and run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable. This option is only available if this 
environment variable is set.

NOTE 

For more information on script locations, see Script list on page 1291.

Import 
Script

Allows you to import a script from your machine into Harmony. When you click on this 
button, you are prompted to browse for and select a script on your file system. Then, 
you are prompted to select which location to import the script in:

 l User: Saves the script to a directory in your user preferences directory. You will 
be able to run and edit the script from any scene as long as you are logged in as 
the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the 
preferences for your account on your computer. if you are using 
Harmony Server, the script will be saved to the preferences for your 
Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the script to 
the Harmony database's global script directory. Anyone who is logged in to the 
database will be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save the 
script to the current scene's environment. Anyone will be able to edit and run 
the script as long as they are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the 
current scene's job. Anyone will be able to edit and run the script as long as 
they are working on a scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able 
to edit and run the script when working on this specific scene. 
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 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable. This option is only available if this 
environment variable is set.

NOTES 

 l When you import a script, any user interface (.ui) or icon (.png) file 
that is in the same directory and has the same filename as the script 
will also be imported.

 l For more information on script locations, see Script Editor View on 
page 1291.

Delete 
Script

Deletes the selected script. 

NOTES 

 l You cannot delete a script if it is in the Application Resources 
location, as those are scripts that are installed with Harmony.

 l If you delete a script that was originally in Application Resources but 
which you copied to another location so you could make changes to 
it, the original version of the script in the Application Resources folder 
will be restored to the list. 

Refresh 
Script File 
List

Refresh the list of scripts in the Script Editor. If there are new scripts in your user 
preferences or your scene's scripts sub-folder, click on this button to be able to open 
them in the Script Editor. 

Set 
External 
Editor

Allows you to type in the path and name for your preferred text editing software.

NOTES 

 l On macOS, only typing the name of your preferred text editing 
software is enough if that application supports the AppleScript Open 
Document protocol. 

 l On Windows and GNU/Linux, unless your text editor is in your 
system's PATH environment variable, you will have to type in the full 
path to the editor. 

Open with 
External 

Opens the selected script in the chosen external text editing software. 
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Icon Button Description

Editor

Set Target

Prompts you to select which script and which function to use with the  Run and 
 Debug buttons.

NOTES 

 l You can set the entire script as the target by selecting the <Nothing> 
function from the functions list.

 l You cannot link an entire script to a toolbar button. Only functions 
within scripts can be added as toolbar buttons. Therefore, running or 
debugging an entire script rather than one of its functions should be 
done for testing purposes only.

Run

Runs the target script and function. 

NOTES 

 l If you have not set a target script and function, you will be prompted 
to set one when you click on this button.

 l You can set or change the target script and function by clicking on the 
 Set Target button.

 l If you are editing <<<Sandbox>>>, this button will simply run what 
you typed into the sandbox, regardless of whether another target is 
set.

Debug

Open the target script and function in the Qt Script Debugger, in which you can test 
and debug the function.

NOTES 

 l If you have not set a target script and function, you will be prompted 
to set one when click on this button.

 l You can set or change the target script and function by clicking on the 
 Set Target button.

 l If you are editing <<<Sandbox>>>, this button will simply debug 
what you typed into the sandbox, regardless of whether another 
target is set.
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Icon Button Description

Stop 
Execution

If a script is currently running, this interrupts its execution.

1213

Harmony 21 Premium Reference Guide                          



Chapter 5: Toolbars

Timeline View Toolbar
The 3D Graph toolbar works in conjunction with the elements in the 3D Graph view.

How to access the Timeline view toolbar

 1. Do one of the following:

 l In the top menu, select Windows > Toolbars > Timeline View.

 l Right-click on the space at the top of the Timeline view and, in the context menu, select 
Timeline View.

Icon Name Description

Set Ease 
Type

Allows you to quickly apply an ease to the selected animation keyframes in the 
camera view.

To set the ease of an animation, simply select the first keyframe in the animation, then 
select the ease type in this drop-down. The ease-in will be applied to the selected 
keyframe, and the ease-out will be applied to the next keyframe in the timeline.

The following presets are available:
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Icon Name Description

Icon Preset
Ease-In (Selected 
Keyframe)

Ease-Out (Next 
keyframe)

Linear 0% 0%

Slow ease-in 25% 0%

Medium ease-in 50% 0%

Fast ease-in 75% 0

Fast ease-in / ease-
out

75% 75%

Medium ease-in / 
ease-out

50% 50%

Slow ease-in / 
ease-out

25% 25%

Slow ease-out 0% 25%

Medium ease-out 0% 50%

Fast ease-out 0% 75%

Quick Ease Sets the ease before and after the selected keyframe to 33%.

Quick Ease 
In

Sets the ease before the selected keyframe to 33%.

Quick Ease 
Out

Sets the ease after the selected keyframe to 33%.

Set Ease on Opens the Set Ease on Keyframes dialog. In this dialog, you can set the ease-in 
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Icon Name Description

Selected 
Keyframes

(before) and the ease-out (after) on the selected keyframes to a custom percentage. 

Set Ease for 
Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog. This dialog allows you to adjust 
the Bezier handles on all the selected animation keyframes in the Timeline. 

Create 
Empty 
Drawing

Creates a drawing in the selected cell, replacing any drawing that may already be 
exposed in that cell and the following ones until it meets another drawing, key 
exposure or a blank cell. 

Duplicate 
Drawing

Creates a duplicate of the selected drawing in the layer. The duplicate drawing will be 
exposed at the selected frame instead of the original drawing. Hence, this command 
allows you to instantly start working on a duplicate of the current drawing and retain 
the original. 

NOTE 

When duplicating a drawing, the exposure at the selected cell is replaced with 
the new drawing, up until the next key exposure.

Insert 
Keyframe

Adds a keyframe on the selected cell in the Timeline view. 

Delete 
Keyframes

Deletes the selected keyframes.

Set Motion 
Keyframe

Converts the selected keyframes to motion keyframes. With motion keyframes, 
Harmony generates the interpolation between the motion keyframe and the next 
keyframe. This means that a value for each frame between the keyframes is calculated 
by Harmony to progress from the value of the previous keyframe to the value of the 
next keyframe. 

Set Stop-
Motion 
Keyframe

Converts the selected keyframes to stop-motion keyframes. Between a stop-motion 
keyframe and the next keyframe, Harmony does not generate any animation and the 
element remains static until the next keyframe. 

Go to 
Previous 
Keyframe

Goes to the previous keyframe.
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Icon Name Description

Go to Next 
Keyframe

Goes to the next keyframe.

Add Key 
Exposure

Adds a key exposure to the selected cell. 

Delete Key 
Exposure

Removes key exposures from the selected cells.

Centre On 
Selection

Scrolls the layers list to the currently selected layer. This is useful if you want to 
select a layer in the Camera view, then manipulate its timing Timeline view. 

Create 
Keyframes 
On

Opens the Create Keyframes On dialog box, in which you can create keyframes at 
every set number of frames within a given range of frames.

Fill Empty 
Cells

Fills the empty frames in the selection with the exposure just before. For example, if 
you select a range of frame that starts with an exposed drawing and then ends with 
empty cells, all of the empty cells in the selection will be filled with the exposed 
drawing just before the empty cells. 

Paste Mode: 
All Drawing 
Attributes

Sets the Paste Mode to All Drawing Attributes. In this mode, when you cut or copy 
and paste frames in the Timeline view, both the animation keyframes and the exposed 
drawings will be pasted.

Likewise, if you drag and drop frames in the Timeline view, both the animation 
keyframes and the exposed drawings will be moved.

Paste Mode: 
Keyframes 
Only

Sets the Paste Mode to Keyframes Only. In this mode, when you cut or copy and paste 
frames in the Timeline view, only the animation keyframes will be pasted. The 
exposed drawings will not be pasted.

Likewise, if you drag and drop frames in the Timeline view, only the animation 
keyframes will be moved. The exposed drawings will not be affected.

Paste Mode: 
Exposures 
Only

Sets the Paste Mode to Exposures Only. In this mode, when you cut or copy and paste 
frames in the Timeline view, only the exposed drawings will be pasted. The animation 
keyframes will not be pasted.

Likewise, if you drag and drop frames in the Timeline view, only the exposed 
drawings will be moved. The animation keyframes will not be affected.
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Icon Name Description

Add Prefix 
or Suffix

Opens the Add Prefix or Suffix dialog. This dialog allows you to instantly rename all 
the selected layers by adding a prefix or a suffix to their name.

1218



Xsheet View Toolbar
The Xsheet toolbar contains the common timing operations such as Add Column, Delete Column, Clone 
Column, and so on. These options can also be found in the top menu.
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Chapter 6: Views
The Harmony interface is composed of different views, each one designed for a specific purpose. You can modify 
the location of the views by adding a new view as a tab or as a window. You can also swap the location of a 
view.  

When a view is active, a red rectangle appears around the view. Keyboard shortcuts and top menu options are 
associated with the active view. If a menu option is greyed out, it means it does not apply to the layer, drawing 
or other type of selection or the option does not apply to the active view.

3D Graph View 1222

Animated Matte Generator View 1224

Camera View 1231

Colour View 1241

Coordinates and Control Points View 1249

Drawing View 1252

Drawing Substitutions View 1255

Function View 1257

Guides View 1260

Integrated Help View 1264

Layer Properties View 1265

Library View 1267

Master Controller View 1270

Message Log View 1272

Metadata Editor View 1273

Model View 1275

Node View 1277

Node Library View 1279

Onion Skin View 1282

Perspective View 1288

Script Editor View 1291

Side View 1296

Timeline View 1298

Tool Properties View 1308
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Top View 1309

Xsheet View 1311
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3D Graph View
When a 3D model is selected, the 3D Graph view allows you to view a list of the subnodes composing the 3D 
model, arranged in their hierarchy. You can select a subnode from the list. When a subnode is selected, you can 
manipulate it with the Transform tool, disable or enable it. 

If your 3D model is connected to a Subnode Animation node, you can select this Subnode Animation node and 
use the 3D Graph view to select and animate a subnode, to add its properties to the Subnode Animation's 
properties in the Timeline view, or connect a subnode to a 3D Kinematic Output node to it so that its animation 
can be applied to another element. 

How to access the 3D Graph view

Do one of the following:

 l From the top menu, select Windows > 3D Graph.

 l From any of the other views, click the Add View  button and select 3D Graph.

Section Description

3D Graph menu Access commands through this menu—see 3D Graph View Menu.

3D Graph toolbar See 3D Graph View Toolbar.

Subnode list
Lists the selected 3D model's subnodes in a tree hierarchy and allows you 
to select a subnode.
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NOTE 

Subnodes preceded with a   icon are transformation subnodes 
which are only used to affect the position, size and angle of its child 

subnodes. Subnodes preceded with a  are geometry subnode, 
which actually contain a visible part of the 3D model. 

Selected subnode hierarchy and 
name

Displays the subnode's parent hierarchy followed by the subnode's name. 

Search bar
Allows you to filter and search for subnodes. Typing anything in the field 
will make the subnode list only display subnodes that contain the typed 
text string in their name, along with their parents. 
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Animated Matte Generator View
The Animated Matte Generator view allows you to configure and animate the matte created by a Animated-
Matte-Generator node. It also allows you to quickly add Animated-Matte-Generator templates to your Node 
view. 

How to access the Animated Matte Generator view

 1. Do one of the following:

 l From the top-right corner of any currently visible view, click the Add View  button and 
select Animated Matte Generator.

 l From the top menu, select Windows > Animated Matte Generator.

How to display the Animated Matte Generator controls and enable the Animated 
Matte Generator view options

 1. In the Tools toolbar, select the Transform tool or press Shift + T.

 2. In the Timeline or Node view, select the Animated Matte Generator node you wish to configure or 
animate.

 3. In the Camera view toolbar, click on Show Controls  or press Shift + F11.

NOTE 

The Animated Matte Generator view also has its own toolbar. For information on the buttons in 
this toolbar, see Animated Matte Generator Toolbar.
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Icon Functionality Description

Editing Mode

Define Matte Point

Allows you to manipulate the matte's contour points by 
dragging them in the Camera view. Use this mode to edit and 
animate your matte. 

Set to Snap

If the Animated Matte Generator node is connected to a 
snapping source drawing, this allows you to define which 
points and contours of the matte should snap to the contours of 
the snapping source drawing, by clicking on them.

If you click on a point in this mode, it will be set to snap to the 
nearest contour of the snapping source drawing.

If you click on a contour in this mode, the contour will be set to 
snap to the nearest contour of the snapping source drawing, and 
will be made to match its curve. Both points on either end of that 
contour will also be set to snap to the snapping source drawing.
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Points and contours that are configured to snap will snap to the 
closest point or contour they can find in the snapping source, 
provided that they are at a reasonable distance from their actual 
coordinates. This distance can be adjusted by changing the 
Drag-to-Snap Distance parameter in the Animated Matte 
Generator's layer properties.

Add Matte Point

Allows you create a point on the contour of the map by clicking 
on one of the matte's contour where you want the point to be 
created.

NOTE 

Adding a matte point to one of the matter's contours 
will also add a point to the matte's other contour. It is 
not possible to have a different amount of points on a 
matte's inner and outer contours.

NOTE 

Contrary to tools like the Contour Editor, you cannot use 
a keyboard shortcut to click and add a point to a matte 
contour.

Matte Visibility Settings

Outer Contour
When enabled, the matte's Outer Contour and its controls 
display in the Camera view, and the Outer Contour can be 
modified. 

1226



TIP 

You can hold Alt while pressing this button to quickly 
enable the outer contour and disable the inner contour 
simultaneously. You can also hold Shift while pressing 
any of the Matte Visibility Settings buttons to quickly 
enable all matte visibility settings.

Inner Contour

When enabled, the matte's Inner Contour and its controls 
display in the Camera view, and the Inner Contour can be 
modified. 

NOTE 

A matte always has an outer contour and an inner 
contour. By default, both contours are merged together, 
having the same shape and points, allowing you to 
animate them simultaneously as if the matte had a 
single contour. You can separate the points of the inner 
and outer contours by hiding one of the contours and 
making modifications on the other contour.

NOTE 

When two contour points are separated, you can lock 
them back together by selecting them and clicking on 

the Merge Inner and Outer Matte Contour  button of 
the Animated Matte Generator toolbar or by moving 
one of the points close to its corresponding point until 
they snap together. 

TIP 

You can hold Alt while pressing this button to quickly 
enable the inner contour and disable the contour 
simultaneously. You can also hold Shift while pressing 
any of the Matte Visibility Settings buttons to quickly 
enable all matte visibility settings.

Point Id

When enabled, the identification number of each of the matte's 
points display in the Camera view. These numbers are used to 
track which point of the outer contour are matched with which 
points of the inner contour. 
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TIP 

You can hold Shift while pressing any of the Matte 
Visibility Settings buttons to quickly enable all matte 
visibility settings.

Scaling Controls

When enabled, moving one of the control points of the matte 
contours will scale the entire matte. A purple square will appear 
in the middle of the matte's contour. Moving this square will 
change the position of the pivot point used for scaling the 
contour.

TIP 

You can hold Shift while pressing any of the Matte 
Visibility Settings buttons to quickly enable all matte 
visibility settings.

Keyframe Settings

Auto Key on All Points

By default, when a matte control point is moved in the Camera 
view, a keyframe is created for that point and its handles. With 
this option enabled, a keyframe will be created for all the points 
in the matte and all of their handles.
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Fix Adjacent Keyframes

When moving a control point, this will look for keyframes on 
other control points right before and after the current frame and, 
if it finds any, it will create keyframes for the control point being 
moved at these frames. This ensures that animating without the 
Auto Key on All Points option does not create overlapping 
animation for control points, but does not create unnecessary 
keyframes. 

Node Systems Creation

  Add Matte to Composite

If a Composite or Matte-Composite node is selected in the Node 
view, this creates an Animated Matte Generator template with an 
empty matte drawing layer in the Node view, then connects the 
newly created Animated-Matte-Generator node to the selected 
composite.

  Composite Operation
When using the Add Matte to Composite option on a Matte 
Composite node, this determines whether the Animated Matte 
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Generator node being created will be connected to the selected 
Matte Composite node in Add, Subtract or Intersect mode.

  Add Matte Generator

This creates an Animated Matte Generator template in the Node 
view which includes a Matte drawing layer, an Animated Matte 
Generator node, a Colour Selector and a Cutter. 

If a drawing layer is selected when clicking this button, it will be 
connected as the peg of the Matte drawing layer, and as the 
input of the Colour Selector node. 

  Add Matte Generator as Mask

This creates a similar template to the one created by the Add 
Matte Generator button, except that the Animated-Matte-
Generator node created by this option is connected to the matte 
port of the Cutter node, and the Colour-Selector node connected 
to the selected layer is connected to the input port of the Cutter 
node. 
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Camera View
The Camera view is the centre of operations in Harmony. In this view, you can draw, paint, animate, set up your 
scene, manipulate objects, open symbols and preview your animation.

The Camera view also has a top and bottom toolbar that you can use to navigate in the view, change the 
display mode or go up your symbol hierarchy. 

How to access the Camera view

Do one of the following:

 l From the top menu, select Windows > Camera.

 l From any of the other views, click the Add View  button and select Camera.

Icon Section Description

View Menu
The View menu contains all the tools and options that you can use in 
the Camera view to draw, animate or set up the scene.
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Icon Section Description

Editing Stack

The Editing Stack menu displays the names of the symbols and their 
hierarchy when you are editing a symbol. You can click on the different 
names to go back up to the different parent symbols or the top/current 
project.

  Camera View Toolbar

The Camera View toolbar contains all the tools and options you can use 
in the Camera view to draw, animate or set up the scene. The toolbar can 
be displayed or hidden by right-clicking on it and selecting or 
deselecting the Camera View toolbar.

Light Table

When you have a drawing layer or drawing selected, the Light Table 
button  button allows you to fade the colours of the other layers so you 
can see the current artwork better as you edit with a drawing tool. Note 
that the light table does not work when using a layer editing tool, such 
as the Transform  tool.

Current Drawing on Top

When this button is enabled, the drawing that you are currently editing 
with a drawing tool is temporarily displayed in front of all the other 
elements. The actual scene is not modified.

Camera Mask

The Camera Mask  button shows or hides Displays a black mask around 
the scene’s frame to avoid seeing the unnecessary artwork. This option 
is handy when you're animating and setting up the scene. It allows you 
to see your scene’s composition better.
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Icon Section Description

You can also access this from the top menu by selecting View > Show > 
Camera Mask.

Proportion Grid

The proportion grid is displayed in the camera view to help with 
proportions and balancing the composition of an image. The grid 
follows the camera frame, similar to camera mask and safe area.

The number of divisions in the proportion grid can be defined by the user 
in the Preferences > Camera > Proportion Grid > Horizontal Divisions 
> Vertical Divisions.

The default is 3 division on each axis to create a rule of third grid. 

TIP 

You can access the Proportion Grid button in the Camera 
View toolbar.

Safe Area 

The Safe Area  button shows or hides Displays the TV safety zone and 
the centre of the camera frame. The safe area adapts to the scene 
resolution, as well as the safety zone and frame’s centre.

You can also access this feature from the top menu by selecting View > 
Show > Safe Area.
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Icon Section Description

Show Alignment Guides

When enabled, alignment guides will be visible in the Camera and 
Drawing views.

This is enabled by default. Disabling this option will hide and disable 
alignment guides, meaning that animation and drawing tools will not 
snap to them, even if the  Snap to Alignment Guides option is 
enabled in the Tool Properties view. 

BBox Selection Style

When you select an object in the Camera view with the Transform tool, a 
bounding box always appears around the object and the artwork is 
tinted in fuchsia, red or yellow. Enabling this option will only keep the 
bounding box and remove the colour tint.

Outline Locked Drawings

Drawings that are locked in the Timeline view (cannot be selected in the 
Camera view) are displayed as wireframes.

OpenGL Node Caching

Toggles OpenGL Node Caching. When enabled, the preview image of 
nodes that have the Cached layer property enabled will be cached so as 
to help with performance when refreshing the OpenGL preview image in 
the Camera view.

You can also double-click or long-click this button to open a pop-up 
menu in which you can select the size of cached preview images:

 l 64x64

 l 128x128
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Icon Section Description

 l 256x256

 l 512x512

 l 1024x1024

Smaller cached images will look less detailed, but will increase the 
performance of node caching as well as decrease the amount of memory 
the cache requires. Larger cached images will look closer to the actual 
OpenGL preview, but will impact performance and require more memory 
to store. 

Reset View 
The Reset View  button resets any panning, zooming or rotation done in 
the Camera view and returns the display to the initial settings. You can 
also press Shift + M.

Take Snapshot

Saves the preview image of the Camera view in memory as a snapshot.

NOTES 

 l Harmony stores five snapshots and have a  drop down 
list with five available slots. So if any snapshot was in 
memory when taking a snapshot, it will be overwritten 
by the new snapshot.

 l Snapshots are not saved to the scene and are discarded 
when the scene is closed.

Show Snapshot

Displays the snapshot currently in memory. To display the snapshot, 
you must click and hold the button. Releasing it will restore the Camera 
view preview. 

NOTE 

The snapshot is displayed as it was taken, regardless of the 
preview mode of the Camera view. For example, if you took a 
screenshot in Render View mode, and display it while in OpenGL 
View mode, the snapshot will display as it was taken in Render 
View mode. 

  Zoom Menu

The Zoom menu lets you enlarge or reduce the Camera or Drawing view 
display. 

To make the camera frame size always match the size of your view, 
select the Fit to View option. Click the drop-down arrow and select a 
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Icon Section Description

zoom level or press 1 and 2.

OpenGL View Mode 

The OpenGL View Mode  button switches the Camera view to fast 
display, letting you see your animation play in real time. The OpenGL 
display requires less memory. The final look of your effects is not shown 
in the OpenGL View Mode. You must switch to the Render View Mode to 
see your effects.

Render View Mode

The Render View Mode  button switches the Camera view to a fully 
rendered display showing the final image of the current frame. If a 
modification is done to your current frame or if you move to a different 
frame, click the Update Preview button to update the display if your 
preview does not update automatically.The Render View Mode display 
lets you see the final look of your frames including effects and 
antialiasing. You cannot play back your scene in Render View Mode. To 
see your scene fully rendered and to play it back, you must press the 
Render and Play  button in the Playback toolbar.

1236



Icon Section Description

Matte View Mode

The Matte View Mode  button switches the Camera view to a matte 
display showing the alpha channel of the elements in your scene. The 
transparency level ranges from 0 to 100 percent. Zero percent is 
completely transparent and represented by black and 100 percent is 
completely opaque and represented by white. Everything in between 
these extremes has a transparency level somewhere between 1 and 99 
percent and is represented in various shades of grey. 

 l To access the Matte View mode, click on the Render View  button 
and select Matte View  from the drop-down menu.

Depth View Mode

The Depth View mode displays images in a relative white to black 
gradient scale. The object(s) closest to the camera are displayed in white 
and the object(s) furthest from the camera are displayed in black. If the 
position of the last object changes along the z-axis, that object will still 
remain black, so long as it retains its position as the object the farthest 
back. It does not matter where that object is in 3D space, it just matters 
what its position is relative to the other object in the same space. The 
objects closest and farthest from the camera set the range of the white 
to black scale. All the other objects fall somewhere in between.
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Icon Section Description

 l To access the Depth View mode, click on the Render View  
button and select Depth View  from the drop-down menu.

  Preview Colour Space

The colour space in which to display the preview image when in  
Render Preview mode. 

You can set this to any colour space supported by Harmony. It is 
recommended to set this to the colour space intended for rendering your 
frames, unless that colour space is not supported by your monitor. In the 
latter case, it’s recommended to set this to the closest colour space 
available that your monitor can display. 

The following colour spaces are available:

 l Linear: The same primaries and white point as sRGB and Rec. 
709, but with no gamma transfer curve applied to the colour 
values. This colour space is useful for compositing intermediary 
images that are meant to be rendered in sRGB or Rec. 709.

 l Display P3: A colour space commonly used for digital 
projection. It has the same primaries as DCI-P3, the same white 
point as sRGB and the same gamma transfer curve as sRGB.

 l Display P3 Linear: The same as Display P3, except with no 
gamma transfer curve. This colour space is useful for 
compositing intermediary images that are meant to be rendered in 
Display P3.

 l Rec. 709: The colour space used for HDTV. It has the same 
primaries and white point as sRGB, but has a different gamma 
transfer curve.

 l Rec. 709 2.4: The same colour space as Rec. 709 or sRGB, 
except with a gamma transfer curve of 2.4 (per ITU-R BT.1886). 
This colour space exists because some editing systems use a 
gamma transfer curve of 2.4 instead of the standard gamma curve 
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Icon Section Description

for Rec. 709.

 l Rec. 2020: A colour space used for Ultra High Definition TV 
(UHDTV). It has a complex gamma transfer curve and primaries 
that cover more of the human-perceivable colour space than 
other colour spaces, especially in the area of human-perceivable 
greens. 

 l Rec. 2020 2.4: The same colour space as Rec. 2020, except with 
a simple gamma transfer curve of 2.4 (per ITU-R BT.1886). This 
colour space exists because some editing systems use a gamma 
transfer curve of 2.4 instead of the standard gamma curve for 
Rec. 2020.

 l Rec. 2020 Linear: The same colour space as Rec. 2020, except 
with no gamma transfer curve. This colour space is useful for 
compositing intermediary images that are meant to be rendered in 
Rec. 2020.

 l sRGB: A colour space typically used for standard computer 
monitors. It has the same primaries and white point as Rec. 709, 
but has a different gamma transfer curve.

NOTE 

You can only select the display colour space in  Render View 

mode. In  OpenGL View mode, the preview image is 

generated in the colour space selected in the Display Colour 
Space drop-down in the Camera tab of the Preferences dialog.

TIP 

You can have multiple Camera views in your workspace, each set 
to their own colour space. Hence, you can preview your scene on 
multiple monitors with different colour spaces by having a 
Camera view on each monitor. 

  Drawing Name 
The Drawing Name field displays the name of the selected drawing, as 
well as the layer containing it. If the cell does not contain any drawing, 
an Empty Cell text is shown in the field.

  Tool Name 

The Tool Name field displays the name of the selected tool. If you 
temporarily override a drawing tool using a keyboard shortcut, the tool’s 
name will be highlighted in red. You can temporarily override a tool by 
holding its keyboard shortcut without the Alt key. For example, the 
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Icon Section Description

Select tool shortcut is Alt + S. If you hold down the S key, you will 
switch to the Select tool. When you release the key, you will return to 
the tool you were using.

  Frame Number The Frame Number field displays the number of the current frame.

  Selected Colour
The colour swatch displays the currently selected colour in the Colour 
view.
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Colour View
The Colour view is where you create colours and palettes and import existing palettes into your project. The 
Colour view is also necessary for drawing, painting and creating colour styling.

How to access the Colour view

Do one of the following:

 l From the top menu, select Windows > Colour.

 l From any of the other views, click the Add View  button and select Colour.

Palette List Panel

Icon Option Description

View Menu
The View menu contains all the commands and options that you can use 
in the Colour view to manage colours and palettes.
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Collapse/Expand Palette 
List

Allows you to show or hide your palette list and its options. By default, 
the palette list is displayed, but you may want to hide it if you are working 
with a single palette and want to allow more vertical space for the colour 
swatch list.

Add Palette Allows you to create a new palette. 

Remove Palette 

Deletes the currently selected palette. If the colour swatch is used in your 
project, zones painted with colour swatches which have been deleted will 
turn red, easily identifying them so you can repaint them with another 
colour swatch.

Link Palette

Allows you to add a palette from a different location, be it in a scene, job, 
environment or even an element to your palette list. The palette will be 
linked to its original location rather than copied to your scene's folder. 
Hence, if you make changes to the original palette, it will affect the colour 
of elements in your scene. 

If you want to import a palette as a copy into your scene's palette library, 
right-click on your palette list and select Import. You can also link to a 
palette in any location on your machine or network by selecting Link to 
External.

Order Palette List

Moves palettes further up or down the palette list. 

If a palette has been cloned, the highest palette among the original palette 
and its clone(s) will be used by Harmony. This can be overridden by using 
a Colour-Override effect—see Colour-Override Node on page 639.

Edit Palette List Mode 
Indicator

In Harmony Server, this icon appears when you have the modifying rights 
on your scene's palette list. While several users can work on a scene at 
the same time, only one user may have the right to modify a palette list at 
any given time. 
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NOTE 

In Harmony Stand Alone, you can always modify your scene's 
palette list. On Harmony Server, you must  unlock your palette list 
before making modifications to it.

Show Colour Palettes Shows only colour palettes in the palette list. This is the default option.

Show Pencil Texture 
Palettes

Shows only pencil texture palettes in the palette list.

Show All Palettes Shows both colour and pencil texture palettes in the palette list.

Palette List

Icon Description

In Harmony Server, this indicates that you have the rights to modify the palette.

Indicates that the palette is stored at the same level as its palette list. For example, a palette that is 
stored in the scene's palette library and which is listed in the scene's palette list, or a palette that is 
stored in an element's palette library and which is listed in that same element's palette list. 

Indicates that the palette file is stored in an external location, such as a different scene, an element in a 
different scene, a job other than the scene's job, an environment other than the scene's environment, or a 
custom location on your file system or network. This means the palette is liable to be missing if it is 
moved from its original location, or if the scene is exported from the database into an offline scene or to 
a different database.

This indicates that the palette is stored at a higher level than its palette list, making it a shared palette. 
For example, a palette in your scene's palette list that is stored in the palette library of the scene's job or 
environment, or a palette in an element's palette list that is stored in the palette library of the scene.

Indicates a potentially dangerous situation. For example, a palette file that is stored in one of the scene's 
element folders, but which is added to your scene's palette list. The whole scene can use the palette, 
but since it's stored inside an element, deleting that element will make your whole scene lose access to 
that palette. 
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Colour Swatch List Panel

Icon Option Description

Add Colour Adds a new colour swatch to the bottom of your colour list.

Remove Colour 

The Remove Colour  button lets you delete the currently selected 
colour swatches. If the colour swatch is used in your project, and 
confirmation dialog will appear prompting you to confirm that you 
want to delete the colour. Zones painted with colour swatches which 
have been deleted will turn red, easily identifying them so you can 
repaint them with another colour swatch.

Add Texture 

Allows you to import a bitmap image as a texture, which can be 
painted with just like a colour. When used with the Brush or Paint 
tools, bitmap textures are tiled inside the shape they fill. The scaling 
and position of the texture inside their shape can be tweaked with the 
Edit Gradient/Texture tool. When used with the Pencil tool or one of 
the Shape tools, a bitmap texture will follow the pencil line's 
direction. 
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Set Current Brush Colour 
When enabled, the colour you select in the colour view will be 
selected for the Brush tool. 

Set Current Pencil Colour 
When enabled, the colour you select in the colour view will be 
selected for the Pencil tool, as well as other tools that create pencil 
lines, such as the Line, Rectangle, Ellipse and Polyline tools. 

Set Current Paint Colour 
When enabled, the colour you select in the colour view will be 
selected for the Paint tool.

Link/Unlink Three Colours 

When enabled, the colour you select will be selected for all drawing 
tools. When disabled, you can select individual colours for the 
Brush, Pencil and Paint tools. 

Edit Palette Mode 

In Harmony Server, this allows you to get the modifying rights to the 
selected palettes. 

Since several people can work on any given scene at the same time, 
and a palette can be shared between scenes, palettes may be loaded 
in read-only mode when opening a scene on a Harmony database. 
Then, an user would only be able to edit a palette by first activating 
Edit Palette Mode. This prevents several users from making changes 
on the palette at the same time, since a user cannot activate Edit 
Palette Mode on a palette that is already being edited by someone 
else. This also prevents users from accidentally making modifications 
on important palettes.

Edit Palette Mode Indicator

In Harmony Server, this icon appears when you have the modifying 
rights on the currently selected palette.

NOTE 

In Harmony Stand Alone, you can always modify your 
palettes. 

  Colour Swatch Name 
Each colour swatch available in the Colour view can have its own 
name, making it easy to identify which colour is used to paint what 
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part of your character or background. 

NOTE 

Two colours can have the same name. Harmony identifies 
colours by an identification number. 

  Colour Swatch 

Also referred to as colour pots, the colour swatch is the actual 
colour information for a colour in your palette. It is represented by a 
rectangle displaying the colour in the list. 

Colour Editor Panel

The Colour Editor panel is an optional panel in the Colour view which can be enabled to edit your colour 
swatches on the go. 
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How to enable the Colour Editor panel

 1. Do one of the following:

 l Right-click on the palettes list, then select Colour Editor.

 l Click on the View Menu  button and  select Palettes > Colour Editor.

Option Description

Enable/Disable Tint Options

This collapses or expands the Tint section of the Colour Editor panel.

When tint options are enabled, the Colour Editor panel can be used to add a tint 
to the colour. This means that all sliders start with a value of 0 and that the new 
colour will be calculated relative to the old colour, using the algorithm chosen in 
the Tint Mode option. As you change the values of the colour sliders, the colour 
in your palette is not updated immediately. Rather, it is only updated when you 
click on the Apply button.

When Tint options are disabled, the Colour Editor panel only has colour sliders, 
and those sliders start out with the values of the selected colour. Changing the 
value of any of the colour sliders immediately updates the colour in your palette 
with the new value. 

Tint Mode

Allows you to select how the colour will be modified by the tint:

 l Offset: The chosen tint's colour values will be added  to the selected 
colour's values to make the new colour. You can choose negative values 
if you wish to subtract from the selected colour's values.

 l Blend: The selected colour will be blended with the selected tint, 
resulting in the average between the selected colour and the tint. 

Reset
In tint mode, this sets all the colour sliders to their neutral value, leaving the 
selected colour unchanged.

Apply
In tint mode, this applies the tint to the selected colour. Note that when tint mode 
is not enabled, changes to the selected colour are automatically applied. 

H (Hue) Sets the hue of the colour or tint.

S (Saturation) Sets the saturation level of the colour or tint.

V (Value) Sets the value of the colour or tint.
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R (Red) Sets the red value of the colour or tint.

G (Green) Sets the green value of the colour or tint.

B (Blue) Sets the blue value of the colour or tint.

a (Alpha) Sets the alpha (transparency) value of the colour or tint.
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Coordinates and Control Points View
The Coordinates and Control Points view displays the parameters of keyframes or control points selected in 
the Camera, Timeline or Xsheet view.  You can also see the same information in the Coordinate and Control 
Point toolbars.

In this view, you can edit keyframes and control point parameters, such as the position, continuity, bias, tension 
and lock-in-time. 

How to access the Coordinates and Control Points view

Do one of the following:

 l From the top menu, select Windows > Coordinates and Control Points.

 l From any of the other views, click the Add View  button and select Coordinates and Control 
Points.

Parameter Description

Name The name of the function curve to which the select point is linked.

Position
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Separate
Modifies modify the X, Y and Z coordinates independently. When this option is 
deselected, all three parameters are linked. If one is deleted, all others will also 
be deleted.

Cumulative Z

When a layer is parented to other layers that are moved forward or backward on 
the Z-axis, the currently selected layer's Z position value may not be accurate 
since its parent will also have an offset on the Z-axis. The Cumulative Z value is a 
compilation of all the Z-axis offsets to give the real Z-axis offset value related to 
the (0,0) centre.

Scale

Separate Scale

Modifies the width and height values independently. When this option is 
selected, the width and height are locked to the same value, forcing the scale to 
be on a 1:1 ratio. If the option is deselected, you have the ability to squash and 
stretch your layer at will.

Rotation

Angle The rotation angle value from the permanent pivot of the element.

Skew

Skew This is the skewing value.

Control Point and Keyframe

Frame The frame at which the select point is set.

Locked in Time
Indicates whether the point is locked to a specific frame (keyframe) or only locked 
to a specific position and the curve can flow through it freely as other points are 
being added, moved, or adjusted (control point).

Stop-Motion 
Keyframe

When this option is selected, the keyframe is set as a stop-motion point. This 
means that there is no automatic interpolation created between the selected point 
and the next one. The layer will maintain its position until the animation reaches 
the frame of the next point and will then jump to the new position. Deselect this 
option to generate interpolation and get the layer to progressively move to the 
next position.

Tension Controls how sharply the path bends as it passes through a control point or 
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keyframe.

Continuity

Controls the smoothness of a transition between the segments joined by a point.

Bias

Controls the slope of the path so it flows towards one side of the motion point or 
the other.
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Drawing View
In Harmony, you can draw in both the Drawing or Camera views. Although the two views are similar, there are 
some differences  when it comes to drawing.

Only the selected drawing is displayed by default in the Drawing view. You can use features, such as the light 
table to display the current drawing of all the enabled layers of your scene in washed-out colours, or the Onion 
Skin to display the previous and next drawings of the currently selected drawing layer.

How to access the Drawing view

Do one of the following:

 l From the top menu, select Windows > Drawing .

 l From any of the other views, click the Add View  button and select Drawing.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use in the Drawing view to draw, animate 
and paint.
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  Drawing Area
This is the main space in the Drawing view. It is where 
you draw and where the drawings are displayed.

  Zoom Menu

The Zoom menu lets you enlarge or reduce the 
Camera or Drawing view display. 

To make the camera frame size always match the size 
of your view, select the Fit to View option. Click the 
drop-down arrow and select a zoom level or press 1 
and 2.

  Drawing Name

The Drawing Name field displays the name of the 
selected drawing, as well as the layer containing it. If 
the cell does not contain any drawing, an Empty 
Cell text is shown in the field.

  Tool Name

The Tool Name field displays the name of the 
selected tool. If you temporarily override a drawing 
tool using a keyboard shortcut, the tool’s name will 
be highlighted in red. You can temporarily override a 
tool by holding its keyboard shortcut without the Alt 
key. For example, the Select tool shortcut is Alt + S. If 
you hold down the S key, you will switch to the 
Select tool. When you release the key, you will return 
to the tool you were using.

  Frame Number
This field displays the current frame of the animation 
you are working on.

  Cursor Coordinates
This indicates the position of the your pointer in the 
drawing area.
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  Colour Picker
The Colour Picker allows you to select a colour for 
drawing.
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Drawing Substitutions View
T-H16NEW-002-001

The Drawing Substitutions view allows you to view all the drawings in the selected layer in a list of 
thumbnails, as well as to quickly select which drawing should be exposed at the current frame. 

How to access the Drawing Substitutions view

 1. Do one of the following

 l From the top menu, select Windows > Drawing Substitutions.

 l In the top-right corner of any view, click on the  Add View button and select Drawing 
Substitutions. 

Section Description

View Menu

Opens a menu with the Create Key Exposure option. This option can be enabled or disabled. It 
determines what happens when you set the drawing in the current frame to the same drawing as 
the drawing in the previous frame.

 l When enabled, the exposure of the drawing at the current frame will be separated from the 
drawing in the previous frame with a key exposure. 

 l When disabled, the exposure of the current frame will be merged with the exposure of the 
previous frame. 
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Section Description

Thumbnails

Allows you to select the drawing to be exposed at the current frame. This will also replace the 
drawing for all subsequent frames during which the current drawing is exposed.

Current 
layer name

The name of the currently selected layer. The drawings in the thumbnails list are the drawings 
currently stored in this layer.

Zoom slider Allows you to change the size of the thumbnails. 
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Function View
The Function view lets you edit function curves and parameters. It contains a visual graph for adding, removing, 
and editing keyframes, as well as adjusting the velocity. The Function view allows you to display multiple 
functions in the background as a reference.

How to access the Function view

Do one of the following:

 l From the top menu, select Windows > Function.

 l From any of the other views, click the Add View  button and select Function.

How to display functions in the Function view

 1. Open the Function view.

The Function view is blank until you select the layer containing the functions you want to display.
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 2. To display a function in the Function view, click on the layer containing the functions to adjust in the 
Timeline view.

 3. To select the functions you want to edit, select them in the Function list.

Parameter Description

Function List

When selecting a layer in the Timeline view, all the corresponding functions are 
displayed (if any).  Select the functions you want to see and edit, and hide the 
ones you don't.

Display Toolbar

Allows you to modify how the editing area is displayed. You can hide the grid, 
disable the synchronization with the current frame, reset the zoom level and 
normalize the function display by stacking them one over the other to compare 
them regardless of their value range.

Current Frame Displays the current scene frame.

Selected Keyframe Value Displays the value of the selected keyframe.

Display Advanced Parameter 
Values

Displays the Projection, Bias, Tension and Continuity parameters to adjust the 
curve around the selected keyframe.

Keyframe, Velocity and 
Interpolation Options

This toolbar lets you add and delete keyframes, adjust the velocity curve, adjust 
the segments to motion or stop-motion keyframes and set the velocity to create 
steps instead of a constant progression.

Function Types
This toolbar lets you click on the different function types to enable or disable all 
the listed functions of that type.

Value Scale
Displays the value range for the displayed editing area. It can be referenced to 
know the value of a keyframe.
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Selected Keyframe
The selected keyframe is displayed in red. When selected, the keyframe values 
are displayed in the corresponding fields.

Bezier Handles
The Bezier handles let you adjust the ease in and ease out of each keyframe. The 
more the handle is pulled out horizontally, the slower the animation will be. The 
more the handle is pulled out vertically, the faster the animation will be.

Function Curve
The thin line going from keyframe to keyframe is the actual curve. The section of a 
curve located between two keyframes is called a segment.

Frame Scale
The Frame Scale displays the frame range for the displayed editing area. It can be 
referenced to know the current frame of a keyframe.
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Guides View
The Guides view allows you to add drawing guides to the current scene, to select which guide to use, to 
manage existing guides, to export and import guides and to enable or disable drawing guides as well as their 
various options.

NOTE 

For more information on each type of guide and how to use them, refer to the User Guide.

Icon Name Description

Options

Enable Guide  
Enables or disables drawing guides. When guides are disabled, they are not visible 
and you cannot edit them or use them with drawing tools. 

Align with 
Guide 

When enabled, when drawing with the  Brush,  Pencil,  Stroke and  
Line tools tool, the cursor is automatically locked against the axis of the currently 
selected guide that most closely matches the angle of your stroke, as if you were 
drawing against a rule. 

When disabled, the drawing tools are not constrained by the axes of the guide, 
allowing you to draw freely.  The guide's axes act as a visual aids only. 
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Icon Name Description

Lock Guide 
When enabled, you cannot do modifications on the currently selected guide. This 
prevents making unwanted modifications to the guide when drawing.

Enable Guide 
with Eraser

Allows you to use the Eraser tool with drawing guides. 

Full Cursor 
Display

When enabled, the guide's axes that go through the mouse cursor in the drawing 
space go throughout the entire drawing space and display even when you're 
drawing.

When disabled, the guide's axes that go through the mouse cursor only display 
over a short distance from the mouse cursor. Also, the guide's axes disappear when 
drawing a stroke. 

Show 
Reference Lines

When enabled, semi-transparent reference lines for each of the currently selected 
guide's axes appear all over your drawing space.

 
Number of 
Lines

Adjusts the amount of reference lines to display in your drawing space.

Guides List

New Guide

Allows you to add a guide to the scene's guides list. You can add a guide of one of 
the following types: 

 l  Ruler

 l  Square Grid

 l  Isometric Perspective

 l  1-Point Perspective

 l  2-Point Perspective

 l  3-Point Perspective (Bird’s-Eye View)

 l  3-Point Perspective (Worm’s-Eye View)

 l  3-Point Perspective (Horizontal Pan)

 l  3-Point Perspective (Vertical Pan)

 l  4-Point Continuous Perspective

 l  4-Point Perspective (Vertical Pan)
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Icon Name Description

 l  5-Point Perspective (Fisheye)

NOTE 

For more information on each type of guide and how to use them, refer to 
the User Guide.

Delete Guide Deletes the selected drawing guides from the scene's guides list.

Guides View 
Menu

Opens a menu with the following commands:

 
Rename 
Guide

Renames the selected drawing guide. 

  Cut Cuts the selected drawing guides from the list and adds them to the clipboard. 

  Copy Copies the selected drawing guides to the clipboard. 

  Paste
Pastes drawing guides from the clipboard to the current scene's guides list. Pasted 
guides are inserted under the selected guide.

 
Import 
Guides

Imports drawing guides that were previously exported to a file and inserts them at 
the bottom of the scene's guides list. Duplicate guides are filtered out to avoid 
cluttering the list. 

 
Export 
Selected 
Guides

Exports the selected drawing guides into a file.

 
Drawing 
Guides List

Displays the scene's list of guides and allows you to select which guide to display, 
edit and use.
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Icon Name Description
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Integrated Help View
Use the Integrated Help when you are unsure about what a certain menu item is or the function of a specific 
preference in the Preferences panel.

If you keep the Integrated Help window open for the entire duration of your work session, then you can use the 
forward and backward arrows to scroll through  a history of the help information that you called up during your 
session.

How to access the Integrated Help view

 1. Do one of the following:

 l From the top menu, select Windows > Integrated Help.

 l From any of the other views, click the Add View  button and select Integrated Help.
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Layer Properties View
The Layer Properties editor or view lets you adjust the properties of a layer in the Timeline view or a node in 
the Node view. The Layer Properties can be viewed as a floating window or as a view (docked).

Each layer has its own set of properties that can be modified, including effect and peg layers. Display the Layer 
Properties editor or view if you want to modify some of the layer’s properties, such as the name or the 
antialiasing quality. 

NOTE 

To know more about the parameters displayed in the Layer Properties view, see Nodes / Layers.

How to access the Layer Properties view

Do one of the following:
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 l From the top menu, select Windows > Layer Properties.

 l From any of the other views, click the Add View  button and select Layer Properties.

How to access the Layer Properties editor

 l Double-click on a layer in the Timeline view or a node in the Node view.

 l Right-click on a layer in the Timeline view or a node in the Node view and select Layer Properties.

 l Select a layer in the Timeline view or a node in the Node view and press Shift + E.
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Library View
The Library view is used to store elements such as animation, drawings, backgrounds and character models so 
as to reuse in different scenes and projects. You can also use the Library view to create and store symbols, as 
well as to store and import images, sound files and 3D models. 

To reuse elements from a scene in other scenes, you must create a template so that you can import it into 
different scenes. Templates can contain anything from a single drawing to a whole scene structure. You can 
create a template by creating it in a scene, then copying the elements you want in your template into a library. 
The resulting template is structured like a mini-scene that contains only the elements you copied into it. A 
template does not have any dependencies on the scene it was originally created in. Hence, it can safely be 
imported in any other scene.

Additionally, the Library view's Drawing Substitutions panel allows you to quickly change the current frame's 
exposure to one of the existing drawings in a layer. This is especially useful for animating a cut-out character's 
mouths, hands, eyelids and other such body parts which typically contain several drawings to choose from. 

How to access the Library view

Do one of the following:

 l From the top menu, select Windows > Library.

 l From any of the other views, click the Add View  button and select Library.

Icon Section Description

View Menu
The Library menu lets you access commands related to the Library view, 
importing .swf movies and Illustrator files, add a new folder, and refresh 
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Icon Section Description

the library’s content.

  Preview Window 

The Preview window lets you see the content of the currently selected 
template or symbol in the Template/Symbol list.

  Preview Playback 
The Preview Playback button lets you play back the content of the 
selected template or symbol if it contains more than one frame. Press 
the Play  button to play back the preview.

  Library Folder List 

The Library Folder List displays all the folders linked to the Library view. 

There are two default folders:

 l Symbols: This folder is the only folder containing symbols. You 
can organize it by adding subfolders inside.

 l Harmony Premium Library: This is a default folder found on the 
hard drive in your user documents. This folder can contain 
templates, but no symbols.

You can link new library folders to the Library view and organize them 
with subfolders.

  Library Search tool

When working on a movie or series, you will probably end up with many 
templates and symbols in your library. Using the Search tool, you can 
quickly find the templates and symbols in your folders.

  Template/Symbol List The Template/Symbol list displays the templates or symbols contained 
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Icon Section Description

in the selected library folder. You can display the templates by right-
clicking the symbols’ thumbnails and selecting View > Thumbnails.

  Slider

A slider could be used to adjust the display size of thumbnails in the 
Library view.
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Master Controller View
T-RIG3-008-008

The Master Controller view allows you to quickly find, select and display Master Controllers in the current 
scene. 

How to add the Master Controller view to your workspace

 1. Do one of the following:

 l In the top-right corner of an existing view, click on  Add View and select Master 
Controller.

 l In the top menu, select Windows > Master Controller.

Icon Section Description

Filter

  Path

Allows you to select a group in the current scene. When a group is selected, only the 
Master Controllers within that group will be listed in the Master Controllers list. This 
can be useful if you have several characters and only want the list of Master 
Controllers for a specific character. 
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Icon Section Description

  Name

Allows you to filter the Master Controllers in the Master Controllers list by their path 
or name. When you type something in this field, only the Master Controllers that 
contain the text you typed in their full path including their name will be listed in the 
Master Controllers list. 

Master Controllers

 
Master 
Controllers

Allows you to select one of the Master Controllers in your scene. This list displays 
the Master Controllers in your scene with their full path in the group hierarchy. 
Groups in the hierarchy are separated by forward slashes (/).

If a group is selected in the Path list, only the Master Controllers within this group 
will appear in the list. If anything is typed in the Name field, only Master Controllers 
with this text in their full path including their name will appear in the list. Otherwise, 
all the Master Controllers in your scene are listed. 

Refresh List
Refreshes the Path list if there are any changes in the name or hierarchy of groups in 
your scene, as well as the Master Controllers list if there are any changes in the 
Master Controllers in your scene.

Locate and 
Select 
Master 
Controller

If a Master Controller is selected in the Master Controllers list, clicking on this button 
will select the actual Master Controller node. It will also make the Node View 
navigate instantly to and focus on that Master Controller node.

Show 
Master 
Controller

If a Master Controller is selected in the Master Controllers list, clicking on this button 
will display its widget in the Camera view.
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Message Log View
The Message log view displays information gathered during a render task, such as which frames and at what 
time they were each rendered. The view also contains a list of the colour recovery operations.

How to access the Message Log view

Do one of the following:

 l From the top menu, select Windows > Message Log.

 l From any of the other views, click the Add View  button and select Message Log.
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Metadata Editor View

The Metadata Editor view lets you access the information of the props and anchors to be exported to Unity.

NOTE 

Because the Unity game engine does not support Unicode characters, it is recommended to avoid 
using it in scenes intended for games.

How to access the Metadata Editor view

 l In the top-right corner of a view, click the Add View  button and select Metadata Editor.

 l In the top menu, select Windows > Metadata Editor.

Parameter Description

Scene Metadata

This is a list of optional parameters you can create in a scene project to be 
exported to Unity. It will not have any incentive towards your scene assets, but 
can help developers know what to do with the assets contained in your Harmony 
scene. 

Once in Unity, scene Metadata will appear in Inspector view > Metadata when the 
Asset is selected in the Hierarchy view.

Name: Name of the Scene entry. (e.g. game.Armor001)
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Value: This can be anything that describes the state of an object. You could, for 
example, have three different stages of armour: new, damaged and destroyed.

Node Metadata

Displays only the props and anchors held inside your selection. If nothing is 
selected, no information will display. Name and value appear in this box as well. 
Name will show you the associated .tvg name and value will be set as either On 
or Off, depending on whether you want the connection to be set as active or not. 

Once in Unity, scene Metadata will appear in the Hierarchy view.

Name: Name of the selected anchor or prop. (e.g. game.isAnchor). Notice that it 
differs from the drawing layer name on the top-left corner of the Node Metadata 
section.

Value: Can be set to be active (On) or inactive (Off).

NOTE 

For any anchor or prop information created within the Metadata Editor, the naming convention 
must always use the prefix "game.". The term "game." is recognized automatically by Unity as a 
metadata information. For example: game.Armor001.

1274



Model View
T-ANIMPA-004-004

Once you have a fully painted drawing, you can use it as a colour model and load it in the Model view. This 
drawing can be used and loaded in any of your Harmony scenes. 

Once a drawing is loaded in the Model view, you can use the Colour Eydropper  tool to select a colour from 
the model and use it to paint in the Camera or Drawing view without having to pick the colour from the colour 
palette.

How to access the Model view

Do one of the following:

 l From the top menu, select Windows > Model.

 l From any of the other views, click the Add View  button and select Model.

Tool/Menu Item Icon Description

View Menu
The View menu contains all the tools and options 
that you can use to manage models.

  Model View Toolbar The Model View toolbar contains all the tools and 
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options you can use in the Model view to navigate 
through and manage models.

Colour Eyedropper
Allows you to select a colour by clicking on a colour 
in your artwork. 
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Node View
T-HFND-010-002

In the Node view, you can connect effects and compositing nodes to form a network, also known as a node 
system. This view is very useful for rigging puppets, creating advanced effects and having a clear view of 
complex scenes. The organization and order of the nodes determines the flow of data during the compositing 
process and how your animation elements will be composited.

How to access the Node view

Do one of the following:

 l From the top menu, select Windows > Node View.

 l From any of the other views, click the Add View  button and select Node.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to manage the node system.

Editing Stack

The Editing Stack menu displays the names of the 
symbols and their hierarchy when you are editing a 
symbol. You can click on the different names to go 
back up to the different parent symbols or the 
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top/current project.

  Node System
The main area of the Node view is where you can add 
and organize different nodes to represent a scene.

  Navigator
The Navigator view lets you pan the visible area to 
move quickly through extensive node sets.

  Search Toolbar

The Search toolbar lets you find and match a node in 
the project. The search is not case-sensitive. Once you 
have entered characters in the search field, press 
Enter/Return to validate and find the pattern in the 
node names. If successful, the node is selected and 
centred in the view. If many instances are found, use 
the Previous and Next buttons to cycle through each 
node.

  Group Navigation
When entering a group, the Group Navigation allows 
you to navigate back to the top and see the hierarchy 
of the group in which you are.
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Node Library View
T-HFND-010-003

To add effects or other types of nodes to the Node view, you must first find them in the Node Library view. 

When you create a new project in Harmony, the default node system that appears in the Node view looks 
similar to the one below.

Notice how layers are connected to your scene's composite. For an effect to work, it must be connected as an 
intermediary between a layer and its composite, as if it was made to filter the layer's drawing information 
before it reaches the composite. 

How to access the Node Library view

Do one of the following:
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 l From the top menu, select Windows > Node Library View.

 l From any of the other views, click the Add View  button and select Node Library View.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to manage the Node Library.

 
Node Library View 
Toolbar

In the Node Library View toolbar, you can change 
how the nodes are displayed. You can display nodes 
as icons, as a textual list or as icons with their names 
and a description.

  Node Categories
The Node Library view is conveniently divided into 
several categories retaining the related nodes.

  Category Description

  3D
Nodes related to working with 3D models within 
Harmony.

  Combine                     Nodes for combining images.

  Deformation

Nodes needed for building a deformation chain, as 
well as advanced effects such as Fold and Auto 
Muscle. The Deformation category is divided into the 
Bone and Distort categories.

  Favorites
Nodes most commonly used. To add nodes to the 
Favorites category, select any node from any other 
section and drag it onto the Favorites category.
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  Filter
Effect nodes, such as blurs. This category is 
subdivided into the following categories: Adjust, 
Blur, Colour Correct, Isolate and Stylize.

  Generator
Nodes that create an image, such as a gradient or 
colour.

  Group
Nodes for grouping, like Group nodes and Multi-Port-
In nodes.

  Misc
Various nodes including External, Note, Script and 
Visibility.

  Move
Nodes for changing elements over time, like Peg 
nodes, as well as certain transformations.

  Output
Output (Export) nodes such as Crop, Display, Scale-
Output and Write nodes.

  Particle

Nodes needed to construct complex particle systems. 
This category includes a series of examples of particle 
effects and is subdivided into the following 
categories: Basic, Examples and Modifier.

  Plugins Plugin nodes.

  Shading Nodes for light shading.
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Onion Skin View
The Onion Skin view allows you to quickly configure onion skin. Using this view, you can choose the colour of 
previous and next drawings, which kind of marked drawings to display and whether to measure the span of 
onion skin per frame or per drawing. When using Advanced Onion Skin, you can also use this view to pick 
which drawings are included in the Onion Skin, as well as the opacity of the drawings relative to how far they 
are from the current frame. 

How to access the Onion Skin view

 1. Do one of the following:

 l In the top-right corner of a view, click on the  Add View button and select Onion Skin.

 l In the top menu, select Windows > Onion Skin.

The Onion Skin view is added to your workspace.

A lot of the controls in the Onion Skin view are only accessible when using Advanced Onion Skin. 
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How to enable Advanced Onion Skin

 1. Do one of the following:

 l In the Tools toolbar, double-click on  Onion Skin and select Advanced Onion Skin.

 l In the Onion Skin view, click on the  Advanced Onion Skin button.

 l In the top-left corner of the Onion Skin view, open the  View Menu and select Advanced 
Onion Skin.

The controls for the Advanced Onion Skin are now accessible in the Onion Skin view.

User 
Interface

Section Description

View Menu
Open the Onion Skin view menu, which contains extra options for Advanced Onion 
Skin—see Onion Skin View Menu on page 380.

Previous Drawings Settings

Previous 
drawings 
visibility 
switches

Allows you to select which drawings before the current frame to include in the 
Onion Skin. A drawing that is toggled on will be visible in the Onion Skin, and a 
drawing that is toggled up will be excluded from it. You can select a range of 
drawings, or include and exclude specific drawings individually. 

TIP 

You can quickly select or deselect a range of drawings by clicking and holding 
on one drawing, then dragging the mouse cursor over the other drawings you 
want to toggle. 
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User 
Interface

Section Description

Previous 
drawings 
opacity 
sliders

Allows you to adjust the opacity scale of drawings before the current frame. Each 
slider represents the opacity of one drawing.

By default, moving one of these sliders will move the other sliders so that the 
opacity remain on a gradated scale. In this case, you can start by adjusting the 
opacity on one end, the opacity on another end and then, if you want, adjust one of 
the sliders in-between to make a segmented progression.

You can disable this behaviour by unchecking the Link Sliders option in the  
View Menu in the top-left corner of the Onion Skin view. This option is enabled by 
default. When disabled, you can adjust the opacity of each drawing independently. 

Previous 
drawings 
colour

Allows you to select the colour in which to display the drawings before the current 
frame.

Onion Skin Settings

Advanced 
Onion Skin

Enables Advanced Onion Skin. Advanced Onion Skin allows you to select, on the 
fly, which drawings to include in your Onion Skin, even if those drawings are not 
consecutive drawings, as well as the opacity scales for the drawings before and 
after the current frame. 

The controls for selecting which drawings to display in the Onion Skin as well as 
their opacity sliders are only accessible when Advanced Onion Skin is enabled. 
Otherwise, when using regular Onion Skin, the opacity of drawings in the Onion 
Skin is determined by the Onion Skin settings in the Preferences dialog. The amount 
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User 
Interface

Section Description

of drawings to include in the Onion Skin is set using the Onion Skin Add / Reduce 
One Previous Drawng and Onion Skin Add / Reduce One Next Drawing commands, 
available in the Camera and Drawing toolbars as well as in View > Onion Skin in the 
top menu. 

Onion skin 
opacity 
slider

Allows you to set the overall opacity of all the drawings in the Onion Skin. 

Include by 
frames or 
by 
drawings

Allows you to select whether the drawings to include in the Onion Skin are selected 
by frame or by drawing. 

 l By Frames: Selects the drawings to display in the Onion Skin by their frame 
number relative to the current frame. For example, if the Onion Skin is set to 
include 2 drawings before and after the current frame, it will include the 
drawings up to two frames before and up to two frames after the current 
frame, even if those drawings are the same as the one in the current frame. 
This is more useful for cut-out animation as it allows you to position a 
drawing relative to its position in adjacent frames.

NOTE 

This option only works in the Camera view. 

 l By Drawings: Selects the drawings to display in the Onion Skin by the 
amount of different drawings before and after the current frame. For example, 
if the Onion Skin is set to include 2 drawings before and after the current 
frame, this will display the nearest two different drawings before and after 
the drawing in the current frame in the Onion Skin, even if those drawings are 
further than 2 frames away from the current frame. This is more useful for 
frame-by-frame animation.

NOTE 

When this option is enabled, the handles allowing you to adjust the 
extent of the Onion Skin in the Timeline view are not available. 

Next Drawings Settings
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User 
Interface

Section Description

Next 
drawings 
visibility 
switches

Allows you to select which drawings after the current frame to include in the Onion 
Skin. A drawing that is toggled on will be visible in the Onion Skin, and a drawing 
that is toggled up will be excluded from it. You can select a range of drawings, or 
include and exclude specific drawings individually. 

TIP 

You can quickly select or deselect a range of drawings by clicking and holding 
on one drawing, then dragging the mouse cursor over the other drawings you 
want to toggle. 

Next 
drawings 
opacity 
sliders

Allows you to adjust the opacity scale of drawings after the current frame. Each 
slider represents the opacity of one drawing.

By default, moving one of these sliders will move the other sliders so that the 
opacity remain on a gradated scale. In this case, you can start by adjusting the 
opacity on one end, the opacity on another end and then, if you want, adjust one of 
the sliders in-between to make a segmented progression.

You can disable this behaviour by unchecking the Link Sliders option in the  
View Menu in the top-left corner of the Onion Skin view. This option is enabled by 
default. When disabled, you can adjust the opacity of each drawing independently. 
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User 
Interface

Section Description

Next 
drawings 
colour

Allows you to select the colour in which to display the drawings after the current 
frame. 

Marked Drawings Settings

Show Key 
drawings 
in Onion 
Skin

Only displays drawings marked as key drawings in the Onion Skin.

Show 
Breakdown 
drawings 
in Onion 
Skin

Only displays drawings marked as breakdowns in the Onion Skin.

Show In-
between 
drawings 
in Onion 
Skin

Only displays drawings with no marker in the Onion Skin. Drawings with no marker 
are considered in-betweens.

Show 
RetakeKey 
drawings 
in Onion 
Skin

Only displays drawings marked as retake key drawings in the Onion Skin.

Show 
RetakeBD 
drawings 
in Onion 
Skin

Only displays drawings marked as retake breakdowns in the Onion Skin.

Show 
RetakeIB 
drawings 
in Onion 
Skin

Only displays drawings marked as retake in-betweens in the Onion Skin.
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Perspective View
T-HFND-008-016

The Perspective view is used during scene setup. It allows you to see a multiplane scene’s orientation. The 
Perspective view is similar to a 3D display, as it lets you rotate the scene through all possible angles to 
understand the spacing between the elements. You can also position and rotate your layers and the camera 
inside the 3D display to achieve some 3D setup and camera moves.

How to access the Perspective view

Do one of the following:

 l From the top menu, select Windows > Perspective.

 l From any of the other views, click the Add View  button and select Perspective.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to work in the Perspective view.
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Editing Stack

The Editing Stack menu displays the names of the 
symbols and their hierarchy when you are editing a 
symbol. You can click on the different names to go 
back up to the different parent symbols or the 
top/current project.

  X Control The red circle rotates the view on its X axis.

  Y Control The green circle rotates the view on its Y axis.

  Z Control The blue circle rotates the view on its Z axis.

  Grid This is a perspective (3D) grid reference.

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the Perspective view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

Reset Rotation Resets the rotation of the Perspective view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.
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  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of 
your animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.
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Script Editor View
The Scripting view allows you to edit scripts to run in Harmony directly from the application. It displays a list of 
available scripts, from which you can select an existing script, edit it, test it and save it. The Script Editor will 
highlight the syntax of your script for easy reading. 

How to access the Script Editor view

Do one of the following:

 l From the top menu, select Windows > Script Editor.

 l From any of the other views, click the Add View  button and select Script Editor.

Parameter Description

Script 
Editor 
menu

The menu for this view—see Script Editor View Menu on page 388. 

Script 
Editor 
toolbar

The toolbar for this view—see Script Editor Toolbar on page 1209. 

Script list
The list of script files available as well as their location and their read and write permissions. 
Selecting a script in this list will open it in the editor.
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NOTE 

The << Sandbox >> item at the top of the list does not correspond to an actual script file. It 
is a temporary container to type and test code, and its content cannot be saved.

The file list has three columns: File, Location and Permissions.

 l The File column indicates the filename of each script.

NOTE 

The << Sandbox >> item at the top of the list does not correspond to an actual 
script file. It is a temporary container to type and test code, and its content cannot be 
saved.

 l The Location of the script can be one of the following:

 l Application Folder: Scripts that are packaged and installed with Harmony. By 
default, you cannot edit these scripts until you select them and click on Make 
Editable, at which point you are prompted to copy the script to a location from 
which you can edit them.

Scripts in the Application Resources folder are in the following location:

 l Windows: C:\Program Files (x86)\Toon Boom Animation\Toon 
Boom Harmony 21 Premium\resources\scripts

 l macOS: /Applications/Toon Boom Harmony 21 Premium/Harmony 
Premium.app/Contents/tba/resources/scripts

 l GNU/Linux:/usr/local/ToonBoomAnimation/harmonyPremium_
21/resources/scripts

 l User: Scripts that are saved in your user preferences. Those scripts can be edited 
and executed from any scene, provided that you are logged in as the same user. 

In Harmony Stand Alone, scripts in the User folder are in the following location:

 l Windows: C:\Users\[username]\AppData\Roaming\Toon Boom 
Animation\Toon Boom Harmony Premium\2000-scripts

 l macOS: /Users/[username]/Library/Preferences/Toon Boom 
Animation/Toon Boom Harmony Premium/2000-scripts

 l GNU/Linux:/home/[username]/Toon Boom Animation/Toon Boom 
Harmony Premium/2000-scripts

In Harmony Server, scripts in the User folder are in the following location:

/USA_DB/users/[username]/HarmonyPremium/2000-scripts

 l Scene: Scripts in the scripts sub-folder of the currently open scene. These scripts 
can only be edited and executed when the current scene is open.

 l Job (Harmony Server only): When using Harmony Server, these are the scripts 
saved in the directory of the current scene's jon. These scripts can be edited and 
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executed by any user when any scene that is part of this job is open.

Scripts in the Job folder can be found in the following location:

/USA_DB/jobs/[job name]

 l Environment (Harmony Server only): When using Harmony Server, these are 
scripts saved in the directory of the current scene's environment. These scripts can 
be edited and executed by any user when any scene that is part of this environment 
is open.

Scripts in the Environment folder can be found in the following location:

/USA_DB/environments/[environment name]

 l Global (Harmony Server only): Scripts in the Harmony database's scripts directory. 
These scripts can be edited by any user when any scene in the database is open.

Scripts in the Global folder can be found in the following location:

/USA_DB/scripts

 l System Variable: Scripts inside the directory set in the TOONBOOM_GLOBAL_
SCRIPT_LOCATION environment variable, if this variable is set. These scripts can be 
edited and executed by anyone on your workstation.

NOTE 

When two or more scripts with the same file name exist in different locations, 
Harmony will give priority to a single one of these scripts. The script given priority 
will be the one listed in the Script Editor and the one executed if it is associated to a 
toolbar button. 

Which script is prioritized is determined by the order of priority of script locations. 
From highest priority to lowest priority, the order goes as follows:

User > Scene > System Variable > Job > Environment > Global > 
Application Resources

An exception to this rule is if you have a script with the same name in both the scene 
folder and your user preferences. In this case, both versions of the script will be listed 
and you will be able to edit both.

 l The Permissions of the script can be one of the following:

 l Read Only: You cannot edit the script in the Script Editor and save your changes. 
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NOTES 

 l If the script's location is the Application Resources folder, it will 
always be Read Only to prevent you from making changes to 
scripts packaged with Harmony. However, you can click on the 
Make Editable button below the script editor to make a copy of the 
script in your user preferences folder, after which you can make 
changes to this copy.

 l If the script is in any other location and is Read Only, then it is 
likely that a network administrator made the script or the folder 
containing the script read-only to prevent other users from making 
unwanted changes to it. 

 l Read/Write: You can edit the script in the Script Editor and save your changes.

Editor

A text field in which you can edit the selected script. 

NOTE 

If the selected script is in the Application Resources folder, you will not be able to edit it until 
you click on the Make Editable button.

Search 
toolbar

Allows you to type in a keyword and search for this keyword within the script. You can use the  
Next button to go to the next instance of the keyword and the  Previous button to go to the 
previous instance. 

Cancel
If you have made any changes to your script that you have not yet saved, this discards those 
changes and reloads the saved version.

Restore to 
Default

If the selected script is a script that was packaged with Harmony, and which you copied to your 
User folder, to the Scene folder or to the Job, Environment or Global folder to make changes to it, 
you can click on this button to delete this copy of this script and resume using the original version 
of the script that is packaged with Harmony instead. 

IMPORTANT 

This will permanently delete your version of the script and any changes you have made to it. 

Verify Verifies that the script has no syntax error. 

Make 
Editable

If the currently selected script is in the Application Resources folder, you cannot edit it. By clicking 
on this button, the script can be copied to a location where you can edit it. 
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When you click on this button, you are prompted to choose whether to copy in either of these 
locations:

 l User: Saves the script to a directory in your user preferences directory. You will be able to 
run and edit the script from any scene as long as you are logged in as the same user.

NOTE 

If you are using Harmony Stand Alone, the script will be saved to the preferences for 
your account on your computer. if you are using Harmony Server, the script will be 
saved to the preferences for your Harmony database user.

 l Global: If you are using Harmony Server, select this option to save the script to the 
Harmony database's global script directory. Anyone who is logged in to the database will 
be able to edit and run this script. 

 l Environment: If you are using Harmony Server, select this option to save the script to the 
current scene's environment. Anyone will be able to edit and run the script as long as they 
are working on a scene inside this environment.

 l Job: If you are using Harmony Server, select this option to save the script to the current 
scene's job. Anyone will be able to edit and run the script as long as they are working on a 
scene inside this job.

 l Scene: Save the script to the scene's scripts sub-folder. Anyone will be able to edit and 
run the script when working on this specific scene. 

 l System Variable: Save the script to the directory in the TOONBOOM_GLOBAL_SCRIPT_
LOCATION environment variable. This option is only available if this environment variable is 
set.

NOTE 

This button will be greyed out if the script is in any location other than Application Resources 
and is read only. 

Save

Saves the modifications you made to the script.

This button replaces the Make Editable button after you have used the Make Editable button to 
copy the script to a location from which you can edit it. 
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Side View
T-HFND-008-015

The Side view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see a 
scene’s stage  from  the side. This lets the camera cone and spacing between the elements to be seen.

How to access the Side view

Do one of the following:

 l From the top menu, select Windows > Side.

 l From any of the other views, click the Add View  button and select Side.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to work in the Side view.

  Thumbnails

A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can see 
a representation of the FB position of each layer in the 
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camera cone.

  Camera Cone
The camera cone represents the camera’s position and 
field-of-view (FOV). 

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.

  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of 
your animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.

1297

Harmony 21 Premium Reference Guide                          



Chapter 6: Views

Timeline View
T-HFND-006-002

To set your animation timing, you will mostly work with the Timeline and Xsheet views. It's extremely useful to 
become familiar with the Timeline view, how it works, and its interface.

The Timeline view is the main view used when adjusting the timing of drawings, adding keyframes and 
ordering layers. The Timeline view displays layers, effects,  sounds, keyframe values, scene length, layer names, 
drawings, keyframes, timing, and frames.

The Timeline view allows you to read your timing from left to right. It represents the scene’s elements in their 
simplest form. You can also see the layers and their names, as well as the drawing’s exposure. The drawing 
name is displayed when you place your pointer over the drawing’s exposure.
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How to access the Timeline view

Do one of the following:

 l From the top menu, select Windows > Timeline.

 l From any of the other views, click the Add View  button and select Timeline.

Icon Section Description

View Menu
The View menu contains all the tools and options that you can use to 
manage models.

Enable/Disable Layer

The Enable/Disable All  button lets you enable or disable layers. Disabling a 
layer makes the scene behave as if it didn't exist, including when rendering 
the scene. For example:

 l A disabled drawing layer will be invisible.

 l A disabled sound layer will be mute.

 l A disabled peg layer will not affect the position of its child layers.

To disable a layer, click the layer's Enable/Disable  button or press D.

To enable a layer, click the layer's Enable/Disable  button or press A.

NOTE 

Next to sound layers, the Enable/Disable layer button will look like 

this: . 

TIP 

You can enable or disable all layers by clicking on the Enable or 
disable all layers  button in the top row.

Enable/Disable Solo 
Mode

Solo mode allows you to only view specific layers in the Camera view and 
hide all others. When solo mode is enabled on one layer, only this layer will 
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be visible. If solo mode is enabled on several layers, and only these layers 
will be visible. If solo mode is not enabled on any layer, all enabled layers 
will be visible.

You can also use solo mode on sound tracks. If solo mode is enabled on any 
sound tracks, only those sound tracks will play during playback.

TIP 

When some layers are in solo mode, you can disable or re-enable 
solo mode on all layers that have it enabled by clicking on the Toggle 
solo mode on or off  button in the top row. 

Add to/Remove from 
Onion Skin

For when the Onion Skin option is enabled, this allows you to enable or 
disable Onion Skin on specific layers.

TIP 

To activate the general Onion Skin preview, in the Tools toolbar, click 
the Onion Skin  button

Lock/Unlock Layer 

The Lock/Unlock Layer button lets you prevent the selection or editing of a 
layer in the Camera view. To select some of the layers without selecting 
others, in the Timeline view, lock the layers you do not want to select. When 
a layer is locked, its name is displayed in red.
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In the top menu, there is a series of locking options. Select Animation > 
Lock > select one of the following:

 l Lock: Locks the currently selected element.

 l Unlock: Unlocks the currently selected element.

 l Lock All: Locks all the elements in the Camera view. 

 l Unlock All: Unlocks all the elements in the Camera view.

 l Lock All Others: Locks all the elements in the Camera view except 
the currently selected one.

Toggle Outline Mode 
/ Change Track 
Colour 

Each drawing layer has a little colour swatch that has two functionalities:

 l Single-clicking a layer's colour swatch toggles Outline mode on or 
off. Outline mode makes the layer display as nothing but the outlines 
of its vector shapes in the Camera view, allowing you to see the 
drawing's shape without it blocking the view of layers behind it. 

 l Double-clicking the layer's colour swatch opens a colour picker 
dialog that allows you to change the layer's track colour. The track 
colour displays in the layer's track in the Timeline view, allowing you 
to give special visibility to specific layers. It also determines the 
colour of the layer's outlines if it's in outline mode. 

Show/Hide 
Thumbnails

Expands the layer to display a thumbnail of the drawing in the current frame, 
as well as for each drawing in the timeline. 
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NOTE 

By default, the timeline's zoom level does not allow enough 
horizontal space to fully display the thumbnails of drawings exposed 
for one or two frames only. To see the thumbnails for drawings with 
short exposure, you must increase the timeline's zoom level—see 
Timeline Zoom on page 1307.

When a drawing layer is in Show Thumbnails mode:

 l An exposure indicator appears at the right of each exposed drawing 
in the timeline, indicating the amount of frames the drawing spans 
over.

 l An Opacity parameter appears to the left of the layer, allowing you to 
set the layer's opacity level.

TIP 

You can show or hide thumbnails for all drawing layers by clicking on 

the Show/Hide All Thumbnails  button in the top row.

  Opacity

Allows you to set the opacity level of the layer. Click and drag the value left 
or right to decrease or increase the layer's opacity.

NOTE 

This parameter only displays for drawing layers that are in Show 
Thumbnails mode.

Active Drawing Layer 
Indicator

This icon appears next to the active drawing layer, which is the layer you 
draw on when using drawing tools. 
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NOTE 

The active drawing layer is not always the selected layer. For 
example, if you select a drawing layer, then a peg layer, the peg 
layer will be the selected layer, but the active drawing layer will 
remain the last drawing layer you selected, until you select another 
drawing layer.

Add Layer

The Add Layers  button lets you add new layers to the Timeline view. When 
you click the Add Layers button, a menu appears displaying the most 
commonly used layer types so that you can quickly add them to your scene. 
If you need to add other types of layers, you must use the Node view and the 
Node library.

Delete 
The Delete Layers  button lets you delete the currently selected layers in the 
Timeline view.

Add Drawing Layer
The Add Drawing Layer  button lets you automatically add a new drawing 
layer to the Timeline view. By default, the layer is named Drawing.

Add Peg 

The Add Peg  button lets you add a peg layer to the timeline. If several layers 
are selected, a peg is added and parented to each layer.

 Expand/Collapse

The Expand/Collapse  button is used to display the children layers of a 
parent layer. Once a layer is parented to another layer, it is indented to the 
right and the Collapse/Expand Children button appears on the parent layer 
allowing you to show or hide the child layer.

 Show/Hide Functions

The Show/Hide Functions  button lets you display the functions embedded 
in each layer. The functions are the different coordinates and values used to 
record a layer’s parameters at each frame. This information is stored on the 
function curves using keyframes.

If the layer can be connected to another layer, for example to use a drawing 
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layer as a matte, expanding a layer's functions will also list its possible 
connections. You can connect layers by dragging and dropping a layer onto 
another layer's connection. 

 
Add/Remove 
Keyframe

Adds a keyframe at the current frame of the selected function or removes the 
keyframe at the current frame of the selected function, if there is one already.

NOTE 

This button only displays for function layers.

Previous Keyframe

Moves the timeline cursor to the previous keyframe on the selected function.

NOTE 

This button only displays for function layers.

Next Keyframe

Moves the timeline cursor to the next keyframe on the selected function.

NOTE 

This button only displays for function layers.

Function Menu

Displays the Function menu, which allows you to create a new function for 
the function layer, or to link it to an existing shared function.

NOTE 

This button only displays for functions layers, in the Parameters 
column—see Show/Hide Parameters on page 1306.

Function Keyframe 

A frame where the value for one or more of the layer's functions is preset. 
The position of each layers in key poses for digital animation is recorded in 
function keyframes. You can grab and move function keyframes as well as 
copy, cut, paste and delete them.
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TIP 

If you have a keyframe and a drawing selected simultaneously, and 
you wish to delete the keyframe without deleting the drawing's 
exposure by doing one of the following:                         

 l In the Timeline toolbar, click on the Delete Keyframe  
button.

 l Press F7.

 l From the top menu, select Animation > Delete Keyframe 

NOTE 

If a collapsed layer has children that have function keyframes, you 

will see a white square  instead.

Split 

The Split  button lets you split the Timeline view in two sections, allowing 
you to see two different portions of the Timeline view. This can be useful if 
you need to often switch between two specific points of a lengthy scene.

Drawing Exposure

In the Timeline view, when a drawing is exposed, it is represented by a grey 
block that extends from the first frame it is exposed to the last frame it is 
exposed. 

View Modes

Lets you choose between different view modes allowing you to decide 
which layers are listed in the Timeline view. This can be useful if you're 
working on a scene with a lot of layers, and you only want layers you will be 
working on to appear in the Timeline view so as to declutter it. The 
following view modes are available:

 l Normal View Mode  will show all the layers that are connected to 
your scene's display node.

 l Selection Only Mode  will hide all the layers that are not currently 
selected, leaving only the currently selected layers in the Timeline 
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view. 

 l View Tagged Layers  will only show layers which you have 
tagged. 

TIP 

You can tag a layer by doing one of the following: 

 l Right click on the layer and select Tag > Timeline Tag.

 l Open the Timeline view menu  and select Edit > Tag > 
Timeline Tag.

Show/Hide 
Parameters

Shows or hides the Parameters column, right of the Layers column. The 
Parameters column displays information on the layer at the current frame, 
depending on the type of layer it is:

 l If the layer is a drawing, it displays the name of the drawing at the 
current frame. 

 l If the layer is a function, it displays the value of the function at the 
current frame. 

 l If the layer is a sound track, it displays the sound track's volume. 

Using the mouse, you can drag the parameter left and right to change its 
value. This is especially useful for quickly changing a drawing's exposure at 
the current frame. 

Show/Hide 
Additional Links

Shows or hides the Additional Links column. The Additional Links column 
displays layers that are connected under the layer, but for other purposes 
than being the parent of those layers. For example, if a layer is used as the 
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matte of an effect, the effect will be displayed in that layer's Additional 
Links. 

If more than one layers are in a layer's Additional Links, only the first of 
these layers will be displayed, followed by the amount of extra linked layers 
there are. 

By clicking on the Additional Links, you can open a menu listing the linked 
layers, and click on one of these layers to navigate to it. 

In the following example, the BOOM_Animation layer is used as the matte of 
Cutter_1 and Cutter_2:

Timeline Zoom

Reduces or increases the width of frames in the Timeline view. Move the 
slider right to increase the width or left to reduce it. You can also press 2 to 
zoom in and 1 to zoom out when the Timeline view is focused on.

If you want to reset the Timeline view's zoom, click on the Timeline Zoon 
 icon left of the slider.
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Tool Properties View
T-HFND-004-002

The Tool Properties view contains the most common options and operations related to the currently selected 
tool. When you select a tool from the Tools toolbar, the Tool Properties view updates.

For example, if you choose the Select  tool, the Tool Properties view will display the options and operations 
related to it, such as Snap to Contour, Apply to All Drawings, Flip Horizontal, and Flatten.

NOTE 

To learn more about the options appearing in the Tool Properties view, see Tools Properties on 
page 974.

How to access the Tool Properties view

Do one of the following:

 l From the top menu, select Windows > Tool Properties.

 l From any of the other views, click the Add View  button and select Tool Properties.
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Top View
T-HFND-008-014

The Top view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see 
the scene’s stage  from above. This lets the camera cone and the spacing between the elements be seen.

How to access the Top view

Do one of the following:

 l From the top menu, select Windows > Top.

 l From any of the other views, click the Add View  button and select Top.

Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to work in the Side view.

  Thumbnails

A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can see 
a representation of the FB position of each layer in the 
camera cone.
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  Camera Cone
The camera cone represents the camera’s position and 
field-of-view (FOV). 

  Axis Reference Arrows
  The axis reference arrows let you maintain your 

orientation when navigating in the view.

Show/Hide Camera Shows or hides camera frame in the Perspective view. 

Reset View
Resets the pan, rotation, and zoom of the Perspective 
view.

  Zoom Menu

This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use a 
zoom level that lets you see all your scene layers and 
information in the Perspective view at once.

  Layer Name
  This field displays the currently selected layer and 

drawing name.

  Tool Name This field displays the currently selected tool.

  Frame Number
This field displays the currently selected frame of 
your animation.

  Colour Swatch
  This field displays the currently selected colour in the 

palette.
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Xsheet View
T-HFND-006-003

The Xsheet view lets you read the timing vertically by displaying it in a grid, with each drawing layer 
represented by a column, each frame of your scene represented by a row, and each exposed drawing 
displayed by its name in the cells. It is meant to work like a traditional animation exposure sheet. 

Using the functions panel, you can also view the functions and keyframes of the motion paths for the selected 
column, with the value of those functions for each frame listed in the cells. 

Contrary to the Timeline view, the Xsheet view does not display pegs, effects or layer hierarchy. Hence, it is 
optimized for traditional and paperless animation, whereas the Timeline view is optimized for digital or cut-out 
animation.

How to access the Xsheet view

Do one of the following:

 l From the top menu, select Windows > Xsheet.

 l From any of the other views, click the Add View  button and select Xsheet.
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Icon Section Description

View Menu
The View menu contains all the tools and options 
that you can use to manage columns and timing.

  View Toolbar
The view toolbar contains all the tools and options 
you can use in the Xsheet view to manage columns 
and timing.

  Xsheet Main Section

The Xsheet view has three sections. By default, only 
the main section is visible. It displays the drawing 
layers, also known as drawing columns.

When using advanced compositing and animation 
techniques, unconnected functions (motion paths) 
also appear in the main section. Unconnected 
functions mean that some motion paths are not 
attached to any particular layer.

When you reconnect functions to a layer, they are still 
visible in the main section.
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  Functions Section

The Functions section is used for more advanced 
techniques. This section displays the functions 
(paths) related to the selected layer in the Timeline 
view. By default, the Functions section is hidden.

In the Xsheet view, click the Expand button located 
on the right side of the main section. Click on the 
same button to collapse it. You can also use the 
Show Column List  button in the Xsheet View toolbar. 
If you select a drawing column in the main section of 
the Xsheet view, the function columns will not be 
displayed. You must select the layer from the Timeline 
view.

  Column List Section

The Column List section allows you to show and hide 
columns in the Xsheet view. When you hide a layer in 
the Xsheet view, it is also disabled in the Timeline 
view.
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You can use the Column List to hide individual 
columns or hide an entire column type (drawing or 
function) from the Xsheet view. By default, the 
Functions section is hidden.

In the Xsheet view, click the Expand button on the 
right side of the main section to show the Functions 
section. Click on the same button to collapse it. You 
can also use the Show Column List  button in the 
Xsheet toolbar.

Go to the Xsheet view menu and select View > Show 
Column List. Click the Expand button on the right 
side of the Functions section to display the Column 
List section.

  Column Header

Each column available in the Xsheet view has a 
header displaying the column’s name. The column’s 
name is the same as the corresponding timeline layer. 
If you rename one or the other, they will both be 
renamed.

A quick access menu is available when you right-
click. This menu contains the command affecting an 
entire column such as renaming, changing the default 
colour, or deleting a column.

The tooltip that appears when you hover at the top of 
each Xsheet column shows the folder path to the 
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source drawings for that column.

In Harmony, the column header shows the layer’s 
name and the name of the drawing folder to which it 
is linked. If the name of the layer is the same as the 
drawing folder, the drawing folder’s name will not be 
displayed. For example; when you link a Timing 
column to a certain element (and thereby the 
Element’s folder). To modify the name of the element 
folder independently from the column and layer 
name, you must select the Advanced Element Mode 
option preference in the Advanced tab of the 
Preferences dialog box.

  Current Drawing

A drawing selected in dark red indicates that the 
drawing is currently displayed in the Drawing and 
Camera views. The current drawing selection is not 
linked to the drawing displayed in the Camera view 
since drawings from each visible layer are displayed 
at once.

  Current Frame

The darker frame appearing in the Xsheet view 
represents the current frame.

  Drawing Exposure

In the drawing columns, you can see the drawing 
names and their exposure. You can use any 
alphanumeric symbol to name your drawing. When a 
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drawing is exposed over more than one cell, a vertical 
black line is displayed to indicate the continuity of the 
exposure. When there is no drawing in a cell, the cell 
will be blank.

  Frame Numbers

On the left side of the Xsheet view, the frame numbers 
are shown indicating where you are. These read 
vertically instead of being displayed horizontally as 
they are in the Timeline view.

 l To go to a particular frame, click the frame 
number.

 l To select an entire range of frames, click and 
drag a selection downwards.

  Current Frame Display

At the bottom-right of the Xsheet view, you can see 
the current frame number, as well as the column 
containing the drawing currently displayed in the 
Drawing view.
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  Functions Column

The functions columns are displayed in the Functions 
section of the Xsheet view. They represent the motion 
and rotation you applied to a drawing layer. Only the 
function columns related to the selected layer are 
displayed.

A function column can also be related to an effect. 
Selecting the effect layer shows you the 
corresponding function column in the Xsheet view.

The function columns display the position value or 
effect value on each cell. If there is a keyframe on a 
cell, a black square is displayed. Holding the same 
value for several frames displays a vertical black line.

 
Increase/Decrease 
Exposure

You can quickly increase or decrease the exposure of 
the selected cell by clicking on the up and down 
arrows in the Increase/Decrease Exposure field.

  Overwrite/Insert Modes
The Overwrite/Insert button allows you to decide the 
way the values are inserted into the Xsheet.
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